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About this manual

 

This is the Reason Operation manual, where all aspects of the program is described 
in detail. The first chapters deal with general methods and techniques, e.g. how to 
route audio and how to handle patches etc. Then follows separate chapters for each 
Reason device.

 

About this Chapter

 

This chapter describes some general methods and techniques employed throughout 
Reason. It also contains some terminology, useful for better understanding of the pro-
gram and the manual. To make your work with Reason as effective and rewarding as 
possible, we recommend that you read this chapter.

 

Conventions in the Manual

 

This manual describes both the Macintosh version and the Windows version of Rea-
son. Wherever the versions differ, this is clearly stated in the text.

 

About Key Commands

 

In the manual, computer key commands are indicated by brackets. For example, 
“press [Shift]-[C]” would mean “hold down the [Shift] key and press the [C] key”. 
However, some modifier keys are different on Mac and PC computers, respectively. 
Whenever this is the case, the manual separates the commands with “(Mac)” and 
“(Windows)” indications.

 

Making Settings

 

Since a large part of Reason is laid out like a “real” effect and synth rack, almost all pa-
rameters are designed like their real world counterparts - mixer faders, synth knobs, 
transport buttons, etc. How to make adjustments to these is described separately for 
each type of parameter below:

 

Knobs

 

To “turn” a knob, point at it, click the mouse button and drag up or down (as if the 
knob was a vertical slider). Dragging upwards turns the knob to the right and vice 
versa.

 

D

 

If you press [Shift] and drag, the knob will turn slower, allowing for 
higher precision.

 

You can also adjust the knob precision with the “Mouse Knob Range” setting on 
the General page in the Preferences dialog. This dialog is opened from the Edit 
menu (or from the Reason menu if you are running Mac OS X).

 

D

 

To reset a knob to its default value (usually zero, center pan or similar), 
press [Command] (Mac) or [Ctrl] (Win) and click on it.

 

Sliders

 

To move a slider, click on the slider handle and drag up or down.

 

D

 

You can also click anywhere on the slider to instantly move the handle to 
that position.

 

D

 

If you press [Shift] and drag, the slider will move slower, allowing for 
higher precision.
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Multi Mode Selectors

 

Some parameters allow you to select one of several modes. There are two different 
graphical representations of this in Reason:

 

This type of multi mode selector consists of a button with the different modes listed above. You can 
either click the button to step through the modes or click directly on one of the modes to select it. The 
currently selected mode is indicated by a lit LED.

This type of multi mode selector is a switch with more than two settings. To change mode, click and 
drag the switch, or click directly at the desired switch position (just as when adjusting a slider).

 

Buttons

 

Many modes and functions are controlled by clicking buttons. Many of the buttons in 
Reason have a “built-in” LED or the button itself lights up, indicating whether the but-
ton is pressed or not.

 

Numerical Values

 

In Reason, numerical values are displayed in alphanumeric readouts with “spin con-
trols” (up/down arrow buttons) on the side. There are two ways to change numerical 
values:

 

D

 

By using the up and down buttons on the spin controls.

 

To adjust a value in single steps, click on its up or down arrow button. To scroll a 
value continuously, click on an arrow button and keep the mouse button pressed.

 

D

 

By clicking in the actual alphanumeric display and dragging up or down 
with the mouse button pressed.

 

This allows you to make coarse adjustments very quickly.

 

✪

 

This type of control is also used for some parameters that are not purely 
“numerical” (e.g. reverb algorithms and synth oscillator waveforms).

 

D

 

For the numerical position displays on the transport and in the Inspector 
(see page 74), values are changed in the same way, but you first select a 
value increment (e.g. bars or ticks) by clicking in the corresponding value 
field. 

 

Then you can change the value using the methods outlined previously.

• The position values on the transport panel can also be edited by double clicking 
and typing a new position.

 

Song position and Left/Right locators

 

On the transport panel there are numerical fields that display the song position (both 
in bars. beats, 1/16th notes and ticks as well as in hours, minutes, seconds and milli-
seconds), and the Left/Right locator positions. These all function similarly to other nu-
merical values (spin controls or click-drag), but you make changes for one value at a 
time, e.g. to change the song position from 3.1.1.0 to 5.1.1.0 you click on the bar 
value and make the desired change.

 

Tool Tips

 

If you position the pointer over a parameter on a device panel and wait a moment, a 
tool tip will appear. This displays the name of the parameter and its current value. This 
helps you fine-tune settings, set several parameters to the same value, etc.

 

✪

 

You can turn off these tool tips by deactivating the option “Show Param-
eter Value Tool Tip” on the Preferences-General page.
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Context menus

 

Context menus are “tailored” to contain the relevant menu items only, allowing you to 
work quicker and more efficiently with Reason.

 

D

 

To bring up a context menu, click with the right mouse button (Windows) 
or press [Ctrl] and click (if using a single button mouse on Mac).

 

If you are using a Mac with a two button mouse, you may want to set this up so 
that clicking the right mouse button generates a [Ctrl]-click. This way, you can 
right-click to bring up context menus.

 

The Dr. REX context menu.

 

The contents of the context menu depends on where you click. Basically, the follow-
ing different context menu types are available:

 

Device Context Menus

 

If you click somewhere on a device in the rack (but not on a control), the context menu 
will contain the following items:

• Cut, Copy, Paste and Delete Device items, allowing you to rearrange and manage 
the devices in the rack.

• A Go To submenu, listing all devices connected to the current device. Selecting a 
device from the Go To submenu scrolls the rack to bring that device into view.

• A duplicate of the Create menu, allowing you to create new devices.
• If the device is pattern-based, there will be various pattern functions (Cut/Copy/

Paste, Clear, Shift, Randomize, etc). These affect the currently selected pattern in 
the device.

• If the device uses Patches, there will be functions for managing Patches.
• Depending on the device there may also be various device-specific functions avail-

able. For example, the drum machine device has functions for manipulating the 
pattern for the selected drum sound only, etc.

 

Parameter Context Menus

 

If you click on an automatable control (a synth parameter knob, a fader, etc), the con-
text menu will contain the following items:

• Functions for clearing and editing the recorded automation data for the control.

• Functions for associating computer keyboard commands and/or MIDI messages 
to the parameter (allowing you to remote control parameters from a MIDI device or 
the computer keyboard).

 

“Empty Rack” Context Menus

 

If you click in an empty section of the rack, the context menu will contain the following 
items:

• A Paste Device item, allowing you to paste any copied or cut devices into the rack.
• A duplicate of the Create menu, allowing you to create new devices.

 

Sequencer Context Menus

 

If you click in the sequencer, the context menu will contain items related to editing 
tracks, clips and events. The available items will differ depending on in which area or 
lane you click (Track list, Key Edit lane, etc.), and depending on whether you click on 
an event or not. For example, the sequencer context menus contain functions for in-
serting or removing bars, deleting tracks, changing or deleting events. 

 

Undo

 

Virtually all actions in Reason can be undone. This includes creation, deletion and re-
ordering of devices in the Rack, parameter value adjustments, editing in the se-
quencer and tempo/time signature adjustments. You can undo up to 30 actions.

 

D

 

To undo the latest action, select “Undo” from the Edit menu or press 
[Command]/[Ctrl]-[Z].

 

The action to be undone is indicated next to the Undo command on the Edit menu. 
For example, if your latest action was to delete some device(s) from the Rack, the 
Edit menu will say “Undo Delete Devices”.

 

D

 

To redo the last undone action (“undo the undo operation”), select 
“Redo” from the Edit menu or press [Command]/[Ctrl]-[Y].

 

Similarly, the action to be redone is shown on the Edit menu.
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About Multiple Undos

 

The concept of multiple undos may require an explanation: You can undo up to 30 ac-
tions, or in other words, Reason has an Undo History with up to thirty steps.

Let’s say you have performed the following actions:

 

1. Created a mixer.

2. Created a synth device. 

3. Adjusted the Amp Envelope Attack time on the synth.

4. Changed the panning for the synth device in the mixer.

5. Adjusted the playback tempo in the transport panel.

 

After these five actions, the Undo History will look as follows:

If you now select Undo, your latest action (the tempo change) will be undone, and 
moved to a “Redo list”:

Selecting Undo again undoes the next action in the list (the panning adjustment):

If you now select Redo, the last undone action will be redone. In this case, your pan-
ning adjustment will be performed again (and added to the Undo History again):

At this point, you still have the option to Redo the tempo change. But if you instead 
would perform another action (e.g. change the level of the synth device in the mixer), 
this would become the action at the top of the Undo History - and the Redo list would 
be cleared.

You can no longer redo the undone tempo change!

 

Window Techniques

 

Using more than one Reason Song window

 

You can have several Reason Songs open at the same time. Each will appear in a 
separate Reason window, complete with rack, sequencer and transport bar areas. 
Each window can be moved, minimized and resized using standard Mac/Windows 
procedures. 

 

|
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4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device

 

|
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|
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Views, Panes and Dividers

 

On screen, Reason is divided into different areas or “panes”. The most obvious exam-
ple is the rack and the sequencer area, but you will also find that the right part of the 
sequencer area can be divided into several horizontal lanes (for editing different as-
pects of your recordings).

 

Detaching the sequencer

 

You can detach the sequencer pane and turn it into a separate window. This allows 
you to make the sequencer wider than the rack and use the width of the computer 
screen more effectively.

 

Scrolling and Zooming

 

Reason offers a few different options for scrolling and zooming in the rack and the se-
quencer.

 

Scrolling with the scrollbars

 

Whenever there is information “outside the screen”, horizontal and/or vertical scroll-
bars will appear. For example, if there are more devices in the rack than can be shown 
at one time, you will be able to scroll the rack up or down by using the vertical scroll-
bar to the right of the rack.

 

Scrolling with the Hand tool

 

In the sequencer, you can also use the Hand tool for scrolling the view. Just select the 
Hand tool and click in a lane, keep the mouse button pressed and drag in the desired 
direction.

 

Scrolling the Key edit lane with the Hand tool.

 

✪

 

By holding down [Shift] while you drag however, you can limit the scroll-
ing direction to horizontal or vertical only.

 

Zooming with the magnification sliders

 

Some areas also allow you to zoom in or out using magnification controls. Either click 
the “+” or “–” magnification icon to zoom in or out respectively, or click and drag the 
magnification slider.

 

D Where applicable, different panes can be scrolled and zoomed individu-
ally.

In the sequencer, there are separate view controls for the Key edit lane and the Controller lane.

Zooming with the Magnifying Glass tool

Another way of zooming in the sequencer is to use the Magnifying Glass tool. This 
tool lets you zoom in and out both horizontally and vertically just like the magnification 
sliders do. However, the Magnifying Glass tool offers a few more possibilities. 

The following applies:

D By clicking once in a lane with the Magnifying Glass, you zoom in by the 
same amount as when clicking the “+” icon on the magnification slider 
twice.

D To zoom out with the Magnifying Glass, click while keeping [Option] 
(Mac)/[Ctrl] (Windows) pressed.
You’ll notice that the “+” sign in the Magnifying Glass tool changes to a “-” sign.

D If the lane has a vertical magnification slider as well, clicking with the 
Magnifying Glass will also zoom in/out vertically by the same amount as 
when clicking the“+” and ”-” icons on the magnification slider once.
By holding down [Shift] when clicking, you disable vertical zooming.
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D You can also click and drag with the Magnifying Glass to create a selec-
tion rectangle.
The view will then be zoomed in so that the selected area fills the lane.

Scrolling and zooming with the mouse wheel

If you’re using a mouse equipped with a scroll wheel, this can be used for the follow-
ing scrolling and zooming operations:

D Scrolling up and down in both the rack and in the sequencer.

D By simultaneously holding down [Shift] you can scroll left and right in 
the sequencer.

D By holding down [Command] (Mac)/[Ctrl] (Windows), you can zoom in 
and out vertically in the sequencer.

D By holding down [Shift]-[Command] (Mac)/[Shift]-[Ctrl] (Windows), you 
can zoom in and out horizontally in the sequencer.

Enclosing these notes in a selection rectangle...

...will zoom in so that they fill the view.
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About this chapter
This chapter contains some useful information about how audio is handled by Reason. 
Some of it may seem a bit technical, but we recommend that you read it, to get the 
most out of Reason.

How Reason communicates 
with your audio hardware
Reason generates and plays back digital audio - a stream of numerical values in the 
form of ones and zeroes. For you to be able to hear anything, this must be converted 
to analog audio and sent to some kind of listening equipment (a set of speakers, 
headphones, etc.). This conversion is most often handled by the audio card installed 
in your computer (on the Macintosh you can use the built-in audio hardware if you 
don’t have additional audio hardware installed).

To deliver the digital audio to the audio hardware, Reason uses the driver you have se-
lected in the Preferences dialog. In the rack on screen, this connection is represented 
by the Reason Hardware device.

The Hardware device is always located at the top of the rack. (Usually, it is folded showing only a blank 
panel.)

! If you are using ReWire, Reason will instead feed the digital audio to the 
ReWire master application (typically an audio sequencer program), 
which in turn handles the communication with the audio hardware. See 
the ReWire chapter for details.

The Reason Hardware device contains 64 output “sockets”, each with an indicator 
and a level meter. 32 sockets are shown on the main panel, and an additional 32 
sockets are shown if the “More Audio” button is activated on the main panel. Each 
one of these indicators represents a connection to an output on your audio hardware 
(or a ReWire channel to another application if you are using ReWire).

However, the number of outputs available depends on the number of outputs on your 
audio hardware. For example, if you are using a standard sound card with stereo out-
puts (or the built-in audio hardware on the Mac), only the first two outputs will be avail-
able. In the Hardware device, the indicators are lit green for all currently used outputs. 

In this case, a standard stereo audio card is used, and only the first two outputs (marked “Stereo” on 
the device panel) are available. 

Outputs that are currently used have green indicators, available but unused outputs 
have yellow indicators, and any connections made to unavailable outputs have red in-
dicators.

To send the sound of a device in the rack to a specific output, you route the device 
output to the corresponding “socket” on the Hardware Interface. This is done by us-
ing the patch cables on the back of the rack, as described on page 26. In most cases, 
you will want to connect a mixer device to the Stereo outputs (outputs 1 and 2).

Audio Quality
The general audio quality in a computer based synthesizer system depends on two 
things:

D The quality of the software calculating the audio.

In our case, this is the Reason DSP (Digital Signal Processing) code.

• Reason uses 32-bit floating point arithmetic for all internal audio operations which 
ensures the highest possible resolution throughout the signal chain.

• The program supports 16, 20, and 24 bit audio output.
• The program supports sampling frequencies from 22kHz to 96kHz.
• A number of digital audio techniques are implemented that reduce the risk of 

“aliasing”, background noise, unwanted distortion and “zipper noise”.

There is no technical reason why this program should not sound as good as or better 
than dedicated, professional hardware.

D The quality of the hardware playing back the sound.

In a PC this is the audio hardware installed. In the Mac it is the built in audio controller 
or any audio hardware you have installed.

Don’t be fooled by the “16 bit, 44.1kHz, CD quality” tags. How good some audio 
hardware actually sounds depends on a number of things, its frequency range and fre-
quency response curve, the signal to noise ratio, the distortion under various circum-
stances, etc. Furthermore, some designs are more prone to disturbance from the 
other electronics in the computer than others. Such disturbance might add hum or 
high pitched noise to the signal.

The only advice we can give is that if you are serious about sound, choose your audio 
hardware carefully! 
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About Sample Rates and Resolutions
Sample rate and resolution are properties of digital audio, which determine the quality 
of the sound. Generally, higher sample rate and resolution result in better audio quality 
(but also larger audio files and higher demands on computer performance and audio 
hardware). 

This table shows some common sample rate/resolution combinations:

To cater for all different situations, Reason supports multiple sample rates and resolu-
tions. This applies to the following areas:

Playing back

Reason handles all internal audio processing in 32-bit floating point resolution. How-
ever, the resolution of the output audio is determined by the audio hardware. That is, 
if you have a 24-bit audio card, Reason will create audio in 24-bit resolution, and if you 
have a 16-bit audio card, audio will be in 16-bit resolution.

The playback sample rate can be specified in the Preferences-Audio dialog (ac-
cessed from the Reason menu or Edit menu depending on whether you are running 
Mac OS X or not):

Note that the available options on this pop-up menu depend on which sample rates 
are supported by the audio hardware. Most standard sound cards support 44.1 kHz 
and various lower sample rates, in which case you should select 44.1 kHz for best au-
dio quality.

About using high resolution audio

Reason has the capability to play back samples with practically any resolution. This 
means that if for instance 24-bit samples are loaded in a sampler or the Redrum, play-
back of the samples can be in 24-bit resolution as well. If you are using such samples 
and want Reason to play them back in their original high resolution, proceed as fol-
lows:

1. Open the Preferences from the Edit menu or Reason menu, and select the 
General page.

2. At the bottom of the page, make sure the option “Use High Resolution Sam-
ples” is checked.

If this is activated, and if your audio card supports it, Reason will play back high reso-
lution samples in their original resolution. If this option is not activated, Reason will 
play back all samples in 16-bit resolution, regardless of their original resolution.

Exporting audio

Reason can export audio, i.e. mix down the song or a section of the song as an audio 
file (see page 137 for details). When you do this, you will be asked to specify a reso-
lution (16 or 24 bit) and sample rate (11–96 kHz) for the file.

✪ If you plan to open the exported file in another application, you should 
select a format that is supported by the application. If you’re uncertain, 
16 bit/44.1 kHz is a safe bet.

Importing audio

When loading samples or ReCycle files into the samplers, the drum machine device 
or the loop player, Reason supports files of a large number of sample rates and reso-
lutions. You can use files of different formats in the same device - one drum sound can 
be an 8-bit sample, the next a 16-bit sample, etc.

|Sample rate: |Resolution: |Comment:
22.05 kHz 8 bit Typically used in situations where small file size is 

more important than audio quality, such as games, 
some multimedia applications, sound files on the 
Internet, etc.

44.1 kHz 16 bit This is the format used on standard audio CDs.

44.1 kHz – 
96 kHz

24 bit These are formats used in professional studios 
and high-end recording equipment.
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About Audio Levels
When playing back in Reason, you should keep an eye on the Audio Out Clip indica-
tor on the transport panel. If this lights up, the audio level is too high, resulting in clip-
ping (digital distortion).

D To remedy this, lower the master level on the mixer (or other device) that 
is connected to the Hardware Interface, until Audio Out Clipping doesn’t 
light up on playback. 
You could also use the MClass Mastering Suite combi to ensure that clipping 
never occurs - see page 335.

! Note that it doesn’t matter if the level meters on the individual devices 
(effects, mixer channels, etc.) “hit the red”. Clipping can only occur in the 
Hardware Interface. 

The technical reason for this is that internally, Reason uses high resolution floating 
point processing, which ensures high audio quality and virtually limitless headroom. In 
the Audio Hardware device, the floating point audio is converted to the resolution 
used by the audio hardware, and that’s where clipping may occur.

If you are using multiple outputs
If you are using audio hardware with more than two outputs, you may have different 
devices connected to different outputs in the Hardware Interface. If the Audio Out 
Clipping indicator lights up, you should play back the section again while checking 
the Hardware Interface. Each output socket has a level meter - if the red meter seg-
ment lights up, the output is clipping. Lower the output level of the device connected 
to the clipping output, until no clipping occurs.

If you are using ReWire
If you are streaming audio to another application using the ReWire protocol, clipping 
can not happen in Reason. This is because the conversion from floating point audio 
happens in the other audio application. See page 123 for more information about us-
ing ReWire.

General Information
Master Tune
By default, Reason plays back a “middle A” at 440 Hz, which is the standard tuning in 
most instruments. However, if you are playing Reason together with other instru-
ments, you may want to adjust the tuning:

1. Pull down the Edit menu (or Reason menu under Mac OS X) and select Pref-
erences...

2. Use the pop-up menu at the top of the Preferences dialog to select the Audio 
page.

3. Adjust the global tuning with the Master Tune control.
If you like, you can adjust this during playback. Note that this affects the tuning of 
all sound sources in Reason, including the drum machine and loop player.

About Latency
On any personal computer system, there is a delay between the moment you “ask” 
the hardware to play a sound and when you actually hear it. This delay is referred to as 
the “latency” of the design. This imposes a problem for any system where you want 
real time user input to affect the sound.

! See the “Optimizing Performance” chapter for basic information on ad-
justing output latency!

Why is there latency?

Any audio application creates its audio in chunks. These chunks are then passed on 
to the audio card where they are temporarily stored before being converted into regu-
lar audio signals.

The storage place for these chunks are called “buffers” (an analogy would be a 
bucket brigade, where a number of people each have a bucket, and water is poured 
from one bucket to another to reach its final destination).

The smaller the buffers and the fewer they are, the more responsive the system will be 
(lower latency) However, this will also raise the demands on the computer and its soft-
ware. If the system can’t cope up with moving the data to and from the buffers fast 
enough, there will be problems that manifest themselves as glitches in audio play-
back.

To make things worse, audio playback always competes with other activities on your 
computer. For example, under Windows, an output latency setting that works perfect 
under normal circumstances might be far too low when you try to open files during 
playback, switch over to another program while Reason is playing or simply play back 
a very demanding song.

The indicator will stay lit for a short moment, to make 
it easier to spot.
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What is acceptable?

Normally, hardware synthesizers provide you with a latency of 3 to 7 ms (milliseconds 
– thousands of a second), at least if the instrument is targeted towards a “profes-
sional” audience.

On a regular PC, the latency can vary quite a lot. This is an effect of the fact that com-
puters and their operating systems were created for many purposes, not just playing 
back audio. For multimedia and games, a latency of a 100ms might be perfectly ac-
ceptable, but for playing a musical instrument it is not!

• PC audio cards with a MME driver (see later in this chapter) might at best give you 
a latency of around 160ms.

• The same card with a DirectX driver provides at best around 40ms.
• A card specifically designed for low latency, with an ASIO driver, or the built-in au-

dio controller under Mac OS X can usually give you figures as low as 2-3 ms. This 
is just as good as (or better than) dedicated hardware synthesizers!

Reason’s built in sequencer is not affected by latency!

When Reason’s sequencer is playing back a song, the timing between notes is per-
fect! Once playback of a Reason pattern or song is up and running, latency isn’t a 
consideration at all. The computer clocks the audio between the steps and does this 
with perfect quartz accuracy! The timing is immaculate!

ReWire and Latency

When you run Reason as a ReWire slave, it is the other program, the Rewire master 
that is responsible for actually creating the audio and playing it back via the audio 
card. This means that it is the master program’s latency you will get as a final result.

! When Reason runs as a ReWire slave, what audio hardware you have, 
what driver you use, and settings you have made in the Preferences dia-
log are of no importance at all! All audio hardware settings are then in-
stead done in the ReWire master application!

For information on ReWire, see “Using Reason as a ReWire Slave”.

Reducing latency

There are a few general methods for making sure latency is as low as possible:

D Remove background tasks on your computer.
This might be any background utility you have installed as well as networking, 
background internet activities etc.

D Optimize your songs.
You might run into situations where you have to raise the Output Latency setting 
to be able to play back a very demanding song on your computer. Another option 
would be to actually optimize the song. See “Optimizing Performance” for details.

D Get a faster computer.
This is related to the point above and only required if you find that you need to in-
crease Output Latency because your computer can’t really cope with the songs 
you try to play.
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PC Specific Information
About ASIO DirectX, MME and the Sound Buffer 
setting
There are three ways for Windows to access the audio hardware:

Via an MME (MultiMedia Extensions) driver

This system has been around since Windows 3.0, and it is this type of driver that is 
normally installed in the Control Panel and via Plug’n’Play. Most regular sound play-
back (like when Windows goes “bing” on startup) happens via MME.

• Practically all cards come with an MME driver. If your hardware appears in the Sys-
tem part of the Control Panel, you have an MME driver installed.

• Using audio hardware via an MME driver gives you the longest latency figures.
• Only one program at a time can use audio hardware accessed via MME.

Via a DirectX driver

DirectX is a later system developed by Microsoft to provide developers with more ef-
ficient routines to access audio.

• Not all audio hardware come with DirectX drivers. However, drivers for some hard-
ware are included with DirectX itself.

• Using a DirectX driver gives you a shorter latency, between 40 and 90 millisec-
onds.

! Only use DirectX if you are sure that there is a “certified” DirectX driver 
installed for your audio hardware.

✪ More information about DirectX can be found on Microsoft’s DirectX 
web pages, at www.microsoft.com/directx.

Via an ASIO Driver

Most audio cards designed for serious music and audio use come with ASIO drivers.

• Using a card via an ASIO driver can give latency figures as low as 3ms.
• When you use ASIO, only one program at a time can access the card.

✪ More information about ASIO can be found on Steinberg Media Technol-
ogies’ web pages, www.steinberg.net.

About processors
When you run Reason under Windows, the clock speed of the processor is a major 
factor determining how many devices you can use at the same time. However, there 
are other factors that should be taken into account, and one important such factor is 
“floating point arithmetic performance”.

All audio operations in Reason are done with floating point calculations (counting with 
decimal numbers rather than with non-decimal numbers, integers) to ensure the high-
est possible audio quality. You can get high audio quality on an integer system too, 
but floating point is effective and accurate when it is available.

Intel and AMD processors are fast at floating point mathematics. Some other lower 
priced processor have taken shortcuts which reduce their performance in this partic-
ular aspect. This will have noticeable effect on the performance of the program. Our 
advice is:

✪ If you plan to buy a computer specifically for Reason, you can play it safe 
and choose an Intel or AMD processor. Alternatively, make sure you se-
lect a processor that is renowned for high floating point arithmetic per-
formance!

Mac Specific Information
Under Mac OS X, all communication with most audio hardware can be handled by the 
internal built-in audio controller.

D Other options may be available as well, mainly for compatibility with all 
possible hardware/software configurations.
Use these only when required.
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Introduction
✪ Please refer to the Tutorial chapters in the Getting Started book for 

quick-start information on how to create devices and to select sounds 
and patches.

This chapter deals with the following topics:

D The procedures and techniques for managing devices in the rack.
See below.

D Cable routing basics.
See “A Quick Note on Routing”.

D ReFills and Reason file formats.
See “About ReFills”.

D Handling Patches in Reason. 
See “About patches”.

D Using the Reason browser.
See “Using the Browser”.

Rack device procedures
As you have seen by now, the central part of Reason is the rack. This is where you 
create and configure your devices, and make parameter settings. This section de-
scribes all the procedures for managing the rack, that is, procedures and techniques 
common to all devices. 

Navigating the rack
If the rack contains more than a few devices, the whole rack will probably not “fit” on 
screen. To scroll the rack up or down, use one of the following methods:

D Use the scrollbar to the right of the rack to scroll continuously up or 
down.

D If you’re using a mouse equipped with a scroll wheel, you can use it to 
scroll up or down.

D Use the Page Up/Page Down buttons on the computer keyboard to move 
the view one “full screen” up or down.

D Use the Home or End buttons on the computer keyboard to scroll the top 
or bottom of the rack.

D Pull down a device context menu and select another device from the Go 
To submenu.
The rack scrolls to the device you select.

✪ When you select a device’s sequencer track, Reason will automatically 
scroll the rack to make the device visible. 

Note that you can enlarge the rack area by clicking its lower edge (the divider be-
tween the rack and the sequencer area) and dragging downwards. This will shrink the 
sequencer area and make more of the rack visible (alternatively, you can detach the 
sequencer from the rack altogether. This is described on page 12). You can also 
make the rack fill the window by clicking the maximize button above the scrollbar to 
the right.

The rack maximize button.

Creating devices
Creating new devices can be done by double-clicking on a device in the Tools win-
dow - Devices menu (or by using drag and drop). Alternatively you can select devices 
from the Create menu. This menu is available both on the main menu bar and on the 
context menus (see “Context menus”).

D The new device is added directly below the currently selected device in 
the rack.
If no device is selected, the new device is added at the bottom of the rack.

D When you add a new device, Reason attempts to route it in a logical way.
For an introduction to the auto-routing features, see page 26.

D A new track will automatically be created in the sequencer, connected to 
the new device.
The track will have the same name as the device. Master Keyboard Input will also 
automatically be set to the new track, allowing you to immediately play the created 
device via MIDI (see page 54).

D By default, this only applies to instrument devices, not to mixers or effect 
devices. 
If you hold down [Option] (Mac) or [Alt] (Windows) when you create the device, 
the opposite is true, i.e. mixers and effect devices get new tracks but instrument 
devices don’t.

✪ You can also create devices by browsing patches - see page 39.
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Selecting devices
Some operations (e.g. cutting, copying and deleting devices) require that you select 
one or several devices in the rack. This is done according to the following rules:

D To select a single device, click on it in the rack.
The selected device is displayed with a colored border (based on the color 
scheme selected for your operating system).

D To select several devices, hold down [Shift] and click.
In other words, [Shift]-clicking a device selects it without de-selecting any other 
selected devices.

D To de-select all devices, click in the empty space at the bottom of the 
rack.

D To de-select one of the selected devices, hold down [Shift] and click on 
it.
Any other selected devices remain selected.

D You can also use the up and down arrow keys on the computer keyboard 
to select the device directly above or below the currently selected one.
When you use this method, Reason will automatically scroll the rack so that the se-
lected device is fully visible. This is a quick way to “step through” the rack. Narrow 
devices (e.g. half-width devices such as the effects) are ordered left-to-right, i.e. 
pressing the down arrow key will step through the devices from left to right before 
moving on the next device row.

D If you hold down [Shift] when using the up or down arrow keys, the cur-
rently selected device will remain selected.
This allows you to select a range of devices.

Adjusting a parameter in a device will automatically select it. In other words, you never 
have to select a device before making settings.

Deleting devices
To delete one or several devices, select them and use one of the following methods:

D Hold down [Command] (Mac) or [Ctrl] (Windows) and press [Backspace] 
or [Delete].

D Select “Delete Devices and Tracks” from the Edit menu or the device 
context menu.
This will delete the device(s) together with the associated sequencer track(s). You 
can have devices without associated tracks but it is not possible to have a se-
quencer track without an associated device.

! If you delete a device connected between two other devices, the connec-
tion between these is automatically preserved.

! The Hardware Interface device at the top of the rack cannot be removed.

Reordering devices
You can rearrange the devices in the rack by moving them, in the following way:

1. If you want to move more than one device at the same time, select the de-
vices.

2. Click in the “handle” area of one of the devices.
For full width devices, this is the area to the left and right of the panel (between the 
rack fittings); for smaller devices you can click anywhere outside the actual param-
eters.

3. With the mouse button pressed, drag the device(s) up or down in the rack.
A thick red vertical line indicates where the device(s) will be positioned. Note that 
the red line can be to the left of a device (indicating that the moved device will be 
inserted before the other device) or to the right of a device (indicating that the 
moved device will be inserted after the other device). 
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In this example an RV-7 reverb device is moved:

4. Release the mouse button.
The device(s) are moved to the new position and the other devices in the rack are 
adjusted to fill up the “gaps”.

! Note that if you start to move a device but change your mind, you can 
abort the operation by pressing [Esc] while keeping the mouse button 
pressed.

D If you hold down [Shift] when you move a device, Reason will attempt to 
automatically re-route it.
See page 26 for more info on auto-routing.

! Moving devices in the rack does not affect the order of the sequencer 
tracks and vice versa.

Duplicating devices
To make a copy of a device in the rack, hold down [Option] (Mac) or [Ctrl] (Windows) 
and drag it to a new position.

D If you hold down [Shift] when you duplicate the device, Reason will at-
tempt to automatically route it, just as when you move devices.
See page 26.

Cut, Copy and Paste
Selected devices can be moved or duplicated using the Cut, Copy and Paste Device 
functions on the Edit menu or device context menu. For example, this allows you to 
copy one or several devices (such as an instrument device and all its insert effects) 
from one Reason Song to another. The following rules apply:

D Cut and Copy affects all selected devices, and work according to the 
standard procedures.
That is, Cut moves the devices to the clipboard (removing them from the rack) 
while Copy creates copies of the devices and puts these on the clipboard, without 
affecting the rack.

D When you Paste devices, these are inserted into the rack below the cur-
rently selected device.
If no device is selected, the pasted devices will appear at the bottom of the rack.

D If you Copy and Paste several devices, the connections between these 
are preserved.

D If you hold down [Shift] when you Paste a device, Reason will attempt to 
automatically route it. 
The rules are the same as when moving or duplicating devices by dragging. Auto-
matic and manual routing is described in the chapter “Routing Audio and CV”.

In this case, the red line indicates that the reverb device will be inserted to the left of the phaser.

This is the result. Note that the filter device is moved to the left, to fill out the gap.

In this case, the red line indicates that the reverb device will be inserted to the right of the chorus/
flanger. 

This is the result. All three devices are moved to the left, to fill out the gap.
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Naming devices
Each device has a “tape strip” showing the name of the device. When you create a 
new device it is automatically named according to the device type, with an index num-
ber (so that the first Subtractor synthesizer you create is called “Subtractor 1”, the 
next “Subtractor 2” and so on). If you like, you can rename a device by clicking on its 
tape strip and typing a new name (up to 16 characters).

For devices connected to a mixer, the device names are automatically reflected on the 
vertical tape strips for the corresponding mixer channels (next to the mixer channel 
faders). Similarly, tape strips below the Return knobs show the names of the effect 
devices connected to the corresponding Return inputs.

Note that the mixer channel tape strips show the name of the device directly con-
nected to the mixer! This means that if you have an instrument device routed through 
an insert effect, the mixer channel tape strip will show the name of the insert effect de-
vice (as this is the device directly connected to the mixer channel). In this case, you 
may want to rename the insert effect device, to indicate the connected instrument.

The relation between device names and track names

When you create an instrument device, it automatically gets a track in the sequencer, 
with the same default name. Renaming a device will also rename the corresponding 
sequencer track, and vice versa.

Folding and unfolding devices
If you don’t need to make settings for a device, you can fold it to make the rack more 
manageable and avoid having to scroll a lot. This is done by clicking the arrow to the 
left of the device.

To unfold the device, click the arrow again.

D In rack rows with devices of smaller width, the fold/unfold arrow is 
placed to the left of the leftmost device and affects all devices in the row.

D If you hold down [Option] (Mac) or [Alt] (Windows) and click the arrow of 
an unfolded device, all devices in the rack will be folded.
Conversely, [Option]/[Alt]-clicking the arrow of a folded device will unfold all de-
vices.

D For folded devices, no parameters are shown and you cannot make rout-
ing adjustments on the backside of the rack as long as the devices are 
folded.
However, if you want to make a connection to a folded device, you can drag a ca-
ble to it and hold it there for a moment. This will cause the folded device to auto-
matically unfold and let you make the connection.
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D Folded devices can be renamed, moved, duplicated and deleted just like 
unfolded devices. 

D For devices that use patches, you can select patches in folded mode as 
well.

D Playback is not affected by folding.

A Quick Note on Routing
! This section only describes the basics in routing. For detailed descrip-

tions of routing procedures and possibilities, see the “Routing Audio and 
CV” chapter.

Reason allows for extremely flexible routing of audio and control signals between the 
devices in the rack. Basically, routing can be done automatically or manually:

Automatic Routing
Auto-routing means that Reason makes all basic audio connections for a device, in 
one go. As mentioned on the previous pages, auto-routing is automatically performed 
when you create a new device, and when you move, duplicate or paste devices with 
[Shift] pressed. 

✪ If applicable, auto-routing is automatically done in stereo.

Creating Mixers

D The first created mixer device will be routed to the Stereo inputs on the 
Hardware Device.

Routing a device to the Mixer

D When you create an instrument device (synth, sampler, drum machine or 
loop player) it is automatically routed to the first available mixer channel.
This makes it immediately available for use.

Routing a Send Effect to the Mixer

D When you have a mixer selected and create an effect device, it will be 
connected as a send effect (to the first free Aux Send/Return).
Examples of effects that lend themselves well for use as send effects are reverb, 
delay and chorus.

Routing an Effect directly to a device (Insert)

D When you have an instrument device selected and create an effect, that 
effect will be connected as an insert effect. That is, the signal from the 
device will pass through that effect and to the mixer.
Examples of effects that work well as inserts are distortion, compression and 
phaser.
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Routing an Insert Effect between the Hardware Interface and 
another device

D If you select the Hardware Interface and then create an effect, the effect 
will be connected as an insert effect between the Hardware Interface and 
whatever device was connected to the Hardware Interface inputs (nor-
mally the outputs of a a Mixer device).
This is the intended way to connect the MClass Mastering Suite Combi, at the 
very end of the signal chain.

Auto-routing Devices after they have been Created

Here follows some additional rules about auto-routing devices that are already in the 
rack:

D To reroute a device already in the rack, you can select it and use Discon-
nect Device and Auto-route Device, both on the Edit menu.

D If you delete a device connected between two devices, the connection 
between the two remaining devices is automatically preserved.
A typical example would be if you have an effect device, connected as an insert ef-
fect between a synth and a mixer. If you delete the effect, the synth will be routed 
directly to the mixer.

D When you move a device, connections are not affected.
If you instead would like the program to re-route the device according to its new 
location in the rack, hold down [Shift] when you move it.

D When you duplicate devices (by dragging) or use copy and paste, the de-
vices are not auto-routed at all.
If you would like them to be automatically routed, hold down [Shift] when you per-
form the operation.

Manual Routing
To connect devices manually, you need to flip the rack around to see the back. This is 
done by pressing [Tab] or selecting “Toggle Rack Front/Rear” from the Options 
menu.

On the back of each device you will find connectors of two different types: audio and 
CV (Control Voltage, used for controlling parameters - see “Using CV and Gate”). Au-
dio inputs and outputs are shown as large “quarter inch” jacks, while CV input and 
output jacks are smaller. For now, we stick to audio connections.

! When the back is shown, you can still navigate in the rack by scrolling, by 
using the computer keyboard, etc. 

There are two ways to route audio from one device to another: by connecting “virtual 
patch cables” between inputs and outputs, and by selecting connections from a pop-
up menu:

Audio connectors

CV connectors
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Using Cables

! For the cables to be visible, the option “Show Cables” must be activated 
on the Options menu. See below.

1. Click on the desired input or output jack on one of the devices, and drag the 
pointer away from the jack (with the mouse button pressed).
A loose cable appears.

2. Drag the cable to the jack on the other device.
When you move the cable end over a jack of the correct type (audio/CV, input/out-
put) it will be highlighted to show that a connection is possible. 

3. Release the mouse button.
The cable is connected. If both input and output are in stereo and you connect the 
left channels, a cable for the right channel is automatically added.

! Dragging a cable to make a connection can be aborted by pressing [Esc] 
while keeping the mouse button pressed.

✪ To give a better overview of the connections, the cables have different 
colors. Connections to or from effect devices are different shades of 
green, other audio connections are different shades of red and CV con-
nections are different shades of yellow.

D You can change an existing connection in the same way, by clicking on 
one end of the cable and dragging it to another connector.

Using pop-up menus

1. Click (or right-click) on a connector.
A pop-up menu appears, listing all devices in the rack. 

2. Move the pointer to the desired device (the device to which you want to cre-
ate a connection).
A submenu appears, listing all suitable input/output connections. For example, if 
you clicked on an audio output on a device, the hierarchical submenus will list all 
audio inputs in all other devices.

D If a device is greyed out on the pop-up menu, there are no connections of 
the suitable kind.

3. Select the desired connector from the submenu.
The connection is created.

Disconnecting Devices
Again, there are two ways to disconnect devices:

D Click on one end of the cable, drag it away from the jack and drop it any-
where away from a jack.

or 

D Click on one of the connectors and select “Disconnect” from the context 
menu that appears.These cables are green, indicating effect device 

connections.

This cable is 
yellow, indicating a 
CV connection.

These cables are red, 
indicating connections 
between instruments and 
mixer devices.
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Hiding and Showing Cables

You can choose whether you want the patch cables to be visible or not, by activating 
or deactivating the Show Cables item on the Options menu. When the cables are hid-
den, connectors in use are indicated by a colored dot:

Checking Connections

You can check to which device a jack is connected. This is especially useful if the 
patch cables are hidden, but it is also practical if you have a lot of cables or if the two 
devices are far from each other in the rack: 

D Position the pointer over a connector and wait a moment.
A tool tip appears, showing the device and connector in the other end.

About patches
A Reason patch contains settings for a specific device. Patches can either be sepa-
rate files on your hard disk or files embedded in a ReFill - see page 32 for info about 
ReFills.

Nine device types use patches:
D Subtractor, Thor and Malström synth patches contain all settings on the 

device panel.
Selecting a patch brings up a new sound, just like when selecting programs or 
patches on a hardware synthesizer.

D NN19 & NNXT sampler patches contain information about which samples 
are used and their settings (key mapping, tuning, etc.), plus the parame-
ter settings on the device panel.
It is important to note that the sampler patch doesn’t contain the actual samples - 
only information about which sample files are used.

D Redrum drum computer patches contain a complete “drum kit”, that is, 
information about which drum samples are used, together with the pa-
rameter settings for each drum sound.
Again, the actual samples are not included in the patch, only file references. Also 
note that Redrum patches are separated from Redrum patterns - selecting a new 
patch will not affect the patterns in the device.

D Scream 4 and RV7000 effect patches contain all settings on the respec-
tive device panel.
Selecting a patch brings up a new sound, just like when selecting programs or 
patches on a hardware effect device.

D The Combinator (Combi) patch format saves all settings and file refer-
ences for each device in the Combi, along with the Combinator’s own 
settings; key/velocity zones, modulation routing etc.
Any audio or CV routing from/to devices that are part of the Combi is also saved. 

! Note that patches for devices included in a Combi are not saved individ-
ually - e.g. if a Combi includes a Subtractor, and you have tweaked its 
settings, these settings will be saved with the Combi, but will not be 
saved as a separate Subtractor patch unless you do so from within the 
Combi - see page 30.

! Apart from Combis, patches do not include information about any rout-
ing done on the back of the device. 
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About the “Load Default Sound in New Devices” preference

On the Preferences - General page there is an option (on by default) to load a default 
patch when creating a device. There are a number of patches for each device that ex-
ist outside category folders in the main Factory Soundbank folder for the device. 
These will be available on the browse list (see page 40) directly after creating a new 
device which allows you check out a few sounds for a device without opening the 
browser.

Selecting a patch 
To select a patch for a device, use one of the following methods:

D Click the folder button in the Patch section on the device panel.
The Patch section has the same basic layout for all patch devices; a Patch name 
display, and three buttons (up/down arrow buttons for stepping through patches 
sequentially, a Folder button to open the browser, and a Save patch button.

The Patch section of a Redrum device.

! Note: On the panels of the Redrum, NN19 and NNXT devices, there are 
also other folder buttons, used for loading samples. Make sure you click 
on the button in the Patch section (next to the patch name display)!

D Select the Browse Patches item on the Edit menu or device context 
menu.
Note that the Edit menu reflects which device is selected - in other words, you 
must select the device for the corresponding Browse Patches item to appear on 
the Edit menu.

D In both cases, the Patch browser dialog appears, allowing you to locate 
and select the patch, on the hard disk or within a ReFill. 
Browser operations are described later in this chapter, starting on page 33.

D Once you have selected a patch, you can step between all the patches in 
the same folder by using the arrow buttons on the device panel.
Note that switching patches on a device in this way can also change the actual de-
vice! See “About browse lists” on page 40.

D If you click on the patch name display on the device panel, a pop-up 
menu will appear, listing all patches in the currently selected folder - see 
“About browse lists” on page 40).
This allows you to quickly select another patch, without having to step through 
each one in turn.

When you select a patch, the device’s parameters will be set according to the values 
stored in the patch, and the name of the patch will be shown in the patch name dis-
play. As with any change you make, this operation can be undone (see page 10).

! Any parameter adjustments you make on the device panel after selecting 
a patch will not affect the actual patch file (for this you need to save the 
patch - see below).

If referenced samples are missing
As described above, patches for the Redrum, NN19 and NNXT contain references to 
samples. Just like patches, samples can be independent files on the hard disk or ele-
ments within a ReFill. However, if sample files have been moved or renamed after a 
patch was saved, the sample file references in the patch will not be accurate.

If this is the case when you select a patch, the program will tell you so. You can then 
choose to either manually locate the missing files, to have the program search for 
them or to proceed with missing sounds. For details, see page 41.

! Proceeding without locating or replacing the missing samples results in 
silent drum sounds and key zones (for the Redrum and NN19/NN-XT, re-
spectively).

Saving Patches

Saving device settings in a song

When you save a Reason song, all settings for all devices are automatically included 
in the song file - there is no need to save the patches separately.

! It’s important to realize that it’s the actual settings that are saved in the 
Song - not references to patches on disk. The next time you open the 
song, all devices will be set as they were when you saved (regardless of 
whether you have removed or edited any patches on disk).
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Saving device settings as patches on disk

Even though the device settings are stored in the song, you may want to save any set-
tings you have made for a device as a separate patch file. This allows you to use the 
patch in other songs, and lets you try out other patches in your song without risking to 
lose your sound.

1. Click the floppy disk button on the device panel.

✪ You can also select a device and use the Export Patch command on the 
File menu.

2. In the file dialog that appears, specify a location and name for the patch file 
and click Save.

D Under Windows, the different types of patch files have different file ex-
tensions.
File extensions are automatically added by Reason when you save. Under Mac 
OS, file extensions are not needed but it may be a good idea to keep them if you 
want the saved files to be usable under Windows.

D If you have selected a patch, modified it and want to save it with the mod-
ifications, you could either save a separate, modified version of the patch 
(with a new name) or simply overwrite the old patch file on disk.
As usual, you will be asked whether you really want to replace the existing patch 
file. 

! Note that you can save a patch under the same name and location with-
out having the save dialog appear by holding down [Option] (Mac)/[Alt] 
(Windows) and clicking the floppy disk button on the device panel. Be 
aware that this overwrites the original patch!

! Note also that you cannot save into a ReFill! This means that if you have 
opened a patch from within a ReFill, modified it and want to save it, you 
need to save it as a separate file. Preferably, you should also rename the 
modified patch file, to avoid confusion.

Copying and Pasting Patches between Devices
A quick way to transfer settings between devices of the same type is to use the Copy 
and Paste Patch functions. The result is exactly the same as if you had saved a patch 
on one device and opened this patch on another device - this is just a quicker method.

! Copying and Pasting settings is possible with all instrument device 
types, except the Dr. Rex Loop Player.

Proceed as follows:

1. Select a patch, and/or make the desired settings on the first device.

2. Select Copy Patch from the device context menu or the Edit menu.

3. Select the other device of the same type (in the same song or another song).

4. Select Paste Patch from the device context menu or the Edit menu.
The settings of the first device (including Redrum and NN19/NNXT sample refer-
ences) are applied to the second device.

! Note that this operation simply copies the settings from one device to 
another. Adjusting the settings on one of the devices will not affect the 
other; neither are the settings connected to any patch file on disk.

Initializing Patches
Sometimes it is useful to start with a “clean slate” when creating a synth sound, a 
drum kit or a sampler patch. This is done by selecting Initialize Patch from the device 
context menu or Edit menu. This sets all parameters to “standard” values. Initializing 
NN19, NNXT, Dr. Rex or Redrum devices will also remove all sample file references, 
allowing you to start from scratch.



SOUNDS, DEVICES AND PATCHES
32

About ReFills
A ReFill is a kind of component package for Reason which can contain patches, sam-
ples, REX files, Soundfonts and demo songs. If you like, you could compare ReFills to 
ROM cards for a synthesizer. On your computer, ReFills appear as large files with the 
extension “.rfl”.

All sounds included with Reason are embedded in two ReFills; “Reason Factory 
Sound Bank” and “Orkester”, which were both copied to the Reason Program folder 
during installation. 

Additional Propellerhead ReFills are available for purchase. You can also download 
ReFills from other Reason users on the Internet, purchase them from other sample 
manufacturers, etc.

✪ Samples (Wave and AIFF files) are compressed to about half their origi-
nal file size when stored in ReFills, without loss of quality.

In Reason, you can use the browser to list and access the embedded sounds and 
other components within the ReFills, just as if the ReFills were folders on your hard 
disk. 

Furthermore, if a song makes use of components from ReFills, Reason will tell you 
which ReFills are required.

Reason File Formats
The following table lists the file formats that you can browse and open using Reason’s 
browser:

|File type |Extension |Description
Song .rsn This is the main document format in Reason. It 

contains your music and the setup of the rack, 
along with references to any used samples and 
loops (or it can contain the actual samples and 
loops, if you have made the song “self-con-
tained”).

Published Song .rps A published song is a self-contained song in-
tended for playback only. It cannot be changed, 
its components cannot be extracted and it is not 
possible to export it as an audio file.

Combinator Patch .cmb The Combinator can store/recall combinations of 
Reason devices. Combinator patches (Combis) 
will save all panel settings (as well as sample ref-
erences if used) for all devices that are part of the 
Combi. In addition, all routing (audio/CV) be-
tween devices in the Combi are included in the 
patch.

Subtractor Patch .zyp This is a patch for the Subtractor synth device, 
containing all panel settings. You store your synth 
sounds by saving Subtractor patches.

Thor Patch .thor This is a patch for the Thor synth device, contain-
ing all panel settings. You store your synth 
sounds by saving Thor patches.

Malström Patch .xwv This is a patch for the Malström synth device, 
containing all panel settings. You store your synth 
sounds by saving Malström patches.

NN19 Sampler 
Patch

.smp This is a patch for the NN19 Sampler device, 
containing references to and settings for all used 
samples, along with panel settings.

NN-XT Sampler 
Patch

.sxt This is a patch for the NN-XT Sampler device, 
containing references to and settings for all used 
samples, along with panel settings.

Redrum Patch .drp This is a patch for the Redrum drum machine de-
vice. It contains information about which drum 
samples are used, along with all drum sound set-
tings. In effect, a Redrum patch is a stored drum 
kit.

RV7000 Patch .rv7 This is a patch for the RV7000 reverb effect, con-
taining all panel settings.

Scream 4 Patch .sm4 This is a patch for the Scream 4 distortion effect, 
containing all panel settings.

REX files .rx2, .rcy or 
.rex

REX files are created in another Propellerheads 
application, the ReCycle loop editor. They con-
tain audio loops chopped into slices, with one 
slice for each significant beat in the loop. By load-
ing a REX file into the Dr. Rex Loop Player device, 
you can play back the loop in virtually any tempo 
(without affecting the pitch), manipulate individual 
beats in the loop, extract timing info, etc.
Note that you can also load REX files into the 
samplers and the Redrum drum machine.

Samples .wav or .aif The NN19 Sampler and the Redrum drum ma-
chine play back samples, in Wave or AIFF format 
with support for a large number of resolutions and 
sample rates. You can use files of different for-
mats in the same device - one drum sound can be 
an 8-bit sample, the next a 16-bit sample, etc.

|File type |Extension |Description
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Using the Browser

The Browser is a special file dialog that appears when you open songs or load 
patches, samples, MIDI or REX files, from within a ReFill or from regular file folders. 

Apart from standard file folder browsing, the browser dialog offers you several useful 
functions:

D Search for files by name and/or type - see page 39. 

D Use “cross-browsing” to search for patches belonging to any type of de-
vice.
For example, you open the browser from a Subtractor device to browse for a suit-
able patch. But instead of limiting the Browser to show only Subtractor patches, 
you can chose to browse for any type of instrument patch. If you select a patch 
with a different format than the device you “started” browsing from, the original de-
vice will be replaced by the new device. See page 38.

D Create Favorite Lists containing shortcuts to your Favorite files for in-
stant access.
See page 40.

D Audition instrument patches, audio samples and loops on the fly.

D Save shortcuts to various locations on your local drive(s).
See page 37.

Soundfont Bank .sf2 The Soundfont format was co-developed by E-mu 
Systems and Creative Technologies and is used 
with many audio cards and software synthesizers. 
SoundFont banks store wavetable synthesized 
sounds, allowing users to create and edit multi-
sampled sounds in special Soundfont editing 
programs. The Soundfonts can then be played 
back in wavetable synthesizers, typically on audio 
cards, thereby effectively turning an ordinary 
sound card into a sampler.
The NN-XT and NN19 Samplers and the Redrum 
drum machine allow you to browse and load 
Soundfonts. Regardless of which editing pro-
gram was used to create them, these banks are 
similarly and hierarchically organized, with folders 
for instruments, presets, samples etc. The NN-XT, 
NN19 and the Redrum lets you load individual 
samples and presets from a Soundfont bank, but 
not the complete Soundfont.

|File type |Extension |Description



SOUNDS, DEVICES AND PATCHES
34

Opening the browser
You can use any of the following commands to open the Browser dialog (what file 
types you can browse for depends on which method you used to open the Browser 
dialog):

D By selecting “Open” from the File menu.
This opens the Song Browser where you can select to open a saved Song. 

D By selecting “Browse Patches” on the Edit menu with a patch device se-
lected (or by clicking the “Browse Patches” button on a device panel).
This opens the Patch Browser allowing you to browse patches for the selected 
device. You can also use “cross-browsing” (see page 38) to select patches for 
other device types.

D By selecting “Browse Samples” on the Edit menu with a sample device 
selected (or by clicking the “Browse Samples” button on a device panel).
This opens the Sample Browser, where you can browse for samples in the sup-
ported audio formats. 

D By selecting “Browse ReCycle/REX Files” on the Edit menu with a Dr. 
Rex Loop Player selected (or by clicking the “Browse Loops” button on a 
device panel).
This opens the REX File Browser, allowing you to browse for REX loops.

D By selecting “Import MIDI File” from the File menu.
This opens the MIDI File Browser, allowing you to browse for MIDI files.

D By selecting “Create Instrument...” or “Create Effect...” from the Create 
menu.
This allows you to browse patches for any device. When you select a patch in the 
browser (without clicking “OK” in the browser dialog), the corresponding device is 
automatically created in the background, together with a corresponding se-
quencer track if an instrument patch is selected. See page 39.

Browser elements

The Patch Browser dialog.

Regardless of what browser mode is chosen (song/patch/sample etc.), the Browser 
dialog basically contains the same main elements, although items may be grayed out 
if not applicable. The dialog contains the following elements:

File and folder list

This is the main browser list, showing the contents in a selected root folder - see page 
36.
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Show pop-up menu

This is only available in the Patch browser (it is otherwise grayed out). It determines 
what patch types are shown in the files and folder list view and thus which patches 
can be selected. See page 38.

Where pop-up menu

The field above the file and folder list displays the name of the currently selected root 
folder. 

• By clicking in the field a pop-up menu is shown, allowing you to move up in the 
folder hierarchy (search results and Favorites lists, however, are shown as “flat” 
lists with no folder hierarchy).

Back/Forward buttons

These arrow buttons allow you to move between the browser locations opened while 
browsing, much like pages in a web browser. When the browser dialog is closed, the 
location list is cleared.

Locations list

This is a list of shortcuts to different locations. You can manually add any locations (on 
any local drive) to this list.
Selecting an item in this list will open the corresponding folder/ReFill as the root in the 
main files and folder list - see page 36.

Favorites section

In the Favorites section of the dialog you can create folders containing shortcuts to 
patches, samples or song files - see page 40. 

Search pop-up and text field

These items allow you to specify a search location and to enter a text string to search 
for, respectively. The Search function is described on page 39.

Info and details



SOUNDS, DEVICES AND PATCHES
36

The Info section in the left corner can show Song/ReFill splash images and the De-
tails section will show information about the item currently selected in the file and 
folder list. Exactly which information is shown depends on the file type. For example, 
samples or REX files contains information about the file format and length of the se-
lected file, while a selected song file can display comments from the author (Song In-
formation, see “Song Information”), etc. If the selected file is part of a ReFill, this will 
be indicated regardless of the file type. 

Audition section

This section contains controls for auditioning samples and REX files - see page 37.

Select Previous/Next arrow buttons

These buttons allow you to move the current file selection up or down in the list. In the 
Patch or Sample Browser, a selected file (patch or sample) is automatically loaded in 
the background.

Loading indicator

This icon will light up to indicate that a patch or sample is loading. You cannot play or 
audition the sound until it is loaded.

Navigating in the Browser

Here, the Patch Browser was opened from a Subtractor device, allowing you to browse for Subtractor 
patches.

When navigating in the Browser, items are shown as a hierarchical list in a selected 
root folder, just like in your computer finder. 

All folders and subfolders within a root folder are shown, but only files of the relevant 
type (i.e. songs/samples/patches etc.) can be viewed/selected in the Browser. For ex-
ample, if you have selected to browse samples for a NN-XT device, only audio sam-
ples will be shown in the Browser. 

• Click on the plus sign (Win)/arrow (Mac) beside a closed folder to open it. If the 
folder contains files of the relevant type, these will be shown.

• Double-clicking a folder in the list opens it as the root folder in the Browser.
• The Name, Modified, and Size columns show the name of the folder or file, the 

modified date (files only) and the size (files only), respectively. Clicking on a col-
umn header sorts the files accordingly (i.e. alphabetically, by date saved or by file 
size).

• You can use the Back/Forward buttons to move between different locations you 
have opened in Browser. When you close the Browser this location list is cleared.

• The “Select Previous/Next” arrow buttons allow you to move between files in the 
current list. Folders are skipped.

• The “Where” pop-up list allows you to move up in the folder hierarchy when the 
Browser points to a specific folder location (see “About hierarchic and flat lists” 
below). 



SOUNDS, DEVICES AND PATCHES
37

About hierarchic and flat lists

In certain circumstances the Browser will display a flat list without any folder hierar-
chy. In such cases there will be an extra “Parent” column displaying the parent folder 
location for all files. The “Where” pop-up will then contain a shortcut to a selected 
file’s parent folder. Flat lists are shown in the following cases:

• When the Browser is showing a search result - see page 39. 
• When the Browser is showing a Favorites folder list - see page 40.
• When the Browser is showing a browse list stored for a device in a saved song - 

see page 40.

Using Locations
To help you to find your files quickly, you can add shortcuts to the folders used to 
store your samples, patch files etc. to the list in the Locations section. By default, the 
Locations list contains five fixed locations; the computer Desktop, the Documents 
folder, the Reason Program folder and the Factory/Orkester Sound Banks.

D Selecting a Location in the list opens it as the root folder in the Browser.

D To add a location, select a folder or ReFill in the main browser list and 
drag it into the Locations list with the mouse button pressed.
Any new locations will be added below the list of fixed locations. Manually added 
locations can be reordered by drag and drop.

D To remove a location, select it in the Locations list and press [Back-
space].
The default locations cannot be removed.

D Manually added locations are stored in the Preferences.

! If a stored location has been removed or is unavailable, a warning trian-
gle with an exclamation mark is shown before the location name in the 
list.

Selecting and auditioning patches
In the Patch Browser, selecting a patch automatically loads it in the background (i.e. 
with the Browser dialog still open). This allows you to preview patches before confirm-
ing a selection by clicking OK in the Browser. 

• Play a few notes when selecting a new patch to audition it. 
• For effect patches you can activate loop playback before opening the Patch 

Browser from the effect. Once the Browser dialog is open, you can browse to a 
folder containing compatible patches and step through them to hear how the 
patches affect the sound.

✪ You can also audition patches for any instrument or effect device - not 
just the device you opened the browser from! See “Cross-browsing patch 
files” on page 38.

Selecting and auditioning samples
For samples and REX loops you can use the Audition controls to preview the audio.

This is done in the following way:

D Select the file in the file list and click the Preview - Play button to the 
right.
The file is played back. During playback, the Play button in the Audition section is 
relabeled to “Stop” - click this to stop playback.

D You can also activate the Autoplay checkbox and simply select the file 
you want to audition.
The selected file is automatically played back. Again, click the Stop button to stop 
playback.

About browsing large patches

As stated previously, when you are browsing patches (or samples), these are auto-
matically loaded in the background when selected. Most of the time, this happens in-
stantaneously. Bear in mind, however, that some files (especially big Combinator 
patches, which can contain any number of devices and samples) can take a little while 
to load.

✪ If you select a particularly large patch by mistake, you can abort the load-
ing by simply selecting another patch.

Selecting multiple files
It is possible to select multiple files in the Browser, by using standard [Shift] or [Ctrl] 
(Win)/[Command] (Mac) selection techniques. This, however, does not mean that the 
selected files can be loaded. 
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There are basically two instances where selecting several files in the Browser file list 
is relevant:

D It is possible to load several samples simultaneously into the NN-XT and 
NN19 sampler devices.
See the NN19 and NN-XT chapters for details.

D You can select several files to add them to a Favorites list in one go - see 
page 40.

! In cases where several selected files (e.g. patches or songs) cannot be 
loaded, the OK button in the Browser is grayed out.

Cross-browsing patch files
Cross-browsing patches is a powerful feature of the Patch Browser. It allows you to 
browse for any type of patch (instrument or effect - see below), regardless of which 
device you opened the Browser from.

About instrument and effect patches

Patches are internally divided into two patch categories in the Browser; instrument 
patches and effect patches (the Browser “knows” what type of patch it is). 

This is because instrument patches and effect patches are fundamentally different - 
instruments are played, and effects are used to process sound - and you would logi-
cally browse for one or the other, but not both.

When browsing patches from an existing instrument device, the options on the Show 
menu are:

• “XXX Patches” (where XXX is the device type you opened the Browser from, e.g. 
NN-XT).

• “All Instruments” will show patches for any instrument device. 

When browsing patches from an existing effect device, the options on the menu are:

• “XXX Patches” (where XXX is the device type you opened the Browser from, e.g. 
RV7000).

• “All Effects” will show patches for any effect device that uses patches, including 
Combi patches.

Cross-browsing - an example:

1. You are playing a Subtractor device but feel that the sound isn’t quite what 
you had in mind, so you open the Browser to check out some other patches.

2. After browsing Subtractor patches for a while, you still haven’t found the type 
of sound you wanted, so you click the “Show” pop-up and select “All Instru-
ments” from the menu.
Now you can select instrument patches for any device. You decide to browse a 
folder containing Malström patches. You can use the Previous/Next buttons to 
step through the files in the selected folder.

3. As soon as you select a Malström patch in the Browser, a Malström device 
replaces the Subtractor in the background (the Browser is still open).
The sequencer track which was previously connected to the Subtractor is now 
connected to a Malström with the patch selected in the Browser loaded. 

D Note that the name of the sequencer track is not automatically changed 
to reflect the new device. 
This may or may not matter. If the track was named “Bass” (and it is a bass sound 
you are looking for), this obviously works fine. But if the track was named “Subtrac-
tor 1” and you end up with another device connected, it might be better to rename 
the track to avoid confusion.

4. You can continue to browse patches and play your keyboard to audition 
them.
Each time you select a patch type belonging to a different device, a corresponding 
instrument device is created in the background, replacing the previous instrument.

5. When you have settled on a patch - for whatever instrument device - click OK 
to confirm the selection and close the dialog.
Clicking Cancel will return to the same state as when opening the Browser.

D If you use cross-browsing for an effect patch it works in the same way - 
selecting an effect patch of a different format will replace the current ef-
fect in the background with a device of the selected format.

Special instances of cross-browsing

There are a few instances when replacing an existing device by browsing might lead 
to lost connections:

D When a device is replaced by another device type, audio connections 
may be lost. 
An example is replacing an NN-XT (which can use up to 16 outputs) with a Sub-
tractor (which only has one output). 

D When a device is replaced by another device type, CV connections on the 
back panel may be lost. 
The only connections that are retained between device types are Sequencer Con-
trol CV/Gate in.

! If you encounter such situations and you want to restore the original con-
nections, use the “Undo” function. Browsing back to the original device 
patch will not restore lost connections.
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Create Instrument/Create Effect
This allows you to browse for any kind of instrument or effect patch. This is essentially 
the same as cross-browsing, except that you do not start with an existing device.

1. Select “Create Instrument...” or “Create Effect...” from the Create menu.
The Patch Browser opens. Depending on your selection, either “ALL Instrument 
Patches” or “ALL Effect Patches” is shown.

2. When you select a patch, a corresponding device is created automatically.
If you select an instrument device patch, a corresponding sequencer track will also 
be automatically be created. Master Keyboard input will be set to the new track so 
that you can audition the patch by playing your master keyboard.

3. The device will be auto-routed according to standard rules.
E.g. if it is an instrument device, it will be connected to the first available mixer 
channel - see page 26.

4. Click OK when you have found the patch you wanted, to confirm the creation 
of the new device and to close the Browser.

About patch formats and sampler devices
As both the NN-XT and NN19 sampler devices can load patches in the NN19 (.smp) 
and REX (.rx2/.rcy/.rex) formats, there has to be certain rules regarding cross-brows-
ing. 

D The basic rule is that the Browser will load such patches into the original 
device type (the device you opened the browser from), whenever possi-
ble. 
Thus, when the patch format is NN19 (.smp) or REX (.rx2/.rcy/.rex) and you are 
browsing from an NN19 device, the patch will be loaded into this device.

D If you are browsing from any other type of device, these patch types will 
be loaded into a NN-XT device.

D If you are using the “Create Instrument” function a NN19 (.smp) patch 
will create a NN19 device and a REX patch will create a NN-XT device.

Using the Search function

The Search function allows you to search for files by name and/or type. The Browser 
mode (patch, song etc.) determines what file type(s) you can search for, just as when 
you are manually navigating in the Browser. 

The Search in pop-up menu

This pop-up menu allows you to select where to search. The options are as follows:

• “Local disks” will perform a complete search of all local drives. 
• “User Locations” will search all folders and ReFills stored in the Locations list (ex-

cept the Desktop).
• “Current Folder” will limit the search to the currently selected root folder (including 

subfolders).

The Search For text field 

This is where you can enter a text string to search for. 

D You can specify one or several words, whole or partial. 
If you specify more than one word, the search will show results that match all 
specified words. Text search is not case sensitive.

✪ Note that you don’t have to enter text to use the Search function. De-
pending on the selected Browser (Patch, Sample etc.), you can also sim-
ply search for files of the corresponding type in the selected location(s).

Executing the search

D Clicking the “Find” button will execute the search according to your 
specifications. 
After the search, the search result is shown as a flat list in the Browser, and the 
Where pop-up field reads “Search result”. 

D A new “Parent” column also appears, listing the name of the parent 
folder for each file.
If you select a file you can pull down the Where pop-up above the file list and se-
lect “Go to Parent folder” - this opens the parent folder for the selected file.

The name of the containing folder is also part of the search result (given that it con-
tains files of the appropriate type). This means that if you are searching for “Guitar”, all 
samples or patches with “Guitar” in the filename will be shown, but also all samples or 
patches contained in folders with “Guitar” in the name.

D If you have searched for patches, you can select to show all patches that 
match the search criteria by selecting to show “All Instruments” on the 
Show pop-up.
This will extend the search result to show all patches that matches the search text. 
Note that you do not have to repeat the search to do this.
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Opening files
When you have navigated to the desired folder (on your hard disk or within a ReFill) 
and located the desired file, you open it by double clicking it in the file display or by 
selecting it and clicking the OK button.

As described earlier, patches and samples are loaded directly upon selection, so 
clicking OK doesn’t actually “open” the file, it simply confirms the selection, and 
closes the Browser dialog.

About browse lists
When you click OK to open a file from the Browser, the file and folder list shown at 
that time is memorized for that device. This is called a “browse list”. 

For patches (and to a certain extent samples) this list provides a specific functionality:

D The browse list is what applies when changing patches using the Next/
Previous Patch buttons on the front panel of a device (or from patch se-
lectors on a control surface).
It is also the active browse list that is shown on the patch list opened by clicking in 
the patch name field for a device.

D For samples, the browse list applies when changing samples using the 
Next/Previous Sample buttons on the front panel of a sampler device. 

What can a browse list contain?

D When you confirm a patch or sample selection by clicking OK in the 
Browser, the resulting browse list will include the files contained in all 
currently open folders in the Browser. 
If you open the Browser again for the same device, the same file and folder struc-
ture is shown. 

D If you save the current song and reopen it, the items in the browse list 
will be shown as a “flat” list, and the “Where” pop-up field will show 
“Document Browse List”.
In such cases, the Browser will show the “Parent” column, listing the names of the 
containing folders. The Where pop-up will also contain the item “Go to parent 
folder” for a selected file.

D A browse list could also be a Search result, or a Favorite list.
Favorite Lists provide a way of controlling/filtering which patches or samples will 
be available on a browse list for a device - see below!

! Note that if you opened a patch after having used cross-browsing (see 
page 38) or used the Search function (see page 39), the active browse list 
could contain patches in different formats, and stepping through patches 
from the device panel could change the device type. 

Using Favorites
Favorites provide a way to group and order files that may be physically located any-
where on your local drives. Any file that can be loaded in Reason (songs, patches, 
samples etc.) can be added to a Favorites folder. Only shortcuts to files are added - 
the original files aren’t moved.

This is particularly useful for handling patches. By adding the patches you need for a 
given situation to a Favorite list, you can determine exactly which patches will be se-
lectable for a device, and in what order. You can then sequentially step through these 
using patch select buttons on your MIDI keyboard or control surface device. See 
page 41 for a practical example of this.

D To add a New Favorite List, click the “New Favorite List” button.
An empty folder is created, named “New Favorite List”. The Browser list remains 
unchanged. If you double-click the folder you can type in a new name for the list.

D To add a file to the Favorite List, select it in the Browser and drag it to the 
Favorite List folder.
You can also select multiple files using standard selection techniques - [Shift] 
and/or [Ctrl] (Win)/[Command] (Mac) - and drag these into the folder in the same 
way. 

D By selecting the folder, the currently selectable contents of the Favorite 
list is shown in the Browser list.
What is selectable/shown depends as usual on the current Browser mode. If you 
select a Favorite List folder that contains samples, these will only be shown if the 
Sample Browser is selected.

D When a Favorites list folder is selected in the Browser, an additional 
“Parent column” is shown (just like Search results), listing the name of 
the containing folder for each file in the list.
Files in a Favorites list have an order, and can not be sorted by clicking the column 
headers. However, they can be reordered by using drag and drop. 

D To remove a file from a Favorite list, open the list, select the file and 
press [Backspace].
This removes the shortcut only - the original file isn’t affected.

D To remove a Favorite List, select it in the Favorites section and press 
[Backspace].
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Using Favorites - a practical example
Here follows a practical example of how you can use Favorites for patch files:

You are preparing for a live gig as a keyboard player. You know the songs, and you 
have chosen suitable patches (in various device formats) for each song.

You want to use Reason, but you want to able to switch to the right patch for each 
song using your MIDI keyboard, and not have to worry about fiddling with the com-
puter during your performance. 

Here is how this can be done by using Favorites:

1. Set up a Reason song with a mixer device (and send effects if desired).

2. Create an instrument device, for example a Combinator.
It doesn’t matter which instrument device you choose at this point. 

3. Open the Patch Browser from the instrument device.

4. Click the “New Favorites List” button.
A new folder appears in the list. Double-click it and type in an appropriate name.

5. Select to show “All Instruments” on the Show pop-up.
Now you can start locating the patches you need by navigating in the Browser.

6. When you have located a patch that you need for the gig, drag it from the 
Browser into the Favorites folder.
If this was a patch in a different format than the instrument you created, a device of 
this type will replace the original device.

7. Continue to add the patches in the same way until you have all the patches 
you need.

8. When done, select the Favorites List folder.
The folder is opened in the Browser, listing all the patches you added.

9. Use drag and drop to order the patches according to the set list.

10.Select the first patch in the Favorites list and click OK. 
The browser closes with the patch loaded.

D If you have a MIDI keyboard or control surface with programmable but-
tons, you can assign a button to “Select next patch” on the device.
This is described in the Remote chapter.

11.Save the Song.

12.At the gig, open the song, and the first patch will be loaded.

13.When the first song is finished, use the “next patch” button on the device or 
on your MIDI keyboard and the next patch in the Favorites list will be loaded!

Handling Missing Sounds
Sampler patches, drum machine patches and Soundfonts contain references to sam-
ples - files on your hard disk. The same is true for songs that contain samples (in sam-
pler or drum machine devices) or REX files. If any of these files have been moved, 
renamed or removed when you try to open the patch or song, Reason will alert you 
that files are missing:

Click one of the four buttons:

|Option: |Description:
Search & Proceed Reason will search for the missing files in all Locations 

added by the user and in all known ReFills.
• If all files are found, the song or patch will be opened 

without further ado.
• If one or more files cannot be found, the Missing Sounds 

dialog will appear (see below).
Note that the file search will look at the file names only - files 
that have been renamed will not be found!

Proceed The song or patch will be opened, with sounds missing. This 
means that sampler patches, drum machine patches and/or 
loop players will not play back correctly.
On the device panels, missing samples are indicated with an 
asterisk (*) before the file names:

Open Dialog Opens the Missing Sounds dialog (see below).

Cancel Cancels the operation, i.e. no song or patch will be opened.

This sample is missing.
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The Missing Sounds dialog

This dialog appears if you clicked the Open Dialog button in the previous dialog, or if 
you clicked the Search & Proceed button but the program couldn’t find all missing 
sounds.

The main display in the dialog lists all missing files. The four columns show the follow-
ing properties:

Selecting

The Replace and Search Locations functions (see below) are performed on the files 
that are selected in the list. This allows you to replace some files manually (necessary 
if the files have been renamed or are outside the Locations), have the program find 
other files automatically and skip the rest of the files.

D To select a file, click on it in the list.
You can use the standard [Shift] or [Ctrl] (Win)/[Command] (Mac) selection tech-
niques to select several files

D To select all files in the list, click the Select All button.
When the dialog first appears, all files in the list are selected.

Search Locations

If you click the Search Locations button, Reason will search for the selected files in all 
Locations set up in the Browser (except the Desktop). If the program finds a file with 
the matching name and file type, the new path is stored in the song/patch and the file 
is shown as “Replaced” in the Status column.

D Since the file search looks at the file names, files that have been re-
named will not be found!
This also means that if your Locations contain several files with the same name, 
the wrong sounds may be found.

Replace

Clicking the Replace button opens the browser dialog, allowing you to manually lo-
cate each missing file. This allows you to use files that have been renamed. The 
browser dialog will appear once for each selected file in the list. The name of the file 
to look for is shown in the Browser window’s title bar.

Search In...

This function is useful when you need to replace a whole lot of samples and you know 
where these samples are located. A typical example would be if you have reorganized 
the folder structure on your computer, and the sample folder has been moved in rela-
tion to the folder with a sampler patch or song.

D If you click “Locate”, the Browser opens, asking you to select the sample 
directory, i.e. the folder in which you know that the samples are located.
Select either the folder, or a sample in the folder. When you click OK, Reason will 
search in the selected folder (and its subfolders) only. 

Download ReFill

If a missing sound is part of a ReFill (as indicated in the Part of ReFill Package col-
umn), and there is a valid URL (Internet address) for this ReFill, you can download the 
ReFill directly from this dialog (provided you have a working Internet connection):

1. Select the sound(s) that use the ReFill.
You should only select several sounds if they use the same ReFill.

2. Click the Download ReFill button.
This launches your Internet browser and takes you to the URL associated with the 
ReFill.

3. A dialog appears, asking you to download the ReFill. Do so.

4. Click OK.
Reason automatically scans the downloaded ReFill and locates the files.

Proceeding

At any point, you can click the OK button to close the dialog and open the song or 
patch. Note:

|Column |Description
Device Shows the name of the device in which the missing 

sound is used, along with a device type icon.

Sound Shows the name of the missing file.

Part of ReFill/Soundfont If the missing file is part of a ReFill, or a Soundfont 
within a ReFill, this column shows the name of the Re-
Fill/Soundfont If there is an URL (Internet address) as-
sociated with a ReFill, you can download the 
necessary ReFill(s) from this dialog, as described be-
low.

Status When the dialog appears, all files will have the status 
“Missing”. Files that are found by the auto-search 
function or manually replaced will be indicated as “Re-
placed”.
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D For the files you have found (status “Replaced”), the new paths will be 
stored in the song or patch.
However, you need to save the song or patch for the changes to become perma-
nent!

D If any file is still missing when you click OK, there will be sounds missing 
in the song/patch.
Sometimes, you may want to proceed with sounds missing, and then remove or re-
place the sounds from the device panels in the rack instead.

On the device panels, missing samples are indicated with an asterisk (*) before the file names:

Clicking Cancel will abort the operation, i.e. the song or patch will not be opened.
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About the various signals 
that can be routed
This chapter describes the various ways you can route signals in Reason. The follow-
ing signal types are used:

Audio
Apart from the Matrix Pattern Sequencer, all devices have audio connectors on the 
back. The audio connectors carries audio signals to or from devices via virtual “ca-
bles”. 

D Audio connectors are shown as large “quarter inch” jacks.

D Audio Effects devices, which are used to process audio, have both audio 
inputs and outputs.

D Instrument devices, which generate audio, have either mono or stereo 
left/right audio output connectors.
You do not have to use both outputs for devices with stereo outputs. Use the left 
output to get a mono signal from a stereo device.

D To monitor audio outputs from devices, the signals can be either be 
routed via a mixer - or directly- to the physical outputs of your audio 
hardware. 
Typically, if you are using audio hardware with standard stereo outputs, you will 
most probably use one or several mixers in Reason to mix the audio signals to the 
master outputs.

CV/Gate
CV (control voltage) signals are used to modulate parameter values, and do not carry 
audio. Gate signals are also a type of control voltage, but are “normally” used for 
slightly different purposes.

D CV/Gate connectors are shown as smaller “mini” jacks.

D CV is typically used for modulation purposes.
For example you could modulate one parameter with the value produced by an-
other parameter. 

D Gate outputs/inputs are typically used to trigger events, such as note 
on/off values, envelopes etc.
Gate signals produce on/off values, plus a “value” which could be likened to (and 
used as) velocity.

D You can only route CV/Gate signals from an output to an input (or vice 
versa).
You cannot route an input to another input or an output to another output.

MIDI Routing
There are several ways you can route MIDI from external MIDI devices to Reason de-
vices. This is described in the chapter “Routing MIDI to Reason”.

About Cables
Hiding and Showing
If you have made many connections in Reason, the cables can sometimes obscure 
the view, making it difficult to read the text printed on the back panels of the devices. 
You can hide all cables in the following way:

D To hide all cables, press [Command]+[L] (Mac) or [Ctrl]+[L] (Windows), 
or (de)select “Show cables” on the Options menu.
When cables are hidden, connections are indicated by a colored connector. Re-
peating the above procedure make the cables appear again.

Cables hidden

D When hidden, you can still connect or disconnect cables in the same way 
as when they are shown.
See page 48 for a description of the available routing methods.

Checking Connections
It is possible to check to which device a jack is connected (useful if the cables are hid-
den, or if the connected devices are located far apart in the rack):

D Positioning the pointer over a connector. 
A tool tip appears after a moment, showing the device and the specific connector 
at the other end.
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Color Coding
Cables are color coded in the following way, making it easier to discern between the 
various connections:

• Audio connections are different shades of red.
• CV connections are different shades of yellow.
• Connections to and from Effects devices are different shades of green.

Automatic Routing
Auto-routing is when devices are automatically routed according to default rules. 
Auto-routing is performed in the following circumstances:

• When a new device is created.
• When moving, duplicating or pasting devices with [Shift] pressed.

Automatic Routing Rules

Reason Mixer devices

D The first created mixer device will be routed to the first available input 
pair in the Hardware Device.

Routing devices to the Mixer

D When an Instrument Device is created, it is auto-routed to the first avail-
able mixer channel(s).

Adding an effect to the Mixer

D When you have a mixer selected and create an effect device, it will be 
connected as a send effect (to the first free Aux Send/Return).
Examples of effects that lend themselves well for use as send effects are reverb 
and delay.

D If there are no free Aux Sends on the mixer, the effect will be routed as 
an insert effect, after the mixer. 
That is, the master output signal from the mixer will be routed through the effect.

Adding an effect directly to a device (Insert)

D When you have an instrument device selected and create an effect, that 
effect will be connected as an insert effect. That is, the signal from the 
device will pass through that effect and to the mixer (or to another ef-
fect).

Adding an effect between the Mixer and the hardware interface.

D If you select the hardware interface at the top of the rack and add an ef-
fect device, it will be routed as an insert effect between the main mixer 
and the hardware interface.
This is where you typically would add an MClass Mastering Suite Combi.

These cables are green, indicating 
effect device connections.

This cable is yellow, indicating 
a CV connection.

These cables are red, indicating connections 
between instruments and mixer devices.
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CV/Gate Auto-route

D CV/Gate auto-routing occurs when you create a Matrix Pattern Se-
quencer with an instrument device (Subtractor/Thor/Malström/NN-19/
NN-XT/Combinator) selected.
The Matrix Note and Gate CV outputs are automatically connected to the Se-
quencer Control CV and Gate inputs on the instrument device, respectively.

Auto-routing devices after they have been created

Here follows some additional rules about auto-routing devices that are already in the 
rack:

D To reroute a device already in the rack, you can select it and use Discon-
nect Device and Auto-route Device, both on the Edit menu.

D If you delete a device connected between two devices, the connection 
between the two remaining devices is automatically preserved.
A typical example would be if you have an effect device, connected as an insert ef-
fect between a synth and a mixer. If you delete the effect, the synth will be routed 
directly to the mixer.

D When you move a device, connections are not affected.
If you instead would like the program to re-route the device according to its new 
location in the rack, hold down [Shift] when you move it.

D When you duplicate devices (by dragging) or use copy and paste, the de-
vices are not auto-routed at all.
If you would like them to be automatically routed, hold down [Shift] when you per-
form the operation.

Bypassing Auto-Routing

D If you wish to create a new device, without any auto-routing taking place, 
press [Shift] when creating the device.

Manual Routing
By selecting “Toggle Rack Front/Rear” from the Options menu or pressing [Tab] you 
turn the rack around. On the back of each device you will find connectors of two dif-
ferent types: audio and CV. As mentioned before, audio inputs and outputs are shown 
as large “quarter inch” jacks, while CV input and output jacks are smaller.

There are two ways to route audio from one device to another: 

• By connecting “virtual patch cables” between inputs and outputs.
• By selecting connections from a pop-up menu.

Using Cables
! For the cables to be visible, the option “Show Cables” must be activated 

on the Options menu. See below.

1. Click on the desired input or output jack on one of the devices, and drag the 
pointer away from the jack (with the mouse button pressed).
A loose cable appears.

2. Drag the cable to the jack on the other device.
When you move the cable end over a jack of the correct type (audio/CV, input/out-
put) it will be highlighted to show that a connection is possible. 

3. Release the mouse button.
The cable is connected. If both input and output are in stereo and you connect the 
left channels, a cable for the right channel is automatically added.

D You can change an existing connection in the same way, by clicking on 
one end of the cable and dragging it to another connector.
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Using pop-up menus
1. Click (or right-click) on a connector.

A pop-up menu appears, listing all devices in the rack. 

2. Move the pointer to the desired device (the device to which you want to cre-
ate a connection).
A submenu appears, listing all suitable input/output connections. For example, if 
you clicked on an audio output on a device, the hierarchical submenus will list all 
audio inputs in all other devices. In addition, occupied inputs/oututs are indicated 
with an asterisk (*).

D If a device is greyed out on the pop-up menu, there are no connections of 
the suitable kind.

3. Select the desired connector from the submenu.
The connection is created.

Disconnecting Devices
Again, there are two ways to disconnect devices:

D Click on one end of the cable, drag it away from the jack and drop it any-
where away from a jack.

or 

D Click on one of the connectors and select “Disconnect” from the context 
menu that appears.

Using CV and Gate
CV/Gate is used for modulating and triggering device parameters. Each separate De-
vice chapter lists the available CV/Gate connections, the parameters that can be 
modulated or be used for modulation outputs for the device.

Routing CV and Gate
There are not really any hard and fast “rules” applicable to CV/Gate routing. A few 
points should be mentioned though:

D The specific “Sequencer Control” inputs present on the Subtractor, Thor, 
Malström, NN-19 and NN-XT sampler devices are primarily intended for 
controlling these devices as (monophonic) instruments from the Matrix 
Pattern Sequencer or the RPG-8 Arpeggiator.
If your intention is to use the Matrix or the RPG-8 CV/Gate outputs to create me-
lodic patterns using these Instrument devices, you should use the Sequencer 
Control inputs. 

✪ The Matrix Pattern Sequencer can be used in many other ways, besides 
creating melodic patterns. For example you could use it to modulate any 
CV controllable parameter, with the added advantage of the modulation 
being synchronized to the tempo.

D Conversely, if you would like to apply Gate or CV modulation to more 
than one voice, you should not use the Sequencer Control inputs, as 
these only function monophonically.

D Feel free to experiment: Use Gate signals to control parameter values 
and CV signals to trigger notes and envelopes, if you like.
See the chapter “Matrix Pattern Sequencer” for more tips about using CV.

✪ By routing CV to the rotary controls on a Combinator, you can CV control 
virtually any parameter on any device - see page 161.

About the Voltage Trim Knobs
All CV inputs have an associated Trim knob. This is used to set the CV “sensitivity” for 
the associated parameter. The further clockwise a voltage trim knob is set, the more 
pronounced the modulation effect. 

• Turned fully clockwise, the modulation range will be 100% of the parameters 
range (0-127 for most parameters). 

• Turned fully anti-clockwise, no CV modulation will be applied.
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Introduction
The sequencer is for assembling your songs. This is where you record notes and au-
tomation and edit clips and events.

Sequencer basics
The following sections provide an overview of the sequencer including track and win-
dow handling. 

For quick-start info about how to play back a song and record notes, please refer to 
the Getting Started book.

Sequencer elements

The relation between the sequencer and the rack
In the sequencer, data for a device is recorded and played back on a track. 

D A track is always associated with a specific device in the rack. 
Note, however, that a device in the rack does not necessarily need to have a cor-
responding track in the sequencer.

About tracks, lanes, clips and events
D A specific instance of a device can never have more than one track in the 

sequencer, but a track can have many “lanes”. 

A track with corresponding lanes.

D When you play notes or tweak a device’s parameters while recording in 
the sequencer, the recorded data will be contained in “clips” placed on a 
corresponding lane on the track. 

D The data contained in a clip are called “events”. 
Events can be notes, performance controllers or parameter automation.

Toolbar Inspector (context sensitive). Arrange/Edit 
window

Track list
Tracks 
are listed 
in the 
track list.

Recorded clips on different tracks/lanes. Some tracks are folded, showing the 
clips as thin bars.

The icons in this column of the track list indicate which 
device each track belongs to.
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Track types

There are three basic track types:

D Tracks for instrument devices and other devices that receive notes.
Devices such as synths, samplers or the RPG-8 arpeggiator will automatically get 
a record enabled track when created. On such tracks you can create any number 
of note lanes, and any note lane can record clips that contain any combination of 
data (notes/performance/automation).

D Tracks for devices that do not receive notes (effect and mixer devices) 
only contain automation lanes.
Such devices do not automatically get a track when created. To automate effect or 
mixer parameters you need to first create a track for the corresponding device. The 
number of available lanes is determined by the device - there will be one dedicated 
lane available for each automatable parameter in the device.

✪ If you press [Alt] (Win) / [Option] (Mac) when you create a device, this 
will create tracks for devices that usually don’t get tracks and vice versa.

D The Transport track.
The Transport track is always present at the top of the track list and cannot be 
moved or deleted. The Transport track can have two lanes; one for automating 
tempo changes, and one for automating time signature changes. See “Automating 
tempo and time signature”.

About the two view modes
The sequencer has two basic view modes; Arrange mode and Edit mode. You can 
switch between these views by clicking the button in the upper left corner of the se-
quencer.

Arrange mode

In Arrange mode, all clips on all lanes of all tracks can be shown. Use this mode to get 
an overview of your arrangement, and when you want to perform clip-based editing 
such as rearranging whole sections of your song, etc. See “Editing clips in Arrange 
mode”.

Edit mode

In Edit mode, you get a close-up look at the recorded events on a track (or a specific 
note lane on a track in case there are several note lanes). When Edit mode is se-
lected, the right part of the sequencer area can be divided into several horizontal edit 
lanes, showing different types of events (notes, REX slices, drum sounds, automation, 
etc.). This is the view mode of choice for fine editing of your recording, and for draw-
ing notes, controllers and other events manually. See “The Edit mode”.

D When you open a note clip for editing, Edit mode is automatically se-
lected.
Automation clips can be opened in either Arrange or Edit mode. Pattern clips can-
not be opened, but are always edited directly in Arrange mode.

Arrange 
mode 
selected.

Edit 
mode 
selected.
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Track handling
! How to handle note lanes on tracks is described on page 63.

Track elements

In the picture below three tracks are shown. From the top down you have the Trans-
port track (which is always present and cannot be moved or deleted), a Mixer track 
and a track belonging to a Thor device. The Thor track has Master Keyboard Input (in-
dicated by the keyboard symbol) and two note lanes. The upper note lane is record 
enabled which is indicated by a lit Record button) and the lower note lane is muted 
(indicated by a lit Mute (“M”) button.

Routing Master Keyboard Input to a track

The standard way of routing MIDI to a device in the rack is to go via the sequencer. 
When MIDI is routed to a track in the sequencer, the notes and controller data are au-
tomatically echoed to the corresponding device.

D To set Master Keyboard Input to a track/device, click on the track in the 
track list to select it.
The device icon will get a red border and a keyboard symbol below it, indicating 
that the track will receive incoming note data. 

D Only one track at a time can have Master Keyboard Input (i.e. note input). 
If a track has several note lanes, only one note lane at a time has Master Keyboard 
Input - the record enabled lane.

D If you select another track the Master Keyboard Input will follow.

✪ This is the “Standard” mode of setting Master Keyboard Input. If you pre-
fer to set Master Keyboard Input independent from the track selection, 
select “Separated” mode in the Preferences (Keyboards and Control 
Surfaces page). In that mode, you click the device icon to set Master Key-
board Input to a track, regardless of selection.

Selecting tracks

Track specific operations apply to one or more selected tracks. 

D Clicking on a track in the track list selects it. 
A selected track is dark gray. By default, Master Keyboard Input also follows track 
selection but this can be changed as described above.

D Selecting a track will automatically scroll the rack to bring the corre-
sponding device into view.

D You can also select the next or previous track in the list by using the up 
and down arrow keys on the computer keyboard.

Selecting several tracks and edit focus

D It is possible to select several tracks, by using standard [Shift] or [Ctrl] 
(Win)/[Command] (Mac) selection techniques.
This allows you to e.g. move or delete several tracks in one go. 

D In Edit mode you can only edit/view the contents of one track at a time 
(the last selected track will have edit focus).

Mute and Solo

To mute a track means to silence it, so that no data is sent from the track during play-
back. This can be very useful when you are trying out different versions of an arrange-
ment, for bringing elements in and out of the mix during playback, etc. To solo a track 
means all other tracks are muted.

D To mute (silence) a track, click the corresponding Mute (M) button.
The clips on all lanes of the track will be muted.

A red M button indicates a muted track.

To unmute the track, click the M button again. Several tracks can be muted at the 
same time, in which case you can unmute them all by clicking the “master” M but-
ton at the top of the track list.
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D To solo a track, click the corresponding Solo (S) button. 
This mutes all other (unsoloed) tracks. Soloed tracks have green S buttons. To 
turn solo off, click the green Solo button again.

Here, the track Redrum 1 is soloed (indicated by a green S button).

Several tracks can be soloed at the same time, in which case you can turn off Solo 
for all of them by clicking the “master” S button at the top of the track list.

! Note that you can also mute individual note lanes on a track - see “Mut-
ing note lanes”.

Moving tracks

D To move a track to another position in the list, click on the track handle 
(the leftmost area of the track) so that it goes dark and drag the track up 
or down. 
Just like when moving devices in the rack a red insertion line is shown indicating 
where the track will be placed when releasing the mouse. All clips on all lanes of 
the track will be moved along with the track.

You can use the same technique to move several selected tracks at once. Use stan-
dard [Shift]-select or use [Ctrl] (Win)/[Command] (Mac) to select non-adjacent 
tracks.

! The order of the tracks in the sequencer is independent of the device or-
der in the rack.

Duplicating/copying tracks and devices

As it is not possible for a specific instance of a device to have more than one track, 
you cannot copy or duplicate tracks. These operations will instead duplicate/copy 
both the track (including all clips on the track) and its associated device (and all of its 
settings). The duplicated/copied device is really just like a separate device but with 
the same name and settings as the original device although its name will have the ex-
tension “Copy” to differentiate it from the original. 

To make copies of tracks and their associated devices, complete with all lanes and re-
corded clips, use any of the following methods:

D Hold down [Option] (Mac) or [Ctrl] (Windows), click on the track handle 
and drag the selected track(s) to a new position in the track list.
This will not only copy the track(s) and its contents but also create a duplicate of 
the device(s) connected to the copied track(s).

D Bring up the context menu for the track and select “Duplicate Devices 
and Tracks”.
To bring up the context menu, [Ctrl]-click (Mac) or right-click (Windows) on the 
track in the track list. The duplicate track will be added below the original track.

D You can also select “Copy Devices and Tracks” from the context menu.
This allows you to insert the copied track/device by selecting “Paste” from the 
context menu. The copied track will be pasted below the currently selected track.

! Note that a duplicated/copied device will not have auto-routed audio 
connections. To hear the device, flip the rack around and connect the au-
dio outputs to an available mixer channel. You might also want to mute 
the original track to avoid double notes.

✪ You can also move whole note lanes or individual clips to other tracks - if 
you wish to play existing clips using a different device this is the way to 
go - see “Selecting/moving note lanes”.

Deleting tracks

D To delete one or several tracks, select them and then select “Delete 
Track” from the context menu (you can also select this from the Edit 
menu).
The tracks will be deleted without a warning but you can always use the undo 
function. See “Undo”.

You can also choose to delete tracks together with their associated devices:

D To delete one or several tracks, select them and then select “Delete 
Track and Device” from the context menu (you can also select this from 
the Edit menu).
A dialog will appear allowing you to proceed or cancel the operation.

Creating tracks

As described earlier, tracks are automatically created for devices that receive notes. 
But for those devices (e.g. effects) that do not automatically get tracks, or if you have 
deleted a track for an existing device, you need to manually create them:



THE SEQUENCER
56

D First select the device and then select ”Create Track for (name of de-
vice)” item on the Edit menu. This is also available on the device’s con-
text menu.
The new track will be connected to the device and will have the same name as the 
device. 

! Note that if a track already exists for a device this menu item will be un-
available - a device can only have one track.

Folding tracks

D To fold/unfold a track, click on the track handle arrow.
By pressing [Alt] (Win) or [Option] (Mac) and clicking on the arrow all tracks will 
be folded/unfolded.

A folded track will not show the individual lanes in the track list, and in the Arrange 
window clips are shown as horizontal strips. If the folded track has several lanes all 
the clips on the lanes will be shown as vertically stacked strips in Arrange mode but 
events and curves are not shown. 

A folded track.

D Basic clip operations (selecting, moving, copying etc.) are available for 
folded tracks, although it is generally better to unfold a track if you want 
to edit its contents, as this gives you a better overview. 

D You can also fold only the automation lanes on a track, by clicking the ar-
row next to the automation lanes in the track list.

Track Color

A track can be assigned a color in the sequencer. This works in the following way:

D To assign a color for a selected track select “Color” from the Edit menu.
On the Color submenu a list of available colors are shown. 

The selected track color is reflected in all new clips you record or draw on this track 
(any previously recorded clips on this track will not change color). Track color is also 
shown in the strip to the right of the track handle in the track list.

D You can select to automatically set a color for new tracks by ticking 
“Auto-color New Sequencer Tracks” on the Options menu.
The track color will be a random selection of one of the available colors.

✪ It is also possible to select a color for one or several selected clips - see 
“Clip color”.

Naming tracks

You can name tracks by double-clicking on its name in the track list. Note that naming 
a track also changes the name of the associated device (and vice versa).

Basic sequencer window handling

The sequencer area below the rack.

D You can adjust the size of the sequencer area by dragging the divider be-
tween the sequencer and the rack.

D Clicking the maximize button in the upper right corner will make the se-
quencer area fill the whole document window.
The key command for this is [Ctrl]/[Command]-[2] (to maximize the rack instead, 
use [Ctrl]/[Command]-[1]). Clicking the button or using the key command again 
will return the area to normal, un-maximized state.

The sequencer maximize button.

D When viewing the contents of a track note lane in Edit mode, the right 
part of the sequencer area is divided into different edit lanes.
You view the note information in one edit lane, performance controller automation 
in another edit lane, and any track parameter automation lanes in a third edit lane. 
You can adjust the size of the edit lanes by dragging the dividers between them 
and by using the zoom controls.
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Key, velocity and controller edit lanes are shown. 

D You can scroll and change magnification in a number of ways, including 
standard scroll bars and horizontal and vertical zoom controls, as well as 
with the Magnifying Glass tool, the Hand tool and a mouse with a scroll 
wheel (see page 12).
Where applicable, different edit lanes in the sequencer have separate scrollbars 
and zoom controls.

D You can also adjust the horizontal magnification in the sequencer area 
by pressing [G] (zoom out) or [H] (zoom in).
You can also use [Command] (Mac) or [Ctrl] (Windows) and press [+] or [–] (on 
the standard part of the computer keyboard, i.e. not on the numeric keypad). 
[Command]/[Ctrl]-[+] zooms in while [Command]/[Ctrl]-[–] zooms out.

D To adjust the vertical magnification, use [Shift]+[Command] (Mac) or 
[Shift]+[Ctrl] (Windows) and press [+] or [–] (on the standard part of the 
computer keyboard, i.e. not on the numeric keypad). 
[Shift]+[Command]/[Ctrl]-[+] zooms in while [Shift]+[Command]/[Ctrl]-[–] zooms 
out.

Rack vs. Sequencer scroll focus

Reason has two basic states when the sequencer is part of the rack; either the rack or 
the sequencer has focus. Scrolling with a mouse wheel or trackpad will correspond-
ingly either scroll the rack or the track list. 

• Click in the sequencer area to switch focus to the sequencer, or on a device to 
switch focus to the rack.

Working with the sequencer in a separate window

The sequencer window can be detached from the rack and used in a separate win-
dow. This could be useful for instance if you are working with a large number of tracks 
or if you are viewing many sequencer lanes at once. Detaching the sequencer will 
then make it possible to view all tracks or lanes at once without having to resize the 
sequencer or scroll the view up and down to focus on a certain track or lane.

The separate sequencer window can be positioned and resized freely both horizon-
tally and vertically using the basic windows techniques described on page 11.

D To detach the sequencer from the rack, either click the corresponding 
button in the top right corner of the rack, or pull down the Windows 
menu and select “Detach Sequencer Window”.

The Detach Sequencer Window button.

D Similarly, to reattach the sequencer window to the rack, either select “At-
tach Sequencer Window” from the Windows menu or click the button.
Note that the button for detaching the sequencer window is only available in the 
rack. The button for reattaching the sequencer though, is available both in the rack 
and in the sequencer.

The Attach Sequencer button on the sequencer and, in the background, on the rack.

! Another way of reattaching the sequencer window is by closing it. Note 
also that the rack is still the “main” window for the song, which means 
that closing the song will close the sequencer window as well.
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About the Transport

You’ll notice that when detaching the sequencer from the rack, there will be two in-
stances of the transport on the screen - one in the rack and one in the sequencer win-
dow. This is for convenience since it allows you to control playback and recording 
regardless of which window is the active one.

Should you wish however, you can fold one of the transports in the same manner as 
with any other device in Reason.

✪ To make the rack or the sequencer the active window when they are sep-
arated, you can use the key commands [Command]-[1] (Mac)/[Ctrl]-[1] 
(Windows) and [Command]-[2] (Mac)/[Ctrl]-[2] (Windows) respectively.

A note about using Reason with two monitors

If you have a computer system with two monitors, you can do the following:

D Use one monitor for viewing and managing the rack only.

D Detach the sequencer as described above, and dedicate one of your 
monitors to the sequencer only.

To be able to use two monitors, you must have an operating system and a graphics 
card that supports it.

Please refer to the documentation for your operating system and possibly the graph-
ics card for instructions on how to set up your system for using two monitors.

About the ruler, song position and locators
Regardless of which view mode is selected, you will find a horizontal ruler at the top of 
the sequencer display. This indicates the meter positions, that is, the positions in bars 
and beats.

D The numbering and detail of the ruler depends on the horizontal magni-
fication.

At a medium zoom setting, odd bars will be shown with a bar number and even bars will be 
indicated by a mark. 

If you have zoomed in fully, each bar will be numbered, and every 1/32 note position will be 
indicated by a mark.

In the ruler, you will also find four different position markers, each with a separate 
“flag”:

✪ The End (E) marker indicates the end of the song. The program uses this 
information when exporting the song as an audio file and when you 
scroll horizontally in the sequencer area. 
Playback or recording will not stop at the End marker. 

This is the song position, indicating at 
which position playback happens. 

This is the End marker. This informs Reason about 
where your song ends (see the note below).

This is the left locator. When using the 
Loop mode (see page 60), the left locator 
governs the start position of the loop. 

This is the right locator. When using the Loop 
mode, this governs the end position of the loop. 
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Transport controls - overview
The transport panel is located at the bottom of each song document window. This is 
where you activate playback, recording, fast forward/rewind, etc. Here is a brief over-
view of the controls, to help you find your way in the recording and playback proce-
dures on the following pages.

Transport key commands

There are fixed computer keyboard combinations for the most important transport 
functions:

Playback and positioning
! If you are using ReWire, transport functions can be handled by either ap-

plication. See the Rewire chapter for details.

Play and Stop

D To play back from the current song position, click the play button or 
press [Enter] on the numeric keypad. 

D To stop playback, click the stop button or press [0] on the numeric key-
pad.

If you click the stop button when the song is already stopped, the song position is 
moved according to the following rules:

• Clicking stop the first time moves the song position to where playback was last 
started.

• Clicking stop a second time moves the position to the start of the song.
• If the song position is at the start of the song, nothing happens.

This means you can always click twice on the stop button in stop mode, to return to 
the beginning of the song.

• If you instead use the left locator to mark the start of the song, you can simply click 
the “L” button to the right of the left locator display to go to this position.

Positioning

The song position is indicated by the vertical line with the position (down arrow) 
marker in the ruler. There are several ways to move the song position:

D Use the rewind and fast forward controls on the transport panel.
This moves the song position in steps of one bar (from its current position). That is, 
if you just click once on the rewind/fast forward button, the song position will be 
moved exactly one bar back or forward. To move the song position several bars, 
click and hold the mouse button.

D Use the transport key commands on the numeric keypad.
See the table on page 59.

D Click and drag the position marker in the ruler, or click directly in the 
ruler at the desired song position.
The resulting song position takes the Snap value into account, as described be-
low.

D Adjust the song position numerically in the value displays to the left of 
the transport buttons.

• The song position is shown as musical values in the top display, i.e. bars, beats, 1/
16 notes and ticks (there are 240 ticks per 1/16 note). 

• The song position is shown as time code in the lower display, i.e. hours, minutes, 
seconds and milliseconds. 

D To adjust values, click on a value field and move the mouse up or down.
You can also select a value field and use the spin control to the right or type in a 
new value.

|Function |Key command
Stop [0] on the numeric keypad

Play [Enter] on the numeric keypad

Toggle Stop/Play Space bar

Rewind [4] on the numeric keypad

Fast Forward [5] on the numeric keypad

Record [*] on the numeric keypad or hold 
[Command] (Mac) or [Ctrl] (Windows) and 
press [Return]

Go to Left Locator (Loop Start) [1] on the numeric keypad 

Go to Right Locator (Loop End) [2] on the numeric keypad

Go to the start of the song [.] on the numeric keypad

Stop PlayRewind

Fast Forward Record

Song Position 

New Dub/New Alt buttons 
(see page 63)

Loop on/off (see page 60)

Left and Right Locators - see page 58. 
The “L” and “R” buttons to the right sets 
the position to the left and right locator, 
respectively.

Song Position 
(time format)
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About Snap to Grid

The Snap to Grid function (from now on called “Snap”) restricts movement to specific 
positions. This is especially useful when you are editing in the sequencer (moving 
clips, drawing events, etc.), but it will also affect the result of moving the song position 
in the ruler.

To set up and activate Snap, proceed as follows:

1. Pull down the Snap pop-up menu and select a value.
If you select “Bar”, you will only be able to move the song position to the beginning 
of bars. The other options restrict movement to the corresponding note values.

2. Activate Snap by clicking the button next to the pop-up menu.

In this example, Snap is activated and set to quarter notes. This means you can move the song 
position to exact quarter note positions only.

Using the loop
In loop mode, the sequencer will repeat a section over and over again, during play-
back or recording. You specify the section to be looped by setting the left and right lo-
cator:

D Set the left locator (the start of the loop) by dragging the “L” marker in 
the ruler.
Or, you can hold down [Option] (Mac) or [Ctrl] (Windows) and click in the ruler.

D Set the right locator (the end of the loop) by dragging the “R” marker in 
the ruler.
Or, you can hold down [Command] (Mac) or [Alt] (Windows) and click in the ruler.

! Note that Snap applies when moving the locators in the ruler, just as with 
the song position.

D Both locator positions can also be adjusted numerically on the transport 
panel.
Click on one of the value fields (Bars/Beats/16th notes or Ticks) and drag the 
mouse up or down or select a value and use the spin controls.

D To activate the loop, click the Loop On/Off button so that it lights up, or 
use the corresponding key command.
On a Mac this is [/], under Windows it’s [÷], both on the numeric keypad.

When you play back in loop mode, and the song position reaches the right locator, it 
will immediately jump back to the left locator. This way, the area between the locators 
will be repeated continuously.

The Snap on/off button.

The Snap value pop-up.
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Recording
Setting up for recording
Before you start recording, you need to make some basic settings:

Tempo and Time Signature

The tempo and time signature settings are located on the transport panel. 

D You can specify any tempo between 1 and 999.999 bpm (beats per 
minute).
The tempo can be adjusted in bpm steps (left value) or in steps of 1/1000 bpm 
(right value).

You can also adjust the tempo (in bpm steps) by using the [+] and [–] keys on the nu-
meric keypad.

D You set the time signature by specifying a numerator (left value field) 
and a denominator (right value field).
The numerator is the number of beats per bar, and the denominator governs the 
length of a beat.

✪ Tempo and Time Signature changes can also be automated by the Trans-
port track - see “Automating tempo and time signature”.

Click

When you record, it is often necessary to have some sort of rhythmic guide to help 
you keep time. The easiest way is to use the built-in metronome click:

When this is activated (by clicking the button or by pressing [C]), you will hear a click 
on each beat, with an accent on the downbeat of each bar. The click is played back 
during recording and playback. You can adjust the volume of the click by using the 
Click Level knob.

✪ Sometimes it might be easier to use a drum machine pattern as a rhyth-
mic guide.

Pre-count

Activating the “Pre” button on the Transport will generate a 1 bar pre-count click be-
fore recording starts. Note that anything you play during the count-in will not be re-
corded.

Quantizing During Recording

If the Quantize Notes During Recording switch is activated on the Transport, notes 
will automatically be quantized when you record them. This is described in detail on 
page 90.

Recording notes
When you record notes, a clip is created on the active (record enabled) note lane of 
the track. The clip will contain all the notes you record (plus any performance control-
lers used during recording - see page 64). 

To record notes from your master keyboard, proceed as follows:

1. Make sure input is routed to the desired track, see “Routing Master Keyboard 
Input to a track”.
The track with Master Keyboard input is automatically record enabled. 

2. Move the song position to where you want the recording to start.
Recording always starts at the song position.

To move the song position, drag the position marker or click directly in the ruler.

3. Activate the “Pre” button if you want a 1 bar pre-count click before recording 
starts.

4. Click the record button or press [*] on the numeric keypad.
Recording starts after the 1 bar pre-count if this is activated, otherwise recording 
starts immediately. 

5. When you are done, click the stop button or press [0] on the numeric keypad.

A clip containing your recorded notes has been created on the note lane in the Ar-
range window. 

A clip’s length is always automatically adjusted to the closest bar position to the right 
when ending a recording, independent of any Snap setting. Notes and other events 
contained in the clip are not affected or adjusted in any way other than if you have ac-
tivated Quantize During Recording - see above.

At this point, you may want to move the song position to the beginning of the record-
ing to listen to what you recorded. The simplest way to do this is to click the Stop but-
ton again. This moves the song position to where playback/recording last started.

3/4 time 
selected.
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D The recorded clip will be selected (indicated by the clip having a border 
and handles at each end) and the recorded notes will be visible as events 
in the clip.

D You can undo the recording by selecting “Undo Recording” from the Edit 
menu or by the key command [Ctrl]/[Command]+[Z].
You can also press [Backspace] to remove a selected clip.

D It is also possible to activate recording during playback (“punch in”), by 
starting playback and then clicking the record button.
Similarly, you can deactivate recording without stopping playback (“punch out”). 

Recording more clips on the same note lane

If you like, you can of course continue recording on the same note lane. 

• If you used “Undo Recording” (see above) or deleted the previous clip, this will 
simply allow you to record another take. 

• If you start recording after the previous clip, this will also work as outlined in the 
previous section, and a new clip will be created.

• But if you kept the clip you previously recorded, and start recording from the same 
position, you will overdub, i.e. record notes on top of the previously recorded 
notes.

The following rules apply:

D No previously recorded note events are erased when recording on the 
same note lane.
You cannot replace or erase recorded note events in a clip by recording over it. 
Recording over clips on the same note lane means that all new notes will be 
added to the note events that were on the note lane before. You will also hear the 
notes recorded previously as you record the new clip. 

D Recording always creates a new clip. If you record over a previously re-
corded clip on the same note lane, the new clip will “engulf” the previous 
clip where they overlap.
If the new clip overlaps the previous clip completely, the previous clip and all the 
recorded note events it contained will be completely merged into the new clip. If 
the previous clip is longer than the new clip, the part of the previous clip that is not 
overlapped by the new clip will be snipped to a separate clip.

! Note that it is in many cases better to record new note data on a separate 
note lane, even if you intend to add notes to a previous take (i.e. over-
dub). See “Adding note lanes and the New Dub/New Alt buttons” for de-
tails.

Redoing part of a take

You will most probably encounter situations where you want to redo part of a re-
corded clip but keep the rest. As explained previously this cannot be done by record-
ing over the clip, but there are several methods you can use to remove the part which 
you want to redo:

D By first erasing the specific notes you wish to redo.
If you double-click the clip you will switch to Edit mode where you can edit (move/
copy/erase etc.) individual note events in the clip - see “The Edit mode”. 

D By splitting the clip.
You can use the Razor tool to split clips. This allows you to split a clip before and 
after the section you wish to redo. Then you can simply erase the resulting new 
clip (which now only contains the notes you want to redo) and record again. See 
“Splitting clips”.

D By drawing a new clip inside the original clip.
If you draw a new clip so that it overlaps another, the new clip will mask all events 
“behind” the new clip, allowing you to record the section again. See “About over-
lapping clips”.

D By resizing the clip.
This method can be used if the section you wish to redo is at the start or end of the 
clip. Selected clips have handles the start and end of the clip. By moving the han-
dles you can resize the clip. If you make the clip shorter, any note events in the clip 
that fall outside of the clip boundaries will be masked and will not play back. See 
“Resizing clips”.
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Basic note lane handling

Adding note lanes and the New Dub/New Alt buttons

You can add new note lanes for an instrument track. This is useful in the following cir-
cumstances:

• If you want to overdub notes or performance automation to an existing clip. (Al-
though this can also be done on the same note lane as described previously). 

• If you want to record a series of takes on separate note lanes, to later decide 
which take is “best” (or to edit together a composite). 

On the transport there are two buttons named “New Dub” and “New Alt”. Clicking on 
either one will add a new note lane, but with the following difference:

D “New Dub” will add a new record enabled note lane above the previous 
note lane, but will not mute the previous note lane.
In other words you will hear the note clip(s) on the previous lane if you record over 
the same area on the new note lane. So use “New Dub” if you wish to overdub 
notes or performance events to an existing clip. The new notes or events will be 
contained in a new clip, but this method is preferable to overdubbing on the same 
note lane as it gives you the option of easily redoing the overdub at any later stage. 
If you want the overdubbed clip(s) to be a permanent part of the clip(s) on the orig-
inal note lane later you can always use the “Merge Note Lanes on Track” function 
- see “Merging note lanes”.

D “New Alt” will also add a new record enabled note lane above the previ-
ous note lane, but the previous note lane will automatically be muted.
Use New Alt when you want to record a new take, but still keep the previous take 
without playing along with it. 

! If Loop is activated and the song position is inside the loop boundaries, 
the clip(s) inside the left and right locators will be muted instead of the 
whole note lane. 

D You can also add new note lanes either by clicking the “Lanes +” button 
at the top the track list or by selecting “New Note Lane” from the Edit 
menu.
This works in the same way as “New Dub”, i.e. a new note lane is added and the 
previous note lane will not be muted.

D You can add note lanes “on the fly” when in record mode (or from play 
mode).
A new record enabled lane will be added. If you are in record mode the new note 
lane will instantly be record enabled so you can continue to record without stop-
ping.

Deleting note lanes

D To delete a lane, click on the “X” button for the lane in the track list.
If there are any clips recorded on the lane, a dialog opens giving you the option to 
cancel the operation or to proceed.

Record enabling note lanes

Whenever a new note lane is created it is automatically record enabled. But if you 
have several note lanes on a track and you would like to record on a previous note 
lane you have to record enable it manually:

D Click on the red “Record Enable” button for the lane you wish to record-
enable.
Only one note lane at a time can be record enabled. 

Muting note lanes

Individual note lanes on a track can be muted by activating the “M” button in the lane 
area of the track list. All clips on the corresponding note lane will be muted.

• Don’t confuse Lane Mute with Track Mute - see “Mute and Solo”. 
• You can also mute individual clips on a lane - see “Muting clips”.

Naming note lanes

Note lanes on a track are by default named “Lane” (plus a successive number accord-
ing to the creation order i.e. Lane 1, Lane 2 etc.). You can rename a note lane by dou-
ble-clicking its name in the track list. 

Note that lane (and track) names are not exclusive - you can have lanes and tracks 
with the same name but it is generally good practice to give them descriptive and 
unique names.
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Selecting/moving note lanes

Note lanes are not selectable items in the same way that tracks are. Tracks (when se-
lected) will adhere to track/device specific operations on the Edit menu for example. 
Individual lanes do not have any comparable edit-related functions. 

However, a note lane is selectable in the following circumstances:

D In Edit mode, data for one note lane of a track is shown at a time.
By clicking on a lane you switch the view to the lane you select. See “Editing 
Notes”.

D A note lane has a “handle” and can be moved vertically together with all 
clips on the lane.
To move a note lane to another position in the list on the same track, click on the 
track handle (the leftmost area of the lane) so that it goes dark and drag the track 
up or down. Just like when moving tracks, a red insertion line is shown indicating 
where the lane will be placed when releasing the mouse. 

D Note that it is possible to move note lanes between tracks - this is de-
scribed on page 64.

Merging note lanes

Note lanes on a track can be merged into a single note lane: 

D Select the track with the note lanes you wish to merge and then select 
“Merge Note Lanes on Tracks” from the Edit menu or the track context 
menu.
The note clips on all note lanes will be merged to the top lane.

A percussion track with separate note lanes, one for each drum sound.

The same track after merging.

D Muted lanes or clips on the track will not be included in the merge.

D If there are gaps between the clips on the lanes, several clips will be cre-
ated.

! Note that if there is any performance controller data (e.g. pitch bend) in 
several note clips at the same position, only the performance data from 
the top lane will be included in the merged clip. See “Recording perfor-
mance controller automation” for details.

Recording automation
In Reason, you can automate virtually all device parameters, creating completely auto-
mated mixes if you like. This is done by recording (or drawing) controller events in the 
sequencer. 

Performance controller vs. track parameter 
automation
Recording automation can be done in two different ways; either as performance con-
troller automation or as track parameter automation.

D Performance controller automation is automatically recorded in note 
clips on note lanes.
Any standard MIDI performance controllers that you apply when playing (Pitch 
Bend etc.) will be recorded as performance automation in the note clip. A clip on 
a note lane can contain any combination of note events, performance automation 
events and parameter automation events. 

Performance automation is shown as curves in the clip.

D Track parameter automation creates separate automation lanes on a 
track, one for each automated parameter. 
Automation lanes are shown in the lane area of the track list and can be created 
manually or automatically (by tweaking parameters on the device connected to the 
track while recording). See “Editing automation”.

An automation lane in the track list.

Which method you should use depends on how you prefer to work and the situation 
at hand. The main differences to take into account are the following:

D If you are planning to record automation on several tracks at the same 
time using a control surface device, you have to use track parameter au-
tomation. 
Track parameter automation has separate, independent record-enable buttons for 
automation recording. These can be activated for any number of tracks simulta-
neously, unlike the record-enable buttons for note lanes. (See “Recording automa-
tion on multiple tracks”).

D Performance parameter automation allows you to contain the automa-
tion data in a note clip together with note events.
Standard MIDI performance controllers will always be recorded as performance 
parameter automation. See below for more details.

! Note that a parameter may be assigned to both performance parameter 
and track parameter automation. See page 87 for details.
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Recording performance controller automation
If you use any MIDI performance controllers when recording on a note lane, these are 
automatically added to the recorded clip. This makes sense as performance control-
lers are usually recorded at the same time you record notes, as a part of the perfor-
mance.

Standard MIDI performance controllers are Pitch Bend, Modulation Wheel, 
Sustain Pedal, Aftertouch, Breath Control and Expression. 

To record standard performance controller automation proceed as follows:

1. Make sure the track is unfolded, record enabled and has master keyboard in-
put.

2. Start recording and use one or more performance controllers as you play., 
e.g. pitch bend and/or mod wheel.

3. Click stop when you are done.
The clip you recorded will now have automation curves visible in the clip along 
with the recorded note data. If you used Pitch Bend and/or Mod Wheel when re-
cording these controllers will also have a green border around them on the device 
panel to indicate they are automated. If you play back the clip, the notes and con-
trollers will play back exactly as recorded.

Performance controllers are shown as curves in the note clip. In this picture pitch bend, mod wheel 
and sustain pedal controllers have been used. 

Depending on the type of controller used the performance automation is shown differ-
ently in the clip. Controllers with bipolar values (like pitch bend) is shown as a line in 
the middle when at zero (no pitch bend) with curves going up or down from the zero 
value. Controllers with only positive values (like Mod wheel) has zero at the bottom of 
the clip with applied modulation shown as curves going up from the zero value. Con-
trollers with off/on values (like sustain pedal) is shown as rectangular curves (on - du-
ration- off)

D If you open the clip in Edit mode (by double-clicking on the clip), the re-
corded performance data will be placed on different edit lanes.
Click on the “Switch to Arrange Mode” button in the top left corner of the se-
quencer window to return to Arrange mode. You can also use |Ctrl]/[Com-
mand]+[E] to toggle between the views. See “Editing performance controller 
automation”.

Performance edit lanes in Edit mode.

D Note that you can record notes and performance controllers separately.
I.e. you can first record notes on one note lane and then record performance con-
trollers on another note lane. The automation will be contained in clips placed on a 
separate lane and can also be moved or muted separately. 

D To edit the automation curves, see “Editing existing automation events”.

D To manually add or delete performance parameter automation edit 
lanes, see “Drawing automation events”.

Redoing performance automation

If you wish to replace or redo recorded performance controller data this works as fol-
lows:

If you enter record for a note lane that has clips with performance data on it, you will 
create a new clip that will engulf the previously recorded clip(s) where they overlap. 
As outlined in the section “Recording more clips on the same note lane” no notes will 
be erased if you record over clips on the same note lane, but it works differently for 
performance automation data:

D If you record over a note clip with performance automation data and you 
adjust any of the performance controllers used in the original clip, the 
automation will be replaced with new performance data from this point 
onward until you stop recording.
If the new clip is shorter than the previous clip, the performance automation in the 
previous clip will “take over” when the new clip ends.
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About performance controller automation on multiple lanes 

If you have several active (unmuted) note clips with performance controller automa-
tion on different lanes of the same track, and these note clips overlap position-wise, 
the following rule applies:

D Performance controllers in the top lane clip overrides any performance 
controllers of the same type in other overlapping clips on lanes below.

The clip on the upper lane has pitch bend down automation, and the clip on the lower lane has 
pitch bend up automation and note events. The pitch bend affecting the notes will follow the 
automation curve of the upper clip for its duration. As soon as the upper clip ends, the notes will be 
affected by the pitch bend up automation in the lower lane.

About the “Automation As Performance Control” option

You can also chose to record any type of parameter automation as performance pa-
rameter automation, i.e. the automation will be contained in note clips on a note lane 
as opposed to being recorded on separate automation lanes.

D This is activated by the “Automation As Perf Ctrl” button below the 
transport controls on the transport panel.
When this is activated, any parameter you tweak on the device connected to the 
track while recording will be recorded as performance automation in a note clip, 
and no automation lanes will be created. 

While this method is perfect for making a clip self-contained, there are some trade-
offs. If you use this method to record device parameters, you won’t have the same 
overview as with track parameter automation. You also won’t be able to later mute the 
separate automation edit lanes, or move them independently. 

Recording track parameter automation
Track parameter automation is the standard way to automate device parameters. 
Each parameter that is automated for a device will get a separate automation lane on 
the track. There are no separate Record Enable buttons for automation lanes, only a 
global Automation Record Enable button for the whole track.

The Automation Record Enable button.

Before you record automation

Before you start recording automation of a parameter or manually create a parameter 
automation track (see below), you may want to set it to a suitable “static value”. By 
this, we mean the value the parameter should have whenever it isn’t automated in the 
song. Here is why:

D When you first create an automation lane for a parameter either manu-
ally or automatically, its original value will be inserted a a static value 
throughout the rest of the song wherever there isn’t an automation clip 
with events present on the lane.

Let’s say you want to create a fade-out by recording a fader movement in the Mixer. 
Then it’s a good idea to first set the fader to the correct static value (i.e. the value the 
fader should be set to before you start the fade-out). 

The same thing is true if you want to create a filter sweep for a synthesizer, some-
where within the song: First set the filter frequency to the value it should have else-
where in the song, then record the filter sweep.

This makes it possible to set up a static mix first, and then add some automated pa-
rameter changes anywhere in the song while maintaining the static values elsewhere 
in the song.

D The static value can later be manually changed for an automation lane in 
Edit mode without overriding any automation. 
See “Editing automation”.

Basic procedure

1. Make sure there is a sequencer track for the device.
For devices that can receive note data, a sequencer track is automatically created 
together with the device. For a mixer or effect device, you need to add a track man-
ually before you can start recording parameter automation. 
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D If the device that you wish to automate doesn’t have a sequencer track, 
the quickest way to add one is by selecting “Create Track for (name of 
device)” from the device context menu ([Ctrl]-click (Mac) or right-click on 
the device panel).
This will create a new record enabled sequencer track for the device, without any 
automation lanes. 

D If the track has note lanes you may want turn off the Record Enable but-
ton for the active note lane (unless you plan to record notes and param-
eter automation simultaneously of course).
If the note lane already has clips recorded on it, a new clip will be created when 
you record, that will engulf any previous clips on the note lane that the recording 
encompasses. Although nothing will be erased, you may end up with a single clip 
instead of several separate clips and the original clips may also be split where you 
don’t want them to be split. See picture examples below.

Recording automation with the note lane record enabled.

The track is now ready for automation recording. Note that it is not necessary for the 
track to be selected or for the track to have Master Keyboard Input to record automa-
tion. The Automation Record Enable button is completely independent from Master 
Keyboard Input. 

2. Set up the device parameters as you want them (for the static values as ex-
plained previously).

3. Start recording from the desired position.

4. During recording, adjust the desired parameter(s), from the device panel or 
from a MIDI remote control surface.
You can automate any parameter for the device - each parameter you tweak will 
automatically generate an automation lane and a clip will be recorded on the cor-
responding lane from the point you changed the parameter. 

5. Stop recording.
On the device panel, each automated parameter will have a green frame. 

The parameters Feedback and Pan are automated. 

In Arrange mode, clips on automation lanes indicate the recorded automation data. 
Clips on automation lanes differ from note clips in that they have a cut upper right 
edge. Automation lanes only have an “On” button and a “Delete Automation Lane” (X) 
button.

If you play back the recorded section again, the parameters will change automatically. 
Outside the clip boundaries, the parameters will have their original settings (the static 
values they had before you started recording).

Recording more for the same parameter

If you need to redo a section of the recorded automation, or simply record more auto-
mation for a parameter, proceed as follows:

1. Set up and start recording in the same way as described above.
As long as you don’t touch the parameter, its automation data will be played back 
normally, and no new clip will be created.

2. At the desired position, adjust the parameter.
As soon as you start changing the parameter value, the Automation Override indi-
cator will light up on the transport panel, and a new clip will be created. 

D From this point on, the previously recorded automation will be replaced 
with the automation events in the new clip. 
Automation recording is different from recording on note lanes where nothing is 
erased when you record over previously recorded clips. A new automation clip in-
stead will replace any previous automation clip(s) at the same position for the du-
ration of the recording. Automation clips logically cannot be “overdubbed” as you 
cannot have two clips with active automation data for the same parameter simulta-
neously. 
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3. Stop recording when you are done.
You have now replaced the automation from where you started recording to where 
you stopped recording. The Automation Override indicator will still be lit but it will 
go off if you click stop or play on the transport.

D You can also click the Reset button below the Automation Override indi-
cator during recording.
This “resets” the parameter and the automation recording will stop (making the 
previously recorded automation active again, from that position). You are still in 
record mode, so as soon as you adjust the parameter again, the Automation Over-
ride indicator will light up and a new clip will be created. 
Basically, clicking the Reset button is the same as stopping recording and starting 
recording again.

D How to edit automation events is described on page 84.

D See “Adding/removing automation lanes” for a description of how to 
manually add parameter automation lanes. 

Moving automated parameters during playback - “Live mode”

Even if you have automated a parameter, you can still “grab it” and adjust it during 
playback, overriding the automation:

1. During playback, adjust an automated parameter.
The Automation Override indicator lights up on the transport panel. From this point 
onward, the recorded automation for the parameter is disabled.

2. To activate the automation again, click the Reset button.
This returns control of the parameter to the sequencer.

Recording automation on multiple tracks

Although only one track can have Master Keyboard input, it is possible to record en-
able any number of tracks for automation recording. 

D Simply activate the Automation Record Enable button for the tracks you 
wish to record automation for.

D When recording is activated, all automation record enabled tracks will 
record track parameter changes from their respective devices in the rack. 
This is especially useful if you have multiple control surfaces, controlling different 
devices in the rack while you’re recording. See the Remote control chapter for de-
tails.

Switching track parameter automation lanes off and on

You can switch off automation lanes by clicking the yellow “On” for a lane button so it 
goes dark. This will freeze whatever value the parameter had when switching off the 
automation lane. Clicking the button again reactivates the automation.

Deleting automation lanes

Deleting an automation lane is done by clicking the “X” button so it goes dark. If the 
lane has clips on it a dialog appears where you have the option to cancel or proceed 
with the operation.

Folding automation lanes

You can fold all automation lanes for a track which can make the arrangements a lot 
less cluttered if you use automation extensively. 

D To fold all automation lanes, click the arrow on the handle of the top au-
tomation lane.
All automation lanes will be folded, and clips on the lanes will be displayed as thin 
horizontal strips, just like note clips for folded tracks.

D Pressing [Alt] and clicking on the arrow will fold/unfold the automation 
lanes on all tracks.
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Recording pattern changes
If your song contains pattern devices, you probably want to use more than a single 
pattern throughout the song. To facilitate this you can record pattern changes in the 
sequencer (or draw them in manually, as described on page 88).

1. Locate the sequencer track for the device, and make sure the Record Enable 
Parameter Automation button is active.
You can disable the Record Enable button for the note lane for now as it won’t be 
needed.

2. Set the desired start pattern on the pattern device.

3. Start recording from the desired position.
When recording starts, the pattern device will automatically start. Although no clip 
will be created until you change pattern, the start pattern is being recorded.

4. During recording, change patterns with the Bank and Pattern buttons on the 
device panel.
Make sure to change the patterns slightly in advance - the actual pattern change 
will be recorded (and happen) on the next downbeat according to the main se-
quencer time signature.

5. When you are done, stop recording.
There will be a green frame around the pattern selection buttons to indicate that 
pattern changes are automated for the device. A Pattern Select automation lane 
with pattern clips has also been created.

Pattern automation clips on the Pattern Select lane.

D Pattern automation has no “static value”. If the pattern selection is auto-
mated, patterns will only be played back where there are pattern clips.
Where the pattern lane is empty, no pattern will be played back.

D Each pattern change will be recorded on a downbeat (at the start of a 
new bar in the sequencer).
You can move pattern changes to other positions by moving or resizing pattern 
clips, see “Editing Pattern Change clips”.

D You can punch in on recorded pattern changes, to replace a section of 
the track.

D After recording the pattern changes, you can use the function Convert 
Pattern Track to Notes, to transfer the notes in the patterns to the main 
sequencer.
This allows you to create unlimited variations by later editing the notes in Edit 
mode.

D You can also manually draw automation clips on the Pattern Select lane 
- see “Editing Pattern Change clips”.

About the toolbar
The toolbar is located above the track list in the sequencer. It contains various tools 
for clip and event editing in the sequencer.

From left to right, the toolbar contains the following items:

• The Edit/Arrange mode switch button - see “About the two view modes”.
• The Arrow tool (or Selection tool) - this is the main tool used for selecting, resizing 

and moving clips or events. This is selected by default.
• The Pencil tool is used for drawing clips and events. 
• The Erase tool is used for deleting clips and events. 
• The Razor tool is used for splitting clips - see “Splitting clips”.
• The Magnifying Glass tool is used to zoom the sequencer view in or out.
• The Hand tool is used for scrolling the view.
• The Snap pop-up and On/Off switch - see below.

D A quick way to switch between the different tools is to use the 
“Q,W,E,R,T,Y” keys on your computer keyboard.
“Q” selects the Arrow tool, “W” selects the Pencil tool and so on, in the same or-
der as the tools are placed on the toolbar.
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About Snap
When you select and edit material (both in the Arrange and Edit mode), the Snap 
function affects the result. By activating Snap, editing becomes “restricted” to the 
note values selected on the Snap pop-up menu (the Snap value). The Snap button 
and pop-up menu are located on the sequencer toolbar: You can also toggle Snap 
on/off by pressing [S].

! Note that you can select different Snap values for arranging and for edit-
ing the contents of open clips. See page 80.

Snap has an effect on the following operations:

D Moving the Song position, Locators and End marker.
When you adjust these markers with Snap activated, they will be “magnetic” to the 
Snap value.

D Moving clips and events.
When you move one or several clips or events with Snap activated, they will keep 
their relative distance to the Snap value positions. 

D Drawing clips.
When you create clips with the Pencil tool, their start and end positions will be 
magnetic to the snap value positions. See page 74.

D Drawing events in open clips.
The Snap value determines the smallest note position on which you can draw a 
note or an automation point. Furthermore, the Snap value determines the smallest 
length of notes when you draw. See page 81.

D Using the Razor tool to split clips.
See “Splitting clips”.

D Nudging clips or events.
See “Nudging clip positions” and “Nudging event positions”.

Editing clips in Arrange 
mode

The Arrange mode allows you to view several tracks at the same time, and provides a 
good overview of the song. This view is used for clip-based editing, such as rearrang-
ing clips, adding or removing bars or applying quantizing and editing functions to clips 
on different tracks and lanes at the same time.

D To select Arrange mode, click the Arrange/Edit mode button in the top 
left corner of the sequencer area.

You can also toggle between Arrange mode and Edit mode by pressing [Shift]-
[Tab] or [Command]/[Ctrl]-[E].

Selecting clips
A clip is selected by clicking on it (with the Arrow tool). A selected clip has a black 
border and two handles at each end of the clip.

Use this pop-up menu to select the Snap value.

Click here to turn 
Snap on or off.
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To select multiple clips in Arrange mode, click and drag a selection rectangle.

D You can draw a selection rectangle covering several tracks or lanes.
Any clips touched by the selection rectangle will be selected.

D If you hold down [Shift] when you select clips, any already selected clips 
remain selected.
This allows you to make multiple, non-contiguous selections: first select some 
clips, then press [Shift] and select some more clips, and so on.

D You can also use the “Select All” function on the Edit menu.
This selects all clips in the song.

D Another way of selecting clips is to use the arrow keys on the computer 
keyboard.
Pressing the right arrow key selects the next clip on the lane, pressing the down 
arrow key selects the closest clip on the lane below, etc. Holding down [Shift] and 
using the left/right arrow keys allows you to make multiple selections on the same 
lane.

D Double-clicking a note clip opens it for editing in Edit mode.
To return to Arrange mode click the “Switch to Arrange Mode” button in the top 
left corner of the sequencer (or press [Shift]+ [Tab]). Editing clip contents is de-
scribed from page 78 onwards.

D Double-clicking a track parameter automation clip opens it for editing di-
rectly in Arrange mode.

D To de-select clips, just click anywhere in an empty area.

Moving clips on the same lane
D To move a clip, click on it and drag it to a new position. 

To move several clips, select them using standard techniques and use click and 
drag on any of the selected clips. They will be moved by the same amount but 
keep relative positions. 

D If Snap is activated, you will only be able to drop the selection so that it 
maintains its relative distance to the Snap value positions.
See “About Snap”.

D You can also move the start position of selected clips numerically in the 
inspector - see “About the inspector strip and selected clips”.

Nudging clip positions

You can use the left/right arrow keys to “nudge” the positions of clips:

• Pressing [Command] (Mac)/[Ctrl] (Windows) and using the left or right arrow key 
moves the position back or forward by the set Snap value.

• Pressing [Command]+[Option] (Mac)/[Ctrl]+ [Alt] (Windows) and using the left 
or right arrow key moves the position back or forward in tick increments (there are 
240 ticks per 1/16 note so this is very fine editing - check the tick positions in the 
inspector when you nudge because otherwise you won’t “see” the position 
changes).

• Pressing [Command]+[Shift] (Mac)/[Ctrl]+ [Shift] (Windows) and using the left or 
right arrow key moves the position back or forward in beat increments.

Moving clips between lanes 
You can move clips between lanes, either on the same track or to lanes on other 
tracks:

D Simply click and drag the clip to the position want it be on the other lane.
The set Snap value is taken in to account if activated.

About alien clips

D You can move note clips to other note lanes and automation clips to 
other automation lanes (if applicable - see below).
It is possible to move a note clip to an automation lane or an automation clip to a 
note lane but the clip will become “alien” and won’t be active. An alien clip is indi-
cated by having red stripes.

An “alien” clip.

An automation clip can become alien if it is moved to an automation lane for a param-
eter with a different value range (for example if you cross-browse to another device 
type). 

D In most cases, you can fix this by selecting the clip and selecting “Adjust 
Alien Clips to Lane” from the Edit menu. 
For example if a clip for a parameter that has a bipolar (-64 to 63) value range is 
moved to an automation lane with a unipolar (0 to 127) value range it will become 
alien. But selecting “Adjust Alien Clips to Lane” will scale the clip data to fit the 
range of the current lane.

The general rules are as follows:

• An automation clip for a parameter with a 0 to 127 range can be moved to another 
automation lane if the parameter for this lane has the same value range.

• An automation clip for a parameter with a 63 to -64 range can be moved to an-
other automation lane if the parameter for this lane has the same value range.

• An automation clip for a parameter with a 0 to 1 range (i.e. an on/off switch) can 
be moved to another automation lane if the parameter for this lane has the same 
value range.
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Moving clips with performance controller automation data to 
another track

If you move note clips that contains performance controller automation to another 
track (for a different type of instrument device) there are a few things to note. 

D If you have only recorded standard performance controllers (Pitch Bend, 
Mod Wheel and Sustain pedal) in the note clip, these will usually tran-
scribe without any problems when moving to another device track.
Just be aware that all devices do not respond to all performance controllers - the 
Malström for example does not respond to Aftertouch, Expression or Breath per-
formance controller data.

D If you have recorded non-standard controller parameters for a device in 
the note clip using the “Automation as Performance control” option (see 
page 66) some automated parameters may not have an equivalent pa-
rameter in the target device.
In such cases the automation data for a incompatible controller will simply be ig-
nored. 

D Parameters common to most instrument devices (filters, envelopes etc.) 
will be transferred to the target device whenever applicable.

Duplicating clips
To duplicate selected clips, hold down [Option] (Mac) or [Ctrl] (Windows) and pro-
ceed as when moving clips.

Moving a note lane to another track
You can move a note lane, complete with all clips to a note lane on another track:

D Click on the note lane handle in the track list and drag it to another track.
Press [Option] (Mac) or [Ctrl] (Windows) if you want to copy the lane rather than 
move it.

This operation will always create a new note lane on the track and place the clips on 
this new lane. All clips on the moved lane will keep their positions.

• The same rules apply regarding performance automation as described above.
• Track automation lanes cannot be moved using this method.

Using Cut, Copy and Paste
You can move or duplicate clips using the Cut, Copy and Paste commands on the 
Edit menu. When you Paste, the clips appear at the song position, on their original 
lane(s).

If you Paste into another Reason song document, new tracks will be created as 
needed. Since all tracks must have a device, the new tracks will be connected to 
empty Combinators - use the browser on the Combinator to select a suitable patch 
and device type. 

The same rules apply regarding alien clips and performance automation as described 
above.

Using Copy and Paste to repeat a section

When you Cut or Copy a selection, the song position will automatically move to the 
end of the selection (or, if Snap is activated, to the closest Snap value position after 
the end of the selection). This allows you to quickly repeat a section of clips, in the fol-
lowing way:

1. Make sure playback is stopped.

2. Set the Snap value to “Bar” (or to the length of the section you want to re-
peat, if is smaller than one bar).

3. Activate Snap.

4. Select the clips you want to repeat.
Since you can make selections on note lanes on several tracks, this is a quick way 
to copy entire song sections.

5. Select Copy from the Edit menu.
The song position is moved to the closest snap value after the end of the selection 
(provided that playback is stopped).

6. Select Paste from the Edit menu.
The copied section is pasted in, and the song position is moved to the end of 
pasted section.

7. Paste again, as many times as you want to repeat the section.
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Deleting clips
D To delete a clip, select it and press [Delete] or [Backspace] or select De-

lete from the Edit menu.
You can also draw selection rectangles with the Arrow tool, encompassing several 
clips and delete them all at once. The same rules apply as when selecting clips. 

Deleting clips with the Eraser tool

You can also use the Eraser tool to delete clips in Arrange mode. The Eraser tool can 
be used in two ways: You can single click on events or you can make a selection rect-
angle encompassing several events. 

Deleting clips by single clicking

D Select the Eraser tool and click on the event you want to delete.

Deleting events by making a selection rectangle

D Select the Eraser tool, click and hold the mouse button and draw a selec-
tion rectangle.
This way, you can make a selection encompassing several events and delete them 
all at once.

! Note that a clip doesn’t have to be fully enclosed to be selected - the se-
lection rectangle only needs to intersect or touch the clip.

Resizing clips
Selected clips can be resized using various methods:

D A selected clip has handles at the start and end. By dragging one of the 
the handles you can resize the clip.
You can make the clip longer or shorter. Snap, if activated, is taken into account as 
usual.

D If you make the clip shorter, any events with start positions outside of 
the clip’s boundaries will not be visible in Arrange mode and will not be 
played. 
The events will still be there although hidden (they are visible in Edit mode - see 
page 82), and will become visible and active again if you resize the clip back to the 
original length position (or longer).

When resizing the clip making it shorter, any events that fall outside the clip boundaries will be 
hidden and won’t play back.

Resizing the clip back makes the hidden notes visible and active again.

D If you resize a clip so that note events still have their start position within 
the clip boundaries but the notes “stick out” outside the clip, these notes 
will still be visible and played for the entire length of the events.

D You can resize several selected clips simultaneously. 

D You can edit a selected clip’s length numerically in the inspector strip.
See page 74.

D If you want to remove all events outside a clip (or a whole track, affecting 
all clips) and select “Crop Events to Clips” from the Edit menu.
This can be useful if you have many “outside events” and find that they make the 
view confusing when editing open clips.

D The only time Reason will automatically remove events outside clips is if 
you join two clips together (see “Joining clips”) and there are hidden 
events between the clips.
In that case, those events are removed - otherwise the joined clip would play back 
differently than the two original clips!

About overlapping clips
If you move or resize clips so that two clips overlap the following rules apply:

D Clips or sections of clips that are hidden (overlapped) will not play back.
Each note lane will play a single clip at a time - if you want to mix two note clips, 
put them on separate lanes.

D The clip with the later start position will appear on top (and be played 
back).
This means if a shorter clip is placed “in the middle” of a longer clip, the program 
will play the beginning of the long clip, then the shorter clip and then the end of the 
long clip.

D If both clips start at the same position and have the same length, one of 
the clips will be completely hidden, and won’t play back at all.
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Drawing clips
You can draw empty clips in Arrange mode using the Pencil tool. This is useful if you 
want to manually draw events into a clip.

D Select the Pencil tool and draw over the range you want the clip.
Snap is taken into account. The type of clip you create depends on the lane type 
(note lane, pattern lane etc.).

Muting clips
Selected clips can be muted:

D Select the clips and then select “Mute Clips” from the Edit menu or from 
the clip context menu.

You can also select clips and press “M” to mute them. Unmute by selecting “Unmute 
Clips” or by pressing M again. Muted clips are shown without colors and with dimmed 
borders.

A muted clip.

Joining clips
Separate clips on a lane can be joined to one clip. You can even join clips that aren’t 
directly adjacent on the lane. It works in the following way:

1. Select the clips you wish to join.

2. Select “Join Clips” from the Edit menu or from the clip context menu.
A single clip is created. If there was a gap between the clips before the operation 
this area will be empty - the relative positions of all events in the original clips will 
be kept in the joined clip. See also the note about events outside clips on page 73.

D You can also join selected clips that have other unselected clips between 
them.
The unselected clips in between will then overlap and mask the joined clip at their 
original positions.

Splitting clips
You can split clips using the Razor tool in the following ways:

D Clicking with the razor tool on a clip splits it at the click position (taking 
the Snap setting into account). 
The Razor tool’s left edge has a line that indicates where the split will take place.

D You can also click and drag with the razor tool to cut out a range, on one 
or several lanes. 

D To split clips on all tracks and lanes, click (or click and drag to make a 
range selection) in the ruler.

Naming clips
You can name an individual clip by selecting it and then selecting “Add Labels to 
Clips” from the Edit menu (or the clip context menu). A text field is opened where you 
can enter a name for the clip.

When adding labels to several selected clips in one go, they will all get generic names 
according to the clip type (e.g. “untitled note clip”). Double-clicking on a label opens 
the text field where you can enter the label text.

About the inspector strip and selected clips

The inspector strip is located above the ruler. Here you can edit clips and events nu-
merically using value fields, or add automation or pattern lanes. What is shown in the 
inspector strip varies according to whether a track, clip or an event of some type is se-
lected. 

For clips it works as follows:

D If no clip is selected (or if the track list has focus), only the Track Param-
eter Automation pop-up (see page 84) and the Create Pattern Lane but-
ton are shown.
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D If you select a clip, two value fields appear, showing the clip start posi-
tion (Pos) and the clip length (Len) in bars, beats, 1/16 notes and ticks (in 
that order).
You can edit these numerical values by selecting a value field (e.g. beats) and 
dragging, using the spin controls or typing. This will change the corresponding 
start position (or length) of the selected clip in increments of the selected value. 
Snap is not taken into account.

D If several clips are selected on the same track lane, the value fields will 
show the position and length for the clip with the earliest start position.

D If several clips are selected on different tracks (or lanes), the clip on the 
uppermost track or lane is shown.
If the uppermost track/lane has several selected clips, the value for the clip with 
the earliest start position on this lane is shown.

Editing values for several selected clips

When you edit values for several selected clips, the changes will always be relative. 
For example if you raise the clip position by 2 beats when several clips are selected, 
they will all move by 2 beats, retaining their relative positions.

✪ You can also add or subtract to values by typing “+” or “–”.
For example, selecting the Bars value in the Position display and typing 
“+3” will move all selected clips three bars forwards.
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About Match values

When several clips are selected and their values differ in position and/or length, the 
Match values button appears beside the corresponding numerical value field (position 
or length).

The Match values button.

These buttons can be used to match the values so that all clips get the same position 
or length, respectively. It works as follows:

These 3 clips have the same start positions but different lengths so only the length value field shows 
the Match values button.

Now the selected clips have different start positions and different lengths so both value fields shows 
the Match values button.

If you click on the position Match values button all selected clips will get the same start position and the 
button disappears.

If you click on the length Match values button all selected clips will get the same length and the button 
disappears.

About subticks

When editing you have a resolution of 240 ticks per 1/16 note, which allows for very 
accurate positioning. But when you record notes, the internal resolution is even higher 
(15260 ppq) which means that values can be fractions of a tick (subticks). This is in-
dicated by an asterisk after the tick value. 

To round off the value to the nearest tick, [Command]-click (Mac)/[Ctrl]-click (Win-
dows) on the asterisk.
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Inserting and Removing Bars
When editing the overall structure of a song, you may need to rearrange the order and 
length of whole sections (e.g. make the “verse” two bars shorter, add a few bars to 
the intro, etc.). On the Edit menu or sequencer context menu you will find two useful 
functions for this:

Insert Bars Between Locators

This function inserts an empty area between the locators. All clips that intersect the 
locator positions on all tracks after the left locator are split and moved to the right to 
“make room” for the inserted area.

Remove Bars Between Locators

This function removes all material between the locators. All clips that intersect the lo-
cator positions on all tracks after the left locator are split and moved to the left to “fill 
out” the gap after the removed section.

Clip color
D You can color selected clips independently from track color by selecting 

“Clip Color” from the Edit menu and then choosing a color from the sub-
menu.
All selected clips will get the selected color. If you record new clips on the lane, 
the set Track color applies.

Editing automation clips in Arrange mode
Double-clicking an automation clip opens it for editing, but unlike note clips you will 
stay in Arrange mode and not switch over to Edit mode. This is convenient if you only 
want to edit the automation events for one specific parameter. How to edit the auto-
mation is identical to how it’s done in Edit mode - see page 85 for a description of 
this.

To close an open automation clip in Arrange mode click outside it (in another lane) or 
press Return or Escape.

Other editing functions in Arrange mode
You can also apply quantizing (see page 89) and use the edit functions on the Tool 
window - Tools page (see page 89) in Arrange mode. This is useful since it allows you 
to edit clips on several tracks in one go.

D You can select one or several tracks and have quantizing or other Tools 
page edit functions apply to all notes in all clips on the selected tracks.
Selecting several tracks is done by [Shift]-clicking in the track list. The Tool win-
dow - Tools page edit functions are described on page 89.
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The Edit mode
The Edit mode allows you to edit events inside a clip. This is where you perform de-
tailed editing of note and automation events. 

D To select Edit mode, click the Edit/Arrange mode button in the top left 
corner of the sequencer area.

Edit mode selected with a note clip open for editing.

You can also toggle between Arrange mode and Edit mode by pressing [Shift]-
[Tab] or [Command]/[Ctrl]+[E].

Selecting what to edit
The Edit mode always shows the contents of a single track (or for a single note lane 
on a track) at a time. Only one note lane can have edit focus at a time.

D If one track is selected when you enter Edit mode, that track contents will 
be shown.
All clips on this note lane will be shown and available for editing but no clips will be 
open, and the clip events will be grayed out. To be able to edit or draw notes or au-
tomation events, you need to open a clip, as described below.

D If the track has multiple note lanes it will show the contents of the cur-
rently selected note lane. 
To switch between note lanes, click on the note lane handle.

D You can change track at any time, by clicking in the track list.
This way you can stay in Edit mode and select different tracks and note lanes for 
editing, without having to go back to Arrange mode. 

D Double-clicking a automation clip will open it for editing in Arrange 
mode which is convenient for quick editing of a single parameter. 
All track parameter automation clips for a track are shown and can be edited in 
Edit mode. How to edit automation is described on page 85.

Opening a clip in Edit mode

D To edit the contents of a note clip, double-click it, or select it and press 
[Return].
Opening a note clip automatically switches the sequencer to Edit mode. 

Double-clicking a note clip in Arrange mode...

...opens it for editing in Edit mode. An open clip in Edit mode is highlighted. 
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The Edit mode elements
In Edit mode, the view is divided into various edit lanes which are used for editing dif-
ferent types of events in a note clip (i.e. notes, velocity and performance controller au-
tomation events). Any Track parameter automation lanes on the track will also be 
shown and can be edited in Edit mode.

The picture shows three clips in Edit mode. The middle clip is open for editing. Adjacent clips on the 
same lane will be visible but the events will be grayed out.

From the top down in the picture, the Edit mode view contains the following elements:

D At the top is the Overview. 
The Overview shows all the clips on the selected track note lane. It displays clips 
like in Arrange mode and you can select several clips on the same note lane. You 
can perform any clip-based editing in the Overview - it works exactly like in Ar-
range mode - but you can only apply the editing to clips on the same lane.

D Next is the Note edit lane where you perform all of your note event edit-
ing. 
Here you can edit notes for one open clip at a time. The Note edit lane can show 
one of three Note edit modes (see page 79). 

D Below the Note edit lane is the Velocity edit lane where you can graphi-
cally edit note velocity values. See “Editing velocity”.

D Next you have edit lanes for performance controller automation. 
Each performance controller you use when recording will get a separate edit lane. 
You can also add performance controller lanes using the Note Lane Performance 
Parameter Automation pop-up above the vertical zoom controls to the right. See 
page 87.

D Lastly, any Track parameter automation used will be shown on separate 
lanes.
Note that Track parameter automation does not “belong” to the selected note lane 
or note clip, and will not be selected if a note clip is open. Clips on Track automa-
tion lanes will affect all active note lanes on a track at the same position. Double-
clicking on a Track parameter automation clip will open it for editing. See “Editing 
automation”.

About the note edit modes

By default, the note edit mode selected when you select Edit mode depends on the 
device type to which the track is connected. For standard instrument tracks, Key edit 
mode is selected, for Redrum tracks, Drum edit mode is selected, and for Dr.Rex 
tracks, the REX edit mode is selected. 

You can manually change between these modes by using the pop-up in the upper 
right corner of the note area.

The note edit mode can be stored individually for each track (or each note lane on a 
track). The next time you select Edit mode for that track (or note lane), the note edit 
mode will be the same.

Key edit mode. The piano keyboard to the left indicates the pitch of the notes, covering the whole MIDI 
note range (C-2 to G8). Note that the black and white keys are reflected in the background colors of 
the grid, making it easier to find the right pitch when drawing and moving notes!
Use this when editing instrument tracks.

Overview

Note edit lane

Velocity 
edit lane

Performance 
controller edit 
lanes.

Track 
parameter 
automation 
lanes.
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Drum edit mode. This is divided vertically into note numbers, corresponding to the drum sound 
channels on a Redrum device (and named accordingly, if the track is connected to a Redrum device). 
Use this for editing drum tracks.

REX edit mode. This is divided vertically into pitches (from C3 and up), corresponding to the slices in 
a Dr.Rex loop player device. Use this for editing Dr.Rex tracks.

D In all three modes, the actual notes are shown as “boxes”, with the note 
length indicated by the width of the box and the velocity values indicated 
by the color of the box (the darker the color, the higher the velocity).
The basic note editing procedures are the same for all three lanes.

About separate Snap values for arranging and editing

There are two different Snap settings, one for when a clip is open for editing, and one 
for when no clip is open (e.g. in Arrange mode). Typically, you would set a fine Snap 
value (e.g. 1/16) for open clips and have the other Snap value set to “Bar” for conve-
nient arranging. You can also choose to turn Snap off in any of these modes, indepen-
dently of the other setting.

D The Snap value for editing is used whenever a note clip or automation 
clip is open (including when an automation clip is opened in Arrange 
mode).
However, there’s one exception: If a note clip is open in Edit mode and you click in 
the Overview, the clip will remain open but the Snap value for arranging will be se-
lected. This allows you to e.g. move or resize the clip in the Overview just like in Ar-
range mode, without closing it first.

Edit mode window handling

Resizing and Zooming

D You can resize or hide edit lanes by dragging the dividers between them.

D Where applicable, the lanes have individual zoom controls and scroll-
bars.

D The Magnifying Glass tool can be used for zooming in and out.
Click to zoom in, and click while pressing [Option] (Mac)/[Ctrl] (Windows) to 
zoom out.

D The Hand tool can be used for scrolling the view in any direction.
Just click, hold and drag in the desired direction.

D For extensive editing, you may want to detach the sequencer area from 
the rack and use it in a separate window. 
This is done either by clicking the Detach Sequencer button in the rack or by se-
lecting “Detach Sequencer Window” from the Windows menu.

To reattach the sequencer, either click the Attach Sequencer button (in the rack or in 
the detached sequencer window) or select “Attach Sequencer Window” from the 
Windows menu.

D Alternatively, you can also maximize the sequencer area so that it fills 
the rack.
This is done by clicking the Maximize Sequencer button or by holding down [Com-
mand] (Mac) or [Ctrl] (Windows) and pressing [2] on the left part of the computer 
keyboard.

The Detach Sequencer button.

The Maximize Sequencer button.
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Drawing Notes
Notes are drawn and edited primarily in the Key lane, but all actions described apply 
to the Drum lane and the REX lane:

Drawing notes

1. Make sure the note clip is open.
If not, select it and press [Return], or double click it.

2. If you want to restrict note input to certain note values (e.g. sixteenth notes), 
set the snap value accordingly and activate Snap.

3. Select the Pencil tool.
You can toggle temporarily between the Arrow tool and the Pencil tool by holding 
down [Command] (Mac) or [Alt] (Windows).

4. If needed, click in the piano keyboard display, drum sound list or slice list to 
find the correct pitch or sound.

5. Click in the note display part of the lane, at the desired position.
A note will be inserted at the closest Snap value position.

D If you just click and Snap is activated the note will get this length.
If snap is off, the note will get the length of the shortest snap value, i.e. 1/64.

D If you instead click and keep the mouse button pressed, you can drag to 
the right to set the length of the note.
If Snap is on, the length will be a multiple of the Snap value. Also, see the note 
about drum note lengths below.

Editing Notes
Notes can be edited manually by using your mouse in Edit mode, or numerically in the 
Inspector. Event editing in the Inspector is described on page 83.

Selecting notes

To select notes in Edit mode, use one of the following methods:

D To select a note in an open clip, click on it with the Arrow tool.

D To select several notes, hold down [Shift] and click.
You can de-select individual notes by [Shift]-clicking them again.

D You can also click and drag a selection rectangle around the notes you 
want to select.

D You can select the next or previous note on the lane by pressing the right 
or left arrow key on the computer keyboard.
Holding down [Shift] and using the arrow keys allows you to make multiple selec-
tions.

D To select all notes in the clip, use the Select All function on the Edit 
menu.
Make sure that the correct lane (Key, Drum or REX) has focus first - otherwise you 
may select automation or pattern change events. To set focus to a lane, click 
somewhere in it (focus is indicated by a thin extra border within the lane).

D To deselect all notes, click somewhere in an empty area.

Moving notes

D To move a note, click and drag it to a new position. 
If several notes are selected, all will be moved. The individual distance between 
the moved notes will be kept.

D If Snap is on, the moved events will keep their relative distance to the 
Snap value positions. 
For example, if Snap is set to “Bar”, you can move the selected notes to another 
bar without affecting their relative timing.

D If you hold down [Shift] when you drag, movement is “magnetic” to hori-
zontal or vertical only.
This helps you move notes without accidentally transposing them, or transposing 
notes without accidentally changing their meter position.

D You can also edit the note positions numerically in the inspector.
See “Editing note events in the inspector strip”.
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Nudging event positions

You can use the left/right arrow keys to “nudge” the positions of selected events. It 
works as follows:

• Pressing [Command] (Mac)/[Ctrl] (Windows) and using the left or right arrow key 
moves the position back or forward by the set Snap value.

• Pressing [Command]+[Option] (Mac)/[Ctrl]+ [Alt] (Windows) and using the left 
or right arrow key moves the position back or forward in tick increments (there are 
240 ticks per 1/16 note so this is very fine editing - check the tick positions in the 
inspector when you nudge because otherwise you won’t “see” the position 
changes).

• Pressing [Command]+[Shift] (Mac)/[Ctrl]+ [Shift] (Windows) and using the left or 
right arrow key moves the position back or forward in beat increments.

Duplicating notes

To duplicate the selected notes, hold down [Option] (Mac) or [Ctrl] (Windows) and 
proceed as when moving notes.

Using Cut, Copy and Paste

You can move or duplicate events using the Cut, Copy and Paste commands on the 
Edit menu.

D When you Cut or Copy, the song position is automatically moved to the 
end of the selection.
You can use this for repeating events.

D When you Paste, the events appear at the song position, on the original 
lane.
You can only paste notes when a note clip is open for editing.

Resizing notes

When you select a note, a handle appears on its right edge. You can click on this han-
dle and drag to make the note shorter or longer.

D If Snap is on, the end of the note will be magnetic to the Snap value po-
sitions.
You can disable this function temporarily by pressing [Shift] when you drag. This 
allows you to resize the note to any length, regardless of the Snap value.

D If several notes are selected, all will be resized by the same amount.

D When resizing notes the event may extend outside the right clip edge.
As long as the start position of events is inside the clip, the note will play for the 
whole duration, i.e. it won’t be cut off when the clip ends.

D You can also edit the length of notes numerically in the inspector.
See page 83.

About resizing drum notes

Drum notes can be resized as any other notes. However, the result of this depends on 
the settings of the Decay/Gate switch and the Length knob for the drum sound on the 
Redrum panel:

D If Decay mode is selected, the drum sound will play to its end, regardless 
of the note length.
Or rather, it will fade out according to the Length setting.

D If Gate mode is selected, the note length affects the resulting sound.
However, the maximum length of the sound is set by the Length knob - the sound 
will be cut off after this length, regardless of the note length. 
Finally, even if the Length knob is set to its maximum value, the sound will not play 
longer than the length of the drum sample.

Deleting notes

You can delete notes in two ways: 

D Select them and press [Backspace] or [Delete], or select Delete from the 
Edit menu.

D Select the Eraser tool and click on the notes you want to delete.

About masked events

If you resize a clip (making it shorter) events may be masked, i.e. events may end up 
outside the clip. Such events are not played back and are not visible in Arrange mode. 
Masked events are visible for open clips in Edit mode.

Masked note events outside a clip have a white border and the background is dark.

Note that just switching to Edit mode won’t show masked events. A clip has to be 
open to see these events. You can remove masked-out events using the function 
“Crop Events to Clips” on the Edit menu (see page 73).
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Editing velocity

The velocity values of notes can be edited manually in the Velocity lane,

The velocity values are shown as bars, with higher bars indicating higher velocity. Note also that the 
color of the notes and bars reflect the velocity.

To change the velocity of a note, click on its velocity bar with the Pencil tool and drag 
the bar up or down. Clicking above a bar immediately raises the velocity to the level at 
which you click.

You can also edit the velocity of several notes at once by clicking and dragging with 
the Pencil tool.

D With the Pencil tool selected, pressing [Option] (Mac) or [Ctrl] (Win) will 
change the pencil cursor to a cross. 
This is the Line tool which is special tool only available in the Velocity edit lane. By 
dragging across the bars, at the desired height you can quickly draw velocity 
ramps.

Drawing a velocity ramp with the Line tool.

The Line tool is probably the preferred method for creating regular, smooth ramps, or 
for giving all the notes the same velocity (by drawing a straight line), while the Pencil 
tool can be used for creating more irregular curves.

! If you hold down [Shift] when you edit velocity values, only the selected 
notes will be affected!

This can be very useful, especially in “crowded” sections with lots of notes. 
Consider for example if you have a busy drum beat, and want to adjust the velocity of 
the hi-hat notes only. Simply dragging with the line- or pencil tool would change the 
velocity of all other drum notes in the area too, but if you first select the hi-hat notes in 
the Drum lane and press [Shift] as you draw, you can edit their velocity without affect-
ing any other notes!

D You can also edit velocity values numerically in the Inspector (see be-
low).

Editing note events in the inspector strip 
The inspector strip is located above the ruler. Here you can edit clips and events nu-
merically using value fields, or add automation or pattern lanes. What is shown in the 
inspector strip varies according to whether a track, clip or an event of some type is se-
lected. 

For note events it works as follows:

D If you select a note event, four value fields appear, showing the event 
start position (Pos), length (Len), note pitch and velocity (Vel).
You can edit these numerical values by selecting a value field and dragging, using 
the spin controls or typing. Snap is not taken into account.

D Note that when moving the position of events these may end up outside 
the clip and be masked (not played).
There will be no warning or indication of this other than you will be able to clearly 
see if any events are outside the clip boundaries if the clip is open in Edit mode. 
See page 82.

D If several note events are selected, the value fields will show the values 
for the event with the earliest start position.

Editing values for several selected events

When you edit values for several selected events, the changes will always be relative. 
For example if you change the event position when several events are selected, they 
will all move by the same amount, retaining their relative positions.

D If several events are selected and their values differ, the Match values 
button appears beside the corresponding numerical value field.
Clicking this sets the property (e.g. velocity) to the same value for all selected 
events, and makes the button disappear. See “About Match values”.
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About subticks

When editing you have a resolution of 240 ticks per 1/16 note, which allows for very 
accurate positioning. But when you record notes, the internal resolution is even higher 
which means that values can be fractions of a tick (subticks). This is indicated by an 
asterisk after the tick value.

To round off the value to the nearest tick, [Command]-click (Mac)/[Ctrl]-click (Win-
dows) on the asterisk.

Editing automation
Automation in Reason is vector-based. This means automation is stored as automa-
tion events (points), connected by lines.

A level fade for a mixer channel (upper) and a more complex filter sweep (lower).

D Track parameter automation is contained in automation clips on auto-
mation lanes. 
Each automated parameter has its own automation lane. 

D Performance controller automation is stored on edit lanes in note clips.

See “Performance controller vs. track parameter automation” for a description of 
these two automation methods. From here on, track parameter automation is de-
scribed unless otherwise indicated.

Adding/removing automation lanes

This track has three automation lanes. The “LFO2 Amount” lane is turned off (ON button is dark) - this 
is useful for muting automation temporarily.

Most of the time you will probably simply start recording and tweak parameters to au-
tomatically add automation lanes - see “Recording track parameter automation”.

But in some cases you may want to add empty automation lanes to draw events in 
clips on the lane rather than record the automation. Automation lanes can be added in 
several ways:

D Hold down [Option] (Mac) or [Alt] (Windows) and click on a parameter on 
a device panel in the rack.
This directly adds an automation lane for the selected parameter.

D You can do the same thing by selecting “Edit Automation” on the context 
menu for the parameter.
You bring up the parameter context menu by [Ctrl]-clicking (Mac) or right-clicking 
(Windows) on the parameter on the device panel. 

D Once there is an automation lane (and its ON button is lit), the parameter 
is automated and will be shown with a green automation frame on the 
device panel. 
Outside the automation clip, the parameter will be set to a static value (the blue 
line on either side of the clip in the picture above). This can be edited, as de-
scribed below.

D By using the Track parameter automation pop-up menu on the se-
quencer toolbar you can add or delete individual automation parameter 
lanes from the sequencer.
Existing automation lanes are indicated by a tick mark on the pop-up menu. Con-
trollers for which there is data (automation) in the track are indicated with an icon. 
If the device has many parameters you can select the “More Parameters...” at the 
bottom of the menu. A dialog then opens where all parameters for the device are 
listed. 

D If you tick an automation parameter (on the pop-up menu or in the Pa-
rameter Automation dialog), an empty automation lane is created for the 
track.

D To remove an automation lane, you can either untick it in the list/dialog 
or select the “Delete empty automation” item on the pop-up. 
Automation lanes that are in use (contain clips) are indicated with a blue automa-
tion symbol. Note that removing a used automation lane will delete all its automa-
tion data!
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D You can also remove automation lanes by using the Delete Automation 
Lane (“X”) button in the track list for the corresponding lane. 
If you try to remove an automation lane with clips on it, an alert dialog opens where 
you can select to cancel the operation or to proceed.

Editing existing automation events 

As explained previously you can edit automation clips in Arrange mode. They open like 
a “mini instance” of Edit mode that only shows the selected automation clip’s con-
tents, not the contents of the note lane. Editing automation is the same whether you 
do it this way or in Edit mode (except the Static value for the automation lane is only 
shown in Edit mode). 
The following section describes editing automation in Edit mode.

To edit existing automation events, proceed as follows:

1. Select Edit mode for the track that has the automation you wish to edit. 
Use the dividers if necessary to locate the automation clip to edit - these are lo-
cated at the bottom pane of the window (not in the note clip). Track parameter au-
tomation clips have a cut upper right corner. (There might be performance 
automation edit lanes on the track also and these are edited in the same way but 
for now we stick to track parameter automation.)

2. You open the clip for editing by double clicking it or by selecting it and press-
ing Return. 
The clip is now open for editing.

D In Edit Mode, the static value is shown to the left in the automation lane.
In this example, the static value is set to 50 - this means that the Filter Freq param-
eter will be set to 50 everywhere in the song except where there are automation 
clips for it. To change the static value, drag the handle or double-click and type.

3. When an automation clip is open, you can select, move, copy or delete auto-
mation points, just like editing notes in the note editor.
When moving automation events with the Arrow tool, snap is taken into account if 
activated. You can also resize the clip by dragging the clip handles in Edit mode.

D A selected automation event’s position and value is also shown in the In-
spector.
These values can be edited numerically just like for note events - see page 83.
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About Automation Cleanup

D If you find you have gotten too many automation points when recording 
or drawing events, you can adjust the “Automation Cleanup” setting to 
“Heavy” or “Maximum” in the Preferences dialog - General page. 
This automatically removes superfluous automation points next time you record or 
draw events and simplifies the curves. Note that snap also governs the number of 
points when drawing events - see below.

Drawing automation (left), and after (right).

You can also apply this function to already recorded events manually from the Tool 
window:

1. With the automation clip open for editing (i.e. with the points showing) chose 
“Select All” from the Edit menu or the clip context menu.
All automation point will be selected in the clip.

2. Make sure the Tool window is open - if not press the [F8] function key.
This toggles the Tool window show/hide status.

3. Select the Tools page.

4. The Automation Cleanup tab is at the very bottom of the page - click the ar-
row to open it.

5. Select a value and then click Apply.
The selected automation events are now thinned out according to the selected 
settings.

Drawing automation events

D To add new points, click or drag with the Pencil tool.
The resulting curve (i.e. the number of points) depends on two factors; the se-
lected “Automation Cleanup” setting in the Preferences (see “About Automation 
Cleanup”), and the snap value (if Snap is activated).

D Pressing [Alt] (Win) or [Option] (Mac) and clicking or dragging with the 
Pencil tool will insert an automation range. 
The length of the range is set with the Snap value.

Alt]/[Option]-clicking with Snap set to 1/4. 

D When the automated parameter is “stepped” rather than continuous, 
there will be abrupt steps between the automation points instead of lin-
ear ramps.

Stepped automation.

D If you mask the automation clip, making it longer, the first or last auto-
mation value will be extended.

Here, a Mute button on a mixer is automated. The clip contains a single automation point, but its 
value extends to the start and end of the clip. This means you can adjust the channel mute 
automation by moving and resizing the clip, without having to open it.

Deleting automation events

D Deleting automation events is done in the same way as deleting note 
events. I.e. you can click on points to select them or draw selection rect-
angles and then press [Backspace] or use the Erase tool etc. 
To clear all automation in a clip simply delete the clip (or remove the whole lane to 
clear all automation for that parameter).
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Editing performance controller automation

To edit, draw or delete performance controllers, open the note clip. 

Performance controllers (in this case, Mod wheel) are shown on separate edit lanes at 
the bottom of the open note clip. The performance controller curves are also indicated 
in the overview (top), and the clip in Arrange mode.

• You edit performance controller data just like regular automation.
• You can create or delete performance controller lanes for any parameter using the 

pop-up menu on the right side bar of the note edit lane. This works the same way 
as for track parameter automation except you cannot mute or delete performance 
automation from the track list - see “Adding/removing automation lanes”.

Special case scenario

Although very unlikely, it is possible to have overlapping track parameter and perfor-
mance automation for the same parameter. In such an event, the track parameter au-
tomation overrides the performance automation. As soon as the track parameter clip 
ends any performance automation in the clip takes over.

Editing Pattern Change clips
Pattern change clips are viewed and edited in the Pattern Select lane, which is avail-
able on Redrum tracks and Matrix tracks:

A pattern change is shown as clips with a pop-up menu area at the top (given the clip 
is selected).

D When you record pattern change clips, they are automatically positioned 
on downbeats (at the beginning of new bars) regardless of the Snap set-
ting. 
See “Recording pattern changes”.

D If clips aren’t continuous on the pattern change lane the pattern device 
will be silent where there is no clip.

Manually adding a Pattern Select lane

A Pattern Select lane is automatically created when recording pattern automation, but 
if you prefer you can create an empty Pattern lane in the following ways:

1. Select the pattern device.
Make sure no clips are selected

2. Click the “Create Pattern Select Lane” button on the toolbar.

D You can also [Alt]/[Option]-click on the Pattern select buttons to create 
a Pattern Select lane.
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Drawing Pattern clips

You can draw pattern clips on the Pattern Select lane with the Pencil tool:

1. Activate Snap and set the Snap value to the note position where you want to 
insert the pattern change clip.
It is probably a good idea to set Snap to “Bar”, at least if you are working with pat-
terns of a length corresponding to the time signature (e.g. 16 or 32 step patterns 
and 4/4 time signature). However, if you are working with patterns of another 
length, it can make sense to use other Snap values.when drawing Pattern clips.

2. Select the Pencil tool.
A Pattern pop-up appears in the Inspector. Use this to select the pattern you wish 
the clip to play.

3. Draw a clip for length you want the selected pattern to play.

4. Continue using the same method to draw clips for all the patterns you wish 
to use.

! Don’t draw pattern change clips with Snap turned off, unless you want 
chaotic rhythm changes!

Manually editing pattern change clips

To manually edit a Pattern change clip, proceed as follows:

1. Select the pattern change clip you wish to edit.

2. Pull down the Pattern pop-up menu to the left in the pattern clip (the down 
arrow), and select the Bank/Pattern you want to insert.
The selected pattern is shown next to the pop-up menu.

D You can also change Bank/Pattern with the Inspector Pattern pop-up if 
the Pencil tool is selected.

Moving and duplicating pattern change clips

You can move, resize and duplicate pattern change clips in the same way as with note 
or automation clips. However it is recommended that snap is activated (and in most 
cases set to “Bar”) when you do this.

You can also move or duplicate sections using the Cut, Copy and Paste commands 
on the Edit menu. Again, the same rules apply as for other clips.

Deleting pattern change clips

D Deleting pattern change clips is done in the same way as deleting note 
clips. I.e. you can draw selection rectangles and then press [Backspace] 
or use the Erase tool etc. 
To clear all automation in a clip simply delete the clip (or remove the whole lane to 
clear all pattern change automation).
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Tool window - Tools page 
note editing functions
The Tool window - Tools page contains some special editing functions. Proceed as 
follows:

1. Select the clips or events to which you want to apply the editing functions (in 
Arrange or Edit mode).
The functions are mainly used with notes, but not all; the Scale Tempo function will 
also affect automation and pattern changes (see below), and Automation Cleanup 
only affects automation events. Automation Cleanup is described separately - see 
“About Automation Cleanup”.

2. Make sure the Tool Window is open.
The [F8] key shows/hides the Tool Window.

3. Select the Tools page.

D The Tools page has a number of panes, each with a separate function.
The panes can be folded/unfolded by clicking on the arrow beside the function 
name.

4. Make settings for one of the functions on the page and click the Apply button 
next to the settings.
All settings can be made by clicking the spin controls, or by clicking in a value field 
and entering a value numerically. The functions are described below.

Quantizing
The Quantize function moves recorded notes to (or closer to) exact note value posi-
tions. This can be used for correcting errors, “tightening up” recorded music or 
changing the rhythmic feel. 

In Reason, you use the Quantize function in the following way:

1. Select the notes you want to quantize.
Only the note events will be affected, so you can select note clips or whole tracks 
if you like.

2. Pull down the Quantize Value pop-up menu on the Tool Window - Tools page 
and select a Quantize value.
This determines to which note values the notes will be moved when you quantize. 
For example, if you select sixteenth notes, all notes will be moved to (or closer to) 
the closest sixteenth note position.

The Quantize pop-up menu.

3. Select a value from the Quantize Amount pop-up menu.
This is a percentage, governing how much each note should be moved. If you se-
lect 100%, notes will be moved all the way to the closest Quantize value positions; 
if you select 50%, notes will be moved half-way, etc.
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4. Click the Quantize “Apply” button.
The selected notes are quantized.

In this example, a sloppily recorded hi-hat pattern is quantized to straight 1/4 notes (Quantize value 
1/4, Strength 100%).

Random

You can offset the quantized notes using the Random function. The notes will be 
quantized according to the Value and Amount settings, but the note positions will be 
randomly offset by the set tick value. E.g. if you set Random to 10 ticks, the notes po-
sitions will randomly vary within a +/- 10 tick range after quantizing.

Quantizing to Shuffle

On the Quantize pop-up menu, you will also find an option called “Shuffle”. If this is 
selected when you quantize, the notes are moved towards sixteenth note positions, 
but with the Shuffle applied. 

Shuffle creates a “swing feel” by delaying the even-numbered sixteenth notes (the six-
teenth notes that fall in between the eighth notes). The amount of Shuffle is set with 
the Global Shuffle control in the ReGroove Mixer - see the ReGroove Mixer chapter 
for details.

Quantizing to Shuffle is useful if you want to match the timing of recorded notes with 
pattern devices in the song (if Shuffle is activated in the patterns).

D The Quantize Strength setting applies as when quantizing to regular 
Quantize values.

Quantizing during recording

You can have Reason quantize notes automatically when they are recorded. This is 
done by activating the “Quantize Notes during Recording” button on the transport, 
before you start recording. The Quantize settings apply as usual.

Pitch (Transpose)
D This function transposes the selected notes up or down, by the specified 

number of semitones.

D You can also Randomize the pitch for selected notes. By setting a Low/
High range the note pitches will be randomized within this range when 
you click Apply.

Velocity
Adjusts the velocity of the selected notes.

D The Add field lets you add a fixed amount to the velocity values.
To subtract, enter a negative amount. Note that the possible velocity range is 1-
127. Adding an amount to a note with velocity 127 will not make any difference.

D Fixed allows you to set all velocities to a set value.

D The Scale field allows you to scale velocities by a percentage factor.
Scaling with a factor above 100% will increase the velocity values, but also make 
the difference between soft and hard notes bigger.
Scaling with a factor below 100% will decrease the velocity values, but also make 
the difference between soft and hard notes smaller.

D Randomize will randomize velocity values by a set percentage value.

D By combining the Add and Scale functions, you can adjust the “dynam-
ics” of the notes in various ways.
For example, by using a Scale factor below 100% and Add a suitable amount, you 
can “compress” the velocity values (decreasing the difference between the veloc-
ity values without lowering the average velocity).

Note Lengths
D Note Lengths allows you to add or subtract values to selected note’s 

length. You select length values in the same way as in the Inspector, i.e. 
select a value (bars, beats, 1/16ths or ticks) and then use the spin con-
trols to set the amount.

D You can also set all notes to the same length by using the Fixed value 
field.
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Legato Adjustments
This function can be used to extend each selected note so that it reaches the next se-
lected note. You can also shorten the note length for one of two selected overlapping 
notes to set a gap between them. You specify the desired gap or overlap in the value 
fields. Note start positions are never changed, only the note length is affected by Le-
gato adjustments.

D Side by Side extends the selected note to the start of the next selected 
note.

D Overlap extends the selected note to overlap the next selected note by a 
set amount.

D Gap will introduce a gap between selected notes, as specified in the 
value fields.

Gap is set to 1/16 note value.

Scale Tempo
This function will make the selected events play back faster (Scale factor above 
100%) or slower (Scale factor below 100%). This is achieved by changing the posi-
tion of the events (starting from the first selected event) and adjusting the length of 
the notes accordingly.

The result of applying Scale Tempo with the Scale factor 200% (double speed).

D The buttons Double and Half are “shortcuts” to Scale factors 200% and 
50%, respectively.
These are probably the most common values used, simulating double tempo and 
half tempo.

! This function affects all types of events: notes, controllers and pattern 
changes! 

Alter Notes
This function alters the properties pitch, length and velocity of the selected notes, in a 
random fashion. 

D The function will only “use” values that already exist among the selected 
notes.
For example, if you have selected notes within a specific pitch interval, the altered 
notes will remain within this pitch interval. Similarly, only velocity values and note 
lengths that were already used in the selection will be applied by the Alter function. 
You could say that the function “shuffles” the existing properties in a selection and 
redistributes them among the notes.

! This means that the less variation there is among the selected notes, the 
less the effect of the Alter function.

D You can adjust the amount of Alteration with the Amount value.

✪ This function is especially useful for experimenting with REX loops. Se-
lect some notes on a Dr.Rex track and use Alter Notes to create instant 
variations, without losing the timing and rhythmic feel of the loop!
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Copying patterns to 
sequencer tracks
As described on page 288, you can use the “To Track” function when using the 
Dr.Rex Loop Player device. This creates sequencer notes on the selected track, so 
that each slice in the REX loop gets a corresponding sequencer note. Playing back 
the sequencer track will then play all slices in the correct order, with the original timing 
of the loop.

Similar functions are available for the Redrum and Matrix devices. 

• By using the function Copy Pattern to Track on the Edit menu or device context 
menu, you can copy the contents of the current pattern to a note clip on the se-
lected sequencer track. 

• The function Convert Pattern Track to Notes works in a similar way, but converts 
all patterns in a song to note clips (taking pattern changes into account).

✪ There is also a similar function for the RPG-8 Arpeggiator - see “Render-
ing arpeggio notes to track” for a description.

The procedures differ slightly for the different device types:

Using the “To Track” function for REX Loops
This assumes that you have loaded a REX loop into the Dr.Rex device. For details, see 
page 287.

1. Set the left and right locator to encompass the section you want to “fill” with 
notes for the REX loop.

2. Select the track connected to the Dr.Rex device.

3. Click the “To Track” button on the Dr.Rex device panel.
The slices in the loop will be converted to note events in note clips of the same 
length as the loop. Depending on the set length one or several clips are created to 
fill out the locator range,

D If the length of the area between the locators is greater than the length 
of the REX loop, the clips will be repeated on the track note lane.
This function always creates an exact number of clips, meaning that the last clip 
may “stick out” after the right locator.

Here, the loop was 4 bars long. Since there are two bars between the locators, the clip will stick 
out after the right locator.

The “Copy Pattern to Track” function
This is available for the Redrum and the Matrix. It is useful when you have created a 
single pattern and want to use it as starting point for editing in the sequencer. You 
could also use this if you e.g. have created a drum pattern and want to have this pat-
tern play back some other type of device.

Proceed as follows:

1. Set the left and right locator to encompass the section you want to “fill” with 
the notes in the pattern.
You may want to make sure the length of the area between the locators is a multi-
ple of the pattern length, to avoid “cutting off” the pattern.

2. Select the track you wish to copy the notes to.
If you use this function with Redrum, you should normally select the Redrum track. 
If the device is a Matrix, you should not copy the notes to the Matrix track, but to 
the track for the device controlled by the Matrix (since the Matrix doesn’t produce 
any sound in itself). You can also copy the notes to any other instrument device 
track if you like.

3. Select the device and select “Copy Pattern to Track” from the Edit menu or 
the device context menu.

D If you selected a track not connected to the pattern device, a dialog will 
appear where you can click OK to proceed, or Cancel to abort the opera-
tion.

The pattern is converted to note clips on the track (see the notes below). If the length 
of the area between the locators is greater than the pattern length, the clips will be re-
peated to fill out the area.
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Redrum notes

When you use this function with the Redrum, you should note the following:

• The notes will have the pitch of the corresponding drum sound (see “Using Re-
drum as a Sound Module”) and the velocity depending on the Dynamic value.
Soft notes have velocity 30, medium notes have velocity 80 and hard notes have 
velocity 127.

• You probably want to turn off the “Enable Pattern Section” switch on the Redrum 
device panel. 
Otherwise, the drum sounds will be “double-triggered” when you start playback 
(once by the pattern section itself, once by the main sequencer).

Matrix notes

When you use this function for the Matrix, you should note the following:

• A note will be created for each pattern step with a gate value other than zero. 
The notes will have the pitch according to the key CV value for the step, and the 
velocity according to the gate value. 

• The curve CV is not copied.
• Make sure that the right track is selected (normally the track for the device that the 

Matrix is connected to)! Creating notes for the Matrix itself is pointless, as the Ma-
trix cannot produce any sound.

• You may want to disconnect or even remove the Matrix after performing a “Copy 
Pattern to Track”. 
This is because you probably don’t want both the Matrix and the sequencer notes 
to play back at the same time.

The “Convert Pattern Track to Notes” function
If you have recorded or drawn pattern changes on a Redrum or Matrix track, you can 
have the whole track converted to notes, in the following way:

1. Select the track with the pattern changes.

2. Select “Convert Pattern Track to Notes” from the Edit menu or the context 
menu for the track.
For each bar, the corresponding pattern is converted to note clips on the track (fol-
lowing the same rules as for the “Copy Pattern to Track” function). The track will 
play back just the same as when you played the pattern device with the pattern 
changes.

D All pattern automation is automatically disabled after the operation (the 
pattern lane is turned off).
This means you can later go back to pattern automation if you so wish, by turning 
the pattern lane on again.

Redrum notes

• The “Enable Pattern Section” switch is automatically turned off when you use this 
function.

Matrix notes

• Make sure that the right track is selected (normally the track for the device that the 
Matrix is connected to)! Creating notes for the Matrix itself is pointless, as the Ma-
trix cannot produce any sound.

• You may want to disconnect or even remove the Matrix after performing this func-
tion. 
This is because you probably don’t want both the Matrix and the sequencer notes 
to play the device at the same time.
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Automating tempo and time 
signature
The transport track can be used to automate tempo and/or time signature changes. It 
works by drawing or recording clips on automation lanes for the transport track.

Automating tempo
Automating tempo is done much in the same way as with other automation. You can 
either record the tempo changes by changing the tempo on the transport panel, or 
you can draw curves in clips on the transport track.

1. Set the desired tempo on the transport.
This will be your static value, i.e. the tempo of the song wherever there is no clip 
present on the automation lane.

2. [Alt]/[Option]-click in the Tempo field on the transport panel.
This will select the Transport track and create a Tempo automation lane in one go.

From here you can decide whether to draw clips where you want the tempo to change 
or to record automation clips by manually changing the Tempo controls on the trans-
port. We will describe how to draw tempo automation clips.

D It is generally a good idea to activate Snap and have the snap value set 
to Bar when drawing clips.

3. Select the Pencil tool and draw a clip over the area where you want the 
tempo to change.

4. With the clip selected, press [Return] to open it for editing.
If you like, you can switch to Edit mode - this allows you to edit the static tempo 
value too.

Now you can draw automation curves in the normal way.

D Remember that Snap applies when inserting points.
You can also change the position of a point numerically in the Inspector.

Here, the tempo changes from 120 to 150 over four bars.

D If you press [Alt]/[Option] you can draw automation ranges for instant 
changes between tempo values.

✪ Even though Reason supports a very wide tempo range, editing is by de-
fault restricted to the range 60 - 250 bpm. This is only to make it easier to 
work with small tempo changes - if you want lower or higher tempi you 
can change the range by double clicking the min or max value (“60” or 
“250” in the picture above) and typing in new values.
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Automating time signature
1. Set the desired time signature on the transport.

This will be your static value, i.e. the time signature of the song wherever there is 
no clip present on the automation lane.

2. [Alt]/[Option]-click in the Time Signature field on the transport panel.
This will select the Transport track and create a Time Signature automation lane in 
one go.

From here you can decide whether to draw clips where you want the time signature to 
change or to record automation clips by manually changing the Time Signature on the 
transport. In the following text drawing time signature automation clips will be de-
scribed.

D It is generally a good idea to activate Snap and have the snap value set 
to Bar when drawing clips.

3. Select the Pencil tool. 
When the Pencil tool is selected, a Time Signature pop-up appears in the Inspec-
tor. Use this to set the required time signature.

4. Draw a clip over the area where you want the time signature to change.
The time signature will change for the duration of the clip.

D You can change the time signature for the automation clip at any time by 
simply double-clicking the clip with the Arrow tool and changing the 
value on the pop-up that appears.
There is no need to switch to Edit mode unless you wish to change the static 
value.

5. Continue using the same general method wherever you want the time signa-
ture to change.
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Importing and Exporting 
MIDI Files
Reason can import and export standard midi files (SMF). This allows you to transfer 
MIDI data between Reason and other applications.

Importing a MIDI File
To import a Standard MIDI File, select “Import MIDI File” from the File menu. The 
Browser appears, where you can locate and open the MIDI file.

D MIDI files have the extension “.mid”.

Now, a number of new tracks are created in Reason’s sequencer. The tracks will have 
their original name, with their original MIDI channel added. All tracks will be Combina-
tor tracks, with empty Combi patches.

D If the imported MIDI file is of “Type 1”, there will be one sequencer track 
for each track in the MIDI file.

D If the imported MIDI file is of “Type 0” (that is, it contains one track with 
MIDI events on multiple channels), there will be one sequencer track for 
each used MIDI channel.

D Any tempo changes in the MIDI file are disregarded.
The tempo in Reason will be set to the first tempo in the MIDI file.

D The Combinators will be empty, which means the imported file will not 
make any sound at first.
You need to use the Browser section on the Combinators to select a suitable 
sound for each track.

D All controller data in the MIDI file is included.
This means that standard performance controllers (pitch bend, mod wheel data 
etc.) are preserved properly and will included in the note clip as when recording in 
Reason. However, some controllers may “mean” different things for the original 
MIDI instruments used when creating the MIDI file and the devices in Reason, so 
some automation clips may be “alien” (see “About alien clips”). 

Green frames will appear for the automated parameters in the device panels. This helps you locate 
any unwanted controller data.

Exporting a MIDI File
To export your Reason song as a MIDI file, proceed as follows:

1. Set the End (E) marker at where you want the MIDI file to end.
The MIDI file will contain all events on all tracks from the start of the song to the 
End marker.

2. Select “Export MIDI File” from the File menu. 

3. In the file dialog that appears, specify a name and location for the file.
Under Windows, the file will automatically get the extension “.mid”. Under Mac 
OS, this is not required. However, if you want the MIDI file to be recognizable un-
der Windows (and by some hardware sequencers), you may want to activate the 
option “Add Extension to File Name” before saving.

4. Click Save.

MIDI files exported by Reason will have the following properties:

D The MIDI file will be of Type 1, with one MIDI track for each track in the 
Reason sequencer.
The tracks will have the same names as in the Reason sequencer.

D Since the Reason sequencer doesn’t use MIDI channels as such, all 
tracks will be set to MIDI channel 1.

D The sequencer tempo is included in the MIDI file.
If tempo or time signature automation is used this will not be included.
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Introduction

The ReGroove Mixer combines all the benefits of quantization, shuffle, and groove 
templates into a single integrated environment, giving you real-time creative control 
over the feel and timing of individual note lanes. The ReGroove Mixer, which extends 
from the top of the Transport Panel (and thus appears in either the rack or the se-
quencer), puts 32 channels of interactive groove control at your fingertips.

If you're familiar with mixing, you're already well on your way toward understanding the 
ReGroove Mixer. Think of it as a mixer with 32 busses but, instead of these busses 
modifying the volume of the input tracks, they modify the feel (or groove) of the input 
tracks. You can route any track or note lane to one of ReGroove's 32 channels, and 
that track's feel and timing are modified, in real-time, by the channel's settings. Each 
ReGroove channel can use its own groove template or shuffle amount. In addition, 
each channel can slide notes forward or backward in time, allowing you to put certain 
tracks slightly ahead or behind the beat, which greatly alters the feel of your music.

ReGroove basics
When working with grooves, you'll make use of three interacting sections within Rea-
son's interface:

• First, in the Sequencer, each note lane can be assigned to any of ReGroove's 32 
channels. You assign a note lane to a groove channel by selecting it with the Se-
lect Groove pop-up in each note lane.

• Second is the ReGroove Mixer, which contains both global groove settings and 
channel-specific ones. This is described on the following pages.

• Finally, there's the Groove Settings section of the Tool Window, which is ac-
cessed by clicking a ReGroove channel's Edit button. Groove Settings allow you 
to set the intensity of various groove patch parameters. This is also where you save 
your own ReGroove patches. See page 102.

The ReGroove Mixer
Open the ReGroove Mixer (in the main window or in the detached sequencer win-
dow) by clicking the ReGroove Mixer button in the Transport Panel.

The ReGroove mixer is divided into two sections. On the left are the Global parame-
ters, and on the right are the Channel parameters.

Global parameters

These parameters operate globally, rather than channel-by-channel.

Channel Banks

The ReGroove mixer consists of 32 channels, grouped into 4 banks (labeled A 
through D). Click a Channel Bank button to see and edit its corresponding bank of 8 
channels.

Global parameters

Channel parameters
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Anchor Point

Normally, all groove patterns start at Bar 1 and repeat themselves throughout a song. 
For example, a 4-bar groove pattern will begin at Bar 1 and repeat its pattern every 
four bars. Many times, however, songs begin with blank measures, pickup measure or, 
perhaps, a short introduction. In these cases, you probably don't want the groove pat-
tern to begin at Bar 1, but at some later bar. This is the purpose of the anchor point - 
it tells Reason at which measure it should begin applying the groove settings.

For example, assume you have a song with a 1-bar pickup. Because the song really 
begins on bar 2, that's where you want your groove to begin. Setting the anchor point 
to 2 insures that the groove patterns all begin at measure 2.

D Note: There is one exception to the rule that grooves start playing at their an-
chor point and repeat indefinitely throughout the song-and that's when they 
encounter a time-signature change. Grooves always restart at any measure 
containing a time signature change. 
You can use this knowledge if, for example, you have a song section with an odd 
number of bars-inserting a time signature change will force all your grooves to re-
start at that measure.

Global Shuffle

This knob adjusts Reason's global shuffle amount, and is used by any devices that 
employ patterns (such as Redrum's internal sequencer, the Matrix pattern sequencer, 
and the RPG-8 arpeggiator). It also defines the shuffle value for any ReGroove chan-
nel for which the Global Shuffle option is activated. This knob is, essentially, a re-
placement for the Pattern Shuffle knob contained in the Transport Panel prior to 
Reason 4 - providing backward compatibility with older Reason documents while 
adding the ability to lock ReGroove channels to the same shuffle settings used by pat-
tern devices.

Setting the Global Shuffle to a value of 50% results in a “straight” beat, with no swing 
applied. Setting the Global Shuffle to a value of 66% results in a perfect sixteenth-
note triplet shuffle. Values between 50% and 66% have a less pronounced swing 
feel, and values greater than 66% are more exaggerated.

Channel parameters

These parameters operate on a per-channel basis. Each of ReGroove's 32 channels 
(arranged in 4 banks of eight) contains an identical set of parameters.

On Button

This is an On/Bypass button for the channel. When the button is lit, the groove chan-
nel is active and any track or note lane assigned to this groove channel will be af-
fected. When the button is not lit, the channel is disabled and any tracks assigned to 
this groove channel will play back straight, without being “grooved.”

✪ This can be used for comparing the groove with the original, ungrooved 
beat. You can also do this for individual note lanes, by turning off the 
“Enabled” item on the Groove Select pop-up menu in the track list - see 
page 104.

Edit Button

Click this button to open Reason's floating Tool Window, and show the Groove tab, 
where you can view and edit additional Groove Settings for each channel.

Each ReGroove channel has its own groove settings, so clicking the Edit button in dif-
ferent channels will fill the Tool Window with groove settings specific to that channel.

Channel Number

This is a non-editable channel number label. Channels are numbered 1-8 and are 
grouped into 4 banks (A-D). Channel numbers are named accordingly. For example, 
A2 is the second channel in Bank A, and B5 is the fifth channel in Bank B.

On button
Edit button

Channel number

Groove patch name

Groove patch browser

Slide knob

Groove Amount

Shuffle knob

Pre-Align button

Global Shuffle button
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Groove Patch Name

This shows the name of the groove patch currently loaded into the channel. If no 
groove patch is loaded, then no name appears. Click this area to bring up a list of the 
patches in the current folder, just as with patch displays on devices in the Reason 
rack.

D To remove a groove patch assignment and reset the channel to its default 
values, right-click the Groove Patch name and select “Initialize Channel” 
from the context menu.

Groove Patch Browser

This allows you to load groove patches and to step between them, just like device 
patches in the Reason rack. ReGroove patches have a .grov extension. See The Re-
Groove patches in the Factory Sound Bank, later in this chapter, to learn more about 
the types of groove patches included with Reason.

Slide

Use this knob to slide notes forward or backward in time. Musicians will frequently 
add energy and urgency to a track by “rushing” a particular beat or instrument a little. 
Similarly, they may “drag” a note a little in order to create a more laid back, shuffle-like 
feel. The Slide knob has a range of ±120 ticks, which allows you to slide notes up to 
a thirty-second note in either direction. Setting negative values makes notes play ear-
lier in time (rushing the feel). Setting positive values makes notes play later in time 
(lagging the feel).

For example, if you wanted to create a slightly “in the pocket” groove, you could cre-
ate a snare lane and assign it to a ReGroove channel with a small amount of positive 
slide. This would delay the snare track slightly, giving your music a relaxed, laid back 
feel.

✪ If you have a track that you want to rush (set to a negative slide value), 
you should put an empty bar at the beginning of your sequence, making 
sure to set the Anchor Point to “2.” This insures that any notes assigned 
to Bar 1/Beat 1 will, indeed play ahead of the beat (since you created an 
empty measure into which the early note can shift).

Shuffle

At its most basic level, this knob adds a sixteenth note “swing” feel to the ReGroove 
channel. A value of 50% results in a straight (no shuffle) feel, and a value of 66% cre-
ates a perfect triplet feel.

You can also use this knob to “de-shuffle” a beat by dialing in values below 50%. For 
example, if you had a recording that was played with a perfect triplet feel, setting the 
Shuffle value to 34% will make the beat straight again!

With Slide set to +20 ticks, 
notes play back later in time.

With Slide set to 0 ticks, notes 
are not shifted in time.

With Slide set to –20 ticks, 
notes play back earlier in time.

Shuffle works by changing the 
start time of every other 
sixteenth note.

A shuffle value of 66% delays 
every other sixteenth note to 
create a perfect triplet feel.
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Groove Amount

Use this fader to adjust how intensely the selected groove patch will modify your 
notes. At 0%, the groove patch will have no effect. At 100%, the groove patch will 
have its maximum effect. Obviously, values between these extremes will produce 
some amount of groove effect, but less than maximum.

As discussed in Groove Settings, later in this chapter, several additional parameters 
are associated with groove patches and how they modify your notes. Specifically, the 
Groove Settings section of the Tool Window contains four “impact” settings (timing, 
velocity, note length, and randomness), and the Groove Amount fader acts like a 
“master” fader that scales these four parameters proportionally.

Pre-Align

Enabling (lighting) this button causes any incoming notes to be quantized to a rigid, 
sixteenth note grid prior to having any additional groove modifications applied to 
them. This quantization, which occurs in real time and is non-destructive, is an easy 
way to align all incoming notes to a “straight” grid, so that any shuffle, slide, or groove 
modifications have the expected effect on the notes.

Global Shuffle

Enabling (lighting) this button causes the ReGroove channel to use the “Global Shuf-
fle” setting, rather than the channel's own shuffle setting. The channel's Shuffle knob 
will have no effect when a channel uses global shuffle. Using global shuffle is a good 
way to synchronize notes in a particular channel with those in pattern-based devices 
(such as Redrum’s internal sequencer, the Matrix pattern sequencer, and the RPG-8 
arpeggiator), all of which get their shuffle values from the Global Shuffle value.

Copy, Paste and Initialize ReGroove channels
To copy one ReGroove channel configuration into another:

1. Decide which ReGroove channel you want to copy from, then right-click (Win-
dows) or [Ctrl]-click (Mac) on the Groove Patch Name (or anywhere else in 
that channel, except directly on a parameter).
A context menu appears.

2. Select “Copy Channel” from the context menu.

3. Right-click (Windows) or [Ctrl]-click (Mac) on the destination channel's 
Groove Patch Name, then select “Paste Channel” from the context menu.
Reason copies all the ReGroove channel settings to this channel.

To initialize a ReGroove channel:

1. Right-click (Windows) or [Ctrl]-click (Mac) on the Groove Patch Name (or 
anywhere else in that channel, except directly on a parameter) to open a con-
text menu.

2. Select “Initialize Channel” from the context menu.
Reason resets all channel parameters to their default values.

Groove Amount of 100% 
modifies notes using all 
groove settings at their 
specified amounts.

Groove Amount of 50% 
modifies notes using all 
groove settings at only half 
their specified amounts.
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Groove Settings

A groove patch consists of a groove template, which contains timing and dynamics in-
formation extracted from a performance, plus a collection of Impact parameters, 
which determine how strongly the groove patch applies the template settings. This 
section discusses the settings on the Groove tab in the Tool window, which is where 
all the Groove Patch settings are viewed and edited.

Groove Channel

The Groove Settings display one mixer channel at a time. To select which ReGroove 
channel is currently displayed, select it from this pop-up (or click the Edit button for 
the channel in the ReGroove Mixer).

Groove Patch Name

This shows the name of the groove patch currently loaded into the channel. If no 
groove patch is loaded, then no name appears. Click this area to bring up a list of the 
patches in the current folder, just as with device patches in the Reason rack. This area 
duplicates the functionality of the Groove Patch Name area in each channel of the Re-
Groove Mixer.

Groove Patch Load/Save

These buttons allow you to load and/or save groove patches, just like device patches 
in the Reason rack. ReGroove patches have a .grov extension. To learn more about 
the types of groove patches included with Reason, see page 107.

Groove Patch Length

This displays the groove's length, which is import for determining how often the 
groove repeats.

D In general, if you apply different groove patches to different note lanes, you'll 
want their lengths to be multiples of one another. 
For example, if one ReGroove channel uses a 4-bar groove, you might want to use 
4-bar grooves on other channels or, perhaps, a multiple (such as 1-bar, 2-bar, or 8-
bar grooves). 
You can, of course, mix and match grooves with non-standard lengths, but you 
need to be aware of how these grooves will interact. For example, if one channel 
used a 3-bar groove and another used a 4-bar groove, the groove pattern would 
actually repeat every 12 bars (3-bars times 4-bars).

Groove Patch Time Signature

This displays the groove's time signature and should, in most cases, match the time 
signature of your sequence.

D In general, if you apply different groove patches to different note lanes, you'll 
want them to share a common time signature. 
You can, of course, mix and match time signatures to create polyrhythmic grooves, 
but you need to be aware of how these grooves interact. For example a 6/8 groove 
will shift notes in a radically different way than a 4/4 groove, so applying them si-
multaneously may or may not sound the way you expect.

Timing Impact

This determines the extent to which timing information embedded in the groove tem-
plate affects the position of your notes. A 50% setting means that notes are moved 
halfway to the positions defined in the groove template. 100% means they are moved 
exactly to the positions in the groove, and 200% means they are moved just as far 
past the groove template positions.

D This parameter works in conjunction with the ReGroove Mixer's Groove 
Amount fader, which can scale back the groove's timing impact. 
For example, if the Groove Amount fader is set to 100%, then notes are moved by 
the indicated Timing Impact amount, but if the Groove Amount fader is set to 50%, 
then notes are moved by only half the Timing Impact amount.

These are the original notes in your sequence.

These are note locations stored in a groove 
template. A Timing Impact = 100% moves 
your original notes to this location.

A Timing Impact = 50% moves your original 
notes only halfway to the template's note 
location.
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Velocity Impact

This determines the extent to which velocity information embedded in the groove tem-
plate affects the velocity of your notes. Grooves modify only the relative differences 
between note velocities, not their absolute values. This way, soft passages remain soft 
and loud passages remain loud-the groove simply accents the notes differently. A 
100% setting means that the feel is more or less exactly transferred from the template 
to your music. Values below this mean that less of the groove's dynamics affect your 
notes, and values above 100% dramatically increase the dynamic effect of the groove 
patch.

D This parameter works in conjunction with the ReGroove Mixer's Groove 
Amount fader, which can scale back the groove's velocity impact. 
For example, if the Groove Amount fader is set to 100%, then velocities are modi-
fied by the indicated Velocity Impact amount, but if the Groove Amount fader is set 
to 50%, then velocities are modified by only half the Velocity Impact amount.

Note Length Impact

This determines the extent to which note length information embedded in the groove 
template affects the length of your notes. This setting is not always relevant (such as 
with drum samples, which always play at their full length) and, consequently, most 
grooves in the Factory Sound Bank do not contain any length information (with the ex-
ception of the “Bass-Comp” category).

That said, when working with sustaining instruments, note length can have a dramatic 
impact on the performance's feel. Grooves modify only the relative differences be-
tween note lengths, not their absolute values. This way, legato or staccato passages 
retain some of their original intent when modified with a groove patch.

D This parameter works in conjunction with the ReGroove Mixer's Groove 
Amount fader, which can scale back the groove's note length impact. 
For example, if the Groove Amount fader is set to 100%, then note lengths are 
modified by the indicated Note Length Impact amount, but if the Groove Amount 
fader is set to 50%, then note lengths are modified by only half the Note Length 
Impact amount.

Random Timing

This determines the extent to which note positions are randomized. This value defines 
the maximum distance that a note can be randomly shifted (in either a positive or neg-
ative direction). You may set an amount between 0 ticks (no randomization occurs) 
and 120 ticks, which allows notes to shift as much as a thirty-second note in either di-
rection.

The effect is “polyphonic,” meaning that any notes originally beginning at the same 
position will still be moved by different amounts. It is also “semi-deterministic,” mean-
ing that if you play a clip several times, without editing anything, all notes will play back 
at exactly the same positions each time. However, as soon as you edit the clip in any 
way, all random positions are recalculated.

D This parameter works in conjunction with the ReGroove Mixer's Groove 
Amount fader, which can scale back the randomization. 
For example, if the Groove Amount fader is set to 100%, then notes are random-
ized by the indicated Random Timing amount, but if the Groove Amount fader is 
set to 50%, then notes are randomized by only half the Random Timing amount.

Get From Clip

This button converts the notes in a selected clip into a groove patch. The patch can 
then be used right away in the active ReGroove Mixer Channel or saved to disk as a 
new groove patch. Clicking this button has the same effect as selecting a clip and 
choosing “Get Groove From Clip” from the Edit (or context) menu. See “Creating your 
own ReGroove patches”.
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Working with grooves
Applying grooves to your music
Follow this example to learn basic ReGroove mixing techniques and hear the effect 
that various groove parameters have on your music.

1. If it's not already visible in either the Sequencer or Rack, open the ReGroove 
Mixer by clicking the corresponding button on the Transport Panel.

2. Decide which note lane you are going to apply the groove to.
For the most obvious effect the track should contain a drumbeat based on straight 
(as opposed to shuffled) sixteenth notes. A hi-hat lane, for example, might be a 
good source for experimentation.

3. Use the Groove Select pop-up on the chosen note lane to route those notes 
to a specific ReGroove mixer channel.

D The “Enabled” item at the top of the pop-up menu allows you to turn Re-
Groove off for individual note lanes.
This is useful for comparing with the original, ungrooved beat. If you want to do 
this for several note lanes set to a particular ReGroove channel, use the “On” but-
ton for the channel in the ReGroove mixer instead (see page 99).

D To turn ReGroove off for a note lane, select “No Channel”.

4. In the ReGroove Mixer, make sure the channel you are using is activated - 
the On button should be lit.

5. To hear some of the different possibilities, start by turning up the channel's 
Shuffle knob while you play the sequence. 

The music on that note lane (and any other note lane assigned to the same Re-
Groove channel) will start playing with a shuffle feel.

6. Turn down Shuffle to its middle position (50%), and turn up the channel's 
Slide knob to hear its effect.

D Note that, because slide shifts all notes by the same amount, you won't hear 
the results unless you play the track in conjunction with another track whose 
notes are not being slid (or with the metronome click activated).

Groove Select pop-up
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7. Turn the Slide knob back to its middle position (0 Ticks), then click the chan-
nel's Browse button and navigate to the Groove Patches folder in the Factory 
Sound Bank.

8. Open the Vinyl folder, select the first groove patch in the list and click Open 
to load the groove patch and close the browser.

9. Pull up the Groove Amount fader on the channel, to about 80%.

10.Click the Next Patch button to step through the groove patches in the folder 
and hear what they do to your music.

11.On the ReGroove Mixer channel, click the Edit button to open that channel's 
groove settings in the floating Tool Window.

12.Move the various horizontal faders and listen for their effect.
Note that none of the patches in the Vinyl folder make use of Note Length, so the 
Note Length Impact will have no effect.

✪ There are all sorts of creative and useful ways to apply grooves to your 
music. See Groovy tips & tricks, later in this chapter, for some suggested 
techniques.

Commit to Groove - making the grooves “permanent”
When you assign a ReGroove channel to a note lane, this will only affect how the 
notes play back. The notes will still be shown with their original, ungrooved positions 
if you open the note clip. 

If you want to edit grooved notes (e.g. adjust timing and velocity manually), it’s useful 
to first actually move the notes to the grooved positions, permanently. This is done 
with the “Commit to Groove” function:

1. Select the track with the grooved note lane(s).

2. Select “Commit to Groove” from the Edit menu or the track context menu.
All notes on all lanes on the track will be moved to their grooved positions, and the 
Groove Select pop-up will be reset to “No Channel”.

If you play back the track, it will sound exactly the same as before. If you look at the 
notes in Edit mode, their positions, length and velocity will now match what you hear.

Using Commit to Groove on some lanes only

“Commit to Groove” affects entire tracks, including all note lanes if there are several. 
If you only want to make the groove permanent for one of the lanes, here’s a 
workaround:

1. Click the Groove Select pop-up for the note lanes that should remain Re-
Grooved, and turn off “Enabled”.
This bypasses the ReGroove channel for those note lanes, but retains the channel 
selection.

2. Select “Commit to Groove”.
Only the note lanes with ReGroove Enabled will be affected.

3. Select “Enabled” again for the note lanes that should remain ReGrooved.
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Creating your own ReGroove patches
To create your own ReGroove Patch, proceed as follows.

1. Create a clip containing notes with the desired timing and dynamics 
(velocity).
Alternately, you could import a MIDI File with the desired effect, or use the “To 
Track” function on a Dr.REX device to extract the notes from a REX loop.

D Note that some MIDI clips will make better grooves than others. 
To learn some of the characteristics of a good groove-making clip, see “Tips for 
selecting the best Groove-Making Clips” below.

2. Select the clip.

3. In the Tool Window's Groove section, select an unused Groove Channel.

4. Click the “Get From Clip” button at the bottom of the Tool Window's Groove 
section.
Alternately, you could select “Get Groove From Clip” from the clip's context menu.

5. Set the various impact parameters as desired.
For a good starting point, you can simply leave them at their default settings.

6. Click the Save Patch button in the Tool Window's Groove section and specify 
a name and location.

Your ReGroove patch is now ready to use. As discussed in Applying grooves to your 
music, simply route one or more note lanes to the ReGroove channel assigned to your 
new groove, and pull up the Groove Amount fader on that channel.

Tips for selecting the best Groove-Making Clips

The following tips will help insure that your custom grooves work their best:

D Include as many sixteenths notes as possible in the source clip. 
If there are any sixteenth note gaps in your source material, there will be corre-
sponding gaps in your groove patch. This means, when you apply the groove to a 
note lane, some notes will be grooved and some (those that fall in the gaps) will 
not.

D Grooves use the relative differences between note velocities, not their abso-
lute values. 
If you don't want dramatic shifts in dynamics, avoid having widely varying velocities 
in your source clip.

D Groove patches are always an exact number of bars, so if your source clip 
has an uneven length, the groove will be extended to the next bar. 
We recommend that you adjust your source clip to an exact number of bars before 
creating a groove patch.

D In general, you should use source clips whose length is an even multiple of 2 
(for example, 1-bar, 2-bars, 4-bars, etc.)
You can create and use grooves that are an odd number in length (3, 7, 13, etc.), 
but unless you're well organized and plan to use these grooves in specific poly-
rhythmic pieces, their general effect on most tracks will be somewhat unpredict-
able.

Groovy tips & tricks
• Because you can route each track (or note lane) to any of the 32 ReGroove chan-

nels, the key to creating really dynamic grooves is to spread your instrumentation 
across multiple tracks and lanes. 
For instance, where you might normally create a ReDrum sequence with kick, 
snare, and hi-hat all on the same track, putting these elements into different lanes 
will let you apply different grooves to them. For example, you might have a kick lane 
routed to a ReGroove channel with a slight shuffle feel, and you might send the 
snare to a ReGroove channel that slides the notes earlier in time to “push” the 
backbeat a little. Breaking things into lanes will definitely enable you to create 
beats that are more loaded with feel and personality than if you simply apply one 
groove setting to everything.

• When building a groove, start simple. Experiment with adjusting the slide parame-
ter to move just the snare or hi-hat forward or backward in time. Try applying 
slightly different amounts of shuffle to different percussion instruments. Small 
changes can sometimes have a big visceral effect, so use your ears (and not your 
eyes) when adjusting the various groove settings.

• Try applying the same groove patch to multiple lanes, but by varying amounts. You 
are, of course, free to apply different groove patches to different lanes. Though, 
more often than not, your results might result in something that sounds more 
clumsy than groovy. The hottest grooves often have the most subtle of humaniza-
tion.

• Don't forget to try sending sequenced REX files through the ReGroove mixer. De-
pending on the material in the file and how it's sliced up, this can create all types of 
results-ranging from unusable to downright inspiring.

• If you're doubling instruments-that is two instruments play the exact same part-try 
sending one of the instruments to a ReGroove channel that has a small amount of 
random timing applied. Random timing (which is accessible in the Groove Set-
tings section of the Tools Window) will put some separation between the two in-
struments, making their performance sound more human. For example, if you have 
a clap doubling a snare, apply a little bit of random timing to the clap track, and it'll 
stand out more clearly in the mix.

• As described under the Anchor Point heading above, grooves restart whenever a 
new time signature appears. You can use this knowledge to force a groove to re-
start, which might be required if your music contains sections of odd lengths. Sim-
ply add in a time signature event, with the same type of time signature as you 
already have in the song. The groove will restart where the event starts.

• Remember that groove patches have separate timing and velocity impacts and, as 
such, you can apply them independently. For example, if you already have a track 
that has just the right groove timing, but you want to experiment with different dy-
namic feels, you can apply just the velocity portion of a groove by setting its Timing 
Impact parameter to 0. A groove's timing and velocity impact parameters can be 
accessed by clicking a ReGroove channel's Edit button, which opens the Groove 
Settings section of the Tools Window.
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The ReGroove patches in the 
Factory Sound Bank
Reason ships with a ready-made assortment of groove patches, arranged in a number 
of different folders:

MPC-60

These grooves were created by analyzing the audio output of an Akai MPC-60. Use 
these patches to get the same shuffle feeling as an original MPC-60. Note that these 
patches do not contain any velocity or note length information. There are some addi-
tional patches that use the Random Timing feature, which emulates the original MPC-
60's behavior when loaded with a lot of information.

Vinyl

These grooves were created by sampling snippets from classic groove records, ana-
lyzing them with a special signal processing tool, then extracting both timing and ve-
locity information from the samples. These grooves do not contain any note length 
information.

Programmed

These grooves were created by a session drum groove programmer. They were hand-
crafted to emulate the feel of certain styles, and are divided into two genres: Hiphop 
and Pop-Rock. These grooves do not contain any note length information.

Bass-Comp, Drummer, and Percussion

Grooves in these categories were created by session musicians. Their performances 
were captured and analyzed, and the timing and velocity information was then ex-
tracted from the performances. The Bass-Comp patches also contain note length in-
formation, though the other categories do not.
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7 D Remote - Playing and controlling Reason devices
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About the various MIDI 
inputs
This chapter describes how you use Remote to set up your master keyboard and con-
trol surfaces, allowing you to play Reason devices, adjust parameters and control var-
ious Reason functions. This is the main way of sending MIDI to Reason, but there are 
also some additional methods:

D Using ReWire 2.
ReWire allows you to run Reason together with another application, such as a se-
quencer or a DAW. With ReWire 2, you can send MIDI from the other application 
directly to devices in Reason. See page 126.

D Using the External Control Bus inputs.
The External Control Bus inputs (set up on the Preferences - Advanced MIDI page 
and in the MIDI In device in the hardware interface) let you send MIDI directly to 
the individual devices in the rack. This is mainly used if you control Reason from an 
external sequencer, etc. See page 122.

D Sending MIDI Clock to Reason.
This allows you to synchronize Reason’s tempo to other devices. See page 130.

About Remote
MIDI from control surfaces (keyboards, remote control units etc.) is handled by a pro-
tocol called Remote. The Remote protocol allows for seamless integration between 
Reason and control surface devices. It is basically a mapping system that provides di-
rect hands-on control of parameters for each Reason device - including transport and 
sequencer track selection! 

At the time of this writing, Reason supports a large number of control surfaces and 
keyboards - the knobs, faders and buttons on the devices are automatically mapped 
to parameters on each Reason device. 

Remote drivers for more control surfaces will be added continuously. Check the Pro-
pellerhead web page in case your model isn’t listed on the Preferences- Control Sur-
faces and Keyboards page.

Remote controlling Reason devices couldn’t be made any simpler. Set up your control 
surface once and for all for use with Reason - the program handles the rest!

Setting up
Adding a control surface or keyboard
This is how you add your control surfaces - including the master keyboard.

1. Open the Preferences dialog and select the Control Surfaces and Keyboards 
page.

2. If your control surface is connected via USB (or if you have made a two-way 
MIDI connection), try clicking the Auto-detect Surfaces button.
Reason scans all MIDI ports and tries to identify the connected control surfaces. 
Note that not all control surfaces support auto-detection.

All found surfaces are listed in the Attached Surfaces list. 

3. To add a control surface manually, click the Add button.
This brings up a new dialog.

4. Select the manufacturer of your control surface from the Manufacturer pop-
up menu.
If you can’t find it on the menu, see below.

5. Select the model of your control surface from the Model pop-up menu.
If you can’t find it on the menu, see below.
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6. An image of the selected control surface model is shown, often along with 
some information text - read this carefully.
For some control surfaces, you need to select a specific preset to use the surface 
with Reason - this is noted here.

7. Use the MIDI Input pop-up to select the input port to which you have con-
nected the surface.
If in doubt, you can click the Find button and then tweak a control or play a key on 
the control surface to have Reason find the correct input port for you.

D Some control surfaces may have more than one MIDI Input pop-up menu.
You need to select ports on all MIDI Input pop-up menus.

D Some control surfaces will have a MIDI Output pop-up menu.
In some cases this labeled “Optional” - then you don’t have to make a selection. In 
other cases, a MIDI Output is required. This is the case if the control surface uses 
MIDI feedback - motor fader, displays, etc. See the separate “Control Surface De-
tails” pdf document for details.

D Reason only “grabs” the MIDI inputs you are actually using. 
MIDI inputs not selected here or on the Advanced MIDI page (see page 122) are 
available to other programs.

D Note that other MIDI programs may “grab” all MIDI ports in your system 
when you launch them!

8. If you like, you can rename your control surface in the Name field.

9. Click OK to add the surface.

D Depending on the surface model, alerts may appear, reminding you to 
select a specific preset etc.
In some cases, Reason can restore a preset in the control surface to factory set-
tings for you - you are then informed of this.

Finally you return to the Control Surfaces and Keyboards Preferences page, where 
your added surface is now listed.

If your control surface model isn’t listed

If you can’t find your control surface listed on the Manufacturer or Model pop-up 
menus when you try to add it, this means that there’s no native support for that model. 
However, the program supports generic keyboards and controllers. Here’s what to 
do:

D Select “Other” on the Manufacturer pop-up menu and then select one of 
the three options on the Model pop-up menu.

or, if the Manufacturer is listed but not your specific model:

D Select one of the three “Other” options on the Model pop-up menu:
In both cases, the options are:

• Basic MIDI Keyboard
Select this is you have a MIDI keyboard without programmable knobs, buttons or 
faders. This is used for playing only (including performance controllers such as 
pitch bend, mod wheel, etc.) - you cannot adjust Reason device parameters with 
this type of control surface.

• MIDI Controller
Select this if you have a MIDI controller with programmable knobs, buttons or fad-
ers (but without keyboard). 
You need to set up your control surface so that the controllers send the correct 
MIDI CC messages, depending on which Reason device you want to control - 
check out the MIDI Implementation Chart in the Reason Documentation folder. If 
your control surface has templates or presets for different Reason 2.5 devices, 
these can be used. 

• MIDI Keyboard with Controls
Select this is you have a MIDI keyboard with programmable knobs, buttons or fad-
ers. Again, you need to set your controllers to send the right MIDI CCs.

After selecting a model, proceed with selecting MIDI input port as described above.

About the master keyboard

One of the control surfaces can be the master keyboard. This is like any other control 
surface, but it must have a keyboard and it cannot be locked to a specific Reason de-
vice (in other words, it always follows the MIDI input to the sequencer). This is the sur-
face you use to play the instrument devices in Reason.

D The first surface with a keyboard that is added (or found by auto-detect) 
is automatically selected to be the master keyboard.
This is shown in the Attached Surfaces list on the Preferences page.

D If you want to use another surface as master keyboard, select it in the list 
and click the “Make Master Keyboard” button.
You can only have one master keyboard.

D If you don’t want to use any master keyboard at all, select the current 
master keyboard surface and click the same button (which is now la-
beled “Use No Master Keyboard”).
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Other functions
D To edit a surface, double click it in the list (or select it and click Edit).

This lets you change its name and MIDI port settings, if needed.

D To delete a surface, select it in the list and click Delete.

D You can turn off a surface by deactivating its “Use with Reason” check-
box.
This could be useful if the surface is connected to your system but you only want 
to use it with another program, etc.

D There is still an “Advanced MIDI” page in the Preferences.
This is only used for External Control MIDI buses and for MIDI Clock Sync input. 
All hands-on MIDI control is set up on the Control Surfaces and Keyboards page.

Example Setups
There are several possible variables when it comes to what type of setup you are us-
ing. Please read on. 

A single MIDI keyboard with controls

With this setup, the keyboard is your master keyboard, which means it is always 
routed via the sequencer (it controls the device connected to the sequencer track 
with MIDI focus). To control another device, you move MIDI focus (the keyboard sym-
bol in the In column in the track list) to another sequencer track.

You can, however, use Remote Override to control parameters on other Reason de-
vices (or global Reason functions such as transport).

A basic MIDI keyboard and an additional control surface

The keyboard and the control surface should be connected to separate MIDI ports (or 
use separate USB connections). Here, the basic MIDI keyboard is your master key-
board - it is used for playing and recording via the sequencer. You can have the con-
trol surface follow the master keyboard - this lets you tweak the parameters of the 
device you are playing (just like in the example above). 

You can also lock the control surface to another device in the rack - this lets you play 
one device while adjusting the parameters of another.

A MIDI keyboard with controls plus one or more control surfaces

This is the ideal setup! Again, all keyboards and control surfaces should be connected 
to separate MIDI ports (or use separate USB connections). The keyboard is routed via 
the sequencer and you can use its controls to tweak the parameters of the device you 
are playing. The additional control surfaces could be locked to different devices in the 
rack. 

For example, if you lock a control surface to the main mixer, you will always have con-
trol over levels and pans. You could also have dedicated controls for transport, Undo/
Redo, sequencer track MIDI focus selection, etc.

Remote basics
Parameters and functions for each Reason device are mapped to controls on sup-
ported control surface devices. As soon as you have added your control surface(s) in 
the Preferences, you can start tweaking parameters!

D By default, all connected control surfaces follow the sequencer Master 
Keyboard Input.
This means that you set Master Keyboard input to a track in the sequencer to route 
the control surface(s) to the track’s device in the rack. You can bypass this func-
tionality by locking a control surface to a specific device - see page 113. Or you 
can simply use Remote Override mapping (see page 115 for specific parameters 
- these will then be mapped to the selected controls regardless of MIDI input.

D The Reason device connected to the track with Master Keyboard input 
will have its parameters standard mapped to logical controls (faders, 
buttons etc.) on the control surface device.
E.g. if a Subtractor has Master Keyboard input, your control surface will control the 
most important Subtractor parameters. If you set MIDI input to a track connected 
to a NN-XT, the control surface will now control parameters on the NN-XT device, 
and so on for each device. There are standard mapping variations for most devices 
as well - see page 113.

! Please refer to the separate “Control Surface Details” document for de-
vice related information.

D Supported control surfaces with dedicated transport controls will be 
standard mapped to the equivalent transport controls in Reason.
If you do not have transport controls on your control surface you can still map 
transport controls to controllers using Remote Override mapping - see page 115.

D Other important functions such as switching target track in the se-
quencer, selecting patches, Undo/Redo can also be remote controlled.
See page 117.

About Standard vs Remote Override mapping 
Reason parameters are “standard mapped” to supported control surface devices. 
There is nothing the user needs to set up to remote control any Reason device. You 
can, however, use Remote Override mapping to map a specific parameter to a spe-
cific control if you should want to.

D By using standard mapping the remote mapping for each device will be 
the same for any new song created in Reason, given you have the same 
set of control surfaces online. 
If you use Remote Override mapping (see page 115), the overrides will be saved 
with the current song, but won’t be there if you create a new song. 

D Which parameters and functions that are standard mapped for each Rea-
son device depends on the control surface(s).
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The “Control Surface Details” document contains some information about the stan-
dard mappings of the different control surface models. But you can also activate Re-
mote Override Edit mode to see which parameters for each device are mapped to 
your control surface(s) - see page 115.

D Note that if you have several control surfaces connected, some parame-
ters could be mapped to controls on more than one control surface.
This is not a conflict of any kind, but simply a consequence that stems from the 
fact that all control surfaces by default follow Master Keyboard (sequencer) MIDI 
input. By using Surface Locking (see below) or Remote Override (see page 115) 
you have full control over your control surfaces.

About mapping variations
Since there are often more parameters on a device than there are controls on the con-
trol surface, there are standard mapping variations available for most devices. When 
selecting a standard mapping variation, a new set of parameters will be mapped to 
the controls on your control surface for a selected Reason device. 

For example, if you have a control surface with 8 rotary knobs routed to a Subtractor, 
the knobs may control filter parameters by default. Selecting variation 2 may make the 
knobs control the oscillator settings, variation 3 may control LFOs and so on.

D For devices that support keyboard shortcuts, you switch between map-
ping variations using [Command] + [Option] (Mac) / [Ctrl] + [Alt] (Win-
dows) and the numerical keys [1] to [10] (not the numerical keypad), 
where [1] selects the default standard mapping.
How many mapping variations are available depends on the control surface and 
the Reason device selected. The variation selected will stay active until you switch 
MIDI input to another device (or select another variation). If you switch back to the 
same device it will have its default standard mapping (variation [1]).

D For control surfaces that have dedicated controls for selecting mapping 
variations these are used instead of keyboard shortcuts.

D Locked devices (see below) can also be locked to a specific mapping 
variation.

Locking a surface to a device
You can lock a control surface to a specific device so that it is always “tweakable”, re-
gardless of which track has Master Keyboard input in the sequencer. This enables you 
to play and record notes for one device and at the same time control parameters for 
another device from a control surface. 

For example, you could lock a control surface to control the main mixer, so you can al-
ways control overall levels while playing/tweaking other devices.

D The master keyboard device cannot be locked!
If you select the master keyboard in the Preferences, you can click the “Use No 
Master Keyboard” button. You can then lock this control surface to a device and 
use its controllers to tweak parameters, but you will not be able to play the device.

D You can lock several control surfaces to the same device.
However, each control surface can only be locked to one device at a time.

D Info about which devices are locked (and to which control surfaces) is 
saved with the song.

Locking a device
There are basically two methods you can use to lock a device:

Using the Surface Locking dialog

1. Select “Surface Locking...” from the Options menu.
The Surface Locking dialog opens. 

In this picture, the dialog has the master keyboard as the selected control surface - this cannot be 
locked. 
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2. Pull down the Surface pop-up from at the top of the dialog and select the 
control surface device you wish to lock to a device.

3. Next, open the “Lock to device” pop-up menu.
On this pop-up, all devices in the current song are listed. The “Follow Master Key-
board” item which is selected by default, means that the control surface isn’t 
locked (it instead follows the Master Keyboard input in the sequencer).

4. Select the device you wish to lock to the selected control surface from the 
list.

D If the selected control surface supports keyboard shortcuts for selecting 
mapping variations (see page 113) an additional “Always use Mapping” 
pop-up appears.
On this pop-up you can set whether you wish to lock a specific standard mapping 
variation or whether the device should switch mapping variations according to key-
board shortcuts. If the former is the case, select the mapping variation from the list. 
If the latter is the case, select “Follow Keyboard Shortcut”.

5. Close the dialog when you are done.
The device is now locked to the selected control surface. In Remote Override Edit 
mode (see page 115) a locked device is shown with a lock symbol in the upper left 
corner of the device panel.

Using the context menu

D A quick way to lock devices is by right-clicking (Win) / [Ctrl]-clicking 
(Mac) on a device panel to bring up the context menu.
On the context menu, all installed control surfaces (apart from the master key-
board) are listed with the text “Lock to” plus the name of the control surface. Se-
lecting one will lock the device to the control surface. On the context menu the 
control surface that is currently locked to this device will be ticked.

Unlocking devices
D To unlock a locked device, bring up the context menu for the locked de-

vice, and untick the “Lock to” item.’
This unlocks the device and the control surface will now follow master keyboard 
input.

D Another way to unlock a device is to open the Surface Locking dialog 
and selecting “Follow Master Keyboard” on the Lock to device pop-up.
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Remote Override 
Remote Override allows you to map parameters and functions to controls on your 
control surface device, overriding the standard mapping. 

Activating Remote Override Edit mode
1. Select “Remote Override Edit Mode” from the Options menu. 

All unselected devices in the rack are grayed out, indicating Edit mode. Each se-
lected device (including the Transport panel) will show a blue arrow symbol on ev-
ery parameter that can be mapped to a control on a control surface.

Remote Override Edit mode enabled with the mixer device selected.

To be able to see which parameters are currently mapped for a device, you have to di-
rect Master Keyboard input to the sequencer track it is connected to:

2. Select a device in the rack and enable Master Keyboard input for its se-
quencer track.
Standard mapped parameters are tagged with yellow knob symbols.

D Note that you can select the Transport panel as well!
Most items on the Transport panel can be mapped to controls. Note that by select-
ing the Transport panel any standard mapping will be shown automatically, unlike 
other devices where you have to first direct Master Keyboard input to the device 
from the sequencer.

D If you point on a standard mapped parameter, a tooltip appears showing 
which control on the control surface device the parameter is mapped to.

Remote Override mapping
If Remote Override Edit Mode is enabled you can use the following methods to map a 
parameter to a control:

Method 1:

1. Select the parameter you wish to map.
The arrow (or knob) changes to orange, indicating it is selected.

2. Select “Edit Remote Override Mapping...” from the Edit menu.
You can also [Ctrl]-click (Mac) / right-click (PC) the parameter to select the same 
item from the context menu.

The “Edit Remote Override Mapping” dialog opens. From here you have two ways to 
proceed:

D Either manually select the control surface and the control you wish to 
map the parameter to from the two corresponding pop-ups.
The Control Surface pop-up lists all installed control surface devices, and the 
Controls pop-up lists all the mappable controls for the selected control surface.
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D Or you can activate “Learn From Control Surface Input” and simply move 
(or press) the control you want to map the parameter to.
The “Control Surface Activity” field momentarily flickers as you turn the knob, and 
then the dialog shows the control surface and control it is mapped to.

D If the control surface has a keyboard, you can also select notes as con-
trols.
Notes work just like on/off buttons. If “Keyboard” is selected from the Controls 
pop-up, a Note Number field appears in the dialog.

3. Click OK to exit the dialog.
The mapped parameter now shows a lightning bolt icon, indicating it uses Remote 
Override mapping. Any overrides are always shown in Remote Override Edit 
mode. The device does not have to be selected or have Master Keyboard input fo-
cus.

4. To exit Remote Override Edit Mode, deselect it from the Options menu.
You can also leave this mode by pressing [Escape].

Method 2:

1. Double-click the parameter you wish to map.
A rotating lightning bolt appears for the parameter - this indicates that “Learn From 
Control Surface” mode is active. You can leave this mode by pressing [Escape].

2. Now move (or press) the control you want to map the parameter to.
The parameter is now mapped to the control. 

You do not always have to edit override mapping when Remote Override Edit mode is 
activated - see below.

Override mapping with Remote Override Edit mode deactivated

If Remote Override Edit Mode is enabled on the Options menu, mapped parameters 
are “tagged”, and the arrow indicators show the assignable parameters. In this mode, 
however, you cannot operate Reason normally. Remote Override Edit mode is prima-
rily for overview of available parameters and the current assignments.

D Another way to map parameters is to have “Remote Override Edit Mode” 
deactivated on the Options menu, and to simply [Ctrl]-click (Mac) / right-
click (PC) the parameter you wish to remote control.
This opens a pop-up menu, where one of the options will be “Edit Remote Over-
ride Mapping”. Selecting this will open the Edit Remote Override Mapping dialog. 
Thus, you do not have to select Edit mode from the Options menu if you already 
know that a parameter is free and assignable.

Removing Remote Overrides

This can be done for a selected parameter in the following way:

1. Select the parameter you wish to remove Remote Override for.
The lightning bolt changes to orange, indicating it is selected.

2. Select “Clear Remote Override Mapping...” from the Edit menu.
You can also [Ctrl]-click (Mac) / right-click (PC) the parameter to select the same 
item from the context menu. This is always available, regardless whether Remote 
Override Edit mode is selected or not.

Or you can remove all Remote Overrides for a device in one go:

1. Select the device you wish to remove Remote Override for.

2. Select “Clear All Remote Override Mappings for Device” from the Edit menu.
You can also [Ctrl]-click (Mac) / right-click (PC) the device panel to select the 
same item from the context menu.

Copying/Pasting Remote Overrides

You can copy Remote Override mappings for a device and paste them into a device 
of the same type. This works as follows:

1. With Remote Override Edit mode activated, select the device you want copy 
Remote Override mappings from, and the select “Copy Remote Override 
Mappings” from the Edit menu.
You can also [Ctrl]-click (Mac) / right-click (PC) the device panel to select the 
same item from the context menu.

2. Select the device you wish to paste the copied mappings to.
It has to be the same type of device you copied from. In case you copied Remote 
Override mappings from the Transport panel you can thus only paste the map-
pings into another song document.

3. Select “Paste Remote Override Mappings” from the Edit menu.

Now the following happens:

D If you are pasting in the mappings into a device in the same song docu-
ment, a dialog appears informing that the overrides are already used.
You then have the choice of cancelling the operation, or to move the existing over-
rides to the new device.

D If you are pasting into a device in another song, the copied Remote Over-
ride mappings are simply pasted.
In this case, the original Remote Override mappings are not affected.
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Additional Remote 
Overrides...

On the Options menu there is an item named “Additional Remote Overrides...”. Se-
lecting this opens a dialog with remote functions that cannot be assigned using Re-
mote Override Edit mode, such as switching target tracks, Undo/Redo etc.

What can be assigned?
Although most of the items in this dialog are self-explanatory, some need to be de-
scribed. These are as follows:

Target Track Delta and Target Previous/Next Track 

D Target track is the track with Master Keyboard (MIDI In) focus.
Assigning Target Previous/Next Track to two Button controls on a control surface 
allows you to move the keyboard symbol up or down in the Track list.

D Target Track Delta is meant to be used with Delta wheel controllers (a 
special control with no min/max range) to switch target track.
A Mackie Jog wheel is an example of this type of controller. 

D Select Previous/Next Track can be assigned to standard button controls.

Select Patch for Target Device and Select Previous/Next Patch for 
Target Device

The target device is the device connected to the target track. 

D Patch selection is usually standard mapped to buttons on a control sur-
face. 
If you wish to override this standard patch selection mapping for devices globally 
to select patches for any patch device that currently has Master Keyboard input, 
you can assign this here.
For example, you may always want to use the same buttons on a specific control 
surface for selecting patches.

D Select Patch for Target Device is also meant to be assigned to a Delta-
type control (see above). 
This allows you to select patches for a device connected to the target track by 
spinning the wheel clockwise or anti-clockwise.

D Select Previous/Next Patch can be assigned to standard button controls.

Select Keyboard Shortcut Variation (Delta) / Select Previous/Next 
Keyboard Shortcut Variation

By mapping controls to these, you can use your control surface to change which key-
board shortcut variation is selected in Reason.

• The "Select Previous/Next” functions are typically mapped to buttons, allowing 
you to step between keyboard shortcut variations.

• The Delta function must be mapped to a delta-type control to work.
• The keyboard shortcut variation selection is a global setting in Reason. It affects all 

added control surfaces (if they make use of keyboard shortcut variations and aren't 
locked to a specific device and variation in the Surface Locking dialog).

Undo/Redo

You can assign Undo/Redo to controls. This works just like the corresponding items 
on the Edit menu.

Document Name

This allows you show the name of the song in the display of the control surface. This 
only works for control surfaces that support this feature.

Assigning Additional Overrides
Assigning overrides in this dialog is similar to assigning standard Remote Overrides:

1. Select a function/controller in the list that you wish to assign to a control and 
click “Edit”.
This opens the Edit Remote Override Mapping dialog, where you can assign a 
control to the selected function/parameter. You can also simply double click the 
item in the list to open this dialog.

2. Click OK to close the dialog.

Clearing Additional Overrides

1. Select “Additional Remote Overrides” from the Options menu.
In the Mapping column you can see which parameters/functions use overrides.

2. Select the item currently assigned override mapping, and click “Clear”.
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Keyboard Control
Assigning keyboard remote commands does not involve MIDI, so there is no special 
setting up required. Keyboard commands can be assigned to parameters just as 
when using Remote Override mapping, but the functionality differs in one central as-
pect:

D Keyboard Control commands can only be used to toggle on/off or min/
max values for an assigned parameter.

Hence, if you assign a keyboard remote command for a knob, slider or spin control, it 
will only switch between the minimum and maximum values for that parameter. The 
only exception to this are the multi-selector buttons used for various parameters such 
as envelope destination, for example. These will cycle through the available options 
when using keyboard control.

Enabling Keyboard Control
To enable Keyboard Control, select “Enable Keyboard Control” from the Options 
menu.

Editing Keyboard Control
D To get an overview of which parameters are remote controllable select 

“Keyboard Control Edit Mode” from the Options menu. 
When done, each device you select will show a yellow arrow symbol beside every 
parameter that can be assigned a keyboard control.

A section of a drum machine with Keyboard Control Edit Mode enabled.

D If you click on an assignable parameter to select it, you can then select 
“Edit MIDI Control Mapping” from the Edit menu.
This opens a dialog allowing you to select a key command for that parameter.
You may use any key except the Space bar, Tab, Enter or the Numeric keypad 
(which is reserved for Transport functions) or a combination of [Shift] + any key 
(with the same aforementioned exceptions).

The Keyboard Control dialog.

D Simply press the key (or key combination) you wish to use to remote 
control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the key-
stroke(s), and then the dialog displays the name of the key you have pressed. If 
[Shift] was used, the box beside the word Shift in the dialog is ticked. 

You can also double-click on the arrow for an assignable parameter to set up key-
board control:

D A rotating yellow rectangle appears, indicating Learn mode. Press the 
key (or key combination) you wish to use to control the parameter.
The rotating stops and the rectangle will now display the key or key combination 
you used.

About the two Edit Keyboard Control Modes

If Keyboard Control Edit Mode is enabled (ticked) on the Options menu, assigned pa-
rameters are “tagged”, showing the remote key for that parameter. In this mode, how-
ever, you cannot operate Reason normally. This mode is primarily for overview of 
available parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Keyboard 
Control Edit Mode” deselected on the Options menu, and to simply 
[Ctrl]-click (Mac)/right-click (PC) the parameter you wish to remote con-
trol.
This opens a pop-up menu, where one of the options will be “Edit Keyboard Con-
trol Mapping”. Selecting this opens the Keyboard Control dialog. Thus, you do not 
have to enable/disable Edit mode from the Options menu if you know that a pa-
rameter is assignable.
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Saving Remote Setups
There’s no need to save MIDI Remote mapping as the Standard Remote mapping for 
each Reason device to supported control surfaces is built-in, and is always available. 
You may, however, wish to save specific Remote Override mappings or Keyboard 
Control setups as a template:

D This could be done by saving a song document containing all the devices 
that are affected by the related Key or Remote Override mappings, but 
without any sequencer data. 
This song document could then be used as a starting point for any new song, by 
simply loading it, and immediately using “Save As” to save it under a new name.



REMOTE - PLAYING AND CONTROLLING REASON DEVICES
120



8 D Advanced MIDI - the External Control Bus inputs



ADVANCED MIDI - THE EXTERNAL CONTROL BUS INPUTS
122

About the External Control 
Bus inputs
The External Control Bus inputs allow you to send MIDI directly to Reason devices.

D These MIDI inputs are for controlling Reason devices from an external 
sequencer.
This could be an external hardware sequencer or a sequencer application running 
on another computer.

D If you want to control Reason from another sequencer application on the 
same computer, the preferred method is ReWire (see page 126). 
However, if the other sequencer software doesn’t support ReWire 2, the External 
Control Bus inputs can be an alternative. In that case, you may need to use a MIDI 
routing application to be able to route MIDI from one program to the other.

You set up the External Control Bus inputs on the Advanced Control page in the Pref-
erences dialog:

D You should select a separate MIDI port for each bus you plan to use.
Each bus provides 16 MIDI channels, for a total of up to 64 MIDI input channels. 
For example, if you have an external sequencer with two MIDI outputs, you connect 
these to two MIDI inputs on your MIDI interface and select these two inputs for the 
first two busses on the Advanced MIDI page. You will then be able to send MIDI 
on up to 32 channels from the external sequencer to Reason.

D Make sure you don’t select a MIDI port that is already selected on the 
Control Surfaces and Keyboards page (or in the MIDI Clock Sync sec-
tion).

Routing MIDI to Devices
Each External Control Bus can control up to 16 different Reason devices, one for 
each MIDI channel. To route a MIDI channel directly to a Reason device, proceed as 
follows:

1. Locate the hardware interface at the top of the rack.

2. In the MIDI In device, click the Bus Select button for the External Control Bus 
you want to use (A, B, C or D).

3. Below the Bus Select buttons there are fields for the 16 MIDI channels. Click 
the arrow button for the desired MIDI channel and select a Reason device 
from the menu that appears.
Incoming MIDI data on that bus and channel will now be sent directly to the se-
lected device. In other words, the master keyboard routing (the “In” column in the 
sequencer) is bypassed.

Sending Controller Data via MIDI
It is possible to send controller data from an external sequencer to control Reason pa-
rameters. Just set up your external device to transmit the correct MIDI controller mes-
sages on the right MIDI port.

To find out which MIDI Controller number corresponds to which control on each de-
vice, please see the “MIDI Implementation Charts.pdf” document.

Once you have located the controller numbers and set everything up, you can record 
and edit the controller data in the external sequencer as you normally do, and the Rea-
son parameters will react correspondingly.

✪ Do not confuse this with Remote control. Remote does not require any 
mapping of controller numbers for supported control surfaces! See page 
110.

Recording Pattern changes
As specified in the MIDI Implementation, MIDI Controller #3 can be used to switch 
patterns in a device. However, pattern changes activated this way occur immediately 
(not at the end of the bar), which may or may not be what you prefer.

Please see page 69 for information on recording and editing pattern changes.
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About this Chapter
This chapter describes how to use Reason as a ReWire slave, that is with Reason de-
livering audio to another ReWire compatible application. It does not deal with using 
ReBirth and Reason together; that is described on page 316.

Why use Reason with 
ReWire?
While Reason is a complete music tool in its own right, you might want to add other 
elements to the music, such as:

• Vocals.
• Instrumental recordings.
• Hardware synthesizers (controlled via MIDI).

Connecting Reason to another application allows you to do just this, integrate your 
Reason songs with any other type of music, external MIDI and acoustic recordings. By 
recording Reason onto audio Tracks in an audio sequencer you can also continue 
processing your Reason tracks with other internal and external effects.

Introducing ReWire!
To make this integration between two audio programs possible, Propellerhead Soft-
ware has developed ReWire. This technology provides the following possibilities and 
features:

In ReWire version 1

• Real time streaming of separate audio channels, at full bandwidth, into another au-
dio program.

• Automatic, sample accurate, synchronization between the audio in the two pro-
grams.

• The possibility to have the two programs share one sound card.
• Linked transport controls that allows you to play, rewind etc, from either program.
• Less total system requirements than when using the programs together in the con-

ventional way.

In ReWire 2

A number of features were added in Reason version 2. The following are the most im-
portant:

• Up to 256 audio channels (previously 64).
• Bi-directional MIDI communication of up to 4080 MIDI channels (255 devices with 

16 channels each)
• Automatic querying and linking features that (among other things) allow a host to 

display the slave’s devices, controllers, drum sounds etc. by name.

How Does it Work?
Basically the key to ReWire is the fact that Reason is divided into three components:

• The Reason application.
• The Reason Engine (a DLL on the PC and a Shared Library file on the Macintosh. 

Both located in the Reason program folder.)
• ReWire (also a DLL on the PC and a Shared Library on the Macintosh).

ReWire and the Reason Engine are common resources to the two programs (the 
other application and Reason) that generate the audio and passes it onto the other 
audio application.

Terminology
In this text we refer to Reason as a ReWire slave and the application receiving audio 
from Reason (this could be Steinberg Cubase, Emagic Logic Audio or Mark of the 
Unicorn Digital Performer for example) as the host application.

About System Requirements
To run Reason together with another audio application of course raises the demands 
on computing power. However, adding ReWire to the equation does not in itself re-
quire a more powerful computer. On the contrary, it is likely that ReWiring two pro-
grams requires less power than for example running them with one audio card each.

Still, you should be aware that running two powerful audio applications on one com-
puter will require a fast processor and most of all a healthy amount of RAM.
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Launching and Quitting
When using Rewire, the launch and quit order is very important:

Launching for normal use with ReWire

1. First launch the host application.

2. Then launch Reason.

Quitting a ReWire session

When you are finished, you also need to Quit the applications in a special order:

1. First quit Reason.

2. Then quit the host application.

Launching the host application for use without Reason/ReWire

If you don’t plan to run Reason, just launch the host application as usual. We recom-
mend that you then also deactivate all ReWire channels if required (see the relevant 
section for your program, below). But this is not completely critical, ReWire does not 
use up very much processing power when it isn’t used.

Launching Reason for use without the host application

If you want to use Reason as it is, without ReWire, just launch it as you normally do.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Reason and a Rewire host applica-
tion at the same time on the same computer, without using ReWire, but you can:

1. First launch Reason.

2. Then launch the host application.

You may get a warning message in the host application, regarding ReWire, but you 
can safely ignore it. Please also note that the two programs now compete for system 
resources such as audio cards, just as when running either with other, non-ReWire, 
audio applications.

Using the Transport and 
Tempo Controls
Basic Transport Controls
When you run ReWire, the transports in the two programs are completely linked. It 
doesn’t matter in which program you Play, Stop, Fast Forward or Rewind. Recording, 
however, is still completely separate in the two applications.

Loop Settings
The Loop in Reason and the corresponding feature (Loop, Cycle etc) in the host ap-
plication are also linked. This means that you can move the start and end point for the 
Loop/Cycle or turn the Loop/Cycle on/off in either program, and this will be reflected 
in the other.

Tempo Settings
As far as tempo goes, the host application is always the Master. This means that both 
program will run in the tempo set in the host application.

However, if you are not using automated tempo changes in the host application, you 
can adjust the tempo on the transport in either program, and this will immediately be 
reflected in the other.

! If you are using the automated tempo changes in the host application, do 
not adjust the tempo on the Reason transport, since that tempo the 
doesn’t have any effect on playback!

Synchronization
All synchronization to other equipment is handled from the host application, not Rea-
son. In fact there are no special synchronization issues. All that is said in the host ap-
plication’s documentation about synchronizing audio channels is true for ReWire 
channels as well.
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Routing Audio
Preparations in Reason

When you route audio from Reason to a ReWire host application, you make use of the 
Hardware Interface at the top of the rack. Basically, each output in the Hardware In-
terface is connected to a separate ReWire channel. Therefore:

D To take full advantage of the mixing features in the host application you 
need to connect the different Reason devices directly to the Hardware In-
terface.
For example, if your Reason Song contains eight different instrument devices and 
you connect these to separate inputs on the Hardware Interface, they will appear 
on separate ReWire channels in the host application. You can then use the mixing 
facilities in the host application to adjust volume and pan, add effects and equaliz-
ing etc. - individually for each Reason device!
If you instead connect all your Reason devices via a Mixer to the stereo input pair 
on the Hardware Interface, all sounds will appear mixed on a single ReWire stereo 
channel pair. While this works perfectly fine, you won’t be able to mix and process 
the devices separately in the host application.

Routing in the ReWire host application

The following description is based on using Reason with Cubase as the host applica-
tion. For descriptions on how to activate and route ReWire channels in other host ap-
plications, please go to www.propellerheads.se/rewirehelp.

1. Pull down the Devices menu in Cubase and select the menu item with the 
name of the ReWire application (in this case Reason). All recognized ReWire 
compatible applications will be available on the Devices menu.
The ReWire panel appears. This consists of a number of rows, one for each avail-
able ReWire channel.

2. Click on the green buttons in the “Active” column to activate/deactivate the 
desired channels.
The buttons light up to indicate activated channels. How many and which chan-
nels you need to activate depends on to which Hardware Interface inputs you have 
connected your Reason devices, as discussed above.

3. If desired, double click on the labels in the right column, and type in another 
name.
These labels will be used in the Cubase Mixer to identify the ReWire channels.

4. Open the Cubase Mixer.
You will find that new channels have been added - one for each activated ReWire 
channel. If the channels aren’t visible, you may need to scroll the Mixer window or 
check the Mixer View options (different channel types can be shown or hidden as 
desired in the Cubase Mixer).

5. Start playback (in Reason or Cubase - it doesn’t matter as both programs will 
automatically be synchronized).
You will now see the level meters moving for the playing ReWire channel, and hear 
the sound of the Reason devices through Cubase’s Mixer. Of course, this requires 
that your Reason Song contains some music!

6. Use the mixing features in Cubase to add effects, EQ, etc.

Routing MIDI via ReWire 2
The following description is based on using Reason with Cubase as the host applica-
tion. For descriptions on how to route MIDI to Reason from other host applications, 
please go to www.propellerheads.se/rewirehelp.

1. In Cubase, select a MIDI track that you want to route to a Reason device.

2. Pull down the MIDI Output menu for the track (in the Inspector or track list).
All devices in the current Reason Song are listed on the pop-up menu, along with 
the conventional, “physical” MIDI outputs.

3. Select a Reason device from the pop-up menu.
The output of the MIDI track is now routed to that device.

D If you now play back a MIDI part on the track, the MIDI notes will be sent 
to the Reason device - just as if the track were connected to any regular 
MIDI sound source.
The sound of the device will be sent back into Cubase via ReWire - which channel 
it will appear on depends on how you have routed the device to the Hardware In-
terface in Reason, as discussed above.

D To play the device “live”, you need to select the proper MIDI input for the 
track in Cubase (the input to which your MIDI keyboard is connected) 
and activate the Monitor button for the track.
When the Monitor button is activated, all incoming MIDI (i.e. what you play on the 
keyboard) is immediately sent to the track’s MIDI Output (i.e. to the Reason de-
vice).

www.propellerheads.se/rewirehelp
www.propellerheads.se/rewirehelp


USING REASON AS A REWIRE SLAVE
127

Converting ReWire 
Channels to Audio Tracks
Most often, there is no need to convert individual ReWire channels to regular audio 
tracks! The channels already appear in the host application’s Mixer, and you can typi-
cally perform the same kind of real-time processing as with regular audio channels (ef-
fects, EQ, volume, pan and mute automation, etc.).

Still, you may need to convert the ReWire channels to audio tracks, for example if you 
want to continue working in Cubase only. This is probably easiest done by using the 
host application’s “Export Audio” or “Bounce” function. In Cubase, you would pro-
ceed as follows:

1. Make sure your Reason devices play back properly via ReWire.

2. In the Cubase Mixer, activate Solo for the ReWire channel you want to con-
vert to a regular audio track.
Make sure no other channel is Soloed as well.

3. Go to Cubase’s Project window and set the left and right locator to encom-
pass the whole song (or a section, if that’s what you want).
Make sure the Cycle (loop) function is turned off.

4. Pull down the File menu in Cubase and select “Audio Mixdown” from the Ex-
port submenu.
The Export Audio Mixdown dialog appears.

5. Activate the “Import to Pool” and “Import to Track” options and fill in the rest 
of the dialog as desired.
You can choose to include any Cubase mixer automation, select a file format and 
file name, etc.

6. Click Save.
The ReWire channel is now rendered to a new audio file on disk. A clip referring to 
the file will appear in the Pool, and an audio event playing this clip will be created 
and placed on a new audio track, starting at the left locator.

D If you now play back the audio track you will hear exactly what was 
played on the ReWire channel. 
This means you should keep that ReWire channel muted (or deactivated) now, 
since otherwise you would hear the sound twice - once via ReWire and once from 
the audio track.

D To convert all your ReWire channels this way, simply proceed as above 
(but solo another ReWire channel in the Cubase Mixer).

! Converting ReWire channels this way results in a number of audio files 
that can be very large (depending on the length of the song). Make sure 
you have enough disk space!

Details About Various 
ReWire Hosts
The Propellerhead Software website provides updated information on how to config-
ure ReWire for most compatible host applications. 
Please go to: www.propellerheads.se/rewirehelp. 

http://www.propellerheads.se/rewirehelp
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ReWire users – Read This!
This chapter is about synchronization via MIDI Clock, and does not apply to users of 
ReWire. If you are using Reason together with a ReWire compatible application, Re-
Wire automatically handles all synchronization issues for you. See page 123 for de-
tails.

What is Synchronization and 
MIDI Clock?
Synchronization, in this context, is when you make Reason play at the same tempo as 
another device; where both start, stop and can locate to certain positions, together. 
This is done by transmitting MIDI Clock signals between Reason and the other de-
vice. MIDI Clock is a very fast “metronome” that can be transmitted in a MIDI cable. As 
part of the MIDI Clock concept there are also instructions for Start, Stop and locating 
to sixteenth note positions.

You can set up synchronization between Reason and hardware devices (tape record-
ers, drum machines, stand alone sequencers, workstations etc.) and other computer 
programs running on the same or another computer.

Master/Slave
In a synchronized system there is always one master and one or more slaves. In our 
case, the master is the one that controls the tempo. In other words, it is only the 
tempo setting on the master device that is of any relevance, since the slaves slavishly 
follow the master's tempo.

D Reason always acts as a slave. That is, it receives MIDI Clock signals, it 
never transmits them.

! Before you create any serious projects that require sync, try out the fea-
tures described below and check out “Synchronization Considerations” 
on page 117.

Slaving Reason to an 
External Device
This example assumes that you have an external device, such as a drum machine, 
hardware sequencer, another computer, tape recorder etc., that transmits MIDI Clock 
signals to which you want to synchronize Reason. 

1. Connect a the device via USB/MIDI to the computer running Reason.

2. Set up the other device so that it transmits MIDI Clock signals to the MIDI 
Out you just connected to the computer running Reason.

3. In Reason, pull down the Edit menu (under Mac OS X, the Reason menu) and 
open the Preferences dialog. Select the Advanced MIDI page.

4. Pull down the MIDI Clock Sync pop-up and select the MIDI Input to which you 
connected the other device.

5. Close the dialog.

6. Activate MIDI Clock Sync from the Options menu in Reason.
This can also be set on the Transport panel.

7. Activate playback on the other device.
Reason will start playing ‘in sync’ with it and the Sync LED on the Transport will 
light up.
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Slaving Reason to Another 
Program on the Same 
Computer
! The preferred method for synchronizing two applications is by using Re-

Wire, see page 123. However, if the application you need to sync Reason 
with doesn’t support ReWire, you can try the procedures described be-
low.

This section describes how to use MIDI Clock to synchronize Reason to another ap-
plication running on the same computer. 

! Note that synchronization via MIDI Clock makes the two programs play 
at the same time, that is, they both “run” when you “hit play”. It does not 
mean they can both play audio at the same time. 

Proceed as follows:

1. Set up the other program, so that it transmits MIDI Clock to Reason:
Under Windows this is done by selecting one of the MIDI routing utility ports.

2. In Reason, open the Preferences - Advanced MIDI page.

3. Pull down the MIDI Clock pop-up and select the corresponding MIDI port.

4. Close the dialog.

5. Activate MIDI Clock Sync from the Options menu in Reason.

6. Activate playback on the other device.
Reason will start playing ‘in sync’ with it and the Sync LED on the Transport will 
light up.

Synchronization 
Considerations
Adjusting for Latency

Latency compensation.

Because of the latency problem described on page 18, you might need to adjust Rea-
son’s playback in relation to the sync master, so that they are in perfect time. The 
tempo will not differ between the two, but Reason might play ahead or behind the 
other application. You might need to adjust this. However, this is something you only 
need to do once. The setting is stored with your other preferences, so you don’t need 
to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for example 
quarter or eighth notes, preferably with a special sound on the downbeat.
This click can either come from an internal metronome or from a MIDI source. If 
you use a MIDI source, make sure you pick one that has solid MIDI timing.

2. Set up Reason so that it plays a similar rhythm as the other application.
You might for example use the Metronome or Redrum drum computer for this.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in Reason and select the Audio page.

6. Trim the “Latency compensation” setting until the “clicks” from the both 
sources sound at exactly the same time.

7. Close the Preferences dialog in Reason.

If Latency Compensation isn’t enough
There might be situations where you can’t compensate enough in Reason to make 
two software applications run in sync. This might especially be true if the other appli-
cation is an audio sequencer, that is if it can record and playback both audio and 
MIDI.

This problem is an indication of the fact that the other application has not been set up 
properly and that its audio playback is not in sync with its own MIDI playback.

! This is not something that you can or should compensate for in Reason. 
Instead, follow the instruction included with the other application to 
make sure its MIDI playback and audio playback are correctly locked to 
each other.
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About the beginning of the Song
Due to the latency phenomenon, described on page 18, Reason needs some time to 
correct it’s playback speed when it first receives the Start command. This can be 
noted as a small glitch in the audio playback, when the program starts. If this is a prob-
lem, you need to insert a couple of empty measures at the beginning of the Song. Pro-
ceed as follows: 

1. Set the Left Locator to “1 1 1” and the right Locator to “3 1 1“.

2. Click somewhere in the main sequencer area to move the menu focus to the 
sequencer.

3. Select “Insert Bars Between Locators” from the Edit menu.

4. Set up the other device/application, so that it also plays two empty bars at 
the beginning.

About MIDI Song Position Pointers
MIDI Clock actually consists of five type of messages: The actual clock (the metro-
nome that establishes the tempo), Start, Stop and Continue commands and Song Po-
sition Pointers. This last type of message contains information about positions, so that 
a program for example “knows” where in a Song to start playback from.

Normally, this ensures that you can locate to any position and activate playback from 
there. In older devices, Song Position Pointers might not be implemented. This means 
that you will be able to synchronize properly only if you start both devices from the ab-
solute beginning of the song.

About Tempo Changes
Again, due to the latency phenomenon, Reason needs a bit of time to adjust to 
changes in tempo. If there are abrupt changes in the MIDI Clock, due to drastic tempo 
changes in the master, you will note that Reason will require up to one measure to ad-
just itself to the change. How long this actually takes also depends on the precision of 
the incoming MIDI Clock. The more precise it is, the faster Reason can adjust to it. 

If this adjustment is a problem, try to use gradual tempo changes rather than immedi-
ate ones.

! When Reason is synchronized to MIDI Clock, there is no Tempo readout.

MIDI Sync and Focus
The Options menu contains items relating to MIDI sync. 

D The “MIDI Clock Sync” button puts Reason into MIDI sync mode. 
The transport controls will be disabled, and Reason will not run unless MIDI sync 
data is provided from an external device. 

The MIDI and Play Focus buttons relate to how incoming MIDI and MIDI sync should 
be handled if there are several open Song documents. If you have two or more Songs 
opened, and no MIDI sync is used, the currently selected Song (the document “on 
top”) always has MIDI focus. If MIDI Sync is enabled (which is global for all currently 
open Song documents), this functionality changes in the following way:

D If both “Play” and “MIDI” are activated for a Song, incoming MIDI data 
and MIDI sync will be sent to this Song, regardless of whether another 
Song is currently in focus.

D If only “MIDI” is activated for Song, and another Song has “Play” focus, 
incoming MIDI will be sent to the former and MIDI sync to the latter (i.e 
this Song will play back), regardless of which Song is currently in focus.
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About Self-contained Songs
The song is the main file format in Reason. A song contains the device setup and all 
settings in the rack, as well as everything you have recorded in the sequencer.

However, this is not always sufficient! Should you open your song on another com-
puter or send it to another Reason user, you would also have to bring all samples and 
REX files used by the devices in the song. To make this easier, Reason allows you to 
create “self-contained” songs.

A self-contained song contains not only the references to the used files, but also the 
files themselves. You can choose exactly which files should be included in the self-
contained song, with the following exception:

! Files that are part of a ReFill cannot be included in a self-contained song.

If your song contains samples or REX files from a ReFill, other users must have the 
same ReFill to be able to play the song.

To specify which files should be included in the song, proceed as follows:

1. Pull down the File menu and select Song Self-Contain Settings...
A dialog appears, listing all samples and REX files used in the song.

2. Tick the checkbox in the Sound column for the files you want included in the 
song.

D You can use the Check All button to activate all checkboxes in one go.
Similarly, the Uncheck All button deactivates all checkboxes.

D Files that are part of a ReFill are indicated by a lock symbol instead of a 
checkbox (since they cannot be included in the song file).
The rightmost column indicates to which ReFill each such file belongs.

3. When you have selected the desired sounds, click OK.
The dialog is closed. The next time you save, the specified sounds will be included 
in the song file.

! Note that a self-contained song file will be considerably larger than the 
original song file. 
However, samples included in a self-contained song are automatically 
compressed by approximately 50%, meaning that the self-contained 
song will still be a lot smaller than the original song and the sample files 
combined.

“Un-self-containing” a Song
If you have opened a song that is more or less self-contained (i.e. contains one or sev-
eral sounds embedded in the song file), you may want to extract these sounds and 
make the song refer to them on disk as usual. This is done in the following way:

1. Select Song Self-Contain Settings from the File menu.
The dialog appears.

2. Locate the sounds you want to extract from the song file, and deactivate their 
checkboxes (or click Uncheck All).

3. Click OK to close the dialog.
Now, the program will check for each “extracted” sound file whether it is available 
(at its original, stored location) or not.

D If the program finds the sound file at the location stored in the song, it is 
simply removed from the song file, and the original file reference path is 
used.
This would be the case if you made the song self-contained yourself, and un-self-
contain it on your own computer (provided that you haven’t removed the original 
sound files from disk since you made the song self-contained).

D If the program doesn’t find the sound file, a file dialog appears, allowing 
you to select a folder and name for the sound file.
The extracted file will be saved in the specified folder, and the path in the song will 
be adjusted. This would be the case if you got the self-contained song from an-
other user, for example.
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Song Information
Selecting the Song Information item on the File menu opens a dialog in which you can 
supply various information about the song. 

For example, if you plan to send the song to other Reason users, this dialog allows 
you to add contact information, comments about the song, etc. Furthermore, if you 
save a published version of the song in the Reason Song Archive on the Propeller-
head web site (see page 136), vital information can automatically be extracted by the 
web archive engine, and displayed with the song file.

The dialog contains the following items:

Text in Window Title

The text you add here will be displayed directly after the file name in the song win-
dow’s title bar.

More Information

This is where you add notes and comments about the song.

Song Splash

Allows you to add a picture to the song. The picture will be displayed when the song 
is opened.

To add a splash picture, click the folder button at the upper right corner, and locate 
and open the picture file in the file dialog that appears.

! Splash pictures must be JPEG files (Windows extension “.jpg”) with a 
size of 256 x 256 pixels.

To remove the splash picture from the song, click the cross button.

Author’s Web Page

Allows you to specify your web site. The user can go directly to your site by clicking 
the Browser button to the right (provided he has a working Internet connection).

Author’s Email

This is where you specify your e-mail address, if you want other Reason users to send 
you their comments, etc.
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Saving a Song
To save a song, proceed as follows:

1. Set up the self-contained settings as desired (see the previous page).

2. Pull down the File menu and select Save (or press [Command] / [Ctrl]-[S]).
If this is the first time you save the song, a regular file dialog will appear.

3. Specify a name and location for the song and click Save.

Once you have saved a song, selecting Save will simply save it under the same name 
and in the same location, without showing a dialog. If you want to save a song under 
another name or in another location, select Save As... from the File menu to open the 
save dialog.

Publishing a Song
If you want to make your songs available to the public, e.g. for downloading on the In-
ternet, there is a special file format for this. A Reason published song (Windows file 
extension “.rps”) is much like a self-contained song, but has the following restrictions:

• The user cannot save any changes to the song.
• Copy, Cut and Paste is disabled.
• It is not possible to use the function Export Song/Loop as Audio File if the the 

song has been changed in any way.

In a word, published songs are “locked”. They are meant for playback only - no ele-
ments can be added, removed or extracted. Furthermore, a published song contains 
information about which ReFills are required (if any).

To create a published song, pull down the File menu and select Publish Song. Specify 
a name and location for the published song in the file dialog that appears, and click 
Save.

D Note that you don’t have to make self-contained settings - all files (ex-
cept ReFill components) are automatically included.

About the Reason Song Archive

On the Propellerhead web site (www.propellerheads.se) you will find the Reason 
Song Archive. This allows you to share your music with other Reason users by up-
loading your songs. 

Opening a Song
1. Pull down the File menu and select Open.

The Reason song browser window appears.

2. Use the browser to navigate to the desired folder on disk or within a ReFill.
See page 33.

3. When you have located the song file, select it and click Open (or double click 
on the file).
The song appears in its own document window.

✪ You can have several songs open at the same time if you like. This allows 
you to copy and paste patterns and patches between songs. However, all 
open songs consume some memory and performance, so you may want 
to close songs you don’t need.

If the “Missing Sounds” dialog appears
If the song includes samples or REX files, and these have been moved or renamed 
since the song was saved, the program will inform you that it cannot find all files. You 
can then choose to either manually locate the missing files, to have the program 
search for them or to proceed with missing sounds. For details, see page 41.

Closing a Song
To close the current song, select Close from the File menu or click the close box of 
the song document window. If you have unsaved changes, you are asked whether you 
want to save the song.

Creating a New Song
To create a new song, select New from the File menu. This makes a new song docu-
ment window appear.

D By default, the new song will contain a mixer and an MClass Mastering 
Suite Combi.
If you want to start with your own selection of devices (or an empty rack), you can 
customize your default song, as described below.

✪ An alternative to creating a new song would be to open one of the tem-
plates found in the Template Documents folder (within the Reason pro-
gram folder).

Creating a Default Song
If you often start off with the same set of devices, patches, patterns and settings, you 
may want to create your own custom default song. Proceed as follows to specify a 
song as the default:
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1. Select New from the File menu to create a new song document window.

2. Add/remove devices and make settings as desired.
Typically, you may want the default song to contain your choice of devices and 
possibly some patterns. You could also make some special routing between de-
vices, or even add some sequencer data.

3. Save the song anywhere you like, and under whatever name you like (to 
keep things organized you might want to save the song in the Reason pro-
gram folder).

4. Open the Preferences dialog from the Edit menu (or from the Reason menu, 
if you are using Mac OS X).

5. On the “General” page, click the radio button to select “Custom” in the sec-
tion called “Default Song”.

6. Click the folder icon to the right to open the file browser.

7. Navigate to the song you created earlier, select it and click “OK”.
The name of the song appears in the textbox.

8. Close the Preferences dialog.
The next time you launch the program or select New from the File menu, the new 
song document will contain the devices and settings you made.

Exporting as an Audio File
When you have created a complete song, you may want to mix it down to make it play-
able for other people (who don’t use Reason). Of course, you could connect the au-
dio outputs of your audio hardware to a tape recorder or similar, and simply record the 
song. But if you are planning to burn an audio CD or create mp3 files, it’s much more 
convenient to mix down to an audio file, using the Export functions. 

You can either export the whole song (from the start to the “E” marker), or only the 
loop (the area between the left and right locator in the sequencer). Proceed as fol-
lows:

1. Make sure only the main stereo outputs are used.
That is, no devices should be connected to individual outputs (output socket 3 and 
higher in the Hardware Interface device). The export function will only include au-
dio routed to the stereo outputs.

2. Make sure the Loop/End markers are at the correct positions.
If you want to export the loop, you need to set the left and right locators to encom-
pass the desired area. If you instead want to export the whole song, make sure the 
End (E) marker is at the desired end position.

✪ If you are using reverb or delay, you may want to adjust the right locator 
or End marker so that the reverb/delay “tails” are included in the ex-
ported file.

3. Check that the song (or loop) plays back properly.
It’s especially important that no clipping occurs during playback (see page 18).

4. Pull down the file menu and select Export Song as Audio File (or Export Loop 
as Audio File).
A file dialog appears.

5. Specify a name, location and file type (AIFF or Wave) for the audio file, and 
click Save.
This opens a Settings dialog.

6. Use the pop-up menus to select a sample rate and bit depth (resolution) for 
the audio file.
16 or 24 bit audio is supported, at a number of different sample rates. The ex-
ported file will always be a stereo audio file. 

D If exporting to 16-bits you have the option of applying Dither. 
Dither is a type of noise added to a digital signal, which improves low level sound 
quality when exporting to a lower bit resolution.

✪ Which format to select depends on how you are planning to use the file. 
If you are planning to burn an audio CD, you should select 16 bit, 44100 
Hz. If you are planning to open the file in another application, you should 
select a format supported by this application. Also note that the higher 
the resolution and sample rate, the larger the file.

7. Click OK.
The program creates the audio file. Depending on the length of the song/loop, this 
may take a while, during which a progress dialog is shown.

! If you are using ReWire, you may want to use the Export function in the 
ReWire master application instead. This allows you to include audio from 
both applications in the exported audio file.
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Introduction
Reason is a program of infinite possibilities. You can create as complex songs as you 
like, using endless racks of devices. While this is one of the most exciting properties 
of the program it does have a drawback – it means that you must be careful with how 
you manage your computer processing power.

Each device you add to the rack uses up a bit of computer processing power – the 
more devices the faster the computer has to be. However, you can set up your de-
vices to require more or less processing power. For example a sound on the Subtrac-
tor synthesizer that only uses one oscillator and one filter requires much less 
processing power than one using both dual oscillators and dual filters.

Samples used in your songs also require RAM - memory - to load properly. The use of 
RAM can also be managed, as described at the end of this chapter.

When creating songs for other people, for example for publishing in the Reason song 
archive (see www.propellerheads.se for more information), you should do what you 
can to reduce the requirements for playing back a certain song, both in terms of pro-
cessing power and in terms of RAM requirements. Other users may not have as pow-
erful a computer as you do!

Checking Processing Power
On the transport you will find a meter labelled DSP. This indicates how much pro-
cessing power is used at any given moment.

The DSP meter.

The higher this meter goes, the higher the strain on your computer processor. You will 
note when your processor is heavily loaded that graphics will update slower. Finally, 
when there’s too little power left to create the audio properly, the sound will start 
breaking up.

Optimization and Output 
Latency
As described on page 18, you generally want the lowest possible latency, to get the 
best response when you play Reason in real time. However, selecting too low a la-
tency is likely to result in playback problems (clicks, pops, dropouts, etc.). There are 
several technical reasons for this, the main one being that with smaller buffers (lower 
latency), the average strain on the CPU will be higher. This also means that the more 
CPU-intensive your Reason song (i.e. the more devices you use), the higher the mini-
mum latency required for avoiding playback difficulties.

Therefore, you may need to adjust the latency. This is done differently depending on 
which audio cards, drivers and operating system you are using:

Making adjustments in the ASIO Control Panel

If you are using an ASIO driver specifically written for the audio hardware, you can in 
most cases make settings for the hardware in its ASIO Control Panel. This panel 
(opened by clicking the ASIO Control Panel button in the Preferences-Audio dialog) 
may or may not contain parameters for adjusting the latency. Usually this is done by 
changing the number and/or size of the audio buffers - the fewer and smaller the au-
dio buffers, the lower the latency. Please consult the documentation of your audio 
hardware and its ASIO drivers for details!

! Raising the buffer size to eliminate audio artefacts on playback is mainly 
effective if you are currently using very small buffers, 64 to 256 samples. 
If the buffers are already big (1024 or 2048 samples) you will not notice 
much difference.

Making adjustments in the Reason Preferences dialog

If you are running Reason under Windows and using an MME or DirectX driver, or if 
you are running Reason under Mac OS X and using the Built-in audio controller driver, 
you can adjust the output latency in the Preferences – Audio dialog.

D This is done by dragging the Buffer Size slider.
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General procedure

The basic procedure for optimizing the latency is the following:

1. Open a song and start playback.
You want to choose a song that is reasonably demanding, i.e. with more than just 
a few tracks and devices. 

2. Open the Preferences dialog.
Under Mac OS X, this is found on the Reason menu; under Windows it’s found on 
the Edit menu.

3. Select the Audio page and locate the buffer settings.
If you are using an ASIO driver, you need to click the ASIO Control Panel button, 
for Mac OS X/Built-in audio, Windows/MME or DirectX you should use the Buffer 
Size slider.

! If you are making adjustments in the ASIO Control Panel for hardware 
with an ASIO driver, you should make a note of the current buffer set-
tings before changing them.

4. While the song is playing, listen closely for pops and clicks and try lowering 
the latency (buffer size/number).

5. When you get pops and clicks, raise the latency value a bit.

6. Close the Preferences dialog (and ASIO Control Panel, if open).

About Latency Compensation

In the lower right corner of the Preferences-Audio dialog, you will find a setting called 
Latency Compensation. This value is used internally in Reason to compensate for the 
latency when synchronizing Reason to another MIDI sequencer or similar. Usually, La-
tency Compensation is set to the same value as the Output Latency, but it is possible 
to increase it (see page 131). Normally however, you shouldn’t need to touch this pa-
rameter.

Optimizing Your Computer 
System
In this manual we do not have the possibility to give you detailed procedures for opti-
mizing your computer for maximum power. This is a subject that we could write com-
plete books on! However, we’d like to share a couple of important tips:

D Quit other programs that are running at the same time as Reason.

D Remove background tasks on your computer.
This might be any background utilities you have installed as well as networking, 
background internet activities etc.

D Under Windows, make sure you use the latest and most efficient driver 
for your audio card.
Generally, ASIO drivers are the most efficient, followed by DirectX and last MME.

D Only work on one Reason document at a time.
Songs that are open in the background do consume some processing power even 
though they’re not playing.

D Lower the sample rate setting in the Preferences dialog.
While this also reduces sound quality, it is a very quick and convenient way to try 
to play a song that your computer otherwise can’t handle.
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Optimizing Songs
Below follows things you can check and change to make sure your song uses as little 
computer processing power as possible:

Global
D Delete unused devices.

If a device isn’t actually doing anything, delete it from the rack.

D Use fewer devices.
For example, instead of using several reverbs as insert effects, replace them all 
with one, set up as a send effect. By the same token, try to use one sampler play-
ing several different samples instead of numerous samplers playing one sample 
each.

D Don’t use stereo unless it is required.
For example, if a sampler or Dr. Rex player is playing mono material, only connect 
the Left output and leave the Right output unconnected.

Sample Players – NN19, NNXT, Dr. Rex and Redrum
D Only activate High Quality Interpolation when it is required.

Listen to the sound in a context and determine whether you think this setting 
makes any difference. However, note that on a Macintosh G4, High Quality Inter-
polation does not require any more processing power.

D If you are playing back a sample at a much higher pitch than it was re-
corded at, consider sample rate converting the actual sample file to a 
lower sample rate.
This will require an external sample editor with good sample rate conversion facili-
ties.

D Try to refrain from using stereo samples.

Filters – Subtractor, Thor, Malström, NN19, NNXT and 
Dr. Rex
D Deactivate filters that are not used.

Observe that if the Cutoff is all the way up or the envelope is set to open the filter 
fully, then the filter doesn’t affect the sound. Conserve processing power by dis-
abling the filter altogether.

D Where applicable, use the 12dB lowpass filter instead of the 24dB low-
pass filter. 
See if you can get the same sonic result by using the 12dB filter, since it uses up 
less processing power.

Polyphonic Devices – Subtractor, Thor, Malström, 
NN19, NNXT, Dr. Rex and Redrum
D Try making the device play fewer voices.

This can be done for example by lowering the release and setting the Polyphony 
setting to exactly the maximum number of notes played simultaneously by this de-
vice.

✪ Please note that just lowering the polyphony setting has no effect. Un-
used voices do not consume processing power.

D Where applicable, try the Low Bandwidth (Low BW) setting.
This will remove some high frequency content from the sound of this particular de-
vice, but often this is not noticeable (this is especially true for bass sounds).

Subtractor
D Try avoiding using Oscillator 2 altogether.

If you can create the sound you need with only one oscillator, this saves consider-
able amounts of processing power.

D Do not use the oscillator Phase mode if you don’t need it.
In other words, set the Oscillator Mode switches to “o”, not “*” or “–”.

D Do no activate Noise unless required.

D Do not activate Filter 2 unless required.

D Do not use FM unless required.
In other words, set the oscillator FM knob to “0” and make sure no modulation 
source is routed to FM.

Thor
D In general, unload any filters or oscillators that aren’t used.

Malström
D If it isn’t necessary, refrain from using Osc B at all.

If you can produce the desired sound by using Osc A only, this will save a lot of 
processing power.

D If one or both Oscillators are routed to one Filter only, and/or the Spread 
parameter is set to “0”, only connect one of the outputs (the one to which 
the filter is connected) to the mixer, and leave the other one uncon-
nected.

D Try to see if you can achieve the desired effect by using only one of the 
filters, and without using the shaper.
Using both of the filters and the shaper in conjunction requires considerably more 
processing power than using just one of the filters and/or the shaper.
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Redrum
D Do not use the Tone feature available on channels 1, 2 and 9.
In other words, make sure the Tone controls and their accompanying Vel knobs are 
set to “0” (“twelve o’ clock”).

Mixer devices
D Avoid using stereo inputs when not required.

For example, if your sampler or Dr. Rex player is playing mono material, only con-
nect it to the Left input on a mixer channel. Leave the Right input unconnected.

D Do not activate EQ (Mixer 14:2 only) unless required.
If a channel doesn’t make use of EQ, make sure it’s EQ button is deactivated.

Distortion
D The D-11 Foldback Distortion will use up less CPU power than the 

Scream 4 Distortion device.

Reverb
D The RV-7 uses much less power than the RV7000.

For some applications the RV-7 might do just fine, and will use up much less 
power.

D If you are running out of processing power, try the Low Density algorithm 
for the RV-7.
This uses up much less power than other algorithms.

Send Effects
D When you are using mono effects as send effects, you can connect the 

effect returns in mono as well (disconnect the cable to Aux Return Right 
on the Mixer).
This is true for the following effects:

• D-11 Distortion.
• Scream 4 Distortion
• ECF-42 Envelope Controlled Filter.
• COMP-01 Compressor.
• PEQ-2 Parametric EQ.
• DDL-1 Delay (provided the Pan parameter is set to center position).
• MClass effects; Equalizer, Compressor, Maximizer.

Songs and Memory 
Requirements
Songs not only use up system resources in terms of processing power, they also re-
quire RAM (memory) to load at all.

The amount of RAM required for loading a song, is directly proportional to the amount 
of samples used in the song. For example, a song only using Subtractors and effects 
requires very little RAM.

If you are running out of RAM try the following:

D Close other song documents.
All open songs compete for RAM.

D Terminate other applications.
All running applications compete for the RAM available in the computer.

D Use mono samples instead of stereo.
Mono samples require half the amount of RAM.

D Try sample rate converting sample files to a lower sample rate.
Note that this will affect sound quality negatively. Also note that it will require an 
external sample editor with good sample rate conversion facilities.
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Overview
The transport panel has standard controls for the sequencer transport, but also features controls for setting tempo, metronome click, locator points etc. The main controls in 
the central area of the transport panel are as follows:

Main Transport Controls
The main transport controls function just like standard controls on tape recorders etc. There are also fixed computer keyboard combinations for the most important transport 
functions:

You can also use the following transport related key commands:

|Function |Key command |Comments
Stop [0] on the numeric keypad or [Return] The nu-

meric keypad [,] (comma) key sets the position 
to the start of the song.

Pressing Stop during playback stops the sequencer. Pressing stop again, sets the position to the last 
playback start position. Pressing stop a third time sets the position to the start of Bar 1. The Stop button 
also sends out a “Reset” message, in case of stuck notes or other related problems.

Play [Enter] on the numeric keypad Starts playback of the sequencer.

Rewind [7] on the numeric keypad Clicking once moves the position backward one Bar. If you press and hold this button on the transport 
(not using key command) it will start scrolling faster after about 2 seconds. 

Fast Forward [8] on the numeric keypad Clicking once moves the position forward one Bar. If you press and hold this button on the transport (not 
using key command) it will start scrolling faster after about 2 seconds.

Record [*] on the numeric keypad, or 
[Command]/[Ctrl]-[Return]

Starts recording if clicked (regardless of transport mode). If activated from stop mode, recording will start 
immediately, if activated during playback it will “punch in”.

|Function |Key command |Comments
Toggle Stop/Play Space bar Switches between stop and play mode.

Go to Left Locator (Loop Start) [1] on the numeric keypad Sets the position to the left locator. There is also a dedicated button for this function - clicking the “L” but-
ton (beside the left locator position display) will set the position to the left locator.

Go to Right Locator (Loop End) [2] on the numeric keypad Sets the position to the right locator. to the left locator. There is also a dedicated button for this function - 
clicking the “R” button (beside the right locator position display) will set the position to the right locator.

Stop
Play

Rewind
Fast Forward

Song Position

Loop on/off

Left and Right Locator positions

Record

Time Signature

Tempo
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Tempo and Time Signature

The tempo and time signature settings can be adjusted on the transport panel. The 
left tempo value sets the tempo in bpm, and the tempo field to the right allows you to 
fine tune the tempo, in steps of 1/1000 bpm.

D You can specify any tempo between 1 and 999.999 bpm (beats per 
minute).

D You can also adjust the tempo (in bpm steps) by using the [+] and [–] 
keys on the numeric keypad.

D You set the time signature by clicking on one of the two values and using 
the spin control or by clicking on the value and moving the mouse up or 
down.
The first value represents the numerator (the number of beats per bar), and the 
second value the denominator (the length of a beat). You can also double-click the 
time signature to open a text box where you can type in a (valid) time signature.

! You can also use the Transport track for controlling the tempo and time 
signature - see page 94 for details.

Song Position

The song position is shown in Bars, Beats, 16th notes and Ticks and in Hours/Min-
utes/Seconds/Milliseconds (in that order) in the fields to the left of the main transport 
controls. You can set the positions by clicking on a value and using the spin controls, 
or by clicking on the value and moving the mouse up or down.

f you just use the spin controls (no value selected), you will move the position in bars 
or seconds, respectively.

D You can also set the position by double clicking on a position value box, 
typing in a new position and pressing [Return].

D About Ticks:

The Tick resolution “shown” is 960 PPQ (Pulses per Quarter note). There are 240 
ticks per 1/16 note, which allows for very accurate positioning. But when you record 
notes, the internal resolution is even higher which means that values can be fractions 
of a tick (subticks). This is indicated by an asterisk after the tick value.

To round off the value to the nearest tick, [Command]-click (Mac)/[Ctrl]-click (Win-
dows) on the asterisk.

Left and Right Locator Positions

The left and right locators are used for several things, like setting the boundaries of a 
loop or inserting/removing bars. You can set the positions for locators by clicking on 
a value and using the spin controls on the transport panel or by double clicking and 
typing a position value.

D There are also two buttons to the right of the locator displays named “L” 
& ”R”. 
Clicking either of these buttons will directly set the song position to the Left or 
Right locator, respectively. (You can also press [1] or [2] on the numeric keypad to 
set the position to the left or right locator)

Loop On/Off

In loop mode, the sequencer will repeat a section over and over again, during play-
back or recording. You specify the section to be looped by setting the left and right lo-
cator. You can also toggle loop on or off by pressing the [/] key on the numeric 
keypad.

New Dub/New Alt buttons

D Pressing the New Dub button will add a new note lane to the selected 
track, but the previous note lane will not be muted. 
This allows you to overdub new notes while listening to the previous recording. 
You can activate New Dub during recording - the new note lane will get MIDI input 
directly.

D You press the New Alt button to record a new alternative take. A new 
note lane is created, and the previous note lane will be muted. 
You can activate New Alt during recording - the new note lane will get MIDI input 
directly. This way you can quickly record a series of takes, and later decide which 
take is best (or edit together a mixture of different takes).

D Note that if Loop is activated and the song position is inside the loop 
boundaries, the clip(s) inside the left and right locators will be muted in-
stead of the whole note lane when using New Alt.
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Additional Transport Panel Items

Click

When this is activated, you will hear a click on each beat, with an accent on the down-
beat of each bar. The click is played back during recording and playback. You can ad-
just the volume of the click by using the Level knob.

Pre (pre-count)

If the “Pre” button is activated, a one bar metronome count-in will sound before actual 
recording starts when clicking the Rec button.

Quantize Notes During Recording

If the Quantize Notes During Recording switch is activated on the Transport, notes 
will automatically be quantized when you record them. 

Record Automation as Performance Controllers

If you want to record parameter automation in the same way as for performance con-
trollers (pitch bend mod wheel etc.) - i.e. into the note clip and not into separate auto-
mation lanes, you can activate this. This way you can later move the clip and all related 
parameter automation will be included. See Sequencer chapter in the Operation Man-
ual for more information.

Automation Override

Automation override is activated when you manually “grab” a parameter that is being 
automated. If you change the setting of an automated parameter, the “Punched In” in-
dicator lights up, and the automation data is temporarily overridden, until you either 
click the “Reset” button or press stop on the transport. As soon as you click Reset, 
the automation regains control.

See page 67.

Audio Out Clipping Indicator

All signals that are being fed into the Hardware Interface (to your audio hardware’s 
physical outputs) are monitored for clipping (signal overload) at the output stage. 
If clipping occurs this indicator will light up, and stay lit for several seconds. If this hap-
pens, you should reduce the output level, in one of the following ways:

D If the signals are being sent to your Hardware Interface via a mixer de-
vice, you should reduce the master output level from the mixer.
This will ensure that the relative levels of the mix are kept intact. Alternatively, if the 
current mix doesn’t represent a “final balance”, and the clipping seems to be 
caused by individual channels in the mixer, you could also try reducing the output 
of the connected device(s), or pulling down the channel faders a bit for the “of-
fending” channels.

! Clipping can only occur in the output stage of the Hardware Interface, 
not in the Reason mixer or in any other Reason device. However, it is 
good practice to keep all mixer channel and master levels as high as pos-
sible within the normal range, for best results. For example, having to 
compensate channel levels by drastically reducing the Master output to 
avoid clipping is indicative of the mixer channel levels being set too high.

✪ If you connect an MClass Maximizer effect (or an MClass Mastering 
Suite Combi) between the final mixed output and the hardware interface, 
you can maximize the loudness of your mix without risking hard clipping 
distortion. See “The MClass effects” for details.

D If the Audio Out Clipping indicator lights up, and the signals are being 
sent directly (not via a Mixer) to your Hardware Interface, you can check 
the meters in the Hardware Interface. If the red segment of any of these 
meters are momentarily lit, this indicates at which output(s) the clipping 
is occurring.
Reduce the output level of all devices connected to outputs whose meters show 
red.

DSP Meter

This bar graph shows the current DSP (processor) load. Note that this measures how 
much of the total processor power the Reason “audio engine” currently is using up. 
Graphics, MIDI and the “rest” of the Reason program is allotted the DSP power not 
used by the audio engine, so audio always has priority. 

ReGroove Mixer button

This opens the ReGroove mixer where you can apply advanced groove editing to af-
fect the timing of notes. How to use the ReGroove mixer is described in the chapter of 
the same name in the Operation Manual.
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Introduction

The Hardware device is where you connect Reason with the “outside world”. This is 
where MIDI is received, and where audio signals are routed to ReWire channels or to 
the physical outputs of your audio hardware. The Hardware device is always present 
at the top of the rack, and cannot be deleted. This chapter is meant to serve as a 
panel reference, describing the various sections of the device. How to set up your 
MIDI interface and audio hardware is described in the “Audio basics” chapter. 

The Hardware device is normally folded, showing a blank panel. By unfolding it, the 
Audio Out panel is displayed, with 32 outputs available. 

• By clicking the “More Audio” button on this panel, two Audio Out panels are 
shown for a total of 64 outputs.

• By clicking the “Adv. MIDI Device” button on this panel, The MIDI In Device is 
shown.

MIDI In Device
This is opened by clicking the “Adv. MIDI Device” button on the Hardware device 
panel. The MIDI In device is only used if you are controlling Reason from an external 
sequencer, using the External Control Bus inputs. Normally, you send MIDI to a track 
via the sequencer, by selecting the sequencer track.

You can select MIDI ports for up to four External Control Busses (on the Prefer-
ences:Advanced MIDI page). Each bus can carry 16 MIDI channels, for a total of up to 
64 MIDI input channels. The MIDI In device is where you route each MIDI channel to 
a device in the Reason rack:

1. Select one of the External Control Busses by clicking the corresponding Bus 
Select button at the top of the MIDI In device.

2. Pull down the device pop-up menu for a MIDI channel and select a device.
The menu lists all devices in the current song.

Now, incoming MIDI data on the selected bus and MIDI channel is sent directly to the 
selected device, bypassing the Reason sequencer. The name of the device is shown 
in the name field for that MIDI channel.

3. Try sending MIDI notes from the external sequencer, on the selected bus and 
MIDI channel.
The indicator below the channel's name field should light up.

Audio Out
Reason supports up to 64 audio output channels. These are divided into two panels, 
each with 32 outputs. To see the outputs 33 to 64, click the “More Audio” button

D Each output features a meter and a indicator which will be lit green for 
each available channel that is currently in use, i.e. has a channel con-
nected to it on the back panel.
Unavailable outputs have unlit indicators.

D If you have outputs on your audio interface that are currently available 
but not used, the indicators will be yellow for the corresponding chan-
nels.

In this case, four outputs are currently used (green indicators) and four more outputs are available, 
which is indicated by yellow indicators.

D Channels connected to unavailable outputs will have red indicators.

! Remember that the Hardware Interface is where any possible audio clip-
ping will occur in Reason. Keep an eye on the clipping indicator on the 
transport panel, and also on the individual meters in the Audio Out 
panel. If a channel pushes the meter into the red, the output level of the 
device should be reduced.

Using ReWire
If you are running Reason together with a ReWire compatible host application, you 
can route any Reason device output to a ReWire channel by connecting the device to 
any of the audio inputs at the back of the Hardware Interface. In ReWire mode, all 64 
channels are available and any device output routed to a ReWire channel will appear 
in the ReWire host application on it’s own channel. See page 124.
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Introduction

The Combinator is special device that allows you to save and recall any combination 
of Reason devices (instruments, effects, mixers etc.) and their internal connections. A 
saved Combinator setup can be loaded as a patch, called a “Combi”. The Combinator 
device itself acts as a container for the devices in a Combi. 

The basic idea behind the Combinator device is simple, but very powerful. Being able 
to save multiple devices as a Combi enables you to instantly recall any type of setup, 
however complex, as simply as loading a patch!

Some typical applications of the Combinator:

D Create split or layered multi-instruments.
Add any number of instrument devices (Subtractors, NN-XT’s etc.) and play them 
as a single layered instrument. Instrument devices in a Combi can also be as-
signed to specific keyboard/velocity zones.

D Save instrument/effect combinations.
Save an instrument together with your favorite effect(s).

D Create multi-effect devices.
You can create and save complex effect chains as Combis. 

About the Combi patch format

The Combinator saves files in the Combi (.cmb) patch format. When you load a ready-
made Combi patch, all devices included in the Combi, their corresponding parameter 
settings and audio and CV connections are instantly recalled.

The Factory Soundbank includes many preset Combinator patches, divided into vari-
ous categories.

There are two basic types of Combi patches; instrument and effect combis. 

D Instrument Combis contain instrument devices and generate sound.

D Effect Combis contain effect devices and are used to process sound.
The MClass Mastering Suite Combi (selectable from the Create menu) is an exam-
ple of an effect Combi.

Creating Combinator 
devices
Creating an empty Combinator device

D Add a Combinator from the Devices tab in the Tool window.
To see the Combinator device icons, the “More” checkbox must be ticked.

D Select “Combinator” from the Create menu.
This will create an empty Combinator. Empty Combinator devices can be used as 
a starting point when creating new Combi patches. It also allows you to browse for 
existing Combi patches.

Creating a Combinator by combining devices

You can create a Combinator device by combining existing devices:

1. Select two or more devices using [Shift].
The devices do not have to be adjacent in the rack.

2. Select “Combine” from the Edit menu.

This creates a Combinator device containing the devices that were selected accord-
ing to the following rules:

D A sequencer track is created for the Combinator, just as when creating 
instrument or pattern devices.

D The new Combinator device appears at the position below the selected 
device that is farthest down in the rack.

D The selected devices are moved to be contained within the Combinator’s 
“holder”.
Their internal order is not changed. Reason attempts to autoroute the first “input 
device” and first “output device” to the Combi To/From Devices connectors - see 
“About internal and external connections”. Other connections are unchanged.

D Devices outside the Combi remain in the same order as before.

! Please see “Adding devices to a Combi” for details about auto-routing.

Creating a Combinator by browsing patches

You can use “Create Instrument” or “Create Effect” to create a Combinator device 
(just as you can any device). If you select a .cmb patch a Combinator will be created 
containing all devices and settings saved in the Combi.
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Combinator elements
In the picture below an unfolded Combinator device is shown. 

The front of the Combinator consists of the following elements (from the top down):

D The narrow panel at the top is always shown, even when the whole Com-
binator is folded. 
It contains a display which (amongst other things) shows the name of the currently 
loaded Combi, and standard Select/Browse/Save patch buttons.

D Next is the Controller panel, which is always shown if the Combinator is 
unfolded. 
See “The Controller panel”.

D The Programmer panel contains settings for Key and Velocity Zone map-
ping as well as Modulation Routing settings.
The Programmer can be shown/hidden by clicking the “Show Programmer” button 
on the Controller panel. See “Using the Programmer”.

D At the bottom are the devices included in the Combi.
Devices can be shown or hidden by clicking the “Show Devices” button on the 
Controller panel. The empty space at the bottom is used for adding more devices 
to a Combi by drag and drop. Clicking the empty space so that the red Insertion 
line appears also makes the Combi the target container for new created devices 
(from the Create menu). See “About the Insertion line”.

About internal and external 
connections
Unlike other devices, the Combinator contains both external and internal audio con-
nections.

D External connections are used to connect a Combinator to devices out-
side the Combi.

D Internal connections are how devices within the Combi are connected.

External connections

D The “Combi Output L/R” connectors carry the audio output of the Combi-
nator. 
This output connects with a device outside the Combi, normally a mixer. Internally, 
this output is connected to the “From Devices” connectors. When you create a 
new Combinator this output will be auto-routed to the first available mixer input 
channel.

D The “Combi Input L/R” connectors is the input to the Combinator (used 
for effect Combis only). 
Internally, this input is connected to the “To Devices” connectors.

Internal Connections

D The “From Devices L/R” inputs is where the outputs from devices in the 
Combi are connected.

D The “To Devices L/R” outputs connect to an input on a device in the ef-
fect Combi.

About External Routing
If an individual device in the Combi is directly connected to a device outside the Com-
binator, this is known as an “External Routing” connection, which should generally be 
avoided. The reason for this is that such connections are not saved with the Combi 
patch.
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D Therefore, all connections to/from a Combi should pass via the To/From 
Device connectors on the Combinator device if you wish to make the 
Combi self-contained.

If a Combi contains external routing connections, this is indicated both on the front 
and back panels of the Combinator; On the front panel “External Routing” is displayed 
in the Patch name display, and on the back panel a LED indicator is lit.

It is still possible to use a Combi with External Routing connections within the context 
of a song (where all routings are saved with the song). Just keep in mind that the ex-
ternal routing connections will not be part of the patch!

How to avoid external routing connections

As explained previously, all connections to/from a Combinator device should pass via 
the To/From Device connectors in order to make the Combi self-contained. Therefore 
you need to include a mixer device for Combis with more than 2 device outputs.

Say you were to combine three instrument devices (each with stereo outputs con-
nected to a mixer) in order to create a layered or split instrument Combi. 

If you simply selected these three instrument devices (but not the mixer) and then se-
lected “Combine”, only one of the devices would be auto-routed to the “From De-
vices” connectors, while the other two devices would have the same connections 
they had before combining.

Therefore:

D When combining several instrument devices, connect them to a mixer 
device and include this mixer in the Combi.
This way, all the instrument device outputs in the Combi can be connected to sep-
arate input channels in the mixer. The mixer device output can then be routed via 
the “From Devices” connectors and thus the Combi will be self-contained.

Instrument devices and effects connected to a Line mixer. within the Combi.

✪ The Line mixer is ideally suited for mixing device outputs in Combis.
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Adding devices to a Combi
About the Insertion line

When the Insertion line is shown, new created devices will be added to the Combina-
tor device. 

D To be able to select the Insertion line you have make sure that the “Show 
Devices” button is lit on the Combinator Controller panel.

D The Insertion line is shown in the empty space at the bottom of the Com-
binator holder (below any devices currently in the Combi).
If the Combi doesn’t contain any devices, the empty space is located just below 
the Controller panel.

Showing the Insertion line

Any of the following methods will select/show the Insertion line:

• By clicking in the empty space at the bottom of the Combinator holder.
• When creating a new Combi, the Insertion line is automatically selected.
• By using the arrow keys you can step through and select each device currently in 

the Combi. By selecting the empty space, the Insertion line appears.
• Selecting “Initialize Patch” for a Combinator will clear all devices and the Insertion 

line appears.

D Note that showing the Insertion line automatically selects the Combina-
tor device. However, selecting the Combinator will not automatically 
show the Insertion line.
The Insertion line remains selected until you select another device (either in the 
Combi or in the rack), or hide the devices.

Creating new devices in a Combi 
To make a Combinator the target device for created devices you have to use one of 
the following methods:

D Showing the Insertion line (see above).
If you create a device with the Insertion line showing, the new device will appear 
below the Insertion line, at the bottom of the Combi holder.

D Selecting a device in the Combi (but not the Combi itself).
When you select a device from the Create menu it will appear below the selected 
device (just like in the rack).

D No sequencer tracks will be automatically created for devices added to a 
Combi. 

About auto-routing

The auto-routing of devices in a Combi is similar to devices in the rack:

D If a device in a Combi is selected, the new created device will appear be-
low the selected device according to standard rules.

• If an effect is selected and you create a new effect device, these will be connected 
serially.

• If an instrument device is selected and you create an effect it will be connected as 
an insert effect to the instrument device. 

• If a mixer is selected and you create an effect it will be connected as a mixer send 
effect.

• If an instrument device is selected and you create another instrument device it will 
be added below the selected device and connected to the first available mixer in-
put channel.

• If you hold down [Shift] and create a new device, no auto-routing will take place.
• If you hold down [Option] (Mac) or [Alt] (Windows) and create a new device, a se-

quencer track will be created for the device.

D If you add a device to an empty Combi, its output will be auto-routed to 
the “From Devices” connectors. For effect devices, the input will also 
auto-route to the “To Devices” connectors.

Adding devices using drag and drop
You can move devices in the rack that are currently outside the Combi into the Com-
binator holder. This works as follows:

1. If you want to add more than one device at the same time, [Shift]-select the 
devices.

2. Click in the “handle” area of a device.
For full width devices, this is the area to the left and right of the panel (between the 
rack fittings); for smaller devices you can click anywhere outside the actual param-
eters.

3. Drag the device(s) into the Combinator.
A thick red vertical line indicates where the device(s) will be positioned. Note that 
the red line can be to the left of a device (indicating that the moved device will be 
inserted before the other device) or to the right of a device (indicating that the 
moved device will be inserted after the other device). You can also add devices to 
the empty space at the bottom of the Combi holder.

D No auto-routing will take place.
The existing connections to the rack will be kept, so there may be external routing 
connections (see “About External Routing”). If there are, “External Routing” will be 
shown the Combinator name display (and on the back of the Combinator a LED in-
dicator will be lit).
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D If you drag devices into the Combi with [Shift] pressed, the devices will 
be disconnected from the rack and auto-routed according to the insert 
position.
The routing between dragged devices will be kept. If it isn’t possible to auto-route 
a dragged device (e.g. if there’s no free mixer inputs in the Combi), the device will 
become unconnected.

D If you drag devices into the Combi with [Option] (Mac) or [Alt] (Windows) 
pressed, the devices will be copied. No auto-routing takes place.
Using [Shift] at the same time will attempt to auto-route according to the same 
rules as described above.

Adding devices using copy/paste
You can copy devices and paste them into a Combi. 

1. Select the devices you wish to copy as usual. 

2. Select “Copy Device” from the Edit (or context) menu.

3. Select a device in the Combi or click the empty space to show the insertion 
line.

4. Select “Paste Device” from the Edit (or context) menu.

D When pasting, the devices will be added below the currently selected de-
vice or the Insertion line in the Combi.
No auto-routing takes place.

D Pressing [Shift] when pasting will attempt to auto-route according to 
standard rules.

Adding a Combi to a Combi
Nested Combis (i.e. a Combi within a Combi) is not supported. If you open the Create 
menu when the Insertion line or a device in a Combi is selected, the Combinator item 
will be grayed out.

You can, however, use drag and drop or copy/paste to add a Combi to another 
Combi. The following then applies:

D The devices in the dragged (or pasted) Combi will be “uncombined” (i.e. 
the Combinator device itself will be removed) and the devices will be 
added below the insert position in the target Combi. 
Existing routing will be unchanged.

D If you press [Shift] when dragging (or pasting) the uncombined devices 
will be auto-routed as if it was a single device.
The “From Devices” Output (and “To Devices” input if applicable) used in the un-
combined Combi will be auto-routed to the target Combi, according to standard 
rules.

Combining two Combis
D The lower Combi will be uncombined and the devices added to the upper 

Combi in the rack when combining.
Existing routing will be unchanged.

Combining devices in a Combi with devices in the 
rack
If you combine some devices in a Combi with devices in the rack, the combined de-
vices are removed from their original locations and added to a new Combi (below the 
“original Combi).

Combi handling
Moving the entire Combi
This works much the same as for other devices in the rack. 

D Select the Combinator by clicking on the holder and drag to a new posi-
tion.
An outline of the Combinator is shown when you drag, and a red line shows the in-
sert position. All connections are kept.

D If you press [Shift] when dragging the Combinator will attempt to auto-
route to the insert position in the rack according to standard rules.
The auto-routing will take into account whether it is an effect Combi or an instru-
ment Combi.

D If you press [Option] (Mac) or [Alt] (Windows) while dragging, a copy of 
the Combi is created.
No Auto-routing takes place. If you press [Option] (Mac) or [Alt] (Windows) + 
[Shift] the copied Combi will be auto-routed according to standard rules.

Moving devices within a Combi
Just as for devices in the rack, an outline of the devices is shown when you drag, and 
a red line shows the insert position. All connections are kept.

D If you press [Shift] when dragging, the device(s) will attempt to auto-
route to the insert position according to standard rules.

Moving devices out of a Combi
If you move devices out of a Combi the following applies:

D The routing is unchanged, and the External Routing indicator is likely to 
light up.
If you press [Shift] when dragging, the device(s) will attempt to auto-route to the 
rack according to standard rules.
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Deleting devices in a Combi
This works exactly as for devices in the rack. Select the device and then either select 
“Delete Device” from the Edit menu, or press [Backspace].

Uncombining devices
You can uncombine a whole Combi or selected devices within a Combi in the follow-
ing way:

D If you select a Combinator and then select “Uncombine” from the Edit 
menu, the Combinator device will be removed, and all devices contained 
in the Combi will be connected as a single device to the rack.
The devices previously connected to the To/From Devices connectors will now be 
connected to the rack in the same way the Combinator device was (via the Com-
binator output and input).

D If you uncombine a few selected devices in a Combi these will be re-
moved from the Combi and added to the rack below the Combi.
Connections are unchanged, so external routing is likely to happen.

Sequencer tracks and 
playing Combis
When you create a Combinator device, a sequencer track is automatically created. 
This track is also given MIDI focus just like standard instrument devices.

D When the Combinator track receives incoming MIDI data, this will be 
routed to all instrument devices in an instrument Combi.
This means that the devices will be layered when you play (taking default velocity 
and key ranges into account). 

D You can turn off Receive Note or selected Performance controller data 
for individual instrument devices in the Programmer panel. 
See “Using the Programmer” for details.

The Controller panel

This is the main Combinator panel. Like standard instrument devices it features Pitch 
and Mod wheels and various controls. 

About the virtual controls

D The four Rotary knobs and buttons in the middle of the Controller panel 
are “virtual” controls that can be assigned to parameters and functions 
in devices contained in the Combi. 
These controls are by default not assigned to any parameters in new Combis. 

• You assign parameters in the Modulation Routing section of the Programmer 
panel (see “Using Modulation Routing”). 

• Movements of the virtual controls can be recorded as automation. 
• Each control can be assigned to any number of parameters.
• Clicking on the label for a Rotary or Button lets you type in an appropriate name for 

it.

The Pitch Bend and Modulation wheels

The Pitch and Mod wheels on the Controller panel will mirror the corresponding ac-
tions on your master keyboard, just like for standard instrument devices. 

D When a Combinator device has MIDI input and the Combi contains sev-
eral instrument devices these will all receive pitch bend and modulation 
data.
This means that the settings in the instrument device determines what happens 
when applying pitch bend or modulation. 

• For example, moving the Mod wheel could apply vibrato for one device and 
change the filter cutoff frequency for another device.

• Pitch Bend will also be applied according to individual settings in the Range field 
for all instrument devices in a Combi.

Run Pattern Devices button

This can be used to start/stop all pattern devices included in the Combi. This works 
exactly as pressing the Run button on the pattern device panel. The on/off status of 
this button is not saved with the Combi patch. Pressing play on the transport panel 
will automatically activate “Run Pattern Devices”.

✪ On the Factory Sound Bank, Combi patches containing pattern devices 
have “(run)” at the end of their patch names.
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Bypass All FX

This button allows you bypass all effect devices in a Combi. It works as follows:

• All insert effect devices in the Combi are switched to Bypass mode.
• All effects connected as send effects to a mixer device are switched off.
• Clicking this button will not affect effect devices that were bypassed or turned off 

already. 

Select backdrop...

This function allows you to change the “skin” of the Controller panel. You can design 
your own labels for the assignable controls, and change the color and look of the 
whole panel. 

D Select the Combinator and choose “Select Backdrop...” from the Edit 
menu.
The Image browser opens, allowing you to select image file in the JPEG (.jpg) for-
mat.

D The dimensions of the image file should be 754 x 138 pixels.

D The knobs, buttons, patch name display and patch buttons cannot be re-
designed.

D If you wish to design your own text labels for the virtual controls, you 
should first remove the original text labels.
Click on a label, remove the current text and press [Enter].

D To remove a Backdrop, select “Remove Backdrop” from the context 
menu.
The original look of the Combinator panel is restored.

About template backdrops

There are template backdrops installed with the program. These have the right dimen-
sions and serve as a good starting point when creating new backdrops. The “Combi 
Backdrops” folder is located in the “Template Documents” folder within Reason’s 
Program folder.

Two templates are available, one in the JPEG format and the other in the Adobe Pho-
toshop format (.psd).

D The .psd (Photoshop) template contains multiple layers, which are useful 
when customizing backdrops.
You have to save any backdrops created in Photoshop as JPEG files before you 
can use them in Reason.

Using the Programmer
The Programmer is used for key mapping and setting velocity ranges for instrument 
devices, and for Modulation Routing; assigning device parameters to the knobs and 
buttons on the Controller panel. 

D To show the Programmer panel, click the “Show Programmer” button on 
the Controller panel.
The Programmer appears below the Controller panel.

D To the left on the Programmer panel the devices in the current Combi are 
listed in the same order they appear in the Combinator holder. 
Clicking on a device in the list selects it for editing.

D The middle Key Mapping section features a keyboard with a horizontal 
scrollbar at the top. In the area below it the key range for each instru-
ment device is shown.

D To the right is the Modulation Routing section where you can assign pa-
rameters to the controls on the Controller panel.
See page 160.

Key Mapping instrument devices
Each instrument device can have its own separate key range, the lowest and the high-
est key that will trigger the device. This allows you to create splits and layers for instru-
ment devices in a Combi. 
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1. Make sure the Combinator track has MIDI focus.

2. Select an instrument device in the Device list to the left (non-instrument de-
vices, e.g. effects and mixers do not have key ranges).
The currently selected device key range is highlighted and shown as a horizontal 
bar under the keyboard display, and as note numbers in the Key Range Hi and Lo 
fields at the bottom of the Programmer panel. By default, the entire range is se-
lected (C -2 to G 8). Only one device at a time can be selected.

There are several ways you can change the current key range:

D By clicking in the Key Range Lo and Hi value fields and moving the 
mouse up or down.

D By moving the handles of the horizontal bar in the middle display. 
You may have to use the scrollbar at the top to “see” the handles.

D By dragging the horizontal bar itself you can also move entire key zones 
horizontally, thereby changing their key ranges.

3. Using either method, set the desired key range for the selected device.
When done, the device will only play back notes in the set key range.

D By setting up key ranges for devices in a Combi, you can create split in-
struments.
For example playing notes below C 2 could trigger a device playing a bass sound, 
whereas playing notes above C 2 could trigger a device playing a pad sound. 

D Instrument devices in a Combi that share the same key range will be lay-
ered - i.e. play at the same time.
This given that no velocity ranges have been set up - see below.

D You can of course set up overlapping ranges where notes within a set 
key range will layer two (or more) devices, but notes above and below 
the set range will play separate devices.

About the Transpose function

The Transpose field in the right bottom corner allows you to transpose the currently 
selected instrument device. It will not shift the key mapping, just the pitch of the se-
lected device. Range is +/- 3 octaves, in semitone steps.

About the keyboard

You can use the keyboard to audition selected instrument devices by pressing [Op-
tion] (Mac) or [Alt] (Windows) and clicking on the keys.

About the Receive Notes/MIDI Performance Controller checkboxes

In the lower left corner of the Programmer there is a Receive Notes field with a corre-
sponding checkbox, and below there are checkboxes for all standard MIDI Perfor-
mance controllers (Pitch Bend/Mod Wheel/Breath/Expression/Sustain Pedal/
Aftertouch). 

D These checkboxes allow you to control whether Note/MIDI Performance 
controller data is to be received for each instrument device in a Combi.

D If you deactivate the “Receive Notes” checkbox the selected device will 
not respond to incoming MIDI note messages. 
If a non-instrument device is selected this checkbox is always deactivated.

D If you deactivate any of the Performance Controllers, the corresponding 
controller(s) will not be received by the selected instrument device.
All are on by default.

Setting Velocity Ranges for instrument devices
When instrument devices are set up so that their key ranges overlap – completely or 
partially – you can use velocity switching to determine which devices should be 
played back depending on how hard or soft you play on your MIDI keyboard.

This is done by setting up velocity ranges.

Each time you press a key on your MIDI keyboard, a velocity value between 1-127 is 
sent to Reason. If you press the key softly, a low velocity value is sent and if you press 
it hard, a high velocity value is sent.

This velocity value determines which devices will be played and which will not.

1. Select an instrument device in the Device list to the left (non-instrument de-
vices, e.g. effects and mixers do not have velocity ranges).
By default, the entire range is selected (0 - 127).

2. Click in the Velocity Range Lo and Hi value fields and move the mouse up or 
down to set a low and high velocity range, respectively.

3. When you have set a range, the device will only be triggered by notes within 
this velocity range.
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About overlapping Velocity Ranges

You can set overlapping velocity ranges. Here’s an example of how this can work:

D Device 1 has a velocity range from 1-60.

D Device 2 has a velocity range of 41-100.

D Device 3 has a velocity range of 81-127.

Now, velocity values between 41 and 60 will trigger notes from both Device 1 and 
Device 2. Likewise, velocity values between 81 and 100 will trigger sounds from De-
vice 2 and Device 3.

About full and partial velocity ranges

You can see which devices have modified velocity ranges in the key map display:

• Devices with a full velocity range (0 - 127) are only shown with an outline.
• Devices with any other velocity range are shown as striped.

The device has a partial velocity range, which is indicated by stripes.

Using Modulation Routing
The Modulation Routing section allows you to assign any parameter or function in de-
vices included in a Combi to any of the virtual Rotary and Button controls on the Con-
troller panel. 

About Rotary and Button controls

The virtual Rotary and controls operate much like the equivalent controls on the real 
devices:

D A Rotary control can either smoothly change parameter values (e.g. a 
level control), or step through fixed values (like the Oscillator waveform 
spin controls on a Subtractor).

D A Button control will switch between two set values like an on/off 
switch.
Worth noting is that there are buttons on several Reason devices that will step 
through a series of values, for example LFO Waveform buttons. If LFO Waveform 
is assigned to one of the virtual Buttons you will only be able to switch between 
two of the six LFO waveforms (which waveforms is determined by the Min/Max 
range).

D The available range for each selected parameter is shown in the Modula-
tion Routing Min/Max fields.
Most sliders and rotary knobs on the actual devices have the standard 0-127 or 
-64 to 63 range. Selectors and spin controls can have any value range.

Assigning parameters to a control

This is done as follows:

1. Select the device you wish to assign parameters for in the device list to the 
left.

The name of the selected device is now shown in the Modulation Routing Device field. 
The Modulation Routing section contains four columns:

D In the Source column, the four Rotary and Button controls are by default 
listed but each field can be changed to any Rotary/Button or Perfor-
mance controller by clicking the arrow and selecting from the pop-up.
The last two fields are unassigned by default.

D The pop-ups in the Target column contain all parameters for the selected 
device.

D Lastly in each Target pop-up list is the option to receive note data or not. 

D The Min/Max columns allow you to specify a value range for the virtual 
control.
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2. Click in the Target column for the Rotary or Button control you wish to assign 
a parameter.
On the pop-up that appears, all the available parameters for the device are listed.

3. Select the parameter you wish to assign to the control.
The parameter is now assigned, and the name of the parameter is shown in the 
Target column for the corresponding control.

4. If you wish the selected device to receive notes this option should be 
checked.

5. If you move or press the assigned Rotary or Button it will now control the pa-
rameter you assigned to it.

6. You can specify a range for the parameter by clicking in the Min and Max col-
umns and moving the mouse up or down.
By default the maximum available range is set.

7. If you select another device in the Device list to the left, you can assign an-
other parameter to the same Rotary or Button control using the same basic 
method.
This means that you can create multi-function controls that operate simultaneously 
on several parameters. E.g. if you have two Subtractors and a Malström in a Combi 
you could create a “master” filter cutoff knob, that controls this parameter for all 
three devices. 

Naming a control

When you make modulation routing assignments, you should give the associated con-
trol a descriptive name that reflects what it does, for example Vibrato On/Off or the 
name of the parameter that it controls.

This is done by clicking the label on the Controller panel and typing in new name.

CV Connections
CV connections between devices in the Combi are saved with the Combi patches. 
This is also true for CV connections between devices in Combi and the Combi itself - 
e.g. if you have connected a Matrix in the Combi to one of the CV inputs on the back 
of the Combi panel.

The following CV connectors can be found at the back of the Combinator:

Sequencer Control Inputs

The Sequencer Control CV and Gate inputs allow you to play the Combinator from 
another CV/Gate device (typically a Matrix or a RPG-8). The signal to the CV input 
controls the note pitch, while the signal to the Gate input delivers note on/off along 
with velocity. 

Modulation Inputs

In this section you will find standard CV Mod Wheel and Pitch Bend modulation in-
puts, as well as modulation inputs for the four Rotary controls. 

! Parameter(s) that are assigned to a Rotary control can thus be modu-
lated by CV, which allows you to use CV control for almost any Reason 
parameter!
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Introduction

The Mixer 14:2 allows you to control the level, stereo placement (Pan), tone (EQ) and 
effect mix (AUX Sends) of each connected audio device.

If you have ever used a conventional hardware audio mixer, you will most likely find the 
Mixer very straightforward to use. It is configured with 14 (stereo) input channels, 
which are combined and routed to the Left and Right Master outputs. The vertical 
channel “strips” are identical and contain - from the top down - four Auxiliary Sends, 
an EQ section, Mute and Solo buttons, Pan control, and a Level fader.

Every mixer parameter can of course be automated, and should the need arise for 
more mixer channels, you can simply create another mixer! 

! Note that if you haven’t created a mixer prior to creating an audio device, 
the audio device output will be auto-routed to your audio hardware out-
puts via the Reason Hardware Interface (Audio Out device). 

The Channel Strip

Each channel strip in the Mixer 14:2 contains the items listed on the next page:

AUX Sends 1-4

EQ Treble and Bass controls

EQ On/Off button

Mute (M) and Solo (S) buttons

Pan control

Channel fader

Channel meter

Channel label

Pre-fader switch for AUX Send 4
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Channel Strip Controls:

|Item |Description |Value Range
Channel Fader The channel fader is used to control the output level of each corresponding channel. 

By adjusting the faders, you can set the desired mix (balance) between different devices connected to the Mixer. 
0 - 127 

Channel Label Each channel in the mixer that has a device connected to it, displays a read-only label with the name of the device to the 
left of the fader.

N/A

Channel Meter The meter is a graphical representation of the channel output level. If the signal level pushes the meter into the range of 
the red area, try lowering either the output level of the device connected to the channel, or the channel fader itself, to 
avoid distortion.

N/A

Pan Control Use this control to set the left/right position of the channel in the stereo field. [Command]/[Ctrl]-click the Pan knob to set 
Pan to the default “0” (center position).

-64 – 0 – 63

Mute (M) and 
Solo (S) Buttons

Clicking a channel’s Mute button silences the output of that channel. Click the button again to unmute the channel.
Clicking a channel’s Solo button silences all other mixer channels, so that you only hear the soloed channel. Several 
channels can be soloed at the same time, but if this is the case, note that soloed channels can’t be muted with the Mute 
button. To mute one of several channels in solo mode you simply “unsolo” it.

On/Off

EQ Treble and Bass 
controls

The EQ Treble and Bass controls is used to cut or boost the higher and lower frequencies of the signal, respectively. 
Click on the EQ button to activate the EQ.
If you need more advanced EQ, you can always use a PEQ2 parametric EQ as an insert effect for a device.
Note also the two EQ modes - see page 166.

Treble: +/- 24 dB at 12 kHz.
Bass: +/- 24 dB at 80 Hz.

Auxiliary (AUX) Effect 
Send 1-4

The four independent AUX Sends control the amount of channel signal that is to be sent to other devices - typically effect 
processors. The effect output is then normally returned to the Mixer via the AUX Return inputs (see page 166) where it is 
mixed with the dry (non-processed) signal. If you create an effect device when the Mixer is selected, the effect is auto-
routed to the first available Send/Return connectors. You can then control the amount of effect that is to be applied to 
any device connected to a Mixer channel via the corresponding AUX Send knob. The AUX Send outputs are taken post 
channel fader, but you have the option of selecting Pre-fader mode for AUX Send 4 (by clicking the “P” button next to the 
send so that it lights up). In that mode, the send level is independent of the channel fader.
The sends are in stereo but can be used in mono as well. 

0 - 127
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The Mixer signal flow
The basic signal flow for a channel in the Mixer is as follows:

Note that the Solo function is true “in-place” solo, meaning that if the channel uses 
Auxiliary sends routed to effect devices, the soloed output signal will also include the 
soloed channel(s) including any Aux Send effects. 

Note also that if the pre-fader send mode is activated for Aux 4 the send is tapped af-
ter the EQ and Pan controls but before the channel fader.

About the EQ modes

With Reason 2.5, the EQ modules in the Mixer were improved to get an even better 
sound and character. However, if you want to play back songs made in previous Rea-
son versions, you may want to use the “old” EQ mode to ensure that the songs sound 
exactly the same.

On the back of the Mixer you will find a switch for this - select “Improved EQ” for the 
new EQ types or “Compatible EQ” for the old-style EQ. The parameters are exactly 
the same in both cases.

The Auxiliary Return Section

The Auxiliary Returns provide an “extra” four stereo inputs in addition to the Mixer’s 14 
stereo channels. The main function of Return channels is to provide inputs for con-
nected Send effects devices. Each Aux Return channel has a level control, and a 
read-only tape label that display the name of the device connected to the Return 
channel.

The Master Fader

The Master L/R fader controls the summed output level of all channels in the Mixer. 
Use this to change the relative level of all channels, to make fade-outs etc.

FaderEQ Mute AUX Sends

Solo Master L/R Output

Effects DevicesAUX Returns 

Input

Aux 4 pre-fader 
mode

Pan
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Connections
All input and output connectors are as usual located on the back panel of the Mixer 
14:2. Special connectors are used for “chaining” two or more Mixers together. This is 
described on page 168.

Mixer Channel Connections

D Each mixer channel features stereo left/right inputs for connecting audio 
devices. 
Use the left input when manually connecting a mono signal source.

D In addition, there are two Control Voltage (CV) inputs (with associated 
voltage trim pots), for voltage controlling channel Level and Pan from 
other devices.

Auxiliary (AUX) Send Out

D There are four stereo Send Out connectors, which normally are used to 
connect to the inputs of effect devices.
To connect a send to a mono-input device, use the Left (Mono) output.

When a Send is connected to an effects device, the corresponding AUX Send knob 
determines the level of the signal sent to the effect device for each channel. The Send 
Output is taken post-channel fader but you have the option of selecting pre-fader 
mode for AUX Send 4. 

D Note that some effects (for example the Comp-01 compressor or the 
PEQ2 parametric EQ) are effect types which are not designed to be used 
as AUX Send effects, but rather as insert effects, where the whole signal 
is passed through the effect. 
Alternatively, you could use AUX Send 4 in pre-fader mode and lower the channel 
fader completely.

Auxiliary (AUX) Returns

D There are four stereo Return input connectors.
These are normally connected to the left and right outputs of effect devices. 

Master Left/Right Outputs

D The Master outputs are auto-routed to the first available input pair on 
the Audio Hardware interface. 
This in turn sends the audio to the outputs of your audio hardware.

✪ Note that the Master outputs don’t have to be routed directly to the Au-
dio Hardware Interface. You could for example route the Master outputs 
to an effect, and then route the effect outputs to the Hardware Interface 
instead.

D In addition, there is a Control Voltage (CV) input (and an associated trim 
pot), for voltage controlling the Master Level from another device.
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Chaining Mixers

Two chained Mixers are connected like this, the top Mixer being the “Master” Mixer.

If you need more Mixer channels, you can simply create a new Mixer. If you do this, the 
Mixers are automatically connected via the “Chaining Master” and “Chaining Aux” 
connectors.

D The newly created Mixer’s Master Output is connected to the original 
Mixer’s Chaining Master input.
The Master Out Level for the new Mixer is now controllable from the original 
Mixer’s Master fader - so that this fader now controls the Master output level of 
both mixers.

D The newly created Mixer’s four stereo Aux Send outputs is connected to 
the original Mixer’s Chaining Aux connectors.
The new Mixer will now have access to any Aux Send effects connected to the 
original Mixer, via the same corresponding Aux Send(s).

This way, the two Mixers operate as “one”. 

! One exception is the Mute/Solo function, which is not chained. Thus, so-
loing a channel in one of the Mixers, will not mute the channels in the 
other Mixer.

You can create as many Mixers as you like, they will be chained in the same way, with 
one Mixer remaining the “master” (i.e. it controls the Master level of all chained Mixers 
and supplies the Aux Send effect sources).

Partially or Non-Chained Mixers

You can also have several Mixers that are only partially or not chained at all. 

D You may for example wish to have different Aux Send effects for one 
Mixer. 
Then simply disconnect one or more of the Send Out to Chaining Aux connectors, 
and assign new Send effects.

D You could for example send the Master output of one Mixer to another 
Input pair on the Audio In Hardware interface, instead of the Chaining 
Master inputs.
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Introduction

The Line Mixer 6:2 allows you to control the level, stereo placement (Pan) and effect 
mix (AUX Send) of each connected audio device.

The Line Mixer is configured with 6 (stereo) input channels, which are combined and 
routed to the Left and Right Master outputs. 

Channel parameters
The channels are identical and contain an Auxiliary Send, Mute and Solo buttons, a 

Pan control, and a Level control:

The Auxiliary Return Section
The AUX Return channels provide inputs for a connected send effect device. The Aux 
Return channels have a single level control on the front panel. 

Master level
The Master L/R fader controls the summed output level of all channels in the Mixer. 
Use this to change the relative level of all channels, to make fade-outs etc.

|Item |Description
Level control This controls the output level of each corresponding channel, 

allowing you to set the desired mix (balance) between different 
devices connected to the Line Mixer. 

Channel label Each channel in the mixer that has a device connected to it, dis-
plays a read-only label with the name of the device.

Channel meter The meter is a graphical representation of the channel output 
level. If the signal level pushes the meter into the range of the 
red area, try lowering either the output level of the device con-
nected to the channel, or the Level control itself, to avoid distor-
tion.

Pan control Use this control to set the left/right position of the channel in 
the stereo field. [Command]/[Ctrl]-click the Pan knob to set Pan 
to the default “0” (center position).

Mute (M) and 
Solo (S) Buttons

Clicking a channel’s Mute button silences the output of that 
channel. Click the button again to unmute the channel.
Clicking a channel’s Solo button silences all other mixer chan-
nels, so that you only hear the soloed channel. Several channels 
can be soloed at the same time. If this is the case, note that so-
loed channels can’t be muted with the Mute button. To mute 
one of several channels in solo mode you simply “unsolo” it.

Auxiliary (AUX) 
Effect Send

The AUX Send controls the amount of channel signal that is to 
be sent to other devices - typically effect processors. The effect 
output is then normally returned to the Mixer via the AUX Return 
input where it is mixed with the dry (non-processed) signal. If 
you create an effect device when the Mixer is selected, the ef-
fect is auto-routed to the Send/Return connectors. You can 
then control the amount of effect that is to be applied to any de-
vice connected to a Line Mixer channel via the AUX Send knob. 
The Send can be taken pre or post channel level - see page 
171.

|Item |Description
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Connections
All input and output connectors are as usual located on the back panel of the Line 
Mixer.

Mixer Channel Connections

D Each mixer channel features stereo left/right inputs for connecting audio 
devices. 
Use the left input when manually connecting a mono signal source.

D In addition, there is a Control Voltage (CV) input, for voltage controlling 
channel Pan from other devices.

Auxiliary (AUX) Send

D The Send connectors are used to connect to the inputs of effect devices.
To connect the send to a mono-input device, use the Left (Mono) output.

When a Send is connected to an effects device, the corresponding AUX Send knob 
determines the level of the signal sent to the effect device for each channel. 

The Send Output can be taken Pre or Post channel level by using the switch to the 
left of the Send connectors. 

Auxiliary (AUX) Return

These are normally connected to the left and right outputs of effect devices. 

Master Left/Right Outputs

D The Master outputs are auto-routed to the first available input pair on 
the Audio Hardware interface, or another mixer. 
If used in a Combi, the Master Outs are normally connected to the “From Devices” 
connectors on the Combinator.
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Introduction

At first glance, Redrum looks styled after pattern-based drum machines, like the leg-
endary Roland 808/909 units. Indeed, it does have a row of 16 step buttons that are 
used for step programming patterns, just like the aforementioned classics. There are 
significant differences, however. Redrum features ten drum “channels” that can each 
be loaded with an audio file, allowing for completely open-ended sound possibilities. 
Don’t like the snare - just change it. Complete drum kits can be saved as Redrum 
Patches, allowing you to mix and match drum sounds and make up custom kits with 
ease.

About File Formats
Redrum reads two basic types of files:

Redrum Patches

A Redrum patch (Windows extension “.drp”) contains all settings for all ten drum 
sound channels, including file references to the used drum samples (but not the ac-
tual drum samples themselves). Switching patches is the same as selecting a new 
drum kit.

Drum Samples

Redrum can read and play back sample files of the following formats:

• Wave (.wav)
• AIFF (.aif)
• SoundFonts (.sf2)
• REX file slices (.rex2, .rex, .rcy)
• Any bit depth
• Any sample rate
• Stereo or Mono

Wave and AIFF are the standard audio file formats for the PC and Mac platforms, re-
spectively. Any audio or sample editor, regardless of platform, can read and create au-
dio files in at least one of these formats, and some of them in both formats.

SoundFonts are an open standard for wavetable synthesized audio, developed by E-
mu systems and Creative Technologies.

SoundFont banks store wavetable synthesized sounds, allowing users to create and 
edit multi-sampled sounds in special Soundfont editing programs. The sounds can 
then be played back in wavetable synthesizers, typically on audio cards. The samples 
in a SoundFont are stored hierarchically in different categories: User Samples, Instru-
ments, Presets etc. The Redrum allows you to browse and load single SoundFont 
samples, not entire soundfonts.

REX files are files created in ReCycle – a program designed for working with sampled 
loops. It works by “slicing” up a loop and making separate samples of each beat, 
which makes it possible to change the tempo of loops without affecting the pitch and 
to edit the loop as if it was built up of individual sounds. The Redrum lets you browse 
REX files and load separate slices from it as individual samples.
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Using Patches
When you create a new Redrum device it is empty. Before it can play back any audio 
you must first load a Redrum patch (or create one from scratch, by loading individual 
drum samples). A Redrum patch contains settings for the ten drum sound channels, 
complete with file references to the drum samples used.

! Redrum patterns are not part of the patch! If you want to save Redrum 
patches complete with patterns, create a Combinator containing the Re-
drum and save the Combi patch.

Loading a Patch
To load a patch, use one of the following methods:

D Use the browser to locate and open the desired patch.
To open the browser, select “Browse Redrum Patches” from the Edit menu or de-
vice context menu, or click the folder button in the patch section on the device 
panel.

D Once you have selected a patch, you can step between all the patches in 
the same folder by using the arrow buttons next to the patch name dis-
play.

D If you click on the patch name display on the device panel, a pop-up 
menu will appear, listing all patches in the current folder.
This allows you to quickly select another patch in the same folder, without having 
to step through each one in turn.

Checking the Sounds in a Patch
There are two ways you can listen to the sounds in a patch without programming a 
pattern:

D By clicking the Trigger (arrow) button at the top of each drum sound 
channel.

D By playing the keys C1 to A1 on your MIDI keyboard.
C1 plays drum sound channel 1 and so on. See also page 183.

Both these methods play back the drum sample for the corresponding drum sound 
channel, with all settings for the sound applied.

Creating a new Patch
To create a patch of your own (or modify an existing patch), you use the following ba-
sic steps:

1. Click the folder button for a drum sound channel.
The Redrum sample browser opens.

2. Locate and open a drum sample.
You will find a large number of drum samples in the Factory Sound Bank (in the 
folder Redrum Drum Kits/xclusive drums-sorted). You can also use any AIFF, 
Wave, SoundFont sample or REX file slice for this.

3. Make the desired settings for the drum sound channel.
The parameters are described on page 180.

4. Repeat steps 1 and 3 for the other drum sound channels.

5. When you’re satisfied with the drum kit, you can save the patch by clicking 
the Floppy Disk button in the patch section on the device panel.
Note however, that you don’t necessarily need to save the patch - all settings are 
included when you save the song.

Loading REX file slices

Loading slices from within a REX file is done much in the same way as loading “regu-
lar” samples:

1. Open the sample browser as described above.

2. Browse to a REX file.
Possible extensions are “.rex2”, “.rex” and “.rcy”.

3. Select the file and click “Open”.
The browser will now display a list of all the separate slices within the REX file.

4. Select the desired slice and click open.
The slice is loaded into the Redrum.

Creating an Empty Patch
To “initialize” the settings in the Redrum, select “Initialize Patch” from the Edit menu or 
the device context menu. This removes all samples for all drum sound channels, and 
sets all parameters to their default values.
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Programming Patterns
Pattern Basics
Redrum contains a built-in pattern sequencer. Unlike the main sequencer in Reason, 
the Redrum sequencer repeatedly plays back a pattern of a specified length. The typ-
ical analogy in the “real world” is a drum machine which plays drum patterns, usually 
one or two bars in length.

Having the same pattern repeat throughout a whole song may be fine in some cases, 
but most often you want some variations. The solution is to create several different 
patterns and program pattern changes (automatic switching from one pattern to an-
other) at the desired positions in the song.

How the Redrum pattern sequencer integrates with the main 
Sequencer

The built-in pattern sequencer in the Redrum interacts with the main Reason se-
quencer in the following ways:

D The tempo set on the transport panel is used for all playback.
If the Tempo track (see page 94) is used, Redrum will follow this.

D If you start playback for the main sequencer (on the transport panel), the 
Redrum will automatically start as well (provided the pattern sequencer 
hasn’t been disabled - see below).

D You can mute and solo Redrum tracks in the sequencer.
If the Redrum has a track in the sequencer and you mute this track, Redrum will 
automatically be muted as well. This is indicated by a Mute indicator on the device 
panel. If there are several note lanes on the Redrum track, their respective mute 
status will not be indicated on the device panel.

This Redrum device is muted.

D You can also run Redrum separately (without starting the main se-
quencer) by clicking the Run button on the device panel.
This starts the built-in pattern sequencer in the device. To stop playback, click the 
Run button again or click the Stop button on the Transport panel.

The Run button on the Redrum.

D If you are running Redrum separately and start playback of the main se-
quencer, the pattern device will automatically restart in sync with the se-
quencer.

D Pattern changes can be controlled by pattern change events in the main 
sequencer.
In other words, you can record or create pattern changes in the main sequencer, 
and have them occur at the correct position on playback.

D The sound sources can also be played by the main sequencer, or via 
MIDI.
You can combine the built-in pattern playback with playback from the main se-
quencer or via MIDI. For example, this allows you to add variations or fills to a basic 
pattern.
It is also possible to disable the pattern sequencer totally, converting the device to 
a pure sound module. This is done by deactivating the Enable Pattern Section 
switch.

Selecting Patterns

The Redrum has 32 pattern memories, divided into four banks 
(A, B, C, D).

The Bank and Pattern buttons for the Redrum pattern sequencer.
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D To select a pattern in the current bank, click on the desired Pattern but-
ton (1-8).
If you like, you can assign computer key commands and/or MIDI messages to pat-
tern selection.

D To select a pattern in another bank, first click the desired Bank button (A, 
B, C, D) and then click the Pattern button.
Nothing happens until you click the Pattern button.

D If you select a new pattern during playback, the change will take effect 
on the next downbeat (according to the time signature set in the trans-
port panel).
If you automate pattern changes in the main sequencer, you can make them hap-
pen at any position - see page 87.

D Note that you cannot load or save patterns - they are only stored as part 
of a song.
However, you can move patterns from one location to another (even between 
songs) by using the Cut, Copy and Paste Pattern commands. 

Pattern tutorial
If you are unfamiliar with step programming patterns, the basic principle is very intui-
tive and easy to learn. Proceed as follows:

1. Load a Redrum patch, if one isn’t already loaded.

2. Make sure an empty pattern is selected.
If you like, use the Clear Pattern command on the Edit menu or device context 
menu to make sure.

3. Make sure that the “Enable Pattern Section” and the “Pattern” buttons are ac-
tivated (lit).

4. Press the “Run” button.
There will be no sound, as no pattern steps have been recorded yet. But as you 
can see, the LEDs over the Step button light up consecutively, moving from left to 
right, and then starts over. Each Step button represents one “step” in the Pattern. 

5. Select a Redrum channel, by clicking the “Select” button at the bottom of the 
channel.
The button lights up, indicating that this channel and the drum sound it contains is 
selected.

6. While in Run mode, press Step button 1, so that it lights up.
The selected sound will now play every time Step 1 is “passed over”.

7. Clicking other Step buttons so they light up will play back the selected sound 
as the sequencer passes those steps.
Clicking on a selected (lit) step button a second time removes the sound from that 
step and the button goes dark again. You can click and drag to add or remove 
steps quickly.

8. Select another Redrum channel to program steps for that sound.
Selecting a new sound or channel also removes the visual indications (static lit 
buttons) of step entries for the previously selected sound. The step buttons always 
show step entries for the currently selected sound.

9. Continue switching between sounds, and programming steps to build your 
pattern.
Note that you can erase or add step entries even if Run mode isn’t activated.

Setting Pattern Length
You may want to make settings for Pattern length, i.e the number of steps the pattern 
should play before repeating:

D Use the “Steps” spin controls to set the number of steps you wish the 
pattern to play.
The range is 1 to 64. You can always extend the number of steps at a later stage, 
as this will merely add empty steps at the end of the original pattern. You could 
also make it shorter, but that would (obviously) mean that the steps “outside” the 
new length won’t be heard. These steps aren’t erased though; if you raise the 
Steps value again, the steps will be played back again.
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About the “Edit Steps” Switch

If you set the pattern length to more than 16 steps, the pattern steps following after 
the 16th won’t be visible, although they will play back. To view and be able to edit the 
next 16 steps, you have to set the Edit Steps switch to 17-32. To see and edit steps 
beyond 32 you set the switch to 33-48, and so on.

Setting Pattern Resolution

Redrum always follows the tempo setting on the transport panel, but you can also 
make Redrum play in different “resolutions” in relation to the tempo setting. Changing 
the Resolution setting changes the length of each step, and thereby the “speed” of 
the pattern.

Step Dynamics 
When you enter step notes for a drum sound, you can set the velocity value for each 
step to one of three values: Hard, Medium or Soft. This is done by setting the Dynamic 
switch before entering the note.

The color of the step buttons reflect the dynamics for each step. Soft notes are light yellow, Medium 
notes are orange and Hard are red.

D When the Medium value is selected, you can enter Hard notes by holding 
down [Shift] and clicking.
In the same way, you can enter Soft notes by holding down [Option] (Mac) or [Alt] 
(Windows) and clicking. Note that this doesn’t change the Dynamic setting on the 
device panel - it only affects the notes you enter.

D When you use different dynamics, the resulting difference in the sound 
(loudness, pitch, etc.), is governed by the “VEL” knob settings for each 
drum channel (see page 180). 
If no velocity amount is set for a drum channel, it will play back the same, regard-
less of the Dynamic setting.

D To change the dynamics for an already programmed step, set the switch 
to the dynamic value you wish to change it to and click on the step.

! Note that if you are triggering Redrum via MIDI or from the main se-
quencer, the sounds will react to velocity like any other audio device. The 
Dynamic values are there to offer velocity control when using the built-in 
pattern sequencer.

Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced swing 
feel. It works by delaying all sixteenth notes that fall in between the eighth notes.

You can activate or deactivate shuffle individually for each Redrum pattern by clicking 
the Shuffle button on the device panel.

The amount of shuffle is set globally with the Global Shuffle control in the ReGroove 
Mixer. See the ReGroove chapter.

Flam

A flam is when you double-strike a drum, to create a rhythmic or dynamic effect. Ap-
plying flam to a step entry will add a second “hit” to a drum sound. The flam amount 
knob determines the delay between the two hits.

To add a flam drum note, proceed as follows:

1. Activate flam by clicking the Flam button.

2. Click on a step to add a note (taking the Dynamic setting into account as 
usual).
A red LED is lit above the step to indicate that flam will be applied to that step.

3. Use the Flam knob to set the desired amount of flam.
The flam amount is global for all patterns in the device.

D To add or remove flam to or from an existing step note, click directly on 
the corresponding flam LED.
You can also click and drag on the LEDs to add or remove several flam steps 
quickly.
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D Applying flam to several consecutive step entries is a quick way to pro-
duce drum rolls.
By adjusting the Flam knob you can create 1/32 notes even if the step resolution 
is 1/16, for example.

The Pattern Enable switch

If you deactivate the “Pattern” button, the pattern playback will be muted, starting at 
the next downbeat (exactly as if you had selected an empty (silent) pattern). For exam-
ple, this can be used for bringing different pattern devices in and out of the mix during 
playback.

✪ You can also mute Redrum devices in the sequencer using the Mute but-
ton for the track connected to the Redrum. If you do so, this will mute the 
Redrum output instantly, and the Mute indicator on the Redrum panel 
lights up. Note that all tracks connected to this Redrum device must be 
muted for this to work.

The Mute indicator.

The Enable Pattern Section switch
If this is deactivated, Redrum will function as a pure “sound module”, i.e. the internal 
Pattern sequencer is disengaged. Use this mode if you wish to control Redrum exclu-
sively from the main sequencer or via MIDI (see page 183).

Pattern Functions
When a Redrum device is selected, you will find some specific pattern functions on 
the Edit menu (and on the device context menu):

Chaining Patterns
When you have created several patterns that belong together, you most probably 
want to make these play back in a certain order. This is done by recording or inserting 
pattern changes into the main sequencer. See page 87.

Converting Pattern Data to Notes
You can convert Redrum Patterns to notes in the main sequencer. This allows you to 
edit the notes freely, create variations or use Groove quantizing. This is described on 
page 92.

|Function |Description
Shift Pattern Left/Right These functions move all notes in the pattern one step to 

the left or right.

Shift Drum Left/Right The Shift Drum functions move all notes for the selected 
drum channel (the channel for which the Select button is 
lit) one step to the left or right. 

Randomize Pattern Creates a random pattern. Random patterns can be great 
starting points and help you get new ideas.

Randomize Drum Creates a random pattern for the selected drum sound 
only - the notes for the other drum sound channels are un-
affected.

Alter Pattern The Alter Pattern function modifies the selected pattern by 
“shuffling” the current pattern notes and redistributing 
them among the drum sounds at random. This creates a 
less chaotic pattern than the “Randomize Pattern” func-
tion.
Note that there must be something in the pattern for the 
function to work on - using an Alter function on an empty 
pattern will not do anything.

Alter Drum Works like the “Alter Pattern” function, but affects the se-
lected drum sound only.

|Function |Description
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Redrum Parameters
Drum Sound Settings
Redrum features ten drum sound channels that can each be loaded with a Wave or 
AIFF sample or a sample from a SoundFont bank. Although they are basically similar, 
there are three “types” of drum sound channels, with slightly different features. This 
makes some channels more suitable for certain types of drum sounds, but you are of 
course free to configure your drum kits as you like.

On the following pages, all parameters will be listed. If a parameter is available for cer-
tain drum sound channels only, this will be stated.

Mute & Solo

At the top of each drum sound channel, you will find a Mute (M) and a Solo (S) button. 
Muting a channel silences its output, while Soloing a channel mutes all other chan-
nels. Several channels can be muted or soloed at the same time.

You can also use keys on your MIDI keyboard to mute or solo individual drum sounds 
in real time. 

D The keys C2 to E3 (white keys only) will mute individual drum channels 
starting with channel 1.
The sounds are muted for as long as you hold the key(s) down.

D The keys C4 to E5 (white keys only) will solo individual drum channel, 
starting with channel 1.
The sounds are soloed for as long as you hold the key(s) down.

This is a great way to bring drum sounds in and out of the mix when playing Reason 
live. You can also record the drum channel Mutes in the main sequencer, just like any 
other controller (see page 64).

The Effect Sends (S1 & S2)

On the back panel of Redrum you will note two audio connections labeled “Send 
Out” 1 and 2. When you create a Redrum device, these will by default be auto-routed 
to the first two “Chaining Aux” inputs on the Mixer device (provided that these inputs 
aren’t already in use).

This feature allows you to add effects to independent drum sounds in the Redrum.

D Raising the S1 knob for a drum sound channel will send the sound to the 
first send effect connected to the mixer.
Similarly, the S2 knob governs the send level to the second send effect in the 
mixer.

D Note that there must be send effects connected to the AUX Sends and 
Returns in the mixer for this to work.

D Also note that if Redrum is soloed in the Mixer the effect sends will be 
muted.

D Another way to add independent effects to drum sounds is to use the in-
dependent drum outputs.
See page 183.

Pan

Sets the Pan (stereo position) for the channel.

D If the LED above the Pan control is lit, the sound uses a stereo sample.
In that case, the Pan control serves as a stereo balance control.

Level and Velocity

The Level knob sets the volume for the channel. However, the volume can also be af-
fected by velocity (as set with the Dynamic value, or as played via MIDI). How much 
the volume should be affected by velocity is set with the “Vel” knob.

D If the Vel knob is set to a positive value, the volume will become louder 
with increasing velocity values.
The higher the Vel value, the larger the difference in volume between low and high 
velocity values.

D A negative value inverts this relationship, so that the volume decreases 
with higher velocity values.

C2 C3 C4 C5

1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10

Mute Solo
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D If the Vel knob is set to zero (middle position), the sound will play at a 
constant volume, regardless of the velocity.
When Vel is set to zero, the LED above the knob goes dark.

Length and the Decay/Gate switch

The Length knob determines the length of the drum sound, but the result depends on 
the setting of the Decay/Gate switch:

D In Decay mode (switch down), the sound will decay (gradually fade out) 
after being triggered. The decay time is determined by the Length set-
ting.
In this mode, it doesn’t matter for how long a drum note is held (if played back from 
the main sequencer or via MIDI) - the sound will play the same length for short 
notes as for long notes. This is the traditional “drum machine” mode.

D In Gate mode (switch up), the sound will play for the set Length, and then 
be cut off.
Furthermore, if a sound set to Gate mode is played from the main sequencer, from 
a CV/Gate device or via MIDI, the sound will be cut off when the note ends or after 
the set Length, depending on which comes first. Or in other words, the sound 
plays for as long as you hold the note, but the Length setting serves as the maxi-
mum length for the sound.
There are several uses for the Gate mode:
• For “gated” drum sounds, when the tail of the sound is abruptly cut off as an ef-
fect.
• For when you want to use very short sounds, and don’t want them to “lose 
power” by being faded out.
• For when you play the Redrum from the sequencer or via MIDI, with sounds for 
which the length is important (e.g. when using the Redrum as a sound effects 
module).

! Audio samples sometimes contain a “loop”, which is set by editing the 
audio in a sample editor. This loop repeats a part of the sample to pro-
duce sustain as long as you hold down a note. Drum samples usually 
don’t contain loops, but who is to say that Redrum should only play drum 
samples? 
Note that if a sample contains a loop, and Length is set to maximum, the 
sound will have infinite sustain, in other words it will never become si-
lent, even if you stop playback. Decreasing the Length setting solves this 
problem. 

Pitch

Sets the pitch of the sound. The range is +/- 1 octave.

D When the pitch is set to any other value than 0, the LED above the knob 
lights up to indicate that the sample isn’t played back at its original pitch.

Pitch Bend

By setting the Bend knob to a positive or negative value, you specify the start pitch of 
the sound (relative to the Pitch setting). The pitch of the sound will then be bent to the 
main Pitch value. Thus, selecting a positive Bend value will cause the pitch to start 
higher and bend down to the original Pitch, and vice versa.

D The Rate knob determines the bend time - the higher the value, the 
slower the bend.

D The Vel knob determines how the Bend amount should be affected by 
velocity.
With a positive Vel value, higher velocity results in wider pitch bends.

D The Bend and Vel knobs have LEDs that light up when the functions are 
activated (i.e. when a value other than zero is selected).

! Pitch bend is available for drum sound channels 6 and 7 only.

Tone

The Tone knob determines the brightness of the drum sound. Raising this parameter 
results in a brighter sound. The Vel knob determines whether the sound should be-
come brighter (positive Vel value) or darker (negative Vel value) with higher velocity.

D The Tone and Vel knobs have LEDs that light up when the functions are 
activated (i.e. when a value other than zero is selected).

! The Tone controls are available for drum sound channels 1, 2 and 10 
only.
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Sample Start

The Start parameter allows you to adjust the start point of the sample. The higher the 
Start value, the further the start point is moved “into” the sample. If you set the Start 
Velocity knob to a positive amount, the sample start point is moved forward with 
higher velocities. A negative Start Velocity amount inverts this relationship.

D When Start Velocity is set to any other value than zero, the LED above 
the knob lights up.

D A negative Start Velocity amount is only useful if you have set the Start 
parameter to a value higher than 0.
By raising the Start value a bit and setting Start Velocity to a negative value, you 
can create rather realistic velocity control over some drum sounds. This is because 
the very first transients in the drum sound will only be heard when you play hard 
notes.

! The Sample Start settings are available for drum sound channels 3-5, 8 
and 9.

Global Settings

Channel 8 & 9 Exclusive

If this button is activated, the sounds loaded into drum channels 8 and 9 will be exclu-
sive. In other words, if a sound is played in channel 8 it will be silenced the moment a 
sound is triggered in channel 9, and vice versa. 

The most obvious application for this feature is to “cut off” an open hi-hat with a 
closed hi-hat, just like a real one does.

High Quality Interpolation

When this is activated, the sample playback is calculated using a more advanced in-
terpolation algorithm. This results in better audio quality, especially for drum samples 
with a lot of high frequency content.

D High Quality Interpolation uses more computer power - if you don’t need 
it, it’s a good idea to turn it off!
Listen to the drum sounds in a context and determine whether you think this set-
ting makes any difference.

! If you are using a Macintosh with a G4 (Altivec) processor or better, turn-
ing High Quality Interpolation off makes no difference.

Master Level

The Master Level knob in the top left corner of the device panel governs the overall 
volume from Redrum.
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Using Redrum as a Sound 
Module
The drum sounds in Redrum can be played via MIDI notes. Each drum sound is trig-
gered by a specific note number, starting at C1 (MIDI note number 36):

This allows you to play Redrum live from a MIDI keyboard or a MIDI percussion con-
troller, or to record or draw drum notes in the main sequencer. If you like, you can 
combine pattern playback with additional drum notes, such as fills and variations. 
However:

! If you want to use Redrum purely as a sound module (i.e. without pattern 
playback) you should make sure that the “Enable Pattern Section” but-
ton is deactivated.
Otherwise, the Redrum pattern sequencer will start as soon as you start 
the main sequencer.

Connections

On the back of the Redrum you will find the following connections:

For each drum sound channel:

Others

C1 C2

1

2

3

4

5 6

7

8

9

10

|Connection |Description
Audio Outputs There are individual audio outputs for each drum sound channel, al-

lowing you to route a drum sound to a separate channel in the 
mixer, possibly via insert effects, etc. 
For mono sounds, use the “Left (Mono)” output (and pan the sound 
using the Pan control in the mixer).
When you use an individual output for a sound, the sound is auto-
matically excluded from the master stereo output.

Gate Out This sends out a gate signal when the drum sound is played (from 
a pattern, via MIDI or by using the Trigger button on the device 
panel). This lets you use the Redrum as a “trig sequencer”, control-
ling other devices.
The length of the gate signal depends on the Decay/Gate setting 
for the sound: In Decay mode, a short “trig pulse” is sent out, while 
in Gate mode, the gate signal will have the same length as the 
drum note (see page 181).

Gate In Allows you to trigger the sound from another CV/Gate device. All 
settings apply, just as when playing the drum sound conventionally.

Pitch CV In Lets you control the pitch of the drum sound from another CV de-
vice.

|Connection |Description
Send Out 1-2 Outputs for the send signals controlled with the S1 and S2 knobs, 

as described on page 180.

Stereo Out This is the master stereo output, outputting a mix of all drum sounds 
(except those for which you use individual outputs).
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Introduction
Subtractor is an analog-type polyphonic synthesizer based on subtractive synthesis, 
the method used in analog synthesizers. This chapter will go through all parameters of 
each section of Subtractor. In addition to the parameter descriptions, the chapter also 
includes a few tips and tricks to help you get the most out of the Subtractor synthe-
sizer.

! It is recommended that you start with default settings (an “Init Patch”) if 
you intend to follow the examples in this chapter, unless otherwise is 
stated. An Init Patch is created by selecting “Initialize Patch” from the 
Edit menu. If you wish to keep the current settings, save them before ini-
tializing.

The Subtractor has the following basic features:

D Up to 99 Voice Polyphony.
You can set the number of voices for each Patch.

D Dual Filters.
A combination of a multimode filter and a second, linkable, lowpass filter allows for 
complex filtering effects. See page 191.

D Two Oscillators, each with 32 waveforms.
See page 186.

D Frequency Modulation (FM). 
See page 190.

D Oscillator Phase Offset Modulation.
This is an unique Subtractor feature that generates waveform variations. See page 
189.

D Two Low Frequency Oscillators (LFO’s)
See page 195.

D Three Envelope Generators.
See page 194.

D Extensive Velocity Control.
See page 197.

D Extensive CV/Gate Modulation possibilities.
See page 200.

! Loading and saving Patches is described on page 29.

The Oscillator Section

Subtractor provides two oscillators. Oscillators are the main sound generators in 
Subtractor, the other features are used to shape the sound of the oscillators. Oscilla-
tors generate two basic properties, waveform and pitch (frequency). The type of 
waveform the oscillator produces determines the harmonic content of the sound, 
which in turn affects the resultant sound quality (timbre). Selecting a oscillator wave-
form is usually the starting point when creating a new Subtractor Patch from scratch.

Oscillator 1 Waveform

Oscillator 1 provides 32 waveforms. The first four are standard waveforms, and the 
rest are “special” waveforms, some of which are suitable for emulating various musical 
instrument sounds.

✪ It is worth noting here that all waveforms can be radically transformed 
using Phase offset modulation (see page 189). 

D To select a waveform, click the spin controls to the right of the “Wave-
form” LED display. 
The first 4 basic waveforms are shown as standard symbols, and the special wave-
forms are numbered 5 - 32. 
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Here follows a brief description of the Subtractor waveforms:

! Please note that the descriptions of the waveforms sound or timbre is 
merely meant to provide a basic guideline, and shouldn’t be taken too lit-
erally. Given the myriad ways you can modulate and distort a waveform 
in Subtractor, you can produce extremely different results from any given 
waveform.

Setting Oscillator 1 Frequency - Octave/Semitone/
Cent

By clicking the corresponding up/down buttons you can tune, i.e. change the fre-
quency of Oscillator 1 in three ways:

D In Octave steps 
The range is 0 - 9. The default setting is 4 (where “A” above middle “C” on your 
keyboard generates 440 Hz). 

D In Semitone steps 
Allows you to raise the frequency in 12 semitone steps (1 octave).

D In Cent steps (100th of a semitone) 
The range is -50 to 50 (down or up half a semitone).

|Waveform |Description
Sawtooth This waveform contains all harmonics and produces a bright and rich 

sound. The Sawtooth is perhaps the most “general purpose” of all the 
available waveforms.

Square A square wave only contains odd number harmonics, which produces 
a distinct, hollow sound.

Triangle The Triangle waveform generates only a few harmonics, spaced at 
odd harmonic numbers. This produces a flute-like sound, with a 
slightly hollow character.

Sine The sine wave is the simplest possible waveform, with no harmonics 
(overtones). The sine wave produces a neutral, soft timbre.

5 This waveform emphasizes the higher harmonics, a bit like a sawtooth 
wave, only slightly less bright-sounding.

6 This waveform features a rich, complex harmonic structure, suitable 
for emulating the sound of an acoustic piano.

7 This waveform generates a glassy, smooth timbre. Good for electric 
piano-type sounds.

8 This waveform is suitable for keyboard-type sounds such as harpsi-
chord or clavinet.

9 This waveform is suitable for electric bass-type sounds.

10 This is a good waveform for deep, sub-bass sounds.

11 This produces a waveform with strong formants, suitable for voice-like 
sounds.

12 This waveform produces a metallic timbre, suitable for a variety of 
sounds.

13 This produces a waveform suitable for organ-type sounds.

14 This waveform is also good for organ-type sounds. Has a brighter 
sound compared to waveform 13.

15 This waveform is suitable for bowed string sounds, like violin or cello.

16 Similar to 15, but with a slightly different character.

17 Another waveform suitable for string-type sounds.

18 This waveform is rich in harmonics and suitable for steel string guitar-
type sounds.

19 This waveform is suitable for brass-type sounds.

20 This waveform is suitable for muted brass-type sounds.

21 This waveform is suitable for saxophone-like sounds.

22 A waveform suitable for brass and trumpet-type sounds.

23 This waveform is good for emulating mallet instruments such as 
marimba.

24 Similar to 23, but with a slightly different character.

25 This waveform is suitable for guitar-type sounds.

26 This is a good waveform for plucked string sounds, like harp.

27 Another waveform suitable for mallet-type sounds (see 23-24), but 
has a brighter quality, good for vibraphone-type sounds.

28 Similar to 27, but with a slightly different character.

29 This waveform has complex, enharmonic overtones, suitable for 
metallic bell-type sounds.

30 Similar to 29, but with a slightly different character. By using FM (see 
page 190) and setting the Osc Mix to Osc 1, this and the following 
two waveforms can produce noise.

31 Similar to 30, but with a slightly different character.

32 Similar to 30, but with a slightly different character.

|Waveform |Description
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Oscillator Keyboard Tracking

Oscillator 1 has a button named “Kbd. Track”. If this is switched off, the oscillator 
pitch will remain constant, regardless of any incoming note pitch messages, although 
the oscillator still reacts to note on/off messages. This can be useful for certain appli-
cations:

D When Frequency Modulation (FM - see page 190) or Ring Modulation 
(see page 190) is used.
This produces enharmonic sounds with very varying timbre across the keyboard.

D For special effects and non-pitched sounds (like drums or percussion) 
that should sound the same across the keyboard.

Using Oscillator 2

You activate Osc 2 by clicking the button next to the text “Osc 2“. Setting oscillator 
frequency and keyboard tracking is identical to Oscillator 1.

Adding a second oscillator enables many new modulation possibilities which can pro-
duce richer timbres. A basic example is to slightly detune (+/– a few cents) one of the 
oscillators. This slight frequency offset causes the oscillators to “beat” against each 
other, producing a wider and richer sound. Also, by combining two different wave-
forms, and adding frequency or ring modulation, many new timbres can be created.

Oscillator Mix 

The Osc Mix knob determines the output balance between Osc 1 and Osc 2. To be 
able to clearly hear both oscillators, the “Osc Mix” knob should be set somewhere 
around the center position. If you turn the Mix knob fully to the left, only Osc 1 will be 
heard, and vice versa. [Command]/[Ctrl]-clicking the knob sets the Mix parameter to 
center position.

Oscillator 2 Waveform
The waveform alternatives for Oscillator 2 are identical to those of Oscillator 1.

However, the Noise Generator provides a third sound generating source (in addition 
to the two oscillators) in Subtractor, and could be regarded as an “extra” waveform for 
Oscillator 2, as it is internally routed to the Oscillator 2 output. See below for a de-
scription of the Noise Generator.

Noise Generator

The Noise Generator could be viewed as an oscillator that produces noise instead of 
a pitched waveform. Noise can be used to produce a variety of sounds, the classic ex-
ample being “wind” or “rolling wave” sounds, where noise is passed through a filter 
while modulating the filter frequency. Other common applications include non-pitched 
sounds like drums and percussion, or simulating breath noises for wind instruments. 
To use the Noise Generator, select an Init Patch and proceed as follows:

1. Turn Osc 2 off.

2. Click the button (in the Noise Generator section) to activate the Noise Gener-
ator.
If you play a few notes on your MIDI instrument you should now hear Osc1 mixed 
with the sound of the Noise Generator.

3. Turn the Mix knob fully to the right, and play a few more notes.
Now just the Noise Generator will be heard. 

D Thus, the output of the Noise Generator is internally routed to Osc 2.
If you switch Osc 2 on, the noise will be mixed with the Osc 2 waveform.

There are three Noise Generator parameters. These are as follows:

|Parameter |Description
Noise Decay This controls how long it takes for the noise to fade out when you 

play a note. Note that this is independent from the Amp Envelope 
Decay parameter (see page 194), allowing you to mix a short 
“burst” of noise at the very beginning of a sound, i.e. a pitched 
sound that uses oscillators together with noise.

Noise Color This parameter allows you to vary the character of the noise. If the 
knob is turned fully clockwise, pure or “white” noise (where all fre-
quencies are represented with equal energy) is generated. Turning 
the knob anti-clockwise produces a gradually less bright sounding 
noise. Fully anti-clockwise the noise produced is an earthquake-
like low frequency rumble.

Level Controls the level of the Noise Generator.
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Phase Offset Modulation
A unique feature of the Subtractor oscillators is the ability to create an extra waveform 
within one oscillator, to offset the phase of that extra waveform, and to modulate this 
phase offset. By subtracting or multiplying a waveform with a phase offset copy of it-
self, very complex waveforms can be created. Sounds complicated? Well, the theory 
behind it might be, but from a user perspective it is just a method of generating new 
waveforms from existing waveforms.

A seasoned synth programmer using Subtractor for the first time may wonder why the 
Subtractor oscillators (seemingly) cannot provide the commonly used pulse waveform 
and the associated pulse width modulation (PWM). Or oscillator sync, another com-
mon feature in analog synthesizers. The simple answer is that Subtractor can easily 
create pulse waveforms (with PWM) and oscillator sync-sounds, and a lot more be-
sides, partly by the use of phase offset modulation.

Each oscillator has it's own Phase knob and a selector button. The Phase knob is 
used to set the amount of phase offset, and the selector switches between three 
modes:

• Waveform multiplication (x) 
• Waveform subtraction (–) 
• No phase offset modulation (o).

When phase offset modulation is activated, the oscillator creates a second waveform 
of the same shape and offsets it by the amount set with the Phase knob. Depending 
on the selected mode, Subtractor then either subtracts or multiplies the two wave-
forms with each other. The resulting waveforms can be seen in the illustration below.

• In example 1, we see two sawtooth waves with a slight offset. 
• Example 2 shows that subtracting one slightly offset sawtooth wave from the 

other, produces a pulse wave. If you modulate the Phase offset parameter (with for 
example an LFO), the result will be pulse width modulation (PWM).

• Example 3 shows the resulting waveform when multiplying the offset waves with 
each other. As you can see (and hear if you try it), multiplying waveforms can pro-
duce very dramatic and sometimes unexpected results.

Using phase offset modulation can create very rich and varied timbres, especially 
when used along with LFO or Envelopes to modulate the phase offset.

✪ To get a “feel” for this concept, you could study Patches that use phase 
offset modulation, and maybe tweak some of the Phase Offset parame-
ters to find out what happens. Try “SyncedUp” in the Polysynth category 
in the Factory Soundbank for an example of osc sync or “Sweeping 
Strings” (in the Pads category) for an example of PWM.

! Note that if you activate waveform subtraction with a Phase offset set to 
“0” for an oscillator, the second waveform will cancel out the original 
waveform completely, and the oscillator output will be silent. If you set 
the Phase Offset knob to any other value than zero, the sound returns.

1. The two offset 
waveforms:
1. The two offset 
waveforms:

2. The result of 
subtraction:

3. The result of 
multiplication:

Ampl.

Ampl.

Ampl.

t.

t.

t.
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Frequency Modulation (FM)

In synthesizer-speak, Frequency Modulation, or FM, is when the frequency of one os-
cillator (called the “carrier”) is modulated by the frequency of another oscillator (called 
the “modulator”). Using FM can produce a wide range of harmonic and non harmonic 
sounds. In Subtractor, Osc 1 is the carrier and Osc 2 the modulator. To try out some 
of the effects FM can produce, proceed as follows:

1. Select an Init Patch by selecting “Initialize Patch” from the Edit menu.

2. Activate Osc 2.
As you need both a carrier and a modulator to produce FM, turning the FM knob 
will not produce any effect unless you first activate Osc 2. For classic FM sounds, 
use sine wave on oscillator 1 and triangle wave on oscillator 2.

3. Use the FM knob to set the FM amount to a value of about 50.
As you can hear, the timbre changes, but the effect isn’t very pronounced yet.

4. Turn the Osc Mix knob fully to the left, so that only the sound of Osc 1 is 
heard.
The modulator (Osc 2) still affects Osc 1, even though the Osc 2 output is muted.

5. Now, hold down a note on your MIDI keyboard and tune Osc 2 a fifth up from 
the original pitch by setting the Osc 2 frequency “Semi” parameter to a value 
of 7.
As you can hear, for each semitone step you vary the Osc 2 frequency, the timbre 
changes dramatically. Setting Osc 2 frequency to certain musical intervals (i.e. 
fourth, fifth or octave semitone steps) produces harmonic, rich timbres, almost like 
tube distortion. Setting Osc 2 to non-musical intervals usually results in complex, 
enharmonic timbres.

✪ Experiment with different oscillator parameters such as phase offset 
modulation, changing the waveforms etc. and listen to how they affect 
the sound of frequency modulation.

Using the Noise Generator as the Modulator source

As explained earlier, the Noise Generator is internally routed to the Osc 2 output. 
Hence, if you deactivate Osc 2, and activate the Noise Generator while using FM, the 
noise will be used to frequency modulate Osc 1. 

✪ With the Noise Generators default settings, this will sound much like col-
ored noise. But by changing (lowering) the Noise Generator Decay pa-
rameter, so that the noise modulates only the attack portion of the sound 
can produce more interesting results. You could also use a combination 
of noise and Osc 2.

Ring Modulation

Ring Modulators basically multiply two audio signals together. The ring modulated 
output contains added frequencies generated by the sum of, and the difference be-
tween, the frequencies of the two signals. In the Subtractor Ring Modulator, Osc 1 is 
multiplied with Osc 2 to produce sum and difference frequencies. Ring modulation 
can be used to create complex and enharmonic, bell-like sounds.

1. Select an Init Patch by selecting “Initialize Patch” from the Edit menu.
Save any current settings you wish to keep before initializing.

2. Activate Ring Modulation with the button in the lower right corner of the os-
cillator section.

3. Activate Osc 2.
You need to activate Osc 2 before any ring modulation can happen.

4. Turn the Osc Mix knob fully to the right, so that only the sound of Osc 2 is 
heard.
Osc 2 provides the ring modulated output.

5. If you play a few notes while varying the frequency of either oscillator, by us-
ing the Semitone spin controls, you can hear that the timbre changes dra-
matically.
If the oscillators are tuned to the same frequency, and no modulation is applied to 
either the Osc 1 or 2 frequency, the Ring Modulator won’t do much. It is when the 
frequencies of Osc 1 and Osc 2 differ, that you get the “true” sound of ring mod-
ulation.
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The Filter Section

In subtractive synthesis, a filter is the most important tool for shaping the overall tim-
bre of the sound. The filter section in Subtractor contains two filters, the first being a 
multimode filter with five filter types, and the second being a low-pass filter. The com-
bination of a multimode filter and a lowpass filter can be used to create very complex 
filter effects.

Filter 1 Type
With this multi-selector you can set Filter 1 to operate as one of five different types of 
filter. The five types are illustrated and explained on the following pages:

D 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. This 
filter type has a fairly steep roll-off curve (24dB/Octave). Many classic synthesizers 
(Minimoog/Prophet 5 etc.) use this filter type.

The darker curve illustrates the roll-off curve of the 24dB Lowpass Filter. The lighter curve in the 
middle represents the filter characteristic when the Resonance parameter is raised.

D 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in analog synthesizers (Oberheim, 
early Korg synths etc.). It has a gentler slope (12 dB/Octave), leaving more of the 
harmonics in the filtered sound compared to the LP 24 filter.

The darker curve illustrates the roll-off curve of the 12dB Lowpass Filter. The lighter curve in the 
middle represents the filter characteristic when the Resonance parameter is raised.

D Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange frequencies 
are not affected. Each slope in this filter type has a 12 dB/Octave roll-off.

The darker curve illustrates the roll-off curve of the Bandpass Filter. The lighter curve in the middle 
represents the filter characteristic when the Resonance parameter is raised.
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D Highpass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out lower frequencies 
and letting high frequencies pass. The HP filter slope has a 12 dB/Octave roll-off.

The darker curve illustrates the roll-off curve of the Highpass Filter. The lighter curve in the middle 
represents the filter characteristic when the Resonance parameter is raised.

D Notch
A notch filter (or band reject filter) could be described as the opposite of a band-
pass filter. It cuts off frequencies in a narrow midrange band, letting the frequen-
cies below and above through. On its own, a notch filter doesn’t really alter the 
timbre in any dramatic way, simply because most frequencies are let through. 

However, by combining a notch filter with a lowpass filter (using Filter 2 - see page 
193 in this chapter), more musically useful filter characteristics can be created. 
Such a filter combination can produce soft timbres that still sound “clear”. The ef-
fect is especially noticeable with low resonance (see page 193) settings.

The darker curve illustrates the roll-off curve of the Notch Filter. The lighter curve in the middle 
represents the filter characteristic when the Resonance parameter is raised.
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Filter 1 Frequency 
The Filter Frequency parameter (often referred to as “cutoff”) determines which area 
of the frequency spectrum the filter will operate in. For a lowpass filter, the frequency 
parameter could be described as governing the “opening” and “closing” of the filter. If 
the Filter Freq is set to zero, none or only the very lowest frequencies are heard, if set 
to maximum, all frequencies in the waveform are heard. Gradually changing the Filter 
Frequency produces the classic synthesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the Fil-
ter Envelope (see page 194) as well. Changing the Filter Frequency with 
the Freq slider may therefore not produce the expected result.

Resonance 
The filter resonance parameter is used to set the Filter characteristic, or quality. For 
lowpass filters, raising the filter Res value will emphasize the frequencies around the 
set filter frequency. This produces a generally thinner sound, but with a sharper, more 
pronounced filter frequency “sweep”. The higher the filter Res value, the more reso-
nant the sound becomes until it produces a whistling or ringing sound. If you set a 
high value for the Res parameter and then vary the filter frequency, this will produce a 
very distinct sweep, with the ringing sound being very evident at certain frequencies.

• For the highpass filter, the Res parameter operates just like for the lowpass filters.
• When you use the Bandpass or Notch filter, the Resonance setting adjusts the 

width of the band. When you raise the Resonance, the band where frequencies 
are let through (Bandpass), or cut (Notch) will become narrower. Generally, the 
Notch filter produces more musical results using low resonance settings.

Filter Keyboard Track (Kbd)
If Filter Keyboard Track is activated, the filter frequency will increase the further up on 
the keyboard you play. If a lowpass filter frequency is constant (a Kbd setting of “0”) 
this can introduce a certain loss of “sparkle” in a sound the higher up the keyboard 
you play, because the harmonics in the sound are progressively being cut. By using a 
degree of Filter Keyboard Tracking, this can be compensated for.

Filter 2 
A very useful and unusual feature of the Subtractor Synthesizer is the presence of an 
additional 12dB/Oct lowpass filter. Using two filters together can produce many inter-
esting filter characteristics, that would be impossible to create using a single filter, for 
example formant effects. 

The parameters are identical to Filter 1, except in that the filter type is fixed, and it 
does not have filter keyboard tracking.

D To activate Filter 2, click the button at the top of the Filter 2 section. 
Filter 1 and Filter 2 are connected in series. This means that the output of Filter 1 
is routed to Filter 2, but both filters function independently. For example, if Filter 1 
was filtering out most of the frequencies, this would leave Filter 2 very little to 
“work with”. Similarly, if Filter 2 had a filter frequency setting of “0”, all frequencies 
would be filtered out regardless of the settings of Filter 1.

✪ Try the “Singing Synth” patch (in the Monosynth category of the Factory 
Sound Bank) for an example of how dual filters can be used.

Filter Link

When Link (and Filter 2) is activated, the Filter 1 frequency controls the frequency off-
set of Filter 2. That is, if you have set different filter frequency values for Filter 1 and 2, 
changing the Filter 1 frequency will also change the frequency for Filter 2, but keeping 
the relative offset. 

✪ Try the “Fozzy Fonk” patch (in the Polysynth category of the Factory 
Sound Bank) for an example how linked filters can be used.

! Caution! If no filter modulation is used, and the filters are linked, pulling 
down the frequency of Filter 2 to zero will cause both filters to be set to 
the same frequency. If combined with high Res settings, this can produce 
very loud volume levels that cause distortion!
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Envelopes - General
Envelope generators are used to control several important sound parameters in ana-
log synthesizers, such as pitch, volume, filter frequency etc. Envelopes govern how 
these parameters should respond over time - from the moment a note is struck to the 
moment it is released. 

Standard synthesizer envelope generators have four parameters; Attack, Decay, Sus-
tain and Release (ADSR). 

There are three envelope generators in the Subtractor, one for volume, one for the Fil-
ter 1 frequency, and one modulation envelope which has selectable modulation desti-
nations. 

The ADSR envelope parameters.

Attack

When you play a note on your keyboard, the envelope is triggered. This means it 
starts rising from zero to the maximum value. How long this should take, depends on 
the Attack setting. If the Attack is set to “0”, the maximum value is reached instantly. If 
this value is raised, it will take time before the maximum value is reached.

For example, if the Attack value is raised and the envelope is controlling the filter fre-
quency, the filter frequency will gradually rise up to a point each time a key is pressed, 
like an “auto-wha” effect. 

Decay

After the maximum value has been reached, the value starts to drop. How long this 
should take is governed by the Decay parameter. 

If you wanted to emulate the volume envelope of a note played on a piano for example, 
the Attack should be set to “0” and the Decay parameter should be set to a medium 
value, so that the volume gradually decreases down to silence, even if you keep hold-
ing the key down. Should you want the decay to drop to some other value than zero, 
you use the Sustain parameter.

Sustain

The Sustain parameter determines the level the envelope should rest at, after the De-
cay. If you set Sustain to full level, the Decay setting is of no importance since the vol-
ume of the sound is never lowered.

If you wanted to emulate the volume envelope of an organ, you theoretically only really 
need to use the Sustain parameter set to full level, as a basic organ volume envelope 
instantly goes to the maximum level (Attack “0”) and stays there (Decay “0”), until the 
key is released and the sound instantly stops (Release “0”). 

But often a combination of Decay and Sustain is used to generate envelopes that rise 
up to the maximum value, then gradually decreases to finally land to rest on a level 
somewhere in-between zero and maximum. Note that Sustain represents a level, 
whereas the other envelope parameters represent times.

Release

Finally, we have the Release parameter. This works just like the Decay parameter, ex-
cept it determines the time it takes for the value to fall back to zero after releasing the 
key.

Amplitude Envelope

The Amplitude Envelope is used to adjust how the volume of the sound should 
change from the time you press a key until the key is released. By setting up a volume 
envelope you sculpt the sound’s basic shape with the four Amplitude Envelope pa-
rameters, Attack, Decay, Sustain and Release. This determines the basic character of 
the sound (soft, long, short etc.).

Filter Envelope

The Filter Envelope affects the Filter 1 Frequency parameter. By setting up a filter en-
velope you control the how the filter frequency should change over time with the four 
Filter Envelope parameters, Attack, Decay, Sustain and Release. 

Attack
(time)

Decay
(time)

Sustain
(level)

Release
(time)

Key Down Key Up

Level

Time
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Filter Envelope Amount

This parameter determines to what degree the filter will be affected by the Filter Enve-
lope. Raising this knob’s value creates more drastic results. The Envelope Amount pa-
rameter and the set Filter Frequency are related. If the Filter Freq slider is set to 
around the middle, this means that the moment you press a key the filter is already 
halfway open. The set Filter Envelope will then open the filter further from this point. 
The Filter Envelope Amount setting affects how much further the filter will open.

Filter Envelope Invert

If this button is activated, the envelope will be inverted. For example, normally the De-
cay parameter lowers the filter frequency, but after activating Invert it will instead raise 
it, by the same amount. 

Mod Envelope

The Mod Envelope allows you to select one of a number of parameters, or Destina-
tions, to control with the envelope. By setting up a modulation envelope you control 
the how the selected Destination parameter should change over time with the four 
Mod Envelope parameters, Attack, Decay, Sustain and Release. 

The available Mod Envelope Destinations are as follows:

LFO Section

LFO stands for Low Frequency Oscillator. LFO’s are oscillators, just like Osc 1 & 2, in 
that they also generate a waveform and a frequency. However, there are two signifi-
cant differences:

• LFOs only generate waveforms with low frequencies.
• The output of the two LFO’s are never actually heard. Instead they are used for 

modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound generat-
ing) oscillator, to produce vibrato. Subtractor is equipped with two LFO’s. The param-
eters and the possible modulation destinations vary somewhat between LFO 1 and 
LFO 2.

LFO 1 Parameters

Waveform

LFO 1 allows you to select different waveforms for modulating parameters. These are 
(from top to bottom):

|Destination |Description
Osc 1 Selecting this makes the Mod Envelope control the pitch (frequency) 

of Osc 1.

Osc 2 Same as above, but for Osc 2.

Osc Mix Selecting this makes the Mod Envelope control the oscillator Mix pa-
rameter. Both oscillators must be activated for this to have any effect.

FM Selecting this makes the Mod Envelope control the FM Amount pa-
rameter. Both oscillators must be activated for this to have any effect.

Phase Selecting this makes the Mod Envelope control the Phase Offset pa-
rameter for both Osc 1 and 2. Note that Phase Offset Modulation 
(Subtraction or Multiplication) must be activated for this to have any 
effect (see page 189).

Freq 2 Selecting this makes the Mod Envelope control the Frequency param-
eter for Filter 2.

|Waveform |Description
Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted Saw-
tooth

This produces a “ramp up” cycle. If applied to an oscillator’s fre-
quency, the pitch would sweep up to a set point (governed by the 
Amount setting), after which the cycle immediately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but in-
verted.

Square This produces cycles that abruptly changes between two values, 
usable for trills etc.

Random Produces random stepped modulation to the destination. On some 
vintage synths, this is called “sample & hold”.

Soft Random The same as above, but with smooth modulation.
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Destination

The available LFO 1 Destinations are as follows:

Sync

By clicking this button you activate/deactivate LFO sync. The frequency of the LFO 
will then be synchronized to the song tempo, in one of 16 possible time divisions. 
When sync is activated, the Rate knob (see below) is used for setting the desired ti-
medivision.

Turn the knob and check the tooltip for an indication of the time division.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modulation 
rate.

Amount

This parameter determines to what degree the selected parameter destination will be 
affected by LFO 1. Raising this knob’s value creates more drastic results.

LFO 2 Parameters
LFO 2 is polyphonic. This means that for every note you play, an independent LFO cy-
cle is generated, whereas LFO 1 always modulates the destination parameter using 
the same “cycle”. This can be used to produce subtle cross-modulation effects, with 
several LFO cycles that “beat” against each other. This also enables LFO 2 to pro-
duce modulation rates that vary across the keyboard (see the “Keyboard Tracking” 
parameter below). 

Destination

The available LFO 2 Destinations are as follows:

LFO 2 Delay

This parameter is used to set a delay between when a note is played and when the 
LFO modulation “kicks in”. For example, if Osc 1 & 2 is selected as the destination pa-
rameter and Delay was set to a moderate value, the sound would start out unmodu-
lated, with the vibrato only setting in if you hold the note(s) long enough. Delayed LFO 
modulation can be very useful, especially if you are playing musical instrument-like 
sounds like violin or flute. Naturally it could also be used to control more extreme mod-
ulation effects and still retain the “playability” of the sound.

LFO 2 Keyboard Tracking

If LFO keyboard tracking is activated, the LFO rate will progressively increase the 
higher up on the keyboard you play. Raising this value creates more drastic results.

✪ If the LFO is set to modulate the phase offset, LFO keyboard tracking can 
produce good results. For example, synth string pads and other sounds 
that use PWM (see page 189) can benefit from this.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modulation 
rate.

Amount

This parameter determines to what degree the selected parameter destination will be 
affected by LFO 2. Raising this knob’s value creates more drastic results.

|Destination |Description
Osc 1&2 Selecting this makes LFO 1 control the pitch (frequency) of Osc 1 

and Osc 2.

Osc 2 Same as above, but for Osc 2.

Filter Freq Selecting this makes the LFO 1 control the filter frequency for Filter 
1 (and Filter 2 if linked). 

FM Selecting this makes the LFO 1 control the FM Amount parameter. 
Both oscillators must be activated for this to have any effect.

Phase Selecting this makes the LFO 1 control the Phase Offset parameter 
for both Osc 1 and 2. Note that Phase Offset Modulation (Subtrac-
tion or Multiplication) must be activated for this to have any effect 
(see page 189).

Osc Mix Selecting this makes the LFO 1 control the oscillator Mix parameter. 

|Destination |Description
Osc 1&2 Selecting this makes LFO 2 modulate the pitch (frequency) of Osc 1 

and Osc 2.

Phase Selecting this makes the LFO 2 modulate the Phase Offset parame-
ter for both Osc 1 and 2. Note that Phase Offset Modulation (Sub-
traction or Multiplication) must be activated for this to have any effect 
(see page 189). 

Filter Freq 2 Selecting this makes the LFO 2 modulate the filter frequency for Fil-
ter 2. 

Amp Selecting this makes the LFO 2 modulate the overall volume., to cre-
ate tremolo-effects.
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Play Parameters
This section deals with two things: Parameters that are affected by how you play, and 
modulation that can be applied manually with standard MIDI keyboard controls. 

These are:

• Velocity Control
• Pitch Bend and Modulation Wheel
• Legato
• Portamento
• Polyphony

Velocity Control

Velocity is used to control various parameters according to how hard or soft you play 
notes on your keyboard. A common application of velocity is to make sounds brighter 
and louder if you strike the key harder. Subtractor features very comprehensive veloc-
ity modulation capabilities. By using the knobs in this section, you can control how 
much the various parameters will be affected by velocity. The velocity sensitivity 
amount can be set to either positive or negative values, with the center position repre-
senting no velocity control. 

The following parameters can be velocity controlled:

|Destination |Description
Amp This let’s you velocity control the overall volume of the sound. If a pos-

itive value is set, the volume will increase the harder you strike a key. 
A negative value inverts this relationship, so that the volume de-
creases if you play harder, and increases if you play softer. If set to 
zero, the sound will play at a constant volume, regardless of how hard 
or soft you play. 

FM This sets velocity control for the FM Amount parameter. A positive 
value will increase the FM amount the harder you play. Negative val-
ues invert this relationship.

M. Env This sets velocity control for the Mod Envelope Amount parameter. A 
positive value will increase the envelope amount the harder you play. 
Negative values invert this relationship.

Phase This sets velocity control for the Phase Offset parameter. This applies 
to both Osc 1 & 2, but the relative offset values are retained. A posi-
tive value will increase the phase offset the harder you play. Negative 
values invert this relationship.

Freq 2 This sets velocity control for the Filter 2 Frequency parameter. A pos-
itive value will increase the filter frequency the harder you play. Nega-
tive values invert this relationship.

F. Env This sets velocity control for the Filter Envelope Amount parameter. A 
positive value will increase the envelope amount the harder you play. 
Negative values invert this relationship.

F. Dec This sets velocity control for the Filter Envelope Decay parameter. A 
positive value will increase the Decay time the harder you play. Nega-
tive values invert this relationship.

Osc Mix This sets velocity control for the Osc Mix parameter. A positive value 
will increase the Osc 2 Mix amount the harder you play. Negative val-
ues invert this relationship.

A. Attack This sets velocity control for the Amp Envelope Attack parameter. A 
positive value will increase the Attack time the harder you play. Nega-
tive values invert this relationship.
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Pitch Bend and Modulation Wheels

The Pitch Bend wheel is used for “bending” notes, like bending the strings on a guitar. 
The Modulation wheel can be used to apply various modulation while you are playing. 
Virtually all MIDI keyboards have Pitch Bend and Modulation controls. Subtractor fea-
tures not only the settings for how incoming MIDI Pitch Bend and Modulation wheel 
messages should affect the sound. Subtractor also has two functional wheels that 
could be used to apply real time modulation and pitch bend should you not have these 
controllers on your keyboard, or if you aren’t using a keyboard at all. The Subtractor 
wheels mirror the movements of the MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is turned fully up 
or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of parameters. 
You can set positive or negative values, just like in the Velocity Control section. The 
following parameters can be affected by the modulation wheel:

Legato
Legato works best with monophonic sounds. Set Polyphony (see below) to 1 and try 
the following:

D Hold down a key and press another key without releasing the previous.
Notice that the pitch changes, but the envelopes do not start over. That is, there 
will be no new “attack”. 

D If polyphony is set to more voices than 1, Legato will only be applied 
when all the assigned voices are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 note 
chord, the next note you played would be Legato. Note, however, that this Legato 
voice will “steal” one of the voices in the 4 note chord, since all the assigned 
voices were already used up!

Retrig
This is the “normal” setting for playing polyphonic patches. That is, when you press a 
key without releasing the previous, the envelopes are retriggered, like when you re-
lease all keys and then press a new one. In monophonic mode, Retrig has an addi-
tional function; if you press a key, hold it, press a new key and then release that, the 
first note is also retriggered.

Portamento (Time)
Portamento is when the pitch “glides” between the notes you play, instead of instantly 
changing the pitch. The Portamento knob is used to set how long it takes for the pitch 
to glide from one pitch to the next. If you don’t want any Portamento at all, set this 
knob to zero.

Setting Number of Voices - Polyphony

This determines the polyphony, i.e. the number of voices a Subtractor Patch can play 
simultaneously. This can be used to make a patch monophonic (=a setting of “1”), or 
to extend the number of voices available for a patch. The maximum number of voices 
you can set a Subtractor Patch to use is 99. In the (unlikely) event you should need 
more voices, you can always create another Subtractor!

! Note that the Polyphony setting does not “hog” voices. For example, if 
you have a patch that has a polyphony setting of ten voices, but the part 
the patch plays only uses four voices, this won’t mean that you are “wast-
ing” six voices. In other words, the polyphony setting is not something 
you need to consider much if you want to conserve CPU power - it is the 
number of voices actually used that counts.

|Parameter |Description
F. Freq This sets modulation wheel control of the Filter 1 Frequency parame-

ter. A positive value will increase the frequency if the wheel is pushed 
forward. Negative values invert this relationship.

F. Res This sets modulation wheel control of the Filter 1 Resonance param-
eter. A positive value will increase the resonance if the wheel is 
pushed forward. Negative values invert this relationship.

LFO 1 This sets modulation wheel control of the LFO 1 Amount parameter. 
A positive value will increase the Amount if the wheel is pushed for-
ward. Negative values invert this relationship.

Phase This sets modulation wheel control of the Phase Offset parameter for 
both Osc 1 and 2. Note that Phase Offset Modulation (Subtraction 
or Multiplication) must be activated for this to have any effect (see 
page 189). 

FM This sets modulation wheel control of the FM Amount parameter. A 
positive value will increase the FM amount if the wheel is pushed for-
ward. Negative values invert this relationship. Both oscillators must 
be activated for this to have any effect.
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About the Low Bandwidth button
This can be used to conserve CPU power. When activated, this function will remove 
some high frequency content from the sound of this particular device, but often this is 
not noticeable (this is especially true for bass sounds).

External Modulation

Subtractor can receive common MIDI controller messages, and route these to various 
parameters. The following MIDI messages can be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending Aftertouch messages, or if you have ac-
cess to an Expression Pedal or a Breath controller, you can use these to modulate pa-
rameters. The “Ext. Mod” selector switch sets which of these message-types should 
be received.

These messages can then be assigned to control the following parameters:

|Destination |Description
F. Freq This sets External modulation control of the Filter 1 Frequency pa-

rameter. A positive value will increase the frequency with higher ex-
ternal modulation values. Negative values invert this relationship.

LFO 1 This sets External modulation control of the LFO 1 Amount parame-
ter. A positive value will increase the LFO 1 amount with higher ex-
ternal modulation values. Negative values invert this relationship.

Amp This let’s you control the overall volume of the sound with external 
modulation. If a positive value is set, the volume will increase with 
higher external modulation values. A negative value inverts this rela-
tionship.

FM This sets External modulation control of the FM Amount parameter. 
If a positive value is set, the FM amount will increase with higher ex-
ternal modulation values. A negative value inverts this relationship. 
Both oscillators must be activated for this to have any effect.
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Connections

Flipping the Subtractor around reveals a plethora of connection possibilities, most of 
which are CV/Gate related. Using CV/Gate is described in the chapter “Routing Au-
dio and CV”.

Audio Output
This is Subtractor’s main audio output. When you create a new Subtractor device, 
this is auto-routed to the first available channel on the audio mixer.

Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the Subtractor from an-
other CV/Gate device (typically a Matrix or a Redrum). The signal to the CV input con-
trols the note pitch, while the signal to the Gate input delivers note on/off along with 
velocity.

! For best results, you should use the Sequencer Control inputs with 
monophonic sounds.

Modulation Inputs
! Remember that CV connections will not be stored in the Subtractor 

patch, even if the connections are to/from the same Subtractor device! 

These control voltage (CV) inputs (with associated voltage trim pots), can modulate 
various Subtractor parameters from other devices, or from the modulation outputs of 
the same Subtractor device. These inputs can control the following parameters:

• Oscillator Pitch (both Osc 1 & 2).
• Oscillator Phase Offset (both Osc 1 & 2).
• FM Amount
• Filter 1 Cutoff
• Filter 1 Res
• Filter 2 Cutoff
• Amp Level 
• Mod Wheel

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other param-
eters in the same Subtractor device. The Modulation Outputs are:

• Mod Envelope
• Filter Envelope 
• LFO 1

Gate Inputs
These inputs can receive a CV signal to trigger the following envelopes. Note that 
connecting to these inputs will override the normal triggering of the envelopes. For ex-
ample, if you connected an LFO output to the Gate Amp input, you would not trigger 
the amp envelope by playing notes, as this is now controlled by the LFO. In addition 
you would only hear the LFO triggering the envelope for the notes that you hold down. 
The following Gate Inputs can be selected:

• Amp Envelope
• Filter Envelope
• Mod Envelope
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Introduction

Thor is an advanced synthesizer with many unique features. 

The design could be described as semi-modular, in that the oscillator and filter sec-
tions are open slots that allow the user to select between various different oscillator 
and filter types, each with a distinct character. Some of these designs were inspired 
by selected vintage equipment.

As a result, Thor is capable of producing an astounding array of sounds. 

While it offers a lot of scope for serious sound modelling, it still has a basically simple 
and user-friendly interface.

In the extensive Modulation bus routing section both audio and control signals (CV) 
co-exist, and more or less any routing combination can be assigned. Use audio to 
modulate a CV signal or vice versa - Thor’s modulation capabilities are virtually limit-
less.

Thor also features an advanced step sequencer which can be used for creating mel-
ody lines or purely as a modulation source.

There are also audio inputs on the back panel. By connecting the output of another 
device to these inputs, you can use Thor’s filters, envelopes etc. to process the 
sound, or you can use the external audio source to modulate a Thor parameter. 

About basic synthesizer terminology

This chapter assumes familiarity with common synth terminology like oscillators, wave-
forms, filters and envelopes. If you are new to Reason (or these terms), you may want 
to read the Subtractor chapter first, where these elements and how they interact are 
described from a more basic point of view.

Thor elements
In the picture below an unfolded Thor device is shown. 

Thor’s user interface consists of the following elements (from the top down):

D The Controller panel, which is always shown if Thor is unfolded. 
See “The Controller panel”.

D The main Programmer panel contains all the synth parameters.
The Programmer can be shown/hidden by clicking the “Show Programmer” button 
on the Controller panel. See “Using the Programmer”.

D The Modulation bus routing section.
See “Modulation bus routing section”.

D The Step Sequencer section, where you can program up to 16 steps to 
produce short melody lines/grooves or use it as a modulation source.
See “Step Sequencer”.
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The Controller panel

The Controller panel contains standard Master Volume and Pitch and Mod controls, 
Keyboard Mode/Note Triggering sections and four virtual (freely assignable) controls. 
The panel also has a patch display and standard Select/Browse/Save patch buttons 
(these are always shown even if Thor is folded).

The Keyboard Mode section

In this section you make basic keyboard related settings for a patch. It has the follow-
ing options:

Note Triggering section

Using the buttons in this section you can select in what way Thor will respond: 

• Via note input only.
• Via the Step Sequencer only (see “Step Sequencer”).
• Or both. 

The section also has a standard Note On indicator.

About the virtual controls

D The rotary knobs and buttons in the Controller panel are “virtual” con-
trols that can be assigned to multiple parameters and functions in Thor. 

• You assign parameters to the knobs and buttons in the Modulation Routing panel 
(these are located on the “Modifiers” sub-menu - see “Modulation bus routing sec-
tion”). 

• Movements of the virtual controls can be recorded as automation. 
• Each control can be assigned to any number of parameters.
• Clicking on the label for a Rotary or Button lets you type in an appropriate name for 

it.

About the button key note function

To the right of the two virtual buttons there are corresponding spin controls and dis-
plays. These can be used to assign a key for turning the button on momentarily, as 
long as the key is held down.

D Use the spin controls (or click in the display and move the mouse up or 
down) to assign a key for the button status.
The assigned key will now turn the function(s) assigned to the button on for as 
long the key is held down. 

D Note that the key note function can only switch from off to on, not the 
other way around, so make sure the button is deactivated if you wish to 
use this function.
An assigned key will not trigger a note, only the button status. Also note that the 
button will not light up when you press the assigned key.

|Function |Description
Polyphony This setting determines the number of voices that you can play si-

multaneously when Polyphonic mode is selected. The maximum 
number of voices is 32.

Release 
Polyphony

This governs the number of voices that are allowed to naturally de-
cay/ring out (in the release phase of the envelope) when new notes 
are triggered and Polyphonic mode is selected. E.g. if you set this 
to “0”, any new note(s) will cut off the release of any previously trig-
gered notes. 

Mono Legato Mono Legato mode is monophonic regardless of the Polyphony 
setting. It works as follows:
• Hold down a key and then press another key without releasing 

the previous.
Notice that the pitch changes, but the envelopes do not start 
over. That is, there will be no new “attack”. 

Mono Retrig Mono Retrig is also monophonic and this mode means that when 
you press a key the envelopes are always retriggered.

Polyphonic This is the standard polyphonic play mode - you can play the num-
ber of voices set with the Polyphony parameter.

Portamento On/
Off/Auto

The knob is used for controlling portamento - a parameter that 
makes the pitch glide between the notes you play, rather than 
changing the pitch instantly as soon as you hit a key on your key-
board. By turning this knob you set how long it should take for the 
pitch to glide from one note to the next as you play them. There are 
three basic portamento modes:

• In Auto mode, there will only be any portamento when playing 
more than one note. If any of the Mono modes is selected, por-
tamento will only affect the legato notes.

• When set to On, portamento is applied to all notes.
• Off means no portamento.

|Function |Description
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The Pitch Bend and Modulation wheels

• The Pitch and Mod wheels on the Controller panel will mirror the corresponding 
actions on your master keyboard. 

• The Range parameter (like for all instrument devices) sets the range of the Pitch 
Bend action.

• Pitch Bend is pre-wired to the pitch parameter of the three oscillators, but you can 
of course use it to control any parameter you like. If you don’t want Pitch Bend to 
affect oscillator pitch, simply set the Range parameter to “0”.

Master volume

This is the main volume control for outputs 1 & 2.

Using the Programmer
The Programmer contains the main synth parameters. 

D To show the Programmer panel, click the “Show Programmer” button on 
the Controller panel.
The Programmer appears below the Controller panel.

D The Programmer panel is divided into two sections; the Voice section to 
the left and the Global section to the right. The Global section has a sep-
arate brown panel to differentiate it from the Voice section.
The Voice section contains the basic synth parameters and the parameters are 
“per-voice”, i.e. all envelope and LFO cycles are triggered individually for each 
voice. The Global section to the right contains global parameters that affect all 
voices.
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D There are three open Oscillator slots, a Mixer, two open Filter slots, a 
Shaper, three Envelope generators, an LFO and an Amplifier in the Voice 
section.
The open Oscillator and Filter slots allow you to select between different types of 
oscillators and filters.

D The Global section contains a second LFO, a Global Envelope, a third 
open Filter slot and Chorus and Delay effects.

Basic connections - a tutorial
There are certain pre-defined connections available between the Oscillator 1-3 slots 
and the Mixer, Filter 1/Shaper, Filter 2 and Amp sections. On the panel itself, lines 
with arrows are shown to indicate the standard signal paths. 

✪ Note that you can also connect sections using the Modulation bus sec-
tion (see “Modulation bus routing section”). You are not in any way lim-
ited to the pre-defined routings, but they do provide a quick and 
convenient way to connect the basic synth “building blocks” together.

In the following tutorial we will create a standard setup using two oscillators and two 
filters to demonstrate Thor basics and the (standard) signal path:

1. Select “Initialize Patch” from the Edit menu.
The Init patch is a basic setup with an Analog oscillator in Oscillator slot 1 and a 
Ladder LP filter in Filter slot 1 loaded. A connection between Oscillator 1, Filter 1 
and the Amp section is already activated, so you get a sound when you play.

Below the Oscillator 1 slot in the upper left corner are two more slots, currently 
empty. These are the Oscillator 2 and 3 slots, respectively. The three Oscillator slots 
are basically identical in that they can each be loaded with one of 6 oscillator types. 

2. Click the arrow pop-up in the upper left corner of the Oscillator 2 slot, and 
select a second oscillator from the pop-up that appears.
The following oscillator types are available; Analog, Wavetable, Phase Modulation, 
FM Pair, Multi and Noise. For a description of the various oscillator types see page 
206.

Selecting oscillator type.

With a basic connection setup, the Oscillator outputs are internally connected to the 
“Mix” section. To pass the output signal onwards in the signal chain, you first have to 
activate a connection. This is done using the two vertical rows of routing buttons la-
belled 1, 2 and 3 to the right of the Oscillator section.

D The upper row of routing buttons determine which of the Oscillators 1 to 
3 are routed to Filter 1, and the lower row which of the Oscillators 1 to 3 
are routed to Filter 2. 
All three oscillators can be simultaneously routed to both filters, serially or in paral-
lel (or any combination of these variations). This is explained later in this tutorial.

By activating one or more of these buttons means that the oscillator (1 to 3) is routed 
to the corresponding Filter. Currently, Oscillator 1 is connected to Filter 1 slot (which 
is pre-loaded with a Ladder LP filter). 

This is indicated by the “1” routing button being lit. The Filter 2 slot is currently not ac-
tive, which is indicated by a blank panel.

3. Click the “2” button to the left of the Filter 1 section so that it lights up to ac-
tivate a connection for Oscillator 2.
Now if you play a few notes you should hear both Oscillator 1 and Oscillator 2, via 
the Filter 1 section.
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D The Filter 1 output passes via the Shaper (currently not activated), on to 
the Amp section, and finally to the Main Outputs.
Actually, the Amp section output is routed via the Global section before being sent 
to the Main Outputs, but as currently nothing is activated in the Global section the 
signal passes through unprocessed.

4. Next, click the arrow pop-up in the upper left corner of the Filter 2 slot.
A pop-up menu with the four available Filter types appears. For a description of the 
filter types, see “Filter slots”.

5. Select a type of filter, e.g. a Comb filter for the Filter 2 slot.
Now that the Filter 2 slot in the Voice section is active, you can connect the oscil-
lators to it by using the lower row of routing buttons. 

6. Click the routing buttons “1” and “2” to the left of the Filter 2 slot so that the 
buttons are lit.
Now the two oscillators are connected to Filter 2. 

7. Make sure the arrow routing button that points to the Amp section just above 
the Filter 2 section is activated.
Now if you play a few notes, both oscillators are routed via both filter sections in 
parallel. You could of course select to pass only one of the oscillators via one filter 
and both oscillators via the other - any combination is possible.

You can also connect the Filter 1 and 2 sections serially, meaning that the output of 
Filter 1 is passed through Filter 2 before reaching the Amp section. This is done as 
follows:

8. Switch off the routing buttons “1” and “2” to the left of the Filter 2 slot. 
If you leave them on the oscillators will pass through Filter 2 twice; both via Filter 1 
and directly. This is also perfectly “allowable”, but to make things clearer in this tu-
torial we will use a standard serial filter setup.

9. Click the Arrow “left” button below the Shaper.
Now the filters are connected serially, with the output of Filter 1 (via the for now in-
active Shaper) being connected to the Filter 2 input. Both oscillators are pro-
cessed by both filters connected in series.

That concludes this tutorial on how the pre-wired connections in the Voice section 
can be used, but note that you can also use the Modulation bus to make connections 
- see “Modulation bus routing section”.

Other pre-defined routing assignments

There are other sections in Thor which are pre-defined and can be used without hav-
ing to make any prior assignments:

D The Amp Envelope and the Filter Envelope control the volume level and 
frequency of the Filters (1 & 2), respectively.
The amount of filter envelope control is controllable by using the “Env” parameter 
in each Filter section.

D The effects (Delay/Chorus) in the Global section are part of the signal 
chain and can simply be switched on and used.

The Oscillator section

Oscillators generate the basic raw sound (pitch and waveform) that can in turn be 
processed by the other parameters. The Oscillator section contains three open slots 
which can each be loaded with one of six oscillator types. The three Oscillator slots 
are numbered 1-3, with the top slot housing Oscillator 1, the middle slot Oscillator 2 
and the bottom slot Oscillator 3.
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D The Arrow button in the top left corner of each slot opens a pop-up menu 
where an oscillator type can be selected for the corresponding slot.

There are six Oscillator types available:

• Analog
• Wavetable
• Phase Modulation
• FM Pair 
• Multi Oscillator
• Noise 

You can also select Off mode (no oscillator).

Common parameters

The specific parameters of the various oscillator types are described separately, but 
there are also common parameters that apply to all oscillator types. These are:

D Octave (OCT) knob - this changes the pitch of the oscillator in octave 
steps. 
The range is seven octaves.

D The Semi knob changes the pitch of the oscillator in semi-tone steps.
The range is 12 semitone steps (1 octave).

D The Tune knob fine tunes the pitch of the oscillator in cent steps. 
The range is +/- 50 cents (down or up half a semitone).

D Keyboard Track (KBD) - this knob sets how much the oscillator pitch 
tracks incoming note data. 
Turned fully clockwise the pitch tracks the keyboard normally, i.e. a semitone per 
key. 

D All oscillators also have waveform selectors and a modifier parameter. 
How the waveform selection works, and what parameter is the modifier 
varies according to the selected oscillator type.

D Important to note is that if you have made a modulation routing to an os-
cillator parameter e.g. the modifier, and then change the oscillator type, 
the modulation will be transferred to the corresponding parameter in the 
new oscillator.
The same goes for all common parameters (tuning and tracking). If you switch os-
cillator type, all common parameters are left unchanged.

D Oscillators can be synced - see “About Oscillator Sync”.

D Any oscillator type loaded into the Oscillator 1 slot can also be amplitude 
modulated by Oscillator 2 - see “About Amplitude Modulation (AM)”.

Analog oscillator

This is a classic analog oscillator with 4 standard waveforms. The waveform selector 
button is in the lower left corner of the oscillator panel, but you can also click directly 
on the waveform symbols to switch waveform. The four available waveforms are from 
the top down (as displayed on the panel): Sawtooth, Pulse, Triangle and Sine.

D The Mod parameter (PW) controls pulse width and only affects the pulse 
waveform. 
By modulating the PW parameter the width of the pulse wave changes, allowing 
for PWM (Pulse Width Modulation) which is a standard feature in most vintage an-
alog synths. 

✪ For a perfect square wave, set pulse width (PW) to 64.

Wavetable oscillator

Wavetable oscillators has been the basis of several vintage synths (PPG, Korg 
Wavestation and many others). 

• With the Wavetable oscillator, you select between 32 wavetables, where each 
wavetable contains several (up to 64) different waveforms. By using an envelope 
or a LFO you can sweep through a wavetable to produce timbre variations. 

The parameters are as follows:

D Position is the modifier (Mod) parameter and controls the position 
within the selected wavetable, i.e. which waveform is active at a given 
time.
By modulating the Position you can sweep through the waveforms in the selected 
wavetable. You can of course also use a single static waveform in a wavetable if 
you so wish, by not applying any modulation to this parameter.

D The X-Fade button determines whether the change between waveforms 
in a wavetable should be abrupt (X-Fade off), or smooth (X-Fade on).
If set to on, the waveform transitions are cross-faded.
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D There are 32 wavetables that can be selected using the up/down buttons 
or by clicking in the Wavetable display.

Some of the wavetables have waveforms that sequentially follow the harmonic series, 
i.e. each following waveform adds a harmonic. Others have waveform series that pro-
duce a sound similar to oscillator sync when swept, and other wavetables are simply 
mixed waveforms. The last 11 wavetables are based on wavetables used in the origi-
nal PPG 2.3 synthesizer.

Phase Modulation oscillator

The Phase Modulation oscillator is inspired by the Casio CZ series of synthesizers. 
Phase modulation is based on modiulating the phase of digital waveforms to emulate 
common filter characteristics. 

D You have a First and Second waveform which can be combined. Instead 
of mixing the two waveforms they are played in series, one after the 
other. 
This adds a fundamental one octave below the pitch of the original sound. 

D The PD parameter (Mod) changes the shape of the wave, much like a fil-
ter does.

The following waveforms (sequentially from the first) are available as the First wave-
form:

• Sawtooth
• Square
• Pulse
• Pulse and Sine
• Sine and flat (half sine)
• Saw x Sine
• Sine x Sine
• Sine x Pulse

The last three waveforms could be described “resonant”, as these originally were 
meant to simulate filter resonance. They didn’t really do this very accurately, but nev-
ertheless constituted an important part of the sound.

The Second waveform has the same available waveforms except the last three, and it 
can also be bypassed altogether. You can combine waveforms freely, except it is not 
possible to combine two “resonant” waveforms. 

FM Pair oscillator

As the name implies, this oscillator generates FM, where one oscillator (Carrier) is fre-
quency modulated by a second oscillator (Modulator). Although very simple to use 
(unlike most hardware FM synths), this oscillator can produce a very wide range of FM 
sounds.

D The Carrier and Modulator selector buttons set the frequency ratio be-
tween these two oscillators (the range is 1-32).
The frequency ratio is what determines the basic frequency content, and thus, the 
timbre of the sound. 

D The FM knob sets the amount of frequency modulation. 
This is also the Modifier parameter. If FM amount is set to zero, there is no FM and 
the output will be a pure sine wave. 

• If you set FM Amount to zero and step through the values of the Carrier oscillator, 
you can hear that the pitch is changed according to the harmonic series. 

• Stepping through the Mod oscillator values will change the pitch in the same way, 
although FM Amount has to be set to a value other than zero to be able to hear it. 

Thus, 2:2 is the same wave shape as 1:1 but one octave higher in pitch, 3:3 is the 
same wave shape as 2:2 but a fifth higher in pitch and so on.
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Multi oscillator

This versatile oscillator can simultaneously generate multiple detuned waveforms (of a 
set type) per voice. It is great for producing complex timbres e.g. to simulate cymbal 
or bell sounds, but can also generate a wide range of harmonic sounds.

D The following basic waveforms are available: Sawtooth, Square, Soft 
Sawtooth, Soft Square, Pulse.
You switch waveforms using the button in the lower left corner, or by clicking di-
rectly on the waveform symbol.

D The Amount (AMT) parameter governs the amount of detune.
Turn clockwise for more detune. This is also the modifier (Mod) parameter. Using 
low Amount settings can produce subtle detune variations that makes the sound 
shift and move endlessly, like an advanced chorus effect, whereas higher Amount 
settings can produce wild, detuned timbres.

D The Detune Mode parameter sets the basic operational mode of the de-
tuning.
If Amount is set to 0, only the “Octave” and “Fifth” Detune modes actually change 
the sound, as these modes start off with dual waveforms tuned one octave and a 
fifth apart, respectively. The “Fifth Up” and “Oct UpDn” modes detune waveforms 
as the names imply between zero to full Amount settings. “Linear” will change the 
amount of detune according to where on the keyboard you play; in lower keyboard 
ranges the amount of detune is stronger than in higher keyboard ranges and vice 
versa. The other modes (Interval and Random) basically add multiple waveforms 
and detune them in various ways that will produce different results.

Noise oscillator

The Noise oscillator can not only produce white and colored noise, but can also be 
used either as a pitched oscillator or as a modulation source.

It has the following basic parameters:

D There is a single Noise parameter (apart from the standard tuning and 
kbd track knobs). 
This is the Noise modifier parameter, that controls different parameters depending 
on the selected Oscillator mode, see below.

D The Waveform selector button in the bottom left corner is used to set the 
Oscillator mode. 
The following modes are available:’

|Mode |Description
Band In this mode, the Oscillator knob controls bandwidth. Turned fully clock-

wise, the oscillator produces pure noise. Turning the knob counter-clock-
wise gradually narrows the bandwidth until a pitch is produced. The pitch 
will track the keyboard normally if the keyboard (KBD) knob is set fully 
clockwise.

S/H S/H stands for “sample and hold”, which is a type of random generator. 
The Oscillator knob controls the rate of the sample and hold. With high 
Oscillator knob settings, it produces colored noise with a slightly 
“phased” sound quality. With lower rate settings you can use the oscilla-
tor as a modulation source like a LFO with random values. For example, if 
you modulate the pitch of another oscillator using S/H with a low Rate 
setting as the source, you will get stepped random modulation of the 
pitch.

Static As the name implies, this can generate the sound of static interference if 
you use low Oscillator settings. The Oscillator parameter controls Den-
sity, i.e. the amount of static. High Density settings generates noise.

Color This produces colored noise, which is basically noise where certain fre-
quency areas are filtered, i.e. cutting or boosting certain frequency areas 
in the noise. The Oscillator knob controls Color. With a maximum Color 
setting you get white noise, and lower settings produces noise emphasiz-
ing lower frequencies.

White This produces pure white noise, where all frequencies have equal energy. 
There is no associated Oscillator parameter for White noise.
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About Oscillator Sync

Oscillator sync is when one oscillator will restart the period of another oscillator, so 
that they will have the same base frequency. If you change or modulate the frequency 
of the synced oscillator you get the characteristic sound associated with oscillator 
sync.

A synced oscillator that resets the other oscillator(s) is called the master, and any 
synced oscillator that is reset by an other oscillator is called a slave. In Thor, oscillator 
1 is the master, i.e. this controls the base pitch of the oscillators, and oscillators 2 and 
3 are slaves.

D You switch Oscillator sync on or off by activating the Sync buttons to the 
left of Oscillator slots 2 and 3.

D The Sync “BW” sliders to the left of Oscillator slots 2 and 3 allows you to 
adjust the sync bandwidth.
This allows you to change the character of the oscillator sync. The parameter basi-
cally sets how abrupt the reset is - high bandwidth settings produces a more pro-
nounced sync effect and vice versa. The picture above illustrates high bandwidth 
reset - if lower bandwidth settings are used the slave osc curve will be more 
rounded at the reset points.

About Amplitude Modulation (AM)

AM (Amplitude Modulation) is often referred to as ring modulation. AM works by mul-
tiplying two signals together. 

D In Thor, Oscillator 2 amplitude modulates Oscillator 1. 
The Ring Modulated output will then contain added frequencies which are gener-
ated by the sum of, and the difference between the two signals. This can be used 
for creating complex, enharmonic sounds.

D The amount of AM is set using the slider to the left of the Oscillator 1 
slot.

Mix section

The Mix section allows you to adjust the levels and the relative balance of the three os-
cillators. 

D The two sliders controls the output levels of oscillators 1-2 and oscillator 
3, respectively.

D The Balance knob sets the balance between oscillator 1 and 2.
The Balance parameter is also a modulation destination, allowing you to modulate 
the balance of the two oscillators with e.g. an LFO. Note that the oscillators have 
to be connected to the filter(s) via the numbered routing buttons for the Mix sec-
tion settings to have any effect.

Master oscillator

Slave oscillator
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Filter slots

Thor has three open Filter slots, two in the Voice section (which act per-voice) and 
one in the Global section which is global for all voices (see “Global Filter slot”). 

D You select (or change) filter type for a slot by clicking the arrow button in 
the top left corner of a slot.
On the pop-up you can select between 4 filter types and bypass mode. Available 
filter types are Ladder LP, State Variable, Comb and Formant, each described 
separately below.

The following general rules apply:

D Filters are pre-wired to the Filter Envelope (see “Filter Envelope”).
• Filters 1 & 2 can be used serially (i.e. the output of Filter 1 goes (via the Shaper) to 

the input of Filter 2, or in parallel (meaning that one signal goes to Filter 1 and an-
other to Filter 2). 

The pre-defined routings of the three oscillators into the Filter 1-2 sections is de-
scribed in the “Basic connections - a tutorial” passage.

Common parameters

As with the open oscillator slots, there are certain parameters which are common for 
all filter types. 

These are as follows:

D All the filter types have large knobs for the filter frequency (FREQ) pa-
rameter and the filter resonance (RES) parameter.
This works slightly differently for the Formant filter - see “Formant filter”.

D The “KBD” parameter sets how the filter frequency tracks incoming note 
pitch data.
Some filter types (Ladder/State Variable/Comb) can “self oscillate” and be used 
as extra oscillator sources.

D The “ENV” parameter sets how much the filter frequency responds to the 
Filter Envelope.

D The “VEL” parameter sets how much incoming note velocity affects the 
Filter Envelope Amount.
In other words, for this parameter to have any effect it requires that the “ENV” pa-
rameter is set to a value other than zero. 

D The “INV” button inverts how the filter frequency responds to Envelope 
settings.

D The “Drive” parameter allows you to adjust the input gain to the filter.
By driving the filter harder you can add further character to the sound. 

D Any parameter settings, as well as any modulation assigned to parame-
ters, will be kept even if you change the filter type. 

Ladder LP Filter

The Ladder LP filter is a low-pass filter inspired by the famous voltage controlled filter 
patented by Dr. Robert Moog in 1965. The name originates from the ladder-like shape 
of the original transistor/capacitor circuit diagram. 

The original filter also had certain non-linear characteristics which contributed to the 
warm, musical sound it is renowned for. These characteristics are faithfully repro-
duced in the Ladder LP filter. 

There is also a built-in shaper in the feedback (self-oscillation) loop. If self-oscillation is 
activated (see below), the shaper will distort the sound to produce these non-linear 
characteristics. To adjust the intensity of this distortion you use the Drive parameter. 

D There are 4 different Filter slopes available; 24, 18, 12 and 6 dB/oct.
24dB slope comes in two different types:

• Type I - The shaper (controlled with the Drive parameter) is placed at the filter out-
put but before the feedback loop.

• Type II - The shaper (controlled with the Drive parameter) is placed at the filter in-
put after the feedback loop.

Note that “Self Osc” (see below) must be activated for the shaper to operate.

D This filter can self-oscillate and will produce a playable note pitch with 
high Resonance settings if this is activated.
Self-oscillation can be switched on or off by using the “SELF OSC” button. The 
“KBD” knob governs how the frequency tracks the keyboard, turned fully clock-
wise will produce 12 semitones/octave tracking.
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State Variable Filter

This is a multi-mode filter which offers 12 dB/octave slope Lowpass (LP), Bandpass 
(BP), Highpass (HP), plus Notch and Peak filter modes which are sweepable be-
tween HP/LP states, similar to the vintage Oberheim SEM filter.

The filter modes are as follows:

D LP 12 (12 dB lowpass)
Lowpass filters let low frequencies through and cut off high frequencies. This filter 
type has a 12dB/Octave slope.

D BP 12 (12 dB bandpass)
Bandpass filters cut both high and low frequencies, leaving the frequency band in 
between unaffected. Each slope in this filter type is 12 dB/Octave.

D HP 12 (12 dB highpass)
Highpass filters let high frequencies pass and cut off low frequencies. This filter 
type has a 12dB/Octave slope.

D The “Notch” and “Peak” filter modes employ a combination of two out-
puts from the same filter combining LP and HP set to the same the filter 
frequency.
The “LP/HP” knob associated to these two filter modes can modulate the state of 
the filter from low-pass to high-pass. If the knob is in the mid-position, you get a 
Peak or Notch filter slope (depending on the mode). The HP/LP parameter can be 
assigned as a modulation destination.

D This filter can self-oscillate and will produce a pitch with high Resonance 
settings if this is activated.
Self-oscillation can be switched on or off by using the “SELF OSC” button. The 
“KBD” knob governs how the frequency tracks the keyboard, turned fully clock-
wise will produce 12 semitones/octave tracking.

Comb filter

The Comb filter can add subtle pitch variations and phasing-like effects to sounds.

D Comb filters are basically very short delays with adjustable feedback 
(controlled with the Resonance knob). 
A comb filter causes resonating peaks at certain frequencies. Comb filters are 
used in various signal processing devices like flangers, and produces a character-
istic swooshing sound when the frequency is swept.

D The difference between the “Comb +” and “Comb –” modes is the posi-
tion of the peaks in the spectrum. 
The main audible difference is that negative Comb mode causes a bass cut.

D The Resonance parameter in both cases controls the shape and size of 
the peaks.
This filter will produce a pitch with high Resonance settings combined with low 
frequency settings.

Formant filter

The Formant filter type can produce vowel sounds. There are no Frequency or Reso-
nance parameters, instead you have a horizontal “X” parameter slider and a vertical 
“Y” parameter slider that operate together to produce the various filter formant char-
acteristics.

D You can alter the settings of both the “X” and “Y”parameters simulta-
neously by moving the “dot” inside the gray rectangle on the filter panel.
Horizontal movement changes the “X” parameter, and vertical movement the “Y” 
parameter.
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D The ENV-VEL-KBD knobs affect the “X” parameter.
The parameter can be CV controlled.

D The “Gender” parameter changes the basic timbre of the vowel genera-
tion between male (low Gender settings) and female (high Gender set-
tings) voice characteristics.
Gender can also be CV controlled.

Shaper
Waveshaping is a synthesis method for transforming sounds by altering the waveform 
shape, thereby introducing various types of distortion. The Shaper can radically trans-
form the sound or just add a little warmth, depending on the mode and other settings.

D The Shaper input is taken from the Filter 1 output.
You can also route other sources directly to the Shaper in the Modulation section.

D The Shaper is activated with the button in the top left corner of the sec-
tion.

D The Drive parameter sets the amount of waveshaping.
Tip: By raising the Filter 1 Drive parameter you can add even more grit and distor-
tion to the Shaper output.

D The Shaper has 9 modes, selectable with the spin controls or by clicking 
in the Mode display, all which distort the waveform in various different 
ways.
These modes are; Soft and Hard clip, Saturate, Sine, Bipulse, Unipulse, Peak, 
Rectify and Wrap. Exactly how the various modes affect the sound depends on 
many factors, and there is a slightly random element to the resulting distortion. We 
recommend simply trying the different modes to hear what happens - many inter-
esting types of distortion of the original signal are guaranteed!

Amp section

The Amp (amplifier) section has two inputs (from Filter 1 & 2) and one output that is 
routed to the Global section (and on to the Master Level and the Main Outputs). 

D The Gain knob controls the level and the Velocity knob controls the Gain 
modulation, i.e. how much velocity affects the level - positive values 
means that you get higher level the faster you strike a key. 

D The Pan knob controls the relative stereo position of the individual 
voices.
By applying modulation to this parameter, you can make individual voices appear 
in different stereo positions when you play.

LFO 1

An LFO (Low Frequency Oscillator) is used for generating cyclic modulation. A typical 
example is to have an LFO modulate the pitch of an oscillator to produce vibrato, but 
there are countless other applications for LFOs.

D LFO 1 will apply modulation polyphonically. 
I.e. if LFO 1 modulation of a parameter is assigned, an individual LFO cycle will be 
triggered for each note you play.

D You select a LFO waveform by using the spin controls beside the wave-
form display, or by clicking in the display and moving the mouse up or 
down.

The following parameters are available for LFO 1:

|Parameter |Description
Rate This sets the frequency or rate of the LFO.

Waveform This sets the LFO waveform. Apart from standard waveforms 
(sine, square etc.) there are various different random, non-linear 
and stepped waveforms. The shape of the waveforms are shown 
in the display, and these shapes basically reflect how a signal is 
affected. 

Delay This introduces a delay before the LFO modulation onset after a 
note is played. Turn clockwise for longer delay.

KBD Follow This determines if (or how much) the Rate parameter is affected 
by note pitch. If you turn the knob clockwise, the modulation rate 
will increase the higher up on the keyboard you play.

Key Sync As explained previously, LFO 1 is polyphonic and will produce a 
separate LFO cycle for each note played. If Key Sync is off, the 
cycles are free running, meaning that when you play a note the 
modulation may start anywhere in the LFO waveform cycle. If 
Key Sync is on, the LFO cycles are reset for each note played.

Tempo sync If this is on, the Rate will be synced to the sequencer tempo. 
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Envelope sections

There are three Envelope generators in the Voice section. These are the Amp enve-
lope, the Filter envelope and the Mod envelope. Each voice played has a separate en-
velope. There is also an additional Global Envelope which is described separately - 
see page 215.

D The Filter envelope is pre-wired to control the frequency of Filter 1 and 2.
Note that envelope control of filter frequency can be switched off in each Filter 
section (the Env parameter can be set to 0), so the Filter Envelope can be used to 
control other parameters as well.

D The Amp Envelope is pre-wired to control the amplitude (volume).
Similarly, the Amp envelope can also be used to control other parameters, but in 
the Voice section you cannot switch off or bypass the Amp Envelope - if no voice 
is active (i.e. if there is no gate trigger input to the Amp envelope) there will be no 
output from oscillators or any external audio source routed to the Voice section.

D The Mod Envelope can be freely assigned to control parameters.
This is done in the Modulation section.

Filter Envelope

The Filter Envelope is a standard ADSR envelope as used in the Subtractor. 

D By setting up a filter envelope you control the how the filter frequency or 
some other parameter should change over time with the four parame-
ters, Attack, Decay, Sustain and Release. 
Please refer to the Subtractor chapter for a description of these parameters. 

D The “Gate Trig” button can be used to switch off the envelope triggering 
from notes (which is the normal mode) and allow the envelope to be trig-
gered by some other parameter.
“Gate Trig” should normally be activated.

D The time ranges of each step are as follows:
Attack: 0 ms - 10,3 s / Decay and Release: 3 ms - 29,6 s. Sustain is not set as a 
time but as a level (from Off to 0dB).

Amp Envelope

The Amp Envelope is also a standard ADSR envelope. 

D By setting up a Amp envelope you control the how the amplitude or 
some other parameter should change over time with the four parame-
ters, Attack, Decay, Sustain and Release. 
Please refer to the Subtractor chapter for a description of these parameters. 

D The “Gate Trig” button can be used to switch off the envelope triggering 
from note input (which is the normal mode) and allow the envelope to be 
triggered by some other parameter.
“Gate Trig” should normally be activated.

D The ranges of each step are the same as for the Filter envelope.

Mod Envelope

This is a general purpose ADR (Attack, Decay, Release) envelope with a pre-delay 
stage before the Attack phase. The Delay to Decay phase can also be looped. Apart 
from standard Attack, Decay and Release stages the Mod Env has the following pa-
rameters:

|Parameter |Description
Delay This can set a delay before the onset of the envelope.

Loop If this is activated, the envelope phase from Delay to Decay 
will continuously loop.

Tempo Sync If this is on, each stage will have a length that corresponds 
to beat increments of the current sequencer tempo. E.g. you 
can have a 1/4 delay before a 1/16 attack phase followed 
by a 1/8 decay. Each stage can be set a range from 1/32 to 
4/1 (4 bars).
If this is off, the envelope times are free running and can be 
set in seconds (same time ranges as for the Filter Envelope).

Gate Trigger The “Gate Trig” button can be used to switch off the enve-
lope triggering from notes (which is the normal mode) and 
allow the envelope to be triggered by some other parameter. 
“Gate Trig” should normally be activated.
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Global section

The Global section contains parameters that affect all voices. It contains two effects, 
an open filter slot, the Global Envelope and LFO 2.

Effects section

There are two global mono in/stereo out effects, a Delay and a Chorus. These effects 
affect all voices coming from the Amp section equally if activated. The effects are 
placed after the Global Filter in the signal chain.

D There are controls for standard Delay/Time and Feedback parameters.
Chorus vs. Delay differ only in the delay time range - Chorus is for chorus effects, 
i.e. short delays, whereas Delay produces echo effects.

D Delay Time can be Tempo Synced.
This is set with the Tempo Sync button - if on the delay time is set in beat resolu-
tions synced to the main sequencer tempo.

D The Delay and Chorus effects can also be pitch modulated by a built in 
LFO (the “Mod” parameters).
“Rate” controls LFO speed and “Amount” the Stereo width.

D Dry/Wet governs the balance between the unprocessed (dry) signal and 
the effect (wet) signal.

Global Filter slot

This is the Filter 3 slot which can be loaded with one of the filter types. Filter 3 is ba-
sically set up as the other filter slots. The difference is that all voices are mixed to-
gether before entering the filter. The “ENV” parameter governs modulation by the 
Global Envelope. If you play one note the filter envelope will trigger. Adding new notes 
while a note is still held down (legato) will not trigger the filter envelope.

See “Filter slots” for a description of the filter types.

Global Envelope

The Global Envelope 4 is an advanced envelope that is free to use for whatever pur-
pose, but remember it is “single trigger” so it will not retrigger legato notes as ex-
plained above. It is an ADSR envelope with a pre-delay stage and a hold stage before 
the decay phase. You can make it Loop and Sync the time settings to the song tempo. 

Apart from standard ADSR parameters, the Global Envelope has the following param-
eters:

|Parameter |Description
Delay This can set a delay before the onset of the envelope.

Loop If this is activated, the envelope phase from Delay to Decay 
will continuously loop.

Hold This allows you to set a “hold” phase before the Decay. 

Tempo Sync If this is on, each stage will have a length that corresponds 
to beat increments of the current sequencer tempo. E.g. you 
can have a 1/4 delay before a 1/16 attack phase followed 
by a 1/8 decay. Each stage can be set a range from 1/32 to 
4/1 (4 bars).
If this is off, the envelope times are free running and can be 
set in seconds (same time ranges as for the Filter Envelope). 

Gate Trigger The “Gate Trig” button can be used to switch off the enve-
lope triggering from notes and allow the envelope to be trig-
gered by some other parameter. This button is normally 
activated.
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LFO 2

D The LFO 2 is a standard LFO but is not polyphonic like LFO 1. It is not as-
signed to any parameter in an “Init” patch so you have to use the Modu-
lation Routing section to use it.

• Also the LFO 2 “Delay” and “Key Sync” parameters are single trigger, i.e. the LFO 
will not retrigger these parameters for legato notes.

D You select a LFO waveform by using the spin controls beside the wave-
form display, or by clicking in the display and moving the mouse up or 
down.

The following parameters are available for LFO 2:

Modulation bus routing 
section

A modulation bus is used to connect a modulation source to a modulation destination. 
Both audio signals and control (CV) parameters are available. This creates a flexible 
routing system that complements the pre-wired routing in the Voice panel.

Basic operation - simple tutorial

To illustrate the basic operation of the modulation bus section, let’s set up a simple 
source to destination modulation assignment:

1. Select “Initialize Patch” from the Edit menu.
If you currently have unsaved settings you wish too keep, don’t forget to save them 
first.

The Init patch is a simple 1 oscillator/1 filter setup, which produces sound when you 
play, and will serve the purpose of this tutorial.

D The left half of the modulation section contains 5 columns, Source, 
Amount, Dest, Amount and Scale.
Below the column headers there are 7 rows. Each row is a modulation bus where 
you can have a Source to Destination modulation assigned.

2. Click in the top row of the leftmost Source column.
A pop-up menu appears listing all available Source modulation parameters. 

|Parameter |Description
Rate This sets the frequency or rate of the LFO.

Waveform This sets the LFO waveform. Apart from standard waveforms 
(sine, square etc.) there are various different random, non-linear 
and stepped waveforms. The basic shape of the waveforms are 
shown in the display, and illustrate how a signal is affected. 

Delay This introduces a delay before the LFO modulation onset after a 
note is played. Turn clockwise for longer delay. 

Key Sync  If Key Sync is off, the LFO cycle is free running, meaning that 
when you play a note the modulation may start anywhere in the 
LFO waveform cycle. If Key Sync is on, the LFO cycle is reset for 
each note played.

Tempo sync If this is on, the Rate will be synced to the sequencer tempo in 
beat increments (4/1 to 1/32).
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The upper half of the menu contains Voice section source parameters, and the lower 
half contains various global play and performance-oriented source parameters and 
the Global Envelope, as well as the Step Sequencer, CV and Audio inputs.

3. Select “LFO 1” from the pop-up.

This means that LFO 1 is the modulation Source, and this can now be assigned to 
modulate a Destination parameter.

4. Pull down the “Dest” column pop-up in the top row.

A pop-up menu appears listing all available modulation Destinations. The upper half of 
the menu contains Voice section destinations, and the lower half contains Global sec-
tion destinations, as well as the Step Sequencer, CV and Audio outputs.

5. Select “Osc 1” from the menu and then “Pitch” from the submenu.

This means that Osc 1 pitch is now assigned to be modulated by LFO 1. Next step is 
to set the amount of modulation to be applied.

6. Click in the top row Amount column to the right of the Source column, and 
move the mouse pointer up and down to set an Amount value.
Both positive and negative Amount values can be set (+/- 100%).

D If you now play a few notes you can hear the oscillator pitch being mod-
ulated by the LFO to produce vibrato. 
But the vibrato will be constant, which you probably don’t want. This is solved by 
assigning a Scale parameter, which allows you to assign another parameter to 
control the modulation Amount.

7. Pull down the “Scale” column pop-up in the top row.

A pop-up menu appears listing all available Scale parameters. The upper half of the 
menu contains Voice section parameters, and the lower half contains various play and 
performance-oriented parameters and the Global Envelope, as well as the Step Se-
quencer, CV and Audio inputs. 

A typical controller for vibrato is the Mod wheel.

8. Select “Performance” from the menu and then “Mod wheel” from the sub-
menu.

This means that Osc 1 pitch is now assigned to be modulated by LFO 1, and the 
amount of modulation is controlled by the Mod wheel. How much the Scale parameter 
controls the Amount is set using the “Amount” column for the top row (to the left of 
the Scale column).

9. Click in the top row Amount column and move the mouse pointer up and 
down to set an Amount value.
Both positive and negative Scale Amount values can be set (+/- 100%). To fully 
control the LFO modulation so that there is no vibrato when the Mod wheel is set 
to zero, set the Amount to 100%.
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10.The modulation routing is now complete!
You now have full control over the vibrato modulation by using the Mod wheel. 

• How much modulation will be applied when the Scale parameter is set to maxi-
mum is governed by the Source to Destination Amount parameter.

• How much the Scale parameter controls the modulation is set with the Scale 
Amount parameter.

• To clear any assigned modulation routing you can use the “CLR” button to the 
right of the corresponding bus.

About the three modulation routing types

As described in the tutorial, the principal operators of the Modulation bus routing sys-
tem are as follows:

• You have Modulation Source, Modulation Destination and Modulation Amount pa-
rameters. 

• Optionally, you have a Scale parameter controlling the Modulation Amount, and a 
Scale Amount that governs how much the Scale parameter controls the Modula-
tion Amount.

There are three different types of modulation routing busses available in Thor:

D You have seven “Source –> Destination –> Scale” routing busses.
These are the seven rows in the left half of the Modulation section, as covered in 
the tutorial.

D There are four “Source –> Destination 1 –> Destination 2 –> Scale” bus-
ses.
These are the four top rows in the right half of the Modulation section. This works 
after the same principle but the Source parameter can affect two different Destina-
tion parameters (with variable Amount settings) and a Scale parameter that affects 
the relative modulation Amount for both Destinations.

D Lastly, there are two “Source –> Destination –> Scale 1 –> Scale 2” bus-
ses.
This means that a modulation Amount can use two Scale parameters. 
An example: You have the Mod Envelope as Source and Oscillator Pitch as the 
Destination (Amount set whatever you like). As the first Scale parameter we use 
the Mod Wheel (Amount set to 100 so that no modulation is applied when the 
Mod wheel is at zero), and LFO 1 as the second Scale parameter (Amount set to 
whatever you like). When you move the Mod wheel, the pitch modulation amount 
will be modulated by both the Mod Envelope and LFO 1 simultaneously.

Modulation Sources - Voice section

The following parameters can be used as Voice section modulation Sources:

|Parameter |Description
Voice Key Voice Key lets you assign modulation according to notes. There 

are 4 modes selectable from the sub-menus:
• Note - this is keyboard tracking. If a positive Amount value is 

used and the destination is filter frequency, the filter fre-
quency will track the keyboard, i.e. increase with higher notes.

• Note2 - this works similarly to Note but within a repeated oc-
tave range. E.g. if Note2 modulates Amp Pan the pan position 
will move from left to right within an octave range then start 
over. If you play chords normally over the keyboard the effect 
will be that notes are randomly spread across the stereo field.

• Velocity - this applies modulation according to velocity (how 
hard or soft you strike the keys).

• Gate - this is Gate on/off. E.g. if applied to oscillator pitch you 
will get one pitch value (set by Amount) when a key is 
pressed, and another value (the unmodulated pitch) when the 
key is released.

Osc 1/2/3 This allows you to route the audio output from the oscillators to a 
destination. 

Filter 1/2 This is the audio output of the filters. All filter parameters affect 
the destination.

Shaper This is the audio output of the Shaper module. Note that any-
thing connected to the Shaper, e.g. Filter 1, affects the Shaper 
output, and thus the resulting modulation.

Amp This is the audio output of the Amp Gain section.

LFO 1 This allows you to modulate parameters with LFO 1.

Filter Envelope This allows you to modulate parameters with the Filter Envelope.

Amp Envelope This allows you to modulate parameters with the Amp Envelope.

Mod Envelope This allows you to modulate parameters with the Mod Envelope.
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Modulation Sources - Global 

The following parameters can be used as Global section modulation Sources:

Modulation Destinations - Voice section

The following parameters can be used as Voice section modulation Destinations:

|Parameter |Description
Global Envelope This allows you to modulate parameters using the Global En-

velope.

Voice Mixer This allows you to modulate parameters using the Left and 
Right Mixer inputs.

Last Key This will apply modulation according to the last note played 
(monophonic), either via MIDI, or from the Step Sequencer. 
For example, you can use Last Key to make a filter’s fre-
quency track notes played by the Step Sequencer. 

MIDI Key This applies modulation according to notes globally, not per-
voice so in other words it is monophonic. E.g. if you use MIDI 
Note as Source and a self-oscillating filter’s frequency as the 
destination, the filter will track but you will only be able to 
play one voice at a time. MIDI Note is handy for transposing 
Step patterns in real time.
There are 3 modes selectable from the sub-menus:
• Note - this is keyboard tracking. If a positive Amount value 

is used and the destination is filter frequency, the filter fre-
quency will track the keyboard, i.e. increase with higher 
notes.

• Velocity - this applies modulation according to velocity 
(how hard or soft you strike the keys).

• Gate - this is Gate on/off. E.g. if applied to oscillator pitch 
you will get one pitch value (set by Amount) when a key is 
pressed, and another value (the unmodulated pitch) when 
the key is released.

LFO 2 This allows you to modulate parameters with LFO 2. 

Performance parame-
ters

On this sub-menu you can assign the one of the standard 
Performance controllers to modulate/scale parameters; Mod 
Wheel/Pitch Bend/Breath/AfterTouch/Expression.

Modifiers This is where you assign parameters and functions to be 
controlled with the virtual 2 Rotary and 2 Button controls on 
the Controller panel.

Sustain Pedal This allows you to assign the Sustain Pedal as a modulation 
source.

Polyphony This allows you to apply modulation according to how many 
notes you play. E.g. you could have a short envelope attack 
when you play single notes, and a long attack when you play 
chords.

Step Sequencer This allows you to apply modulation according to the settings 
for each step in the Step Sequencer. 
On the sub-menu you can chose to apply modulation ac-
cording to Gate/Note/Curve 1 and 2/Gate Length/Step Du-
ration settings for each step. 
In addition you have Start and End Trig, which sends a gate 
trigger at the start and end of the Step sequence, respec-
tively.

CV Inputs 1-4 These are CV inputs on the back panel which facilitates the 
use of external modulation sources, (e.g. the Matrix) in Thor. 
If connected you can freely assign the external CV to any 
modulation destination in Thor.

Audio Inputs 1-4 These are Audio inputs on the back panel which allows you 
to connect external audio signals and process these using 
Thor parameters, or use them as modulation sources. See 
page 221.

|Parameter |Description
Osc 1 There are four modulation destinations available on the Osc 

1 sub-menu: 
• Pitch - this will affect oscillator pitch (frequency). 
• FM - this will frequency modulate the oscillator. 
The difference between Pitch and FM is that if a high fre-
quency audio signal (i.e. an oscillator or an external audio sig-
nal) is the source, FM will not alter the basic pitch of the 
source, only the timbre. If Pitch is used both the pitch and the 
timbre will be affected. 
• There is also a modifier parameter, which differs depend-

ing on what oscillator type is selected. See “The Oscilla-
tor section” for details.

• Osc 2 AM Amount - this will control AM modulation 
amount from Osc 2. See “About Amplitude Modulation 
(AM)”.

Osc 2/ Osc 3 Oscillator slots 2 and 3 have the same Destination parame-
ters as Osc 1, except that there is no AM.

|Parameter |Description
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Modulation Destinations - Global

The following Global modulation destinations are available:Filter 1/ Filter 2 The following destinations are available on the Filter 1 and 2 
sub-menus:
• Audio In - this allows you to connect an audio source (e.g. 

an oscillator or an external audio signal) to the filter input.
• Frequency - this controls the filter frequency.
• Frequency (FM) - this will apply filter frequency modula-

tion. 
The difference between Frequency and FM is that if a high 
frequency audio signal (i.e. an oscillator or an external audio 
signal) is the source, FM will not alter the basic frequency of 
the source, only the timbre. If Frequency is used both the 
pitch and the timbre will be affected. 
• Resonance - this controls filter resonance.
• Drive - this controls the filter’s Drive parameter.
• Gender - this controls the Gender parameter (Formant fil-

ter only).
• LPHPMix - this controls the LP/HP parameter (State Vari-

able filter only).

Shaper Drive This will control the Shaper Drive parameter.

Amp The Amp section has three destinations on the sub-menu:
• Input - this allows you to connect a source (e.g. an oscilla-

tor or an external audio signal) to the Amp input. 
• Gain - this controls the Amp Gain.
• Pan - this controls the Pan for each voice. Modulating this 

parameter with for example LFO 1 means that the Pan po-
sition will modulate differently for each voice you play.

Mix The Mixer has three destinations on the sub-menu:
• Osc 1+2 Level - this controls the level of both oscillator 1 

and 2.
• Osc 1:2 Balance - you can modulate the level balance be-

tween oscillator 1 and 2, e.g. to sweep from one oscillator 
to the other.

• Osc 3 Level - this controls the level of oscillator 3.

Filter Envelope The Filter Envelope mod destinations are as follows:
• Gate - this is the gate input of the envelope. A gate signal 

applied to this input will trigger the envelope.
• Attack - this controls the Attack of the envelope.
• Decay - this controls the Decay of the envelope.
• Release - this controls the Release parameter.

Amp Envelope This has the same destination parameters as the Filter Enve-
lope.

Mod Envelope This has the same destination parameters as the Filter Enve-
lope.

LFO 1 Rate This allows you to control the LFO 1 Rate parameter.

|Parameter |Description

|Parameter |Description
Portamento This allows you to control the Portamento time parameter.

LFO 2 Rate This allows you to control the LFO 2 Rate parameter.

Global Envelope The Global Envelope mod destinations are as follows:
• Gate - this is the gate input of the envelope. A gate signal 

applied to this input will trigger the envelope.
• Attack - this controls the attack time of the envelope.
• Decay - this controls the decay time of the envelope.
• Release - this controls the release time of the envelope.

Filter 3 The following destinations are available on the Filter 3 sub-
menu:
• Left/Right In - this allows you to connect an a source to 

the filter input. 
• Frequency - this controls the filter frequency.
• Frequency (FM) - this will apply filter frequency modula-

tion.
• Resonance - this controls filter resonance.
• Drive - this controls the filter’s Drive parameter.
• Gender - this controls the Gender parameter (Formant fil-

ter only).
• LPHPMix - this controls the LP/HP parameter (State Vari-

able filter only).

Chorus The Chorus effect has the following destinations:
• DryWet balance
• Delay (time)
• ModRate
• ModAmount
• Feedback

Delay The Delay effect has the following destinations:
• DryWet balance
• Time
• ModRate
• ModAmount
• Feedback
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Scale parameters

The available scale parameters are the same as the Source parameters.

About using the Audio inputs

The 4 Audio inputs on the back panel can be used to connect external audio sources 
and process them with Thor’s parameters.

Note that when routing audio to the Voice section, the following things apply:

• There are only mono inputs in the Voice section.
• You need to send a gate trigger for the audio signal to be heard. This can be done 

in three ways; by playing notes, via notes played by the Step sequencer or from 
CV gate signals.

D Routing audio to Global destinations does not require a gate trigger and 
stereo inputs are provided.

D The external audio sources can also be used purely for modulation, e.g. 
you can modulate an oscillators pitch with an audio signal.
This way you can use the audio input source to modulate any available destina-
tions.

Step Sequencer

Thor’s Step Sequencer is a further development of the step sequencers which were 
often present in vintage analog modular systems. It can be used for programming ar-
peggios or short melody sequences. Alternatively, it can be used purely as a modula-
tion source.

You can have up to 16 steps, and each step can be programmed with various values 
such as Note pitch, Velocity, Step Duration etc.

Basic operation
The main parameters and functions are as follows:

D The row of 16 buttons are used to program each step’s on or off status.
A lit button means that the step is active, and a dark button means that the step 
will be a rest (silent).

D Each step button has a knob above it, which is used to set values for the 
corresponding step.

D The Edit knob determines what value you set with the step knobs.
The available Edit values are Note (pitch), Velocity, Gate length, Step duration and 
Curve 1 and 2.

D The Run button starts/stops the step sequencer.

What exactly happens when you press Run depends on the Run mode - see below.

Setting the Run mode

The Run mode is set with the lever beside the Run button. The set mode governs how 
the step sequencer is played back when you press Run. The options are as follows:

D Repeat mode - this will repeat the sequence continuously.
Click the Run button again or use the Transport to stop.

D 1 Shot mode - this will play the sequence once then stop.

D Step mode - the Run button steps the sequencer forward one step at a 
time.

D Off - the step sequencer is inactive.

Step Sequencer This allows you to control various parameters belonging to 
the Step Sequencer. 
• Trig - this enables control over the Step Sequencer Run 

on/off status.
• Rate - this enables control over the Step Sequencer Rate.
• Transpose - this enables control over the Step Sequencer 

base pitch. E.g. if you apply MIDI Note as a source to this 
parameter you can transpose the sequence by playing 
notes.

• Velocity - this enables control over the Step Sequencer 
Velocity response.

• Gate Length - this enables control over the Step Se-
quencer Gate Length response.

CV Output 1-4 This will allow you to send signals to the CV outputs on the 
back of the device. Note that you can send CV signals to au-
dio outputs and vice versa.

Audio Output 1-4 This will allow you to send signals to the audio outputs on the 
back of the device. Note that you can send CV signals to au-
dio outputs and vice versa.

|Parameter |Description
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Setting the direction

The Direction parameter is used to set the direction of the step sequence. The follow-
ing options are available:

D Forward - plays the sequence from the first step to the last.

D Reverse - plays the sequence from the last step to the first.

D Pendulum 1 - plays the sequence from the first step to the last, then from 
the last step to the first. 
I.e. the last and first step is played twice when the sequencer reverses direction.

D Pendulum 2 - plays the sequence from the first step to the last, then from 
the second last step to the first, i.e. without repeating the last/first step 
when reversing direction.

D Random - plays the steps in a random order.

Programming step note pitch

To program step note pitch, you proceed as follows:

1. Make sure that the Step Seq Trigger button is activated in the Controller 
panel.

2. Set the Run mode to “Repeat”.
You don’t have to use Repeat mode but it makes it easier to follow the following 
steps. 

3. Start the step sequencer by pressing the Run button.
You should now hear a sequence of repeated notes, each with the same pitch 
(C3). The current step is indicated by a yellow LED above the step buttons.

4. Make sure that the Edit knob is set to Note.

5. Turn one of the step knobs above one of the steps.
A tooltip shows you what current note pitch the knob is set to, and when the se-
quencer repeats you should be able to hear the change in pitch for that step. Turn 
clockwise to raise the pitch in semitone increments. Turn counter-clockwise to 
lower the pitch.

D You can set the knob’s note range by using the Octave lever to the left of 
the step buttons.
Available note ranges are 2 Octaves (i.e. one octave up and down from the middle 
knob position (C3), 4 Octaves (i.e. two octaves up and down from the middle po-
sition (C3), or Full (-C2 to G8).

✪ Note that the octave range can be set independently for each step. Each 
step memorizes the current octave range when the pitch is set for that 
step, and will keep this octave range until you change the pitch for the 
step with a different octave range setting.

D You can either program steps “on the fly” (with the Step sequencer run-
ning) or step by step (Step mode).
In Step mode, you press Run to forward the step number one position so you can 
set step parameters for one step at a time.

By using this general method you can continue to enter note pitch for other steps.

Inserting rests

To make step sequences more rhythmically interesting, you can program rests for 
steps.

D This is simply done by pressing one or several step buttons so they go 
dark.
Dark steps will be rests.

D Note that the Step Duration value still “counts” for rests.
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Setting the number of steps

D You can set how many steps a sequence should have before starting 
over using the Steps knob at the far right on the panel.
Up to 16 steps can be used. The lit LEDs above each step button show the num-
ber of steps currently used. You can also change number of steps by clicking on a 
LED directly - the sequencer will then stop/start over at the selected step.

Setting Rate

The Rate knob determines the rate of the step sequence. 

• You can either use “free running” rates (i.e. not synced to main sequencer tempo) 
or synced tempo.
This is set with the Sync button on/off status. If Sync is active you can set the 
tempo in various beat resolutions.

Setting other values for steps

For each step you can also program other parameters with the step value knobs apart 
from note pitch. You use the Edit knob to set one the following:

D Velocity - if this is selected as the Edit mode you can set a velocity value 
for each step.
Default value is 100, range is 0-127.

D Gate Length - if this is selected as the Edit mode you can set a Gate 
Length value for each step.
Default is 75%. Gate Length determines the length of the note played for that 
step. 

D Step Duration - if this is selected as the Edit mode you can set a Step du-
ration value for each step.
This parameter determines the total length of the step, which is a factor related to 
the sequencer rate. Range is 1/4 to 4. E.g. if Rate is 1/16, “1” means a 1/16-note 
will be played, a “4” means a 1/4-note will be played, and so on.

D The Curves 1 and 2 allow you to set values for each step that can be sent 
to control parameters of your choice. 
This is done in the Modulation bus routing section, where these two independent 
Curves are selectable as Source controllers. 

✪ You can compare these curves to the Curve CV output of the Matrix - they 
simply represent a series of values which can be applied to anything.

Step Pattern functions

You will find some specific Step pattern functions on the Edit menu (and on the de-
vice context menu). These are as follows:

|Function |Description
Randomize Se-
quencer Pattern

The Randomize Pattern function creates random patterns. The 
function only randomizes the selected Edit value (e.g. if set to 
Note, only the note pitch values are randomized, not velocity, 
gate length etc.).

Shift Pattern L/R The Shift Pattern functions move the pattern one step to the 
left or right. All parameters (rests, note pitch, velocity etc.) are 
shifted one step.
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Connections
The following Audio and CV connectors can be found at the back of Thor:

Sequencer Control Inputs

The Sequencer Control CV and Gate inputs allow you to play Thor from another CV/
Gate device (e.g. a Matrix or the RPG-8). The signal to the CV input controls the note 
pitch, while the signal to the Gate input delivers note on/off along with velocity. 

Modulation Inputs

D The Rotary control voltage (CV) inputs (with associated voltage trim 
pots), can modulate the two virtual Rotary controls. 
Thus, any parameter(s) assigned to a Rotary control can be modulated by CV.

D The Filter 1x allows for CV control of the Filter 1 frequency.
If the Formant filter is used this is the “X” parameter - see “Formant filter”.

D The four CV Inputs can receive CV from external sources that will be 
available as Sources in the Modulation bus.

Modulation Outputs

Here you can find CV outputs from the Global Envelope and LFO 2, as well as the 4 
user assignable CV outputs.

Audio Inputs

The Audio inputs can be used to connect audio outputs from other Reason devices. 
When connected, you can route the Audio inputs as a Modulation source to for exam-
ple one of the filters and process the external signal. See “About using the Audio in-
puts”.

Audio Outputs

Thor has 4 outputs: 

• 1 Left (Mono)/2 Right - these are the main stereo outputs.
• 2 additional outputs (3 and 4), which can be assigned in the Modulation section. 
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Introduction
The Malström is a polyphonic synthesizer with a great number of different routing pos-
sibilities. It is based on the concept of what we call “Graintable Synthesis” (see be-
low), and is ideally suited for producing swirling, sharp, distorted, abstract special 
effect types of synthesizer sounds. In fact, you could go so far as to say that the Mal-
ström can produce sounds quite unlike anything you’ve ever heard from a synthesizer. 

For a complete run-down of the principles behind it and thorough explanations of the 
controls, read on...

Features
The following are the basic features of the Malström:

D Two Oscillators, based on Graintable Synthesis.
See page 227 for details.

D Two Modulators, featuring tempo sync and one-shot options.
See page 229.

D Two Filters and one Shaper.
A number of different filter modes in combination with several routing options and 
a Waveshaper makes it possible to create truly astounding filter effects.

D Three Envelope generators.
There is one amplitude envelope for each oscillator and a common envelope for 
both filters. See page 228 and page 232 for details.

D Polyphony of up to 16 voices.

D Velocity and Modulation control.
See page 237.

D A number of CV/Gate Modulation possibilities.
See page 239.

D A variety of Audio Input/Output options.
You can for instance connect external audio sources for input to the Mal-
ström, and you can also control its output. See page 238 for more details.

Theory of operation
There are a number of different synthesis methods for generating sound. There is e.g. 
Subtractive Synthesis (which is used in Reason’s other synth - the Subtractor), FM 
Synthesis and Physical Modelling Synthesis to mention but a few.

To give you a clear understanding of the inner workings of the Malström, it might be in 
order with a brief explanation of what we call Graintable Synthesis.

What we refer to as Graintable Synthesis is actually a combination of two synthesis 
methods; Granular Synthesis and Wavetable Synthesis.

• In granular synthesis, sound is generated by a number of short, contiguous seg-
ments (grains) of sound, each typically between 5 to 100 milliseconds long. The 
sound is varied by changing the properties of each grain and/or the order in which 
they are spliced together. Grains can be produced either by a mathematical for-
mula or by a sampled sound. This is a very dynamic synthesis method with a lot of 
variation possibilities, although somewhat hard to master and control.

• Wavetable synthesis on the other hand, is basically the playback of a sampled 
waveform. An oscillator in a wavetable synth plays back a single period of a wave-
form, and some wavetable synths also allow the possibility of sweeping through a 
set of periodic waveforms. This is a very straightforward synthesis method that is 
easily controlled, but somewhat limited in variation possibilities.

The Malström combines these two into a synthesis method that provides a very flexi-
ble way of synthesizing sounds with incredible flux and mutability.

It works like this:

• The oscillators in the Malström play back sampled sounds that are subject to some 
very complex processing and cut up into a number of grains. From here on, these 
sounds will be referred to as Graintables

• This results in a set of periodic waveforms (a graintable) that, when spliced to-
gether, play back the original sampled sound.

• This can then be treated just like a wavetable. I.e. It is possible to sweep through it. 
Move through it at any speed without affecting pitch. Play any section of it repeat-
edly. Use it to pick static waveforms. Jump between positions. Etc. etc.

• It is also possible to perform a number of other tricks, all of which are described 
further on in this chapter.

Loading and Saving Patches
Loading and saving patches is done in the same way as with any other Reason de-
vice. 
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The Oscillator section

The two oscillators (osc:A and osc:B) of the Malström are the actual sound genera-
tors, and the rest of the controls are used for modulating and shaping the sound. The 
oscillators actually do two things; they play a graintable and generate the pitch:

• A graintable is several short, contiguous segments of audio (see above).
• Pitch is the frequency at which the segments are played back.

When creating a Malström patch, the fundamental first building block is usually to se-
lect a graintable for one or both of the oscillators.

D To activate/deactivate an oscillator, click the On/Off button in the top 
left corner.
When an oscillator is activated, the button is lit.

An activated oscillator

D To select a graintable, either use the spin controls or click directly in the 
display to bring up a pop-up menu with the available graintables.
The graintables are sorted alphabetically into a number of descriptive categories, 
giving a hint as to the general character of the sound. Note that the categories are 
only visible in the pop-up menu, not in the display.

Setting oscillator frequency
You can change the frequency - i.e. the tuning - of each oscillator by using the three 
knobs marked “Octave”, “Semi” and “Cent”.

D The Octave knob changes the frequency in steps of one full octave (12 
semitones).
The range is -4 – 0 – +4 where 0 corresponds to middle “A” on your keyboard at 
440 Hz.

D The Semi knob changes the frequency in steps of one semitone.
The range is 0 to +12 (one full octave up).

D The Cent knob changes the frequency in steps of cents, which are 100ths 
of a semitone.
The range is -50 – 0 – +50, i.e. down or up by up to half a semitone.
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Controlling playback of the graintable
Each oscillator features three controls that determine how the loaded graintables are 
played back. These are: The “Index” slider, the “Motion” knob and the “Shift” knob.

D The Index slider sets the playback starting point in the graintable.
By dragging the slider, you set which index point in the graintable should be 
played first when the Malström receives a Note On message. Playback will then 
continue to the next index point according to the active graintable. With the slider 
all the way to the left, the first segment in the graintable is also the one that will be 
played back first.

! Note that the Malström’s Graintables are not all of the same length, and 
that the range for the Index slider (0-127) does not reflect the actual 
length of the graintables. I.e. regardless of whether a graintable contains 
3 or 333 grains, the Index slider will always span the entire graintable 
even though the slider range says 0-127.

D The Motion knob controls how fast the Malström should move forward to 
play the next segment in the graintable, according to its motion pattern 
(see below).
If the knob is kept in the middle position the speed of motion is the normal default. 
Turning the knob to the left slows it down and turning it to the right results in 
higher speed. If the knob is set all the way to the left, there will be no motion at all, 
which means that the initial segment, as set with the Index slider, will play over and 
over as a static waveform. 

D The Shift knob changes the timbre of the sound (the formant spectrum).
What it actually does is change the pitch of a segment up or down by re
sampling. However, since the pitch you hear is independent of the actual pitch of 
the graintable (see above), pitch-shifting a segment instead means that more or 
less of the segment waveform will be played back, resulting in a change of har-
monic content and timbre.

About motion patterns

Each graintable has a predefined motion pattern and a default motion speed. 

When a graintable is looped (i.e. if the Motion knob is not set all the way to the left), it 
follows one of two possible motion patterns:

D Forward
This motion pattern plays the graintable from the beginning to the end, and then 
repeats it.

D Forward - Backward
This motion pattern plays the graintable from the beginning to the end, then from 
the end to the beginning and then repeats it.

The motion speed can be changed with the Motion knob, as described above, but it is 
not possible to alter the motion pattern of a graintable.

The amplitude envelopes

Each oscillator features a standard ADSR (Attack, Decay, Sustain, Release) envelope 
generator, and a Level control. These are used for controlling the volume of the oscil-
lator. One thing that makes the Malström different from many other synths though, is 
the fact that the amplitude envelopes are placed before the filter and routing sections 
in the signal path.

The amplitude envelopes control how the volume of a sound should change from the 
moment you strike a key on your keyboard to the moment that you release it again.

Vol

The Volume knobs set the volume level out from each oscillator.

! For an overall description of the general envelope parameters (Attack, 
Decay, Sustain, Release), please refer to the Subtractor chapter.
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The Modulator section

The Malström features two Modulators (mod:A and mod:B) These are in fact another 
type of oscillators, called LFOs (Low Frequency Oscillators). They each generate a 
waveform and a frequency, much like osc:A and osc:B. However, there are a couple 
of important differences:

• Mod:A and mod:B do not generate sound. They are instead used for modulating 
various parameters to change the character of the sound.

• They only generate waveforms of low frequency.

Furthermore, both modulators are tempo syncable and possible to use in one shot 
mode, in which case they will actually work like envelopes.

Modulator parameters
The two Modulators have a few controls in common, but there are also some differ-
ences. Both the common parameters and the ones that are unique for each Modulator 
(the destinations) are described below.

D To activate/deactivate a Modulator, click the On/Off button in the top 
left corner.
When a Modulator is activated, the button is lit.

An activated Modulator

Curve

This lets you select a waveform for modulating parameters. Use the spin controls to 
the right of the display to cycle through the available waveforms. Some of these wave-
forms are especially suited for use with the Modulator in one shot mode (see below).

Rate

This knob controls the frequency of the Modulator. For a faster modulation rate, turn 
the knob to the right.

The Rate knob is also used for setting the time division when synchronizing the Mod-
ulator to the song tempo (see below). 

One Shot

To put the Modulator into one shot mode, click this button so that it is lit. 

Normally, the Modulators will repeat the selected waveforms over and over again, at 
the set rate. However, when one shot mode is activated and you play a note, the Mod-
ulator will play the selected waveform only once (at the set rate) and then stop. In 
other words, it will effectively be turned into an envelope generator!

Note that even though all waveforms can be used with interesting results, some wave-
forms are explicitly well suited for use in one shot mode. For example, try using the 
waveform with just one long, gently sloping curve.

Sync

Clicking this button so that it is lit synchronizes the Modulator to the song tempo, in 
one of 16 possible time divisions. 

! When sync is activated, the Rate knob is used for selecting the desired ti-
medivision. Turn the Rate knob and observe the tool tip for an indication 
of the time division.

A/B selector

This switch is used for deciding which oscillator and/or filter the Modulator should 
modulate - A, B or both. With the switch in the middle position, both A and B will be 
modulated.

Destinations
The following knobs are used for determining what each of the two modulators should 
modulate.

D Note that these knobs are bi-polar, which means that if a knob is in the 
middle position, no modulation is applied. If you turn a knob either to the 
left or to the right, an increasing amount of modulation is applied to the 
parameter. The difference is that if you turn a knob to the left, the wave-
form of the modulator is inverted.

Mod:A

Mod:A can modulate the following parameters of either oscillator:
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D Pitch
Use this if you want Mod:A to offset the pitch of osc:A, osc:B, or both (see page 
227).

D Index
Use this if you want Mod:A to offset the index start position of osc:A, osc:B, or 
both (see page 228).

D Shift
Use this to have Mod:A affect the harmonic content of osc:A, osc:B, or both (see 
page 228).

Mod:B

Mod:B can modulate the following parameters of either oscillator:

D Motion
Use this if you want Mod:B to affect the motion speed of osc:A, osc:B, or both 
(see page 228).

D Vol
Use this if you want Mod:B to change the output level of osc:A, osc:B, or both 
(see page 228).

D Filter
Use this if you want Mod:B to offset the cutoff frequency of filter:A, filter:B, or both 
(see page 231).

D Mod:A
Use this if you want Mod:B to change the total amount of modulation from Mod:A.

The Filter section

The filter section lets you further shape the overall character of the sound. Contained 
herein are two multimode filters, a filter envelope and a waveshaper.

The Filters

Both filter:A and filter:B have the exact same parameters, all of which are described 
below.
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D To activate/deactivate a filter, click the On/Off button in the top left cor-
ner.
When a filter is activated, the button is lit.

An activated filter

Filter types

To select a filter type, either click the Mode button in the bottom left corner or click di-
rectly on the desired filter name so that it lights up in yellow:

D LP 12 (12 dB lowpass)
Lowpass filters let low frequencies through and cut off high frequencies. This filter 
type has a roll-off curve of 12dB/Octave.

D BP 12 (12 dB bandpass)
Bandpass filters cut both high and low frequencies, leaving the frequency band in 
between unaffected. Each slope in this filter type has a 12 dB/Octave roll-off.

D Comb + & Comb –
Comb filters are basically delays with very short delay times with adjustable feed-
back (in Reason controlled with the Resonance knob). A comb filter causes reso-
nating peaks at certain frequencies. 
The difference between “+” and “–” is in the position of the peaks, in the spec-
trum. The main audible difference is that the “–”-version causes a bass cut.
The Resonance parameter in both cases controls the shape and size of the peaks.

D AM
AM (Amplitude Modulation) is often referred to as Ring Modulation. A Ring Modu-
lator works by multiplying two signals together. In the case of the Malström, the fil-
ter produces a sine wave which is multiplied with the signal from osc:A or osc:B. 
Resonance controls the mix between the clean and modulated signals. The Ring 
Modulated output will then contain added frequencies which are generated by the 
sum of, and the difference between the two signals. This can be used for creating 
complex, non-harmonic sounds.

Filter controls

Each filter contains the following four controls:

D Kbd (keyboard tracking)
By clicking this button so that it is lit, you activate keyboard tracking. If keyboard 
tracking is activated, the frequency of the filter will change according to the notes 
you play on your keyboard. That is, if you play notes higher up on the keyboard, the 
filter frequency will increase and vice versa. If keyboard tracking is deactivated, the 
filter frequency will remain at a fixed value regardless of where on the keyboard 
you play.

Comb + Low Resonance Comb + High Resonance

Comb – Low Resonance Comb – High resonance
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D Env (envelope)
If you click on this button so that it is lit, the cutoff frequency (see below) will be 
modulated by the filter envelope. If you leave this deactivated, the Filter Envelope 
will have no effect.

D Freq (frequency)
The function of this parameter depends on which filter type you have selected:
With all filter types except AM, it is used for setting the cutoff frequency of the fil-
ter. In the case of the lowpass filter for example, the cutoff frequency determines 
the limit above which high frequencies will be cut off. Frequencies below the cutoff 
frequency will be allowed to pass through. The farther to the right you turn the 
knob, the higher the cutoff frequency will be.
If you have selected AM as filter type, this will instead control the frequency of the 
signal generated by the filter. The same control range applies though; the farther 
to the right you turn the knob the higher the frequency will be.

D Res (resonance)
Again, the function of this parameter depends upon which filter type is selected:
If the selected filter is any other type than AM, it sets the filter characteristic, or 
quality. For the lowpass filter for example, raising the filter Res value will emphasize 
the frequencies around the set filter frequency. This generally produces a thinner 
sound, but with a sharper, more pronounced filter frequency “sweep”. The higher 
the filter Res value, the more resonant the sound becomes until it produces a whis-
tling or ringing sound. If you set a high value for the Res parameter and then vary 
the filter frequency, this will produce a very distinct sweep, with the ringing sound 
being very evident at certain frequencies.
In the case of the AM filter type though, this control instead regulates the balance 
between the original signal and the signal resulting from amplitude modulation. 
The farther to the right you turn the knob, the more dominant the AM signal will be.

The Filter Envelope

This is a standard ADSR envelope with two additional controls; inv and amt. 

The filter envelope is common for both filter:A and filter:B, and controls how the filter 
frequency should change over time.

Inv (inverse)

This button toggles inversion of the envelope on and off. The Decay segment of the 
envelope will for instance normally lower the frequency, but if the envelope is inverted 
it will instead raise the frequency.

Amt (amount)

This controls to which extent the filter envelope affects the filters, or rather - the set fil-
ter cutoff frequencies. For example; if the cutoff frequency is set to a certain value, the 
filter will already be opened by this amount when you hit a key on your keyboard. The 
amount setting then controls how much more the filter will open from that point. Turn 
the knob to the right to increase the value.

! For an overall description of the general envelope parameters (Attack, 
Decay, Sustain, Release), please refer to the Subtractor chapter.
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The Shaper

Before filter:A is an optional waveshaper. Waveshaping is a synthesis method for 
transforming sounds by altering the waveform shape, thereby creating a complex, rich 
sound. Or, if that’s more to your taste, truncating and distorting the sound to lo-fi 
heaven!

A guitar distortion box could be viewed as a type of waveshaper for example. An un-
amplified electric guitar produces a sound with fairly pure harmonic content, which is 
then amplified and transformed by the distortion box.

D To activate/deactivate the Shaper, click the On/Off button in the top left 
corner.
When the Shaper is activated, the button is lit.

The Shaper activated

Mode

You can select one of five different modes for shaping the sound, each with its own 
characteristics. 

To select a mode, either click the Mode button in the bottom left corner or click di-
rectly on the desired mode name so that it lights up in yellow.

D Sine
This produces a round, smooth sound.

D Saturate
This gives a lush, rich character to the sound.

D Clip
This introduces clipping - digital distortion - to the signal.

D Quant
This lets you truncate the signal by bit-reduction, thus making it possible to 
achieve that noisy, characteristic 8 bit sound for example.

D Noise
This is actually not strictly a shaper function. Instead it multiplies the sound with 
noise.

Amt (amount)

This controls the amount of shaping applied. By turning the knob to the right you in-
crease the effect.

Input Signal

Sine

O
utput S

ignal

Saturate
Clip
Quant
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Routing
The Malström puts you in total control of how the signal should be routed from the os-
cillators, through the filters and on to the outputs. Below is first a general description 
of the routing options, followed by examples of how to route the signal in order to 
achieve a certain result.

D Click on a button so that it is lit, to route the signal correspondingly.
See below for descriptions.

! Note that the result depends both on the routing buttons and on whether 
the filters and shaper are activated or not! 

Routing examples

One or both oscillators without filters

With this configuration, the signals from the oscillators will bypass the filters and the 
shaper and go directly to the respective output. Using both oscillators allows you to 
use the Spread parameter to create a true stereo sound.

One or both oscillators to one filter only

Both oscillators routed to filter:B only. Both oscillators routed to filter:A only.

With these configurations, the signal from osc:A and/or osc:B will go to either filter:A 
or filter:B and then to the outputs. This is essentially a mono configuration and hence 
Spread should probably be set to “0”.

If this button is lit, the signal from osc:B 
is routed to filter:B. If this is not lit, the 
signal from osc:B will go straight to the 
outputs.

If this button is lit, the signal from filter:B is routed to filter:A via the shaper. The 
signal from filter:B can originate from either osc:A, osc:B or both. If this is not 
lit, the signal from filter:B will go straight to the outputs.

If this button is lit, the signal from osc:A 
is routed to filter:B. If neither this nor the 
other routing button from osc:A (to 
filter:A/shaper) is lit, the signal from 
osc:A will go straight to the outputs.

If this button is lit, the signal from osc:A is routed to filter:A via the shaper. If neither this nor 
the other routing button from osc:A (to filter:B) is lit, the signal will go straight to the outputs.
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Both oscillators with one filter each

With this configuration, the signals from osc:A and osc:B will go to filter:A and filter:B 
respectively, and then to the outputs.

Again, this configuration allows you to work in true stereo.

One oscillator with both filters in parallel

With this configuration, the signal from osc:A will go to both filter:A and filter:B, with 
the filters in parallel.

! This configuration is only possible with osc:A. Osc:B can be routed to 
both filters as well, but only in series (see below).

One or both oscillators with both filters in series

Osc:A routed through both filters in series. Osc:B routed through both filters in series.

With these configurations, the signal from osc:A and/or osc:B will go to both filter:A 
and filter:B, with the filters in series (one after the other).

Adding the shaper

The signal from one or both oscillators can also be routed to the shaper. The signal 
will then pass through the shaper to the outputs, with or without also passing through 
the filters.

In the left figure, the signal from osc:A is routed to the shaper and then directly to the outputs. In the 
right figure, the signal from osc:B is routed to filter:B, then to the shaper and then to filter:A.

The output controls

These two parameters control the output from the Malström in the following way:
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Volume

This knob controls the master volume out from the Malström.

Spread

This controls the stereo pan-width of the outputs from Osc:A/B and Filter:A/B re-
spectively. The farther to the right you turn the knob, the wider the stereo image will 
be. In other words, the signals will be panned further apart to the left and right.

! If you are only using one output (A or B), it is strongly recommended that 
you set Spread to “0”.

The play controls

To the far left on the Malström’s “control panel” are various parameters that are af-
fected by how you play, and lets you apply modulation by MIDI controls. The following 
is a description of these controls.

Polyphony - setting the number of voices

This lets you set the polyphony for the Malström. Polyphony is the number of voices it 
can play simultaneously. The maximum number is 16 and the minimum is 1, in which 
case the Malström will be monophonic.

! The number of voices you can play depends of course on the capacity of 
your computer. Even though the maximum number is 16 it doesn’t neces-
sarily mean that your system is capable of using that many voices. Also 
note that voices do not consume CPU capacity unless they are really 
“used”. That is, if you are using a patch that plays two voices but have 
polyphony set to four, the two “unused” voices do not consume any of 
your system resources.

Porta (portamento)

This is used for controlling portamento. This is a parameter that makes the pitch glide 
between the notes you play, rather than changing the pitch instantly as soon as you hit 
a key on your keyboard. By turning this knob you set how long it should take for the 
pitch to glide from one note to the next as you play them. 

With the knob turned all the way to the left, portamento is disabled.
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Legato

By clicking this button you activate/deactivate Legato. Legato in Malström is unique in 
that it allows you to control whether the sound is monophonic or polyphonic by using 
your playing style:

D If you play legato (hold down a key and then press another key without 
releasing the previous), the sound is monophonic.
Also note that the pitch changes, but the envelopes do not start over. That is, there 
will be no new “attack”.

D If you play non-legato (separated notes), with polyphony set to more 
voices than 1, each note will decay separately (polyphonic).
This will be most apparent with longer release times.

The Pitch Bend and Modulation wheels

• The Pitch Bend wheel is used for bending the pitch of notes, much like bending 
the strings on a guitar or other string instrument. 

• The Modulation wheel can be used for applying modulation while you are playing.

Virtually all MIDI keyboards have Pitch Bend and Modulation controls. The Malström 
does not only feature the settings for how incoming MIDI Pitch Bend and Modulation 
wheel messages should affect the sound, but also two functional wheels that can be 
used for applying real time modulation and pitch bend if you don’t have these control-
lers on your keyboard, or if you aren’t using a keyboard at all. The wheels on the Mal-
ström also mirror the movements of the wheels on your MIDI keyboard.

Pitch Bend Range

The Range parameter sets the maximum amount of pitch bend, i.e. how much it is 
possible to change the pitch by turning the wheel fully up or down. The maximum 
range is 24 semitones (2 Octaves). You change the value by clicking the spin controls 
to the right of the display.

The Velocity controls

Velocity is used for controlling various parameters according to how hard or soft you 
play notes on your keyboard. A typical use of velocity control is to make sounds 
brighter and louder if you strike a key harder. By using the knobs in this section, you 
can control how much the various parameters will be affected by velocity. 

! All of the velocity control knobs are bi-polar, which means that the 
amount can be set to either positive or negative values, while keeping 
the knobs in the center position means that no velocity control is ap-
plied.

The following parameters can be velocity controlled:

D Lvl:A
This lets you velocity control the output level of osc:A.

D Lvl:B
This lets you velocity control the output level of osc:B.

D F.env
This sets velocity control for the Filter Envelope Amount parameter. Positive values 
will increase the envelope amount the harder you play, and negative values will de-
crease the amount.

D Atk (attack)
This sets velocity control for the Amp Envelope Attack parameter of osc:A and/or 
osc:B. Positive values will increase the Attack time the harder you play, and nega-
tive values will decrease it.

D Shift
This lets you velocity control the Shift parameter of osc:A and/or osc:B.

D Mod
This lets you velocity control all modulation amounts of mod:A and/or mod:B.

! Note that you can set the last three parameters (Atk, Shift and Mod) to 
be velocity controlled for either or both of oscillator/modulator A and B. 
This is done with the A/B selector switch.
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The Modulation wheel controls

The Modulation wheel can be set to control a number of parameters. You can set pos-
itive or negative values, just like in the Velocity Control section (see above).

The following parameters can be affected by the modulation wheel:

D Index
This sets modulation wheel control of the currently active graintable’s index (see 
page 228) for osc:A and/or osc:B. Positive values will move the index position for-
wards if the modulation wheel is pushed forward. Negative values will move it 
backwards.

D Shift
This sets modulation wheel control of the Shift parameter of osc:A and/or osc:B 
(see page 228).

D Filter
This sets modulation wheel control of the Filter Frequency
parameter (see page 231). Positive values will raise the frequency if the
wheel is pushed forward and negative values will lower the frequency.

D Mod
This sets modulation wheel control of the total amount of modulation from mod:A 
and/or mod:B. Positive values will increase the settings if the wheel is pushed for-
ward and negative values will decrease the settings.

! You can set whether these parameters on either or both oscillator/mod-
ulator/filter A and B will be affected by the modulation wheel. This is 
done with the A/B selector switch.

Connections

Flipping the Malström around reveals a wide array of connection possibilities. Most of 
these are CV/Gate related. Using CV/Gate is described in the chapter “Routing Au-
dio and CV”.

Audio Output
These are the Malström’s audio outputs. When you create a new Malström device, 
they are auto-routed to the first available channel on the audio mixer:

D Shaper/Filter:A (left) & Filter:B (right)
These are the main stereo outputs. Each of the two filters are connected to a sep-
arate output, and by connecting both, you can have stereo output. Whether the 
output really will be in stereo however, is determined by the routing and the 
Spread parameter. See page 234 for details about this.

D Osc:A & osc:B
These make it possible to output the sound directly after the Amp Envelope of 
each oscillator, bypassing the filter section. Connecting one or both of these to a 
channel on the audio mixer will break the Malström’s internal signal chain. That is, 
it is not possible to process the sound by using the filters and the shaper of the 
Malström. the sound instead goes directly to the mixer.

✪ Note also that you can connect the outputs Osc:A & Osc:B to the Audio 
Inputs on the Malström for some interesting effects - see page 239.

Audio Input
• Shaper/Filter:A
• Filter:B

These inputs let you connect either other audio sources, or the Malström’s own inter-
nal signal directly to the filters and the shaper - see page 239.
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Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the Malström from an-
other CV/Gate device (typically a Matrix or a Redrum). The signal to the CV input con-
trols the note pitch, while the signal to the Gate input delivers note on/off along with 
velocity.

! For best results, you should use the Sequencer Control inputs with 
monophonic sounds.

Gate Input
These inputs can receive a CV signal to trigger the following envelopes:

• Amp Envelope
• Filter Envelope 

! Note that connecting to these inputs will override the normal triggering 
of the envelopes. For example, if you connected a Modulation output to 
the Gate Amp in-put, you would not trigger the amp envelope by playing 
notes, as this is now controlled by the Modulator. In addition you would 
only hear the Modulator triggering the envelope for the notes that you 
hold down.

Modulation Input
These control voltage (CV) inputs (with associated voltage trim pots and A/B selector 
switches), can modulate various Malström parameters from other devices, or from the 
modulation outputs of the same Malström device. These inputs can control the follow-
ing parameters:

• Oscillator Pitch
• Filter Frequency
• Oscillator Index offset
• Oscillator Shift
• Amp Level
• Mod Amount
• Mod Wheel

Modulation Output
The Modulation outputs can be used to voltage control other devices, or other param-
eters in the same Malström device. 

The Modulation Outputs are:

• Mod:A 
• Mod:B
• Filter Envelope

Routing external audio to 
the filters

The audio inputs on the back of the Malström allows you to connect any audio signal 
to the filters and Shaper. 

To use this feature, it’s important to understand the following background:

Normally the Malström behaves like any regular polyphonic synthesizer, in that each 
voice has its own filter. The filter settings are the same, but each filter envelope is trig-
gered individually when you play a note.

However, when you connect a signal to the audio inputs, it is routed to an “extra” filter. 
The envelope for this filter is triggered each time any of the other filter envelopes is 
triggered. In other words, the “extra” filter envelope is triggered each time you play a 
note on the Malström.

There are two different uses for the audio inputs:

Connecting an external signal source

Connecting an audio signal from another device in the rack to the audio input allows 
you to process the signal through the filters and/or Shaper of the Malström. The pro-
cessed signal will then be mixed with the Malström’s “own” voices (if activated) and 
sent to the outputs.

The result depends on the following:

• To which jack you connect the signal.
• Whether the filters and/or Shaper are activated on the front panel.
• The routing button for filter:B.

If this is activated and you connect a signal to the Filter:B input, the signal will be 
processed in filter:B and then sent to the Shaper and filter:A (just as when routing 
Malströms own oscillators on the front panel).

Note again that the filter envelope is triggered by all voices. To make use of the filter 
envelope, you either need to play the Malström or use gate signals to trigger it or the 
filter envelope, separately.
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Connecting the signal from the Malström itself

If you connect one or both oscillator outputs to the audio input(s), the internal signal 
path from the oscillators to the filters is broken. In other words, no signals will pass in-
ternally from the oscillators to the filters, and the three routing buttons for the oscilla-
tors are ignored.

This may seem pointless at first, but there are several uses for this:

D When you play the Malström in this mode, the filter envelope will be trig-
gered for each note you play, affecting all sounding notes.
This is due to the monophonic “extra” filter described above. On older synthesiz-
ers, this feature is called “Multiple triggering”.

D Since all notes you play are mixed before being sent into the filter, the 
result of using the Shaper will be totally different (if you play more than 
one note at a time).
This is similar to playing a guitar chord through a distortion effect, for example.

D You can patch in external effects between the oscillators and the filters.
Just connect an oscillator output to the input of the effect device, and the effect 
output to the Malströms’s audio input.

✪ You can use combinations of connections and routing. You could for in-
stance connect an external audio signal to one of the inputs, one of the 
Malström’s oscillators to the other input and then use the routing op-
tions on the front panel for the other oscillator. All of these signals will 
then be mixed and sent to the Malström’s main outputs.
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Introduction
A sampler could be described as a device capable of recording and reproducing au-
dio material, like a tape recorder. Unlike a tape or hard disk based recorder, samplers 
allows you to “play” the recorded sound via MIDI, using a keyboard for example. This 
way, any reproducible sound can be integrated into the MIDI environment, and be 
controlled from sequencers etc. like synthesizers. 

The NN-19 is a sample player, capable of reproducing, but not recording or editing 
sound files. 

The program comes with numerous ready-made sample patches, covering all kinds of 
instrument types. In addition to this there are plenty of single samples that can be 
used for creating your own patches.

If you want to record or edit your own samples, there are plenty of relatively inexpen-
sive (and even free) audio editing software for both the Windows and the Mac OS 
platforms, that will allow you to both record audio (via your computers or audio cards 
audio inputs), and to edit the resulting audio file. Virtually every product that is capable 
of this, can create sound files which can be loaded directly into the NN-19.

Also, there are thousands of high quality sample CD:s available, covering every con-
ceivable musical style or direction ranging from professionally recorded orchestral 
samples to esoteric electronic noises.

General Sampling Principles 
Background
Before a sound can be used by a sampler, it must be converted to a digital signal. 
Hardware samplers provide audio inputs that can convert the analog signal to digital, 
by the use of an “A/D Converter” (analog to digital). This “samples” the signal at very 
short time intervals and converts it to a digital representation of the analog signal’s 
waveform. The sample rate and the bit depth of this conversion determines the result-
ing sound quality. Finally the signal is passed through a digital to analog converter (D/
A) which reconstructs the digital signal back to analog, which can be played back. 

Multisampling vs. Single Samples
Most of the included NN-19 patches are made up of a collection of several samples. 
This is because a single sampled sound only sounds natural within a fairly narrow fre-
quency range. If a single sample is loaded into an empty NN-19, the sample will be 
playable across the whole keyboard. The pitch (frequency) of the original sample 
(called root-key) will be automatically placed on the middle C key (C3). 

Note that this has nothing to do with the actual pitch the sample itself produces! It 
may not even have a pitch as such, it could be the sound of someone talking for exam-
ple. 

If you play any single sample about two octaves above or below its root key, it will 
most likely sound very “unnatural”. In the case of it actually being a sample of some-
one talking, playing two octaves up will make the talking voice sample sound squeaky, 
short and most likely unintelligible. Two octaves down the voice will sound something 
like a drawn-out gargle.

Thus, the range that most samples can be transposed without sounding unnatural is 
limited. To make a sampled piano, for example, sound good across the whole key-
board, you need to first have made many samples at close intervals across the key-
board, and then define an upper and lower range for each sample, called a Key Zone. 
All the keyzones in the piano sample patch then make up a Key Map. 

How to create key zones is described on page 244.

To sample real instruments accurately requires a lot of hard work. Firstly, you need the 
original instrument, which should be in perfect working order. For acoustic instru-
ments you need a couple of good microphones, a mixer or other device with high 
quality microphone preamps, and a room with good acoustics. You need to be metic-
ulous when recording the different samples, so that levels are smooth and even 
across the range etc. 

Fortunately Reason provides a wide range of high quality multisampled instruments, 
so much of this hard work has already been done for you.

In our experience, most people don’t use samplers only for playing sampled versions 
of “real” instruments. Very often, single “stand alone” or single samples are used. 
Maybe you wish to use different sounds for every key zone. Or you could have com-
plete chorus and verse vocals plus variations assigned to several “one note” key 
zones. Or use samples of different chords that play rhythmic figures to the same 
tempo, and use these to build song structures etc. The possibilities are endless. 
When you use samples in this way, the keys on your keyboard that play the samples 
do not necessarily correspond to pitch at all, the keys are simply used to trigger the 
samples.
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About Audio File Formats
The NN-19 can read audio files in the following formats:

• Wave (.wav)
• AIFF (.aif)
• SoundFonts (.sf2)
• REX file slices (.rex2, .rex, .rcy) 
• Any sample rate and practically any bit depth.

! If you want the files to play back with their original bit depth - if higher 
than 16-bits - make sure to activate “Use High Resolution Samples” on 
the General page in the Preferences dialog. Otherwise, samples will be 
played back as 16-bit files in NN-19 regardless of their original bit depth. 

Wave and AIFF are the standard audio file formats for the PC and Mac platforms, re-
spectively. Any audio or sample editor, regardless of platform, can read and create au-
dio files in at least one of these formats.

SoundFonts are an open standard for wavetable synthesized audio, developed by E-
mu systems and Creative Technologies.

REX files are music loops created in the ReCycle program (see below). The NN-19 
lets you either load REX files as patches or separate slices from REX files as individ-
ual samples.

About the Sample Patch format

Reason’s Sample Patch format (.smp), is based on either Wave or AIFF files, but in-
cludes all the NN-19 associated parameter settings as well.

D The audio files may be stereo or mono. Stereo audio files are shown with 
a “S” symbol beside its name in the display.

Loading a Sample Patch
When you create a new NN-19 device, it is empty. That is, the “Init patch” in the NN-
19 does not contain any samples. For NN-19 to produce sound, you need to load ei-
ther a sample patch, or a sample. 

A patch contains “everything”. All the samples, assigned key zones, and associated 
panel settings will be loaded. Loading a sample patch is done using the patch 
browser, just like in all other devices that use Patches.

Open the folder that contains the NN-19 patch you wish to load, select it and click 
open.

Loading REX Files as Patches
REX Files are files created in the ReCycle program. This is an application created by 
Propellerhead Software, used for slicing up music loops and enabling them to be 
played back in any tempo. In Reason, REX files are primarily used in the Dr. Rex loop 
player, but they can be used in the NN-19 as well. Possible extensions are “.rx2”, 
“.rcy” and “.rex”.

When loading a REX file, each slice in the file is assigned to one key, chromatically. All 
parameters are set to default settings.

When using REX files in the DR. Rex loop player, it is possible to make a track play the 
slices in order to recreate the original loop. To do the same in the NN-19 requires a 
few extra steps.

1. Use the patch browser to load the REX file into an NN-19 sampler.

2. Create a Dr. Rex loop player and load the same REX file in to this device.

3. Use the To Track feature on the Dr. Rex to create playback data (a group) on 
the track assigned to the Dr. Rex.

4. Move that group to the track that plays the NN-19 and play it back from there.

5. Delete the Dr. Rex loop player.
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About Key Zones and 
Samples
Loading a Sample into an empty NN-19
1. Create a new sampler device.

2. Click on the sample browser button.
This is located above the keyboard display to the left.

✪ When you browse samples, you can preview them before loading using 
the browser Play button. If you select the Preview “Autoplay” function, 
the samples play back once automatically when selected.

3. Use the browser to select a sample and open it.

When you load the first sample into an empty NN-19, this will be assigned a key zone 
that spans the entire range of the keyboard, and the default Init Patch settings will be 
used.

Below the keyboard, the range, sample name, root key, tuning, level and loop status of 
the current key zone is displayed, each with a corresponding knob.

The light blue strip above the keyboard indicates the currently selected key zone, which is in this case 
the full range of the keyboard. 

The inverted note on the keyboard indicates the “root key” of the sample. All samples 
contain a root key, tuning and level setting. If NN-19 is empty, a sample will have its 
root key placed on the middle “C” (C3) key.

4. If desired, click on the keyboard to change the root key. 

! You can audition a loaded sample patch or sample by holding down [Op-
tion] (Mac)/[Alt] (Windows) and clicking on a key in the Keyboard dis-
play. The mouse will take on the shape of a speaker symbol to indicate 
this.

Loading SoundFont samples
The SoundFont format was developed by E-mu systems in collaboration with Creative 
Technologies. It is a standardized data format containing wavetable synthesized audio 
and information on how it should be played back in wavetable synthesizers - typically 
on audio cards. The SoundFont format is an open standard so there is a vast amount 
of SoundFont banks and SoundFont compatible banks developed by third parties.

The samples in a SoundFont are stored hierarchically in different categories: User 
Samples, Instruments, Presets etc. The NN-19 allows you to browse for and load sin-
gle SoundFont samples, but not entire soundfonts.

1. Use the sample browser to select a SoundFont file (.sf2) and open it.
The browser opens the SoundFont and displays the folders within it.

2. Select the folder “Samples” and open it.
This folder contains a number of samples which can be loaded like any other sam-
ple.

3. Select the desired sample and open it.
The sample is loaded and assigned a key zone range that spans the entire key-
board. You can now make settings for it as with any other sample.

Loading REX slices as samples
A slice is a snippet of sound in a REX File. To import a REX slice, click the sample 
browser button (see above), browse to a REX file and open it as if it was a folder. The 
browser will then display the slices as files inside that “folder”.

In the rest of this manual, when we refer to importing samples, all that is said applies 
to REX slices as well.
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Creating Key Zones
A “key zone” is a range of keys, that plays a sample. All key zones together make up a 
“key map”.

To create a new key zone, the following methods can be used:

D Select “Split Key Zone” from the Edit or context menus.
This splits the currently selected key zone in the middle. The new zone is the upper 
half of the split, and is empty. The dividing point has a “handle” above it, see “Set-
ting the Key Zone Range” below for a description.

D By [Alt]/[Option]-clicking at a point just above the key zone strip, a new 
empty key zone is created. 
The point where you click becomes the lower limit (or boundary) for the original 
key zone, and the upper limit for the new key zone. 

The new empty key zone gets selected upon creation.

Selecting Key Zones
Only one key zone can be selected at a time. A selected key zone is indicated by a 
light blue (as opposed to dark blue) strip above the keyboard in the display. There are 
two ways you can select key zones:

D By clicking on an unselected key zone in the display.

D By activating the “Select Key Zone via MIDI” button.
Playing a note belonging to an unselected key zone from your MIDI keyboard, will 
select the key zone it belongs to.

Setting the Key Zone Range 
! Key zones cannot overlap.

When you adjust the boundaries of a key zone, the surrounding boundaries are auto-
matically adjusted accordingly. 

You can change the key zone range in the following ways:

D By dragging the “handle(s)” which divides the key zones, you can change 
the range of the selected key zone.
In the case of having two key zones split in the middle, you could thus change the 
lower limit for the upper (new) key zone and the upper limit for the original key 
zone. 

D By using the “Lowkey” and “Highkey” knobs to set a lower and upper 
range, respectively.

Deleting a Key Zone
D To delete a key zone, select it and then select “Delete Key Zone” from 

the Edit menu. 
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About Key zones, Assigned and Unassigned Samples
When you load samples and rearrange your key mapping, you will often end up with 
samples that are not assigned to any key zone. In the following texts we refer to the 
samples as follows:

• Assigned samples are samples that are currently assigned to one ore more key 
zones.

• Unassigned samples are samples that reside in the sample memory, but that are 
currently not assigned to any key zone.

Adding Sample(s) to a Key Map

If the sample hasn’t been loaded yet

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the Sample Browser to add one, or several (see below), sample(s).

The following will happen:

D If the zone contained a sample prior to loading, this will be replaced, 
both in the zone and in the sample memory, unless the sample was also 
used by another key zone, in which case it will be kept.

D If you loaded several samples, one of the samples will be assigned to the 
key zone, and the other samples will be loaded but remain unassigned.

If the sample is already loaded but unassigned

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the Sample knob to dial in the sample you want the key zone to play.

The Sample knob.

Setting the Root Key
Once you have defined a key zone, and added a sample, you should set the root key 
for the sample. 

D Select the key zone the sample belongs to, and click on the key you wish 
to set the root key to.
Which key to select is normally determined by the pitch of the sample. For exam-
ple if the sample plays a F#2 guitar note, click on F#2.

✪ Note that it is possible to select a root key outside the key zone, if re-
quired.

Removing Sample(s) from a Key Map
D To remove a sample, select the zone it belongs to, and then select “De-

lete Sample” from the Edit or context menus.
The sample is removed from the zone and from sample memory.

D To remove a sample from a key zone/map, without removing it from 
memory, you can either select “No Sample” with the Sample knob for 
that zone, or simply replace it with another sample in the same way.

Removing All Unassigned Samples
D To remove all samples that are not assigned to any key zone, select De-

lete Unused Samples from the Edit menu.

Rearranging Samples in a Key Map
There is no specific function for rearranging or trading places between samples and 
key zones. Simply select a key zone and change the current sample assignment with 
the Sample knob.

Setting Sample Level
For each key zone you can set a volume level, using the Level button below the dis-
play. If the transition between two key zones causes a noticeable level difference, this 
parameter can be used to balance the levels.

Tuning Samples
Sometimes you might find that the samples you wish to use in a key map are slightly 
out of tune with each other. This parameter allows you to tune each sample in a map 
by +/– half a semitone. 

D Select the key zone(s) that contains the out of tune sample(s), and use 
the Tune knob below the keyboard display. 

✪ If all samples originate from different sources, and all or most of them 
are pitched slightly different (a not uncommon sampling scenario), you 
could first tune them so that they all match each other, and then, if nec-
essary, use the Sample Pitch controls in the Osc section to tune them 
globally to the “song” you wish to use the samples in.

D Note that if all the samples were slightly out of tune by the same amount 
in relation to the song you intend to use the samples in, it would be much 
simpler to use the Sample Pitch controls in the Osc section directly.
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Looping Samples

A sample, unlike the cycles of an oscillator for example, is a finite quantity. There is a 
sample start and end. To get samples to play for as long as you press down the keys 
on your keyboard, they need to be looped. 

For this to work properly, you have to first set up two loop points which determine the 
part of the sample that will be looped, and make this a part of the audio file. You can-
not set loop points in the NN-19, this has to be done in a sample editor. 

All included samples already have set loop points (if needed).

For each sample (or key zone), you can select the following Loop modes by using the 
Loop knob below the keyboard display:

D OFF
No looping is applied to the sample.

D FWD
The part between the loop points plays from start to end, then the cycle is re-
peated. This is the most common loop mode.

D FWD - BW
The part between the loop points plays from start to end, then from end to start 
(backwards), and then repeats the cycle. 

! For samples without any loop points, the whole sample will be looped.

About the Solo Sample Function
The Solo Sample button will allow you to listen to a selected sample over the entire 
keyboard range.

D Select the key zone the sample is assigned to, and then activate Solo 
Sample.
This can be useful for checking if the root key is set correctly or if the current range 
is possible to extend etc.

! For Solo Sample to work, “Select Key Zone via MIDI” must be disabled!

Automap Samples
If you have a number of samples that belong together, but haven’t mapped them to 
key zones you can use the “Automap Samples” function on the Edit menu. This is 
used in the following way:

1. Select all samples that belong together and load them in one go, using the 
sample browser.
One of the samples will be assigned to a key zone spanning the whole range, and 
the rest will be loaded in to memory but remain unassigned.

2. Select Automap Samples from the Edit menu.

Now all samples currently in memory (assigned or unassigned) will be arranged auto-
matically so that:

D Each sample will be placed correctly according to its root note, and will 
be tuned according to the information in the sample file.
Most audio editing programs can save root key information as part of the file.

D Each sample will occupy half the note range to the next sample’s root 
note.
The root key will always be in the middle of each zone, with the zone extending 
both down and up in relation to the root position.

Mapping Samples Without Root Key or Tuning 
Information
Some samples may not have any information about root key or tuning stored in the file. 
If the file names indicate the root key you can manually set it for each sample using the 
method described below. In a worst case scenario, i.e. no tuning or root key informa-
tion whatsoever, you can still make use of the Automap function:

1. Select all samples that belong together and load them in one go, using the 
sample browser.
One of the samples will be assigned to a key zone spanning the whole range, and 
the rest will be loaded in to memory but remain unassigned.

2. Manually set the root key, and adjust the tune knob if the sample needs fine-
tuning.
Without any information stored in the file, or if the file name doesn’t indicate the 
root key, you will have to use your ears for this step. Play the sample and use an-
other instrument or a tuner to determine its pitch.

3. Select the next sample using the Sample knob, and repeat the previous step.
Proceed like this until you have set a root key for all the samples in memory.

4. Select “Automap Samples” from the edit menu.
The samples will be mapped according to their set root key positions!

How Mapping Information is Saved
All information about key zones, high and low range, root key etc. is stored as part of 
the Sampler Patch. The original sample files are never altered!
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NN-19 Synth Parameters
The NN-19 synth parameters are used to shape and modulate samples. These are 
mostly similar to the parameters used to shape the oscillators in Subtractor - you have 
envelope generators, a filter, velocity control etc. Again, it is important to remember 
that these parameters do not alter the audio files in any way, only the way they will play 
back.

! These parameters are global, in the sense that they will affect all sam-
ples in a sample patch.

The Oscillator Section

For a sample patch, the actual samples are what oscillators are for a synthesizer, the 
main sound source. The following settings can be made in the Osc section of the NN-
19:

Sample Start

This changes the start position of samples in a sample patch. Turning the knob clock-
wise gradually offsets the samples’ start position, so that they will play back from a po-
sition further “into” the samples’ waveform. This is useful mainly for two things:

D Removing “air” or other unwanted artefacts from the start of less than 
perfect samples.
Occasionally (although not in any samples supplied with Reason) you may come 
across samples where the start point of the sample is slightly ahead of the start of 
the actual sound. There may be noise or silence in the beginning which was not in-
tended to be part of the sample. By adjusting the sample start position, this can be 
removed.

D Changing the start point as an effect.
For example, if you had a sample of someone saying “one, two, three”, you could 
change the start position so that when you played the sample it would start on 
“three”. 

✪ You can also assign velocity sample start allowing to use your playing to 
determine the exact sample start. See later in this chapter.

Setting Sample Pitch - Octave/Semitone/Fine

By adjusting the corresponding knobs you can change the pitch of all samples be-
longing to a patch, in three ways:

D Octave steps 
The range is 0 - 8. The default setting is 4. 

D Semitone steps 
Allows you to raise the frequency in 12 semitone steps (1 octave).

D Fine steps (100th of a semitone) 
The range is -50 to 50 (down or up half a semitone).

! Note that the controls in this section cannot be used to tune samples 
against each other, as all samples will be affected equally. To tune indi-
vidual samples, you use the Tune parameter below the keyboard display 
(see page 246).

Keyboard Tracking

The Osc section has a button named “Kbd. Track”. If this is switched off, the sample’s 
pitch will remain constant, regardless of any incoming note pitch messages, although 
the oscillator still reacts to note on/off messages. This could be useful if you are using 
non-pitched samples, like drums for example. You could then play a sample in a zone 
using several keys, allowing for faster note triggering if you wanted to play a drum roll, 
for example.

Osc Envelope Amount

This parameter determines to what degree the overall pitch of the samples will be af-
fected by the Filter Envelope (see page 250). You can set negative or positive values 
here, which determines whether an envelope parameter should raise or lower the 
pitch.
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The Filter Section

Filters are used for shaping the overall timbre of the sound. The filter in NN-19 is a 
multimode filter with five filter types.

Filter Mode

With this selector you can set the filter to operate as one of five different types of filter. 
These are as follows:

D 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. This 
filter type has a fairly steep roll-off curve (24dB/Octave). Many classic synthesizers 
(Minimoog/Prophet 5 etc.) used this filter type.

D 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in classic analog synthesizers (Ober-
heim, TB-303 etc.). It has a gentler slope (12 dB/Octave), leaving more of the har-
monics in the filtered sound compared to the LP 24 filter.

D Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange frequencies 
are not affected. Each slope in this filter type has a 12 dB/Octave roll-off.

D High-Pass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out the lower frequen-
cies and letting the high frequencies pass. The HP filter slope has a 12 dB/Octave 
roll-off.

D Notch
A notch filter (or band reject filter) could be described as the opposite of a band-
pass filter. It cuts off frequencies in a narrow midrange band, letting the frequen-
cies below and above through. 

Filter Frequency 

The Filter Frequency parameter (often referred to as “cutoff”) determines which area 
of the frequency spectrum the filter will operate in. For a lowpass filter, the frequency 
parameter could be described as governing the “opening” and “closing” of the filter. If 
the Filter Freq is set to zero, none or only the very lowest frequencies are heard, if set 
to maximum, all frequencies in the waveform are heard. Gradually changing the Filter 
Frequency produces the classic synthesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the Fil-
ter Envelope (see “Envelope Section” below) as well. Changing the Filter 
Frequency with the Freq slider may therefore not produce the expected 
result.

Resonance

The filter resonance parameter (sometimes called Q) is used to set the Filter charac-
teristic, or quality. For lowpass filters, raising the filter Res value will emphasize the fre-
quencies around the set filter frequency. This produces a generally thinner sound, but 
with a sharper, more pronounced filter frequency “sweep”. The higher the resonance 
value, the more resonant the sound becomes until it produces a whistling or ringing 
sound. If you set a high value for the Res parameter and then vary the filter frequency, 
this will produce a very distinct sweep, with the ringing sound being very evident at 
certain frequencies.

• For the highpass filter, the Res parameter operates just like for the lowpass filters.
• When you use the Bandpass or Notch filter, the Resonance setting adjusts the 

width of the band. When you raise the Resonance, the band where frequencies 
are let through (Bandpass), or cut (Notch) will become narrower. Generally, the 
Notch filter produces more musical results using low resonance settings.

Envelope Section
Envelope generators are used to control several important sound parameters in ana-
log synthesizers, such as pitch, volume, filter frequency etc. Envelopes govern how 
these parameters should respond over time - from the moment a note is struck to the 
moment it is released. 

Standard synthesizer envelope generators have four parameters; Attack, Decay, Sus-
tain and Release (ADSR). 

There are two envelope generators in the NN-19, one for volume, and one for the filter 
frequency.

! Please refer to the Subtractor chapter for a description of the basic enve-
lope parameters.

Amplitude Envelope
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The Amp Envelope is used to adjust how the volume of the sound should change from 
the time you press a key until the key is released. By setting up a volume envelope you 
sculpt the sound’s basic shape with the four Amplitude Envelope parameters, Attack, 
Decay, Sustain and Release. This determines the basic character of the sound (soft, 
long, short etc.). The Level parameter acts as a general volume control for the sample 
patch.

Filter Envelope

The Filter Envelope can be used to control two parameters; filter frequency and sam-
ple pitch. By setting up a filter envelope you control the how the filter frequency and/
or the sample pitch should change over time with the four Filter Envelope parameters, 
Attack, Decay, Sustain and Release. 

Filter Envelope Amount

This parameter determines to what degree the filter will be affected by the Filter Enve-
lope. Raising this knob’s value creates more drastic results. The Envelope Amount pa-
rameter and the set filter frequency are related. If the Filter Freq slider is set to around 
the middle, this means that the moment you press a key the filter is already halfway 
open. The set Filter Envelope will then open the filter further from this point. The Filter 
Envelope Amount setting affects how much further the filter will open.

Filter Envelope Invert

If this button is activated, the envelope will be inverted. For example, normally the De-
cay parameter lowers the filter frequency, but after activating Invert it will instead raise 
it, by the same amount. Note that Invert does not affect the Osc pitch parameter (this 
can be inverted by setting positive or negative values).

LFO Section

LFO stands for Low Frequency Oscillator. LFOs are oscillators in the sense that they 
generate a waveform and a frequency. However, there are two significant differences 
compared to normal sound generating oscillators:

• LFOs only generate waveforms with low frequencies.
• The output of the two LFOs are never actually heard. Instead they are used for 

modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound generat-
ing) oscillator or sample, to produce vibrato. 

The LFO section has the following parameters:

Waveform

LFO 1 allows you to select different waveforms for modulating parameters. These are 
(from the top down):

Destination

The available LFO Destinations are as follows:

|Waveform |Description
Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted
Sawtooth

This produces a “ramp up” cycle. If applied to an oscillator’s fre-
quency, the pitch would sweep up to a set point (governed by the 
Amount setting), after which the cycle immediately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but in-
verted.

Square This produces cycles that abruptly changes between two values, 
usable for trills etc.

Random Produces random stepped modulation to the destination. Some vin-
tage analog synths called this feature “sample & hold”.

Soft Random The same as above, but with smooth modulation.

|Destination |Description
Osc Selecting this makes LFO control the pitch (frequency) of the sam-

ple patch.

Filter Selecting this makes the LFO control the filter frequency. 

Pan Selecting this makes the LFO modulate the pan position of sam-
ples, i.e. it will move the sound from left to right in the stereo field.
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Sync

By clicking this button you activate/deactivate LFO sync. The frequency of the LFO 
will then be synchronized to the song tempo, in one of 16 possible time divisions. 
When sync is activated, the Rate knob (see below) is used for setting the desired time 
division.

Turn the knob and check the tooltip for an indication of the time division.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modulation 
rate.

Amount

This parameter determines to what degree the selected parameter destination will be 
affected by the LFO. Raising this knob’s value creates more drastic results.

Play Parameters
This section deals with two things: Parameters that are affected by how you play, and 
modulation that can be applied manually with standard MIDI keyboard controls. 

These are:

• Velocity Control
• Pitch Bend and Modulation Wheel
• Legato
• Portamento
• Polyphony
• Voice Spread
• External Controllers

Velocity Control

Velocity is used to control various parameters according to how hard or soft you play 
notes on your keyboard. A common application of velocity is to make sounds brighter 
and louder if you strike the key harder. By using the knobs in this section, you can con-
trol how much the various parameters will be affected by velocity. The velocity sensi-
tivity amount can be set to either positive or negative values, with the center position 
representing no velocity control. 

The following parameters can be velocity controlled:

|Destination |Description
Amp This let’s you velocity control the overall volume of the sound. If a 

positive value is set, the volume will increase the harder you strike a 
key. A negative value inverts this relationship, so that the volume de-
creases if you play harder, and increases if you play softer. If set to 
zero, the sound will play at a constant volume, regardless of how 
hard or soft you play.

F. Env This sets velocity control for the Filter Envelope Amount parameter. 
A positive value will increase the envelope amount the harder you 
play. Negative values invert this relationship.

F. Dec This sets velocity control for the Filter Envelope Decay parameter. A 
positive value will increase the Decay time the harder you play. Neg-
ative values invert this relationship.

S.Start This sets velocity control for the Sample Start parameter. A positive 
value will increase the Start Time amount the harder you play. Neg-
ative values invert this relationship.

A. Attack This sets velocity control for the Amp Envelope Attack parameter. A 
positive value will increase the Attack time the harder you play. Neg-
ative values invert this relationship.
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Pitch Bend and Modulation Wheels
The Pitch Bend wheel is used for “bending” notes, like bending the strings on a guitar. 
The Modulation wheel can be used to apply various modulation while you are playing. 
Virtually all MIDI keyboards have Pitch Bend and Modulation controls. NN-19 also has 
two functional wheels that could be used to apply real time modulation and pitch 
bend should you not have these controllers on your keyboard, or if you aren’t using a 
keyboard at all. The wheels mirror the movements of the MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is turned fully up 
or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of parameters. 
You can set positive or negative values, just like in the Velocity Control section. The 
following parameters can be affected by the modulation wheel:

Legato
Legato works best with monophonic sounds. Set Polyphony (see below) to 1 and try 
the following:

D Hold down a key and then press another key without releasing the previ-
ous.
Notice that the pitch changes, but the envelopes do not start over. That is, there 
will be no new “attack”. 

D If polyphony is set to more voices than 1, Legato will only be applied 
when all the assigned voices are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 note 
chord, the next note you played would be Legato. Note, however, that this Legato 
voice will “steal” one of the voices in the 4 note chord, as all the assigned voices 
were already used up!

Retrig
This is the “normal” setting for playing polyphonic patches. That is, when you press a 
key without releasing the previous, the envelopes are retriggered, like when you re-
lease all keys and then press a new one. In monophonic mode, Retrig has an addi-
tional function; if you press a key, hold it, press a new key and then release that, the 
first note is also retriggered.

Portamento (Time)
Portamento is when the pitch “glides” between the notes you play, instead of instantly 
changing the pitch. The Portamento knob is used to set how long it takes for the pitch 
to glide from one pitch to the next. If you don’t want any Portamento at all, set this 
knob to zero.

Setting Number of Voices - Polyphony
This determines the polyphony, i.e. the number of voices a patch can play simulta-
neously. This can be used to make a patch monophonic (=a setting of “1”), or to ex-
tend the number of voices available for a patch. The maximum number of voices you 
can set a patch to use is 99. 

! Note that the Polyphony setting does not “hog” voices. For example, if 
you have a patch that has a polyphony setting of ten voices, but the part 
the patch plays only uses four voices, this won’t mean that you are “wast-
ing” six voices. In other words, the polyphony setting is not something 
you need to consider if you want to conserve CPU power - it is only the 
number of voices actually used that counts.

|Destination |Description
F. Freq This sets modulation wheel control of the Filter Frequency parame-

ter. A positive value will increase the frequency if the wheel is 
pushed forward. Negative values invert this relationship.

F. Res This sets modulation wheel control of the Filter Resonance parame-
ter. A positive value will increase the resonance if the wheel is 
pushed forward. Negative values invert this relationship.

F. Dec This sets modulation wheel control for the Filter Envelope Decay pa-
rameter. A positive value will increase the decay if the wheel is 
pushed forward. Negative values invert this relationship.

LFO This sets modulation wheel control of the LFO Amount parameter. A 
positive value will increase the Amount if the wheel is pushed for-
ward. Negative values invert this relationship.

Amp This sets modulation wheel control for the Amp level parameter. A 
positive value will increase the level if the wheel is pushed forward. 
Negative values invert this relationship.
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Voice Spread
This parameter can be used to control the stereo (pan) position of voices. The Spread 
knob determines the intensity of the panning. If this is set to “0”, no panning will take 
place. The following pan modes can be selected:

Low Bandwidth
This will remove some high frequency content from the sound, but often this is not no-
ticeable (this is especially true if you have “filtered down” samples). Activating this 
mode will save you some extra computer power, if needed.

Controller Section
NN-19 can receive common MIDI controller messages, and route these to various pa-
rameters. The following MIDI messages can be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending Aftertouch messages, or if you have ac-
cess to an Expression Pedal or a Breath controller, you can use these to modulate 
NN-19 parameters. The “Source” selector switch determines which of these mes-
sage-types should be received.

These messages can then be assigned to control the following parameters:

Connections
On the back panel of the NN-19 you will find the connectors, which are mostly CV/
Gate related. 

Audio Outputs
These are the main left and right audio outputs. When you create a new NN-19 de-
vice, these are auto-routed to the first available channel on the audio mixer.

Mono Sequencer Control
These are the main CV/Gate inputs. CV controls the note pitch. Gate inputs trigger 
note on/off values plus a level, which can be likened to a velocity value. If you want to 
control the NN-19 from a Matrix Pattern Sequencer for example, you would normally 
use these inputs. The inputs are “mono”, i.e. they control one voice in the sampler.

Modulation Inputs
! Remember that CV connections will not be stored in the sample patch, 

even if the connections are to/from the same NN-19 device! 

These control voltage (CV) inputs (with associated voltage trim pots), can modulate 
various NN-19 parameters from other devices, or from the modulation outputs of the 
same NN-19 device. These inputs can control the following parameters:

• Osc (sample) Pitch
• Filter Cutoff
• Filter Resonance
• Amp Level 
• Mod Wheel

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other param-
eters in the same NN-19 device. The Modulation Outputs are:

• Filter Envelope 
• LFO 

|Mode |Description
Key This will shift the pan position gradually from left to right the higher up on 

the keyboard you play.

Key 2 This will shift the pan position from left to right in 8 steps (1/2 octave) for 
each consecutive higher note you play, and then repeat the cycle.

Jump This will alternate the pan position from left to right for each note played.

F. Freq This sets external modulation control of the filter frequency parameter. A 
positive value will increase the frequency with higher external modulation 
values. Negative values invert this relationship.

LFO 1 This sets external modulation control of the LFO Amount parameter. A 
positive value will increase the LFO amount with higher external modula-
tion values. Negative values invert this relationship.

Amp This let’s you control the overall volume of the sound with external modu-
lation. If a positive value is set, the volume will increase with higher exter-
nal modulation values. A negative value inverts this relationship.
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Gate Inputs
These inputs can receive a CV signal to trigger the envelopes. Note that connecting 
to these inputs will override the “normal” triggering of the envelopes. For example, if 
you connected a LFO output to the Gate Amp input, you would not trigger the amp 
envelope by playing notes, as this is now controlled by the LFO. In addition you would 
only hear the LFO triggering the envelope for the notes that you hold down.

• Amp Envelope
• Filter Envelope
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Introduction
Features
The basic functions of the NN-XT are very similar to those of its sampler companion in 
the Reason rack - the NN-19. Just like the NN-19, NN-XT lets you load samples and 
create multi-sample patches by mapping samples across the keyboard. The sound 
can then be modified by a comprehensive set of synth-type parameters. There are 
however some major differences between the two. The NN-XT has:

D Support for SoundFonts.
Presets and samples from SoundFont banks can be loaded and used in the NN-
XT (see page 257).

D 8 stereo output pairs.
This makes it possible to route different samples to different mixer channels for in-
dividual effect processing (see page 276).

D The possibility to create layered sounds. 
This is done by mapping several samples across the same keyboard range (see 
page 272).

D The possibility to create sounds that only play over certain velocity 
ranges, velocity switched key maps and velocity crossfading.
See page 273.

D Key maps with individual synth parameter settings for each sample.
See page 277.

Even though the NN-XT is a more advanced sample player than NN-19, it should not 
be considered as a successor to the NN-19, but rather as a complement to it. The 
NN-19 will for example probably still be the sampler of choice for those of you who 
want to be able to quickly load a couple of samples and start playing, since that par-
ticular aspect takes a little more doing with the NN-XT.

Panel Overview
The Main Panel
When the NN-XT is added to the rack, you will initially only see the main panel.

The NN-XT main panel.
The main panel is where you load complete sample patches. It also contains the “glo-
bal controls”. These are controls that affect and modify the sound of entire patches 
rather than the individual key zones.

The Remote Editor panel
To show/hide the remote editor panel, use the fold/unfold arrow at the bottom left.

The remote editor panel is where you load individual samples, create key maps, mod-
ify the sound of the samples with synth parameters etc.

! The main panel of the NN-XT can be folded like any other Reason device. 
Note that folding the main panel will also fold the remote editor regard-
less of its current state.

Click this 
arrow...

...to make the 
remote editor 
panel visible.
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Loading Complete Patches 
and REX Files
As previously alluded, you can load complete sample patches as well as individual 
samples into the NN-XT.

• A patch is a complete “sound package”. It contains information about all the sam-
ples used, assigned key zones, associated panel settings etc. Loading a sample 
patch is done by using the patch browser on the main panel, and works in the 
same way as with any other Reason device.

The patch browser button on the main panel.

For general instructions on how to load and save patches, please see page 29.

• Loading separate samples is done in a similar way, but via the sample browser on 
the remote editor panel. If you load samples, map them across keyboard ranges 
and set up the sound the way you want it, you can save your settings as a Patch 
for easy access later.

The sample browser button on the remote editor.

More about loading samples later in this chapter.

Loading NN-XT Patches
NN-XT Patches are patches made specifically for the NN-XT. Reason ships with a 
large number of NN-XT Patches, some in the Factory Sound Bank but most in the 
Orkester Sound Bank. NN-XT Patches have the extension “.sxt”.

Loading NN-19 Patches
NN-19 Patches have the extension “.smp”. Note that when loading NN-19 patches 
into the NN-XT, some parameters will not be applicable since the NN-19 and the NN-
XT to some extent differ from each other in terms of controls. In these cases, the con-
cerned parameters will either be ignored by the NN-XT or mapped to the most equiv-
alent control.

Loading SoundFonts
The SoundFont format was developed by E-mu systems in collaboration with Creative 
Technologies. It is a standardized data format containing wavetable synthesized audio 
and information on how it should be played back in wavetable synthesizers - typically 
on audio cards. The SoundFont format is an open standard so there is a vast amount 
of SoundFont banks and SoundFont compatible banks developed by third parties.

Loading SoundFonts is no different from loading NN-XT Patches. As with NN-19 
Patches, the NN-XT does its best to map all the SoundFont settings to NN-XT param-
eters.

You can load SoundFont presets by using the patch browser, and single SoundFont 
samples by using the sample browser.

Loading Complete REX Files as Patches
REX Files are files created in the ReCycle program. This is an application created by 
Propellerhead Software, used for slicing up music loops and enabling them to be 
played back in any tempo. In Reason, REX files are primarily used in the Dr. Rex loop 
player, but they can be used in the NN-XT as well. Possible extensions are “.rx2”, 
“.rcy” and “.rex”.

When loading a REX file, each slice in the file is assigned to one key, chromatically. All 
parameters are set to default settings.

When using REX files in the DR. Rex loop player, it is possible to make a track play the 
slices in order to recreate the original loop. To do the same in the NN-XT requires a 
few extra steps.

1. Use the patch browser to load the REX file into an NN-XT sampler.

2. Create a Dr. Rex loop player and load the same REX file in to this device.

3. Use the To Track feature on the Dr. Rex to create playback data (a group) on 
the track assigned to the Dr. Rex.

4. Move that group to the track that plays the NN-XT and play it back from there.

5. Delete the Dr. Rex loop player.
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Using the Main Panel
All of the controls on the main panel are used for globally modifying certain parame-
ters for all of the samples in a patch, by the same amount.

! Movements of the parameters on the main panel can be recorded as au-
tomation. However, controls on the remote editor panel (described later) 
can not!

The following is a description of the controls and parameters on the main panel.

The Pitch Bend and Modulation wheels

Most MIDI keyboards come equipped with Pitch Bend and Modulation wheels. The 
NN-XT features settings for how incoming MIDI Pitch Bend and Modulation wheel 
messages should affect the sound. The wheels on the NN-XT will also mirror the 
movements of the wheels on your MIDI keyboard.

If you don’t have Pitch Bend or Modulation controls on your keyboard, or if you aren’t 
using a keyboard at all, you can use the two fully functional wheels on the NN-XT to 
apply real time modulation and pitch bend.

• The Pitch Bend wheel is used for “bending” the played notes up and down to 
change their pitch - much like bending the strings on a guitar or other string instru-
ment. The Pitch Bend Range is set on the remote editor panel (see page 279).

• The Modulation wheel can be used for applying modulation to the sound while 
you’re playing. It can also be used for controlling a number of other parameters, as 
described on page 277.

External control

This section can be used in three ways:

Receiving MIDI controller messages from external sources

NN-XT can receive common MIDI controller messages, and route these to various pa-
rameters. You use the “Source” selector switch to determine which type of message 
should be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending aftertouch messages, and/or if you have 
connected an expression pedal or a breath controller to it, you can use these to mod-
ulate NN-XT parameters. Which parameters should be modulated is set in the remote 
editor panel (see page 277).

Recording MIDI controller messages with the wheel

The wheel in the external control section can be used for recording any or all of the 
three MIDI controller message types into the Reason sequencer. If your MIDI key-
board isn’t capable of sending aftertouch messages or you don’t have access to an 
expression pedal or a breath controller, you can use the wheel instead. 

This is done just as with any other automation recording, see page 64

High Quality Interpolation

This switch turns High Quality Interpolation on and off. When it is activated, the sam-
ple pitch is calculated using a more advanced interpolation algorithm. This results in 
better audio quality, especially for samples with a lot of high frequency content.

• High Quality Interpolation uses more computer power however - so if you don’t 
need it, it’s a good idea to turn it off! Listen to the sounds in a context and deter-
mine whether you think this setting makes any difference.

• If you are using a Macintosh with a G4 or G5 (Altivec) processor, High Quality In-
terpolation is always activated, regardless of the state of this button.

Global Controls
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All of these knobs change the values of various parameters in the remote editor panel 
and affect all loaded samples. Thus they can be used for quickly adjusting the overall 
sound.

The knobs are bi-polar, which means that when they are centered, no parameter 
change is applied. By turning them to the right you increase the corresponding value, 
and by turning them to the left, you decrease the value.

Again, the movements of these parameters can be recorded as automation. This is 
done just as with any other automation recording, see page 64.

The controls are, from left to right:

Filter

These two knobs each control a parameter of the filter (see page 279). Note that the 
filter must be on for these to have any effect.

D Frequency
This changes the cutoff frequency of the filter. 

D Resonance
This changes the resonance parameter of the filter, meaning - the filter character-
istic, or quality.

Amp Envelope

These three knobs control the Amplitude Envelope (see page 281) in the following 
way:

D Attack
This changes the Attack value of the Amplitude Envelope. That is, how long it 
should take for the sound to reach full level after you press a key on your keyboard.

D Decay
This changes the Decay value of the Amplitude Envelope. Decay determines how 
long it should take for the sound to go back to the sustain level after it has reached 
full value (see page 281) and the key that triggered the sound is still being 
pressed.

D Release
This changes the Release value of the Amplitude Envelope. Release works just like 
Decay with the exception that it determines how long it should take for the sound 
to become silent after the key has been released.

Mod Envelope

This knob controls the Decay value of the Modulation Envelope (see page 280). 
Also see above for a brief description of Decay.

Master Volume

This controls the main volume out from the NN-XT. Turn the knob to the right to in-
crease the volume.

Overview of the Remote 
Editor panel
It is in the Remote Editor Panel that the main NN-XT action is going on, especially if 
you’re creating your own patches. The remote editor is dominated by the key map dis-
play, and this is also the part on which we will concentrate to begin with.

The Key Map display
The key map display consists of a number of separate areas that let you do different 
things. To help you navigate the key map display, these areas are described below.

The Info area

This displays the following information about the currently selected sample: Sample 
rate, mono/stereo information, bit resolution and file size.

The Sample area

This area displays the names of the samples in each zone. It also allows you to change 
the order of the zones by clicking and dragging them up and down.

The Group area

This area does not show any information. However, by clicking in it, you can instantly 
select all the zones that belong to a certain group. See page 266 for information on 
how to create groups.

The Keyboard area

Aside from the fact that is a guideline for setting up key ranges, it is also used for set-
ting the root keys of, and auditioning loaded samples. See page 270 and page 265 
respectively for more information.

The Info area.

The Sample 
area.

The Group
area.

The Keyboard area. The Tab Bar area.

The Key Range area.

The Scrollbars.
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The Tab Bar area

This area gives you a visual indication of the key range of a selected zone. By clicking 
and dragging the “handles” at the key range boundaries, you can resize the key 
ranges, and by clicking in between the handles, you can move the key ranges without 
changing their length.

The Key Range area

This area in the middle of the key map display is where you keep track of all the zones 
and the relationship between them. You can also move and resize the zones just like 
in the Tab Bar area, as described above.

The Scrollbars

There are both horizontal and vertical scrollbars that work just like regular scrollbars. 
Whenever there is more information in the key map display than what fits on a “single 
screen”, you can use the scrollbars to reveal it. Either click on the arrows or click and 
drag the scrollbar handles.

Sample Parameters

This area shows the current values of basic parameters you can set for zones, such as 
root key, play mode, output etc. The parameters are changed by using the knobs di-
rectly below the key map display.

Group Parameters

These parameters are adjusted on a per group basis (see page 276 for more informa-
tion on groups). Most of them relate to performance or playing style.

Synth Parameters

The bulk of the parameters on the remote editor are used for adjusting the sound of 
the samples by applying filtering, envelope shaping, modulation (like vibrato and trem-
olo) and so on. We call these the synth parameters, since they are to a large extent 
identical to those on a regular synthesizer.

About Samples and Zones
For a clear understanding of the terminology used when describing the various oper-
ations that can be performed in the key map display, it is important to clarify the dis-
tinction between a sample and a zone:

• A Sample is a piece of audio that can be loaded into the NN-XT and played back.
• A Zone could be viewed as a “container” for a loaded sample.

All loaded samples are placed in “Zones” in the key map display. You can then orga-
nize the zones as you please, and make various settings such as key- and velocity 
ranges separately for each zone.

In other words, the settings you make are actually performed on the zones, but affect 
the samples in them. Hence, when we talk about making settings for a zone, it is syn-
onymous with making settings for a sample - the sample that the zone contains.

• Two or more zones can play the same sample, but with different parameter set-
tings, making them sound completely different.

• A zone can be empty, playing no sample at all.
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Selections and Edit Focus
Almost all operations in the remote editor are performed on one or more selected 
zones or on the zone with edit focus. Several zones can be selected at once, but only 
one zone at a time can have edit focus.

This is important since:

D Editing operations that can be performed on several zones (like delet-
ing), always apply to the selected zones.

D Editing operations that can be performed on one zone only, always apply 
to the zone with edit focus.

D The front panel always shows the settings for the zone with edit focus.

Here no zone is selected.

Here the middle zone is selected but does not have edit focus.

Here the middle zone has edit focus but is not selected. Notice the thicker border and the additional 
handles in the key range area.

Here the middle zone is selected and has edit focus.

Here, all three zones are selected, but the middle one has edit focus.

Selecting Zones
D To select a zone, click on it.

Clicking on a zone will also automatically give it edit focus.

You can also select multiple zones in several ways:

D By holding down [Shift] or [Command] (Mac)/[Ctrl] (Windows) and click-
ing on the zones you wish to select.
This way you can select several non-contiguous zones. You can also deselect a 
selected zone by clicking on it again.

D By using the keyboard command [Command]-[A] (Mac)/[Ctrl]-[A] (Win-
dows). 
This will select all of the zones in the key map display. To deselect all zones, click 
in an unoccupied area in the Sample column or the key map area.

D By clicking and dragging a selection box in the key map area.

Note that the zones don’t have to be completely encompassed by the selection box. 
The selection box only have to intersect parts of the zones to include them in the se-
lection.

Making a selection box like this....

...will select these zones:



NN-XT SAMPLER
262

Selecting zones via MIDI

You can also select zones via your MIDI keyboard. By clicking the button marked “Se-
lect zones via MIDI” above the key map display so that it lights up, you enable selec-
tion via MIDI.

This way, you can select a zone and give it edit focus by pressing a key that lies within 
the zone’s key range (see later in this chapter for information about setting up key 
ranges).

In this case, this zone can be selected by pressing any key between C2 - C3 on your MIDI keyboard.

Note also, that selection via MIDI is velocity sensitive. Zones may have specific veloc-
ity ranges. This means that they won’t be played unless the key that triggers the zone 
is played with a certain velocity. The same rules apply when selecting via MIDI, only 
zones that meet the velocity criteria will be selected. Read more about setting up ve-
locity ranges on page 273.

Selecting All Zones in a Group

The concept of zone groups is fully introduced on page 266. For now we will only de-
scribe how to select all samples that belong to the same group:

Moving Edit Focus

Moving Edit Focus

A zone can be given edit focus independently of selection:

D When you click on an unselected zone, it both gets selected and gets 
edit focus.

D When you select several zones using [Shift] or [Command]/[Ctrl], the 
one you select last always gets edit focus.

D To set edit focus to a zone when several zones are already selected, click 
on it without holding down any modifier keys.
This way, you can move edit focus between the selected zones freely without de-
selecting any of them.

Clicking in the 
Group column...

...selects all 
zones in the 
group
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Adjusting Parameters
Adjusting Synth Parameters
The synth parameters are the ones that occupy the bulk of the remote editor panel 
(see page 260). Changes you make to synth parameters always apply to all selected 
zones.

D The panel always shows the settings for the zone with edit focus.
More about this below.

D To make adjustments to one zone, select it (which also gives it edit fo-
cus) and adjust the parameter on the front panel.

D To set several zones to the same value, select them and adjust the pa-
rameter.
All zones will be set to the same value for the parameter you adjusted. 

Adjusting Group Parameters
Group parameters apply to a group. That is, they are settings that are shared by all 
zones in a group.

D To make adjustments to one group, select one or more zones that be-
long to the group, and adjust the parameter on the front panel.

D To set several groups to the same value, select at least one zone in each 
group you want to adjust, and adjust the parameter.
All groups will be set to the same value. More about this below.

About “Conflicting” Parameters

Often you will find yourself in a situation where you select multiple zones and parame-
ter settings differ between them. This is quite normal. For example, you will often find 
yourself making adjustments to for example level and filtering to balance the sound 
between several samples across the keyboard. However, if you have multiple selec-
tions this can sometimes lead to confusion: Enter the NN-XT’s “conflicting parame-
ters” indication:

Whenever two or more selected zones have conflicting parameter settings, NN-XT 
will notify you about this by showing a small “M” (for multiple) symbol, next to the pa-
rameter.

In this example, Level and Spread have conflicting settings.

D The controls on the panel always show the setting for the zone with edit 
focus.

D By clicking your way through the zones within the selection, you can see 
the settings for each zone.

D If you adjust a parameter, all selected zones will be set to the same value 
for this parameter.

You can put this functionality to good use when checking how a patch has been cre-
ated and when checking that your own settings are consistent through the various 
zones.

Sample Parameters
The Sample parameters allow you to specify various properties for one or several se-
lected zones, such as tuning, key and velocity ranges.

D To set several zones to the same value, select them and adjust the pa-
rameter.
All zones will be set to the same value for the parameter you adjusted.

Copying parameters between zones

You can easily copy parameter settings from one zone to any number of other zones. 
Proceed as follows:

1. Select all the zones you want to involve in the operation.
By this we mean the zone with the settings you wish to copy, and the zone(s) to 
which you want to copy the settings.

2. Make sure the zone that contains the settings you want to copy has edit fo-
cus.

3. Pull down the Edit menu or the NN-XT context menu and select “Copy Pa-
rameters to Selected Zones”.
All the selected zones will now get the exact same parameter settings.

! Observe that this only applies to the synth parameters (see page 277). 
Sample parameters (root key, velocity range etc.) can not be copied.
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Managing Zones and 
Samples
Creating a Key Map
When you add an NN-XT sampler to the rack, its key map display is always empty. 
That is, it contains no samples.

To create a new key map, proceed as follows:

1. Either click the Browse Samples button, select Browse Samples from the 
Edit menu or select Browse Samples from the NN-XT’s context menu.
This will bring up the regular Reason file browser.

The Browse Samples button.

2. Select the sample or samples that you want to load in the browser and click 
“OK”.
The selected sample(s) are loaded into the NN-XT.

When new samples are loaded into the NN-XT they have the following properties:

• Each sample is placed in its own zone.
• Each zone spans a key range of five octaves on the keyboard - C1 to C6.
• All the newly added sample(s)/zones are automatically selected.
• The first added zone gets edit focus.

A key map with four newly added samples.

Setting Root Notes and Key Ranges

The next step after loading the samples is most likely to adjust the key range, root note 
and tuning of the samples, so that they play sensibly across the key range. There are 
many ways of doing this, described on page 267 and onwards. However, we will here 
briefly describe a procedure for quickly creating a complete key map out of a set of 
loaded samples.

This example assumes that the samples you load is a set of multisamples for a pitched 
instrument (like guitar, piano, flute etc.).

1. Load the samples.

2. Use “Select All” on the Edit menu to select all the loaded samples.

3. Use “Set Root Notes from Pitch Detection” to automatically set up the root 
notes (pitches) for the samples.

4. Select “Automap Zones” from the Edit menu.

All selected zones are automatically arranged into a basic key map. You can now pro-
ceed with adjusting the synth parameters on the front panel to shape the sound!

About File Formats and REX Slices
The NN-XT can import various types of samples:

D Standard Wave files 
These have the extension “.wav”. This is the standard audio file format for the PC 
platform. Any audio or sample editor, regardless of platform, can read and create 
audio files in Wave format. Any sample rate and practically any bit resolution is 
supported.

D Standard AIFF files 
These have the extension “.aif” and this is the standard audio file format for the 
Mac platform. Again, any audio editor can read and create audio files in this format. 
Any sample rate and practically any bit resolution is supported.

D SoundFont samples
This is a standardized data format containing wavetable synthesized audio and in-
formation on how it should be played back in wavetable synthesizers - typically on 
audio cards. SoundFont banks are hierarchically organized into different catego-
ries: User Samples, Instruments, Presets etc. The NN-XT lets you load single sam-
ples from within a Soundfont bank.

D REX file slices
A slice is a snippet of sound in a REX File (see page 257). To import a REX slice, 
browse to a REX file and open it as if it was a folder. The browser will then display 
the slices as files inside that “folder”. In the rest of this manual, when we refer to 
importing samples, all that is said applies to REX slices as well.

! If you want files to play back with their original bit depth - if higher than 
16-bits - make sure to activate “Use High Resolution Samples” on the 
General page in the Preferences dialog. Otherwise, samples will be 
played back as 16-bit files in NN-XT regardless of their original bit depth. 

Adding More Samples to the Key Map
You can add additional samples to an existing key map way described above.

1. Make sure that no already loaded sample has edit focus.
If you don’t, there’s a risk that the selected sample will be replaced, see below. To 
remove the edit focus, click in an unoccupied area in the Sample column or the 
key map area. 

2. Open the Sample Browser.

3. Select the sample(s) you want to load in the browser and click “OK”.
The new sample(s) are added to the key map.
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Replacing a Sample
To replace the sample in a zone, proceed as follows:

1. Make sure the zone has edit focus and do one of the following:

D Click the Browse Samples button.

D Select Browse Samples from the Edit menu or the NN-XT context menu.

D Double click in the zone.
Any of these methods will open the standard file browser in which you can select 
a new sample for the zone.

2. Select one and only one sample in the Sample Browser.
If you select more than one sample in the browser the samples you load will not re-
place the one with edit focus. They will instead be added below it.

Quick Browsing through Samples
If you want to quickly browse through a number of samples, for example to see which 
one of them would fit best in a certain context, proceed as follows:

1. Set up the zone as desired and make sure it has edit focus:

2. Use the arrow buttons in the Browse Samples section to select the next/pre-
vious sample in the same directory.

Removing Samples
D To remove a sample from a zone, select it by clicking on it and then se-

lect “Remove Samples” from the Edit menu or the NN-XT context menu.
This will remove the sample from the zone, leaving it empty. Note that you can re-
move the samples from several selected zones at the same time.

Auditioning samples
You can audition the loaded samples in two ways:

D By pressing [Option] (Mac)/[Alt] (Windows) and clicking a sample in the 
sample column.
The mouse pointer will take on the shape of a speaker symbol when you move it 
over the sample column.
Clicking a sample will play it back at its root pitch (see page 270). Furthermore, 
the sample will play back in its unprocessed state. That is, without any synth-pa-
rameters applied (see page 277).

D By pressing [Option] (Mac)/[Alt] (Windows) and clicking a sample in the 
keyboard column.
The difference here is that you will hear the sample at the pitch corresponding to 
the key you clicked and with any and all processing applied. The click mimics a key 
played with velocity 100. Also note that this may trigger several samples, depend-
ing on whether they are mapped across the same or overlapping key ranges, and 
the velocity range settings (see page 267 and page 273 respectively).

Adding Empty Zones
You can add empty zones to a key map. Empty zones are treated just like zones con-
taining samples, in that they are automatically selected, gets edit focus and are as-
signed a five octave key range when they are first created. However, you can only add 
one zone at a time. It is also possible to resize, move and edit empty zones in the same 
way as zones containing samples.

D To add an empty zone, pull down the Edit menu or the NN-XT context 
menu and select “Add Zone”.
An empty zone is added below any existing zones in the key map. An empty zone 
is indicated with the text “**No Sample**”.

After you have added an empty zone, you can assign a sample to it, just as when Re-
placing a Sample, or when Quick Browsing, as described above.

Duplicating Zones
You can duplicate any number of already existing zones (containing samples or 
empty). 

1. Select the zone(s) you want to copy.

2. Pull down the edit menu or the NN-XT context menu and select “Duplicate 
Zones”.
The selected zones will now be copied and automatically inserted below the last 
one in the key map display. 

The duplicated zones will contain references to the same samples as the original 
zones. They will also have the exact same key ranges and parameter settings.

Using Copy and Paste

The Copy Zones function on the Edit menu allows you to copy all selected zones to 
the clipboard. Selecting Paste Zones from the Edit menu will paste the zones into the 
selected NN-XT device, below the existing zones.

This is a handy way to transfer zones (complete with all settings) from one NN-XT de-
vice to another.

Removing Zones
To remove one or several zones, select them and do one of the following:

D Press [Delete] or [Backspace] on the computer keyboard.

D Select “Delete Zones” from the Edit menu or the NN-XT context menu.

When removing zones, you will remove any samples in them as well.

Rearranging Zones in the List
D To move a zone to another position in the list, click on it in the samples 

column and drag up or down.
An outline shows you where the zone will appear when you release the mouse but-
ton.
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Working with Grouping
About Groups
Grouping has two purposes:

D To allow you to quickly select a number of zones that “belong together.”
For example if you have created a layered sound consisting of piano and strings, 
you could put all string samples in one group and all piano samples in one group. 
Then you can quickly select all piano samples and make an adjustment to them by 
trimming a parameter.

D To group zones that need to share group settings together.
For example, you may want to set a group to legato and monophonic mode and 
add some portamento so that you can play a part where you slide between notes.

Note that there is always at least one group, since the zones you create are always 
grouped together by default.

Creating a Group
1. Select the zones you want to group together.

The zones don’t have to be contiguous in order to be grouped. Regardless of their 
original positions in the samples column, they will all be put together in succes-
sion.

2. Select “Group Selected Zones” from the Edit menu or the NN-XT context 
menu.
The zones are grouped.

Moving a Group to another Position in the List
D Click on the group in the Groups column and drag up or down with the 

mouse button pressed.
An outline of the group you move is superimposed upon the display to help you 
navigate to the desired position.

Dragging a group to a new position.

3. Release the mouse button at the desired position.
The group and all its zones appear at the new position.

Moving a Zone from one Group to another
This is done just as when rearranging samples in the list, as described on the previous 
page. The only difference is that you drag the zone from one group to another.

Selecting a Group and/or Zones in a Group
D Clicking on a group in the groups column selects the group and all the 

zones in the group.

D Clicking on a zone in the samples column selects the group (and that 
zone).

The Group Parameters
There are a few parameters on the front panel that apply specifically to groups. see 
page 276 for details.

Selecting these zones and grouping them...

...will create these two groups instead of the original one large group.
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Working with Key Ranges
About Key Ranges
Each zone can have its own separate key range, the lowest and the highest key that 
will trigger the sample. 

A good example of use for this is when sampling a certain instrument. Sampling of a 
piano for example is usually performed by making several recordings of different notes 
at close intervals, and then mapping these samples to separate, contiguous, fairly nar-
row key ranges. This concept is called multi-sampling.

The reason for this is that if one single sample is played across the entire keyboard, it 
will most likely sound very unnatural when played too far from its original pitch, since 
the amount you can transpose a sound without negatively affecting its timbre is very 
limited.

Setting up Key Ranges
You can adjust the key range of zones in a number of ways:

By Dragging the Zone Boundary Handles

1. Select the zone in the Key Range area.

2. Point and click on one of the handles that appear at each end.

3. Drag the handle left/right.
Dotted lines extend from the edges of the zones up to the keyboard area. These 
lines give you a visual indication of which keys the key range will encompass. 
There is also an alphanumerical indication at the bottom left of the display.

4. Repeat the procedure with as many zones as you wish, to create a complete 
key map.

By using the Lo Key and Hi Key controls

Directly below the key map area you will find the sample parameters. These are used 
for changing various parameters that affect how the zones are played back. They can 
affect single or multiple selected zones. In the middle of the sample parameters area 
are two knobs called “Lo Key” and Hi Key”.

These can be used for setting the low key and the high key of a zone’s key range. 

1. Make sure the zone which you want to set the key range for is selected.

2. Use the Lo Key/Hi Key knobs to change the key range.
Check the display right above the knobs for an indication of the key. You can also 
keep an eye on the lines extending from the zone edges to the keyboard area.

Setting key ranges for multiple zones

You can set key ranges for multiple selected zones simultaneously. This can only be 
done by using the Lo and Hi Key controls. It works as follows:

D If you have three selected zones that each have different high keys and 
then turn the Hi Key knob, they will all automatically get the same High 
Key value as the zone with edit focus.
In other words, if the selected zone with edit focus has the high key set to C4, and 
you change this to D4 by turning the Hi Key knob, all other selected zones will also 
be extended to D4 as the High Key.

D If any selected zone’s low key setting is higher than the edit focused 
zone’s high key before turning the Hi Key knob, the zone range will be 
scaled down to one semitone, starting from the low key setting.
The high key can naturally never be set to a value lower than one semitone above 
its low key setting - the zone would otherwise disappear!

Clicking and dragging the high key boundary handle of a zone with the default key range of C1 - C6...

...to change the key range to C1 - C2.
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D The inverse is also true - i.e. turning the Lo Key knob for several selected 
zones will apply the edit focused low key setting to all selected zones.
A low key can never be set higher than one semitone below the high key in a zone, 
so if the edit focused zone has a low key above the high key of another zone, the 
other zone will be scaled to the minimum semitone range.

By Dragging the Zone Boundary Handles on the Tab Bar

As previously described, the area directly below the keyboard area is called the tab 
bar. This shows the key range for the currently selected zone, and also contains 
boundary handles. 

Dragging a boundary handle on the tab bar.

These handles can be used much to the same effect as when dragging the boundary 
handles in the key map display. However, the handles on the tab bar can change the 
key range of multiple zones at the same time.

The following applies:

• The tab bar shows the key range for the zone with edit focus.
• Dragging the boundary handles for that zone will also simultaneously change the 

key range for a number of surrounding zones if:

D The high key or low key (depending on which handle you drag) of the 
other zones are the same as the zone with edit focus.

D The other zones are adjacent to the zone with edit focus.

! Note that it doesn’t matter whether the other zones are selected or not. 
They will be affected anyway.

In the example in the picture above, the zone in the middle has edit focus. Its left han-
dle (the low key) is placed differently from any of the other zones, but all of the zones 
have the same high key setting. This means that...

• Dragging the left handle will only move the low key position of the zone with edit 
focus (the pictures show before and after dragging).

• Dragging the right handle will move the high key position for all of the zones at the 
same time, since they all have the same high key position (again, the picture shows 
before and after dragging).
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Moving Zones by Dragging the Zone Boxes

You can also move entire zones horizontally, thereby changing their key ranges.

1. Select all the zones you want to move.
You can move several zones simultaneously.

2. Point on any of the selected zones, and press the mouse button.

3. Drag left/right and release the mouse button.

Dragging multiple zones.

Moving Zones by Dragging in the Tab Bar

You can also move a zone by dragging anywhere between the zone boundary handles 
on the tab bar. When you do, the surrounding zones will be affected just as when 
dragging the boundary handles in the tab bar (see above).

This can be used to “slide” a zone in relation to its surrounding zones, as the picture 
example below shows (before and after dragging).

About the Lock Root Keys function

Normally, when you move zones (as described above), the root note of the zone(s) 
you move will change accordingly. In other words, the zone(s) will be transposed. If 
this is not desired, you can activate the Lock Root Keys function prior to moving the 
zone(s) by clicking on the button above the key map display.

Moving zones without changing their root notes can be used for some interesting ef-
fects, since it will completely change the timbre of the sample(s) as they are played 
back.

About the Solo Sample function

The Solo Sample function lets you play a selected sample over the entire keyboard 
and disregarding any velocity range assigned to the sample. All other loaded samples 
are temporarily muted.

This is useful if you for example want to check how far up and down from its root key 
a sample can be played on the keyboard before starting to sound “unnatural”. The 
solo sample function can therefore be useful as a guide for setting up key ranges, as 
described on page 267.

1. Select one and only one zone, or - if you have a selection of multiple zones - 
make sure the one you want to hear has edit focus.

2. Activate Solo Sample by clicking on the button so that it lights up.

3. Play the MIDI keyboard
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Sorting Zones by Note
The Edit menu and the NN-XT context menu contains an item called “Sort Zones by 
Note”. This option lets you automatically sort the selected zones in descending order 
according to their key ranges.

When you invoke this option, the selected zones will be sorted from top to bottom in 
the display starting with the one with the lowest range.

Note however, that the sorting is done strictly on a group basis. That is, only zones 
that belong to the same group can be sorted in relation to each other.

Before sorting and after.

If two zones have the same key range, they are sorted by velocity range.

Setting Root Notes and 
Tuning
About the Root Key
All instrument sounds have an inherent pitch. When playing a sample of such a sound 
on the keyboard, the keys you play must correspond to that pitch. For example, you 
may have recorded a piano playing the key “C3”. When you map this onto the NN-XT 
key map, you must set things up so that the sampler plays back the sample at original 
pitch when you press the key C3.

This is done by adjusting the root note.

D Many samples files from different sources already have a set root key in 
the file. If they do, the root key will be correctly set automatically when 
you load the sample into a zone.

D However if the sample doesn’t have a root note stored in the file, (if you 
for example have recorded it yourself) you will need to adjust it

Setting the Root Note Manually
To set the root key for a zone, proceed as follows:

D Make sure the zone has edit focus (for example by clicking on it), and do 
one of the following:

D Use the knob marked “Root” in the sample parameter area below the 
display.
Turning it to the right will raise the pitch of the root key. The selected key is dis-
played alphanumerically directly above the knob, and you can also look at the key-
board area for a visual indication (see below).

D Press [Ctrl] (Windows)/[Command] (Mac) and click on the desired root 
key in the keyboard area.
The set root key is shaded so you can easily distinguish it.
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Tuning Samples Manually 
In addition to setting the root note, you may need to fine tune your samples, in order 
for them to match other instruments and/or each other:

D Make sure the zone has edit focus (for example by clicking on it).

D Use the knob marked “Tune” in the sample parameter area.
This allows you to tune each sample in a key map by +/– half a semitone 
(-50 – 0 – 50).

Setting the Root Note and Tuning Using Pitch 
Detection
The NN-XT features a pitch detection function to help you set the root keys. This is 
useful if you for example load a sample that you haven’t recorded yourself, and you 
don’t have any information about its original pitch.

Proceed as follows:

1. Select all the zones you want to be subject to pitch detection.

2. Pull down the Edit menu or the NN-XT context menu and select “Set Root 
Notes from Pitch Detection”.
The samples in all the selected zones will now be analyzed, and the detected root 
keys will automatically be set for you.

! Note that for this to work properly, the samples must have some form of 
perceivable pitch. If it is sampled speech, or a snare drum for example, it 
probably doesn’t have any discernible pitch.

About Changing the Pitch of Samples
The procedures above should be used to make sure the samples are consistently 
pitched across the keyboard, and that they all match an absolute reference (for exam-
ple A 440 tuning).

If you need to tune the samples to match other material, or to get a certain effect (for 
example detuning two sounds against each other for a chorus effect) you should use 
the Pitch section among the synth parameters, not the sample tuning parameters.

Using Automap
The automap function can be used as a quick way of creating a key map, or as a good 
starting point for further adjustments of a key map.

Automap works under the assumption that you intend to create a key map for a com-
plete instrument, for example a number of samples of a piano, all at different pitches.

1. Load the samples you want to Automap.
Now you have three options:

D Trust that the root note information in the files is already correct.

D Manually adjust the root notes (and tuning) for all the samples.

D Use “Set Root Notes from Pitch Detection” to automatically set up the 
root notes.

2. Select all zones you want to automap.

3. Select Automap Zones from the Edit menu or the NN-XT context menu.

All the selected zones will now be arranged automatically in the following way:

D The zones will be sorted in the display (from top to bottom - lowest key 
first) according to the root keys.

D The zones will be assigned key ranges according to the root keys.
The key ranges are set up so that the split between two zones is exactly in the mid-
dle between the zones’ root notes. If two zones have the same root key they will be 
assigned the same key range.

Automapping zones chromatically

D This Edit menu item will give each zone a key range of one semitone (i.e. 
one key), starting from C2 and upwards.
The function does not take root key into account. It simply places each selected 
sample on successive keys according the position in the sample list (from the top 
down).
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Layered, Crossfaded and 
Velocity Switched Sounds
Creating Layered Sounds
You can set things up so that two or more zones have overlapping key ranges - either 
completely or partially. This way you can create layered sounds, i.e. different samples 
that are played simultaneously when you press a key on your keyboard.

In the picture above, you can see a set of piano samples at the top, mapped across 
the key range.

Below these are a set of string samples that also span the entire key range.

Whenever you play a key within this keyboard range, the sound produced will be a 
combination of the piano and the string sample.

In addition, in the example above, the user has arranged the piano samples into one 
group and the string samples in another. This is convenient since it allows for quick 
selection of the entire piano map, for example for balancing its level against the 
strings.

About Velocity Ranges
When zones are set up so that their key ranges overlap – completely or partially – you 
can use velocity switching and crossfading to determine which zones should be 
played back depending on how hard or soft you play on your MIDI keyboard.

This is done by setting up velocity ranges, with or without crossfading.

Each time you press a key on your MIDI keyboard, a velocity value between 1-127 is 
sent to Reason. If you press the key softly, a low velocity value is sent and if you press 
it hard, a high velocity value is sent.

This velocity value determines which samples will be played and which will not.

Let’s say for example that you’ve mapped three different zones across the same key 
range:

D Zone 1 has a velocity range from 1-40.
This means that the sample in it will be triggered by velocity values between 1-40.

D Zone 2 has a velocity range of 41-80.
The sample in this zone will be played back by velocity values between 41-80.

D Zone 3 has a velocity range of 81-127.
The sample in this zone will be triggered by all velocity values above 80.

Overlapping Velocity Ranges

Let’s change the values above slightly:

D Zone 1 has a velocity range from 1-60.

D Zone 2 has a velocity range of 41-100.

D Zone 3 has a velocity range of 81-127.

Now, velocity values between 41 and 60 will trigger samples from both Zone 1 and 
Zone 2. Likewise, velocity values between 81 and 100 will trigger sounds from Zone 
2 and Zone 3.

About Full and Partial Velocity Ranges

You can see which zones have modified velocity ranges in the key map display:

• Zones with a full velocity range (0 - 127) are only shown with an outline.
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• Zones with any other velocity range are shown as striped.

The top zone has a full velocity range (1-127), and the lower zone has a partial velocity range (any other 
range), which is indicated by stripes

Sorting Zones by Velocity Values

The Edit menu and the NN-XT context menu contain an item called “Sort Zones by 
Velocity”. This option lets you automatically sort the selected zones in the display in 
descending order according to their set low or high velocity values.

When you invoke this option, the selected zones will be sorted from top to bottom 
starting with the one with the highest “Lo Vel “value.

Note however, that the sorting is done strictly on a group basis. That is, only zones 
that belong to the same group can be sorted in relation to each other.

If two zones have the same velocity range, they are sorted by key range.

Setting Velocity Range for a Zone
To set up a velocity range for a zone, proceed as follows:

1. Select one or more zones that you want to adjust.

2. Use the knobs marked “Lo Vel” and “High Vel” in the sample parameter area 
to set the desired low- and high velocity values.

Adjusting the “Lo Vel” value for a zone.

“Lo vel” is the lowest velocity value that should trigger the sample in the zone - i.e. if a 
key is pressed so softly that the velocity is lower than this value, the sample will not be 
played. 

“Hi vel” is the highest velocity value that should trigger the sample, which means that 
if a key is pressed so hard that the velocity is higher than this value, the sample will not 
be played.

About Crossfading Between Zones
At the bottom right in the sample parameter area are two knobs marked “Fade In” and 
“Fade Out”. These are primarily used for setting up velocity crossfades for smooth 
transitions between overlapping zones. In order to set up crossfades you adjust the 
fade out and fade in values for the overlapping zones.

Crossfading Between two Sounds

An example:

D Two zones are both set to play in the full velocity range of 1-127.

D Zone 1 has a fade out value of 40.
This means that this zone will play at full level with velocity values below 40, With 
higher velocity values, it will gradually fade out.

D Zone 2 has a fade in value of 80.
This has the effect that as you play velocity values up to 80, this zone will gradually 
fade in. With velocity values above 80, it will play at full level.

Another example:

Crossfading can be used to only fade in or fade out a certain sound. One common ex-
ample is to set things up so that one sound plays the entire velocity range and another 
is faded in only at high velocity values.

D Zone 1 is set to play the entire velocity range with no crossfade.

D Zone 2 is set to play the velocity range 80 to 127, with a fade in value of 
110.
This means that this zone will start fading in from velocity values 80 and will play at 
full level in the velocity range 110 to 127.

This can be used for example to add a rimshot to a regular snare sound or a harder at-
tack to a softer violin sample.
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Setting Crossfading for a Zone

Manually

To set up a crossfade for a zone, proceed as follows:

1. Select one or more zones that you want to adjust.

2. Use the knobs marked “Fade In” and “Fade Out” in the sample parameter 
area, to set the desired values.

✪ You can change the values with finer precision by pressing [Shift] while 
turning the knobs, and you can reset the standard values by pressing 
[Command] (Mac)/[Ctrl] (Windows) and clicking on the knobs.

Automatically

If you find it tedious to manually set up crossfades between zones, NN-XT can do it 
for you! The Edit menu and the NN-XT context menu contain an item called “Create 
Velocity Crossfades”.

1. Set up the zones so that their velocity ranges overlap, as desired.

2. Select the zones.
You can select as many zones as you wish, not just one pair of overlapping zones.

3. Select “Create Velocity Crossfades” from the Edit menu.
NN-XT will analyze the overlapping zones and automatically set up what it deems 
to be appropriate fade in and fade out values for the zones.

D This operation will not work if both zones have full velocity ranges.
At least one of the zones must have a partial velocity range (see page 272).

D This operation will not work if the zones are completely overlapping.

Using Alternate
About the Alternate function

At the bottom right in the sample parameters area is a knob marked “Alt”. It only has 
two states - On and Off. This is used for semi-randomly alternating between zones 
during playback.

There are several practical uses for this. Here follows two examples:

• Layering several recordings of the same snare drum. By alternating between them 
you get a more natural repetition.

• Layering string up- and down strokes. By alternating you get the realistic effect of 
switching between the two directions of the stroke.

You can layer as many sounds as you will and the algorithm switches between them in 
a way that provides as little repetition as possible.

To set up an alternating set of zones, proceed as follows:

1. Set up the zones so that they overlap completely or partially.

2. Select them all.

3. Set “Alt” to On for all the zones.
Now, the program will automatically detect how to alternate between the zones, 
depending on their overlap.
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Sample Parameters

The Sample parameter area is found below the screen. They allow you to adjust pa-
rameters for one or several selected zones. Adjusting a parameter with multiple zones 
selected, will set the parameter to the same value for all selected zones. Below fol-
lows a run-down of the various parameters:

Root Note and Tune
These parameters are described on page 270.

Sample Start and End
By turning the knobs you offset the start and end positions, so that they will play back 
more or less of a samples’ waveform. Typical examples of use for this would be:

D Removing unwanted portions from samples.
This could be anything from noise to “dead air” at the beginning or end of a sam-
ple.

D To create variations out of a single sample.
These controls can be used to pick out any section of a recording for use as a 
sample.

D Together with velocity sample start control.
You can for example increase Sample Start and then apply negative velocity mod-
ulation to Sample Start. Then, the harder you play the more you will hear of the at-
tack portion of the sound.

✪ If you hold down [Shift] when adjusting these parameters, the adjust-
ment is always in single frames (samples).

Loop Start and End
A sample, unlike the cycles of an oscillator for example, is a finite quantity. There is a 
sample start and end. To get samples to play for as long as you press down the keys 
on your keyboard, they need to be looped. 

For this to work properly, you have to first set up two loop points which determine the 
part of the sample that will be looped.

The instrument samples in the sound banks included with Reason are already looped. 
The same will be true for most commercial sample libraries. However, if you need to, 
you can use these controls to adjust the looping.

• The size and position of the loop – in the sample – is determined by two parame-
ters, Loop Start (the beginning of the loop) and Loop End (the end point of the 
loop).

• The NN-XT then keeps repeating the section between the Loop Start and Loop 
end until the sound has decayed to silence.

Play Mode
By using this knob you can select one of the following loop modes for each zone:

D FW
The sample in the zone will play only once, without looping.

D FW-LOOP
The sample will play from the sample start point to the loop end point, jump back 
to the loop start point and then loop infinitely between the start and end loop 
points. This is the most common loop mode.

D FW - BW
The sample will play from the sample start point to the loop end point, then from 
the loop end point to the loop start point (backwards), and then loop infinitely for-
wards-backwards between the start and end loop points.

D FW-SUS
This works like FW-LOOP with the exception that it will only loop as long as the 
key is held down. As you release the key, the sample will play to the absolute end 
of the sample, that is beyond the boundaries of the loop.

This means that the sound may have a short natural release even if the release pa-
rameter is raised to a high value (which is not true for “FW-LOOP”, where the re-
lease parameter always controls the length of the sound after the key is released).

D BW
The sample will play only once - from the end to the beginning - without looping.

Lo Key and Hi Key
These parameters are described on page 267.

Lo Vel and Hi Vel
These parameters are described on page 272.

Fade In and Fade Out
These parameters are described on page 273.

Alt
This parameter is described on page 274.
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Out
The NN-XT features eight separate stereo output pairs (see page 284). For each 
zone, you can decide which of these output pairs to use. Thus, if you have created a 
key map consisting of eight zones, each of these can have a separate stereo output 
from NN-XT, and can then be routed to a separate mixer channel if you so wish.

D To select which output a selected zone should be directed to, use the 
knob marked “Out” in the sample parameter area.
The output pairs are indicated above the button.

! Note that you still have to route the outputs the way you want them on 
NN-XT’s back panel. If you assign a zone to an output pair other than 1-2 
(which is the default) no connections or auto routing are made. You have 
to do that manually.

A Stereo Example

One possible way of utilizing this would be to create a drum kit. In this case you could 
load up to eight different stereo drum samples, assign them to separate outputs, route 
each to a separate mixer channel and then use the mixer to set levels and pan, add 
send effects etc.

Using a Stereo Output as Two Mono Outputs

If, on the other hand, you are using mono samples, you can use one stereo pair as a 
two separate outputs, effectively giving you a total of 16 separate outputs.

1. Assign two zones to the same output.

2. Us the Pan control to pan one of the zones hard left and the other hard right.

3. Connect each of the two outputs in the stereo pair to a separate mixer chan-
nel.

Group Parameters

The group parameters are located at the top left on the remote editor panel. These are 
parameters that in various ways are directly related to playing style.

Group parameters apply to a group, that is they are settings that are shared by all 
zones in a group.

D To make adjustments to one group, select one or more zones that be-
long to the group, and adjust the parameter on the front panel.

D To set several groups to the same value, select at least one zone in each 
group you want to adjust, and adjust the parameter on the front panel.

Key Poly
This setting determines the number of keys that you can play simultaneously (the po-
lyphony). The maximum number is 99 and the minimum is 1, in which case the group 
will be monophonic.

Users of other samplers may want to note that the polyphony often means setting the 
number of voices that should be able to play. The NN-XT is different in this aspect, 
since the polyphony setting instead determines the number of keys, regardless of 
how many voices each key plays.

The Group Mono button

The Group Mono button beside the Key Poly section can be used to quickly set a 
group to play monophonically regardless of the polyphony setting. E.g. if you have a 
group with open and closed hi hats, you can switch this on so that an open hi hat is 
automatically muted when you play a closed hi hat.

Group Mono overrides the Key Poly setting - except when playing the same note. 

So you can play your open hihat repeatedly without the sound cutting itself off. When 
you play the closed hihat, this cuts off the open hihat.

Note that activating this button is not the same as setting polyphony to 1. E.g., it can 
not be used for Legato or mono Retrig (see below). 
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Legato and Retrig

Legato

Legato works best with monophonic sounds. Set Key Poly (see above) to 1 and try 
the following:

D Hold down a key and then press another key without releasing the previ-
ous.
Notice that the pitch changes, but the envelopes do not start over. That is, there 
will be no new “attack”. 

D If Key Poly is set to more voices than 1, Legato will only be applied when 
all the assigned keys are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 note 
chord, the next note you played would be Legato. Note, however, that this Legato 
key will “steal” one of the keys in the 4 note chord, as all the assigned keys were 
already used up!

Retrig

Retrig is the “normal” setting for playing polyphonic patches. That is, when you press 
a key without releasing the previous, the envelopes are triggered, like when you re-
lease all keys and then press a new one. In monophonic mode, Retrig has an addi-
tional function; if you press a key, hold it, press a new key and then release that, the 
first note is also retriggered.

LFO 1 Rate
This is used for controlling the rate of LFO 1 if it is used in “Group Rate” mode. In that 
case, this knob will take precedence over the rate parameter in the LFO 1 section. 
See page 282 for detailed information about this.

Portamento
This is used for controlling portamento - a parameter that makes the pitch glide be-
tween the notes you play, rather than changing the pitch instantly as soon as you hit a 
key on your keyboard. By turning this knob you set how long it should take for the 
pitch to glide from one note to the next as you play them. 

In legato mode, there will only be any portamento when actually playing legato (tied) 
notes.

With the knob turned all the way to the left, portamento is disabled.

Synth parameters
The Modulation controls

As previously described, the Modulation wheel (and the External Control wheel) can 
be used for controlling various parameters. These controls allow you to define which 
parameters the wheels should modulate and to what extent.

D Below each of the knobs are the letters “W” and “X”.
These are used for selecting the source that should control the parameter, and 
represent the “Modulation Wheel” and the “External Control wheel” respectively.

D By clicking on any of the letters, you decide which source should control 
the parameter. 
You can select either, both or none. When a letter is “lit”, the corresponding 
source is set to control the parameter.

D By turning the knobs, you decide how much the modulation and/or ex-
ternal control wheel should modulate the corresponding parameter.

Note that all of the control knobs are bi-polar, which means that they can be set to 
both positive and negative values. Positive values are set by turning the knobs to the 
right, and negative values are thus set by turning the knobs to the left:

• Setting them to positive values means that the value of the controlled parameter 
will be raised if the source wheel is pushed forward.

• Setting them to negative values means that the value will be lowered when a wheel 
is pushed forward.

• Keeping the knobs in the center position means that no modulation control is ap-
plied. 

There is one exception to these rules, and that is the LFO 1 Amt control, which works 
in a slightly different way. See below for more information about this.

The following parameters can be modulated:

F.Freq

This sets modulation control of the Filter’s cutoff frequency (see page 279).

Mod Dec

This sets modulation control of the Decay parameter in the Modulation Envelope (see 
page 280).
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LFO 1 Amt

This determines how much the amount of modulation from LFO 1 is affected by the 
Modulation wheel and/or the External Controller wheel. It does this by “scaling” the 
amounts set with the three destination knobs in the LFO 1 section (Pitch, Filter and 
Level, see page 282). We’ll explain this with an example:

To use the Modulation Wheel to increase pitch modulation (vibrato), proceed as fol-
lows:

1. Turn the Mod Wheel all the way down, so that no modulation is applied.

2. Activate the “W” button for LFO 1 Amt in the Modulation section.

3. Set the corresponding knob to “12 o’clock” (zero).

4. Set up LFO 1 so that as much vibrato is applied as you want it to be when the 
Modulation wheel is turned all the way up.

5. Increase LFO 1 Amt until you hear as much vibrato as you want it to be when 
the wheel is turned all the way down.
If you turn LFO 1 Amt all the way up, there will be no vibrato at all when the wheel 
is all the way down.

To instead use the Modulation wheel to decrease vibrato, process as follows:

1. Turn the Mod Wheel all the way down, so that no modulation is applied.

2. Activate the “W” button for LFO 1 Amt in the Modulation section.

3. Set the corresponding knob to “12 o’clock” (zero).

4. Set up LFO 1 so that as much vibrato is applied as you want it to be when the 
Modulation wheel is turned all the way down.

5. Turn the Modulation wheel all the way up.

6. Decrease LFO 1 Amt until you hear as much vibrato as you want it to be 
when the wheel is turned all the way up.
If you turn LFO 1 Amt all the way down, there will be no vibrato at all when the 
wheel is all the way up.

F.Res

This sets modulation control of the Resonance parameter in the Filter (see page 279).

Level

This sets the amount of amplitude envelope modulation of each zone’s level. The level 
set here will be the level of the highest point of the Amp Envelope.

LFO 1 Rate

This sets modulation control of the Rate parameter in LFO 1 (see page 282).

The Velocity controls

Velocity is used for controlling various parameters according to how hard or soft you 
play notes on your keyboard. A typical use of velocity control is to make sounds 
brighter and louder if you strike a key harder. By using the knobs in this section, you 
can control if and how much the various parameters will be affected by velocity. 

Just like the modulation controls, all of the velocity control knobs are bi-polar, and can 
be set to both positive and negative values.

• Setting them to positive values means that the value of the controlled parameter 
will be raised the harder you play.

• Setting them to negative values means that the value will be lowered the harder 
you play.

• Keeping the knobs in the center position means that no velocity control is applied. 

The following parameters can be velocity controlled:

F.Freq

This sets velocity control of the Filter’s cutoff frequency (see page 279).

Mod Dec

This sets velocity control of the Decay parameter in the Modulation Envelope (see 
page 280).

Level

This sets velocity control of the Amp Envelope.

Amp Env Attack

This sets velocity control of the Attack parameter in the Amplitude Envelope (see 
page 281).

S. Start

This sets velocity control of the Sample Start parameter (see page 275), so that it will 
be offset forwards or backwards, according to how hard or soft you play.

This allows you to control how much of the attack portion of the sample you hear 
when playing harder or softer.

To be able to make use of negative values for this parameter, you must increase the 
sample parameter Sample Start.
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The Pitch section

This section contains various parameters related to controlling the pitch, or frequency, 
of the zones. 

Pitch Bend Range

This lets you set the amount of pitch bend, i.e. how much the pitch changes when 
your turn the pitch bend wheel fully up or down. The maximum range is +/- 24 semi-
tones (2 Octaves).

Setting the pitch

Use the three knobs marked “Octave”, “Semi” and “Fine” to change the pitch of the 
sample(s):

D Octave
This changes the pitch in steps of one full octave. The range is -5 – 0 – 5.

D Semi
This lets you change the pitch in semitone steps. The range is -12 – 0 – 12 (2 oc-
taves).

D Fine 
This changes the pitch in cents (hundredths of a semitone). The range is -50 – 0 – 
50 (down or up half a semitone).

K. Track

This knob controls Keyboard Tracking of the pitch.

• In the center position, each key represents a semitone This is the normal setting.
• When turned all the way down, all keys play the same pitch. This can be useful for 

percussion like timpani where you might want to play the same pitch from a range 
of keys.

• When turned all the way up, each key on the keyboard shifts the pitch one octave.

The Filter Section

Filters can be used for shaping the character of the sound. The filter in NN-XT is a 
multimode filter with six different filter types.

D To activate/deactivate the filter, click the On/Off button in the top right 
corner.
When the filter is activated, the button is lit.

Filter mode

To select a filter mode, either click the Mode button in the bottom right corner or click 
directly on the desired filter name so that it lights up:

D Notch
The notch filter is used for cutting off frequencies in a narrow frequency range 
around the set cutoff frequency, while letting the frequencies below and above 
through.

D HP 12
This is a highpass filter with a 12 dB/Octave roll-off slope. A highpass filter cuts off 
low frequencies and lets high frequencies pass. That is, frequencies below the 
cutoff frequency are cut off and frequencies above it pass through.

D BP 12
This is a bandpass filter with a 12 dB/Octave roll-off slope. A bandpass filter could 
be viewed as the opposite of a notch filter. It cuts off both the high and the low fre-
quencies, while frequencies in the band range pass through.

D LP 6 
This is a lowpass filter with a gentle, 6 dB/Octave slope. A lowpass filter is the op-
posite of a highpass filter. It lets the low frequencies through and filters out the 
high frequencies. This filter has no Resonance.

D LP 12
This is a lowpass filter with a 12 dB/Octave roll-off slope.

D LP 24
This is a lowpass filter with a fairly steep roll-off slope of 24 dB/Octave.

Filter controls

The following filter controls are available:
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D Freq
This is used for setting the filter cutoff frequency. The cutoff frequency determines 
the limit above or below which frequencies will be cut off depending on the se-
lected filter type. In the case of a lowpass filter for example, frequencies below the 
cutoff frequency will be allowed to pass through, while frequencies above it will be 
cut off. The farther to the right you turn the knob, the higher the cutoff frequency 
will be.

✪ It is very common to modulate filter frequency with the modulation enve-
lope, as described on page 280.

D Res
Technically, this knob controls feedback of the output signal from the filter, back to 
its input. Acoustically it emphasizes frequencies around the cutoff frequency. For a 
lowpass filter for example, increasing Res will make the sound increasingly more 
hollow until the sound starts “ringing”. If you set a high value for the Res parameter 
and then vary the filter frequency, this will produce a classic synthesizer filter 
sweep.

For the notch and bandpass filter types, the Resonance setting instead adjusts the 
width of the band. That is, the higher the resonance setting, the narrower the band 
will be where frequencies are cut off (notch) or let through (Bandpass).

D K. Track
This lets you activate and control keyboard tracking of the filter frequency. If key-
board tracking is activated, the set cutoff frequency of the filter will change ac-
cording to the notes you play on your keyboard. That is, if you play notes higher up 
on the keyboard, the filter frequency will be raised and vice versa.

When the knob is set to its center position, filter frequency is adjusted so that the 
harmonic content remains constant across the keyboard.

Keyboard tracking is deactivated by default (the knob all the way to the left). This 
means that the filter frequency will remain unchanged regardless of where on the 
keyboard you play.

The Modulation Envelope

The Modulation Envelope parameters let you control how certain parameters, or des-
tinations, should change over time - from the moment a note is struck to the moment 
it is released again. 

The destinations you can use are: 

• Pitch
• Filter frequency

Parameters

The following are the available controlling parameters:

D Attack
When you press a key on your keyboard, the envelope is triggered. The attack pa-
rameter then controls how long it should take before the controlled parameter 
(pitch or filter) reaches the maximum value, when you press a key. By setting at-
tack to a value of “0”, the destination parameter would reach the maximum value 
instantly. By raising the attack parameter, the value will instead slowly “slide” up to 
its maximum.

D Hold
This is used for deciding how long the controlled parameter should stay at its max-
imum value before starting to decrease again. This can be used in combination 
with the Attack and Decay parameters to make a value reach its maximum level, 
stay there for a while (hold) and then start dropping gradually down to the sustain 
level.

D Decay
After the maximum value for a destination has been reached and the Hold time has 
expired, the controlled parameter will start to gradually drop down to the sustain 
level. How long it should take before it reaches the sustain level is controlled with 
the Decay parameter. If Decay is set to “0”, the value will immediately drop down 
to the sustain level.
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D Sustain
The Sustain parameter determines the value the envelope should drop back to af-
ter the Decay. If you set Sustain to full level however, the Decay setting doesn’t 
matter since the value will never decrease.
A combination of Decay and Sustain can be used for creating envelopes that rise 
up to the maximum value, then gradually decrease to, and stay on a level some-
where in-between zero and maximum. 

D Release
This works just like the Decay parameter, with the exception that it determines the 
time it takes for the value to fall back to zero after the key is released.

D Delay
This is used for setting a delay between when a note is played and when the effect 
of the envelope starts. That is, the sound will start unmodulated, and the envelope 
will kick in after you have kept the key(s) pressed down for a while. Turn the knob 
to the right to increase the delay time. If the knob is set all the way to the left, there 
will be no delay.

D Key To Decay
By using this, you can cause the value of the Decay parameter (see above) to be 
offset depending on where on your keyboard you play. If you turn the knob to the 
right the decay value will be raised the higher up you play, and turning the knob to 
the left will lower the decay value the higher up you play. With the knob in the cen-
ter position, this parameter is deactivated.

Destinations

The following are the available Mod Envelope destinations:

D Pitch
This will make the envelope modulate the pitch, as set in the Pitch section (see 
page 279). Turn the knob to the right to raise the pitch and to the left to lower the 
pitch. In the middle position, pitch will not be affected by the envelope.

D Filter
This will make the envelope modulate the cutoff frequency of the Filter (see page 
279). Turn the knob to the right to increase the frequency and to the left to lower 
the frequency. In the middle position, the envelope will have no effect on the cutoff 
frequency.

The Amplitude Envelope

The Amplitude Envelope parameters let you control how the volume of a sound should 
change over time - from the moment a note is struck to the moment it is released 
again.

Parameters

Most of the Amplitude Envelope parameters are identical to those of the Modulation 
Envelope. So for a detailed description of the following parameters, please refer to the 
modulation envelope section on page 280:

• Attack
• Hold
• Decay
• Sustain
• Release
• Delay
• Key To Decay

The following are the parameters that are unique for the Amp Envelope section:

D Level
This knob sets the level of the zone. Turn it to the right to raise the level.

D Spread and Pan modes
These two parameters are used for controlling the stereo (pan) position of the 
sound. The Spread knob determines the sound’s width in the stereo image (how 
far left – right the notes will be spread out). If this is set to “0”, no spread will take 
place. The Mode selector switch is used for choosing which type of spread you 
want to apply:
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D Pan
This controls the stereo balance of the output pair to which a zone is routed. In the 
middle position, the signal appears equally strong on the left and right channel in a 
stereo pair. By turning the knob to the left or right, you can change the stereo bal-
ance.

Note that if you for instance turn the Pan knob all the way to the left, you cause the 
signal to be output from the left channel of the stereo pair only.

You can use this to treat a stereo output as two independent mono outputs, if re-
quired.

See page 276 for information on routing zones to output pairs.

The LFOs

NN-XT features two Low Frequency Oscillators - LFO 1 and LFO 2. “Normal” oscilla-
tors generate a waveform and a frequency, and produce sound. Low frequency Oscil-
lators on the other hand, also generate a waveform and a frequency, but there are two 
major differences: 

• LFOs only generate sounds of a low frequency.
• LFOs don’t produce sound, but are instead used for modulating various parame-

ters.

The most typical use of an LFO is to modulate the pitch of a sound (generated by an 
oscillator or - in the case of NN-XT - a sample), to produce vibrato.

About the Difference between LFO 1 and LFO 2

There are two fundamental differences between LFO 1 and LFO 2:

D LFO 2 is always key synced, that is, each time you press a key, the LFO 
waveform starts over from scratch. LFO 1 can be switched between key 
synced and non-key synced modes.

D LFO 2 only has one waveform, triangle.

The following parameters are available for the LFOs:

Rate (LFO 1 and 2)

This knob controls the frequency of the LFO. For a faster modulation rate, turn the 
knob to the right.

The Rate knob of LFO 1 is also used for setting the timedivision when synchronizing 
the LFO to the song tempo (see below).

Delay (LFO 1 and 2)

This can be used for setting a delay between when a note is played and when the 
LFO modulation starts kicking in (gradually). This way, you can make the sound start 
unmodulated, and then have the LFO modulation start after you have kept the key(s) 
pressed down for a while. 

Turn the knob to the right to increase the delay time.

|Mode |Description
Key This will make the pan position shift gradually from left to right, the higher 

up on the keyboard you play.

Key 2 This will make the pan position shift from left to right and then back again 
from right to left in a sequence of eight keys. Playing 4 adjacent semi-
tones thus makes the pan position gradually go from left to right. The next 
4 higher semitone notes will then change the pan position from right to 
left in the same way, and this cycle will then be repeated.

Jump This will make the pan position jump between left and right each time a 
note is played.
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Mode (LFO 1 only)

This lets you set the “operation mode” for the LFO. Click the button to switch be-
tween the available modes:

D Group Rate
In this mode, the LFO will run at the rate set for its group in the group section, 
rather than at the rate set here (see page 276). This way, all zones in the group will 
have the exact same modulation rate.

D Tempo Sync
In this mode, the LFO will be synchronized to the song tempo, in one of 16 possi-
ble time divisions.

! When tempo sync is activated, the Rate knob is used for selecting the de-
sired timedivision. Turn the Rate knob and observe the tool tip for an in-
dication of the timedivision.

D Free Run
In free run mode, the LFO simply runs at the rate set with the Rate parameter. Fur-
thermore, if Key Sync is deactivated, the modulation cycle will not be retriggered 
each time you press a key - it will run continuously.

Waveform (LFO 1 only)

Here, you select which type of waveform should be used for modulating the destina-
tion parameters.

Click the button to switch between the following waveforms:

! LFO 2 always uses a triangle waveform.

Key Sync (LFO 1 only)

By activating key sync, you “force” the LFO to restart its modulation cycle each time a 
key is pressed.

! Note that LFO 2 always uses Key Sync.

Destinations for LFO 1

The following parameters can be modulated by LFO 1: 

D Pitch
This will make the LFO modulate the pitch, for vibrato, trills, etc. It can be set to -
2400 – 0 – 2400 cents which equals 4 octaves. The set pitch will change up and 
down by this amount, with each modulation cycle. Turning the knob to the right will 
make the modulation cycle start above the set pitch, while turning it to the left will 
invert the cycle. Keeping this in the middle position means that the pitch will not be 
affected by the LFO.

D Filter
This will make the LFO modulate the cutoff frequency of the Filter, for auto-wah ef-
fects, etc. The positive/negative effect is the same as for pitch.

D Level
This will make the LFO modulate NN-XT’s output level, for tremolo effects, etc. The 
positive/negative effect is the same as for pitch.

Destinations for LFO 2

The following parameters can be modulated by LFO 2:

D Pan
This makes the LFO modulate the pan position of a zone. The sound will move 
back and forth in the stereo field. Turning the knob to the left makes the sound 
move from left to right, and turning it to the right thus makes it move from right to 
left. The middle position provides no modulation at all.

D Pitch
Just like for LFO 1 (see above), this makes LFO 2 modulate the pitch. The range is 
also the same as for LFO 1.

|Waveform |Description
Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted Sawtooth This produces a “ramp up” cycle. If applied to an oscillator’s fre-
quency, the pitch would sweep up, after which the cycle imme-
diately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but in-
verted.

Square This produces cycles that abruptly change between two values, 
usable for trills etc.

Random Produces random stepped modulation to the destination. Some 
vintage analog synths called this feature “sample & hold”.

Soft Random The same as above, but with smooth modulation.
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Connections
On the back panel of NN-XT are a number of connectors. Many of these are CV/Gate 
related. Using CV/Gate is described in the chapter “Routing Audio and CV”.

Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the NN-XT from another 
CV/Gate device (typically a Matrix or a Redrum). The signal to the CV input controls 
the note pitch, while the signal to the Gate input delivers note on/off along with veloc-
ity.

Modulation Input
These control voltage (CV) inputs (with associated voltage trim pots), can modulate 
various NN-XT parameters from other devices. These inputs can control the following 
parameters:

• Oscillator Pitch
• Filter Cutoff Frequency
• Filter Resonance
• LFO 1 Rate
• Master Volume
• Pan
• Modulation Wheel
• Pitch Wheel

Gate Input
These inputs can receive a CV signal to trigger the following envelopes:

• Amplitude Envelope
• Modulation Envelope 

Note that connecting to these inputs will override the normal triggering of the enve-
lopes. For example, if you connect a Matrix Gate Out to the Gate In Amp Envelope, 
you would not trigger the amp envelope by playing notes, as this is now controlled by 
the Matrix Gate Out. In addition you would only hear the Gate Out triggering the en-
velope for the notes that you hold down.

Audio Output
There are 16 audio output jacks on the NN-XT’s back panel - eight separate stereo 
pairs. When you create a new NN-XT device, the first output pair (1L & 2R) is auto-
routed to the first available channel on the audio mixer. 

The other output pairs are never automatically routed. If you wish to use any of the 
other output pairs, you have to manually connect them to the desired device - typically 
a mixer channel. The basics on Routing is described on page 26.

! Note that when you use any other output pair than the first, you also have 
to route one or more zones to it if you want it to actually output sound, 
since all zones by default are routed to outputs 1 & 2. How to route zones 
to other outputs is described on page 276.
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Introduction

The Dr.Rex Loop Player is capable of playing back and editing files created in ReCy-
cle, another product created by Propellerhead Software. ReCycle is a program de-
signed especially for working with sampled loops. By “slicing” a loop and making 
separate samples of each beat, ReCycle makes it possible to change the tempo of 
loops without affecting the pitch and to edit the loop as if it was built up of individual 
sounds.

ReCycled Loops
To fully understand Dr.Rex you need to understand what it means to ReCycle a drum 
loop. Imagine that you have a sample of a drum loop that you want to use in a track 
you are working on. The loop is 144 bpm and your track is 118 bpm. What do you 
do? You can of course lower the pitch of the loop, but that will make the loop sound 
very different, and if the loop contains pitched elements they will no longer match your 
song. You can also time stretch it. This won’t alter the pitch, but will make the loop 
sound different. Usually it means that you loose some “punch” in the loop. 

Instead of stretching the sample, ReCycle slices the loop into little pieces so that 
each drum hit (or whatever sound you are working with) gets it's own slice. These 
slices can be exported to an external hardware sampler or saved as a REX file to be 
used in Reason. When the loop has been sliced you are free to change the tempo any 
way you want. You can also create fills and variations since the slices can be moved 
around in the sequencer.

About File Formats
Dr.Rex can read files in the following formats:

D REX (.rex) 
This is the file format generated by previous versions of ReCycle (Mac platform).

D RCY (.rcy) 
This is the file format generated by previous versions of ReCycle (PC platform).

D REX 2 (.rex2) 
This is the ReCycle file format for both Mac and PC platforms generated by ReCy-
cle version 2.0. One of the differences between the original REX format and 
REX2, is that the REX2 format supports stereo files. 

! Unlike the other audio devices, Dr.Rex does not load or save file informa-
tion in a “Patch” format. The REX file and the associated panel settings 
is instead saved in the Song (.rns) file. 

✪ If you have made adjustments (pitch, level etc.) to a REX loop that you 
wish to use in another Song, you can simply copy the whole Dr.Rex de-
vice from one song to another.
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Adding a Loop
To add a loop into the Dr.Rex Loop Player, proceed as follows:

1. Open the browser by selecting “Browse ReCycle/REX Files” from the Edit 
menu or the device context menu, or click on the folder button beside the 
Loop name display.

2. In the browser, locate and open the desired loop.
You can listen to the loops before loading by using the Preview function in the 
browser.

! Loading a new REX file will replace any currently loaded file.

Auditioning the Loop in Dr.Rex
D Once loaded, you can check out the loop by using the Preview button.

It will play back repeatedly in the tempo set on the transport panel. If you change 
the tempo, the loop tempo follows.

D You can also play the loop once via MIDI, by using the D0 key.

D To check out the loop together with other device sequencer data and pat-
terns already recorded, activate both the Preview function and the se-
quencer Play button.
This does not have to be done in any particular order, they will play back in perfect 
sync anyway.

Loading Loops “On the Fly”
Another practical method for checking out loops, is to load them “on the fly”, i.e. dur-
ing playback. This is especially useful if you want to check out a number of loops 
against other sequencer data and patterns previously recorded. Proceed as follows:

1. Activate Preview on the Dr.Rex and start sequencer playback.
The REX loop and the sequencer are synced.

2. Now load a new REX file by using the Browser in one of the usual ways.
After a brief silence, the new file is loaded, and sync is maintained.

3. Repeat step 2 as necessary until you have found a suitable loop.

D If you are trying out loops within the same folder, the quickest ways to 
select a new loop is to use the arrow keys next to the loop name display.
Or, you can click in the loop name display and select a new loop from the pop-up 
menu that appears.

! Note that the Preview function is not the “real” way of playing back REX 
loops. If you want to use the loop in a context with other devices, you 
should transfer the REX slices to notes in the sequencer, as described on 
page 288.
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Creating Sequencer Notes
To be able to make your REX loop start at the same time as other sequencer or pat-
tern data, you first have to create sequencer notes from the slices:

1. Select the sequencer track connected to the Dr.Rex device.

2. Set the left and right locators to encompass the section you want to fill with 
REX notes.

3. Click the To Track button on the Dr.Rex panel.

Now, the program will create clips containing a note for each slice, positioned accord-
ing to the timing of the slices. The notes will be pitched in semitone steps, with the 
first note on C1, the second on C#1 and so on, with one pitch for each slice. If the 
area between the locators is longer than the loop length, the clip containing the loop 
notes will be repeated to fill out the loop.

The loop clips in the Arrange View...

...and in the Edit View.

Activating playback in the sequencer will now play back the notes on the sequencer 
track. These in turn will play back the slices in the Dr.Rex device, in the correct order 
and with the original timing maintained. Now the fun begins!

• You can change the groove in the loop by quantizing or moving notes.
• You can transpose notes to change the order of the slices on playback.
• You can use the Alter Notes function (see page 91) to scramble the loop notes - 

without destroying the original loop timing.
• You can remove and draw new notes, creating any kind of variation.
• You can use the User Groove function to apply the rhythmic feel of the loop to 

notes on other sequencer tracks.

For details about editing in the sequencer, see page 78.

! Note that if you have created sequencer notes from a REX file, you can-
not load a new REX file into Dr.Rex and play it from the existing track. 
Well, you can, but it will not play back properly. If you have created notes 
in this way, and want to change the REX file, first delete the notes, then 
use the “To Track” command again after having loaded the new REX file. 

You can also export the REX file as a MIDI file, as described on page 370.
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Slice Handling
Selecting Slices

A selected slice is indicated by being highlighted in the waveform display. To select a 
slice, use one of the following methods:

D By clicking in the waveform display.
If you hold down [Option] (Mac) or [Alt] (Windows) and click on a slice in the 
waveform display, it will be played back. The pointer takes on the shape of a 
speaker symbol to indicate this.

D By using the “Slice” knob below the waveform display.

D Via MIDI.
If you activate “Select Slice Via MIDI”, you can select and “play” slices using your 
MIDI keyboard. Slices are always mapped to consecutive semitone steps, with the 
first slice always being on the “C1” key.

D If you play back a loop with “Select via MIDI” option activated, each con-
secutive slice is selected as it is played back.
You can edit parameters during playback.

Editing Individual Slices
There are two basic methods you can use to edit individual slices in Reason:

D In the Waveform display of the Dr.Rex device.
This is used for making playback settings for a slice.

D In the Sequencer.
Here you can edit the notes that play the slices. There is a special REX edit lane 
for editing REX slice notes, with the notes indicated by the slice numbers instead 
of by pitches. Editing in the sequencer is described in the Sequencer chapter.

Editing in the Waveform Display

Here you are able to edit several parameters for each slice, by first selecting it, and 
then using the knobs below the waveform display. The following slice parameters can 
be set:

! If you have made settings to any of the parameters listed above, these 
will be lost if you load a new REX file. All Dr.Rex panel settings are 
stored in the Song. You cannot directly apply panel settings to another 
REX file!

|Parameter |Description
Pitch Allows you to transpose each individual slice in semitone steps, over 

a range of more than eight octaves.

Pan The stereo position of each slice.

Level The volume of each slice. The default level is 100.

Decay Allows you to shorten individual slices.
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Dr.Rex Synth Parameters
The Dr.Rex synth parameters are used for shaping and modulating the sound of the 
REX loops. These parameters are familiar synth parameters, similar to the ones in the 
synthesizers; The Subtractor and the Malström, and in the samplers; the NN-19 and 
the NN-XT. It is important to remember that these parameters do not alter the REX 
files in any way, only the way they will play back. 

! These parameters are global, in the sense that they will affect all slices in 
a REX file.

Oscillator Section

For a REX file, the audio contained in the slices are what oscillators are for a synthe-
sizer, the main sound source. The following settings can be made in the Osc section 
of the Dr.Rex:

Setting the overall Pitch

You can change the pitch of a REX file in three ways:

D In octave steps.
This is done using the Oct knob. The range is 0 - 8, with “4” the default.

D In semitone steps.
This is done by using the Transpose knob below the waveform display, or by click-
ing on the keyboard above the knob. You can raise or lower the frequency in 12 
semitone steps (+/– 1 octave). The transpose value can also be changed via MIDI, 
by pressing a key between C-2 and C0 (with C1 resetting the transpose value to 
zero).

D In cents (hundredths of a semitone).
The range is -50 to 50 (down or up half a semitone).

! To tune an individual slice, you select it and use the Pitch parameter be-
low the waveform display.

Osc Envelope Amount

This parameter determines to what degree the overall pitch of the REX file will be af-
fected by the Filter Envelope (see page 291). You can set negative or positive values 
here, which determines whether the envelope curve should raise or lower the pitch.

The Filter Section

Filters are used for shaping the overall timbre of the sound. The filter in Dr.Rex is a 
multimode filter with five filter modes.

D You activate or deactivate the filter completely by clicking the Filter but-
ton.
The filter is active when the button is lit.

Filter Mode

With this selector you can set the filter to operate as one of five different types of filter. 
These are as follows:

D 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. This 
filter type has a fairly steep roll-off curve (24dB/Octave). Many classic synthesizers 
(Minimoog/Prophet 5 etc.) used this filter type.

D 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in classic analog synthesizers (Ober-
heim, early Korg synths, etc.). It has a gentler slope (12 dB/Octave), leaving more 
of the harmonics in the filtered sound compared to the LP 24 filter.

D Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange frequencies 
are not affected. Each slope in this filter type has a 12 dB/Octave roll-off.

D High-Pass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out lower frequencies 
and letting high frequencies pass. The HP filter slope has a 12 dB/Octave roll-off.

D Notch
A notch filter (or band reject filter) could be described as the opposite of a band-
pass filter. It cuts off frequencies in a narrow midrange band, letting the frequen-
cies below and above through. 
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Filter Frequency 

The Filter Frequency parameter (often referred to as “cutoff”) determines which area 
of the frequency spectrum the filter will operate in. For a lowpass filter, the frequency 
parameter could be described as governing the “opening” and “closing” of the filter. If 
the Filter Freq is set to zero, none or only the very lowest frequencies are heard, if set 
to maximum, all frequencies in the waveform are heard. Gradually changing the Filter 
Frequency produces the classic synthesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the Fil-
ter Envelope (see page 291) as well. Changing the Filter Frequency with 
the Freq slider may therefore not produce the expected result.

Resonance

The filter resonance parameter affects the character of the filter sound. For lowpass 
filters, raising the resonance will emphasize the frequencies around the set filter fre-
quency. This produces a generally thinner sound, but with a sharper, more pro-
nounced filter frequency “sweep”. The higher the resonance value, the more resonant 
the sound becomes until it produces a whistling or ringing sound. If you set a high 
value for the resonance parameter and then vary the filter frequency, this will produce 
a very distinct sweep, with the ringing sound being very evident at certain frequencies.

• For the highpass filter, the resonance parameter operates just like for the lowpass 
filters.

• When you use the Bandpass or Notch filter, the resonance setting adjusts the 
width of the band. 
When you raise the resonance, the band where frequencies are let through (Band-
pass), or cut (Notch) will become narrower. Generally, the Notch filter produces 
more musical results using low resonance settings.

Envelope Section
Envelope generators are used to control several important sound parameters in ana-
log synthesizers, such as pitch, volume, filter frequency etc. In a conventional synthe-
sizer, envelopes govern how these parameters should respond over time - from the 
moment a note is struck to the moment it is released. In the Dr.Rex device however, 
the envelopes are triggered each time a slice is played back.

There are two envelope generators in the Dr.Rex, one for volume, and one for the filter 
frequency (and/or pitch). Both have the standard four parameters; Attack, Decay, 
Sustain and Release 

! Please refer to the Subtractor chapter for a description of the basic enve-
lope parameters.

Amplitude Envelope

The Amp Envelope governs how the volume of a slice should change over time, from 
the time it is triggered (the slice note starts) until the slice note ends. This can be used 
to make a loop more distinct (by having a snappy attack and a short decay time) or 
more spaced-out (by raising the attack time).

The Level parameter acts as a general volume control for the loop.

Filter Envelope

The Filter Envelope can be used to control two parameters; filter frequency and over-
all loop pitch. By setting up a filter envelope you control how the filter frequency and/
or the pitch should change over time for each slice.

The Amount parameter determines to what degree the filter frequency will be affected 
by the Filter Envelope. The higher the Amount setting, the more pronounced the effect 
of the envelope on the filter.

✪ Try lowering the Frequency slider and raising Resonance and Envelope 
Amount to get the most effect of the filter envelope!

LFO Section

LFO stands for Low Frequency Oscillator. LFOs are oscillators in the sense that they 
generate a waveform and a frequency. However, there are two significant differences 
compared to normal sound generating oscillators:

• LFOs only generate waveforms with low frequencies.
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• The output of the two LFOs are never actually heard. Instead they are used for 
modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound generat-
ing) oscillator or sample, to produce vibrato. In the Dr.Rex device, you can also use 
the LFO to modulate the filter frequency or panning.

Waveform

LFO 1 allows you to select different waveforms for modulating parameters. These are, 
from top to bottom:

Destination

The available LFO Destinations are as follows:

Sync

By clicking this button you activate/deactivate LFO sync. The frequency of the LFO 
will then be synchronized to the song tempo, in one of 16 possible time divisions. 
When sync is activated, the Rate knob (see below) is used for setting the desired time 
division.

Turn the knob and check the tooltip for an indication of the time division.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modulation 
rate.

Amount

This parameter determines to what degree the selected parameter destination will be 
affected by the LFO 1, i.e. the amount of vibrato, filter wah or auto-panning.

Velocity Control

Velocity is usually used to control various parameters according to how hard or soft 
you play notes on your keyboard. A REX file does not contain velocity values on its 
own. And when you create sequencer track data by applying the “To Track” function, 
all velocities are set to a default value of “64”. As velocity information is meant to re-
flect variation, having them all set to the same value is not meaningful if you wish to ve-
locity control Dr.Rex parameters.

There are basically two ways you can apply “meaningful” velocity values to REX files:

• After creating track data, you can edit velocity values in the Velocity Lane in the se-
quencer.

• You can play slices in real time on your keyboard. The resulting data will have ve-
locity values reflecting how the notes were struck when you played.

When velocity values have been adjusted, you can control how much the various pa-
rameters will be affected by velocity. The velocity sensitivity amount can be set to ei-
ther positive or negative values, with the center position representing no velocity 
control. 

The following parameters can be velocity controlled:

|Waveform |Description
Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted
Sawtooth

This produces a “ramp up” cycle. If set to control pitch (frequency), 
the pitch would sweep up to a set point (governed by the Amount 
setting), after which the cycle immediately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but inverted.

Square This produces cycles that abruptly changes between two values, us-
able for trills etc.

Random Produces random stepped modulation to the destination. Some vin-
tage analog synths called this feature “sample & hold”.

Soft Random The same as above, but with smooth modulation.

|Destination |Description
Osc Selecting this makes LFO control the pitch (frequency) of the REX 

file.

Filter Selecting this makes the LFO control the filter frequency. 

Pan Selecting this makes the LFO modulate the pan position of the REX 
file, i.e. it will move the sound from left to right in the stereo field.

| Parameter |Description
Amp This let’s you velocity control the overall volume of the file. If a posi-

tive value is set, the volume will increase with higher velocity values. 

F. Env This sets velocity control for the Filter Envelope Amount parameter. 
A positive value will increase the envelope amount with higher veloc-
ity values. Negative values invert this relationship.

F. Decay This sets velocity control for the Filter Envelope Decay parameter. A 
positive value will increase the Decay time with higher velocity val-
ues. Negative values invert this relationship.
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Pitch Bend and Modulation Wheels

The Pitch Bend wheel is used for “bending” the pitch up or down. The Modulation 
wheel can be used to apply various modulation while you are playing the loop. Virtually 
all MIDI keyboards have Pitch Bend and Modulation controls. Dr.Rex also has two 
functional wheels that could be used to apply real time modulation and pitch bend 
should you not have these controllers on your keyboard, or if you aren’t using a key-
board at all. The wheels mirror the movements of the corresponding MIDI keyboard 
controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is turned fully up 
or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of parameters. 
You can set positive or negative values, just like in the Velocity Control section. The 
following parameters can be affected by the modulation wheel:

Setting Number of Voices - Polyphony

This determines the polyphony, i.e. the number of voices, or slices, Dr.Rex can play si-
multaneously. For normal loop playback, it is worth noting that slices sometimes “over-
lap”. Therefore, it is recommended that you use a polyphony setting of about 3-4 
voices when playing REX files. If you are “playing” slices via MIDI, the polyphony set-
ting should be set according to how many overlapping slices you want to have.

! Note that the Polyphony setting does not “hog” voices. For example, if 
you are playing a file that has a polyphony setting of ten voices, but the 
file only uses four voices, this won’t mean that you are “wasting” six 
voices. In other words, the polyphony setting is not something you need 
to consider if you want to conserve CPU power - it is only the number of 
voices actually used that counts.

Audio Quality Settings

These two parameters provide ways of balancing audio quality vs. conservation of 
computer power.

High Quality Interpolation

When this is activated, the loop file playback is calculated using a more advanced in-
terpolation algorithm. This results in better audio quality, especially for loops with a lot 
of high frequency content.

D High Quality Interpolation uses more computer power - if you don’t need 
it, it’s a good idea to turn it off!
Listen to the loop in a context and determine whether you think this setting makes 
any difference.

! If you are using a Macintosh with a G4 or G5 (Altivec) processor, turning 
High Quality Interpolation off makes no difference.

Low Bandwidth (BW)

This will remove some high frequency content from the sound, but often this is not no-
ticeable (this is especially true if you have “filtered down” your loop). Activating this 
mode will save you some extra computer power, if needed.

|Parameter |Description
F. Freq This sets modulation wheel control of the filter frequency parameter. 

A positive value will raise the frequency if the wheel is pushed for-
ward. Negative values invert this relationship.

F. Res This sets modulation wheel control of the filter resonance parameter. 
A positive value will increase the resonance if the wheel is pushed 
forward. Negative values invert this relationship.

F. Decay This sets modulation wheel control for the Filter Envelope Decay pa-
rameter. A positive value will increase the decay if the wheel is 
pushed forward. Negative values invert this relationship.
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Connections
On the back panel of Dr.Rex you will find the connectors, which are mostly CV/Gate 
related. Using CV/Gate is described in the chapter “Routing Audio and CV”.

Audio Outputs
These are the main left and right audio outputs. When you create a new Dr.Rex de-
vice, these are auto-routed to the first available channel on the audio mixer.

Slice Gate Output
This outputs a gate signal for each triggered slice in the loop.

Modulation Inputs
These control voltage (CV) inputs (with associated voltage trim pots), allow you to 
modulate various Dr.Rex parameters from other devices (or from the modulation out-
puts of the Dr.Rex device itself). The following CV inputs are available:

• Osc Pitch.
• Filter Cutoff.
• Filter Resonance.
• Amp Level.
• Mod Wheel.

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other param-
eters in the Dr.Rex device itself. The Modulation Outputs are:

• Filter Envelope.
• LFO.

Gate Inputs
These inputs can receive a CV/gate signal to trigger the two envelopes. Note that 
connecting to these inputs will override the “normal” triggering of the envelopes. For 
example, if you connected an LFO CV output on another device to the Gate Amp in-
put on the Dr.Rex, the amplitude envelope would not be triggered by the incoming 
MIDI notes to the Dr.Rex device, but by the LFO CV signal. In addition you would only 
hear the LFO triggering the envelope for the slices that were playing at the moment of 
the trigger.

• Amp Envelope
• Filter Envelope
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Introduction

The Matrix is a pattern-based device. Matrix doesn’t generate sound on its own, but 
has to be connected to another instrument device. It basically works by sending pat-
tern data in the form of Note CV (pitch) and Gate CV (note on/off plus velocity) or 
Curve CV (for general CV parameter control) signals to a device or device parameter. 
The patterns can be up to 32 steps, and there are 32 memory locations for storing 
pattern data. The Matrix is monophonic and can control one voice in an instrument de-
vice.

Unlike most other devices in Reason, the user interface of the Matrix is not modeled 
on any existing hardware equivalent. The hardware devices that could be said to have 
similar functionality are analog step sequencers, which usually had rows of knobs that 
controlled the note pitch and gate values for each step.

About the Three Output Types

Note and Gate CV values.

The Matrix can produce three types of output: Curve CV, Note (Key) CV and Gate 
CV. 

D Note CV normally controls note pitch. 
When connected to an instrument device Sequencer Control input, the values 
correspond to semitone steps.

D Gate CV represents a note-on/off value, plus a level value (that could be 
likened to velocity).

Both of these two outputs are typically connected to the Sequencer Control Gate and 
CV inputs on a compatible instrument device. For example, if you create a Matrix with 
either a synthesizer (Subtractor, Malström) or a sampler (NN-19, NN-XT) selected, 
they will be auto-routed in this way, and will control one voice in the device.

D Curve CV is a separate pattern, programmed separately from the Note/
Key and Gate CV.

Curve CV values (upper window).

This is useful for programming CV curves that control other parameters other than 
note pitch (although you could do this too). This way you could control the note pitch 
and triggering from the Key and Gate outputs for a device, then add a second inde-
pendent pattern using the Curve CV output that could control filter cutoff for example.

It should be stressed that all three outputs can be used in any number of ways. For ex-
ample, you could use the Gate CV to trigger a drum in Redrum, or let the Curve CV 
control the feedback parameter of a delay, etc.

Gate values are 
entered here

Note values are 
entered here



MATRIX PATTERN SEQUENCER
297

Programming Patterns
Pattern Basics
Matrix contains a built-in pattern sequencer. Unlike the main sequencer in Reason, the 
Matrix sequencer repeatedly plays back a pattern of a specified length. The typical ex-
ample in the “real world” (as well as in Reason) is a drum machine which plays drum 
patterns, usually one or two bars in length.

Having the same pattern repeat throughout a whole song may be fine in some cases, 
but most often you want some variations. The solution is to create several different 
patterns and program pattern changes (automatic switching from one pattern to an-
other) at the desired positions in the song.

How the Matrix pattern sequencer integrates with the main 
Sequencer

The built-in pattern sequencer in the Matrix interacts with the main Reason sequencer 
in the following ways:

D The tempo set on the transport panel is used for all playback.
If the Tempo track (see page 94) is used, Matrix will follow this.

D If you start playback for the main sequencer (on the transport panel), the 
Matrix will automatically start as well (provided the pattern sequencer 
hasn’t been disabled - see below).

D You can mute and solo Matrix tracks in the sequencer.
If the Matrix has a track in the sequencer and you mute this track, Matrix will auto-
matically be muted as well. This is indicated by a Mute indicator on the device 
panel. If there are several note lanes on the Matrix track, their respective mute sta-
tus will not be indicated on the device panel.

D You can also run Matrix separately (without starting the main sequencer) 
by clicking the Run button on the device panel.
This starts the built-in pattern sequencer in the device. To stop playback, click the 
Run button again or click the Stop button on the Transport panel.

D If you are running Matrix separately and start playback of the main se-
quencer, the pattern device will automatically restart in sync with the se-
quencer.

D Pattern changes can be controlled by a pattern lane in the main se-
quencer.
In other words, you can record or create pattern changes in the main sequencer, 
and have them occur at the correct position on playback.

Selecting Patterns

The Matrix has 32 pattern memories, divided into four banks 
(A, B, C, D).

The Bank and Pattern buttons for the Matrix pattern sequencer.

D To select a pattern in the current bank, click on the desired Pattern but-
ton (1-8).

D To select a pattern in another bank, first click the desired Bank button (A, 
B, C, D) and then click the Pattern button.
Nothing happens until you click the Pattern button.

The pattern change takes effect on the next downbeat according to the time signature 
set in the transport panel or on the transport track.

The Pattern Enable switch

The Pattern Enable switch.

Next to the Bank and Pattern buttons you will find an additional switch, which is nor-
mally activated. If you click this to turn it off, the pattern playback will be disabled, 
starting at the next downbeat - exactly as if you had selected an empty (silent) pattern. 
For example, this can be used for bringing Matrix patterns in and out of the mix during 
playback.

Steps

Matrix patterns consist of a number of discrete steps. For each step, you can enter a 
note, a CV value and a Curve value. When you run the pattern, each step will be 
played back in turn and will play a sound or send out the information programmed for 
this step. If you have ever used a drum machine, this will be obvious to you.

Clearing a Pattern

To clear (empty) a pattern, select it and use the Clear Pattern command on the Edit 
menu or device context menu.
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! Note that clearing a pattern doesn’t affect the pattern length, resolution 
or shuffle settings!

Using Cut, Copy and Paste

By using the Cut, Copy and Paste Pattern commands on the Edit menu or device con-
text menu, you can move or duplicate patterns. The following rules apply:

D Copy Pattern makes a copy of the currently selected pattern and places 
the copy on the clipboard.

D Cut Pattern moves the currently selected pattern to the clipboard.
This is the same as first performing Copy Pattern and then Clear Pattern.

D Paste Pattern copies the pattern on the clipboard to the selected pattern 
location in the selected device.
This overwrites the selected pattern with the one on the clipboard.

Transferring patterns between Reason songs

If you want to copy patterns between different Reason songs, you use copy and 
paste:

1. Open both songs.

2. Select the pattern you want to copy.

3. Select Copy Pattern from the Edit menu or the device context menu.
You can also hold [Command] (Mac) or [Ctrl] (Windows) and press [C] to copy.

4. Make the other song active.
This is done by clicking in the song window or by selecting the song from the Win-
dows menu.

5. Select the bank and pattern location to which you want to copy the pattern.
Note that any pattern already stored in that location will be overwritten!

6. Select Paste Pattern from the Edit menu or the device context menu.
You can also hold [Command] (Mac) or [Ctrl] (Windows) and press [V] to copy.

Tutorial
The programming procedure of the Matrix is to input note and gate values into the up-
per and lower fields of the pattern window respectively. You can input values by click-
ing or dragging in the pattern window. Proceed as follows:

1. Create a Subtractor synth.
You don’t have to use the Subtractor device to use the Matrix, in fact you don’t 
have to use an instrument device at all, but for this basic tutorial we will use a 
“standard” setup.

2. With the Subtractor selected, create a Matrix Pattern Sequencer.
The Matrix Note and Gate CV outputs will now be auto-routed to Subtractors Se-
quencer Control Gate and CV inputs, as you can see if you flip the rack around.

3. Make sure that the switch to the left of the pattern window is set to “Keys” 
position.
As you can see, there are two rows of red rectangles. The one with horizontal rect-
angles at the bottom of the upper field in the pattern window represent note pitch, 
for each step in a pattern. At the moment they are all set to the same note pitch. 
The row of vertical rectangles in the lower field represent Gate velocity values - 
currently these are all set to a velocity value of 100 for all steps.
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4. Click inside the upper grid section of the Matrix pattern window.
An orientation line is displayed in the grid to make it easier for you to find the de-
sired note, and the red rectangles are placed according to where you click. You 
can drag to input continuous note values.

5. Click and drag in the lower area of the pattern window.
You can create vertical Gate velocity strips of varying heights. The higher the strip, 
the higher the velocity value. 

6. Press the Play button on the Matrix.
The pattern you “programmed” in the previous steps is now repeated. At the top of 
the pattern window, a red rectangle indicates every step of the pattern.

D If you now click or drag in the upper grid section with the pattern playing, 
you can hear how the note pitches change.
The note pitch corresponds to the keyboard printed to the left of the pattern win-
dow, in a one octave range, and as previously mentioned, an orientation line is vis-
ible when clicking or dragging, making it easy to find the note pitch on the 
keyboard.

D If you now click or drag in the lower gate section while the pattern is 
playing, you can hear how the timbre and volume changes. 

D If you drag some of the vertical rectangles down so that they disappear 
from view, the corresponding steps of the pattern are completely si-
lenced.

D By using the 5-way switch below the “Keys/Curve” switch you can input 
notes in other octave ranges (over five octaves).
Note that there can only be one note for each step in the pattern.

7. By using a combination of the methods described in the above steps, you 
can program suitable note values for each step, decide which steps should 
be played and set their velocity with the gate values.
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Using Curve Patterns
Curve patterns are independent patterns that can be applied separately to the note 
pattern programmed in “Keys” mode. If you switch the Keys/Curve switch to “Curve”, 
the note, but not the gate steps, disappear from view, and leaves the upper area of the 
pattern window empty. You can now start programming a curve pattern. Proceed as 
follows:

1. Draw a curve, using the same method as for notes or gates.
As you can see, the Curve pattern looks like large vertical gate steps. 

D If you play the pattern, nothing has changed, i.e. the pattern sounds ex-
actly like it did before the Curve pattern was drawn.
This is because the Curve CV output hasn’t been connected to any parameter yet.

2. Flip the rack around so you can see the back panel of the Matrix.

3. Connect the Curve CV output to the Filter Cutoff Modulation Input on the 
Subtractor.
Now the curve pattern controls the filter frequency of the Subtractor.

✪ If the effect isn’t very noticeable, try raising the filter Q parameter, and 
lowering the filter frequency.

D The Curve CV output can be connected to any device CV or Modulation 
input.
Actually, Curve CV signals can also produce Gate triggers (used for triggering 
samples or envelopes for example). 

D A Gate trigger is produced for each curve pattern step that follows a 
value of “0”. 
If you look at the picture below, steps 2,4 and 6 will produce a trigger, because 
steps 1, 3 and 5 are set to zero, but the rest of the pattern would not.

About Unipolar and Bipolar Curves

On the back panel of the Matrix you will find a switch, allowing you to select between 
“Unipolar” or “Bipolar” Curves. The difference is as follows:

D A unipolar curve has values starting from “0” and up. 
“0” is the value produced by all steps when they are “empty” (not visible). Unipolar 
is the default setting of this switch when a new Matrix is created.

Unipolar curve.

D A bipolar curve is divided in the “middle”, with the middle representing a 
value of “0”.
The curve reflects this. If no curve has been drawn and you switch to bipolar 
mode, all steps go from the bottom up to the middle of the scale printed to the left 
of the pattern window. Thus, all steps are at “0”, and the curve can be drawn both 
up and down from the middle.

Bipolar curve.

Bipolar curves are essential in some instances. If you want to use the Matrix to CV 
control the Pan parameter for a mixer channel for example, a unipolar curve would 
start at zero - which for Pan equals center position. This means that you would only be 
able to use the curve to pan in one direction from this center position. A bipolar curve 
however, will have the zero value in the middle, allowing you to draw pan curves in 
both directions. Bipolar curves can also be used for controlling parameters with posi-
tive and negative values.
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Setting Pattern Length

You may want to make settings for Pattern length, i.e. the number of steps the pattern 
should play before repeating:

D The “Steps” spin controls are used to set the number of steps you wish 
the pattern to play.
The range is 1 to 32. You can always extend the number of steps at a later stage, 
as this will merely add empty steps at the end of the original pattern. You could 
also make it shorter, but that would (obviously) mean that the steps you remove 
won’t play back. The steps you remove aren’t erased though, if you set the step 
number back again, anything recorded in the previously removed step locations 
will be played back.

Using Tied Notes
If you activate “Tie” to the left of the Gate pattern window, you can create longer 
notes (eighth notes, quarter notes etc.). A quick way to draw tied gates is to hold 
down [Shift] when you input the gate values.

Entering tied gate values.

D Each step that has one tied gate value will be twice the length compared 
to a normal step.
Tied gate steps are indicated by being twice as wide in the pattern window.

D If two or more notes of the same pitch are tied together, the result will 
be even longer notes. 

Tied notes are also essential if you want to create typical TB-303 “Acid”-type lead 
lines - see page 303.

Setting Pattern Resolution
Matrix always follows the tempo setting on the transport panel, but you can also make 
Matrix play in different tempo “resolutions” in relation to the tempo setting.

Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced swing 
feel. It works by delaying all sixteenth notes that fall in between the eighth notes.

Straight sixteenth note pattern (viewed in the sequencer).

The same sixteenth note pattern with shuffle applied.

In Reason, you can activate or deactivate shuffle individually for each pattern in a pat-
tern device. However, the amount of shuffle is set globally with the Global Shuffle 
control in the ReGroove Mixer. The ReGroove Mixer is described in the Operation 
Manual chapter of the same name.

The Shuffle on/off switch in Matrix and the Pattern Shuffle control on the transport panel.

Pattern Mute
If you deactivate the “Pattern” button above the Pattern select buttons, the pattern 
playback will be muted, starting at the next downbeat (exactly as if you had selected 
an empty (silent) pattern). For example, this can be used for bringing different pattern 
devices in and out of the mix during playback.
If you mute the Matrix track in the sequencer, it is muted instantly and the Mute indica-
tor lights up on the panel. Note that all tracks connected to the Matrix must be muted 
for this to work. 
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Pattern Functions
When a pattern device is selected, you will find some specific pattern functions on the 
Edit menu (and on the device context menu).

Shift Pattern Left/Right

The Shift Pattern functions move the notes and corresponding gate values in a pat-
tern one step to the left or right.

Shift Pattern Up/Down

! This function does not alter the Curve CV. This is because the values pro-
duced by the Curve CV do not necessarily correspond to semitone note 
steps at all.

The Shift Pattern functions will transpose all the notes in a pattern one semitone up or 
down. 

Randomize Pattern

The Randomize Pattern function create random patterns. These can often be great 
starting points and help you get new ideas. Both Note, Gate and Curve CV values will 
be created.

Alter Pattern

The Alter Pattern function modifies existing patterns. Note that there must be some-
thing in the pattern for the function to work on - using an Alter function on an empty 
pattern will not do anything.

! Note that Randomize and Alter affects both the Gate, Note and Curve CV!

Chaining Patterns
When you have created several patterns that belong together, you will most probably 
want to make these play back in a certain order. 

D Simply activate record for the track with the Matrix as the destination in 
the sequencer and use the Pattern and Bank buttons to determine the 
playback order as the Song is playing. 
The Patterns play to the end before changing, so you won’t have worry 
too much over the “timing” of the pattern changes you input manually. 
When you are done, the sequencer track will contain pattern change 
data, and the patterns will automatically switch according to the order 
set while recording. More on recording pattern changes on page 69.

D An alternative way to do this is editing directly in the Pattern Edit lane in 
the sequencer.
Editing in the Pattern lane is described in the Sequencer chapter.

Converting Pattern Data to Notes
! Curve patterns cannot be converted to sequencer data! Only the note 

pattern and the gate values will be converted.

You can convert Matrix Pattern data to note data, that can be edited and played back 
from the main sequencer. Proceed as follows:

1. Select the sequencer track connected to the Matrix.

2. Set the left and right locators to the desired range or length.
If the range set is longer than the pattern(s), the data will be repeated to fit the 
range.

3. Select the Matrix device you wish to copy the pattern(s) from.

4. Select “Copy Pattern to Track” from the Edit menu or the device context 
menu.
Notes will be created between the left and right locators, according to the se-
lected pattern (Gate and Key values only).

However, at this point the track with the notes is connected to the Matrix itself. This is 
pointless, since the Matrix doesn’t produce any sound. Therefore:

5. Re-route the sequencer track to the device which was controlled by the Ma-
trix (or to another instrument device if you like).
This is done by clicking in the Out column for the track in the track list, and select-
ing another device from the pop-up menu that appears.

If you now activate playback from the transport you will send note data to the con-
nected device from both the sequencer and the Matrix at the same time, which is 
probably not what you want. To avoid this happening, you have to do one of the fol-
lowing:

D Delete the Matrix device.

Or...

D Disconnect CV and Gate cables between the Matrix and the instrument 
device on the back panel.

✪ The procedure above copies a single pattern to notes in the sequencer. If 
you have automated pattern changes, you can copy a complete pattern 
track to notes, taking all pattern changes into account. This is described 
on page 93.
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Example Usage
As mentioned previously, the Matrix is a very flexible device. Here follows a few exam-
ples of how you can use the Matrix Pattern Sequencer.

Using the Matrix for Modulation
You can effectively use the Matrix as a modulation source, much like an LFO. Just like 
the LFOs in Reason’s instrument devices, the Matrix can generate modulation that is 
synchronized to tempo, which has many advantages. Proceed as follows:

1. Create a Synthesizer (Subtractor or Malström).

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to an empty 
pattern.

3. Flip the rack around and disconnect the Gate and Note CV outputs.
Gate/Note CV is not used in this example

4. Flip the rack around and connect the Curve CV output on the Matrix back 
panel to the “Amp Level” Modulation input on the synthesizer.
This parameter is used for modulating the output level (volume) of the synthesizer. 
Volume modulation is often referred to as Tremolo. You can use a unipolar curve 
(see page 300) for this example.

5. Flip the rack back again, and switch the Matrix to display the Curve pattern 
window.

6. Draw a curve like the one shown in the illustration below.
If you use fewer or more steps than16 (as shown in the picture), just draw the 
curve so that it roughly matches the shape in the picture.

7. Activate Click on the transport panel.

8. Select the track that is routed to the synthesizer, so that you can play it from 
your MIDI keyboard.

9. Activate Play on the transport panel, and hold a chord down on your key-
board.
You should now hear the volume being modulated by the Curve pattern.

10.While still in play mode, you can use the Resolution knob to change the mod-
ulation “rate” in relation to the tempo.
For each clockwise resolution step the modulation speed is doubled and vice 
versa, but it will always stay in sync with the tempo.

Programming “Acid Style” lead lines
By “acid style” lead lines we mean patterns that use a combination of Legato and 
slide (or portamento) effects to produce the widely used hypnotic “wavy” sound pro-
duced by the original Roland TB-303, and recreated in the Propellerhead Software 
product ReBirth. To approximate this typical sound using Reason, proceed as follows:

1. Create a Synthesizer (Subtractor or Malström).

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to an empty 
pattern.

3. Make sure that the Note and Gate CV outputs are connected to the synthe-
sizers Sequencer Control CV and Gate inputs, respectively.

4. For Subtractor, select either a Init Patch, or use the “TB Synth” patch in the 
Monosynth category of the Factory Sound Bank. 

D If you use an Init patch, it is important that you make the following set-
tings:

• Set Polyphony to “1”.
• Switch Trigger Mode to “Legato”.
• Set Portamento to a value around “50”.

5. Create a pattern in Matrix, and keep it playing back.

D If “Tie” (see page 301) now is activated for a step, the note will be tied to 
the next and the pitch will continuously “glide” to the pitch of the follow-
ing step.
Please note that Tie should be activated on the note you wish to slide from, and 
not the note you slide to.

D If you have several tied notes, one after the other, they will play as one 
long legato phrase. This can be used to create “wavy” lead lines with 
pitch bend effects.

6. Experiment with different Note, Tie and Gate values.
If you have ever used a TB-303 or ReBirth, you should now begin to get the hang 
of how you can create patterns in that particular style by using the Matrix together 
with a synthesizer.

✪ Adding a DDL-1 (delay), and a D-11 (distortion) effect device will make it 
sound even more “ReBirth”-like, but of course you are also able to get a 
much wider range of timbres by utilizing Reason’s other sound and mod-
ulation capabilities.

Triggering Samples
The Gate CV output can be used to trigger samples, either in Redrum or in the NN-19 
or NN-XT Sampler.

D Connect the Matrix Gate CV out to the Gate (Sequencer Control) in on 
the NN-19/NN-XT or to one of the individual Gate Channel inputs of Re-
drum.
Gate values will now trigger the sample on each step with Gate values above “0”.
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Introduction

An arpeggiator generates rhythmic note patterns (arpeggios) from notes or chords. 
The RPG-8 Arpeggiator doesn’t generate sound on its own, but has to be connected 
to another instrument device, just like the Matrix. It works by converting MIDI note data 
(input to the RPG-8) to Note CV (pitch) and Gate CV (note on/off plus velocity) sig-
nals. These CV/Gate signals are sent to the corresponding Sequencer Control inputs 
of an instrument device. 

In addition to standard arpeggiator features the RPG-8 is equipped with a 16 step 
pattern editor for creating rhythmic variations.

The RPG-8 is monophonic and can control one voice in an instrument device. 

Using the RPG-8
Setting up
The basic procedure is to input note data, either live or recorded, to the RPG-8 de-
vice. This note data is in turn sent to a target device via its Sequencer Control CV/
Gate inputs. The resulting output from the target device can either be arpeggiated 
notes or simply mirror what is played on your control surface device. Proceed as fol-
lows:

1. Create an instrument device, e.g. a Subtractor.
Select a suitable patch, preferably one with a short attack time.

2. With the instrument device selected, create an RPG-8 Arpeggiator.
A sequencer track with MIDI focus named “Arp 1” is created for the RPG-8. The 
RPG-8 Note and Gate CV outputs will be auto-routed to the instrument device Se-
quencer Control Gate and CV inputs, as you can see if you flip the rack around. In 
addition, the Mod Wheel and Pitch Bend CV outs are also auto-routed to the cor-
responding modulation inputs on the target device. 

3. Make sure the Arpeggiator Enable (“On”) button on the upper part of the 
panel is activated.



RPG-8 ARPEGGIATOR
307

4. With MIDI input directed to the Arp 1 sequencer track, play a few notes.
The notes in the chord you play are now arpeggiated for as long as you hold down 
the keys. The arpeggio will change directly if you release all notes and play another 
note or chord. If you add notes while holding down a chord, the arpeggio will con-
tinue with the added notes.

• The display to the right shows the notes played by the arpeggio pattern, with small 
bars indicating pitch for each step. The display is continuously updated as you 
play.

• The arpeggio will play in sync with song tempo by default in new RPG-8 devices.
• You do not need to start playback to generate arpeggios. 

D Try changing the arpeggiator mode using the Mode knob.
The various modes govern how the notes are arpeggiated. For example “Up” 
means from lowest note to highest note, Up+Down from lowest to highest note, 
then back down to lowest note again. For a description of all the modes see page 
310.

D By activating the Hold button the arpeggio will continue to play even if 
you release the keys.
If you play a new chord the arpeggio will continue to play, using the new notes. To 
stop the arpeggio, deactivate the Hold button or hit Stop on the transport. See 
page 309.

D The “Insert” buttons can be used to introduce further variations to the ar-
peggio.
See “Insert buttons”.

D If you change the Rate parameter the rate of the arpeggiated notes will 
follow the song tempo at the selected note value resolution. 
Straight, triplet and dotted note values are available. The arpeggiator can also be 
free running, i.e. not synced to tempo - see “Rate”.

D The Gate Length knob allows you to adjust the length of the arpeggiated 
notes.
If the knob is turned fully clockwise (“Tie”), the gate is always open (the notes will 
be played legato). If it is turned fully counter-clockwise, the gate is closed (no 
sound). See “Gate Length”.

D By using the Octave buttons beside the Mode knob you can increase or 
decrease the octave range of the arpeggio.
With “1 Oct” selected the arpeggiated notes will be those that you press down on 
the keyboard. If “2 Oct” is selected the range will be expanded so that the arpeg-
giated notes play over two octaves, and so on - see “Octave range buttons”.

D You can transpose the arpeggio up or down in octave steps using the Oc-
tave Shift buttons.
See “Octave Shift”.

D By using the Velocity knob you can set the arpeggio to play with a fixed 
velocity value (selectable between 1 to 127) for all notes. Turning the 
knob fully clockwise to the “Manual” position means that the arpeggio 
notes will use the same velocity as the MIDI notes you input.
By using the Manual mode and varying the velocity for individual notes the arpeg-
gio will become more animated and rhythmic. See “Velocity”.

That covers the basic principles of how to set up and use the RPG-8 to arpeggiate 
notes that you play in real time. But to make full use of the RPG-8 there are many fur-
ther applications:

D You can of course record and edit the notes you input.
You can also render the arpeggio output “to track” for full sequencer edit control 
of the notes generated by the RPG-8 - see “Rendering arpeggio notes to track”.

D You can introduce rests for more complex rhythmical arpeggios by using 
the Pattern editor.
See “Pattern editor” for a description.

D You can use the RPG-8 as a MIDI to CV converter which allows you to 
freely assign common performance MIDI controllers like Mod Wheel and 
Aftertouch to control parameters - see page 314.
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Recording MIDI note data for the RPG-8 - simple 
tutorial
The notes that you feed into the Arpeggiator can be recorded and edited in the se-
quencer. This works pretty much like recording/editing normally, but with a few excep-
tions which will be duly noted. 

In this section we will go through the basic principles of recording MIDI data. As sev-
eral functions are described later in this chapter (e.g. the Pattern editor) we will keep 
things simple in this tutorial. 

To record the notes you play into the RPG-8 you proceed as follows:

1. Set MIDI input to the “Arp” track.
Make sure the RPG-8 is connected to a target instrument device as described in 
the “Setting Up” section.

2. Make sure the “On” button for the Arpeggiator is activated.
If you play a chord, this will now be arpeggiated. 

3. Set up the RPG-8 as you want it to play arpeggios.
For detailed descriptions of all the parameters, see page 309.

• Note that if an arpeggio is playing before you enter record, the notes that gener-
ated this arpeggio will not be recorded! This is because the note-ons have already 
occurred before recording commenced - only the notes that you enter after re-
cording has started will be recorded.

4. Enter Record mode and start playing.

5. Hit stop when you are done recording.

A clip has now been added to the Arp track containing the notes you just recorded. If 
you play back the clip from the top the arpeggio will play back as you recorded it.

D If you switch to Edit mode for the Arp track, you will see that only the 
notes that you input to the RPG-8 were recorded - not the actual arpeg-
gio notes generated by the RPG-8 and sent to the target device.

The arpeggio you “recorded” is actually still being generated rather than played back. 
The only difference is that now the arpeggio is generated from the notes you recorded 
on the track rather than from the notes you played live. Thus, if you change any RPG-
8 parameters like Rate or Mode this will change the arpeggio you hear.

When using this method the following points should be noted:

D It will not be possible to edit the individual notes generated by the ar-
peggiator, only the source notes you play.
This may be fine, depending on the situation. If you simply played some wrong 
notes you can easily edit them in the sequencer as usual.

D If you used Hold when recording (or if you activate Hold during playback) 
the arpeggio will play for as long the sequencer is in Play mode or until 
Hold is deactivated.
It is generally better to have Hold off when recording.

Depending on the situation, the above limitations may or may not be of concern. But 
there is a quick and effective solution to all above mentioned issues; the “Render Ar-
peggio Notes to Track” function (see below).

Using multiple Lanes

You can record note data on several Lanes of the RPG-8 (Arp) track. If you do this, 
any overlapping note data will be merged and will not play separate arpeggios. The 
Arp track will always produce a monophonic output regardless of how many overlap-
ping Lanes there are. 

If you want to use separate simultaneous arpeggios, with each controlling one voice in 
a device, you have to use the “Arpeggio Notes to Track” function (see below) to sep-
arate Lanes in the target device track. 

Generating arpeggios from already recorded tracks

The RPG-8 can also be used to arpeggiate notes copied/moved from other tracks:

1. Copy the clip(s) containing the notes you wish to arpeggiate.
You can also drag and drop clips between tracks to do this.

2. Paste the clip(s) to the “Arp” track.

3. Activate Arpeggio On and activate playback.

4. If you only wish to hear the arpeggio, mute the sequencer track/lane you 
copied the source data from.
If you leave it unmuted you will hear both the original chords and the arpeggio.
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Rendering arpeggio notes to track
This function allows you to render the arpeggio generated by RPG-8 to the target de-
vice track. The arpeggio output - rather than just the source notes that generate the 
arpeggio - will be rendered as notes allowing for full sequencer edit control.

After rendering, the target device track will have a clip with the arpeggio notes and the 
RPG-8 track should be muted, so no arpeggiator parameter settings can be changed 
- only the actual notes can be edited. You can of course always go back to the original 
Arp track, change arpeggiator parameters and perform the rendering again at any 
time.

To perform the rendering, proceed as follows:

1. Set the left and right locators to the desired range or length.
If the range set is longer than the arpeggio pattern(s), the data will be repeated to 
fit the range.

2. Select the sequencer track that the RPG-8 is connected to, i.e. the target 
track, not the “Arp” track.

3. Select the RPG-8 device you wish to copy the arpeggio(s) from in the rack.

4. Select “Arpeggio Notes to Track” from the Edit menu or the RPG-8 device 
context menu.
Now notes will be created on the target device track between the left and right lo-
cators, according to the selected arpeggio.

5. Mute the Arp track originally used to generate the arpeggio. If you now acti-
vate playback from the transport the arpeggio will play back as note data (the 
RPG-8 is inactive). 
If you enter sequencer Edit mode for the target device track, you can freely edit the 
arpeggio notes.

D Performance data (e.g. Pitch Bend or Mod Wheel) recorded on the Arp 
track are not included in the “Arpeggio Notes to Track” operation.
If you have performance data that should be played back with the arpeggio, you 
need to copy it manually to the rendered note clip.

RPG-8 Parameters
MIDI-CV Converter parameters

The MIDI-CV Converter section to the left contains parameters that affect the CV out-
put from the RPG-8, regardless of whether the Arpeggiator section is activated or not. 
The following parameters are available:

Velocity

The Velocity knob can be used to set a fixed velocity value for the notes that are out-
put via the Gate CV Out jacks on the back of the RPG-8. If you set the Velocity knob 
to a value between “0” and “127”, the Gate CV Out will be fixed (at the set value) re-
gardless of the velocity of the incoming MIDI notes.

Turning the knob fully to the right activates Manual (“Man.”) mode (a LED is lit when 
activated). In Manual mode the velocity levels will be sent out via the Gate CV Out 
with the same velocity value as they are input, i.e. “what goes in, will come out”. Man-
ual mode is on by default in new devices.

There is also a “Velocity CV” input at the back. If this is connected to a controller 
source (a LFO modulation output for example), the output will be a merge between 
the Velocity setting and the applied CV modulation by the LFO - see “CV Inputs” on 
page 313.

Hold On/Off

If the Hold parameter is activated (lit button), an arpeggio will continue to run even if 
you release all keys. It will continue to arpeggiate the last notes played until a new 
note-on is received. 

• If you continue to hold down at least one key when Hold is on, any new notes will 
be added to the existing arpeggio as opposed to starting a new arpeggio.

• If the Arpeggiator section is off, and the Hold function is activated, there will be no 
note-offs for incoming notes played (i.e. the CV Gate stays open). 

• The Hold On/Off status responds to Sustain Pedal messages - as long as the 
pedal is pressed down, Hold will stay activated.
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Octave Shift

This allows you to transpose the RPG-8 Note CV output in octave steps. You can oc-
tave shift up or down 3 octaves.

Octave Shift can also be CV controlled.

Arpeggiator parameters

The middle section contains the Arpeggiator parameters that govern how the arpeg-
gio is played. The following parameters are available:

Arpeggiator “On” button

This switches the Arpeggiator on or off.

Mode switch

This determines the direction of the arpeggio notes.

Octave range buttons

The Octave buttons allow you to set the octave range of the arpeggio.

Use as follows:

Insert buttons

Insert can be used to add variations to the arpeggio by repeating certain notes in a 
predetermined order. It works as follows:

Rate

This sets the rate of the arpeggio. There are two basic modes for the Rate parameter:

D If Sync is activated, the Arpeggiator will play in sync with the sequencer 
tempo. By changing the Rate you can make the Arpeggiator play in dif-
ferent tempo resolutions in relation to the tempo setting.
Straight, dotted or triplet note values are available in 1/2 to 1/16 resolutions. In ad-
dition, there are also 1/32, 1/64 and 1/128 (straight) note resolutions.

D If the “Free” button is activated, the arpeggio rate is free running, and 
not synced to tempo.
The Rate is then selectable from 0.1 to 250Hz.

Gate Length

This determines the length of the arpeggio notes. Minimum value is 0 (Gate closed - 
no output). Maximum value is “Tie”, meaning the gate is open all the time. This param-
eter can be controlled via CV.

|Mode |Description
Up This will generate an arpeggio that plays from the lowest note to the 

highest note.

Up+Down Notes are played from lowest note to highest, then from highest back 
down to the lowest. The very lowest and the highest arpeggio notes 
are not repeated. I.e. the arpeggiator will play the lowest note to the 
second highest note, then the highest note to the second lowest 
note.

Down Notes are played from the highest note to the lowest note.

Random The notes you input will be arpeggiated randomly. 

Manual Notes are arpeggiated in the same order they are played when input.

|Octave range |Description
1 Oct The arpeggiated notes will be those that you press down on the key-

board.

2 Oct If you select this, the arpeggio will be extended to a two octave 
range, i.e, the arpeggio pattern is played then repeated one octave 
up. In Random mode, the notes you input are played in random order 
over 2 octaves. 

3 Oct Same as 2 Oct but extended to a three octave range.

4 Oct Same as 2 Oct but extended to a four octave range.

|Insert mode |Description
Off No Insert repeat.

Low The lowest note is repeated in between every second note in the ar-
peggio.

Hi The highest note is repeated in between every second note in the ar-
peggio.

3-1 The arpeggio will play 3 notes forward, then step 1 note back and 
from there play 3 notes forward etc.

4-2 The arpeggio will play 4 notes forward, then step 2 notes back and 
from there play 4 notes forward etc.
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Single Note Repeat

Single Note repeat governs how the arpeggiator behaves when the user plays single 
keys or monophonic lines. 

D When Single Note Repeat is on, a single key will retrigger the gate, 
meaning the note will repeat.
If the Octave setting is 1 Oct, the note will simply repeat (given the Gate Length 
setting is not set to “Tie”). If the Octave setting is set to anything else, the note will 
repeat according to the Octave, Mode and Insert settings.

D When this is off, single notes will not repeat and RPG-8 will play arpeg-
gios when the user plays more than one key (chords). 

Shuffle

Shuffle is a rhythmic feature, that gives the arpeggio a more or less pronounced swing 
feel. It works by delaying all sixteenth notes that fall in between the eighth notes.

In the RPG-8 you can switch Shuffle on or off using the corresponding button. How-
ever, the amount of shuffle can set globally (for all devices that incorporate this fea-
ture) with the Global Shuffle control in the ReGroove Mixer.

The Shuffle on/off switch in RPG-8 and the Global Shuffle control in the ReGroove Mixer.

Pattern editor

The Pattern editor allows you to introduce rests for arpeggio steps which can pro-
duce more rhythmic results. The Pattern editor has 16 step buttons at the top, and a 
main grid display where the arpeggio notes are represented as horizontal bars for 
each step in the arpeggio. The pitch of the arpeggio notes are shown on the vertical 
axis. Notes within the C-1 to C7 octave range are shown. Notes cannot be edited in 
the display, they are only a visual representation of the arpeggio.

D The Pattern editor is activated with the “Pattern” button.
When activated, the Pattern button and the 16 Step buttons light up.

D When you play a chord (or in case you have recorded notes, when you 
start playback) the arpeggio will play according to the current Arpeggia-
tor parameter settings, as normal. 
The only difference is that a pattern will be repeated in the display so that all 16 
steps play the pattern.

A three note chord with Pattern off...

...and with Pattern on.
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D If you click on a step button it goes dark. This means that this step will in-
sert a rest in the arpeggio pattern.
Note that no arpeggio notes are “skipped”. Inserting a rest means that the step will 
be silent and the next active step will play the next note in the arpeggio pattern.

D The “Steps -/+” buttons can be used to set the number of steps in the 
Pattern editor. 
E.g. if you press the “Steps minus” button four times the last four step buttons will 
go dark and the Pattern editor cycle will start over after step 12.

Pattern functions

When the Pattern editor is activated, you will find some specific pattern functions on 
the Edit menu (and on the device context menu). These are as follows:

Automating the Pattern editor

To automate the RPG-8 step buttons a little planning is necessary. 

D In the sequencer, each automation point represents all the possible com-
binations of each of the 16 step buttons on/off status, so the numbers 
become slightly bewildering (there are 65535 possible variations). 
This makes it difficult to control the automation by drawing events in the se-
quencer as each position represents a different combination of all the button’s on/
off status. 

D You can of course automate the buttons manually while recording but 
this is not always a solution as you may wish to change the on/off status 
of several buttons simultaneously.

The solution to both these issues is to record “snapshots” of the Pattern editor:

1. Set up the buttons as you want them from the start of the song, e.g. all but-
tons “on”. 
This will be your “static value” which is active from the start.

2. Right-click the buttons and select “Edit Automation” from the context menu. 
A Pattern automation lane is created and the Pattern buttons will have a green 
rectangle around them to indicate that they are automated.

3. Still in stop mode, set up the buttons (except one - see below) to create a 
new pattern you would like to change to.
Note that the Automation override indicator on the transport will light up, but this is 
as it should be.

To record the button’s status, you need to press at least one button after entering 
record mode. Thus, you need to save one “last” button to press during record to auto-
mate the Pattern editor to an exact combination of the 16 button’s on/off status. 

4. Place the position cursor just before where you want the automation change 
to take place.

5. Enter record mode (you can use Precount if you like) and press the “last” 
step button where you want the automation to happen. Continue recording 
for as long as you wish the pattern to play, then click stop.
A clip has been added on the Pattern automation lane.

6. If you open the clip by double-clicking on it in the Arrange view you can see 
that the clip has one automation point.
Note that it is the clip that governs the start and duration of the automation, not the 
point itself. 

D If the snapshot automation is not in the right time position, you can sim-
ply reposition the clip so that it starts where you want the change to oc-
cur using the usual methods.
When the clip you recorded ends, the buttons will revert to the static value you set 
up in step 1.

7. By using this general method you can continue to add further clips to the 
Pattern lane, each containing a “snapshot” of the Pattern editor buttons.

|Function |Description
Alter Pattern The Alter Pattern function modifies existing step patterns. 

Note that there has to be a pattern to start with - using the Al-
ter function if all step buttons are active (or inactive) won’t do 
anything.

Randomize Pattern The Randomize Pattern function creates random patterns. 

Invert Pattern This will invert the pattern, i.e. active steps will become rests 
and vice versa.

Shift Pattern L/R The Shift Pattern functions move the pattern one step to the 
left or right.
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CV connections

On the back of the RPG-8 you can find a number of useful CV connectors. These are 
as follows:

CV Inputs

There are five CV inputs, of which four can be used to control RPG-8 parameters that 
have associated controls on the front panel. These parameters are Gate Length, Ve-
locity, Rate and Octave Shift. 

If you use an external source to modulate these parameters, the incoming CV is 
merged with the setting on the front of the device. 

An example: Velocity is set to 50 on the front panel. A Matrix (bi-polar curve) that var-
ies between +- 20, with the voltage trim pot set to 64 (50%) is connected to the Ve-
locity CV input. The resulting Velocity should then vary between 40-60.

In addition to the above CV inputs, there is a “Start of Arpeggio Trig In” connector. 
This restarts the arpeggio figure from step 1 when this input receives a gate trigger. 
See “Triggering Arpeggios” on page 314 for a tip on how this can be used. If some-
thing is connected to this input the RPG-8 will not generate arpeggios unless a Gate 
trigger is received.

Note: If you are modulating the arpeggio using the CV Input jacks, this will not affect 
the rendered arpeggio notes.

CV Outputs

The following CV outputs are available:

• Gate CV Out (Velocity) transmits a gate/velocity value that corresponds to the Ve-
locity parameter setting. This is normally auto-routed to the Sequencer Control 
Gate input on an instrument device.

• Note CV Out transmits the notes generated by the Arpeggiator (or if this is off, the 
notes you input to the RPG-8). This is normally auto-routed to the Sequencer Con-
trol CV input on an instrument device.

• Mod Wheel/Pitch Bend Outputs will normally connect to the corresponding inputs 
of the instrument device controlled by RPG-8.

• The common MIDI performance controllers Aftertouch/Expression/Breath can be 
used to control any parameters using these CV outputs.

• Start of Arpeggio Trig Out - every time the arpeggio figures start over this output 
will send a gate signal. This can be used to trigger filter, amp and mod envelopes 
in other devices, e.g. Subtractor. The length of this gate is the same as the length 
of the first note in the arpeggio.

• Sustain Pedal Gate Out - the sustain pedal can be used to trigger envelopes in 
other devices. If you plug a cable into the “Sustain Pedal Gate Out” the normal 
pedal to the Hold parameter connection is broken and the sustain pedal function 
is changed to send out a gate signal with velocity equalling the Velocity setting 
knob (if Manual mode is on then velocity defaults to a value of 100).
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Tips and tricks
Using the RPG-8 for modulation

You can use the RPG-8 as a modulation source, much like an LFO. The RPG-8 can 
generate stepped modulation that is both synchronized to tempo and controlled by 
note input. In this and in following examples we assume you already have a RPG-8 
connected to an instrument device.

D With the RPG-8 selected in the rack, create a Spider CV Merger/Splitter.
The RPG-8 Note and Gate CV outputs are auto-routed to the Spider Split A and B 
inputs, and the Spider first split Note and Gate outputs are connected to the in-
strument device (as they were before creating the Spider).

You now have 2 (and 1 Inverted) additional Note and Gate CV outputs via the Spider. 

D Try using the Note CV split outputs to modulate other parameters in the 
instrument device, e.g. filter frequency. 
The filter frequency will then track the notes generated by the Arpeggiator.

D You can of course also connect the Note CV out to various parameters in 
any device, not just the device connected to the RPG-8. 

D You can connect the Spider split CV/Gate outputs to the corresponding 
Sequencer Control CV inputs to another instrument device so that the 
RPG-8 controls two (or more) devices. (This can of course also be done 
by connecting the RPG-8 to a Combinator device.)

Triggering Arpeggios

On the back panel there is a “Start of Arpeggio Trig In” CV connector. This restarts 
the arpeggio figure from step 1 when this input receives a gate trigger. You could use 
this in the following way:

D One or more Redrum channels Gate out can reset the step pattern to cre-
ate rhythmic patterns in sync. 

D You could use the Matrix in the same way - each positive Gate signal will 
restart the arpeggio figure.

! Note that no arpeggio will be generated unless a Gate trigger is received 
when something is plugged in to the “Start of Arpeggio Trig In” CV con-
nector.

Triggering Samples

The Gate CV output can be used to trigger samples, either in Redrum or in the NN-19 
or NN-XT Sampler.

D Connect the RPG-8 Gate CV out to the Gate (Sequencer Control) in on 
the NN-19/NN-XT or to one of the individual Gate Channel inputs of Re-
drum.
Gate values will now trigger the sample on each step with Gate values above “0”.

Using the RPG-8 as a MIDI to CV converter

You can also use the RPG-8 as a stand-alone MIDI to CV converter without generat-
ing arpeggios. In this mode (Arpeggiator Off) you can play instrument devices just like 
as if MIDI input was directly connected to the target device. 

The main benefit of this mode is that you can use note pitch and velocity to control pa-
rameters, not only in the target device but in any device. 
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Introduction

The ReBirth Input Machine is a device dedicated to receiving audio from the Propel-
lerhead program “ReBirth RB-338” (version 2.01 and later). This is achieved by using 
ReWire technology (see page 124), where Reason will act as master and ReBirth as 
a slave device. If you don’t have ReBirth installed, you cannot use this device. If you 
are a ReBirth user, you can use the ReBirth Input Machine for the following:

D Receive up to eighteen channels of streaming ReBirth channels in Rea-
son.
You can create more ReBirth Input Machines, but only one can be active at a time.

D Sample accurate synchronization between the audio in the two pro-
grams.

D The two programs can share the same audio card and take advantage of 
multiple outputs on that card.

Preparations
For the ReBirth Input Machine to correctly operate together with ReBirth, the launch 
and quit order is very important. Proceed as follows:

Launching
1. Launch Reason.

2. Create a ReBirth Input Machine.
You may want create a Mixer prior to this step, otherwise the L/R Mix channels will 
be routed directly to the Audio Hardware Interface. If you have a Mixer, the L/R Mix 
output from the ReBirth Input Machine will be automatically connected to the 
mixer’s first available audio inputs.

3. Launch ReBirth.

4. When ReBirth is launched, select Reason as the application in focus.
If both the “Reason is Rewire Master” and the “Active” indicator on the ReBirth In-
put Machine are lit, this indicates that the launch procedure was correct and that 
Reason and ReBirth are now locked and in sync.

D If only the “Active” indicator is lit, either the launch order was wrong, or 
ReBirth is not installed properly.

5. Activate playback on Reason’s transport panel.
ReBirth and Reason are locked in perfect sync, and will follow any transport com-
mands in either of the programs.

! Note that there is no master/slave relationship for the transport controls 
when using ReWire, as either device will control the other device’s trans-
port. The audio, however, is streamed from ReBirth to Reason, so in this 
aspect Reason is the master device.

Quitting
1. First quit ReBirth.

2. Then quit Reason.



REBIRTH INPUT MACHINE
317

Routing
When the two programs are synced, you can route any of the eighteen available out-
puts in ReBirth, to separate channels in a Reason Mixer, or to the Hardware Interface 
for direct connection to a physical output on your audio card.

If you flip the rack around, a row of 18 audio outputs is shown, with the L/R Mix out-
puts auto-routed to your mixer or to the hardware interface.

What Signals are on the Outputs?

Mix-L and Mix-R

This is the regular master output in ReBirth RB-338. These are the only stereo chan-
nels, all other channels are in mono.

D If none of the other channels are used, then this carries all the sound 
from ReBirth.

D Signals that are activated separately are removed from this mix.
If for example the 909-Mix channel is activated, then Mix-L and Mix-R carries all the 
sound from ReBirth RB-338 except the 909, which will appear on its own channel.

The individual outputs are described more closely in the ReWire chapter of the Re-
Birth manual.
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Introduction

The BV512 is an advanced vocoder device with a variable number of filter bands. It 
also has a unique 1024-point FFT vocoding mode (equivalent of 512-band vocoding) 
for very precise and high quality vocoded speech. By connecting the BV512 to two 
instrument devices, you can produce anything from vocoded speech, singing or 
drums to weird special effects.

Even if you have worked with a vocoder before, please read the following section. 
Knowing the basic terms and processes will make it much easier to get started with 
the BV512!

How does a vocoder work?

Carrier and modulator

A vocoder accepts two different input signals, a “carrier” and a “modulator”. It ana-
lyzes the modulator signal, applies its frequency characteristics to the carrier signal 
and outputs the resulting “modulated” carrier signal. 

In the most typical case, the carrier signal is a string or pad sound and the modulator 
signal is speech or vocals - the result will be a talking or singing synth sound. The 
modulator could also be drums or percussion (for rhythmically modulated sounds and 
effects) or any sound with changing frequency content.

Filter bands

Technically, a vocoder works in the following way: The modulator signal is divided into 
a number of frequency bands by means of bandpass filters (called the “modulator fil-
ters” or “analyzing filters”). The signal in each of these bands is sent to a separate en-
velope follower (which continuously analyzes the level of the signal). The carrier signal 
is sent through the same number of bandpass filters (the “carrier filters”), with the 
same frequency ranges as the filters for the modulator signal. The gain of each band-
pass filter is controlled by the level from the corresponding envelope follower, and the 
filtered signals are combined and sent to the vocoder’s output.

In this way, the carrier is filtered to have roughly the same frequency characteristics as 
the modulator. If the modulator signal has a lot of energy in one of the frequency 
bands, the gain of the corresponding filter band for the carrier signal will be high as 
well, emphasizing those frequencies in the output signal. If there is no signal at all 
within a frequency band in the modulator signal, the corresponding band in the output 
signal will be silent (as the gain will be zero for that filter).

There are several factors determining the quality of the vocoder sound, but the most 
important is the number of filter bands. The larger the number of filter bands, the 
closer will the output signal follow the modulator’s frequency characteristics. The 
BV512 offers 4, 8, 16 or 32-band vocoding.

✪ Even if a high number of bands will make the sound more precise and in-
telligible, this isn’t always what’s desired! Vocoding with a lower number 
of bands can give results that sound different, fit better in a musical con-
text, etc.

FFT vocoding

The BV512 has an additional FFT mode, in which the vocoding process isn’t based 
on bandpass filters as described above. Instead, FFT (Fast Fourier Transform) analy-
sis and processing is used. This equals 512 “conventional” frequency bands and re-
sults in a very precise and detailed vocoder sound. Note:

• The FFT mode is best suited for vocoding speech or vocals, giving crystal clear 
and highly intelligible results. It is not so well suited for vocoding drums and per-
cussion, since the FFT process is inherently “slower” than the regular filtering and 
doesn’t respond as quickly to transients, and also there will be a slight delay 
added to the signal (in the region of 20ms). A workaround solution to this would 
be to move the modulator signal slightly ahead to compensate for the delay.

• Where the conventional filter bands are distributed logarithmically (i.e. the same 
number of filter bands per octave), the 512 bands in the FFT mode are distributed 
linearly. This means a lot of the bands will be in the high frequency range - this is 
one of the reasons for the clear sound but it is also something to keep in mind 
when making settings for the vocoder in FFT mode.
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Setting up for basic 
vocoding
This tutorial describes how to connect and use a typical vocoder setup. We assume 
here that you have a MIDI keyboard connected. For details on the parameters, see 
page 324.

1. Make sure there’s a MIxer device in the rack (with at least one free channel).

2. Create the instrument device you want to use for the carrier signal.
This could typically be a synth or a sampler. In this example we choose a Subtrac-
tor synthesizer.

3. Set up the carrier device for a sustaining, bright sound.
It’s important to have high frequencies in the carrier. On the Subtractor, a simple 
but effective carrier sound would be based on a sawtooth wave, with the filter fairly 
open. For more about choosing carrier sounds, see page 326.

4. Select the carrier device and create a BV512 Vocoder.
If you flip the rack around you will see that the Vocoder is automatically routed as 
an insert effect for the carrier device (using the Carrier Input jacks).

5. Press [Shift] and create the instrument device you want to use for the modu-
lator signal.
Pressing [Shift] will add the device without auto-routing it to a mixer - this makes 
sense since we want to route it to the Vocoder in this case. 
For a modulator device you would typically either want a sampler (with vocals or 
speech samples), a drum machine or a Dr.Rex device (with vocal or rhythmic 
loops). For simplicity we use a Dr.Rex device in this example.

6. Flip the rack around and route the output of the Dr.Rex to the Modulator In-
put jack on the BV512.

7. On the BV512 Vocoder, turn the Dry/Wet knob fully to the left (“dry”).

This will let you hear the unprocessed sound of the modulator device only - useful for the next step:

8. Load a loop into the Dr.Rex device and click the Preview button to start play-
back.
For example, you could simply choose one of the Dr.Rex Drum Loops in the Fac-
tory Sound Bank.

9. Turn the Dry/Wet knob on the vocoder fully to the right (“wet”).
Now you won’t hear anything - since there is no carrier signal.

10.Route MIDI to the carrier device by clicking in the MIDI symbol column for its 
track in the sequencer.

11.Play a chord or a note on your MIDI keyboard.
What you hear now is the vocoded sound, e.g. the carrier sound processed to 
have the same tonal characteristics as the modulator.

Carrier

Vocoder

Modulator
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12.Try the different filter band options and note the difference in sound.

13.You can also adjust the vocoder sound by clicking and dragging the bars in 
the lower display.
Each bar corresponds to a frequency band, with low frequencies to the left and 
high frequencies to the right. You adjust the level of a band by dragging its bar up 
or down. Clicking and dragging across the bars allow you to change the levels of 
several bars, much like drawing an eq curve.

The upper display shows the spectrum of the modulator signal, for display only.

D To reset a band to ±0 dB, press [Command] (Mac) or [Ctrl] (Win) and click 
on it.
You can also reset all bands to zero by bringing up the context menu for the Vo-
coder device and selecting “Reset Band Levels”.

14.If the vocoder sound is “muddy” or indistinct, try raising the “HF Emph” knob 
on the Vocoder.
This parameter (High Frequency Emphasis) boosts the high frequencies in the car-
rier signal.

15.Try out the other parameters if you like.
See page 324 for details.

That’s it - a basic vocoder setup!

Vocoded vocals
The most common usage for a vocoder is probably the typical “singing” or “talking 
synth” sound, using vocals or speech as modulator. Since Reason doesn’t support 
live audio input you cannot sing and play in real time - instead you need to use sam-
pled speech or vocals (with e.g. an NN-19 or NN-XT as the modulator device). The 
procedure for this is roughly the same as in the tutorial above, but this time you need 
to record or enter some notes in the sequencer for the modulator device (since the 
samplers don’t have pattern or Preview playback). Here’s a quick guideline:

1. Create the carrier device.

2. Select the carrier device and create a BV512 vocoder.

3. Create the modulator device (typically an NN-19 or NN-XT sampler device) 
and route its output to the Modulator Input on the BV-512.

4. Load the vocals or speech samples into the sampler device and assign them 
to keyzones as desired.
For details about using sampler devices, see the respective device chapter.

5. Record or enter some notes on the sequencer track for the sampler device, 
so that the vocal samples are played back where you want them in the song.
To hear the unprocessed sound of the sampler device, set the Dry/Wet control on 
the BV512 to “Dry”, as above. When you’re done, turn the control back to “Wet” 
to get the vocoded sound.

6. Route MIDI to the carrier device.

7. Start sequencer playback and play notes or chords on your MIDI keyboard.
The result will be the classic vocoded vocal sound.

8. At this point you may want to record the notes or chords you play for the car-
rier device.
As MIDI is already routed to the carrier device track, all you need to do is start re-
cording and play along.
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Using the BV512 as an 
equalizer
The BV512 has a unique equalizer mode, in which the device works purely as an in-
sert effect (the modulator input isn’t used). This allows you to use the processing fil-
ters of the vocoder as a kind of graphic equalizer.

Setting up
1. Select the device that you want to process through the BV512.

2. Create a BV512 device.
It is automatically connected as an insert effect, using the Carrier Input jacks.

3. Set the switch to the left of the displays to “Equalizer”.

In use

In equalizer mode, you cut or boost frequencies by clicking and dragging in the lower 
display - just as with a regular graphic equalizer. The usage and results differ depend-
ing on which mode is selected:

4 - 32 band mode

As in vocoder mode, the number of bars in the display conforms to the number of 
bands selected (4, 8, 16 or 32). With a higher number of bands you get a more de-
tailed control over the frequency response. However:

D In these modes, the equalizer will “color” the sound even if all bands are 
set to ±0 dB!
This is due to phase interaction and overlap between the bandpass filters.

Therefore you probably want to use the 4 - 32 band mode for coloring and mutating 
sounds - not for subtle, “clean” equalizing.

FFT (512) mode

In FFT (512) mode you still get 32 bars in the display, but the each bar may control 
several frequency bands (remember that there are 512 bands in FFT mode). Since 
the frequency bands are distributed linearly in FFT mode, bars to the left in the display 
control few frequency bands while bars to the right control many frequency bands.

D In FFT (512) mode, setting all bands to ±0 dB is the same as bypassing 
the equalizer - the sound will not be affected.
This makes FFT mode suitable for “clean” equalizing, where you want to boost or 
cut some frequencies without changing the basic sound character.

D However, FFT mode equalizing is not suited for very drastic frequency 
cuts or boosts, as this may give audio artefacts due to the workings of 
FFT processing.
Still: as always, there are no hard and fast rules. Let your ears judge!

D Keep in mind that FFT mode also introduces a slight delay to the signal.
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BV512 parameters
On the front panel of the BV512 Vocoder, you will find the following parameters and 
displays:

|Parameter |Description
Bypass/On/Off 
switch

In Bypass mode, the carrier signal passes through the device un-
affected and the modulator signal is disregarded. In On mode, 
the device outputs the vocoded or equalized signal. Off mode 
cuts the output, silencing the device.

Level meters Show the signal level of the carrier and modulator signals, re-
spectively.

Band switch Selects the number of filter bands (4, 8, 16 or 32) or FFT (512) 
mode.

Equalizer/Vocoder 
switch

Determines whether the BV512 should work as a vocoder or an 
equalizer. In Equalizer mode, the Modulator input is disregarded 
(see page 323).

Modulation level 
display

The upper display shows the spectrum of the modulator signal.

Frequency band 
level adjust

The lower display allows you to adjust the level of each filter fre-
quency band, by clicking and dragging the corresponding bar. In 
vocoder mode this affects the vocoded sound. In equalizer mode, 
this is where you cut or boost frequencies. To reset a band to ±0 
dB, press [Command] (Mac) or [Ctrl] (Win) and click on its bar in 
the display. To reset all bands, select “Reset Band Levels” from 
the device context menu.
Note: when FFT (512) mode is selected, each of the 32 bars in 
the display corresponds to several frequency bands, with bars to 
the right in the display controlling progressively more bands (due 
to the FFT bands being linearly distributed over the frequency 
range).

Hold button Clicking this button “freezes” the current filter settings. While the 
button is lit, the modulator signal doesn’t affect the sound - the 
carrier signal is filtered with the settings as they were the moment 
you activated Hold. Click the button again to turn off Hold. Hold 
is also automatically reset (turned off) when you stop sequencer 
playback - just like the pitch bend and modulation wheels on 
synth devices.
This function can be controlled via CV or MIDI, for sample and 
hold-like effects.
The Hold button is not available in Equalizer mode.

Attack This is a global attack time control, affecting all envelope follow-
ers (see page 320). Normally you probably want this set to zero, 
to make the vocoder react as quick as possible. Raising the At-
tack time can be useful for “smearing” sounds, creating pads, 
etc. 
Not available in Equalizer mode.

Decay Similarly, this controls the decay time for all envelope followers, 
i.e. how quick the filter band levels drop. Adjust this according to 
taste and context. 
Not available in Equalizer mode.

Shift Shifts the carrier filters up or down in frequency, drastically 
changing the character of the vocoded (or equalized) sound. This 
parameter can be controlled via CV, for phaser-like sweeps and 
special effects.

HF Emph 
(High Frequency 
Emphasis)

Boosts the high frequencies in the carrier signal. This is some-
times desired to get a clearer vocoded sound. The reason is that 
a carrier signal should theoretically contain roughly equal ener-
gies in all frequency ranges for best results - in a typical synth 
sound the high frequencies are often weaker than the low fre-
quencies. Raising the HF Emph control will rectify this.
Not available in Equalizer mode.

Dry/Wet Determines the balance between modulator sound (dry) and vo-
coded sound (wet). To get the pure vocoder sound, set this to 
wet (turned fully right).
Not available in Equalizer mode.

|Parameter |Description
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Connections

The back panel of the BV512 offers the following connections:

Individual band levels

These are CV outputs and inputs. 

• The upper row outputs CV signals generated by the envelope followers for each 
frequency band. 

• The lower row are CV level inputs to the individual bandpass filters through which 
the signal is processed (the “vocoder filters”).
Connecting a CV signal to one of the inputs breaks the internal signal path from 
the corresponding envelope follower (in other words, that frequency band is now 
controlled by the CV signal you’ve connected - not by the corresponding fre-
quency band in the modulator signal).

• If 16 band mode is selected, each output/input pair corresponds to a separate fre-
quency band. In 8 band or 4 band mode, only the 8 first or 4 first output/input pairs 
are used. In 32 band mode, each output is a mix of two adjacent frequency bands 
and each input controls two bands. Finally, in FFT (512) mode each output/input 
pair corresponds to several frequency bands.

There are several interesting uses for the Individual band levels connectors: you can 
cross-patch frequency bands so that e.g. low frequencies in the modulator signal con-
trols high frequency bands in the vocoder, you can extract CV signals for controlling 
synth parameters in other devices, you can base the vocoding on CV signals from 
other devices rather than on a modulator signal, etc. See page 328 for details.

Other CV connections

Audio connections

|Connection |Description
Shift (CV in) This allows you to control the Shift parameter from an external CV 

source. A sensitivity knob determines how much the Shift setting 
is affected by the CV signal.

Hold (Gate in) When a gate signal is sent to this input, the Hold function is acti-
vated (see page 324). Hold remains on until the gate signal “goes 
low” (falls to zero). By connecting e.g. a Matrix to this input, you 
can create “stepped” vocoder sounds, sample and hold-like ef-
fects, etc.

|Connection |Description
Carrier input This is where you connect the instrument device that provides the 

carrier signal (or the device to be processed in Equalizer mode) - 
typically a synth or sampler device. The vocoder can handle mono 
or stereo carrier signals.

Modulator input This is where you connect the instrument device that provides the 
modulator signal, in mono. This connection is not used in Equal-
izer mode.

Output In Vocoder mode, the outputs carry a mix between the vocoded 
signal and the modulator signal (as set with the Dry/Wet control 
on the front panel). In Equalizer mode the output is the carrier sig-
nal, processed through the equalizer filter.
Note that the output will be in mono if the Carrier input is in mono, 
and vice versa - the BV512 does not process mono into stereo.
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Automation

All parameters on the front panel can be automated in the standard manner. The indi-
vidual band levels (the bars in the lower display) will be edited on separate lanes in the 
sequencer. Note:

D As with the other effect devices, you have to manually create a se-
quencer track for the BV512.

D Although the band level adjustments can be edited individually, they are 
treated as one automatable parameter on the device panel.
This means that if any single band level control is automated, there will be a frame 
around the whole lower display on the device panel. [Ctrl]-clicking (Mac) or right-
clicking (Win) in the lower display and selecting “Clear Automation” will remove 
the automation for all bands. Similarly, selecting “Edit Automation” will open the 
sequencer with lanes for all band levels shown.

The frame indicates that one or more band level controls are automated.

Tips and tricks
Choosing a carrier sound
As always, which carrier sound to choose is a matter of taste and musical context. 
However, here are a few guidelines to help you get a good result:

• The carrier sound should preferably have a lot of harmonic content (brightness) - 
dark or muffled sounds will not “give the vocoder much to work with”.

• Often, you want the carrier sound to sustain at an even level (i.e. it shouldn’t “die 
out” when you hold a chord). Similarly, you most often want a reasonably fast at-
tack (although not with a distinct, sharp click or edge).

• You may want a sound that is rather static over time, without drastic envelope con-
trol of filter cutoff for example.

• If you want to play vocoded chords, the carrier sound must of course be poly-
phonic.

Here are some hands-on suggestions for carrier sounds:

D A simple Subtractor pad based on a sawtooth waveform.
You could simply start with the initial patch (as set up when you create a new Sub-
tractor device). Open the filter, turn off envelope modulation of the cutoff fre-
quency and raise the Amp Envelope Sustain. 
If you want a classic, rich chorus-like sound, use two detuned oscillators - or better 
still, add a UN-16 Unison device as an insert effect between the Subtractor and 
the vocoder!

A simple but effective carrier sound setup.

D A similar fat carrier sound can be obtained using a Malström device with 
a patch based on the “Sawtooth*16” graintable.
With the Malström you can get a stereo carrier signal with no extra devices: simply 
select the “Sawtooth*16” graintable for both oscillators, detune the oscillators 
slightly with the Cent controls and raise the Spread parameter to the desired ste-
reo width. No filter routings are necessary.
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D For a more distinct and precise sound, try using a narrow pulse wave-
form.
You get this by selecting e.g. a sawtooth wave on the Subtractor, setting the 
Phase Mode selector to “–” and turning the Phase knob to the left until you get the 
desired sound. This type of carrier sound lends itself well to monophonic vocoder 
lines in the lower registers.

D Use noise as a carrier.
Try using pure noise (possibly filtered down a bit) for robotic voices, whispering 
and special effects. It’s also very useful to add a bit of noise to a sawtooth or pulse 
sound - this makes vocoded speech clearer and more intelligible.

D Use sampled strings or choir sounds.
A rich drawbar organ sample can also be a cool carrier sound.

D For unusual vocoder sounds, try using the Malström as carrier device, 
e.g. with a glassy, digital pad sound selected.
Try turning up the Attack and Decay controls on the BV512, for smeared, rhythmic 
or pseudo-random modulation of a pad.

Choosing a modulator sound
The modulator sound should typically have varying level and harmonic content. As 
we’ve already mentioned, the most typical modulator sounds are vocals or speech 
and drums or percussion.

D The quickest way to get a modulator sound is to use a rhythmic loop in 
the Dr.Rex device (as in the tutorial on page 321).
This way you don’t have to program a rhythm pattern. On the other hand, using a 
Redrum as modulator allows you to create exactly the rhythm you want and fine-
tune the sounds and the groove.

D To use your “own” vocals as modulator sounds, you need to record them 
as WAV or AIFF files (using any audio recording utility on your computer) 
and load the files as samples into an NN-19 or NN-XT device.

D Instead of using a sampler device as modulator for speech or vocals, you 
could slice the vocal samples in Propellerheads’ ReCycle application, 
and play them back with a Dr.Rex device.
This would make it easier to work with vocoded vocals, especially if you are exper-
imenting with different tempo settings or grooves. Tip: You can copy the MIDI 
notes played by Dr.Rex to the carrier track so that the original rhythm of the 
speech/vocal is preserved.

Using the modulator as carrier
You can get cool special effects by using the same device both as carrier and as 
modulator. For example, try processing a Redrum device in the following way:

1. Create a Redrum device and set up the desired patch and pattern.

2. Create a Spider Audio Merger & Splitter device.

3. Create a BV512 Vocoder.

4. Flip the rack around and connect the devices in the following way:

The output of the Redrum goes into the splitter section of the Spider, and is split into two signals. 
One signal goes into the carrier input of the vocoder, the other goes into the modulator input.

This is essentially the required connections, but for best results it’s a good idea to add 
some distortion and/or compression to the carrier signal - this increases the amount 
of high frequencies in the carrier signal:

5. Press [Shift] and create a Scream 4 distortion device.

6. Connect the distortion device as an insert effect between the Spider and the 
carrier input of the vocoder.
Now, the carrier signal will be processed in the distortion device, but not the mod-
ulator signal.

7. Play back the pattern and experiment with the settings on the vocoder and 
distortion device.

D This technique can also be used to process vocals and speech.

D Try adjusting the Shift parameter for new effects and sounds.
Remember that you can route CV to the Shift parameter on the back of the BV512 
- use e.g. a Matrix or an LFO output on a synth device!
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Controlling the Hold function
As described see page 324, pressing the Hold button on the front panel “freezes” the 
current filter spectrum until you deactivate it again. This can be used for creating sam-
ple & hold-like effects, stuttering or garbled vocoder sounds:

• Connect e.g. the Gate output on a Matrix device to the Hold input on the back of 
the BV512. By playing back a gate pattern on the Matrix, the Hold function will re-
peatedly be turned on and off according to the programmed rhythm in the pattern. 
Hold will be active for the length of each gate signal.

• Automate the Hold function with the main sequencer, either by recording it or by 
drawing in its controller lane.

• If you route MIDI to the BV512 you can control the Hold function in two ways by 
default: By pressing a damper pedal connected to your MIDI controller or by play-
ing the note C4. In both cases, the Hold function will be momentary - Hold is on 
until you release the pedal or key.

Using the individual band level connections
As described on page 325, the individual band level connectors on the back are CV 
output and input jacks. The upper row sends out the CV signals from the envelope fol-
lowers for the different frequency bands, while the lower jacks are CV inputs for con-
trolling the individual bandpass filters (breaking the internal connection from the 
envelope followers). There are several interesting things you can do with these con-
nections:

Crosspatching frequency bands

By connecting outputs to inputs in alternative configurations, you can drastically 
change the result of the vocoding. For example, you could have low frequencies in the 
modulator signal give high frequencies in the vocoded sound and vice versa. Note: 

• In 4 band and 8 band mode, only the 4/8 first output/input pairs are used.
• In 32 band mode and FFT (512) mode, each connection corresponds to two or 

several frequency bands.
This means that connecting an output to the input with the same number is not the 
same as using the internal signal path (no CV cable connected). You can hear this 
quite clearly in FFT (512) mode: connect all outputs to the corresponding inputs 
and gradually remove the CV cables while listening to the vocoder sound - the 
sound will progressively get more detailed.

Extracting CV from the vocoder

You can connect an individual band level output to any CV input on any device. This 
means you can use the vocoder as an envelope follower, having elements in the mod-
ulator sound control a parameter in another device, e.g. an effect. Note:

• The Attack and Decay settings on the BV512 panel affect the envelope followers, 
and thus the rise and fall times of the CV signals from the individual band level out-
puts. 

• If you are using the vocoder in a mode with many bands, but want a broader fre-
quency range to generate the CV signal, you can merge several band outputs into 
one CV signal - use a Spider CV Merger & Splitter device.

Controlling vocoder bands from an external source

Connecting a CV source to an individual band input breaks the internal connection 
from the corresponding envelope follower. This way you can “manually” control the 
vocoder filters. Some applications:

D Connect the CV outputs for one or more envelopes in the carrier device 
to individual band inputs.
When you play the carrier instrument, one or more of the bandpass filters in the vo-
coder will automatically open, adding an extra attack to the sound. Useful if you re-
ally want to “play” the carrier, rather than just hold a chord.
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D Connect the gate outputs on a Redrum to individual band level inputs.
With this connection (and no device connected to the Modulator input), the Re-
drum will serve as a pattern sequencer, opening and closing different filter bands. 
To adjust the gate times, set the drum sounds to Gate mode and use the Length 
parameter. The result is totally different from using the audio signal of the Redrum 
as modulator.

The vocoder bands are now solely controlled by the gate signals from the drum channels - the 
modulator input isn’t used. 
Note that you can use a Spider CV Merger & Splitter device to split a gate signal, sending it to 
several bands. Also, note that the velocity of the programmed drum notes govern the level of the 
corresponding filter bands.

“Playing” the vocoder from a MIDI keyboard
If you have routed MIDI to the BV512, playing notes from C1 and up will control indi-
vidual filter bands. For example, in 16 band mode, C1 controls band 1, C#1 band 2 
and so on up to D#2 (which controls band 16).

• The level of the bands is proportional to key velocity (how hard you play).
• A band will be “open” until you release the corresponding key.
• Bands to which you have connected a CV signal (using the individual band level 

inputs on the back panel) will not respond to MIDI keys.

Note that with this function, you “play the modulator”. You still need a carrier signal to 
get any sound. Typically, you would first record the notes or chords for the carrier de-
vice in the sequencer, then route MIDI to the vocoder and “play” it from your MIDI key-
board while playing back the recorded carrier notes.

✪ An interesting application of this is to patch the vocoder as an insert ef-
fect for the whole mix (the output of the main mixer connected to the car-
rier input, with no modulator device connected), and “play the vocoder”. 
Only the frequency bands for which you press keys will be let through. 
Use the FFT (512) mode for best results.
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Using the BV512 as a reverb
This is a very special trick which can be quite cool. Proceed as follows:

1. Create a Redrum device.
The “vocoder-reverb” is best suited for drums, even though nothing stops you from 
using it on other sounds.

2. Create a Subtractor and a vocoder.
The Subtractor will automatically be routed to the carrier input. We don’t need a 
dedicated modulator device in this setup.

3. Flip the rack around and connect Aux send 1 on the Mixer to the modulator 
input on the vocoder.

4. While you’re there, re-route the vocoder output to Aux return 1.
This way, our vocoder-reverb will be connected as a regular send effect.

5. Set the vocoder to FFT (512) mode, turn the Decay knob to between 6 and 7 
and turn the Dry/Wet control to “wet” (fully right)

6. On the Subtractor, set up a noise sound as follows:
Turn the Oscillator Mix knob fully to the right.
Turn on the Noise section (but make sure Osc 2 is off).
In the Noise section, turn Color to around twelve o’clock.
Open the filter fully and make sure resonance is set to 0.
Make sure Filter Envelope Amt is 0 (and turn off velocity modulation.
Raise the Sustain to full in the Amp Envelope section.

Now we want the Subtractor to play a continuous noise. You could just route MIDI to 
it, play a note and keep it pressed, but that will probably wear you out in the long run. 
Better to use a Matrix:

7. Create a Matrix and route it to the Subtractor.
We really only need the Gate connection - the note number isn’t important with the 
noise patch.

8. Set up a one step pattern with a tied gate (press [Shift] and draw the gate) 
and start playback on the Matrix.
Now the vocoder gets a continuous noise signal as carrier.

9. Create a suitable drum pattern on the Redrum and start pattern playback.

10.Gradually turn up send 1 for the Redrum channel in the mixer.
This now serves as a balance control between the dry drum sound and the reverb, 
generated by the voccoded noise! Set it to a suitable reverb level.

11.Use the Decay control on the vocoder to adjust the reverb decay time.

12.Use the Noise Color control on the Subtractor to make the reverb darker or 
brighter.
You could use the filter cutoff for this as well.

That’s it - a pretty good reverb sound with a lot of control. Although the settings above 
give the most natural sound, you can vary the sound and create special-FX reverb in 
the following ways for example:

• Switch the vocoder to a lower band mode.
• Lower the cutoff and add some resonance in the Subtractor filter.
• Modulate the Subtractor filter with a fast LFO.
• Set the Subtractor filter to HighPass mode to remove the bottom end from the re-

verb.
• Turn off the Matrix controlling the Subtractor and “play” the noise patch yourself 

(or from the sequencer). This way you can create gated reverb effects, etc.
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Creating a stereo reverb

What you’ve got above is a mono reverb. Here’s how to make it stereo:

1. Select the Subtractor and create a Spider Audio Merger & Splitter device.

2. Create a DDL-1 delay.

3. Connect the devices in the following way:
The Subtractor output should be routed to a Splitter input on the Spider. One split 
output should be routed to one of the carrier inputs on the vocoder, the other split 
output should be routed to the delay. The delay output (mono) should be routed to 
the other carrier input on the vocoder.

The vocoder will now get a “fake-stereo” noise carrier signal.

4. Make sure the output from the vocoder is connected in stereo to the Aux re-
turn on the Mixer.

5. Finally turn down the Feedback on the delay, set it to all “wet” and set the de-
cay time to a second or so.

When you now start playback on the Redrum, the reverb will be in stereo!
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Common Device Features
While the specific parameters for each device are described below, some features 
and procedures are common to all effect devices:

The Input meter

This shows the level of the incoming audio signal, giving you an indication of which 
devices are active, connected and playing. However, you don’t need to worry about 
clipping in effect devices, even if the meter goes into the red.

The Power/Bypass switch

This is located in the upper left corner of each effect device. The switch has three 
modes, according to the following figure:

About making settings

You adjust effect parameters using the regular editing techniques. Note:

✪ A quick way to reset the parameters to their default values is to [Com-
mand]/[Ctrl]–Click the corresponding knob.

About Connections

D All effect devices have stereo inputs and outputs, and can be connected 
as send effects or as insert effects. 
However, some effects are best used as one of these only. This is stated for each 
effect on the following pages. See also the section about the signal flow graphs 
below.

D Most of the effect devices have one or several CV inputs on the back 
panel.
These allow you to control various effect parameters in real-time, from another de-
vice in the rack. See page 49 for details about routing CV.

The Signal Flow graphs

On the back of each effect device, you will find two or three small “graphs”. These in-
dicate how the effect device handles mono and stereo signals, depending on the con-
nections. The selection of graphs for a device tells you how it should be used, 
according to the following rules:

|Mode |Description
Bypass In this mode, the input signal is passed directly to the audio output, with-

out being affected by the effect device. This is useful when the effect de-
vice is connected as an insert effect, and you want to compare the effect 
sound with the dry sound.

On This is the default mode, in which the device processes the incoming 
signal.

Off In this mode, the effect device is turned off and neither dry nor effect 
sound is sent out. This is useful when the device is connected as a send 
effect and you want to turn it off temporarily.

|Graph |Description
Can be connected as a mono-in, mono-out device. 
(Of course, all effect devices can be connected in mono. However, if this 
graph isn’t shown for a device, this means that a mono-in, mono-out con-
nection may not give the proper results).

Can be connected as a mono-in, stereo-out device. This means that the 
device creates some sort of stereo effect (e.g. a reverb) or a mono effect 
that can be panned.

If you connect both inputs and outputs in stereo, the two sides will be 
processed independently (dual mono processing).

If you connect both inputs and outputs in stereo, the two sides are 
summed before the effect processing. However, the actual effect is in 
stereo (and the dry signal will remain in stereo, if it is passed through the 
effect).

“True stereo” processing, or “stereo in - stereo out” processing. When 
you connect the inputs in stereo, each channel in the effect uses the sig-
nal information from both inputs. However, the inputs are not summed - 
the two channels are processed differently.
This mode is available on the RV7000 Advanced Reverb.
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The MClass effects
The MClass package consists of four effect devices, which are available separately or 
grouped together in the “MClass Mastering Suite Combi”. As the name implies, the 
effects are suitable for mastering purposes, i.e. to process the final mixed output, but 
can of course be used to process individual devices as well. The individual MClass ef-
fects are as follows:

• The MClass Equalizer - this has low and high shelving bands, two fully parametric 
bands and a low cut “anti-rumble” switch. See “The MClass Equalizer”.

• The MClass Stereo Imager - this can be used to control the stereo width for the 
high and low frequency ranges separately. See “The MClass Stereo Imager”.

• The MClass Compressor - this single band compressor features sidechain input 
and program-adaptive release. See “The MClass Compressor”.

• The MClass Maximizer is a special limiter tailored for loudness maximizing without 
risk of clipping. See “The MClass Maximizer”.

The MClass Mastering Suite Combi

Selecting the MClass Mastering Suite will create a Combinator device containing all 
four MClass effects with all internal routing between the devices already made, and 
with the first patch in the “MClass Mastering Patches” folder loaded. 

This Factory Sound Bank folder contains many MClass Combi patches, with descrip-
tive names indicating how the effects will affect the sound - use the patch selectors 
on the Combinator panel to try out different mastering patches!

In addition, most of these Combis have logical parameters and functions linked to the 
knobs and buttons on the Combinator Programmer panel, which makes the MClass 
Mastering Suite Combi very simple and intuitive to operate.

By using the rotaries and buttons on the Combinator you can fine-tune the sound to 
your liking. If you need more control, click “Show Devices” and make settings on the 
individual MClass devices.

Connections

When using the MClass Mastering Suite Combi for mastering purposes, the Combi-
nator should be connected at the very end of the signal chain, inserted between the fi-
nal mixed output and the Hardware Interface. 

D If you select the Hardware Interface and then create a MClass Mastering 
Suite Combi, the correct connections will be auto-routed.

! For descriptions of how to use Combinator devices please refer to the 
Combinator chapter.

The MClass Equalizer

The MClass Equalizer consists of two independent, fully parametric bands plus high 
and low shelving bands and a lo cut switch. 

This is most often used as an insert effect, in mono or stereo.

Activating the separate EQ bands

The separate bands are organized as vertical strips on the panel, in the following or-
der (from left to right): Lo Cut/Lo Shelf/Parametric 1/Parametric 2/Hi Shelf. 

You activate the separate bands by clicking the button at the top of each strip (none 
of the bands are activated by default).

Lo Cut 

The Lo Cut switch will simply cut frequencies below 30 Hz (by 12 dB/Octave). This is 
useful for removing low frequency “rumble”.

✪ When you are using the MClass Equalizer with a compressor or Maxi-
mizer, activating the Lo Cut switch prevents subsonic sound from “top-
ping” the compressor/limiter, and allows them to operate as efficiently 
as possible.
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Parametric 1-2 parameters

A parametric equalizer will boost or cut frequencies around the selected frequency. 
The following parameters are available for both the parametric bands:

Lo/Hi Shelf parameters

A shelving equalizer will boost or cut frequencies below or above the selected fre-
quency.

The following parameters are available for the Lo/Hi Shelf bands:

About the graphic display

The graphic display to the left in the device panel shows the frequency response 
curve as set by the EQ parameters. This gives a visual feedback and helps you tailor 
the EQ settings.

The MClass Stereo Imager

The MClass Stereo Imager splits the signal into two frequency bands; “Hi” and “Lo” 
and allows you to widen or narrow the stereo image of each band. A typical applica-
tion of the Stereo Imager is to widen the higher frequencies and narrow the lower fre-
quencies. This will make the bass end “tight” whilst “opening up” the higher 
frequencies.

This is most often used as an insert effect in stereo. 

! The MClass Stereo Imager does not create stereo from mono input! For 
the device to work properly it must connected with stereo in/out, and the 
input signal must contain a stereo audio signal.

Parameters

The following parameters are available:

Connections

Apart from standard L/R inputs and outputs, there are also “Separate” L/R outputs on 
the back panel. The Separate outputs can either carry the Lo or Hi band output, which 
is set by the switch beside the outputs. These outputs can be used to apply process-
ing separately to either the Lo or Hi band.

✪ If you set the Solo switch to “Lo” and the Separate output switch to “Hi”, 
the device will operate as a basic crossover filter, delivering the Lo band 
signal from the main output and the Hi band signal from the Separate 
out.

|Parameter |Description
Frequency This determines the center frequency of the EQ, i.e. at which fre-

quency the level should be decreased or increased. The range is 
39 Hz to 20 kHz.

Gain Specifies how much the level of the selected frequency range 
should be boosted or cut. The gain range is ±18 dB.

Q This governs the width of the affected area around the set center 
frequency. The higher the value, the narrower the affected fre-
quency range.

|Parameter |Description
Frequency Frequencies below (Lo Shelf) or above (Hi Shelf) the selected fre-

quency will be boosted or cut.
• The Lo Shelf range is 30 Hz to 600 Hz.
• The Hi Shelf range is 3 kHz to 12 kHz.

Gain Specifies how much the level should be boosted or cut. The gain 
range is ±18 dB.

Q This governs the slope of the shelving curve. The higher the value, 
the steeper the curve slope. High Q settings will also produce a 
“bump” in the opposite cut/boost direction at the set frequency. 

|Parameter |Description
X-Over 
Frequency

This determines the crossover frequency between the Hi and Lo 
band. Range is 100 Hz - 6 kHz. Frequencies below this will be af-
fected by the Lo Width setting; frequencies above will be affected by 
the Hi Width setting.

Lo Width This adjusts the stereo width for the Lo band. Turn anti-clockwise to 
narrow the stereo width (i.e. to make it more “mono”), and clockwise 
to widen the stereo image. Center position means no change from 
original signal. The “Active” LED indicates whether Low Width is acti-
vated or not. Note that for the Lo band, it is more common to narrow 
the stereo image, as the low frequency content in a mix is usually 
mixed center and can become less defined if widened.

Hi Width This adjusts the stereo width for the Hi band. Turn anti-clockwise to 
narrow the stereo width (i.e. to make it more “mono”), and clockwise 
to widen the stereo image. Center position means no change from 
original signal. The “Active” LED indicates whether Hi Width is acti-
vated or not.

Solo switch This allows you to listen to the Lo and Hi bands separately, for refer-
ence purposes. “Normal” is the standard operating mode.
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The MClass Compressor

This is a single-band compressor capable of everything from subtle compression to 
aggressive pumping effects. Like all dynamics processors it is best used as an insert 
effect. 

The features include “soft-knee” compression for more musical and unobtrusive com-
pression, program-adaptive release time and a sidechain input for de-essing and 
other dynamics processing. Additionally, you have a CV output, allowing you to have 
the amount of gain reduction control other Reason parameters.

Parameters:

About the Sidechain inputs

D When a signal is connected to the Sidechain inputs, it is this signal that 
will trigger the compression.
This signal is not passed to the compressor output, and will thus not be heard (un-
less Sidechain Solo is activated). 

D The signal connected to the normal L/R inputs is the signal that will be 
processed by the compressor (as usual).

Here follows two examples of how you can use sidechain processing:

Example 1 - using the Sidechain inputs to create ducking effects

“Ducking” is when the level of one signal is reduced by the presence of another sig-
nal. A typical application is to automatically lower the level of a musical bed when a 
voice-over starts, and to automatically bring the level up when the voice-over stops. To 
set this up, we can name the musical bed in the example “Device A”, and the voice-
over “Device B”. Proceed as follows:

1. Connect Device A and Device B to separate channels on a mixer device.
In this example the signal produced by Device A should be continuous, and the 
signal produced by Device B should be intermittent, i.e. it should contain both si-
lent passages and signal passages.

2. Select Device A and then select an MClass compressor from the Create 
menu.
The effect will be auto-routed as an insert effect to Device A.

3. Connect a Send on the mixer device to the Sidechain inputs on the MClass 
compressor.
As soon as anything is connected to the Sidechain inputs, the “Active” indicator 
lights up on the device panel. The compressor will no longer react to the signal 
produced by Device A.

4. Turn up the corresponding AUX Send level for Device B on the mixer.
This means that the Device B signal now feeds both the mixer's input, and the 
sidechain input on the compressor, which in turn triggers the gain reduction.

|Parameter |Description
Input Gain The Input Gain controls the ”drive” of the compression. This deter-

mines how much compression the signal will have in conjunction 
with the Threshold. Range: ±12 dB.

Threshold This sets the level at which onset of compression occurs. When the 
input level is below the Threshold setting the signal is unaffected. 
When the input level exceeds the threshold, compression kicks in. 
In practice, this means that the lower the Threshold setting (and the 
higher the Input Gain), the more compression will be applied.
Range: -36 dB to 0 dB

Soft Knee Normally signals above the threshold will be compressed immedi-
ately at whatever ratio is set. This can be very noticeable, especially 
when using high compression ratios. When Soft Knee is activated, 
the onset of compression will be more gradual, producing a less 
drastic result.

Ratio This lets you specify the amount of gain reduction applied to the 
signals above the set threshold. The Ratio can be set from 1:1 (no 
reduction) to ∞:1 (Infinite).

Gain meter This shows the amount of gain reduction (in dB).

Solo Sidechain This allows you to monitor the signal connected to the sidechain in-
put (see below).

Attack This governs how quickly the compressor will apply its effect when 
signals rise above the set threshold. If you raise this value, the re-
sponse will be slower, allowing more of the signal to pass through 
the compressor unaffected. Typically, this is used for preserving the 
attacks of the sounds. Range: 1ms to 100ms.

Release When the signal level drops below the set threshold, this deter-
mines how long it takes before the compressor lets the sound 
through unaffected. Set this to short values for intense, “pumping” 
compressor effects, or to longer values for a smoother change of 
the dynamics. Range: 50ms to 600ms.

Adapt 
Release

When this is used, set Release to the time you want for short peaks 
- when longer peaks occur, the Release time is automatically in-
creased.

Output Gain This controls the output gain and can be used to compensate for 
the gain reduction caused by compression. Range: ±12 dB.

|Parameter |Description
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5. If you now start playback of both devices, the level of Device A will be low-
ered whenever Device B sounds, and be raised again when Device B stops.
The amount of gain reduction, how quickly it lowers the level, and the time it take 
for the level to return to normal again is determined by the corresponding Gain/
Threshold/Ratio and Attack/Release parameters.

Example 2 - using the Sidechain inputs to create frequency 
sensitive compression

By inserting an equalized signal to the sidechain inputs you can make the compres-
sion more or less sensitive to a certain frequency range. A typical application of this is 
“de-essing” - where harsh “S”-sounds in vocal material is reduced or eliminated. 

Frequency sensitive compression is set up as follows:

1. Hold down [Shift] and create an instrument device.
Pressing [Shift] means no auto-routing connections to/from the device are made.

2. Hold down [Shift] and create a MClass Equalizer.

3. Hold down [Shift] and create a MClass Compressor.

4. Create a Spider Audio Merger and Splitter device.

5. Connect the outputs of the instrument device to the A and B inputs on the 
Spider.

6. Route one pair of the split outputs of the Spider to the MClass Equalizer in-
puts.

7. Route the Equalizer outputs to the Sidechain inputs on the MClass Compres-
sor.

8. Route another pair of the split outputs of the Spider to the MClass Compres-
sor.
Now, the compressors normal audio inputs are fed the unprocessed signal, and 
the sidechain inputs are fed the equalized signal.

9. Next, route the outputs of the Compressor to inputs on a mixer device.

10.Activate the Solo Sidechain button on the compressor’s front panel.
You will now only hear the equalized signal. 

11.Now use the parameters on the MClass Equalizer to boost the frequencies 
you wish should trigger the gain reduction and cut the frequencies you wish 
to avoid triggering the gain reduction.
You can use rather extreme eq settings - the signal will not be heard when Solo 
Sidechain is deactivated anyway. E.g. for de-essing you should separate and 
boost the offending “S” frequencies as much as possible.

12.Deactivate Solo Sidechain when you have finished tweaking the equalizer.
Now, the compressor will be more sensitive to the frequency area you tuned in 
with the equalizer, and thus react more to these frequencies. Note, however, that 
the whole signal will still be compressed - not just the boosted frequencies - so in 
case of de-essing you should usually use fast Attack and Release settings so that 
the gain reduction does not affect the rest of the program too much.

CV Outs

On the back of the MClass Compressor you can find a “Gain Reduction” CV out con-
nector. This can be used to modulate other parameters with the amount of gain reduc-
tion applied by the compressor. This means that the compressor works as an 
envelope follower. You could for example have the audio signal level control pan in a 
mixer or a synth parameter.
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The MClass Maximizer

This is a loudness maximizer, a special type of limiter which can significantly raise the 
perceived loudness of a mix without risk of hard clipping distortion. Features include a 
4 ms look ahead function for “brick wall” limiting and a Soft Clip function.

The MClass Maximizer should be used as an insert effect, and is designed to be 
placed at the end of the signal chain between the mixed final output and the Hard-
ware Interface.

Parameters

Scream 4 Sound Destruction 
Unit

Scream 4 is a very versatile stereo in/out sound destruction device, capable of warp-
ing any sound literally beyond recognition, but also capable of producing more subtle 
musical effects. Scream 4 features a wide range of algorithms for distortion and 
sound mangling which can be combined with an EQ and a resonant “Body” section to 
provide everything you need to add an edge to your sounds. This effect is most often 
used as an insert effect.

About the Patch format

Unlike most of the other effect devices, Scream 4 features programmable effect pre-
sets. Included are a number of factory Patches which can be used as they are or pro-
vide you with a good starting point for further tweaking.

Patches use the Windows file extension “*.SM4”. Loading and saving Patches is 
done in the same way as for instrument devices.

|Parameter |Description
Input Gain The Input Gain sets the basic volume of a mix. If this is set 

very high, you should use Look Ahead mode or the Soft Clip 
function to eliminate the risk of hard clipping distortion. 
Range: ±12 dB.

Limiter On/Off This turns the Limiter section on or off.

Look Ahead On/Off If activated, this will introduce a very short delay (4 ms) to the 
signal. This delay is used to detect peaks in the signal before 
they actually occur. If high peaks are detected the limiter is 
“ready for them” and gain reduction is applied to transpar-
ently control the peaks.

Attack
(Fast/Mid/Slow)

This governs how quickly the Limiter will apply its effect. If set 
to Fast with Look Ahead activated (and the Output Gain is 
set to 0 dB) you will get “brick wall” limiting - no signal peaks 
over 0 dB will pass.

Release
(Fast/Slow/Auto)

This determines how long it takes before the Limiter lets the 
sound through unaffected. If Auto is activated, the Release 
time will automatically adapt to the program material.

Output Gain This controls the output gain and should normally be set to 0 
dB.

Soft Clip On/Off If this is activated, it also acts a 0 dB brick wall limiter but in 
a slightly different way. The signal will be “soft-clipped” 
which adds a pleasant, warm sounding distortion to the sig-
nal. It can be used simply to get this effect, or as a safeguard 
against hard clipping distortion if Look Ahead with Mid or 
Slow attack settings are used (or if Look Ahead is deacti-
vated).

Soft Clip Amount This controls the amount of soft-clipping distortion. Note that 
if Soft Clip is on but the Amount is set to zero, the distortion 
will be like hard clipping, and thus less pleasing to the ear.

Output level meter
(Peak/VU)

This is a more detailed meter than found on the mixer. You 
can switch the meter characteristics between Peak (faster 
response to peaks) and VU mode (average levels).
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Parameters
Scream 4 contains three main sections; Damage (distortion and other types of sound 
destruction), Cut (EQ) and Body (places the sound in a resonant environment - can 
serve as anything from a cabinet emulator to a wah-wah to completely new special ef-
fects) which can be switched on or off independently. The parameters in each section 
are as follows:

Damage section controls

The “Damage” section is where you specify the basic sound mangling algorithm and 
make settings to inflict the desired amount of damage to the sound. There are ten ba-
sic algorithms to chose from, ranging from classic distortion effects to digital-sound-
ing warping and modulation effects.

There are five controls in this section, with the following functions:

Description of the various Damage Type algorithms

Here follows a basic description of the ten Damage Types available, and what param-
eters the P1/P2 knobs control for each type:

|Parameter |Description
Damage button This switches the Damage section on or off.

Damage Control knob This controls the input gain which in turn determines the 
amount of damage inflicted. The higher the value, the 
more destruction!
When raising the Damage Control you may need to lower 
the Master level to maintain the same output level (and 
vice versa).

Damage Type knob This selects the type of effect - see the table below for a 
description of the available damage methods.

P1/P2 knobs The functionality of these knobs vary according to the se-
lected Damage Type - see the table below for a descrip-
tion.

|Type |Description
Overdrive This produces an analog-type overdrive effect. Overdrive is quite re-

sponsive to varying dynamics. Use lower Damage Control settings for 
more subtle “crunch” effects. 
- The P1 knob controls the basic tone of the effect. Turn clockwise for 
a brighter sound.
- The P2 knob controls Presence. Presence boosts frequencies in the 
high midrange before the distortion stage which in turn affects the 
character of the distortion. Turn clockwise for more Presence boost.

Distortion Similar to Overdrive, but produces denser, thicker distortion. The dis-
tortion is also more “even” across the Damage Control range com-
pared to Overdrive.
- The P1/P2 knobs control Tone and Presence, respectively - see 
Overdrive for a description.

Fuzz Fuzz produces a bright and distorted sound even at low Damage 
Control settings.
- The P1/P2 knobs control Tone and Presence, respectively - see 
Overdrive for a description.

Tube This emulates tube distortion. 
- The P1 knob controls Contour, which is somewhat like a high pass 
filter, changing the tone and character of the distortion.
- The P2 knob controls Bias, which changes the “symmetry” of the 
tube distortion. Setting this to the minimum or maximum value will 
produce asymmetrical distortion (typical of a real-life tube amplifier), 
while a 12 o’clock setting will produce symmetrical distortion (odd 
harmonics only).

Tape This emulates the soft clipping distortion produced by magnetic tape 
saturation and also adds compression which adds “punch” to the 
sound.
- The P1 knob controls Speed, which simulates tape running at differ-
ent speeds. The higher the Speed setting the more of the original 
high frequency material in the signal. Turn clockwise for a brighter 
sound.
- The P2 knob controls the amount of Compression. Turning the knob 
clockwise increases the compression ratio.
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Cut section (EQ)

The sliders in the Cut section are tone controls, allowing you to cut or boost the level 
by up to 18dB in the low, mid and high frequency areas. The Cut section is activated 
with the Cut button above the sliders.

Move the slider from the middle upwards to boost the level, and from the middle 
downwards to cut the level of the corresponding frequency area.

Body section

The Body section is just what it says - it places the sound in a resonant “body”. De-
pending on the settings, the result can be similar to a speaker cabinet simulator, an 
auto-wah effect, or effects with no real-world counterpart. The section is based on 5 
basic body types, which simulate how a sound is affected by different physical enclo-
sures. The size and resonance of the Body types can be changed, and the section 
also features an envelope follower.

The Body parameters are as follows:

Feedback This effect combines distortion in a feedback loop which can produce 
many interesting and sometimes unpredictable results. Feedback is 
basically when a sound source is fed back to itself. An open micro-
phone picking up sound from a nearby loudspeaker that is also being 
used to amplify sound from the microphone will produce a feedback 
loop with the associated typical howling. For this effect the Damage 
Control knob controls the gain of the feedback loop.
- The P1 knob controls Size, which could be described as the 
“length” (i.e. the distance between the microphone and the loud-
speaker in the above example) of the feedback loop. 
- The P2 knob controls Frequency, which for this effect determines 
which overtones will “howl”.

Modulate Modulate first multiplies the signal with a filtered and compressed 
version of itself, and then adds distortion. This can produce resonant, 
ringing distortion effects.
- The P1 knob controls Ring, which is the resonance of the filter. Turn 
clockwise for more pronounced ringing effects.
- The P2 knob controls Frequency, which is the filter frequency. Turn 
clockwise to raise the filter frequency which generally produces a 
sharper, more piercing effect.

Warp Warp distorts and multiplies the incoming signal with itself.
- The P1 knob controls Sharpness. Lower values will produce a soft, 
compressed distortion, while higher values produces more harmonics 
and a sharper sound.
- An effect of multiplying a signal with itself is that the fundamental 
pitch is removed from the signal, leaving overtones only. The P2 knob 
controls Bias - raise this to reintroduce the fundamental pitch in the 
sound.

Digital Lo-fi anyone? This reduces the bit resolution and sample rate for raw 
and dirty sounds or for emulating vintage digital gear.
- The P1 knob controls (bit) Resolution. If the knob is turned fully to 
the right there is no bit reduction, fully the left the resolution is 1-bit.
- The P2 knob controls the sample rate. If the knob is turned fully to 
the right the sample rate is not reduced; turning it to the left gradually 
reduces the sample rate.

Scream Similar to Fuzz, but with a bandpass filter with high resonance and 
gain settings placed before the distortion stage. 
- The P1 knob controls the basic tone of the effect. Turn clockwise for 
a brighter sound.
- The P2 knob controls the filter frequency. The high resonance set-
ting of the filter makes it suitable for wah-wah effects.

|Type |Description

|Parameter |Description
Body button This switches the Body section on or off.

Body Type knob This is used to select one of the five available Body types (A-E). 

Body Reso knob This simulates the resonance of the selected Body. Turning the 
knob clockwise gives a more resonant effect.

Body Scale The Body Scale parameter could be said to control the “size” 
of the Body. Note that this is “inverted” - turning the knob 
clockwise reduces the emulated size.

Auto knob Determines the amount of envelope follower effect on the 
Scale parameter - see below.
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About the envelope follower

The Body section features an envelope follower for dynamic control of the Scale pa-
rameter. The envelope follower analyzes the amplitude of the incoming signal and 
changes the Scale setting accordingly - the louder the incoming signal the higher the 
value of the Scale parameter. The operating frequency (or size) range is set with the 
Scale parameter, and the envelope follower amount is set with the Auto parameter. A 
typical use for this is auto-wah effects - try Body Type “B” for a pronounced wah ef-
fect.

• On the back of the Scream 4 you will find an Auto CV output - this delivers the CV 
signal from the envelope follower, allowing you to dynamically control parameters 
in other devices. See page 344 for an example.

About the Master level control

The Master level control should be used when you need to increase or decrease the 
output level, while retaining the basic character of the effect. It can also be used to 
balance the level between the distorted sound and the “clean” (unprocessed) sound 
if the effect is to be switched in and out in the mix.

If the output level is too high, turning down the Damage Control setting would lower 
the output, but it would also change the character of the distortion, as would chang-
ing eq or presence settings.

Simply lowering the mixer channel level (for the channel that Scream 4 is connected 
to) would also work of course, but this would also mean that the level difference be-
tween the unprocessed and processed sound would increase. 

So if the clip indicator lights up on the Transport, or if the distorted sound is too loud 
compared to the normal sound, the solution is to lower the Master output level.

As pointed out elsewhere in the manual, audio out clipping (indicated by the red clip 
indicator lighting up on the Transport panel) can only happen in the Reason Hardware 
Interface. In other words, you never have to worry about levels passed internally from 
device to device. However, bear in mind that if you use high Master output settings (or 
a lot of boost in the Cut section) Scream 4 can quite easily cause audio out clipping - 
and that is most likely not a distortion effect you want! 

CV inputs and outputs

On the back of the Scream 4 you will find CV inputs for controlling the following four 
parameters:

D Damage Control
Use this for dynamically changing the amount of damage effect.

D P1
The use for this depends on the selected Damage Type. For example, if the Feed-
back effect is selected, this will control the Size parameter - connect it to the CV 
Out on a Matrix or synth LFO for strange, flanger-like sweeps.

D P2
The use for this depends on the selected Damage Type. For example, if the 
Scream effect is selected, this will control the Frequency parameter, producing a 
distorted wah wah sound.

D Scale
Lets you control the Scale parameter in the Body section from another CV source, 
for wah wah-like effects, etc.

In addition, you find a CV output from the “Auto” (envelope follower) function in the 
Body section. By connecting this to a CV input for a parameter in another device, the 
level of the signal going into the Scream 4 will affect that parameter. See below for an 
example on how to use this.
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Tips and tricks
Don’t restrict yourself to using Scream 4 as a basic distortion stompbox, but try it in as 
many ways as possible - you may be surprised to find how often Scream 4 can add 
power, warmth and color to your sounds. Here are some examples:

Creating a heavy drum sound

Scream 4 is ideal for processing drums. Try connecting it as an insert effect to a Re-
drum device and experiment with the Damage Types and settings. 

• For classic distorted drums, try the Tube, Tape or Distortion algorithms.
• The Scream algorithm is excellent for a really raw body or industrial drum sound.
• For more weird, synth-like effects, try the Modulation or Warp effects.

Remember that you don’t have to route the whole drum kit through the Scream device 
- sometimes it may be better to route the individual outputs from the bass drum, snare 
and/or toms to a Spider Audio Merger (see page 360), connect the merged output of 
the Spider to the Scream 4 and route this to a separate channel in the Mixer. That 
way, hi-hats, cymbals and similar are unprocessed.

Warming up a mix with the Tape effect

If you find your mixes a bit sterile, the Tape algorithm is excellent for providing some 
warmth and gentle distortion:

1. Create a Scream 4 device and connect it between the main outputs of the 
Mixer and the Audio Hardware device.

2. Set the Damage Type to Tape.
Make sure the Cut and Body sections are turned off.

3. Start with a low Damage Control setting and P1 (Speed) and P2 (Compres-
sion) at 12 o’clock.

4. Play back your mix and adjust the settings.
Raise the Damage Control for more tape saturation distortion, adjust P1 to get the 
desired brightness and raise P2 if you want a more controlled, compressed sound. 
If you like, you could also activate the Cut section and use the three-band EQ to 
further adjust the sound.

Using the Body section as a sound enhancer/phaser/wah

Nothing stops you from using the Body section on its own, without Damage. Try this:

1. Create a sampler device (e.g. an NN-19) and select an electric piano patch.

2. Select the sampler and create a Scream 4.
It is added as an insert effect.

3. Turn off the Damage section and instead activate the Body section.

You will find that this adds a resonant character to the sound, which will make it more 
“alive” and help it stand out in a mix. You should experiment with the Body settings to 
find the character that suits you best. You could also activate the Cut section- if you 
e.g. find the sound too bassy, just lower the “Lo” slider a bit.

4. Now flip the rack around and connect the CV out from the sampler’s LFO to 
the Scale CV input on the Scream 4.
As you can hear, the Scale is modulated by the LFO.

5. Adjust the amount of Scale modulation with the pot next to the CV input on 
the back of the Scream 4, and the speed (and waveform) of the modulation 
in the LFO section on the sampler device.
With this type of modulation setup, it’s easy to get lush, dreamy phaser effects. For 
a more wah wah-like sound, select Body type B and raise the Reso and Scale set-
tings.

Emulating vintage digital gear

The first generations of digital instruments (drum machines, synths and samplers) 
used 8 or 12 bit sampling and processing, at low sample rates. This “lo-fi” sound is 
still in high demand, e.g. in hip-hop and R’n’B. Try this:

1. Connect a Scream 4 as an insert for a Redrum, with a suitable kit selected.

2. Set Damage Type to Digital and turn P1 and P2 fully right.

3. Play back and lower P1 (bit depth) and P2 (sample rate) to get the sound you 
want.
You may also want to use the Cut section to emphasize or cut frequencies in the 
sound.
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Creating a real dynamic wah effect with the envelope follower

As we have shown, you can get auto-wah-like effects with the Body section in Scream 
4 (by using the Auto parameter). You could also use the ECF-42 envelope controlled 
filter and trigger this with a gate signal - this is after all a “real” filter and sounds even 
more like a wah effect. However, to get a “real” auto-wah effect that responds to the 
signal level, you need to combine both these devices:

1. Create an instrument device that you want to process with an auto-wah.
It should be velocity responsive so that the harder you play, the louder it sounds.

2. Create a Scream 4 device and an ECF-42 device.
Both these should now be connected as insert effects to the instrument device.

3. Turn off all three sections in the Scream 4.
This is of course a matter of taste - but here we will show how to use the envelope 
follower in Scream 4, not its sound destruction capabilities.

4. Flip the rack around and connect the Auto CV Output on the Scream to the 
Freq CV input on the ECF-42.

5. Lower the pot next to the CV input a bit - the envelope follower is rather sen-
sitive and you probably don’t want the filter to open too much.
You can adjust this later if needed.

6. On the ECF-42, select the BP 12 (bandpass) mode and set the Res setting 
rather high.

7. Play the instrument device and adjust the Freq setting on the ECF-42 to 
taste.
As you can hear, the harder (or the more notes) you play, the more the filter will 
open.

✪ If you find the auto-wah too responsive, you could add a compressor be-
tween the instrument device and the Scream 4 to even out the level dif-
ferences a bit.

✪ The Spider CV Splitter and Merger (see page 361) can be used to invert 
and split the Auto CV output for even greater flexibility.

Scream 4 sample rate issue

Some of the algorithms on the Scream 4 Distortion device do not have the expected 
effect when running Reason at a sample rate lower than 14 kHz (or exporting to a 
sample rate lower than 14 kHz). Please use a higher sample rate if your song contains 
Scream devices.

RV7000 Advanced Reverb

The RV7000 is a high quality reverb processor. It features nine different reverb and 
echo algorithms, ranging from rooms and halls to special effects. Since the RV7000 
comes with a number of useful reverb presets, you could simply select one and tweak 
the most important parameters on the main panel - or you could use the Remote Pro-
grammer panel to fine-tune the reverb in great detail.

The RV7000 also contains an equalizer and a gate section. Both of these are for pro-
cessing the actual reverb sound, making it possible to get virtually any kind of reverb 
character, including gated reverb.

About the Patch format

Like the Scream 4 device, the RV7000 features programmable effect presets. In the 
Factory Sound Bank will find a number of preset Patches which can be used as they 
are or provide you with a good starting point for further tweaking.

Patches use the Windows file extension “*.RV7”. Loading and saving Patches is done 
in the same way as for instrument devices.

Connections

Typically you connect the RV7000 as a send effect, as this allows you to use it for 
processing several different mixer channels. However, it’s also possible to use it as an 
insert effect - use the Dry/Wet control on the main panel to adjust the balance be-
tween the dry, unprocessed sound and the reverb. Note:

D The RV7000 is a true stereo reverb, which means that it will use the ste-
reo input information when processing both channels (without summing 
the input channels).
It’s also possible to use it as a mono in - stereo out effect. Which type of connec-
tion to use (mono or stereo in) depends on the material. If the audio sources are in 
mono (or in stereo but with no important difference between the left and right 
channel) using a mono input is sufficient.

D If you want to use RV7000’s Reverse reverb effect, you should consider 
connecting it as an insert effect or using Send 4 on the Mixer, with Pre-
fader mode selected (and the channel fader lowered).
This is because you typically don’t want to hear the dry sound when using the Re-
verse effect. See page 349.
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The main panel

The RV7000 main panel.

When you create an RV7000, only the main panel will be shown. This contains a sec-
tion for handling patches, on/off buttons for the EQ and Gate sections, the most im-
portant reverb parameters and a dry/wet mix control. To select a reverb patch and 
make coarse adjustments, this is all you need.

The remote programmer

Clicking the arrow button next to the “cable slot” on the main panel brings up the re-
mote programmer panel.

This is where you make detailed settings for the reverb. Note:

• The Edit Mode button to the left determines which section to make settings for, 
Reverb, EQ or Gate.

• Settings are made with the eight dials around the graphic display. The functions of 
the dials differ depending on the selected Edit Mode and the selected reverb algo-
rithm. Next to each dial, the display shows the name and value of the correspond-
ing parameter.

• Not all modes and algorithms use all eight dials. If a dial isn’t used in the selected 
mode, nothing will be shown next to it in the display.

• You cannot make settings in the graphic display itself - this is for showing a 
graphic representation of the selected reverb.

Reverb algorithms and parameters

About the main panel parameters

On the main panel you find three parameters that are available for all algorithms:

Selecting an algorithm

You select a reverb algorithm in the remote programmer panel:

1. Click the remote programmer arrow button on the main panel to display the 
remote programmer panel.

2. Make sure the Edit Mode button is set to Reverb.

3. Use the top left dial to select a reverb algorithm.
The selected algorithm is shown in the display next to the dial.

|Parameter |Description
Decay This governs the length of the reverb or the feedback if an echo algo-

rithm is selected.

HF Damp Controls how quickly the high frequencies should decay in the re-
verb. Raise it to gradually remove high frequencies, making the re-
verb sound warmer and less bright.

HI EQ This is a high-shelving EQ that works much like a typical treble con-
trol on a mixer or amplifier. Lower the setting for a softer reverb sound 
or raise it to get more high frequencies.
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Here’s a quick overview of the nine algorithms - for details and parameter descrip-
tions, see below.

Small Space

This algorithm places the sound in a small enclosed space, ranging from a tiny reso-
nant body to a room. The parameters are:

Room

Emulates a medium-sized room, with the following parameters:

Hall

Emulates a hall. The parameters are the same as for the Room algorithm above (but 
the Hall algorithm offers larger Size settings).

Arena

Emulates the ambience in an arena or concert hall, with long pre-delay times (sepa-
rate for left, right and center):

|Algorithm |Description
Small Space Emulates a small enclosed space (a small room or a resonant body).

Room Emulates a room with adjustable shape and wall character.

Hall Emulates a hall.

Arena Emulates a large arena, with separate pre-delay for the left, right and 
center reverbs.

Plate Emulates a classic plate reverb.

Spring Emulates a spring reverb, as used in e.g. guitar amplifiers.

Echo An echo effect with gradually diffusing echo repeats. Can be synced 
to Reason’s tempo.

Multi Tap A multi-tap delay with four different delay lines and tempo sync.

Reverse A reverse reverb that “pushes” the dry sound to appear after the re-
verb. The result is a backwards reverb leading up to the direct sound.

|Parameter |Description
Size The size of the emulated space.

Mod Rate The reverb can be randomly modulated for a more even sound (or 
for special effects). This parameter sets the rate of modulation (the 
amount is set with Mod Amount).

Room Shape Select from four different room shapes, affecting the character of 
the reverb.

LF Damp Controls how quickly the low frequencies should decay in the re-
verb. Raise it to gradually remove low frequencies, making the re-
verb sound “thinner” and less boomy.

Wall Irreg Adjusts the positioning of the emulated walls in the small space. 
The lowest setting emulates two directly opposed walls while 
higher settings emulate more walls and angles, for a more complex 
resonance.

Predelay Sets the predelay time, i.e. the delay between the source signal 
and the start of the reverb.

Mod Amount Sets how much the reverb will be modulated. Use fairly low set-
tings when emulating real rooms and resonant bodies, and higher 
settings for special effects.

|Parameter |Description
Size The size of the emulated room.

Diffusion At low Diffusion settings, you will hear the individual reverb 
“bounces” more clearly, while higher settings produce a more 
“smeared”, dense and even reverb.

Room Shape Select from four different room shapes, affecting the character of 
the reverb.

ER->Late The first “answers” in the reverb are called early reflections (ER) 
and are typically more pronounced than the actual reverb tail. This 
parameter sets the time between the early reflections and the re-
verb tail. This is set as a percentage - the actual delay time de-
pends on the Size setting.

ER Level Adjusts the level of the early reflections. “0” is normal level.

Predelay Sets the predelay time, i.e. the delay between the source signal 
and the start of the early reflections and reverb.

Mod Amount Sets how much the reverb will be modulated. Moderate modula-
tion gives a natural, less static sound.

|Parameter |Description
Size The size of the emulated arena or hall.

Diffusion At low Diffusion settings, you will hear the individual reverb 
“bounces” more clearly, while higher settings produce a more 
“smeared”, dense and even reverb.

Left Delay The predelay time for the left side of the reverb.

Right Delay The predelay time for the right side of the reverb.

Stereo Level Adjusts the level of the left and right sides of the reverb. “0” is nor-
mal level.

Mono Delay The predelay time for the mono (center) reverb signal.

Mono Level Adjusts the level of the mono (center) reverb signal. “0” is normal 
level.
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Plate

A classic plate reverb, excellent for vocals for example. The parameters are:

Spring

An emulation of a spring reverb as can be found in guitar amplifiers, organs, etc. The 
spring reverb has the following parameters:

Echo

This is an advanced echo effect, with diffusion controls and tempo sync. When Echo 
is selected, the Decay control on the main panel controls the echo feedback (the 
number of echo repeats). The parameters are:

Multi Tap

The Multi Tap delay produces up to four different delays with separate delay times, 
panning and level. The whole set of four delay taps can then be repeated at a given 
rate. Again, the Decay control on the main panel controls the feedback (the number of 
repeats for the whole multi tap set). All delay times can be tempo synced.

Note: this algorithm is handled a bit differently since you make separate settings for 
each delay tap:

• The parameters to the left of the display are common for all taps.
• You use the Edit Select parameter in the top right corner to select which tap to 

make settings for - the three parameters below affect the currently selected tap.

Tap 2 selected for editing.

|Parameter |Description
LF Damp Controls how quickly the low frequencies should decay in the re-

verb. Raise it to gradually remove low frequencies, making the re-
verb sound “thinner” and less boomy.

Predelay Sets the predelay time, i.e. the delay between the source signal 
and the start of the reverb.

|Parameter |Description
Length Sets the length of the simulated spring.

Diffusion At low Diffusion settings, you will hear the individual reverb 
“bounces” more clearly, while higher settings produce a more 
“smeared”, dense and even reverb.

Disp Freq When sending a signal to a real-life spring reverb, the initial tran-
sient will produce a quick, characteristic sweeping tonal noise. 
This is because different frequencies in the sound are delayed by 
different amounts (a phenomenon called dispersion). This parame-
ter controls the frequency of that sound.

LF Damp Controls how quickly the low frequencies should decay in the re-
verb. Raise it to gradually remove low frequencies, making the re-
verb sound “thinner” and less boomy.

Stereo (on/off) Determines whether the output of the spring reverb should be in 
mono or stereo.

Predelay Sets the predelay time, i.e. the delay between the source signal 
and the start of the early reflections and reverb.

Disp Amount Sets the amount of dispersion effect (see Disp Freq above).

|Parameter |Description
Echo Time Sets the time between each echo. 

When Tempo Sync (see below) is off, the echo time is set in milli-
seconds (10 - 2000 ms); when Tempo Sync is on you set the echo 
time as a number of 1/16 notes or 1/8 triplet notes, in relation to 
the current song tempo.

Diffusion When this is set to 0, the echo will sound as a standard delay with 
clear, precise repeats. Raising the Diffusion setting will introduce 
additional echoes very close to the “main” echo repeats, causing a 
“smeared” echo sound. This will also expand the echo stereo im-
age.

Tempo Sync Determines whether the echo time should be freely set (“off”) or 
synchronized to Reason’s tempo (“on”).

LF Damp Controls how quickly the low frequencies should decay in the ech-
oes. Raise it to gradually remove low frequencies.

Spread Adjusts the spacing of the additional echoes added by the Diffu-
sion parameter. For a very smeared echo (sound more like a re-
verb), set both Diffusion and Spread to their maximum values.

Predelay Sets an additional delay time before the first echo repeat.
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• You can also set Edit Select to “Repeat Tap” - this is where you specify the repeat 
time for the whole multi tap “package”.
With short Repeat times, the first tap may be repeated before the last tap has 
sounded. This can be used to create very complex multiple delay effects.

The common parameters (to the left) are:

When Tap 1 - 4 is selected with the Edit Select parameter, you can make the follow-
ing settings for the selected delay tap:

When Repeat Tap is selected with the Edit Select parameter, there is only one param-
eter to the right in the display:

Reverse
The Reverse reverb algorithm in RV7000 is special in that it actually “moves” the 
source audio as well. Sounds fed into the Reverse reverb are “sampled”, a reverse re-
verb is created and played back and finally the “sampled” original sound is played 
back. For example, if you feed a snare drum hit into the Reverse reverb, you will hear a 
rising “backwards” reverb, followed by the snare drum hit.
Therefore, you probably don’t want to hear the first, original (dry) sound. There are two 
ways to set this up:

D Connect the RV7000 as an insert effect and make sure the Dry/Wet con-
trol on the main panel is set fully to “Wet”.

D Connect the RV7000 as a send effect using send 4 on the Mixer, activate 
the Prefader (P) switch for the send and lower the mixer fader completely 
for the source signal.
That way, the signal will be sent to the reverb but the dry sound from the Mixer 
channel isn’t heard. Again, the Dry/Wet control should be set to “Wet”.

Note that with this algorithm, raising the Decay setting on the main panel will make the 
reverse reverb start earlier and build up under a longer time. Similarly, the HF Damp 
parameter affects how fast the high frequencies are built up in the reverse reverb. In 
the remote panel, the Reverse algorithm has the following parameters:

|Parameter |Description
Tempo Sync Determines whether the delay times and repeat times should be 

freely set (“off”) or synchronized to Reason’s tempo (“on”).

Diffusion Raising the Diffusion setting will introduce additional echoes 
very close to the “main” repeats, causing a “smeared” delay 
sound.

LF Damp Controls how quickly the low frequencies should decay in the 
echoes. Raise it to gradually remove low frequencies.

|Parameter |Description
Tap delay Sets the delay - the time from the source signal to the tap. 

When Tempo Sync is off, the delay time is set in milliseconds (10 
- 2000 ms); when Tempo Sync is on you set the delay as a num-
ber of 1/16 notes or 1/8 triplet notes, in relation to the current 
song tempo.

Tap level Adjusts the level of the selected tap.

Tap pan Adjusts the pan of the selected tap.

|Parameter |Description
Repeat Time Sets the time between each repeat of the whole multi tap set. 

The number of repeats is set with the Decay control on the main 
panel.
When Tempo Sync is off, the repeat time is set in milliseconds 
(10 - 2000 ms); when Tempo Sync is on you set the repeat time 
as a number of 1/16 notes or 1/8 triplet notes, in relation to the 
current song tempo.

|Parameter |Description
Length This sets the time from when the source signal is fed into the re-

verb until it is played back again. It is during this time you will 
hear the reverse reverb, as shown in the display.
The time can be set in milliseconds or as note values, depending 
on whether Tempo Sync is off or on.
Note: As stated above, the Decay setting determines the length 
of the actual reverse reverb - in essence how soon it starts after 
the source signal. But of course, the reverse reverb cannot start 
before the original source signal! If you set Decay to a longer 
time than the Length setting, the reverse reverb will start 
abruptly, immediately when the source signal is fed into the re-
verb. If this sounds complicated, just take a look at the RV7000 
display and try the settings - you will soon see how it works.
Note also that very high Length settings demand a lot of proces-
sor power. This can be reduced by adjusting the Density param-
eter, see below.

Density Density governs the “thickness” of the Reverse effect. If this pa-
rameter is turned down to zero, the effect produces individual 
delays rather than a dense “wash”, which can be used as a spe-
cial effect. Worth noting is that if Density is set to around 50%, 
this can considerably reduce the CPU load without altering the 
sound of the effect too much. Exactly how much the Density pa-
rameter can be reduced without altering the sound depends on 
the source material.

Rev Dry/Wet Sets the balance between the “moved” source signal (“dry”, low 
values) and the reverse reverb (“wet”, high values).

Tempo Sync Determines whether the Length setting should be freely set 
(“off”) or synchronized to Reason’s tempo (“on”).
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The EQ section

The equalizer in RV7000 affects the wet reverb sound only and is used for shaping 
the character of the reverb. There are two EQ bands, one for low frequencies (shelv-
ing) and one full-range parametric EQ.

D To activate the EQ, click the EQ Enable button on the main panel so that 
the indicator lights up.

D To make EQ settings, select “EQ” with the Edit Mode button to the left in 
the remote programmer panel.

D In this mode, the remote programmer display shows a frequency curve, 
indicating the settings you make with the EQ parameters.

The parameters are:

D Remember that you have a third EQ band at your disposal - the HI EQ pa-
rameter on the main panel.
The reason why this is on the main panel and not in the EQ section is simply that 
it’s a setting you may want to adjust often, without having to open the remote pro-
grammer panel.

The Gate section

The Gate section allows you to create gated reverb effects with a lot of options and 
possibilities. You can either trigger the gate from the source audio signal or via MIDI 
or CV. 

When triggering the gate from the source audio signal, it works like this:

• The gate “listens” to the source (dry) signal and opens whenever the signal 
reaches a certain threshold level.

• The reverb sound is sent through the gate - when the gate is closed you won’t 
hear the reverb.

• When the source signal level drops below the threshold level, the gate closes after 
a time that depends on the Hold parameter and the level of the source signal (see 
the parameter table).

D If you need the gate to be open for an exact duration (time), you should 
trigger it via MIDI or CV.
In audio trigger mode, the actual gate time will vary depending on the source sig-
nal.

When triggering the gate via MIDI or CV, it works like this:

• The reverb sound is sent through the gate - when the gate is closed you won’t 
hear the reverb.

• Whenever the gate receives any MIDI note (sent to the RV7000) or a gate signal 
(connected to the Gate Trig CV input on the back of the RV7000), the gate opens 
for the duration of the note or gate signal.

Note:

D To activate the Gate, click the Gate Enable button on the main panel so 
that the indicator lights up.

D To make Gate settings, select “Gate” with the Edit Mode button to the 
left in the remote programmer panel.

D In this mode, the remote programmer display shows two meters - one 
showing the signal level (with an indication of the threshold level) and 
one showing the status of the gate.
This is useful for checking what happens, how the gate triggers, etc.

|Parameter |Description
Low Gain The amount of cut or boost of the low-shelving filter.

Low Freq The frequency below which the Low Gain cut or boost is applied.

Param Gain The amount of cut or boost for the parametric EQ.

Param Freq The center frequency of the parametric EQ, e.g. at which frequency 
the level should be decreased or increased.

Param Q This governs the width of the affected area around the set center 
frequency. The higher the value, the narrower the affected fre-
quency range.
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The parameters for the Gate section are: CV Inputs

On the back of the RV7000 you find three CV inputs. These are:

|Parameter |Description
Threshold When Trig Source is set to “Audio”, this determines the audio sig-

nal level at which the gate opens. If you raise this setting, only very 
loud sounds will open the gate.

Decay Mod This modulates the reverb Decay parameter so that the decay time 
is lowered when the gate closes. When this is set to zero, no de-
cay modulation happens - this means that if the gate is closed and 
then opened again, you may hear “previous” reverb tails that are 
still ringing. If you raise the Decay Mod setting, the decay will auto-
matically be lowered when the gate is closed, eliminating this ef-
fect.

Trig Source Determines whether the gate should be triggered by audio or 
MIDI/CV, as described above.

High Pass A high-pass filter that affects the audio that triggers the gate (only 
active when Trig Source is set to “Audio”). If you raise this setting, 
sounds with low frequencies only will not open the gate. Note that 
this setting doesn’t affect the sound of the reverb, only the trigger-
ing mechanism.

Attack Determines how long it takes for the gate to open after a triggering 
signal has been received.

Hold This parameter is only active when Trig Source is set to “Audio”. 
Hold affects how quickly the gate closes, in the following way:
Internally, the gate is controlled by an envelope follower that ana-
lyzes the source signal level and generates a “level CV signal” ac-
cordingly. This signal is compared to the Threshold level to 
determine whether the gate should be opened or closed. The 
Hold parameter affects how quickly the envelope follower re-
sponds when the source signal level drops - you could say that 
this is the decay control for the envelope follower. The higher the 
Hold setting, the longer it will take for the envelope follower signal 
to drop below the threshold level and close the gate. But the re-
sulting time also depends on the source signal level - with a loud 
signal, it will take longer time for the envelope follower to drop to 
the threshold level. Therefore, the actual gate time depends both 
on the Hold setting and on the character of the source audio.

Release Determines how long it takes for the gate to close after the Hold 
time.

|Parameter |Description
Decay Controls the reverb decay or echo/delay feedback via CV.

HF Damp Controls the HF Damp parameter on the main panel.

Gate Trig Used for triggering the Gate section with a gate signal. The length 
of the gate signal determines the length of the gated reverb.
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RV-7 Digital Reverb

Reverb adds ambience and creates a space effect. Normally, reverb simulates some 
kind of acoustic environment such as a room or a hall, but you could also use it as a 
special effect.

D The Reverb device can be used as a send effect or an insert effect.
If several devices uses the same type of reverb, you should connect the reverb as 
a send effect, to conserve computer power.

Parameters

The display to the left on the panel shows the selected reverb algorithm - the general 
type of reverb. By clicking the arrow buttons you can change algorithm, with the fol-
lowing options available:

✪ If you need to conserve computer power, try using the Low Density algo-
rithm. This uses much less power than the other algorithms.

The selected reverb algorithm can be tweaked using the parameters on the device 
panel:

CV Inputs

You can control the Decay parameter via the CV input on the back of the Reverb de-
vice.

|Algorithm |Description
Hall Emulates a fairly large, smooth hall.

Large Hall Emulates a larger hall, with pronounced pre-delay.

Hall 2 A hall reverb with a brighter attack than “Hall”.

Large Room Emulates a large room with hard early reflections.

Medium Room Emulates a medium-sized room with semi-hard walls.

Small Room A smaller room, suitable for “drum booth”-type reverbs.

Gated A gated reverb, that is abruptly cut off.

Low Density A thinly spaced reverb, where you clearly can here the individual 
echoes. Useful for strings and pads and as a special effect.

Stereo Echoes An echo effect with the repeats alternating between stereo 
sides.

Pan Room This is slightly similar to “Stereo Echoes”, but the echo repeats 
have soft attacks.

|Parameter |Description
Size Adjusts the emulated room size. Middle position (value 0) is the de-

fault size for the selected algorithm. 
Lowering this parameter results in a closer and gradually more 
“canned” sound. Raising this parameter results in a more spacey 
sound, with longer pre-delay.
For the “Stereo Echoes” and “Pan Room” algorithms, the Size pa-
rameter adjusts the delay time.

Decay This governs the length of the reverb effect. Middle position is the 
default decay time for the selected algorithm.
Note: Decay is not used for the “Gated” algorithm.

Damp Raising the Damp value cuts off the high frequencies of the reverb, 
thereby creating a smoother, warmer effect.

Dry/Wet If you are using the reverb as an insert effect, you use this parameter 
to adjust the balance between the unprocessed audio signal (dry) 
and the effect (wet). 
If the reverb is used as a send effect, this should be set all the way 
to wet only, since you can control the balance by using the AUX 
send controls in the Mixer.
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DDL-1 Digital Delay Line

This is a mono delay (where the output can be panned in stereo) that can be synchro-
nized to the song tempo. The delay can be used as a send effect or an insert effect. 

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Pan CV.
This allows you to control the panning of the delay signal. Connect an LFO to this 
for moving delay effects, or use a Matrix pattern to simulate random delay panning.

D Feedback CV.
This allows you to control the amount of feedback (the number of delay repeats) 
from another device. Useful for dub-type echoes on certain beats or notes only.

Switching between Unit modes

When you switch between the two Unit modes (Steps and MS), the following rules 
apply:

D If you switch from Steps mode to MS mode, the delay will be set to the 
same actual delay time as was used in the Steps mode.
This means that you can set up an exact rhythmic delay in Steps mode, and then 
switch to MS mode to adjust it slightly. 

D If you switch from MS mode to Steps mode, the delay is reset to the pre-
viously used Steps value.

|Parameter |Description
Delay time The display to the left on the device panel shows the delay time, ei-

ther as note value steps (based on the sequencer tempo and the 
Step Length parameter) or in milliseconds, depending on the set-
ting of the Unit switch. 
The maximum delay time is two seconds (2000 ms) while the maxi-
mum number of steps is 16. 
Note that if the tempo is low, you may reach the maximum delay 
time at a lower number of steps than 16 (in which case raising the 
steps value will not make any difference).

Unit This is where you select whether you want a tempo-based delay 
(“Steps” mode) or a free time delay (“MS” mode).
In the Steps mode, you specify the delay time in note value-based 
steps. This means that if you change the tempo in the transport 
panel, the delay will maintain its rhythmic relation to the music (pro-
vided that the resulting delay time doesn’t reach the maximum 
value). This mode is useful for creating rhythmic patterns.
If you change the tempo when using the delay in MS mode, the de-
lay time will remain the same.
See also the note about switching Unit modes below.

Step length Governs whether each step in Steps mode should be a sixteenth 
note (1/16) or an eighth triplet note (1/8T).

Feedback Determines the number of delay repeats.

Pan Pans the delay effect to the left or to the right.

Wet/Dry If you are using the delay as an insert effect, you use this parameter 
to adjust the balance between the unprocessed audio signal (dry) 
and the delay effect (wet). 
If the delay is used as a send effect, this should be set all the way to 
wet only, since you can control the balance by using the AUX send 
controls in the Mixer.
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D-11 Foldback Distortion

The D-11 is a simple but effective distortion effect, capable of producing anything 
from just a whisper soft touch of distortion, to complete thrashing. This effect is most 
often used as an insert effect.

Parameters

The distortion has the following parameters:

CV Inputs

On the D-11 you will find a CV input for controlling the Amount parameter. This can 
produce very drastic effects, especially if you control parameters in the instrument de-
vice (such as filter frequency and resonance) at the same time.

ECF-42 Envelope Controlled 
Filter

The ECF-42 is a multimode filter with a built in envelope generator. It is mainly de-
signed to be used together with pattern devices to create pattern controlled filter and 
envelope effects, but it can also be triggered via MIDI, or used as a “static” filter for 
shaping the sound of an instrument device or a whole mix. 

Usage

The Envelope Controlled Filter is best connected as an insert effect. However, unlike 
the other effects it is not a pure “stand-alone” device. To make the most of the ECF-
42, you need either CV/Gate from an external device or MIDI notes from a sequencer 
track.

D If you connect a device to the ECF-42 using audio inputs/outputs only, it 
will simply act as a filter with no velocity or envelope modulation. 
Hence, all filter parameters are “static”, unless you manually turn the knobs or au-
tomate them in the sequencer.

D Connecting a gate signal to the Env Gate input on the back panel of the 
device allows you to trigger the envelope generator for the filter.
Note that the ECF-42 envelope generator is not triggered by the audio itself - the 
envelope parameters won’t do anything unless the device receives gate signals.

D By creating a sequencer track connected to the ECF-42, you can have the 
envelope triggered by MIDI notes on the track.
The envelope is affected by the position, length and velocity of the MIDI notes (but 
not by their pitch).

✪ If you are unfamiliar with basic filter and envelope parameters, please re-
fer to the Subtractor chapter for a description of these. 

The Filter Parameters

|Parameter |Description
Amount This controls the amount of distortion. The higher the value, the 

more distortion.

Foldback This adjusts the character of the distortion by introducing fold-
back, which makes the waveform more complex. 
The default value is in the middle position. This produces a “flat” 
clipping distortion, which is the most common type. Lowering the 
parameter makes the sound rounder and more gentle, raising it 
makes the sound sharper and more evil.
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The ECF-42 filter section has the following parameters: The Envelope Parameters

This is a standard envelope generator with Attack, Decay, Sustain and Release pa-
rameters. It is triggered by a gate signal connected to the Env Gate input on the back 
panel, or by MIDI notes on a sequencer track connected to the ECF-42. The parame-
ters have the following functionality:

D The Gate indicator lights up when the device receives a signal to the Env. 
Gate input on the back panel or a MIDI note from a sequencer track.

CV/Gate Inputs

On the back panel of the ECF-42, you can find the following CV/Gate inputs:

D Freq CV.
Use this for controlling the filter frequency from another device. For smooth filter 
modulation, try connecting an LFO to this input.

D Decay CV.
For controlling the envelope decay parameter from another device.

D Res CV.
Allows you to control the filter resonance from another device. Can be very effec-
tive in combination with filter frequency sweeps.

D Env. Gate.
This is where you connect a gate signal (e.g. from a Matrix or Redrum device) for 
triggering the envelope.

|Parameter |Description
Mode This button sets the desired filter mode. Three modes are available: 

24dB/octave lowpass, 12dB/octave lowpass and 12dB/octave 
bandpass.

Freq This is the filter cutoff frequency. 
When using the ECF-42 in “static” mode (without triggering the enve-
lope), this parameter adjusts the frequency content of the sound.
When using the envelope, the Freq parameter serves as the start and 
end frequency for the filter sweep.

Res This is the filter resonance. Raising this produces a more extreme, 
“synthy” effect.

Env Amt Determines how much the filter frequency should be affected when 
the envelope is triggered. The higher the value, the more drastic the 
effect.
Note though, that if the Freq parameter is set high, raising the Enve-
lope Amount will not make any difference over a certain value! This is 
because the filter is already fully opened - try lowering the Freq pa-
rameter in that case.

Velocity This parameter determines how much the gate velocity value should 
affect the envelope amount.

|Parameter |Description
A (Attack) When the envelope is triggered, this is the time it takes before the 

envelope signal reaches its max value.

D (Decay) After reaching its max value, this is the time it takes for the envelope 
signal to reach the sustain level.

S (Sustain) If the gate remains open (or the MIDI note is held), the envelope sig-
nal will remain on this level.

R (Release) When the gate is closed (gate CV goes back to 0) or the MIDI note 
ends, this is the time it takes for the envelope signal to drop from its 
current value to the start value (set by the Freq parameter).
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Pattern Controlled Filter - An Example

This example shows how to use the ECF-42 and the Matrix to create pattern con-
trolled filter effects. Proceed as follows:

1. Start with an empty Song.

2. Create a Mixer.

3. Create a Subtractor Synthesizer.
An Init Patch will work fine for these examples.

4. Create an ECF-42.

5. Create a Matrix Pattern Sequencer.
If you flip the rack around, you can see that the audio out from the Subtractor is 
passed through the ECF-42 and then on to the Mixer. The Matrix Curve CV is con-
nected to the ECF-42 Frequency CV parameter, and the Matrix Gate CV is con-
nected to the ECF-42 Env Gate input.

6. Select the Track connected to the Subtractor (given that you are handling 
MIDI input via the sequencer) so that you can play it from your keyboard.
If you play a few notes and turn the ECF-42 filter freq knob, you should hear the 
sound being filtered.

7. Draw a Gate pattern in the Matrix, using mixed velocity values.
Draw only a Gate pattern, not a Curve pattern.

8. Set both the Env.Amt and Vel knobs on the ECF-42 to about “40”.

9. Click the Run button on the Matrix panel.

10.While in Run mode, hold a chord down on your keyboard.
Now you should hear the envelope (controlling the filter) being triggered with every 
gate step.

D By increasing the Env.Amount, you determine how much the envelope 
parameters should affect the filter frequency.

D By increasing the Vel. parameter, you determine how much the gate ve-
locity should affect the filter frequency.

✪ If the filter effect isn’t very noticeable, try lowering the filter frequency, 
and raising the Res value.

11.Set both the Env.Amt and Vel knobs on the ECF-42 to “0”.

12.With the Matrix still playing, draw a Curve pattern in the Matrix pattern win-
dow.
Now, you should hear the filter frequency being modulated by the curve pattern. 
By combining the various parameters you can create many new filter effects. 

D You can also control the ECF-42 from other devices with CV and/or Gate 
outputs.

Triggering the ECF-42 via MIDI

To trigger the envelope in the ECF-42, proceed as follows:

1. Create a sequencer track for the ECF-42.
This is easiest done by bringing up the context menu for the device and selecting 
“Create Sequencer Track for XX” (where “XX” is the name of this particular filter 
device).

2. Record or draw some notes on the sequencer track.
Remember that the envelope takes the note length and velocity into account. The 
note pitches doesn’t matter.

3. Play back the track.
The actual notes will not be heard (since the track is connected to the ECF-42, 
which produces no sound in itself) but the envelope will be triggered according to 
the notes.

D You can even control the envelope “live” via MIDI: just set MIDI input to 
the sequencer track for the ECF-42 and play your MIDI instrument!
To route MIDI input to a track, click in the In column in the track list, so that the 
MIDI connector symbol appears next to the track name.
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CF-101 Chorus/Flanger

The CF-101 is a combined chorus and flanger effect. It adds depth and movement to 
the sound by adding a short modulated delay to the audio signal. The delayed signal 
is then mixed with the original (either in the effect device or manually by you - see be-
low). The CF-101 can be used as an insert or send effect.

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Delay CV.
Allows you to control the delay time from another device. This may give best re-
sults if you turn off the LFO modulation in the device (turn LFO Mod Amount to 
zero). For example, by controlling the delay parameter from a Matrix, you can cre-
ate “stepped flanger” effects, in sync with the tempo.

✪ If you use the Delay CV input for “playing” the feedback tone, note that a 
higher delay value gives a lower pitch.

D Rate CV.
Lets you control the rate of the modulating LFO from another device.

About Stereo and Mono connections

The CF-101 can be connected using mono or stereo inputs, as shown by the graphs 
on the back panel. Note the following:

D A “moving” stereo effect is only obtained when you use a mono input 
and stereo outputs.
With a stereo input, the two sides are processed in parallel, maintaining the stereo 
image of the original sound.

D When you are using a mono input and stereo outputs, there will only be a 
stereo effect if the internal LFO is used.
If you turn LFO Mod Amount to zero, both stereo outputs will carry the same signal 
(mono). This is because the “fake stereo” effect is produced by inverting the mod-
ulation for one of the output channels.

Tip: Using the CF-101 as a vibrato effect

The Send mode is intended for when using the CF-101 as a send effect. In this mode, 
the device will only output the modulated delay signal - you get the actual “chorusing” 
by mixing this signal with the dry, unprocessed signal in the Mixer.

However, if you activate Send mode while using the device as an insert effect, the re-
sult will be a pitch modulated version of the original sound - in short, a vibrato effect. 
Along with a little feedback, this can be used for special effects.

|Parameter |Description
Delay This is a manual control for the delay time used to create the chorus/

flanger effect. Usually, flanger-type effects use fairly short delay times 
while chorus-type effects use medium long delays.

Feedback This governs the amount of effect signal fed back to the input, which 
in turn affects the intensity and character of the effect. Turning this to 
the extreme left (negative feedback) or right (positive feedback) pro-
duces different flanger effects with a pronounced resonance “tone”, 
while keeping it in between produces a more gentle chorus effect.

LFO Rate This is the frequency of the LFO modulating the delay time. The 
higher the value, the faster the sound will oscillate.

LFO Sync This button lets you activate/deactivate LFO sync. When it is acti-
vated, the frequency of the LFO is synchronized to the song tempo, in 
one of 16 possible time divisions. The LFO Rate knob is then used for 
setting the desired time division. Turn the knob and check the tooltip 
for an indication of the time division.

LFO Mod 
Amount

This determines the depth of the LFO modulation, i.e. by how much 
the delay time should be modulated. If you set this to 0, the effect will 
be “frozen” (most effective if you add some feedback).

Send Mode This determines whether the delayed signal and the dry signal should 
be mixed in the effect device or not. If you use CF-101 as an insert ef-
fect, you should turn this off - the device will then output a mix of the 
dry signal and the modulated delay signal.
If you use the device as a send effect, you should activate Send 
mode. Then, the device will only output the modulated delay signal, 
allowing you to mix it with the dry signal using the AUX send controls 
in the mixer. See also the note below about using the CF-101 as a vi-
brato effect!
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PH-90 Phaser

The PH-90 Phaser is a classic phaser effect with some special features for fine-tuning 
the sound. It can create the classic sweeping phaser sounds suitable for pads or gui-
tars, but also more extreme effects if you like. The phaser is best used as an insert ef-
fect.

Theory

A phaser works by shifting portions of the audio signal out of phase, and then adding 
the processed signal back to the original one. This way, narrow bands of the fre-
quency range (“notches”) are filtered out. When these frequencies are adjusted, a 
sweeping phaser sound is created.

The PH-90 is a four-stage phaser, which means that there are four “notches” in the 
frequency response curve (this is a little like using four notch filters with different filter 
frequencies - see page 192 for an explanation of notch filters). 

When the phaser frequency is adjusted (manually or by the built-in LFO), these 
notches will move in parallel in the frequency spectrum. Furthermore, you can adjust 
the distance between the notches (Split) and their Width. Adding feedback raises the 
filter gain just below each notch in the frequency range, creating a more pronounced 
effect.

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Freq CV.
Adjusts the frequency parameter. Use this e.g. for creating envelope controlled 
phasing (preferably with LFO Freq. Mod turned off in the device).

D Rate CV.
Lets you control the speed of the modulating LFO from another device.

About Stereo and Mono connections

The PH-90 can be connected using mono or stereo inputs, as shown by the graphs 
on the back panel. Note the following:

D A “moving” stereo effect is only obtained when you use a mono input 
and stereo outputs.
With a stereo input, the two sides are processed in parallel, maintaining the stereo 
image of the original sound.

D When you are using a mono input and stereo outputs, there will only be a 
stereo effect if the internal LFO is used.
If you turn LFO Mod Amount to zero, both stereo outputs will carry the same signal 
(mono). This is because the “fake stereo” effect is produced by inverting the mod-
ulation for one of the output channels.

|Parameter |Description
Frequency Sets the frequency of the first notch. Adjusting this will move the 

other notches correspondingly. This is the parameter modulated by 
the LFO to create phaser sweeps.

Split This adjusts the distance between the notches in the frequency 
range, thereby changing the character of the effect.

Width Determines the width of the notches. Raising the Width deepens 
the effect and simultaneously makes the sound more hollow and 
thin. This will also have an effect on character of the feedback 
“tone”.

LFO Rate This is the speed of the LFO modulating the frequency parameter. 
The higher the value, the faster the phaser sweeps.

LFO Sync This button lets you activate/deactivate LFO sync. When it is acti-
vated, the frequency of the LFO is synchronized to the song tempo, 
in one of 16 possible time divisions. The LFO Rate knob is then 
used for setting the desired time division. Turn the knob and observe 
the tooltip that appears for an indication of the time division.

LFO Freq. Mod This determines the depth of the LFO modulation, i.e. by how much 
the frequency parameter should be modulated.
If you turn this to zero, the effect will be a static, formant-like sound 
(most effective if you add a little feedback).

Feedback This is similar to the resonance control on a filter. Raising the feed-
back gives a more pronounced “tone” in the effect. For “singing” 
phaser sounds, try raising this to the maximum.

|Parameter |Description
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UN-16 Unison

The UN-16 simulates the sound of several detuned voices playing the same notes si-
multaneously. The voices are individually slightly delayed and also pitch modulated by 
low frequency noise. This produces a rich chorus effect with the voices spread across 
the stereo field (given that stereo outputs are used).

The UN-16 can be used as an insert effect or a send effect.

Parameters

CV Input

One CV input is available on the back panel of the device. This controls the Detune 
parameter.

COMP-01 Auto Make-up 
Gain Compressor

The COMP-01 compressor levels out the audio, by making loud sounds softer. To 
compensate for the volume loss, the device has an automatic make-up gain, that 
raises the overall level by a suitable amount. The result is that the audio levels become 
more even and individual sounds can get more “power” and longer sustain.

The COMP-01 should be used as an insert effect, either for a single instrument device 
or for a whole mix (e.g. inserted between a Mixer device and the Hardware Interface). 
There are no CV inputs for this device.

Parameters

|Parameter |Description
Voice Count This switch sets the number of voices for the effect; 4. 8 or 16.

Detune This sets the amount of detuning for the voices. Turn clockwise for 
stronger detuning effects.

Dry/Wet If you are using the UN-16 as an insert effect, you use this param-
eter to adjust the balance between the unprocessed audio signal 
(dry) and the effect (wet). 
If the UN-16 is used as a send effect, this should be set all the 
way to wet only, since you can control the balance by using the 
AUX send controls in the Mixer.

|Parameter |Description
Ratio This lets you specify the amount of gain reduction applied to the 

signals above the set threshold. The value is expressed as a ratio, 
from 1:1 (no reduction) to 16:1 (levels above the threshold are re-
duced by a factor 16).

Threshold This is the threshold level above which the compression sets in. 
Signals with levels above the threshold will be affected, signals be-
low it will not.
In practice, this means that the lower the Threshold setting, the 
more the compressor effect.

Attack This governs how quickly the compressor will apply its effect when 
signals rise above the set threshold. If you raise this value, the re-
sponse will be slower, allowing more of the signal to pass through 
the compressor unaffected. Typically, this is used for preserving the 
attacks of the sounds.

Release When the signal level drops below the set threshold, this deter-
mines how long it takes before the compressor lets the sound 
through unaffected. Set this to short values for intense, “pumping” 
compressor effects, or to longer values for a smoother change of 
the dynamics.

Gain meter This shows the amount of gain reduction or increase (in dB), 
caused by the combined compression and make-up gain.
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PEQ-2 Two Band Parametric 
EQ

While there is a simple two-band shelving equalizer available for each channel in the 
mixer, the PEQ-2 gives you much more precise control over the tone color. The device 
consists of two independent, fully parametric equalizers and is most often used as an 
insert effect, in mono or stereo.

About the two EQ modules

The two independent EQs are labeled “A” and “B”. 

D EQ A is always active (provided that the effect device is in “On” mode 
and that you have set the Gain to a value other than 0). 

D To activate EQ B, click the button next to the EQ B parameters, so that 
the LED lights up.
If you only use one EQ, it’s a good idea to turn EQ B off, to conserve computer 
power.

Parameters

For both EQs (A and B), the following parameters are available:

About the graphic display

The graphic display to the left in the device panel shows the frequency response 
curve as set by the EQ parameters. This gives a visual feedback and helps you tailor 
the EQ settings.

CV Inputs

The following CV inputs are available on the back panel of the device:

D Freq 1 CV.
Allows you to control the frequency of EQ A from another device, creating subtle 
or dramatic EQ sweeps depending on the Q and Gain settings.

D Freq 2 CV.
Allows you to control the frequency of EQ B in the same way.

|Parameter |Description
Frequency This determines the center frequency of the EQ, e.g. at which fre-

quency the level should be decreased or increased. The range is 
31 Hz to 16 kHz.

Q This governs the width of the affected area around the set center 
frequency. The higher the value, the narrower the affected fre-
quency range.

Gain Specifies how much the level of the selected frequency range 
should be boosted (positive values) or lowered (negative values). 
The gain range is ±18 dB.
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Spider Audio Merger & 
Splitter

The Spider Audio Merger & Splitter is not an effect device, but a utility. It has two ba-
sic functions:

D To merge up to four audio input signals into one output.

D To split one audio input signal into four outputs.

There are no controls on the front panel of this device, only signal indicators.

Merging audio

On the back panel of the Spider are several audio connectors. The left half of the 
panel contains four stereo audio input connectors, and to the right of these, one 
merged stereo output. 

D The principle is simple; all audio signals connected to any of the four in-
puts will be merged and output via the output connectors.
If you connect a mono signal (to a L/Mono input, with nothing connected to the 
corresponding R input) it will be output on both merged outputs. This way you can 
merge stereo and mono signals freely.
If you connect a signal to the R input only (with nothing connected to the corre-
sponding L/Mono input) it will be output on the R output only.

Practical uses of merging audio

There are many practical uses of merging audio signals together, for example:

D Process several audio signals with the same insert effect(s).
Perhaps you want to process certain channels in a mix with the same compressor, 
or use one ECF-42 to filter a group of instruments in a mix. You can also set up a 
chain of insert effects and process the merged signals.

D Sub-grouping signals.
It may be practical to control several audio signals using one channel strip in the 
Mixer.

D Use merged signals as either carrier or modulator source for the BV512 
Vocoder.
You could use several sounds as carrier signal, or modulate the carrier with sev-
eral signal sources.

Splitting audio

The right half of the back panel contains two signal splitters, labeled “A (L)” and “B 
(R)”. The two splitters work independently, in the following way: 

D The signal fed to the input connector will be simultaneously output by all 
four outputs.
For splitting stereo signals you simply use both splitters with “A” for the left chan-
nel and “B” for the right channel.

Practical uses of splitting audio

There are many practical uses of splitting audio signals - here a few examples:

D Create “pseudo” stereo effects from mono signals.
For example, you could route the mono output of a Subtractor to the Spider and 
then send two split outputs (from the same row) to different effects and on to dif-
ferent Mixer channels panned left and right.

D It provides a way to instantly switch between (or mix) different variations 
of the same signal.
This is a neat way of applying “spot effects” in a mix. An instrument output is split 
and sent to three different combinations of insert effect processing. The outputs 
from the three effects are routed to separate channels in the Mixer, which could in 
turn have different send effects, eq, etc. You then have three different variations of 
the same signal that can be easily switched in and out of the mix for drastic sonic 
changes - or combined for huge layered sounds.

Four audio input pairs. Merged outputs.

Four split output pairs.Inputs.
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Spider CV Merger & Splitter

The Spider CV Merger & Splitter is not an effect device, but a utility. It has two basic 
functions:

D To provide one merged CV output from up to four CV input sources.

D To split CV or Gate inputs into several outputs.
Two inputs, A and B, are provided, each with four outputs, where one of the out-
puts will invert the polarity of the control signal. One reason for having two spl-
itable inputs is to make it possible to split Gate and Note CV, to control several 
instrument devices with one Matrix for example.

There are no controls on the front panel of this device, only CV signal indicators. The 
four horizontal indicators light up to indicate signals connected to the corresponding 
merge input. The two indicators to the right indicate signals connected to the corre-
sponding split inputs.

Merging CV

On the back panel of the Spider there are several CV connectors. The left half of the 
panel contains four CV/Gate input connectors with associated trimpots, and to the 
right of these, one merged CV output. 

D The merged CV output will produce a CV signal that represents the 
“sum” of all connected CV inputs.

A few things to note:

• Gate CV signals typically trigger notes or envelope cycles and are normally routed 
to a Gate input. 

• CV signals typically control note pitch or for modulating parameters and are typi-
cally routed to CV Note or Modulation inputs.

There are no strict rules involved, but the facts mentioned above means that it is gen-
erally better to stick to using either Gate CV signals or CV signals but not a mixture 
when merging. simply because the CV/Gate signals usually go to different input des-
tinations.

For instance, merging Note CV and Gate CV from a Matrix does not make much 
sense if you want to use Matrix to play melodic patterns via the Sequencer Control in-
puts of an instrument device. There would only be one merged output whereas the in-
strument device would need a separate Gate and Note CV signal to work properly. 

Practical uses of merging CV

The practical applications of merging CV are perhaps less obvious compared to split-
ting CV. But there are numerous applications for a merged CV control output, a few of 
which are listed below:

D You can create interesting modulation effects by merging several Modu-
lation outputs from LFO’s and other CV modulation sources.
For example, merging the Modulation outputs from several LFO’s would produce a 
“mixed modulation” output. This merged output signal could be likened to a “super 
LFO” capable of generating several modulation cycles simultaneously, each with a 
different waveform and modulation rate! In addition to this, by using the trim con-
trol for each CV input, you have full control over the amount of modulation applied 
by each LFO.
The above example could of course also include Curve CV outputs from a Matrix 
or Mod Outs from Malström etc., in short any CV Modulation output.

D Use the ECF-42 Filter to apply envelope controlled filter effects.
This can create the sound of “synthesized” percussion, and other interesting ef-
fects.

This is done using the following method:

1. Connect the audio outputs of a Redrum to a ECF-42 Envelope controlled fil-
ter.

2. Connect the Gate outputs from up to 4 Redrum drum channels to the merge 
inputs of a Spider CV.

3. Route the merged output to the Env Gate input on the ECF-42.
If you add a touch of velocity the connected Gate signals will trigger the ECF-42 
filter envelope. Again, the trim pots on the Spider allows you to adjust the amount 
of filter envelope applied. 

D Create an “arpeggiator” using two Matrix devices and the Spider CV 
Merger & Splitter.

By merging the Note CV output from one Matrix with a Curve CV output of another 
Matrix, you can transpose the Matrix pattern in real-time, a bit like an arpeggiator.

1. Create a Subtractor and a Matrix device.
Connect the Matrix Note and Gate CV outputs to the Subtractor Sequencer CV 
and Gate inputs, respectively.

2. Program a pattern for the Matrix.
In the following text this is referred to as “Matrix 1”

Four CV inputs with trim 
controls.

The merged CV 
output.
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3. Now create a Spider CV and a second Matrix device and connect them as 
in the picture below.

Note that the Note CV output from Matrix 1, and the Curve CV output of Matrix 2 should be 
connected to the Spider. The merged output is connected to the Sequencer Control Note CV 
input on the Subtractor.

4. On the Spider CV, turn the trimpot for the input connected to the Note CV 
output fully to the right.
This setting will retain the correct pitch relationship for the notes played by the pat-
tern.

5. On the Spider CV, turn the trimpot for the input connected to the Curve CV 
output to “32”.
This will produce a Curve CV output that corresponds to semitone steps.

6. Set the Curve type switch to “Bipolar” on the back of the second Matrix (Ma-
trix 2).

7. Flip the rack around so that the front panels are showing, and make the fol-
lowing settings for the “Matrix 2”:

• Set the number of steps to “1”.
• Set the Curve/Keys switch to “Curve”. 

8. Adjust the Matrix 2 curve for step 1 (the only step used) so that it is in the 
middle of the bipolar curve as the picture shows.

9. If you now activate Play from the transport, the pattern you programmed for 
Matrix 1 is played back. By carefully adjusting the Matrix 2 Curve step 1 up or 
down the Matrix 1 pattern is transposed in semitone steps.
By programming different values for the “pattern” played by Matrix 2 and saving 
them in different pattern locations, you can use the Pattern selectors to transpose 
the Matrix 1 pattern to different keys!
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Splitting CV

On the right half of the back panel you will find two split inputs “A” and “B”, each with 
four output connectors. The signal connected to a Split input will be output by all four 
corresponding outputs, where one is inverted.

Practical uses of splitting CV

There are many practical uses of splitting CV signals - here are a few examples:

D Connecting the CV Note and CV Gate outputs from a Matrix to Split Input 
A and B, allows you to connect the Matrix to several instrument devices.
Simply route the CV and Gate outputs to the corresponding Sequencer Control 
CV/Gate inputs on the instrument devices. Although this could also be done by 
copying the Matrix Pattern data to several sequencer tracks and routing the out-
puts to the desired devices, the advantage by using Split is if you are editing Matrix 
pattern data this will be immediately be reflected in all the connected devices, 
without any copy/paste operations.

D Splitting modulation outputs from LFO’s, Curve CV data etc. allows you 
to apply modulation from one source to several parameters.
By using the inverted output, you can create interesting modulation crossfades, 
where one parameter value rises and another parameter value is lowered for exam-
ple.

Two CV Split Inputs (A & B).

Each of the two Split inputs provide four Split 
outputs. The lower right Split outputs will 
produce an inverted CV signal.
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Reason Menu (Mac OS X)
About Reason
This menu item opens up a dialog that informs you about the version of the program 
and the people behind it.

Preferences
This menu item opens up the Preferences dialog. See page 380 for detailed descrip-
tions of the options in this dialog.

In addition, the Reason menu contains the standard Mac OS X services and Hide/
Show options. Please consult the Macintosh help for descriptions of these options.

Quit Reason
This allows you to quit the program. If there are any documents open with unsaved 
changes you will be asked whether you want to save those changes.

File Menu
New
When you select this, a new, empty song appears. The exact contents of this song is 
determined by your Preferences settings (see page 380).

Open...
To open a Song, proceed as follows:

1. Pull down the File menu and select Open.
The Reason song browser window appears.

2. Use the browser to navigate to the desired folder on disk or within a ReFill.

3. When you have located the song file, select it and click Open (or double click 
on the file).
The song appears in its own document window.

✪ You can have several songs open at the same time if you like. This allows 
you to copy and paste patterns and patches between songs. However, all 
open songs consume some memory and performance, so you may want 
to close songs you don’t need.

Close
This closes the active window.

If the window is a song document and it has unsaved changes, you will be asked 
whether you want to save those changes.

Closing the last open window will quit Reason (Windows only).

Save
This saves the active song document to disk.

• If the song document hasn’t yet been saved, the Save As dialog appears, request-
ing you to enter a file name and specify a location for the file on disk.

• If the document has already been saved at least once, the document will simply be 
saved without any questions.

Save As...
This saves the active song document to disc. A standard Save As dialog appears re-
questing you to enter a file name and specify a location for the file on disk.

✪ You can set things up so that any samples used in the song are included 
in the song file itself by specifying self-contained settings (also on the 
File menu).
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Song Information...

This brings up a dialog that allows you to add contact information, comments about 
the song, etc. Furthermore, if you save a published version of the song in the Reason 
Song Archive on the Propellerhead web site, vital information can automatically be ex-
tracted by the web archive engine, and displayed with the song file.

The dialog contains the following items:

Text in Window Title

The text you add here will be displayed directly after the file name in the song win-
dow’s title bar.

More Information

This is where you add notes and comments about the song.

Song Splash

Allows you to add a picture to the song. If the “Show splash on song open” checkbox 
is ticked, the picture will be displayed when the song is opened.

To add a splash picture, click the folder button at the upper right corner, and locate 
and open the picture file in the file dialog that appears.

! Splash pictures must be JPEG files (Windows extension “.jpg”) with a 
size of 256 x 256 pixels.

To remove the splash picture from the song, click the cross button.

Author’s Web Page

Allows you to specify your web site. The user can go directly to your site by clicking 
the Browser button to the right (provided there is a working Internet connection).

Author’s Email

This is where you specify your E-mail address, if you want other Reason users to send 
you their comments, etc.

Publish Song...
If you want to make your songs available to the public, e.g. for downloading on the In-
ternet, there is a special file format for this. A Reason published song (Windows file 
extension “.rps”) is much like a self-contained song, but has the following restrictions:

• The user cannot save any changes to the song.
• Copy, Cut and Paste is disabled.
• It is not possible to use the function Export Song/Loop as Audio File if the song 

has been changed in any way.

In a word, published songs are “locked”. You can edit them at will, but you cannot 
save or export any changes. Furthermore, a published song contains information 
about which ReFills are required (if any).

To create a published song, pull down the File menu and select Publish Song. Specify 
a name and location for the published song in the file dialog that appears, and click 
Save.

D Note that you don’t have to make self-contained settings - all files (ex-
cept ReFill components) are automatically included.

About the Reason Song Archive

On the Propellerhead web site (www.propellerheads.se) you will find the Reason 
Song Archive. This allows you to share your music with other Reason users by up-
loading your songs. 
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Song Self-contain Settings...

A self-contained song contains not only the references to the used files, but also the 
files themselves. You can choose exactly which files should be included in the self-
contained song, with the following exception:

! Files that are part of a ReFill cannot be included in a self-contained song.

If your song contains samples or REX files from a ReFill, other users must have the 
same ReFill to be able to play the song.

To specify which files should be included in the song, proceed as follows:

1. Tick the checkbox in the Sound column for the files you want included in the 
song.

D You can use the Check All button to activate all checkboxes in one go.
Similarly, the Uncheck All button deactivates all checkboxes.

D Files that are part of a ReFill are indicated by a lock symbol instead of a 
checkbox (since they cannot be included in the song file).
The rightmost column indicates to which ReFill each such file belongs.

2. When you have selected the desired sounds, click OK.
The dialog is closed. The next time you save, the specified sounds will be included 
in the song file.

! Note that a self-contained song file will be considerably larger than the 
original song file. 
However, samples included in a self-contained song are automatically 
compressed by approximately 50%, meaning that the self-contained 
song will still be a lot smaller than the original song and the sample files 
combined.

“Un-self-containing” a Song

If you have opened a song that is more or less self-contained (i.e. contains one or sev-
eral sounds embedded in the song file), you may want to extract these sounds and 
make the song refer to them on disk as usual.

1. Locate the sounds you want to extract from the song file, and deactivate their 
checkboxes (or click Uncheck All).

2. Click OK to close the dialog.
Now, the program will check for each “extracted” sound file whether it is available 
in at its original, stored location or not.

D If the program finds the sound file at the location stored in the song, it is 
simply removed from the song file, and the original file reference path is 
used.

D If the program doesn’t find the sound file, a file dialog appears, allowing 
you to select a folder and name for the sound file.

Import MIDI File...
Reason can import standard MIDI files (SMF). This allows you to import MIDI data to 
Reason from other applications.

D MIDI files have the extension “.mid”.

D If the imported MIDI file is of “Type 1”, there will be one sequencer track 
for each track in the MIDI file.

D If the imported MIDI file is of “Type 0” (that is, it contains one track with 
MIDI events on multiple channels), there will be one sequencer track for 
each used MIDI channel.

D In both cases, the devices for the new sequencer tracks will be empty 
Combinators. 
This means there won't be any sound if you play back an imported MIDI file - first 
you have to load suitable patches by using the patch browsers on the Combina-
tors.

D Any tempo changes in the MIDI file are disregarded.
The tempo in Reason will be set to the first tempo in the MIDI file.
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D All controller data in the MIDI file is included.
Performance controllers such as pitch bend and mod wheel will be part of the note 
clips, while other MIDI controllers will be imported onto separate automation lanes, 
most often as alien clips. Since the MIDI implementation in Reason is different for 
different devices (and not always the same as in other MIDI instruments) you may 
want to move automation clips to other lanes (or delete them) to get the best re-
sult. 

Export MIDI File...
Reason can export standard MIDI files (SMF). This allows you to transfer MIDI data 
from Reason to other applications.

1. Set the End (E) marker at where you want the MIDI file to end.
The MIDI file will contain all events on all tracks from the start of the song to the 
End marker.

2. Select “Export MIDI File” from the File menu. 

3. In the file dialog that appears, specify a name and location for the file.
The file will automatically get the extension “.mid”.

4. Click Save.

MIDI files exported by Reason will have the following properties:

D The MIDI file will be of Type 1, with one MIDI track for each track in the 
Reason sequencer.
The tracks will have the same names as in the Reason sequencer.

D Since the Reason sequencer doesn’t use MIDI channels as such, all 
tracks will be set to MIDI channel 1.

D Tempo changes are not included in the MIDI file (only the first tempo in 
the Reason song is included).

Export Device Patch...
This item is valid for all items that can save patches. The menu item name reflects the 
type of device selected (for example “export Redrum Patch”).

Even though the device settings are stored in the song, you may want to save any set-
tings you have made for a device as a separate patch file. This allows you to use the 
patch in other songs, and lets you try out other patches in your song without risking to 
lose your sound.

D The different types of patch files have different file extensions.
These are:
“.cmb” (Combinator patch files),
“.zyp” (Subtractor patch files), 
“.thor” (Thor patch files), 
“.xwv” (Malström patch files), 
“.smp” (NN-19 patch files), 

“.sxt” (NN-XT patch files), 
“.drp” (Redrum patch files)
“.rv7” (RV7000 patch files) and
“.sm4” (Scream 4 patch files).

D If you have selected a patch, modified it and want to save it with the mod-
ifications, you could either save a separate, modified version of the patch 
(with a new name) or simply overwrite the old patch file on disk.
As usual, you will be asked whether you really want to replace the existing patch 
file.

✪ You can save a patch under the same name and location (without having 
the save dialog appear) by holding down [Option] (Mac) or [Alt] (Win-
dows) and clicking the floppy disk button on the device panel. Note that 
this overwrites the original patch!

Export Song/Loop as Audio File...
When you have created a complete song, you may want to mix it down to an audio file 
to make it playable for other people (who don’t use Reason). You can either export the 
whole song (from the start to the “E” marker), or only the loop (the area between the 
left and right locator in the sequencer). Proceed as follows:

1. Make sure only the main stereo outputs are used.
The export function will only include audio routed to the stereo outputs.

2. Make sure the Loop/End markers are at the correct positions.
If you want to export the loop, you need to set the left and right locators to encom-
pass the desired area. If you instead want to export the whole song, make sure the 
End (E) marker is at the desired end position.

✪ If you are using reverb or delay, you may want to adjust the right locator 
or End marker so that the reverb/delay “tails” are included in the ex-
ported file.

3. Check that the song (or loop) plays back properly.
It’s especially important that no clipping occurs during playback (see page 148).

4. Pull down the file menu and select Export Song as Audio File (or Export Loop 
as Audio File).
A file dialog appears.

5. Specify a name, location and file type (AIFF or Wave) for the audio file, and 
click Save.

6. Specify a sample rate and bit depth (resolution) for the exported file in the 
Settings dialog that appears.
If you are exporting to a lower bit resolution (i.e. from 24 bits to 16 bits), you 
should activate the Dither checkbox.

7. Click OK.
The program creates the audio file. Depending on the length of the song/loop, this 
may take a while, during which a progress dialog is shown.
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Export REX as MIDI File...
If you have imported a REX file into a Dr. Rex device and wish to play back the loop via 
MIDI (typically from another sequencer), proceed as follows:

1. Select the Dr. Rex device in the rack.

2. Select “Export REX as MIDI File...” from the File menu.

3. Save the MIDI File to disk.

4. In the other application, open the MIDI file you just created.

5. Set up the other application to play back the MIDI File on the correct MIDI 
Output and MIDI Channel (the output and channel on which the Dr. Rex de-
vice receives data).

Quit
This allows you to quit the program. If there are any documents open with unsaved 
changes you will be asked whether you want to save those changes.

Edit Menu
Undo
Virtually all actions in Reason can be undone. This includes creation, deletion and re-
ordering of devices in the Rack, parameter value adjustments, editing in the se-
quencer and tempo/time signature adjustments. You can undo up to 10 actions.

D To undo the latest action, select “Undo” from the Edit menu or hold 
[Command] (Mac) or [Ctrl] (Windows) and press [Z].
The action to be undone is indicated next to the Undo command on the Edit menu. 
For example, if your latest action was to delete some device(s) from the Rack, the 
Edit menu will say “Undo Delete Devices”.

Redo
To redo an undone action (“undo the undo operation”), select “Redo” from the Edit 
menu or hold [Command] (Mac) or [Ctrl] (Windows) and press [Y].

The action to be redone is indicated next to the Redo command on the Edit menu.

You can undo/redo up to 10 actions.

Cut/Cut Devices and Tracks
This command takes the selected item(s), removes them and places them on the clip-
board (an invisible storage location) from where they can later be pasted in.

Cutting applies to devices and their sequencer tracks, sequencer clips, notes and au-
tomation points.

Copy/Copy Devices and Tracks/Copy Patch
This command takes the selected item(s), copies them and places the copies on the 
clipboard (an invisible storage location) from where they can later be pasted in.

Copying applies to devices and their sequencer tracks, sequencer clips, notes, auto-
mation points and device patches.

Paste/Paste Device/Paste Patch
This command takes the items you have cut or copied and pastes them back into the 
document.

Sequencer tracks and rack devices

D When you paste a track, its device will be pasted at the same time (and 
vice versa, if the device had a track).
Pasted tracks and devices are inserted below the currently selected track and de-
vice in the track list and rack, respectively.
If nothing is selected, the pasted items will appear at the bottom of the track list/
rack.
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D If you copy and paste several devices, the connections between these 
are preserved.

D If you hold down [Shift] when you paste a device, Reason will attempt to 
auto-route it.
For example, [Shift]-pasting an instrument device typically connects it to the first 
free mixer input above it in the rack.

D You can also paste the device(s) and track(s) into another song, includ-
ing all sequencer data and device settings.

Sequencer clips and events

D When you paste sequencer clips, they appear at the song position, on 
their original track(s).
If you have deleted the original tracks, or if you paste into another Reason song 
document, new tracks with empty Combinator devices will be created as needed.

D Notes or automation points can only be pasted into an open clip.
The pasted event will appear at the song position.

Delete/Delete Devices and Tracks
This menu item is used for deleting selected items. If you delete a sequencer track 
with this menu item (then called “Delete Tracks and Devices”), its device is also de-
leted.

Delete Tracks
This deletes the currently selected sequencer track(s) without removing the corre-
sponding rack device(s).

Select All
This selects all devices in the rack, all tracks in the track list, all clips or all notes or au-
tomation points in an open clip. The result depends on which area (rack, track list, 
etc.) has focus. This is indicated by a thin frame around an area in the document win-
dow. To set focus to the desired area, click somewhere in it.

You can use this menu item to quickly apply a command to all items you are working 
on, for example deleting all devices in the rack (select Select All and then press [De-
lete]) or for Quantizing all notes in an open clip (select Select All and then click the 
Quantize button in the Tool window).

Duplicate Devices and Tracks
This creates a copy of the selected device and track, complete with all events. The du-
plicated items will appear below the selected device and track, respectively.

Initialize Patch
Sometimes it is useful to start with a “clean slate” when creating a synth sound, a 
drum kit or a sampler patch. This is done by selecting Initialize Patch from the device 
context menu or Edit menu. This sets all parameters to “standard” values. Initializing 
NN-19, NN-XT, Dr. Rex or Redrum devices will also remove all sample file references, 
allowing you to start from scratch.

Cut Pattern
Moves the selected pattern in the selected Redrum or Matrix to the clipboard. The 
pattern is then cleared.

Copy Pattern
Copies the selected pattern in the selected Redrum or Matrix to the clipboard.

Paste Pattern
Copies the pattern on the clipboard to the selected pattern location in the selected 
Redrum or Matrix device. This overwrites the selected pattern with the one on the clip-
board. Note that this can be used to transfer patterns between different Reason 
songs.

Clear Pattern
This menu item clears (empties) the selected pattern on the selected pattern device 
(Redrum or Matrix).

Browse Device Patches...
This menu item allows you to select a new Patch for a device. The menu item reflects 
which device is selected - in other words, you must select the device for the corre-
sponding Browse Patches item to appear on the Edit menu.

When you select the menu item, the Browser dialog appears, allowing you to locate 
and select the patch, on the hard disk or within a ReFill.

When you select a patch, the device’s parameters will be set according to the values 
stored in the patch, and the name of the patch will be shown in the patch name dis-
play. As with any change you make, this operation can be undone.

! Any parameter adjustments you make on the device panel after selecting 
a patch will not affect the actual patch file (for this you need to save the 
patch).

If referenced samples are missing

Patches for the Redrum, Combinator (if any sampler devices are part of the Combi), 
NN-19 and NN-XT devices contain references to samples. Just like patches, samples 
can be independent files on the hard disk or elements within a ReFill or a SoundFont. 
However, if sample files have been moved or renamed after a patch was saved, the 
sample file references in the patch will not be accurate.



MENU AND DIALOG REFERENCE
372

If this is the case when you select a patch, the program will tell you so. You can then 
choose to either manually locate the missing files, to have the program search for 
them in all stored locations and ReFills or to proceed with missing sounds.

Browse ReCycle/REX Files...
This menu item is used to add a loop to the selected Dr.Rex device. Files to be im-
ported can be in REX, RCY or REX2 file format. 

Loading a new REX file will replace any currently loaded file.

Browse Samples...
This menu item lets you load samples into the devices that use them; the Redrum, the 
NN-19 and the NN-XT. The following sample formats can be loaded:

D Wave (.wav)
This is the standard audio format for the PC platform.

D AIFF (.aif)
This is the standard audio format for the Mac platform.

D SoundFont samples (.sf2)
This is an open standard format for wavetable synthesized audio, developed by 
E-mu systems and Creative Technologies.

D REX file slices (.rex2, .rex, .rcy)
REX files are music loops created in the ReCycle program. This program “slices” 
up loops into several, separate samples. These samples - or slices - can be loaded 
into the devices mentioned.

Redrum

To use this menu item to load a new drum sound into Redrum, proceed as follows:

1. Select a channel in the drum machine, by clicking its Select button.

2. Select Browse Samples.
The Redrum sample browser opens.

3. Navigate to a location containing any of the sample formats listed above, se-
lect one and click Open.

NN-19

This menu item can also be used to add a sample to a key zone in a key map in the 
NN19 sampler.

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the browser to add one or several (see below) sample(s).

The following will happen:

D If the zone contained a sample prior to loading, this will be replaced, 
both in the zone and in the sample memory, unless the sample was also 
used by another key zone.

D If you loaded several samples, one of the samples (the sample that was 
selected furthest down in the Browser list) will be loaded into the key 
zone, and the other samples will be loaded into the sample memory.

NN-XT

This menu item is used for adding one or more sample(s) to a key map in the NN-XT:

1. Make sure the Remote Editor panel is folded out, by clicking the small arrow 
in the bottom left corner.
If the remote editor panel is folded in, you will only be able to browse for NN-XT 
patches.

2. Use the sample browser to add one or several sample(s).
The sample(s) will be placed in separate zones and mapped across the same key 
range.

D If a zone is selected when you browse for samples, the sample will be 
loaded into that zone, replacing any previous sample. 
Replacing samples this way is only possible when you load a single sample.

Automap Samples
This menu item applies to the NN 19 Sampler. If you have a number of samples that 
belong together but haven’t been mapped to key zones, you can use the “Automap 
Samples” function. This is used in the following way:

1. Select all samples that belong together and load them in one go, using the 
sample browser.
One of the samples will be loaded to a key zone spanning the whole range, and 
the rest will reside in the sample memory.

2. Select Automap Samples from the Edit menu.

Now the samples currently in memory will be arranged automatically so that:

D Each sample will be placed correctly according to its root note, and will 
be tuned according to the information in the sample file.
Most audio editing programs can save root key information as part of the file.

D Each sample will occupy half the note range to the next sample’s root 
note.
The root key will always be in the middle of each zone, with the zone extending 
both down and up in relation to the root position. Hence, no key zone high or low 
limits have to be manually set!

Mapping Samples Without Root Key or Tuning Information

Some samples may not have any information about root key or tuning stored in the file 
(nor indicated in the file name). If this is the case, you can still make use of the Au-
tomap function:
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1. Select all samples that belong together and load them in one go, using the 
sample browser.
One of the samples will be loaded to a key zone spanning the whole range, and 
the rest will reside in the sample memory. 

2. Manually set the root key, and adjust the tune knob if the sample needs pitch 
fine-tuning.
Without any information stored in the file, or if the file name doesn’t indicate the 
root key, you will have to use your ears for this step. Play the sample across differ-
ent areas of the keyboard and listen to where it sounds the most “natural”. As long 
as you are in the general area of the correct root key, the result should be o.k. You 
can always adjust this later.

3. Select the next sample using the Sample knob, and repeat the previous step.
Proceed like this until you have set a root key for all the samples.

4. Select “Automap Samples” from the edit menu.
The samples will be automatically mapped according to their set root key posi-
tions!

Delete Sample/Remove Sample

Redrum

D To remove a sample from a Redrum drum machine, select its drum sound 
channel and then select “Delete Sample” from the Edit menu.
The sample is removed from the drum sound channel and from sample memory.

NN-I9

D To remove a sample from an NN-19 Sampler’s memory, select the zone it 
belongs to, and then select “Delete Sample” from the Edit menu.
The sample is removed from the zone and from sample memory.

NN-XT

D To remove a sample from an NN-XT Sampler’s memory, select the zone it 
belongs to, and then select “Remove Samples” from the Edit menu.
The sample is removed from the zone and from sample memory. The zone still re-
mains though. To delete a zone, you must use the option “Delete Zones”.

Delete Unused Samples
This menu item is used for the NN-19 Sampler. When you select it, all samples that 
are not assigned to a key zone are deleted from sampler memory.

This way you can make sure that you are not wasting any sample memory for samples 
that are not actually used.

Split Key Zone
This menu item is used for the NN-19 Sampler. It splits the currently selected key 
zone in the middle. The new zone is the upper half of the split, and is empty. The divid-
ing point has a “handle” above it.

Delete Key Zone
This menu item is used for the NN-19 Sampler. It deletes the currently selected key 
zone from the key map.

Reload Samples
This menu item is used with the NN-XT sampler. When you select this, any changes 
you have made on a loaded sample using the sample parameters (root key, loop set-
tings, etc.) are immediately undone, and the settings revert back to the original.

Add Zone
This menu item is used with the NN-XT sampler. It is used for adding an empty zone to 
the key map. An empty zone can be resized, moved and edited in the same way as 
zones that contain samples.

An empty zone is indicated with the text “**No Sample**”. After you have added an 
empty zone, you can assign a sample to it.

Copy Zones
This menu item is used with the NN-XT sampler. It copies the selected zone(s), and all 
of its settings - including references to any sample it may contain - and places it in the 
clipboard buffer. You can then select “Paste Zones” to create a new zone that is an 
exact replica of the copied zone(s). Note that copying/pasting zones can also be per-
formed between NN-XT devices.

Paste Zones
This menu item is used with the NN-XT sampler. If you have used the “Copy Zones” 
command, with any number of selected zones, you can create exact duplicates of 
these by using the “Paste Zones” command. The pasted zones will then be added be-
low any existing zones in the key map.

Duplicate Zones
This menu item is used with the NN-XT sampler. It lets you duplicate any number of al-
ready existing zones (containing samples or empty).

1. Select the zone(s) you want to copy.

2. Select “Duplicate Zones”.
The selected zones will now be copied and automatically inserted below the last 
one in the key map display. 

The duplicated zones will contain references to the same samples as the original 
zones. They will also have the exact same key ranges and parameter settings.
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Delete Zones
This menu item is used with the NN-XT sampler. Selecting this option will remove 
both the selected zones, and any samples they may contain.

Select All Zones
This menu item is used with the NN-XT sampler. This option will automatically select 
all zones in a key map.

Copy Parameters to Selected Zones
This menu item is used with the NN-XT sampler. It lets you easily copy parameter set-
tings from one zone to any number of other zones. Proceed as follows:

1. Select all the zones you want to involve in the operation.
By this we mean the zone with the settings you wish to copy, and the zone(s) to 
which you want to copy the settings.

2. Make sure the zone that contains the settings you want to copy has edit fo-
cus by clicking on it.

3. Select “Copy Parameters to Selected Zones”.
All the selected zones will now get the exact same parameter settings.

! Observe that this only applies to the synth parameters (LFOs, envelopes 
etc.). Sample parameters (root key, velocity range etc.) can not be cop-
ied.

Sort Zones by Note
This menu item is used with the NN-XT sampler. This option lets you automatically 
sort the selected zones within a Group in descending order according to their key 
ranges.

When you invoke this option, the selected zones will be sorted from top to bottom in 
the display starting with the one with the lowest range.

If two or more zones have the same key range, they are instead sorted by velocity 
range.

Sort Zones by Velocity
This menu item is used with the NN-XT sampler. This option lets you automatically 
sort the selected zones within a Group in descending order according to their set low 
or high velocity values.

When you invoke this option, the selected zones will be sorted from top to bottom 
starting with the one with the highest “Lo Vel “value.

If two or more zones have the same velocity range, they are instead sorted by key 
range.

Group Selected Zones
This menu item is used with the NN-XT sampler. It lets you put any number of selected 
zones together in a group.

Grouping zones is good for two things:

D To allow you to quickly select a number of zones that “belong together.”
For example if you have created a layered sound consisting of piano and strings, 
you could put all string samples in one group and all piano samples in one group. 
Then you can quickly select all piano samples and make an adjustment to them by 
trimming a parameter.

D To group zones that need to share group settings together.
For example, you may want to set a group to legato and monophonic mode and 
add some portamento so that you can play a part where you slide between notes.

Proceed as follows:

1. Select the zones you want to group together.
The zones don’t have to be contiguous in order to be grouped. Regardless of their 
original positions in the samples column, they will all be put together in succes-
sion.

2. Select “Group Selected Zones”.
The zones are grouped.

Note that there is always at least one group, since the zones you create are always 
grouped together by default.

Set Root Notes from Pitch Detection
This menu item is used with the NN-XT sampler. All instrument sounds have an inher-
ent pitch. When playing a sample of such a sound on the keyboard, the keys you play 
must correspond to that pitch. For example, you may have recorded a piano playing 
the key “C3”. When you map this onto the NN-XT key map, you must set things up so 
that the sampler plays back the sample at original pitch when you press the key C3, 
and this is done by adjusting the root note.

The NN-XT features a pitch detection function to help you set the root keys of loaded 
samples. This is useful if you for example load a sample that you haven’t recorded 
yourself, and you don’t have any information about its original pitch.

Proceed as follows:

1. Select all the zones you want to be subject to pitch detection.

2. Select “Set Root Notes from Pitch Detection”.
The samples in all the selected zones will now be analyzed, and the detected root 
keys will automatically be set for you.

! Note that for this to work properly, the samples must have some form of 
perceivable pitch. If it is sampled speech, or a snare drum for example, it 
probably doesn’t have any discernible pitch.



MENU AND DIALOG REFERENCE
375

Automap Zones
This menu item is used with the NN-XT sampler. The automap function can be used 
as a quick way of creating a key map, or as a good starting point for further adjust-
ments of a key map.

Automap works under the assumption that you intend to create a key map for a com-
plete instrument, for example a number of samples of a piano, all at different pitches.

1. Load the samples you want to Automap.
Now you have three options:

• Trust that the root note information in the files is already correct.
• Manually adjust the root notes (and tuning) for all the samples.
• Use “Set Root Notes from Pitch Detection” to automatically set up the root notes.

2. Select all zones you want to automap.

3. Select Automap Zones.

All the selected zones will now be arranged automatically in the following way:

D The zones will be sorted in the display (from top to bottom - lowest key 
first) according to the root keys.

D The zones will be assigned key ranges according to the root keys.
The key ranges are set up so that the split between two zones is exactly in the mid-
dle between the zones’ root notes. If two zones have the same root key they will be 
assigned the same key range.

Automap Zones Chromatically
This menu item is used with the NN-XT sampler. It will map the selected zones chro-
matically (one zone per semitone) from C2 and up. This is useful if you are mapping 
non-pitched material (e.g. drum or percussion samples) and want one sample per key. 
Before you select Automap Zones Chromatically, you may want to adjust the order of 
the zones, since this determines which zone is mapped to which key.

Create Velocity Crossfades
This menu item is used with the NN-XT sampler. This is used for automatically setting 
up velocity crossfades for smooth transitions between overlapping zones. To set up 
crossfades, you adjust the fade out and fade in values for the overlapping zones.

An example:

D Two zones are both set to play in the full velocity range of 1-127.

D Zone 1 has a fade out value of 40.
This means that this zone will play at full level with velocity values below 40, With 
higher velocity values, it will gradually fade out.

D Zone 2 has a fade in value of 80.
This has the effect that as you play velocity values up to 80, this zone will gradually 
fade in. With velocity values above 80, it will play at full level.

Instead of manually setting up a crossfade, you can let NN-XT do it for you. Proceed 
as follows:

1. Set up the zones so that their velocity ranges overlap, as desired.

2. Select the zones.
You can select as many zones as you wish, not just one pair of overlapping zones.

3. Select “Create Velocity Crossfades”.
NN-XT will analyze the overlapping zones and automatically set up what it deems 
to be appropriate fade in and fade out values for the zones.

Note the following important points:

D This operation will not work if both zones have full velocity ranges.
At least one of the zones must have a partial velocity range (see page 272).

D This operation will not work if the zones are completely overlapping.

Copy REX Loop to Track
This menu item is used for the Dr. Rex loop player device. To be able to make your 
REX loop start at the same time as other sequencer or pattern data, you “convert” the 
slices in the loop to notes in the sequencer:

1. Select the sequencer track for the Dr.Rex device.

2. Set the left and right locators to encompass the section you want to fill with 
REX notes.
You may want to make sure that this area doesn’t contain any notes already, to 
avoid confusion.

3. Select the Dr. Rex player, so that it has focus.

4. Pull down the Edit menu and select “Copy REX Loop to Track”.
Now, the program will create a note for each slice, positioned according to the tim-
ing of the slices. The notes will be pitched in semitone steps, with the first note on 
C1, the second on C#1 and so on, with one pitch for each slice. If the area be-
tween the locators is longer than the loop length, the loop notes will be repeated 
to fill out the loop.

Now you can reorder, overdub onto, and otherwise edit the note data, using the REX 
or Key edit lanes in the sequencer.

Copy Pattern to Track
This menu item is used for the Redrum drum machine and Matrix pattern sequencer. It 
converts the selected pattern to notes on a sequencer track. Proceed as follows:

1. Select a sequencer track.
When working with a Redrum, you want to select the track for the Redrum device. 
For the Matrix, you would typically select the track for the Matrix’ target device (the 
instrument device to which the Matrix is connected). This is because the Matrix it-
self produces no sound, so the notes won’t do any good on the Matrix track.

2. Set the left and right locators to the desired range or length.
If the range set is longer than the pattern(s), the data will be repeated to fit the 
range.

3. Select the pattern device, so that it has the focus.



MENU AND DIALOG REFERENCE
376

4. Pull down the Edit menu and select “Copy Pattern to Track”.
Notes will be created between the left and right locators, according to the se-
lected pattern.

! When copying Matrix patterns, only the Gate and Keys values will be in-
cluded!

D If you copied a Redrum pattern, you may want to turn off the “Enable Pat-
tern Section” before playing back the new track data.
Otherwise, both the main sequencer and the pattern sequencer will play the drum 
sounds, simultaneously.

D If you copied a Matrix pattern, you may want to disconnect the Matrix (or 
even remove it), to avoid having both the Matrix and the sequencer notes 
playing at the same time.

D If you have automated pattern changes for your pattern device, you can 
render all patterns to notes in one go, using the “Convert Pattern Track 
to Notes” menu item instead.
See page 377.

Shift Pattern Left/Right
These menu items are used for Redrum, Matrix, Thor (called “Shift Sequencer Pattern 
Left/Right”) and the RPG-8 Arpeggiator (when the Pattern editor is activated).

The Shift Pattern functions move the notes in a pattern one step to the left or right. 

Shift Drum Left/Right
These menu items are used for Redrum.

The Shift Drum functions move the notes for the selected instrument one step to the 
left or right.

Shift Pattern Up/Down
These menu items are used for the Matrix.

The Shift Pattern functions will transpose all the notes in a pattern one semitone up or 
down.

! This function does not alter the Curve CV.

Random Sequencer Pattern
This menu item is used for the Thor synthesizer. It will assign random values to the 
pattern sequencer steps, but only for the property selected with the Edit knob. For ex-
ample, if “Note” is the edited property, only the note pitches will be randomized; leav-
ing velocity values, lengths, durations and curves intact.

D Randomized note pitches will be kept within the range set with the Oc-
tave switch.

D The “Steps” setting (pattern length) will not be changed by randomizing. 

D Steps outside the current pattern length will not be affected.

Randomize Pattern
This menu item is used for the Redrum, Matrix and RPG-8 Arpeggiator (when the Pat-
tern editor is activated).

The Randomize Pattern function create random patterns. These can often be great 
starting points and help you get new ideas.

! Note that for the Matrix, Randomize affects both the Gate, Note and 
Curve CV!

Randomize Drum
The Randomize Drum functions creates random patterns for the selected drum sound 
channel in the Redrum drum machine.

Alter Pattern
This menu item is used for the Redrum, Matrix and RPG-8 Arpeggiator (when the Pat-
tern editor is activated).

The Alter Pattern function modifies existing patterns. Note that there must be some-
thing in the pattern for the function to work on - using an Alter function on an empty 
pattern will not do anything.

! Note that for the Matrix, Alter affects both the Gate, Note and Curve CV!

Alter Drum
The Alter Pattern function modifies existing patterns for the selected drum sound. 
Note that there must be something in the pattern for that channel for the function to 
work - using an Alter function on an empty pattern will not do anything.

Invert Pattern
This menu item is used for the RPG-8 Arpeggiator device, when the Pattern editor is 
activated. This inverts the pattern, so that active steps become rests and vice versa.

Arpeggio Notes to Track
This menu item is used for rendering the arpeggio from an RPG-8 to actual note clips. 
For this to work, you must have recorded chords or notes on the RPG-8 track and set 
the locators (so that an arpeggio is generated when you start playback from the left lo-
cator). 

“Arpeggio Notes to Track” will create a note clip between the locators on the selected 
track, containing the generated arpeggio notes. You can then mute the original note 
clip(s) on the RPG-8 track and edit the rendered arpeggio notes as usual.
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Combine/Uncombine
D By selecting several devices in the rack and selecting “Combine”, a Com-

binator device will be created containing the selected devices.

D By selecting the Combinator (or one or several devices contained in a 
Combinator) and then selecting “Uncombine” will remove the devices 
from the Combinator and into the rack.
In case the whole Combinator is selected, this will be removed and the devices it 
contains will be moved into the rack.

! See the Combinator chapter in the Operation Manual for details.

Create Track for... / Delete Track for...
A rack device can have one sequencer track or no sequencer track. Instrument de-
vices are by default created together with a sequencer track, while effect devices, mix-
ers etc. are created without tracks.

D If a device without sequencer track is selected, this menu item is called 
“Create Track for [device name]”. 
Select it to create an empty sequencer track for the device.

D If the selected device has a sequencer track already, this menu item is 
called “Delete Track for [device name]”. 
It will remove the sequencer track and all its contents, but leave the device.

Auto-route Device
Auto-routing is when devices’ audio and CV/gate connections are automatically 
routed according to default rules. Auto-routing is normally performed when:

• A new device is created.
• Moving, duplicating or pasting devices with [Shift] pressed.

However, if a device is already in the rack, you can “force” it to be auto-routed by se-
lecting it and then select this menu item.

For more information about auto-routing rules, see page 47.

Disconnect Device
This disconnects all audio and CV/gate connections from the selected device(s).

Insert Bars Between Locators
This function inserts an empty area between the locators in the main sequencer. All 
events after the left locator are moved to the right to “make room” for the inserted 
area.

Remove Bars Between Locators
This function removes all material between the locators in the main sequencer. All 
events after the right locator are moved to the left to “fill out” the gap after the re-
moved section.

Convert Pattern Track to Notes
If you have recorded or drawn pattern changes on a Redrum or Matrix track, you can 
have the whole track converted to notes, in the following way:

1. Select the track with the pattern changes.

2. Select “Convert Pattern Track to Notes” from the Edit menu or the context 
menu for the track.
For each pattern clip, the corresponding pattern is converted to note clips on the 
track (following the same rules as for the “Copy Pattern to Track” function). The 
track will play back just the same as when you played the pattern device with the 
pattern changes.

D After the operation, all pattern clips are automatically removed from the 
track.
“Enable Pattern Section” (Redrum) and the Pattern Enable switch (Matrix) are au-
tomatically turned off.

D When you use this with a Matrix, you need to move the note clips to the 
track of an instrument device (typically the device to which the Matrix is 
connected).
This is because the Matrix doesn’t make any sound itself.

Commit to Groove
This function is available if the track list has focus and one or several note lanes on the 
selected track have ReGroove Mixer channels assigned. 

Commit to Groove will move all notes (on all note lanes on the selected track) to their 
grooved positions and then reset the groove settings to “No Channel” for the note 
lanes. In other words, this makes the groove “permanent” - the track will play back ex-
actly as before, but you can now view and edit the grooved notes.
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Parameter Automation

The parameter automation dialog allows you to add or remove automation lanes for 
the selected sequencer track.

D The checkboxes to the left determine if a lane is shown or not.
To add a lane, activate its checkbox.

D The Automated column indicates if there is automation data (clips) on 
the lane.
If you deactivate the checkbox for an automated parameter, this will delete the au-
tomation data. This is indicated by the automation symbol with the trash can.

D If the “Show Frequently Used Only” checkbox is activated, only the more 
common automation parameters are listed.
To see all parameters, deactivate the checkbox.

New Note Lane
Adds a new note lane to the selected track(s). This is the same as clicking the “+ 
Lanes” button above the track list.

Merge Note Lanes on Tracks
If there is more than one note lane on the selected track, this menu item will merge all 
note clips on all lanes into a single lane.

D If there are several clips containing the same performance controllers 
(e.g. mod wheel) on the same positions in the song, only the perfor-
mance controller data from the topmost lane will be kept.
This is the same rule as during playback - performance control data in the topmost 
lane has priority.

Get Groove From Clip
This requires that a single note clip is selected. The function will look at the notes in 
the clip and extract a groove from these. You can apply this groove to other note lanes 
or save it as a groove patch for later use.

1. Create or record a rhythmic note “pattern” of some kind.
You may for example record a drum pattern, or use the notes playing the slices in 
a REX loop. 

✪ For the groove to be useful in most common music styles, it’s recom-
mended that the note clip is an exact number of bars in length - prefera-
bly 1, 2, 4 or maybe 8 bars.

2. Open the ReGroove Mixer from the transport panel and select a channel for 
editing (by clicking its Edit button).
This is where your custom groove will end up - choose an unused channel if you 
don’t specifically want to replace a groove.

3. With the note clip selected, select “Get Groove From Clip” from the Edt menu 
or sequencer context menu.
The groove is assigned to the ReGroove Mixer channel as “User”. By selecting 
that ReGroove Mixer channel for other note lanes, you can make the music fit with 
your custom groove.

4. Select the Groove tab in the Tool window.
Here you can adjust how the groove should affect note timing, velocity and length 
and also save the groove as a ReGroove Patch (including the settings of the slid-
ers in the window).

Read more in the ReGroove Mixer chapter in the Operation Manual.

Join Clips
This requires that more than one clip is selected on the same lane. Join Clips will join 
the selected clips together.

! If any of the clips contains masked-out events in the range between the 
clips, these events will be deleted. Also, if the clips overlap, any hidden 
events are deleted.

Mute Clips / Unmute Clips
If there are one or several unmuted clips selected, this menu item is called “Mute 
Clips”. Muted clips (shown without colors and with dimmed borders) will not play 
back but can be edited and arranged as usual.

If only muted clips are selected, the menu item is called “Unmute Clips”. The keyboard 
shortcut for Mute/Unmute Clips is [M].
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Crop Events to Clips
Notes or automation points can be positioned before or after the start or end of a clip. 
For example, this would happen if you have resized a clip after recording. Notes out-
side the clip won’t be heard on playback, but you can view and edit them if you open 
the clip.

Selecting “Crop Events To Clips” removes all such outside events from the selected 
clip(s). If the track list has focus, this function is performed on all clips on the selected 
track(s).

Add Labels to Clips / Remove Labels from Clips
This allows you to name the selected clips.

D Clips with name labels (and their lanes) are drawn slightly higher, to 
make room for the labels.

D If you select “Add Labels to Clips” with a single clip selected, this adds 
an “untitled” label and opens a text box for editing the label.
If you have several clips selected, the “untitled” label will be added to all selected 
clips. To edit the names of the clips, you need to double click each label.

D If all selected clips have labels already, the menu item is called “Remove 
Labels from Clips”.

Clip Color
Allows you to select a color for the selected clip(s).

Track Color
Allows you to select a color for the selected track(s). The selected color is shown in 
the track list and will be assigned to all new clips you create on the track. However, 
clips that are already on the track will not be affected - to change color of existing 
clips, select the clips and use the “Clip Color” setting.

✪ If “Auto-color New Sequencer Tracks” is activated on the Options menu, 
tracks will get colors assigned automatically when they are created.

Repair Invalid Data in Clips
If an automation clip has been moved to a lane for a parameter with a different range 
(for example if you cross-browse to another device type), it will be shown as alien and 
won’t play back.

Depending on the data, you may be able to fix this by selecting the clip and selecting 
“Repair Invalid Data in Clips”. This scales the automation data in the clip to fit the 
range of the current lane.

! If it’s not possible to scale the data, an alert will appear to tell you this.

Quantize Notes
In Reason, you use the Quantize function in the following way:

1. Select the notes you want to quantize.
You can select notes inside an open note clips, or one or several closed note clips 
(to quantize all notes within the clips). Selecting one or several tracks will quantize 
all notes in all clips on all note lanes on these tracks.

2. Bring up the Tool window and select the Tools tab.

3. Set the quantize value (the Value pop-up menu in the Quantize section).
This determines to which note values the notes will be moved when you quantize. 
For example, if you select 1/16, all notes will be moved to (or closer to) the closest 
sixteenth note position.

4. Select a value from the Amount pop-up menu.
This is a percentage, governing how much each note should be moved. If you se-
lect 100%, notes will be moved all the way to the closest Quantize value positions; 
if you select 50%, notes will be moved half-way, etc.

5. If you like, you can make the quantization less exact by adding a Random 
value.
This is a random deviation range in ticks. If this is set to 10, the quantized notes 
will be randomly distributed in a range of +/- 10 ticks around the quantize value 
grid.

6. Click the Apply button, select “Quantize Notes” from the Edit menu or press 
[Command] / [Ctrl] -[K].
The notes are quantized.

Edit Keyboard Control Mapping
This menu command is available when Keyboard Control Edit Mode is selected. It will 
open a dialog where you can assign a Keyboard Control for a selected parameter.

Clear Keyboard Control Mapping
This menu command is available when Keyboard Control Edit Mode is selected. It will 
remove the Keyboard Control mapping for a selected assigned parameter.

Clear All Keyboard Control Mappings for Device
This menu command is available when Keyboard Control Edit Mode is selected. It re-
moves all keyboard mapping you have set up for the selected device.

Edit Remote Override Mapping...
This menu command is available when Remote Override Edit Mode has been acti-
vated on the Options menu. It opens a dialog where you can assign a Remote Over-
ride for the selected parameter.
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Clear Remote Override Mapping
This menu command is available when Remote Override Edit Mode has been acti-
vated on the Options menu. It will remove the Remote Override mapping for a se-
lected assigned parameter.

Clear All Remote Override Mappings for Device
This menu command is available when Remote Override Edit Mode has been acti-
vated on the Options menu. It removes all Remote Override mapping you have set up 
for the selected device.

Copy/Paste Remote Override Mappings
These menu commands are available when Remote Override Edit Mode has been ac-
tivated on the Options menu. You can use them to copy override mappings from one 
device and paste them into a device of the same type.

If the device you paste into is in the same song as the device you copied from, the op-
eration will replace the existing overrides.

Preferences – General

Mouse Knob Range

This lets you adjust the response sensitivity of the various knobs in Reason when ma-
nipulating them with the mouse. A higher sensitivity gives a higher degree of preci-
sion. You can choose between Normal, Precise and Very Precise.

Automation Cleanup

The Automation Cleanup setting reduces the number of automation points when you 
record or draw automation. Adjust this setting if you find that recording or drawing re-
sults in too many or too few automation points.

• This can also be done manually from the Tool window (Tools tab).

Cable Animation

Cables in Reason are animated in a lifelike fashion when flipping the Rack and making 
connections. Should you so wish, you can choose to disable the cable movement an-
imation by deactivating this checkbox.

Show Parameter Value Tool Tip

Normally, if you hold the mouse pointer over a parameter on a device panel for a mo-
ment, a Tool Tip appears displaying the name and the current value of the parameter. 
If you uncheck this option, Tool Tips will not be displayed.

Show Automation Indication

If a parameter is automated in the sequencer, this is, by default, indicated by a colored 
square around the parameter on the device panel. If you uncheck this option, automa-
tion will not be indicated.

Default Song

By default, every time you start Reason, a simple demo song opens. This default song 
contains a few devices and sequencer data and can be played. Every time you select 
“New” from the File menu, a default template song (without sequencer data) is 
opened, with a few selected devices. This serves as a suitable starting point for creat-
ing your own songs.

This section allows you to set one of the following Default Song options:

• Empty Rack - This will open an empty rack. Well, almost empty, since it contains 
the Reason hardware interface.

• Built In - If this is selected the built-in default demo/template songs will be opened 
according to the rules stated above. 

• Custom - This allows you to select a custom default song. Any Reason song can 
be used, so if you often create songs using the same or similar device setups, you 
can use a previously created song as the default song. This way, all new songs you 
create will have the same device setup.

To customize the contents of new songs, proceed as follows:



MENU AND DIALOG REFERENCE
381

1. Select New from the File menu to create a new song document window.

2. Add/remove devices and make settings as desired.
Typically, you may want the default song to contain your choice of devices and 
possibly some patterns. You could also make some special routing between de-
vices, or even add some sequencer data.

3. Save the song anywhere you like (preferably in the Reason program folder 
though) and under any name.

4. Pull down the Edit menu and open the Preferences dialog.

5. Go to the General page, and under “Default Song” click the radio button 
marked “Custom”.

6. Click the browser button to the right in the dialog, navigate to the song you 
saved earlier and click “Open”.
The name of the song appears in the textbox in the dialog.

7. Close the Preferences dialog.
The next time you launch the program or select New from the File menu, the new 
song document will contain the devices and settings you made.

CPU Usage Limit

Reason is a powerful program but also demanding in terms of processing power. The 
more devices you add to your rack, the more of your computer’s resources it will use.

Furthermore, as you use more and more of your computer resources for creating au-
dio, less will be available for the user interface, resulting in slower performance in 
terms of graphics and overall responsiveness.

The CPU Usage Limit setting allows you to set a limit on how much of the CPU (com-
puter processor) that can be used for creating audio. The remaining capacity is re-
served for the user interface and the graphics.

Set this so that you feel comfortable using the program, even when a very demanding 
song document is played back.

Use High Resolution Samples

Reason has the capability to play back samples with practically any resolution. This 
means that if for instance 24-bit samples are loaded in a sampler or the Redrum, play-
back of the samples can be in 24-bit resolution as well. If you are using such samples 
and want Reason to play them back in their original high resolution, make sure that 
this checkbox is ticked.

If this is activated, and if your audio card supports it, Reason will play back high reso-
lution samples in their original resolution. If this option is not activated, Reason will 
play back all samples in 16-bit resolution, regardless of their original resolution.

Load Default Sound in New Devices

When this is activated and you create a new device (of a device type that supports 
patches), a default patch will be loaded. This way you can be sure that a new device 
creates sound right away. The default sound will also determine the default location in 
the Factory Sound Bank when you browse for patches for the new device.

If you turn this off, new devices will be initialized - parameters are reset to their default 
values and no samples are loaded in sample-based devices.

Preferences – Audio

Master Tune

This lets you adjust the global tuning in Reason. Standard tuning is “middle A” at 440 
Hz. You can adjust this by +/- 100 cents.

Audio Card Driver – Windows

This menu lists all the available Audio Card Drivers on your system, and lets you select 
which one Reason should use. Which option to select depends on the audio hard-
ware:
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D If you are using audio hardware for which there is a specific ASIO driver, 
you should select this. 
With an ASIO driver written specifically for the audio hardware you will get lower 
latency (see below), support for higher sampling frequencies (up to 96 kHz in 24 
bit/32 bit float resolution), and possibly better support for additional hardware fea-
tures such as multiple outputs.

D If there is no specific ASIO driver, you should select the Direct Sound 
driver for the audio hardware. 
This makes Reason communicate with the hardware via Direct Sound (a part of 
the Microsoft DirectX package). For this to be possible, you need to have DirectX 
installed on your computer, and there must be a Direct Sound driver for the audio 
hardware.

D If the audio hardware doesn’t support Direct Sound (i.e. there is no Direct 
Sound driver for the audio hardware), select the MME driver for the audio 
hardware. 
This makes use of Windows Multimedia Extensions, the part of Windows that han-
dles audio, MIDI, etc. Using MME often results in larger latency values (see below).

Audio Card Driver – Mac OS X

This menu lists all the available Audio Card Drivers on your system, and lets you select 
which one Reason should use. Which option to select depends on the audio hard-
ware:

D Normally, you select “Built-in audio”
Select the option that corresponds to the hardware you want to use (the built-in 
audio connectors or some additional audio hardware that you have installed).

D Other options may be available, mainly for compatibility with all possible 
hardware/software configurations.
You should use these only when required.

Active Channels

This displays the number of audio channels (outputs) the currently selected audio 
hardware supports. For a regular stereo card, this number will be “2”. If your audio 
card has multiple outputs and a driver that supports this is selected, the “Channels” 
button will be available. By clicking on it, you will be able to select which channel out-
puts (stereo pairs) should be active. Active outputs will be indicated in the Reason 
Hardware Interface.

Clock Source (ASIO Only)

If you are using an ASIO driver for your audio hardware, you have the possibility of se-
lecting a Clock Source. This is used for determining the source to which audio play-
back should synchronize its sample rate. If you have an audio card and a driver that 
supports it, you can choose to synchronize to external sources.

ASIO Control Panel (ASIO Only)

If you have selected an ASIO driver, this button brings up a control panel window spe-
cifically for that audio hardware. This may contain buffer settings, routing options, syn-
chronization alternatives etc.

Sample Rate

This lets you specify the playback sample rate. The options available on this menu de-
pends on which sample rates are supported by your audio hardware.

Play in Background

When this is activated, Reason will not “release its grip” on the audio hardware when 
another application is active.

• The advantage is that Reason will keep playing while you work in the other appli-
cation.

• The disadvantage is that other audio applications may not be able to play any au-
dio, depending on the type of driver used.
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Output Latency & Buffer Size

The Output latency is the delay between when audio is “sent” from the program and 
when you actually hear it. The latency in an audio system depends on the audio hard-
ware, its drivers and their settings.

If the latency is large, you will notice that the sound is delayed when you play a device 
from a MIDI keyboard. You may also notice that reactions are delayed when adjusting 
controls on the device panels (for example, if you lower the volume of a device, you 
will not hear this immediately but after the latency time). Therefore, you want to get as 
low a latency value as possible.

When you select a driver, its latency value is automatically reported and displayed in 
the Preferences-Audio dialog. Depending on the audio hardware and the driver, you 
may be able to adjust this value:

D If you are running Reason under Windows using a Direct Sound or MME 
driver, or Mac OS X using a Built-in audio driver, you can adjust the la-
tency value by using the Buffer Size slider or the up/down arrow buttons. 
The highest and lowest possible values depend on the driver.

D If you are using an ASIO driver specifically written for the audio hard-
ware, you can in most cases make settings for the hardware by clicking 
the Control Panel button. This opens the hardware’s ASIO Device Con-
trol Panel, which may or may not contain parameters for adjusting the la-
tency. Usually this is done by changing the number and/or size of the 
audio buffers - the smaller the audio buffers, the lower the latency. 
Please consult the documentation of your audio hardware and its ASIO 
drivers for details!

OK, so why not just set the latency to the lowest possible value? The problem is that 
selecting too low a latency is likely to result in playback problems (clicks, pops, drop-
outs, etc.). There are several technical reasons for this, the main one being that with 
smaller buffers (lower latency), the average strain on the CPU will be higher. This also 
means that the more CPU-intensive your Reason song (i.e. the more devices you use), 
the higher the minimum latency required for avoiding playback difficulties.

Latency Compensation

This control should normally only be adjusted when synchronizing Reason to external 
MIDI Clock.

Because of the latency problem, you might need to adjust Reason’s playback in rela-
tion to the MIDI Clock sync master, so that they are in perfect time. The tempo will not 
differ between the two, but Reason might play ahead or behind the other application. 
You might need to adjust this. However, this is something you only need to do once. 
The setting is stored with your other preferences, so you don’t need to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for example 
quarter or eighth notes, preferably with a special sound on the downbeat. 
This click can either come from an internal metronome or from a MIDI 
source. If you use a MIDI source, make sure you pick one that has solid MIDI 
timing.

2. Set up Reason so that it plays a similar rhythm as the other application. You 
might for example use the Redrum drum computer for this.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in Reason and select the Audio page.

6. Trim the “Latency compensation” setting until the “clicks” from the both 
sources sound at exactly the same time.

7. Close the Preferences dialog in Reason.

Preferences – Keyboards and Control Surfaces

This is where you set up MIDI devices; keyboards and control surfaces. 
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D The “Attached Surfaces” list in the middle shows the currently added de-
vices.
Selecting a device in the list allows you to edit its settings or delete it from the list, 
by clicking the corresponding “Edit” or “Delete” button.

D Clicking the “Auto-detect Surfaces” button will scan for connected con-
trol surfaces. 
This requires a USB connection or a two-way MIDI connection. Note that not all 
control surfaces support auto-detection - but you can always add a control surface 
manually.

D If you have devices connected in the list of Attached Surfaces that you do 
not wish to use with Reason, you can uncheck the “Use with Reason” 
checkbox.

D The “Use No Master Keyboard” button allows you to disable MIDI note 
input in the sequencer.
The device designated as Master Keyboard cannot be locked to a specific device 
- it always follows sequencer MIDI input. By selecting the master keyboard device 
in the Attached Surfaces list and clicking this button allows you use Surface lock-
ing, although you will not be able to play the device. See the Remote Control 
chapter in the Operation Manual for details.

Adding a Control Surface device

To add a control surface device, click the “Add” button in the dialog to open the Con-
trol Surfaces dialog, and proceed as follows:

1. Select the manufacturer of your control surface from the Manufacturer pop-
up menu.
If you can’t find it on the menu, see below. 

2. Select the model of your control surface from the Model pop-up menu.
If you can’t find it on the menu, see below.

3. An image of the selected control surface model is shown, often along with 
some information text - read this carefully.
For some control surfaces, you need to select a specific preset to use the surface 
with Reason - this is noted here.

4. Use the MIDI Input pop-up to select the input port to which you have con-
nected the surface.
If in doubt, you can click the Find button and then tweak a control or play a key on 
the control surface to have Reason find the correct input port for you.

D Some control surfaces may have more than one MIDI Input pop-up menu.
You need to select ports on all MIDI Input pop-up menus.

D Some control surfaces will have a MIDI Output pop-up menu.
In some cases this is labeled “Optional” - then you don’t have to make a selection. 
In other cases, a MIDI Output is required. This is the case if the control surface 
uses MIDI feedback - motor fader, displays, etc.

5. If you like, you can rename your control surface in the Name field.

6. Click OK to add the surface.

D Depending on the surface model, alerts may appear, reminding you to 
select a specific preset etc.
In some cases, Reason can restore a preset in the control surface to factory set-
tings for you - you are then informed of this.

Finally you return to the Control Surfaces Preferences page, where your added sur-
face is now listed.
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If your control surface model isn’t listed

If you can’t find your control surface listed on the Manufacturer or Model pop-up 
menus when you try to add it, this means that there’s no native support for that model. 
However, the program supports generic keyboards and controllers. Here’s what to 
do:

D Select “Other” on the Manufacturer pop-up menu and then select one of 
the three options on the Model pop-up menu.

or, if the Manufacturer is listed but not your specific model:

D Select one of the three “Other” options on the Model pop-up menu:

In both cases, the options are:

• MIDI Control keyboard
Select this is you have a MIDI keyboard with programmable knobs, buttons or fad-
ers. You need to set up your control surface so that the controllers send the cor-
rect MIDI CC messages, depending on which Reason device you want to control 
- check out the MIDI Implementation Chart in the Reason documentation. If your 
control surface has templates or presets for different Reason 2.5 devices, these 
can be used.

• MIDI Control Surface
Select this if you have a MIDI controller with programmable knobs, buttons or fad-
ers (but without keyboard). 
Again, you need to set your controllers to send the right MIDI CCs.

• MIDI Keyboard (No Controls)
Select this is you have a MIDI keyboard without programmable knobs, buttons or 
faders. This is used for playing only (including performance controllers such as 
pitch bend, mod wheel, etc.) - you cannot adjust Reason device parameters with 
this type of control surface.

✪ Under the “Other” Manufacturer, there are also two options called “MIDI 
Keyboard Multichannel” and “MIDI Controller Multichannel”. Use these 
if the controls on your keyboard/control surface send the same MIDI 
message but on different MIDI channels. Read more in the Remote chap-
ter.

After selecting a model, proceed with selecting MIDI input as described above.

About the master keyboard

One of the control surfaces can be the master keyboard. This is like any other control 
surface, but it must have a keyboard and it cannot be locked to a specific Reason de-
vice (in other words, it always follows the MIDI input to the sequencer). This is the sur-
face you use to play the instrument devices in Reason.

D The first surface with a keyboard that is added (or found by auto-detect) 
is automatically selected to be the master keyboard.
This is shown in the Attached Surfaces list on the Preferences page.

D If you want to use another surface as master keyboard, select it in the list 
and click the “Make Master Keyboard” button.
You can only have one master keyboard.

D If you don’t want to use any master keyboard at all, select the current 
master keyboard surface and click the same button (which is now la-
beled “Use No Master Keyboard”).

The Master Keyboard Input setting

This determines how you set master keyboard input in the sequencer: to which track 
and device the master keyboard should be directed (which track to play from your 
keyboard):

D In Standard mode, the last selected track automatically gets master key-
board input.
This way you can just click anywhere on a track in the track list to select it for play-
ing (or use the arrow keys to step up and down in the track list).

D In Separated mode, you need to click directly on the device icon to the 
left in the track list to set master keyboard input.
This is useful if you’re working with multiple selections in the track list, or if you 
want to select different tracks for editing without changing which device you play 
from your keyboard.

Preferences – Advanced Control

External Control Bus Inputs

The External Bus inputs provide up to 64 MIDI input channels divided into four buses, 
each with 16 channels.

D These MIDI inputs are for controlling Reason Devices from an external 
sequencer.

This could be an external hardware sequencer or sequencer software that is installed 
on the same computer as Reason. See the chapter “Routing MIDI to Reason”.

MIDI Clock Sync

Using MIDI Clock, you can slave (synchronize) Reason to hardware devices (tape re-
corders, drum machines, stand alone sequencers, workstations etc.) and other com-
puter programs running on the same or another computer. MIDI Clock is a very fast 
“metronome” that can be transmitted in a MIDI Cable. As part of the MIDI Clock con-
cept there are also instructions for Start, Stop and locating to sixteenth note posi-
tions.

D By first selecting the appropriate MIDI input using the MIDI Clock pop-up 
and then selecting “MIDI Clock Sync” on the Options menu, Reason is 
made ready to receive MIDI Clock sync. 
See the “Synchronization” chapter for more information.

International (Windows only)
Reason is localized to several different languages. The language setting affects 
menus, dialogs, tool tips and some display texts, but generally not the texts on the de-
vice panels. 

You need to restart the program for a language change to take effect.
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D Under Mac OS X, Reason will use the language selected in the operating 
system (if applicable). Create Menu

Create Instrument / Create Effect
Selecting this will open the Patch Browser, where you can browse for patches, re-
gardless of the device type. Depending on which menu item you selected, the 
browser will be set to show instrument patches or effect patches only.

D Selecting a patch in the browser will automatically create a device of the 
corresponding type in Reason, with the selected patch loaded.

Device List
To create a new device, select the desired item on the Create menu.

D The new device is added directly below the currently selected device in 
the rack.
If no device is selected, the new device is added at the bottom of the rack.

D When you add a new device, Reason attempts to route it in a logical way.

D A track for the device will automatically be created in the sequencer.
The track will have the same name as the device. Master keyboard input will also 
automatically be set to the new track, allowing you to immediately play the created 
device from your MIDI keyboard. 

! By default, this only applies to instrument devices, not to mixers or effect 
devices. If you hold down [Option] (Mac) or [Alt] (Windows) when you 
create the device, the opposite is true, i.e. mixers and effect devices get 
new tracks but instrument devices don’t.

D Note that you can also create devices from the Device palette in the Tool 
window.
Double clicking a device icon there is the same as selecting it from the Create 
menu. You can also drag and drop devices from the Tool window to anywhere in 
the rack.
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Options Menu
Internal Sync/MIDI Clock Sync/ReWire Sync
These three options are used to specify which type of tempo synchronization you pre-
fer:

Internal Sync

When this is activated, the program is not synchronized to any external source. It 
plays in the tempo set on the transport panel.

MIDI Clock Sync

When this is activated, the program is synchronized to external MIDI Clock, as set up 
in the Preferences dialog. The tempo setting on the Transport is of no relevance, Rea-
son plays in the tempo of the incoming MIDI Clock signals.

ReWire Sync

When this is activated, Reason is synchronized to another application via ReWire. 
This is not a setting that you can activate yourself, it is automatically enabled when the 
program is in ReWire slave mode.

Enable Keyboard Control
When this is activated, keyboard keys can be used to control devices, as set up with 
the Keyboard Control Edit feature.

Keyboard Control Edit Mode
D To get an overview of which parameters are remote controllable select 

“Keyboard Control Edit Mode” from the Options menu. 
When done, each device you select will show a yellow arrow symbol beside every 
parameter that can be assigned a keyboard control.

D If you click on an assignable parameter to select it, you can then select 
“Edit MIDI Control Mapping” from the Edit menu.
This opens a dialog allowing you to select a key command for that parameter.
You may use any key or a combination of [Shift] + any key.

D Simply press the key (or key combination) you wish to use to remote 
control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the key-
stroke(s), and then the dialog displays the name of the key you have pressed. If 
[Shift] was used, the box beside the word Shift in the dialog is ticked. 

You can also double-click on the arrow for an assignable parameter to set up key-
board control:

D A rotating yellow rectangle appears, indicating Learn mode. Press the 
key (or key combination) you wish to use to remote control the parame-
ter.
The rotating stops and the rectangle will now display the key or key combination 
you used.

! Note that the transport panel uses the numeric keypad for various com-
mands. If you assign a parameter to a single numeric key, the corre-
sponding transport functionality will be overridden!

D Another way to assign keyboard control commands is to have “Keyboard 
Control Edit Mode” deselected on the Options menu, and to simply 
[Ctrl]-click (Mac) / right-click (Windows) the parameter you wish to re-
mote control.
This opens a pop-up menu, where one of the options will be “Edit Keyboard Con-
trol Mapping”. Selecting this opens the Key Control dialog. Thus, you do not have 
to enable/disable Edit mode from the Options menu if you know that a parameter 
is assignable.

! If you try to assign a key control that is already in use, you will get an 
alert asking if you wish to change the current assignment.

Remote Override Edit Mode
All supported control surface devices have “standard remote mappings” for each 
Reason device. If you wish to override this standard mapping, you can do so in the fol-
lowing way:

1. To get an overview of which parameters can be assigned remote overrides, 
select “Remote Override Edit Mode” from the Options menu. 
Each device you select will show a blue arrow symbol beside every parameter that 
can be assigned a remote override. Standard mappings are marked with yellow 
knob symbols (only shown when the device has MIDI input). Assigned overrides 
are marked with a lightning bolt symbol.

2. If you click on an assignable parameter to select it (selected parameters are 
orange in color), you can then select “Edit Remote Override Mapping...” from 
the Edit menu.
This opens a dialog where you can assign override mappings.

3. Make sure that the “Learn from Control Surface Input” box is ticked.

4. Simply turn the knob (or slider etc.) that you wish to use to assign Remote 
Override for the parameter.
The “MIDI Received” field momentarily flickers as you turn the knob, and then the 
dialog shows the control surface device and the control you used. 

You can also make override mappings manually:

D Select a device from the Control Surface pop-up in the dialog, and then 
select a control from the Control pop-up.
On the Control pop-up, all the controls on the selected control surface are listed.
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5. Click “OK” to exit the dialog.
The selected parameter is now tagged with a lightning bolt symbol, indicating Re-
mote Override mapping.

6. To exit Remote Override Edit mode, deselect it from the Options menu.
You do not always have to use this method - see below.

Mapping with Remote Override Edit mode deactivated

If Remote Override Edit Mode is enabled on the Options menu, mapped parameters 
are “tagged”, and the arrow indicators show the assignable parameters. In this mode, 
however, you cannot operate Reason normally. Remote Override Edit mode is prima-
rily for overview of available parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Remote 
Override Edit Mode” deselected on the Options menu, and to simply 
[Ctrl]-click (Mac) / right-click (Windows) the parameter you wish to re-
mote control.
This opens a pop-up menu, where one of the options will be “Edit MIDI Remote 
Mapping”. Selecting this opens the MIDI Remote dialog. Thus, you do not have to 
select Edit mode from the Options menu if you already know that a parameter is 
assignable.

Additional Remote Overrides...
On the Options menu there is an item named “Additional Remote Overrides...”. Se-
lecting this opens a dialog with remote functions that cannot be assigned using Re-
mote Override Edit mode, such as switching target tracks, Undo/Redo etc.

See the Remote Control chapter for details.

Surface Locking...
This opens a dialog where you can lock a control surface to a specific device.

This means that the locked device is always “tweakable”, regardless of which track 
has MIDI input in the sequencer. This enables you to play and record notes for one 
device and at the same time control parameters for another device from a control sur-
face. 

For example, you could lock a control surface to control the main mixer, so you can al-
ways control overall levels while playing/tweaking other devices.

D The master keyboard device cannot be locked!
If you select the master keyboard in the Preferences, you can click the “Use No 
Master Keyboard” button. You can then lock this control surface to a device and 
use its controllers to tweak parameters, but you will not be able to play the device.

D Each control surface can be locked to one device at a time (but you can 
lock several control surfaces to the same device).
This locked device will always be controlled by the selected control surface, until 
you unlock the device or lock the surface to another device. You can lock as many 
devices you wish, as long as you have enough control surfaces.

D Locked devices can use remote overrides, just like unlocked devices.
In other words, even if a device is locked to a control surface, some parameters 
could be overridden so they are controlled by another control surface, or some 
controls on the locked surface could be override-mapped to another device.

! See the Remote Control chapter for more details.

Toggle Rack Front/Rear
This switches the rack between the front and rear views. A quicker way to do this is to 
press [Tab].

Show Cables
If you have made many connections in Reason, the cables can sometimes obscure 
the view, making it difficult to read the text printed on the back panels of the devices. 
You can hide/show all cables in the following way:

D Select “Show/Hide cables” on the Options menu to hide all cables.
When cables are hidden, connections are indicated by a colored connector. Re-
peating the above procedure makes the cables appear again.

D When hidden, you can still connect or disconnect cables in the same way 
as when they are shown.

Checking Connections

It is possible to check to which device a jack is connected, which is useful if the ca-
bles are hidden, or if the connected devices are located far apart in the rack:

D Positioning the pointer over a connector makes a tool tip appear after a 
moment, showing the device and the specific connector at the other end.

Follow Song
When this is activated, the sequencer Arrange and Edit views will scroll with the song 
pointer, on playback. When this item is deactivated, the view will not scroll automati-
cally.

Auto-color New Sequencer Tracks
When this option is activated, a color will automatically be assigned to a new se-
quencer track when you create it. Clips created on a track will always get the color of 
the track.

Enter Edit Mode / Enter Arrange Mode
Allows you to toggle the sequencer between Arrange Mode and Edit Mode. Note that 
note clips and automation clips need to be opened (double click or select and press 
[Return]) in order to edit the notes or automation data.
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Window Menu (Windows 
Version)
Stay on top
When this is activated, the Reason window will always stay on top of other program’s 
windows.

Detach/Attach Sequencer Window
Selecting this will detach the sequencer pane from the rack, and open it in a separate 
window. When the sequencer is detached, the menu item text changes from Detach 
to Attach. Selecting this will then reattach the sequencer to the rack.

Show / Hide Tool Window
This item (keyboard shortcut [F8]) shows or hides the floating Tool window. This con-
tains the Device palette (for creating new devices), the Tools tab (for quantizing and 
editing sequencer data) and the Groove tab (for fine-tuning and saving ReGroove 
patches).

Window List
This lists all open song documents. Selecting one makes it the active window.

Window Menu (Mac OS 
Version)
Detach/Attach Sequencer Window
Selecting this will detach the sequencer pane from the rack, and open it in a separate 
window. When the sequencer is detached, the menu item text changes from Detach 
to Attach. Selecting this will then reattach the sequencer to the rack.

Minimize (Mac OS X only)
This minimizes a selected song document.

Show / Hide Tool Window
This item (keyboard shortcut [F8]) shows or hides the floating Tool window. This con-
tains the Device palette (for creating new devices), the Tools tab (for quantizing and 
editing sequencer data) and the Groove tab (for fine-tuning and saving ReGroove 
patches).

Window List
This lists all open song documents. Selecting one makes it the active window.
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Help/Contacts Menu 
Contents (Windows only)
This menu item opens up the Help system with the Contents tab selected.

Index (Windows only)
This menu item opens up the Help system with the Index tab selected.

Search (Windows only)
This menu item opens up the Help system with the Search tab selected.

Internet Page Menu Options

About the Internet menu alternatives

Regardless of which of the Internet options you select, you will be connected to the 
Internet using your preferred browser. The browser will then take you to the page 
specified in the dialog.

Go to the Propellerhead Homepage

This takes you to the main entrance on the Propellerheads web site.

Download Reason Songs

This takes you to our archives of song files that you can download and use. You can 
also contribute with your own creations!

Download Reason ReFills

This takes you to ReFill archives with the latest offerings in free sounds for Reason!

Reason Tech Info and Support

If you have a problem or a technical question, this is the place to go!

Order Reason Now

This allows you to purchase your own personal copy of this exquisite application!

Register Reason Now

This takes you to the Propellerhead Software registration pages. Once registered you 
can download free sounds, chat with other Reason users and upload songs for others 
to hear!

Check for Updates

This will take you to a page where you can check for recent updates.

About Reason (Windows only)
This menu item opens up a dialog that informs you about the version of the program 
and the people behind it.
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A
Add Labels to Clips 379
Adjust Alien Clips to Lane 71
ADSR 194
Alien Clips 71
Alter

Notes 91
Pattern (Matrix) 302
Pattern (Redrum) 179
Pattern (RPG-8) 312

Anchor Point (ReGroove Mixer) 99
Arpeggio Notes to Track 376
Arrange View 70
ASIO Control Panel 140
ASIO Driver 20
Attach Sequencer Window 80, 389
Audio File Formats 17
Audio Hardware 16
Audio Levels 18
Audio Out 16
Audio Out Clipping 18, 148
Audio Outputs (Hardware Interface) 150
Audio Quality 16
Auditioning patches (Browser) 37
Auto-color New Sequencer Tracks 388
Automap Samples 247, 372
Automap Zones 271, 375
Automap Zones Chromatically 375
Automatic Quantize 90
Automatic Routing 26
Automating parameters 64
Automation

Adding lanes 84
Editing 84
Pattern Changes 69
Recording on multiple tracks 68
Resetting during recording 68
Showing in Device Panels 380
Static Controller Value 66

Automation As Performance Control 66
Automation Cleanup 380

About 86
Automation lanes

Deleting 68
Folding 68
Switching on and off 68

AUX Sends and Returns 167

B
Back panel 27
Bipolar Curves 300

Bit Depth 137, 369
Browse Device Patches 371
Browse Samples 372
Browser

About 33
Cross-browsing 38
Favorites 40
Locations 37
Search function 39

Buffer Size Slider 140
Built In (Default Song) 380
Buttons 9
Bypass 334

C
Cables 27

Color 47
Deactivating Animation 380
Disconnecting 49
Dragging 48
Hiding and Showing 46

CF-101 Chorus/Flanger 356
Chaining 168
Channel 8 & 9 Exclusive 182
Chorus 356
Clear All Keyboard Remote 379
Clear Pattern 297
Click 61, 148
Clip Color 379
Clipping 18, 148
Clips

Alien 71
Cropping 379
Deleting 73
Drawing 74
Duplicating 72
Joining 74, 378
Moving 71
Moving between lanes on the same track 71
Muting 74, 378
Naming 74, 379
Overlapping 73
Resizing 73
Splitting 74
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Combinator
Adding devices 155
Bypass All FX 158
Combining devices 152
Creating 152
Creating by browsing patches 152
Creating new devices 155
External Routing 153
Insertion line 155
Key Mapping 158
Receive Notes 159
Run Pattern Devices 157
Select backdrop 158
Uncombining devices 157
Using the Programmer 158

Commit to Groove 105, 377
Compatible EQ 166
Compressor 358
Context Menus 10
Control Surfaces

Adding and setting up 383
Controllers see Automation
Convert Pattern Track to Notes 93
Copy 370
Copy Device 24
Copy Parameters to Selected Zones 374
Copy Patch 31
Copy Pattern 298
Copy Pattern to Track 92, 375
Copy REX Loop to Track 375
Copy Zones 265
CPU Usage Limit 381
Create device by browsing patches 39
Create Effect 39, 386
Create Instrument 386
Create Sequencer Track for... 56
Create Velocity Crossfades 375
Crop Events to Clips 73, 379
Cross-browsing patches 38
Curve (Matrix)

About 296
Unipolar/Bipolar 300

Custom (Default Song) 380
Cut 370
Cut Device 24
Cut Patch 31
Cut Pattern 298

CV
About 46
Merging 361
Routing 49
Splitting 363
vs. Gate 300

CV Trim knobs 49

D
D-11 Distortion 353
DDL-1 Delay 352
Decay/Gate Switch 181
Default Song 136, 380
Delay 352
Delete Unused Samples 246
Deleting lanes 63
Detach Sequencer Window 57, 80, 389
Devices

Creating 22
Cut, Copy and Paste 24
Deleting 23
Deleting with Track 55
Duplicating 24
Folding 25
Moving in the Rack 23
Naming 25
Routing 26
Selecting 23

DirectX Driver 20
Disconnect (Routing) 49
Distortion

D-11 353
Scream 4 339

Dither (Export) 137
Dividers 12
Download ReFill 42
Dr Rex

To Track function 288
Dr.Rex

About 286
Adding Loops 287
Editing Slices 289
Parameters 290
Playing from Sequencer 288

Drawing
Notes 81

DSP Meter 148
Duplicate 371
Dynamics 178
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E
E Marker 137, 369
ECF-42 Envelope Filter 353
Edit Automation 84
Edit Keyboard Remote 118
Edit View 78
Editing

Automation events 85
Empty Rack (Default Song) 380
Enable Keyboard Remote 118
Enable Pattern Section 93, 176, 179
Envelope Filter 353
Envelopes 194
EQ

Mixer 165
Parametric 359
RV7000 Advanced Reverb 349
Vocoder mode 323

Eraser tool
Notes 82

Export as Audio File 137
Export Device Patch 369
Export MIDI File 96, 369
Export REX as MIDI File 370
Export Song/Loop as Audio File 369
Ext Mod (Subtractor) 199

F
Factory Sound Bank 32
FFT (Vocoder) 320
File Formats 32
Filter

Dr.Rex 290
Effect Device 353
Malström 230
NN-19 249
NN-XT 279
Subtractor 191

Flam 178
Flanger 356
FM 190
Focus switches 132
Folding Devices 25
Follow Song 388

G
Gate

About 46
Programming in Matrix 299
Routing 49
vs. CV 300

Gate (Matrix) 296
Gate (RV7000 Advanced Reverb) 349
Gate mode (Redrum) 181
Get Groove From Clip 378
Global Shuffle 99
Groove

Assigning to note lanes 104
Creating from Clips 106
Factory Patches 107
Making permanent 105
Mixer Parameters 98
Settings in Tool Window 102

Grooves
Committing to 377
Extracting 378

Group Selected Zones 374
Groups

NN-XT 266

H
Hand tool 12, 80
Hardware Interface 16, 150
Help Menu (Windows) 390
High Quality Interpolation

Dr Rex 293
NN-XT 258
Redrum 182

High Resolution Samples 17, 243, 264, 381
Host application 124

I
Import MIDI File 96, 368
Improved EQ 166
Init patch

NN-19 243
Redrum 175
Subtractor 186

Initialize Patch 31, 371
Input meter (Effect devices) 334
Insert Bars Between Locators 77, 377
Inspector strip

Clips 74
Note event editing 83

Internet Options 390
Invert

Pattern (RPG-8) 312

J
Join Clips 378
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K
Key Commands

Syntax in Manual 8
Transport 59
Zooming 57

Key Maps
NN-19 246
NN-XT 264

Key Zones
NN-19 245
NN-XT 256

Keyboard Control Edit Mode 387
Keyboard Remote 118
Keyboards (MIDI) 383
Keys (Matrix) 296
Knobs 8

L
L Marker 60
Lanes

Adding 63
Deleting 63
Merging 64
Moving 64
Muting 63
Naming 63

Latency 18, 140
Latency Compensation 131
Left Locator 60
Levels 18
LFO Sync

Dr. Rex 292
NN-19 251
Subtractor 196

Line Mixer
About 170
AUX Send and Return 171

Load Default Sound in New Devices 381
Locations (Browser) 37
Locators 147
Loop Mode 60
Loops

Creating Sequencer Notes 288
Editing Slices 289
Editing Sound 290
In Drum Samples 181
In Samples 247
Loading 287

Low BW 253, 293

M
M Column 54
Magnification 12
Magnifying Glass tool 12
Magnifying glass tool 80
Malström

About 226
Filters 230
Graintables 226, 228
Modulators 229
Oscillators 227
Routing 234
Routing external audio to 239
Shaper 233

Mapping variations (Remote) 113
Masked events 82
Master Keyboard Input 54, 385
Master Tune 18, 381
Match values

Clips 76
Matrix

About 296
Application Examples 303
Programming 297

Maximize Sequencer 80
MClass effects

About 335
Compressor 337, 339
Equalizer 335
Stereo Imager 336

Memory Requirements 143
Merge Note Lanes on Tracks 378
Metronome Click 61
Metronome Click Pre-count 61
MIDI Clock 130
MIDI Files 96

Exporting 369
Importing 368

MIDI In Device 150
MIDI Sync 132
Missing Sounds 41
Mixer

About 164
Chaining 168
Signal Flow 166

MME Driver 20
Mono

Considerations 142
In Effect Devices 334

Mouse Knob Range 8, 380
Mouse wheel 13
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MultiMedia Extensions Driver 20
Multiple Undo 11
Mute 54

Mixer 165, 170
Redrum 180

Mute Clips 378

N
Naming

Devices 25
New 366
New Dub/New Alt buttons 63
NN-19

About 242
Loading Samples 244
Parameters 248

NN-XT
About 256
Group Parameters 276
Groups 266
Loading Samples 257
Main Panel 258
Remote Editor Panel 259
Sample Parameters 275
Synth Parameters 277
Velocity Ranges 272

Notes
Altering 91
Editing 81
Editing Velocity 83, 90
Recording 61
Transposing 90

Nudging event positions 82
Numerical Value Editing 9

O
Open 366
Open Song 136
Outputs (Hardware Interface) 150

P
P button 165
P marker 59
Panes 12
Parameter Automation Dialog 378
Parameters

Automating 64
Parametric EQ 359
Paste 370
Paste Device 24
Paste Patch 31

Paste Pattern 298
Paste Zones 265
Patch Cables 27, 48
Patches

About 29
Browsing 371
Cut, Copy and Paste 31
Exporting 369
Initializing 31, 371
Malström 226
Missing Sounds 30, 371
NN-19 243
NN-XT 257
Redrum 175
RV7000 344
Saving 30
Scream 4 339
Selecting 30
Subtractor 186

Pattern Changes
Converting patterns to notes 93
Editing 87
Recording 69

Pattern clips
Drawing 88

Pattern Controlled Filter 355
Pattern Shuffle 178
Patterns

Clearing 297
Cut, Copy and Paste 298
Matrix 297
Muting 179, 297
Redrum 176
Running 176
Selecting 176, 297

Pencil tool
Notes 81

PEQ-2 EQ 359
Performance controller automation

Recording 65
Phase Controls (Subtractor) 189
Phaser 357
Pitch (Transpose) 90
Play 59
Polyphony

Dr.Rex 293
Malström 236
NN-19 252
NN-XT 276
Subtractor 198

Post-fader Sends 165
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Pre-Align (ReGroove Mixer) 101
Pre-count 61
Preferences

Advanced Control page 385
Audio page 381
General page 380
International page 385
Keyboards and Control Surfaces page 383

Preview (Dr.Rex) 287
Publish Song 136, 367
Punch In/Out 62

Q
Quantize 89
Quantize Notes 379
Quantize Notes during Recording 90

R
R Marker 60
Rack

Navigating 22
Turning around 27

RAM 143
Random Sequencer Pattern 376
Random Timing (ReGroove Mixer) 103
Randomize

Pattern (Matrix) 302
Pattern (Redrum) 179
Pattern (RPG-8) 223, 312

Razor tool
Splitting clips 74

RCY files 286
Reason Hardware Interface 150
Reason Song Archive 136, 367
ReBirth Input Machine 316
Record Automation as Performance Controllers 148
Recording 61

Controllers see Automation
Notes 61
Pattern Changes 69

ReCycle 286
Redo 10, 370
Redrum

Individual Outputs 183
MIDI Notes for 183
Parameters 180
Patches 175
Programming Patterns 176

ReFills
About 32
Downloading from Browser 42

Registering Reason 390
ReGroove Mixer

Assigning to note lanes 104
Creating ReGroove Patches 106
Factory Patches 107
Making grooves permanent 105
Parameters 98
Settings in Tool Window 102

Reload Samples 373
Remote

About 110
Additional Overrides 117
Mapping variations 113
Remote Override 115
Surface Locking 113
Surface Locking dialog 113

Remote Override
Edit mode 115

Remote Override Edit Mode 387
Remote Override mapping 115
Remove Bars Between Locators 77, 377
Repair Invalid Data in Clips 379
Reset (Automation) 68
Reset Band Levels (Vocoder) 324
Resizing

Lanes in Edit View 80
Notes 82

Resolution (Audio) 17, 137, 369
Resolution (Redrum Pattern) 178
Reverb

RV-7 351
RV7000 344

ReWire
Latency 19
Setting Up 125
With ReBirth 316

REX files 32
Loading in Dr.Rex 286
Loading in NN-19 243
Loading in NN-XT 257
Loading in Redrum 175

Right Locator 60
Ring Modulation (Subtractor) 190
Routing

Automatic 26, 47
Manual 27, 48
Pop-up Menu 49
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RPG-8
About 306
Arpeggiator parameters 310
Arpeggio notes to track 309
MIDI-CV Converter parameters 309
Setting up 306

rps files 136
Run button 176, 177
RV-7 Reverb 351
RV7000 Advanced Reverb 344

S
S1/S2 controls 180
Sample Rate

About 17
For Playback 141
In Exported Audio 137, 369

Samples
Browsing 372
Extracting from Self-contained Songs 134, 368
File Formats 32
Missing 41
NN-19 244
NN-XT 260
Redrum 174

Save Song 136, 366
Scale Tempo 91
Scream 4 339
Scrolling 12, 22
Search function 39
Select All (Sequencer) 71
Selecting

Clips 70
Notes 81

Self-Contained Songs 134
Self-contained Songs 368
Send Out (Redrum) 180
Sends

Mixer 165
Redrum 180

Seqencer
Key edit mode 79

Sequencer
Adjust Alien Clips to Lane 71
As separate window 57
Attaching 80
Basic window handling 56
Bypassing 122
Detaching 80
Drum edit mode 80
Inspector strip 74, 83
REX edit mode 80
Transport Controls 146
vs Pattern Sequencers 176, 297

Set Root Notes from Pitch Detection 374
Shift

Pattern (Matrix) 302
Pattern (Redrum) 179
Pattern (RPG-8) 223, 312

Shift Pattern 376
Show Parameter Value Tool Tip 380
Shuffle 178

Global 99
ReGroove Mixer 100
Setting for Pattern Devices 99

Sidechain inputs
About 337

Signature 61
Slices

About 286
Creating Sequencer Notes 288
Making Settings for 289
Selecting 289

Slide (ReGroove Mixer) 100
Sliders 8
Snap 60

About 70
Disabling with Shift 82

Solo 54
Mixer 165, 170
Redrum 180

Song Archive 136, 367
Song Information 135, 367
Song Position 59, 147
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Songs
Creating Default 136
Creating New 366
End position 137, 369
Exporting as Audio Files 137
Opening 136, 366
Optimizing 142
Published 136
Publishing 367
Saving 136
Self-Contained 134
Self-contained 368
Setting up the Default Song 380
Splash Picture 135, 367

Sort Zones by Note 374
Sort Zones by Velocity 374
Soundfont files 33
SoundFonts

NN-19 244
NN-XT 257
Redrum 174

Spider
Audio Merger and Splitter 360
CV Merger and Splitter 361

Splash Picture 135, 367
Startup Song 136
Steps (Pattern) 297
Stereo

Considerations 142
In Effect Devices 334

Stop 59
Subticks

About 76, 84
Subtractor

About 186
External Modulation 199
Filter 191
Oscillators 186
Waveforms 187

Surface Locking 113, 388
Sync

About 130
Internal/MIDI Clock/ReWire 387
Latency 131
Setting Up 130

T
Template Songs 136
Tempo 61, 147

Thor
Oscillator section 206
Using the Programmer 204
Virtual controls 203

Tie switch 301
Time Signature 61, 147
To Track 92
Toggle Rack Front/Rear 27, 388
Tool Tips 380
Tool Window 389
Tool window

Quantize 89
Track

Types of 53
Track automation

Recording 66
Track Color 379
Track Parameter Automation pop-up menu 84
Tracks

About 52
Creating 55, 66
Deleting 55
Folding 56
Moving 55
Routing master keyboard input to 54
Selecting 54
Viewing 70

Tracks & Devices
Duplicating 55

Transport Panel 59, 146
Trigger buttons (Redrum) 175
Trim knobs 49
Tuning 18

U
Undo 10, 370
Unipolar Curves 300
Unison 358
Unmute Clips 378
Use High Resolution Samples 17, 381

V
Value Editing (Numerical) 9
Velocity

Editing 83
Velocity Function 90
Velocity Lane 83
Vocoder

About 320
Parameters 324
Setting up 321
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W
Web Site 135, 367
Wheel mouse 13
Windows MME Driver 20

Z
Zooming 12
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